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DO NOT connect hardware until prompted by the  
Hardware Setup Wizard after installing Point of Sale!

Install and Setup Sequence 

  1. Install Point of Sale   2. Start Setup Interview

  3. Connect Hardware and Complete Interview

  4. Ring Up Sales!   5. Next Steps
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Before You Begin 
All Installations

• �Ensure your workstation meets the minimum system requirements listed at the 
end of this guide

• Sign on to Windows with Administrator rights before installing
• �Install the latest updates for your firewall software. Typically, this is done by  

right-clicking on the firewall icon in your task tray and selecting the option to 
check for updates.

• �If installing on multiple workstations, ensure they are properly networked; contact 
a qualified network technician if you need networking help

• �If integrating with QuickBooks Accounting software, review the QuickBooks 
Integration tab before beginning

New Single-Store Installations
1. Gather the following information:

• �Applicable sales tax rate(s) and the name of the agency to which they are paid

Other helpful information to have:
• �Names, contact information, account numbers, balances, etc., for existing 

vendors, customers and employees
• Current on-hand counts, costs and prices for existing inventory items
Don’t worry if you don’t have all this information now. You can still install and 
enter the information later.

2. Follow the order of the tabs in this guide.   

Upgrading from a Previous Version
• Select the Upgrade Prior Version tab for instructions specific to you

New Multi-Store Installations
1. Review the information on the Multi-Store tab. 
2. Gather the following information:

• The information shown for single-store installations
• Names, addresses and phone numbers for each store
• �Point of Sale license number and Store Exchange communication  

method for the Server Workstation at each store                   

3. Follow the order of the tabs in this guide.
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About Firewalls
Firewalls are an important part of an overall data protection 
strategy. With the latest updates, most major software 
firewalls will be automatically configured to allow Point of Sale 
operations. Likewise, the firewall included in Windows® XP/
Vista/7 is detected and automatically configured when you first 
run Point of Sale.
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Installing Point of Sale on the 
Server Workstation 
Choosing a Server Workstation
One computer in your store must be made the Server Workstation. This computer 
performs all Point of Sale activities, plus:

• Creates and stores the Point of Sale company data file
• Manages your Point of Sale registration and user licenses
• Connects to and exchanges data with QuickBooks accounting software
• �In a multi-workstation environment, it must be running to use Point of Sale  

on any workstation

To install Point of Sale on the Server Workstation:
1. Close all running programs, except Windows. 
2. Put the Point of Sale CD in your CD-ROM drive. 

• �If the installation doesn’t begin automatically, locate and double-click  
the setup.exe file on the CD 

3. Follow the onscreen prompts: 
• �Enter the License and Product numbers from the CD holder or provided to  

you by a sales agent 
• �Choose how many computers Point of Sale will be installed on at this location.  

If installing on only one computer, go to step 4.
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Installation

4. ����If prompted, restart your computer and then launch Point of Sale. 
Point of Sale will automatically install other required applications contained on  
the CD, if necessary. See requirements on back cover.

Creating Your Company Data
On startup, Point of Sale displays options for opening or creating a company data file. 

1. Select New Company File.

2. Enter a unique name for your company data and click OK.
• �If a multi-store installation, also enter your Store type, Headquarters or Remote 

and store number  
(Note: Install only one Headquarters store)

3.� �When prompted, select a workstation number  
(1 is suggested for the Server Workstation).

4. Click OK.

Point of Sale creates your company data file; which may take a few minutes. 
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Registering Point of Sale
Point of Sale must be registered on the Server Workstation or it will cease to 
function on the 6th day after installation.

1. When prompted, select Register Now. 
2. �Follow the instructions to register online (alternatively, you can register by 

phone).
After registering, your workstation type and license/product numbers can be viewed 
by selecting About Point of Sale from the Help menu. You will need to provide 
these numbers if contacting Intuit for support or to purchase additional user 
licenses. 

 
 
 

About Point of Sale Licensing
Point of Sale can be installed on multiple workstations using a single license number. 
However, in that case, only one of the workstations can run Point of Sale at one 
time. For multiple workstations to run the program concurrently requires multiple 
user licenses (additional licenses sold separately). 

With multiple user licenses, the Server Workstation acts as the “license manager,” 
checking licenses in and out to the other workstations. As many workstations can be 
using the program concurrently as you have purchased user licenses, up to twenty 
in a store. 

The Server Workstation must be running for any workstation to run Point of Sale, but 
only uses a license itself if it also has Point of Sale open. 

• �Instructions for adding Client workstations can be found on the Add 
Workstations tab

• �For additional information about Point of Sale licensing, search the in-product 
Help index by keyword “licensing” 

Benefits of Registering Point of Sale
You are encouraged to register Point of Sale promptly. Besides keeping your  
software functional, registration provides access to valuable online features.
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The Setup Interview is automatically launched and will help you configure basic Point 
of Sale options for your business.

Notes about the interview:
• �If you are not prepared to complete a page, skip it and come back later (select 

Setup Interview from the File menu)
• Most of the choices you make can be changed later
• �Use the Tell me more links on each page for answers to frequently  

asked questions
• �More advanced options can be set up later in either Company or Workstation 

Preferences (accessed from the File menu)

What’s important about interview pages?
Your Company
The company information you enter is printed on sales receipts and other documents 
created in Point of Sale.

Completing the Setup Interview  

Setup
Interview
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Sales Tax
If you charge sales tax, answer Yes and enter the total sales tax rate and the agency  
to which you make your tax payments.
 

  
 
 
 
 
 

Other Sales Tax Options
Point of Sale offers several advanced sales tax options, such as:

• Different rates based on item type, customer location or unit price thresholds
• Collecting and paying taxes to multiple agencies 
• Removing taxes on sales to tax-exempt customers
• And others to help you meet local taxing requirements

If you need to set up more advanced sales tax options, enter the tax rate you most 
often charge on this page and then, after completing the interview, set up other tax 
options in Company Preferences.

More information on sales taxes can be found on the Setup Inventory tab. 

Payments*
Learn about the Intuit Payments Account which allows you to easily accept credit  
and debit cards.

If you already have an Intuit Payments Account for your Point of Sale software,  
simply log in with your ID and password to link your account to your new software.

For more information, select the Payments or Gift Cards tab.

Gift Cards*
Learn about the Intuit Gift Card service which allows you to easily accept gift cards.

If you already have an Intuit Gift Card Account for your Point of Sale software,  
simply enter your account number to link your account to your new software.

For more information, select the Payments or Gift Cards tab. 
 
 
*Both services are optional, require application approval and additional fees apply.
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Connecting Hardware 
Point of Sale hardware is available directly from Intuit or you can purchase  
compatible hardware from other sources.

• �If you purchased hardware from a source other than Intuit, verify it is on the  
Point of Sale compatible hardware list and have any instructions or driver discs  
that came with the hardware on hand. The list is available online at  
support.quickbooks.intuit.com and enter INF16088 in the search box.

• �For detailed hardware connection instructions, refer to individual hardware  
setup guides.

Hardware Port Notes
• �Ensure you have the required number and correct type of computer ports for the 

hardware you are installing. For example, the USB hardware bundle sold by Intuit 
requires three USB ports.

• �If more USB ports are needed, purchase a powered USB hub. Check your  
computer manufacturer’s specifications for the correct type of hub to purchase.

• �Installation of some USB devices is specific to the port in which it is plugged at 
the time of installation. If you later move the connection to another USB port,  
your device may stop working. We recommend you make a note of the ports  
used and always plug these devices back into the same port.

Connect  
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The Hardware Setup Wizard is included as part of the Setup Interview and will walk 
you through connecting and configuring your hardware.

• �Do not connect hardware to your workstation until instructed to do so by 
the wizard

• �You can return to the wizard anytime from the Setup Interview.

To Set Up Your Hardware:
1. Select the Hardware tab from the Setup Interview

2. �For each piece of hardware you wish to set up, click on the setup button to 
launch the wizard. Follow the onscreen instructions to connect, configure and 
test each piece of hardware.

 
 
 
 
 
 
 

 
 

• �If installing non-Intuit hardware, you may be prompted to use the           
manufacturer’s CD. When done, return to the Setup Wizard and continue.

Configuring an Inkjet or Laser Printer
1. Select the Hardware tab from the Setup Interview.

2. �For printer installation, click on the Windows printer setup button to launch 
the wizard. Follow the onscreen instructions to connect, configure and test 
the printer.

The Hardware Setup Wizard 

What if my hardware stops working?
If your hardware stops working in the future, you can use the Hardware 
Troubleshooter to pinpoint the cause and get it working again.

From the Point of Sale Help menu, select Hardware Troubleshooter and  
follow the prompts.  

Co
nn

ec
t 

 
H

ar
dw

ar
e 



12

Getting Started Guide
The Setup Interview helped you to configure basic program options.  
The recommended next steps for your business are:

• �Set Up Inventory—create departments and add your vendors and 
inventory items 

• �Customize Point of Sale—add employees, assign security rights, set up  
sales tax options and define printing options 

• �Complete Routine Tasks—receive and sell merchandise, run reports and  
share data with QuickBooks accounting software

Use with QuickBooks Accounting Software
QuickBooks Point of Sale is designed to share data with QuickBooks  
accounting software.

If you are ready to integrate now, follow the steps in the QuickBooks  
connection wizard. The wizard can be found in the Financial Center under  
the Financial menu.

Next Steps   

N
ext Steps
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Do you have data you can import into Point of Sale?
Getting your vendor, item and customer records entered into Point of Sale 
is, without doubt, the most difficult challenge in getting up and running with 
Point of Sale. 

If you already have this information, Point of Sale can help make this 
unavoidable chore much easier and faster.

There are two ways existing data can be imported:
1. Import data from your QuickBooks accounting software1

2. Import data from an Excel spreadsheet or text file2

Select the Import Data tab to learn more about these options.
1	Works with any Intuit QuickBooks Pro or Premier (2009–2012) and Intuit QuickBooks Enterprise 	
	 Solutions (Version 9.0–12.0). Sold separately. 
2	Requires Microsoft Excel 2000, 2002, 2003, 2007 or 2010.
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Setting Up Inventory   

Planning your Departments
In Point of Sale, inventory is categorized  
into departments. A well-planned department 
structure helps monitor sales performance, 
manage inventory and run meaningful reports, 
allowing you to make informed  
buying decisions. 

Carefully planned departments will also save you data entry time and give you greater 
flexibility when conducting a physical inventory, modifying prices and printing tags.

Tips for planning your departments:

• �Adding departments should be the first task completed in setting up inventory; 
department tax codes and profit margins are automatically associated with new 
items added to the department.

• �There is no right number of departments. If you want to compare the performance 
of two groups of items, each should be assigned to its own department. On the 
other hand, having too many departments makes it difficult to consolidate data 
on your reports. 

Adding or Importing Vendors
Each vendor from whom you purchase merchandise should be set up in Point of Sale. 
As you add items in inventory, you associate them with a vendor, allowing Point of 
Sale to automatically add vendor account numbers, terms, and order costs to purchase 
orders and receiving vouchers and build a history for the vendor, easily viewed from the 
vendor record.

�If you have vendor records in another 
application or Excel spreadsheet, you 
may be able to import them to Point of 
Sale. Select the Import Data tab for 
more information.

Using Price Levels (Optional)
Each item can have a regular price and up to four alternate price levels, allowing you  
to offer different prices to qualifying customers.

If you plan to use price levels, define them now and Point of Sale will calculate the  
prices at each level for you as you add your items to inventory.

Setting up your inventory can help you maximize profit while minimizing your 
investment of time and money.

Set U
p

Inventory
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Sales Tax Options
During the Setup Interview, you entered one sales tax rate and the agency to which you  
pay sales taxes. If necessary, you can set up other sales tax options in company preferences. 
The sales tax codes, locations and taxing instructions you set up can then be associated  
with inventory items and customers, so the correct sales tax is collected on sales.
The Sales Tax page of company preferences opens with the help sidebar displayed:

Use the Add or Edit buttons to set up sales tax codes and locations and define taxing 
instructions for each.

• Sales tax codes allow you to collect tax based on what merchandise is sold
• �Sales tax locations allow you to use different taxing instructions for each tax code 

based on where the merchandise is sold or where the customer is located

Adding or  
Importing Items
Each item added to  
inventory must be unique  
in the combination of item  
type, department,  
description, size and  
attributes you enter.

Tips for entering items:
• For merchandise items, select Inventory as the item type
• Department and Item Name are required fields
• �If entering new items not yet received, leave the On-Hand Quantity field empty. 

Point of Sale will update this field
• �If using department margins to calculate prices, enter the item cost but leave  

price fields empty. Point of Sale will calculate the prices when the item is saved  
or received.

• �Press F1 on the item window to learn more about adding items
If you have existing item records in QuickBooks accounting software, an 
Excel spreadsheet, or a text file, Point of Sale can import those records for you.  
Go to the Financial Center from the Financial menu for more information.
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Importing Data  
Point of Sale offers two importing options that can greatly reduce your initial data 
entry time. Importing not only saves time, it also helps avoid data entry errors that 
can occur with manual entry. Using these tools, you can import existing customer, 
vendor and item records.

Using the Data Import Wizard
The Data Import Wizard can be used to import data you have exported from another 
software application, received from a vendor, or have in an Excel spreadsheet or text 
file (text files must be saved with the .csv extension). Point of Sale provides a default 
Excel template or you can custom map fields from your own file to the fields in Point 
of Sale.

1. From the Point of Sale File menu, select Utilities > Import.
2. �Follow the onscreen prompts to specify the type of data and file format for  

the import. 
• �Default Template: Enter (or copy and paste) your data to the appropriate 

columns of the template
• ��Custom File: Follow the onscreen instructions to indicate how the data will be 

imported to Point of Sale
3. Specify other import options, as available, and then start the import.

Additional information is included on the default template or can be accessed by 
selecting Help from within the wizard.  

Importing from QuickBooks Accounting Software

Importing from QuickBooks is enabled after you have established the connection 
between the two programs. Review the QuickBooks Integration tab for an overview  
of integration.

Importing QuickBooks vendors and customers
Active QuickBooks vendors and customers are automatically imported with every 
data exchange. 

• �If you do not want a customer or vendor imported, mark them as Inactive in 
QuickBooks before your first data exchange

• �After the initial exchange is completed, review the imported customer and vendor 
records and edit them as necessary to take advantage of Point of Sale 
features unique to each

• New or edited customers and vendors in either program are exchanged routinely

Im
port  

D
ata
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What’s important about importing items from QuickBooks?
•	 You can import all or just selected items
•	 After importing, all activities related to the imported items, such as  

ordering, receiving and selling, should be done in Point of Sale
•	 Imported item quantities, costs and prices are tracked only in Point of  

Sale, although your QuickBooks financial accounts are updated to reflect  
item transactions

•	 Quantities of imported items are “zeroed out” in QuickBooks
•	 Review the imported item records, and edit as necessary, to take advantage of 

Point of Sale inventory features 
•	 Select Help on the Import windows for more information

Importing QuickBooks items (optional)
Point of Sale will prompt you to import QuickBooks items until you do so or decline.

1. �Select to import when prompted or select Import Items Now from the 
Advanced Options page of the Financial Center.

2. �In the Item Fields window displayed, specify how you want to map the 
QuickBooks description fields to Point of Sale item description fields.

3. ��On the Item Selection window, specify if you want to import all items or 
selected items.

�Note: If you prefer to track some items in QuickBooks, such as non-resale items, 
don’t import them. 

4. ��If importing selected items, use the Select Items to Import window to specify 
the items.

• �Select or clear the checkboxes at the left. All selected items will be imported.
• Click a column header to sort the list by the values in that column
• �Use the Select All, Unselect All or Filtered View buttons at the bottom to help 

locate items and make selections
• Select Help for more information

5. Select OK to start the import.
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Upgrade Notes
Previous version remains intact. Your previous version and data remain intact 
after upgrading. However, you should enter new transactions only in the new 
version. You can safely uninstall the previous version, if desired.
Upgrade one workstation at a time. If you have multiple workstations, close 
Point of Sale on all and then upgrade the Server Workstation. Then install other 
workstations, one at a time.
Upgrade all workstations/stores to new version. Workstations not upgraded 
to this version will not be able to access the company data until upgraded. 
Review custom settings. Some settings (varies by previous version) may be 
returned to the default configuration to accommodate new features in this 
version. Review the following settings:

• �List columns and order. To reconfigure columns, right-click in a column 
header and select Customize Columns.

• Memorized reports. Reconfigure and rememorize.
• �Custom security groups. Employees in a custom group will not have access 

to new features until the group properties are updated.
Update Store Exchange settings. Multi-Store users must update their Store 
Exchange settings to reflect new license numbers and exchange folder paths 
for each store. 

Upgrading From a Prior Version  
of Point of Sale   
Preparing to Upgrade

• �Ensure you meet the system requirements for Point of Sale 2013 outlined at the end 
of this guide

• �Complete activities in your previous version:
✓ Settle any pending credit card/debit transactions
✓ �If applicable, conduct data exchanges with other stores and your QuickBooks 

accounting software
✓ Make a backup of your Point of Sale company data file
✓ �If you require passwords to log in to use Point of Sale, ensure you have  

a password assigned to the Sysadmin user; some activities in  
Point of Sale 2013 are restricted to this user

• �Do not uninstall your previous version before upgrading; if you have already 
uninstalled, you must insert the CD from the previous version when prompted

• �Update any installed firewall software to the latest release. Typically, this is done by 
right-clicking on the firewall icon in your task tray and selecting Check for Updates.

• �If changing your configuration in conjunction with this upgrade, such as adding 
workstations, stores, or integrating with QuickBooks accounting software, read the  
information on the applicable tabs of this guide before beginning

U
pgrade  

Prior Version
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1. Close all running programs except Windows.
2. ������Put the Point of Sale Upgrade CD into your CD-ROM drive.

�If the installation doesn’t begin automatically, locate and double-click the setup.exe file on the CD.

3. When prompted:
• Enter the License and Product Numbers from the CD holder or provided to you
• Select Server Workstation as the installation type

4. If prompted, restart your computer when the installation is completed.
5. Launch Point of Sale 2013.

���Your previous version is detected and you are prompted to convert it for use with the 
new version.

6. Click Yes to copy and convert your data. Enter a name for the new company file 
(can be the same as previous).
7. �On the window displayed, accept the suggested location for your previous data or 

browse to a different location and click OK. The conversion process may take some 
time, as Point of Sale builds the data necessary for new features.

8. If applicable, use your existing user name and password to log in.
9. �Register your new software when prompted; then select Manage My License > 

Synch License Data Online from the Help menu.
Synching your license data is necessary to update your company file with the number 
of user licenses you have purchased.

Upgrading Client Workstations
1. �Close Point of Sale on the Server Workstation, but leave the Server  

Workstation running.
2. �Follow the same procedure to install the upgrade to each client workstation, 

selecting Client Workstation as the installation type.
3. Restart your computer and launch Point of Sale 2013.
4. �Point of Sale will search for and connect to the company data on the Server 

Workstation. If more than one company data file is found, a list is displayed. Select 
the correct company data and click OK.

5. �If prompted, enter a workstation number and then your user name and password  
to log on.

6. �If prompted, follow the onscreen instructions to merge licenses with the Server 
Workstation. Select Help on the Merge window for more information.

On subsequent launches, Point of Sale will reconnect to the same company data from 
the Client Workstations.

Upgrading the Server Workstation
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Network

Adding Client Workstations   

Multi-Workstation Guidelines
Only one Server Workstation allowed. Additional workstations must be 
installed as Client Workstations. 

Install one workstation at a time. Point of Sale must be able to determine 
what workstation numbers are available and in use during each Client 
installation. Installing on multiple workstations at the same time could result in 
duplicate workstation numbers, which could cause data conflicts.

Same version/level required at all workstations. Workstations on the same 
network must be installed with the same version (e.g., Point of Sale 2013) and 
level (Basic, Pro or Multi-Store) as installed on the Server Workstation.

Server Workstation must always be running. For Clients to access the 
company data, the Server Workstation must be running (but not necessarily 
running Point of Sale). 

Point of Sale supports up to twenty networked workstations in a store, one Server 
Workstation and up to nineteen Client Workstations, which access the Point of Sale 
company data on the Server Workstation across the network.

Before beginning...
• �Make sure your computers are properly networked and meet the minimum system 

requirements (see end of guide). Consult a qualified network technician if you 
need assistance with your network.

• �Review the Point of Sale licensing information on the New Installation tab for 
information about when additional licenses are needed for multiple workstations

• �Install the Server Workstation and create your company data file. Close Point of 
Sale on the Server Workstation, but leave the computer running.

Server Workstation
•	 Program and company data files
•	 Database applications
•	 Communicates with QuickBooks 

accounting software
•	 Must always be running for any  

workstation to use Point of Sale

Client Workstation
•	 Program files
•	 Accesses company data 

across network

A
dd
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Installing a Client Workstation
1. Close all programs except Windows on the computer being installed as a Client.
2. Put the Point of Sale CD in your CD-ROM drive. 

�If the installation doesn’t begin automatically, locate and double-click the setup.exe file on the CD. 
3. Follow the onscreen prompts to install the program files to your computer: 

• �Enter the License and Product numbers (from CD holder or provided to you  
by a sales agent)

• Select Add Client Workstation as the installation type
• �Accept the default installation folder (recommended). Do not install  

to the Server Workstation over the network.
4. If prompted, restart your computer.

To connect to the company data:
1. �Ensure the Server Workstation is running and then start Point of Sale on the  

Client Workstation.

2. �Point of Sale searches your network and locates the company data on the Server 
Workstation. If one company data file is found, you are automatically connected  
to it. If multiple company data files are found, a list is presented; select the correct 
file and click OK.

3. When prompted, select a workstation number for this computer.

4. �Use the Hardware Setup Wizard to install hardware connected to this workstation. 
See the Connect Hardware tab.

Merging and Synchronizing Licenses
If you entered a unique license number for the Client installation, you will be prompted 
to merge the license with the license on the Server Workstation. You have 5 days to 
complete the merge, after which time only one workstation will be able to run Point  
of Sale at any one time.

After merging, the Server Workstation synchronizes its license with Intuit’s online 
licensing servers. Once done, both workstations can concurrently run Point of Sale.

To merge and synchronize licenses: 
1. When prompted to merge, select Merge Now. 

2. Follow the onscreen prompts or phone agent’s instructions to complete the merge.

3. On the Server Workstation, synchronize with Intuit’s licensing server.
• �If Server is connected to the Internet and has previously registered, this  

is completed automatically. If not connected or not registered, select  
Manage My License from the Help menu and then:

a) �To register/synchronize online: Select Synch License Data Online Now 
and follow the prompts, or 

b) �To register/synchronize by phone: Select Buy A User License and call  
the number displayed
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Getting Around in Point of Sale   
Shown below is the Point of Sale Home page Navigator  
(Pro level).

Side toolbar can be customized 
for easy access to your most 
common tasks.

The Employees section helps  
you manage employees  
(optional).

Quick Find allows you to search for  
items, receipts, help and more.

The Navigator provides an  
overview workflow and clickable 
links to common tasks.

G
etting 

A
round

Standard menu provides access 
to all areas and features.

Items List helps you manage 
your inventory.

Report Center helps you  
manage your business with  
an extensive list of reports.
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Messages area allows you to 
post your own notes.

Getting Around in Point of Sale (Cont.)   

Make a Sale allows you to ring 
sales, take payments and print 
receipts.

Temporarily put a sale on hold 
and then come back and finish 
it later.

In Progress helps you  
multi-task by toggling 
between open documents.

Preferences helps you manage 
the various settings and options 
in your software.

End of Day helps you close out 
your cash drawer and balance 
against sales.

Mobile Sync allows you to share 
your items with your mobile devices 
and make sales wherever, whenever. 
(Intuit Payments Account required).
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Working with Lists   
New records and documents are added in a form, but upon saving are added to the 
corresponding Point of Sale list

I want to... menus provide access to other 
tasks related to the current  window.

Click any column header in a list or report to re-sort the list by the 
values in that column.  Click it again to sort in reverse order.  Right-
click a column header and choose Customize Columns to add or 
remove columns.  Drag columns to rearrange.
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Working with Lists (Cont.)   

Press F1 or select Help 
for assistance with your 
current task.

The View selector allows you to 
change the records currently displayed 
by selecting from predefined options.

Enter search keywords 
here to filter lists.

Action buttons let you quickly edit 
the current item or add a new 
item.  Actions vary in other lists.

To return the full list view click 
on the Hide Detail button.

Sync to Mobile allows your item 
to be shared outside your store 
using Mobile Sync (requires an 
Intuit Payments Account).
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Sales Receipt

Look up customer information 
and assign them to the sale.

Once you have taken the payment, click on the 
Print Receipt button to complete the transaction.

Scan barcode or enter item information 
here to add to the receipt.

Make changes to the selected item 
using the available buttons.

Side toolbar can be customized for easy 
access to your most common tasks.
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Intuit Payments and  
Gift Card Services 

With an Intuit Payments Account you can accept 
all major credit and debit cards as well as add 
Gift Card Services for your business.*

Accepting Credit, Debit and Gift Cards

Key Benefits
No credit card terminal needed. Use our optional credit card reader and data is 
entered right into your Point of Sale software.* This reduces the many hidden 
(or “unknown”) costs of using a credit card terminal, including:

• Double-entering information into both a terminal and your software
• Zeroing-out a terminal every day
• Reconciling discrepancies between your terminal and your software
• Maintaining a second phone line
• Leasing a terminal

Get better information about your business and customers

When you use an Intuit Payments Account, your QuickBooks Point of Sale 
software will automatically capture transactions, approval code, type of card 
and credit card number for each transaction. Use this information to better 
understand your business and provide better service to your customers.

* Integrated credit and debit card processing requires an Intuit Payments Account. 
Integrated gift card processing requires an account with Intuit Card Service. Both services 
are optional, require application approval, and fees apply. Optional credit card reader 
required for lowest discount rate available, sold separately. PIN pad to accept PIN debit 
transactions required, sold separately. See the end of this User Guide for additional 
requirements.
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FAQs
Can I use my current merchant service? Yes. You will process payments 
separately through your credit card terminal and then must manually record 
them into Point of Sale. You will not benefit from integrated authorization, 
settlement and reporting and risk higher chances of data entry error. 
Do I need special hardware? A card reader is recommended to speed credit  
and gift card processing and qualifies you for a lower rate on credit card sales. 
Other hardware is available, including a PIN pad for PIN Debit transactions,  
a signature capture device and a card reader/PIN pad combination. All are 
optional and sold separately.  
Do I need a separate phone line? You have two connection options:  
1) Internet connection, which eliminates the need for a separate phone line, or  
2) by direct modem connection, in which case a dedicated phone line is required.
What kind of support will I get? Live customer support is available via phone 
24/7/365* for your merchant service account. You can also manage your account 
online for free through our Merchant Services Center. 
* Subject to occasional downtime due to systems and server maintenance.

What if I have multiple stores? You will need to set up separate merchant  
and gift card accounts for each store location. Discounts are available. 
Call 1-877-672-7040 for details.

Key Benefits (Cont.)

With Intuit Transparent Pricing, you don’t have to worry
• �From Intuit, the makers of QuickBooks and TurboTax software
• You get a competitive discount rate
• There are no hidden fees (e.g., statement fees, cancellation fees) 
• �There are no contracts—you can cancel at any time

With Intuit Gift Card Service you can automate gift card acceptance and redemption.

Mobile Sync

With an Intuit Payments Account you can accept payments on your mobile device and 
automatically update your Point of Sale software. By checking the Sync to Mobile box 
on your Item Details in Point of Sale, your items will seamlessly appear on your mobile 
device to sell wherever, whenever. You can then make sales away from your business 
with the confidence that your data is correct. When you view the sales receipts you will 
see the the sales you made on your mobile device within your Point of Sale software. 
Adding new items from your mobile device is easy, and you will also see those appear 
in your Point of Sale software. To learn more, refer to the Help menu and the Mobile 
Sync icon on the Navigator.
*Requires an Intuit Payments Account, as well as a supported mobile device; visit  
www.GoPayment.com for more details about the mobile solution.
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Configuring Intuit Payments and  
Intuit Gift Card Services
Once you are approved and create your Intuit login via the link in your welcome  
email, you’ll need to configure Point of Sale for transaction processing.
1.	 Select Setup Interview from the File menu. 
2.	 Select the Merchant tab.
3.	 Select login and enter your account info (the email address and password  
	 you created earlier).
	 •	Select the appropriate associated profile.
4. 	 Once you have signed in correctly, the tab will indicate that your Intuit Payments  
	 Account is linked.
 
 
 
 
 
 
 
 
 
 
 
 
 
5. 	 Select Payments Preferences to configure other payments options. 
6. 	 (Optional) Navigate to the Gift Cards tab and enter the gift card account number  
	 that you received after signing up for Intuit Gift Card Service.
 	 •	Note: You can only accept gift cards in QB POS 2013 if you also have an 		
		  Intuit Payments Account 
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Protecting Credit and Debit Cardholder’s Data
Point of Sale provides a separate Implementation Guide to help 
you comply with the requirements of the Payment Card Industry 
Data Security Standard. 

Select User Guides from the Help menu to access this important 
information.

Configuring Intuit Payments and 
Intuit Gift Card Services (Cont.)

7. 	 Select Communication Setup from the left-side menu. 
8. 	 Select Use this computer... if you want all communication to the service(s)  
	 to connect through this workstation. 
	 •	If this setting is grayed out, communication is already configured to go through  
		  this workstation. To change to another workstation, access this setting from that  
		  workstation.
9.	 Select Secure Internet Connection or Direct-dial (modem) as your 		
	 communication method.
	 •	If you need assistance, select Internet Connection Setup. Internet connection  
		  requires you have an Internet Service Provider (ISP). A high-speed, always-on  
		  connection is recommended (such as DSL or cable).
10.	 Accepting PIN Debit payments also requires that a PIN pad be installed.  
	 Refer to the Connect Hardware tab for installation instructions.

30
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Setting Up Multiple Stores    
Review this information and then follow the setup procedures in this guide at each 
store, starting with your Headquarters store.

Overview
With the Pro level of Point of Sale, you can effectively manage up to twenty stores 
from one location, with features like centralized purchasing, transfers of merchandise, 
exchange of information between stores and company reporting. The managing 
location is called the Headquarters and all other stores are remote stores.

All stores share one inventory, but Point of Sale tracks item quantities by store and, 
if integrated with QuickBooks Accounting software, profit and loss by store can be 
tracked using the class tracking feature.

Store Exchange
The exchange of information between remote stores and Headquarters is called 
Store Exchange. Store Exchanges are done through the Server Workstations in your 
stores via one of five methods:

• Desktop email, using your default Windows email client
• Web-based email, such as Yahoo!® Mail and MSN Hotmail®

• Removable media, such as a USB memory stick
• Network file transfer over a VPN, WAN, or LAN
• Exchange over the Internet with the Intuit Service (fees apply)

To learn more about how a multi-store configuration works, see in-product Help.

Choosing a Headquarters Store
Selection of a Headquarters is important, because only Headquarters:

•	 Can add, edit or delete items, departments and vendors
•	 Set or edit item prices (remote stores can give discounts)
•	 Create regular purchase orders (remotes can do special orders)
•	 Consolidate data from all stores and run company reports
•	 Define company-wide preferences
•	 Enter transactions for other stores
•	 Exchange data with QuickBooks accounting software
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M
ulti-Store

Install and Configure at Headquarters
1. �Follow the New Installation instructions to install the Server Workstation,  

create your company data (select Headquarters as Store type) and start the 
Setup Interview.

2. �Select Preferences > Company from the File menu. In the Multi-Store section 
select the number of stores and enter information for your first remote store:
• A 1–3 character store code and a store name
• A communication method for sending Store Exchange files to the store
• The Point of Sale license number from the remote Server Workstation
• �Email address, removable media drive or port, or file transfer path for the 

selected method
3. Repeat for each remote store.
4. �Select Change Password and enter a password to encrypt Store Exchange files. 

This same password must be entered when setting up each remote store. 
5. �Set up departments, sales taxes, price levels, etc. as needed and enter or  

import items, vendors and customers. Refer to the other tabs of this guide  
for instructions. 

6. �When Step 5 is done and after remote stores have installed, select Store 
Exchange > Send Files from the Stores menu to send each remote store  
a file with your company data (inventory, preferences, etc.).
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Install and Configure at Remote Stores
1. �Follow same procedure as Headquarters to install a Server Workstation, except 

choose Remote Store as the store type.
2. �Select Preferences > Company from the File menu and enter the requested 

information for the Headquarters Store.
3. �Select Store Exchange > Receive Files from the Stores menu to process the initial 

Store Exchange file from Headquarters. 
4. �Select Preferences > Company from the File menu and review store-specific 

settings, such as the default tax location and default price levels for your store.

You now have access to inventory and can carry out all normal Point of Sale activities. 
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Integrating with QuickBooks®  
Accounting Software     
Overview
Point of Sale is designed to be integrated with QuickBooks accounting software.* 
Point of Sale tracks your daily retail activities: purchasing, receiving, sales and related 
inventory activities, while your financial software tracks your financial information.
Exchanging data between the two programs, referred to as Financial Exchange, can 
significantly reduce your workload because you can transfer your daily Point of Sale 
transactions to your financial software and, if you already have existing data in your 
QuickBooks accounting software, it can be imported into Point of Sale. 
Several options are available to customize the way data is exchanged between the 
programs, such as the account mappings, level of detail and data formatting.
You do not have to integrate the programs immediately; integration can be 
accomplished at any time in the future, if preferred.
For more information about how data is exchanged, search the in-product Help index 
using keyword financial exchange.

Q
uickBooks

Integration

* Requirements of Integration
• �QuickBooks Pro or Premier (2009–2012) or Enterprise Solutions (9.0–12.0), sold separately
• QuickBooks accounting software company file set up and configured for exchanges (see below)
• If applicable, a properly configured network with mapped drives as appropriate

Typical Network Configuration:

Point of Sale Server Workstation
• Point of Sale program and company file
• Financial program and company file
• Typically in back office

Point of Sale Client Workstation
• Point of Sale program files
• Typically at front register

Network
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QuickBooks Installation Options
1. �QuickBooks installed only on the Point of Sale Server Workstation. Only 

option if you have only one workstation and the typical choice on a network.  
The Point of Sale Server Workstation and QuickBooks could be in a back office  
or at a front register.

2. �QuickBooks installed on both the Point of Sale Server Workstation and 
another networked computer. Typical when the Point of Sale Server Workstation 
is at a front counter, but you want your QuickBooks financial file in a back office; 
the copy of QuickBooks on the Server Workstation does not have to be run there.

3. �QuickBooks installed only on another networked computer (not on the  
Point of Sale Server Workstation). This more advanced option, called Remote 
Data Sharing (RDS), uses server and client applications to send information across 
your network.

For more information, search the Point of Sale in-product Help index using keywords 
financial exchange, installation options.

Division of Activities after Integration

Activity
 

Add & track inventory items	 ✓	
Order & receive merchandise	 ✓	
Ring up sales & collect sales tax      	 ✓	
Point of Sale reports	 ✓	
Add customers & vendors	 ✓		  ✓

Track cost of goods sold & expense             			   ✓                 
Pay bills & sales tax			   ✓

Invoice customers			   ✓

Process payroll			   ✓

Financial reports			   ✓

Banking activities			   ✓

Q
ui

ck
Bo

ok
s

In
te

gr
at

io
n

QuickBooks
Point of Sale

QuickBooks 
Accounting Software



36

Preparing your QuickBooks Company File
1.	If necessary, install QuickBooks according to one of the options above and begin 
	 a new financial company file, following the instructions included with QuickBooks.
2.	Ensure your QuickBooks company preferences (from the File menu, select 		
	 Preferences) are set as follows:

• �Integrated Applications: Ensure the checkbox for Don’t allow any application 
to access this company file is NOT selected.

• �Purchases and Vendors. Ensure the checkbox for Inventory and purchase  
   orders are active is selected
• Sales Tax: Click Yes if you collect sales tax

3.	From the Company menu, select Chart of Accounts and ensure that the  
	 following accounts are present. Select Account > New and add them  
	 if necessary:

Connecting to QuickBooks Accounting Software
You can establish the connection with QuickBooks by selecting Financial Center 
from the Point of Sale Financial menu. QuickBooks must be running and your 
financial company file open during the initial connection.

Account Name	          	 Account Type

Cost of Goods Sold	         	 Cost of Goods Sold

Accounts Payable	         	 Accounts Payable

Accounts Receivable	         	 Accounts Receivable

Undeposited Funds	         	 Other Current Asset

Inventory Asset	         	 Other Current Asset

Sales Tax Payable	         	 Other Current Liability
Q

uickBooks
Integration
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Help and Support Resources     
Point of Sale offers both self-help and assisted support to ensure you can find the 
answers you need!

Self-Help Options
Quick in-program help for your current task:

• Press F1 on your keyboard
• Select the Help button on a window or message
• Click a blue help text link

For more information:
• Select Help Contents from the Help menu
• �Browse through the “books” in the Table of Contents on the left side of the  

Help window
• Click on the Index or Search tabs and enter a search keyword
• �Select Help & Support from the Help menu for a full listing of online and phone 

support options
• �Select Help and Learning from the Help menu for addition support including 	

a Glossary of Terms

Self-Help Resources: (Internet connection required)
• �Select User Community from the Help menu to connect with other Point of Sale 

users and experts to ask questions and share advice 
• �Visit www.quickbooks.com/support to search our Knowledge Base of frequently 

asked questions, learn about available updates or research other support options
• �Select How-To Videos from the Help menu to access videos that will guide you 

through the basics
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Get help from an expert or find a local resource to help you install, set up 
and use Point of Sale.

30 Days Free Support
Free QuickBooks Point of Sale Support included for 30 days by calling 1-800-348-0254.

Please note:
• �FREE 30 consecutive days support begins on the date of product registration 
• �You must register within 90 days after the date of purchase 

Support Plans*	
Intuit offers a variety of support plans, providing expert assistance 
when and as often as you need it; one-time or for an unlimited 
number of issues. (Fees apply.)

Learn more about QuickBooks Support Plans at  
pointofsale.intuit.com and click on Support.

Already have a Support Plan? 
Call us directly at 1-800-348-0254 to get expert assistance. 

Find a Local Expert 
Get local, onsite help from an expert certified by Intuit on Point of Sale. 
(Fees apply and are set by the expert.)

Certified Point of Sale Intuit Solution Providers are your local  
retail business and technology experts that can help you with any  
retail technology questions.  
Visit: Intuitsolutionproviders.com

Certified QuickBooks Point of Sale ProAdvisors® can provide 
accounting advice tailored to your business needs. 
Visit: www.FindAProAdvisor.com

Sales Specialists
To get information about additional products, services or hardware available for your 
Point of Sale system, call 1-866-379-6636.

Assisted Support Resources   

*	Fees, hours of operation and terms and conditions apply and may vary for assisted support options.  
  	Visit pointofsale.intuit.com for details.

H
elp and  

Support
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How are we doing?
You are the retail expert and the Point of Sale team wants to hear from you. How 
can we improve the product to better meet your needs? Find a program bug? Is help 
not helping? Let us know! While we can’t promise a personalized response to every 
submission, we do read all feedback and use it to improve future releases of Point of 
Sale.

• �Select Send Feedback from the Help menu, choose a category and enter your 
comments or suggestions

Did you know you can...?
• Add your store logo to printed sales receipts
• Add, remove or rearrange the order of columns in lists
• Rename item description fields to better reflect the merchandise you sell
• Customize the main toolbar with the task buttons you use most
• Restrict employee access to features or sensitive data
• And select from many other customization options

To learn more, from the Help menu select Help Contents and explore the options  
in the Customizing Point of Sale folder.

Quick Tips
• �Point of Sale allows you to open multiple windows at one time. You can view, 

switch between or close all open windows at one time from the Windows menu.
• �Keyboard entry is often the fastest way to navigate the program. From the Help 

menu, select Keyboard Shortcuts to view a list of the keyboard commands for 
your current area.

• �When working in Point of Sale lists, many frequently used tasks can be quickly 
accessed by right-clicking in the list

• �Lists can be sorted by another value by clicking the column header for that value. 
To sort a list by multiple values, from the View menu select Sort List > Sort on 
Multiple Columns.

Protecting Your Data
Your company data is valuable and you should take steps to protect it.  
We recommend at a minimum that you:

• Install and keep up-to-date anti-virus and firewall software
• �Make daily backups of your data, preferably to removable media that you  

store off-site

Assisted Support Resources (Cont.)      

Helpful Tips     
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Protecting Your Data (Cont.)

• Assign and require passwords for employees to log in 
• �Install an uninterruptible power supply (UPS) and reboot your computers at  

least once a week; power losses and infrequent rebooting can lead to corruption  
in any database

For more information, browse the topics in the Working with Company Data  
folder in The Basics area of the in-product Help contents.

Tips for Lists
• �Perform basic operations, such as printing, deleting, or adding items to a document, 

on multiple list records by selecting them all before choosing an action:
• Hold down your Ctrl key and click each record to select
• �To select a series of records, click and hold your left mouse button down on the 

first record and drag to the last record OR hold down the Shift key and click the 
first record and then the last record

• �To select all displayed records, press Ctrl+A on your keyboard

Why Is a Feature Unavailable to Me?
If there is a feature you would like to use, but you are unable to access, it could be for 
any of the following reasons:

• Feature doesn’t apply to your level of Point of Sale
• You don’t have the security right to use the feature
• The feature is disabled in company preferences (access from Edit menu)
• �A necessary field or button is not currently displayed in a list or on a taskbar to 

complete the task

For more information, explore the options in the Customizing Point of Sale folder 
from the in-product Help contents.

For your convenience, write down your important Intuit numbers here:

Point of Sale License Number_____________________________________________

Point of Sale Product Number_ ____________________________________________

Intuit Payments Account Number__________________________________________

Intuit Gift Card Account Number _ _________________________________________

Tips and  
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Point of Sale 2013 
System Requirements     
Recommended Configurations:

• �At least 2 GB of RAM for a single workstation installation
• �1 GB of disk space (additional space required for data files)
• �Optimized for 1024x768 screen resolution
• �Operating Systems: 

Microsoft Windows XP, all editions (SP3 or later strongly recommended) 
Windows Server 2003 
Windows Vista, all editions (SP2 or later strongly recommended) 
Windows Server 2008 (SP1 or later strongly recommended) 
Windows 7

• �Data import/export and Microsoft Office integration requires: 
Microsoft® Excel 2000, 2002, 2003, 2007 or 2010 
Microsoft® Word 2000, 2002, 2003, 2007 or 2010

Multi-user recommendations:
• �Multi-core processor and 4 GB of RAM are recommended for better performance 

on the Point of Sale server workstation.
• �In a multi-user configuration, each workstation concurrently running Point of Sale 

must have a separately purchased user license, and every copy of Point of Sale 
must be the same version and level.1

Intuit QuickBooks Point of Sale Merchant Service: (sold separately)

• �Optional fee-based service, additional terms and conditions apply
• �Requires an Intuit QuickBooks Point of Sale Merchant Service account through 

Intuit Payment Solutions, LLC. Application approval and fees apply. Details 
available at www.payments.intuit.com/posms.

• PIN pad required for debit transactions, sold separately.
• �Internet connection required

Intuit QuickBooks Point of Sale Gift Card Service (sold separately)

• �Optional fee-based service, additional terms and conditions apply. Requires a 
gift card account through QuickBooks Point of Sale Gift Card Service, provided 
by Intuit Payment Solutions, LLC. Application approval and fees apply. Details 
available at www.payments.intuit.com/posgcs.

• �Requires QuickBooks Point of Sale Gift Card Service gift cards, sold separately
• �Internet connection or modem required
• �Service is independent of QuickBooks Point of Sale Merchant Service 
• �Optional card reader and receipt printer sold separately or available with 

QuickBooks Point of Sale Software/hardware bundle
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1  ��Applicable to the Server Workstation when multiple networked computers concurrently run Point of Sale.

© 2013 Intuit Inc. All rights reserved. Intuit, the Intuit logo, QuickBooks, Quicken,  
TurboTax, Lacerte, ProSeries, Simple Start, EasyStep and QuickZoom among others,  
are registered trademarks and/or registered service marks of Intuit Inc. or one of  
its subsidiaries. 
Contains images ©Microsoft Corporation.  
Contains images RoboHelp ©2005 eHelp Corporation.
Contains Sybase Central Copyrighted ©1989–2005, Sybase Inc. with portions Copyrighted 2002, iAnywhere 
Solutions, Inc. The Software contains Adobe® Flash® Player software by Adobe Systems Incorporated, 
Copyright ©1995–2006 Adobe Macromedia Software LLC. All rights reserved. Adobe and Flash are 
trademarks of Adobe Systems Incorporated. The software contains components from Anders Melander. This 
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.
openssl.org/).

 
QuickBooks Accounting Software integration requires: 
	 • �Intuit QuickBooks Pro or Premier 2009–2012

• �Intuit QuickBooks Enterprise Solutions Versions 9.0–12.0

Security Software:
• �Products have been tested with the following software:

-McAfee Internet Security Suite 
-Symantec Norton® Internet Security Suite 
-Zone Labs’ Zone Alarm Pro 
-Trend Micro

Note: Some configurations may require that you adjust settings in firewall and  
anti-virus products to ensure the best possible performance with Point of Sale.

System Configuration Notes:
• �Disk space requirements do not include company data files. If your company data 

file is very large or includes item pictures, you may need more disk space.
• �In order to run several applications simultaneously, your system should have a 

multi-core processor and at least 2 GB of RAM. Point of Sale will run on both 32-bit 
and 64-bit processors running Windows. However, not all hardware devices will 
install and operate on 64-bit operating systems. We recommend that you contact 
the device manufacturers for more information about installing their hardware 
devices on 64-bit operating systems.
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Welcome to Point of Sale! 
  
QuickBooks Point of Sale (Point of Sale) is an advanced inventory control, sales, customer tracking, and reporting 
solution designed for effective management of retail stores. As you order, receive, and sell merchandise, your 
inventory quantities and costs are instantly updated. 
At a glance, you can view item quantities on hand and on order; review costs, prices and margins; and view 
detailed reports on sales and merchandise activity. You can track customers and use the resulting purchase history 
information to customize promotions, mailings and other marketing materials. At the end of your business day, 
Point of Sale will help you reconcile your cash drawer, settle credit card transactions (optional fee-based service), 
backup your data files, and, if applicable, send the day's transactions to your QuickBooks financial software. 

Are you new to QuickBooks Point of Sale? 
If so, we suggest you visit these topics to learn the basics: 
Completing routine tasks 
Using this help system 
Getting additional help 
What's new in this version? 
Terminology used in Point of Sale 
How to purchase supplies: tags, labels, or receipt paper 
Free resources for starting and growing your business 
  
To view how-to and informational  videos on QuickBooks 2013 Point of Sale, 
click here.  
  
For immediate help on your current task, press <F1> on your keyboard or select Help on this Window from the 
Help menu. 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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New Features in QuickBooks Point of Sale 2013 
 
The following is a list of new features and enhancements introduced in this version; many as a direct result of 
customer requests. 
Note:  To view how-to and informational  videos on QuickBooks 2013 Point of Sale, click here.  
  
What's New? 
  
Detailed sales and inventory reports let’s you know what is selling and what is not 

• Instant reports can show you top selling products, best customers and sales data for any time period you 
choose. 

• Save inventory tracking time.  No manual tracking—your inventory is updated with every sale, order, and 
return. 
 

Instantly view what’s in stock, what’s hot, and what needs to be reordered 

• Set reorder points and automatically generate purchase orders so you never run out of inventory and lose 
a sale. (Pro version) 

•  For even more control, you can track layaways, sales orders, serial and UPC codes. (Pro version). 
Automatically track and reward your best customers 

• Use the customer center to easily access your customers contact information, like birthdays and last item 
purchased. 

• Keep customers coming back with loyalty programs, gift cards, personalized email reminders, updates, 
and specials. 

Never miss a sale whether you are on the road, or have a long-line in your store  
• With the new mobile sync feature, you can accept credit cards on your smart phone or tablet. 

• All sales and inventory information syncs with QuickBooks Point of Sale 2013. 

Activate your integrated payments account to save time and increase sales 

• Ring up sales in your store or on-the-go and know that all information automatically syncs with QuickBooks Point of 
Sale 2013.  

• An integrated payments account eliminates the hassles of manual data entry and reconciliation. 

If you are a QuickBooks user, all your information automatically syncs with your QB financial software 

• Transfer data to QuickBooks Accounting software with just a click. No worries about data entry errors from retyping 
data.  

•  Be better prepared at tax time. 
 

Key Improvements include:  

• Better navigation and design 

• Improved Welcome screen featuring Getting Started video tutorials 

• Faster and simpler payments activation 

• With the Quickbooks Point of Sale Mobile Sync feature, our free GoPayment app, and an Intuit Payments 
Account, make sales any time, any where, and on-the-go 

• Improved Quick-Pick functionality allowing you to better create and manage Groups, add items, and view details 

• New In-Progress drop-down menu lets you see and instantly go to unfinished and pending tasks 

• Enhanced customization on the Task button panel gives you more control 

• Collapse and expand the Messages and Task panels as needed.  

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
http://gopayment.com/
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To view how-to and informational  videos on QuickBooks 2013 Point of Sale, click here.  
  

  

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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Get Started 

Setup Interview 
Help and Support | How Do I? 
  
The first time Point of Sale is started on the Server Workstation, the Setup Interview window is automatically 
opened. The interview is the fastest way to set up basic Point of Sale options in one place so you are ready to 
begin ringing up sales fast! 
Not all options are defined in this initial setup. Advanced options that help you customize Point of Sale for your 
unique business needs can be set up later in company preferences. 
  

The Setup Interview allows you to define: 
Printed receipt – Enter the company information you want printed on sales receipts including phone numbers, web 
site, and email address. This information is also printed on orders and reports. 
Sales tax – Specify if you collect sales tax and, if so, enter your primary sales tax rate and to whom the taxes are 
paid. You can set up more advanced sales tax options, such as different taxing instructions by merchandise type, 
price, or location, or paying taxes to multiple agencies later in company preferences. 
Payments  – Learn about and sign up for a QuickBooks POS Merchant Service account to process credit card and 
debit/ATM transactions from within Point of Sale. If you already have an account use this page to enter your 
account number and set service options. 
Gift Card  – The QuickBooks POS Gift Card Service allows you to sell, redeem, and track the balance of gift cards 
from within Point of Sale. An Intuit Payments Account is required.  
Hardware –  Click Configure/Setup for the Point of Sale equipment you have. The Hardware Setup Wizard will 
walk you through configuring and testing each piece of hardware. 
  
You can return to the Setup Interview at anytime by selecting it from the File menu. 
  
Learn more 

Hardware Setup Wizard 
Hardware Drivers  | Compatible Hardware | Troubleshooting 
  
The Hardware Setup Wizard is launched automatically when you configure hardware in the Setup Interview to 
guide you through connecting and configuring hardware to work with Point of Sale. If you add hardware in the 
future, you can manually access the setup wizard from the File menu or from the hardware configuration pages in 
workstation preferences. 
Important: Do not connect hardware to your computer until instructed to do so by the wizard. 

To use the Hardware Setup Wizard: 
1. If installing hardware purchased from Intuit, put the Point of Sale CD in your CD-ROM drive 
(cancel the installation wizard if it launches). 
2. Click Next after reading the welcome page. 
3. Select the type of hardware you are installing. 
4. Select Next and follow the on-screen instructions to connect, set up, and test each piece of 
hardware. 

  

Notes: 
• If installing non-Intuit hardware, you may be prompted to use the manufacturer’s CD or instructions to 
install the device. When done return to the setup wizard and continue. 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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• Since Windows, Software and Hardware are constantly changing, the driver you need may not be on the 
CD.  To find the most current driver, go to www.quickbooks.com/support and search for Hardware 
Drivers.  You should see a link for the tested drivers as well as instructions for installation. 

Related Topics 
About connection ports 

Home Page 
Keyboard Shortcuts | Mouse & Touchscreen 
  
The Point of Sale Home Page provides access to program areas, analytical tools, and assistance in setting up and 
learning to use Point of Sale. In most cases, you return to the Home Page anytime you want to start a new task. 
 The Home button, located at the top-left of all Point of Sale task windows will bring you back to the Home Page at 
any time.  
Here are the main features of the Home Page:  

• The Navigator is a graphical representation of the work flows used  to perform routine retail tasks. Click on 
any enabled icon on the Navigator to go directly to the screen for the selected task. The Navigator is 
divided into four sections: 

• Point of Sale 

• Purchasing 

• Employees 

• Operations (vertical section on the right)  

• To the left of the Navigator, are buttons for commonly used tasks. These left navigation buttons can be 
changed by doing a right-click just below the buttons and then click on Customize Buttons. 

• If you turn off a feature in company preferences, the related menu choices and icons are removed from 
the Home Page. 

• The In Progress field at the top of the Home page provides a drop-down list that displays tasks that you 
are currently working on. By making a selection from this drop-down list, you will be taken directly to the 
work area for that particular task.  This allows you to more effectively multi-task.  

• Use the pull-down text menus at the top of the screen to access other tasks. 

• Use the Quick Find Search field to look up a customer, item, or sales document directly from the 
Navigator window. 

• To the right of the Navigator is the Message Board, displayed on the Home Page and accessible from the 
receipts, inventory, receiving, and customer areas, allows you to leave notes for yourself or other 
employees. Point of Sale will also post messages for you when something needs your attention, such as 
inventory reminders.  Use the Search message to find a specific note.  

• Click the cloud icon to sync to Mobile or to check on sync preferences and activity.  

• Click the monitor icon at the top right to expand your screen view. Click again to decrease the view.  

• Select Home from the top of the screen to return to the Home Page at any time. 

Note:   The icons and activities available on the Home Page will vary depending on the level of Point of Sale you 
have purchased, the features you are using, and your assigned security rights. 
  
Related Topics 
Customize the navigation toolbar 
Home Page Dashboard 
Point of Sale Basics 

About Server and Client Workstations 
Install Additional Workstations | Networking Issues 

Basic  

http://www.quickbooks.com/support
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Within a store, QuickBooks Point of Sale can be run in Single User Mode (one workstation) or Multi User Mode (up 
to 20 networked workstations). In Multi User Mode, all the workstations have simultaneous access to the program. 
The most powerful computer should be the Server Workstation and holds the company data file with up to nineteen 
Client Workstations connecting to the server. A separate user license (or seat) must be purchased for each 
workstation requiring simultaneous access. 
From the Home screen, you can view your current workstation type and number by selecting Help and About 
Point of Sale. 
  

About the Server Workstation 
Typically the first workstation to which you installed Point of Sale. If you are in Single User Mode, your workstation 
is a Server Workstation. Only the Server Workstation: 

• Creates and holds your point-of-sale company data 

• Can back up, restore, or rename the company data 

• Exchange information with QuickBooks financial software 

• Import data via the Data Import Tool 

• Set item and customer ranking preferences 

• (Pro) Exchange information with other stores 
Only one Server Workstation can be installed on a network. 
Important: The Server Workstation must be running for Client Workstations to have access to the Point of Sale 
data. (Point of Sale does not have to be open on the Server Workstation.) 
  

Client Workstation 
Any networked workstation that is not a Server Workstation is a Client Workstation. Client Workstations access the 
Point of Sale company data across the network. 
  

Switching Between Single User and Network Mode 
You initially choose Single User Mode or Multi User Mode when setting up your Point of Sale company file. When 
installing, it will ask you if you are using one computer or two or more computers.  You may need to change this 
setting if you are adding or removing workstations in the future. 

To switch between modes: 

• From the File menu, select Switch Company File to Multi User Mode or Switch Company File to 
Single User Mode. 

• Follow any on-screen instructions. 

Note: Virtual Private Networks (VPN) and wireless networks tend to be low bandwidth (slow) and therefore are not recommended 
for use with Point of Sale. These network configurations may be unreliable. 

  
Related Topics 
Install additional workstations 
About Point of Sale licensing 
Connection, performance, and network issues 
Help and support overview 

Prepare QuickBooks for Financial Exchange 
Financial Exchange Overview | Connect to QuickBooks 
  
Before you can share data, you should prepare your QuickBooks financial software by doing the following: 
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• Make a backup copy of both your Point of Sale and QuickBooks files.  (Create a unique name for the 
backup. For example: "POS backup before QB"). 

• Install QuickBooks on the same computer as QuickBooks Point of Sale 2013 for sharing.  

• Turn on the collection of sales tax, if applicable.  

• Turn on Inventory, if applicable. 

• Clean up QuickBooks lists (optional, if you plan to import data) 
Related Topics 
Set QuickBooks preferences to allow access 
Turn on the collection of sales tax 
Clean up QuickBooks lists  
  
Related Topics 
Troubleshoot Financial Exchange 

Security and Program Preferences 
Employees/Security | Company Preferences | Workstation Preferences 
  
Security settings and program preferences can control the availability of many program features. If a feature is not 
available to you, your security group assignment or the program preference settings may not be set to allow you 
access to that feature. 
Ask your system administrator  to review these settings. 
  

Employees & Security 
Employees can be added and passwords and security rights assigned by selecting Security from the Employees 
menu. You must log in as the System Administrator to add employees. 
Employees must be defined if you want to list their names on documents, create sales performance reports, limit 
access to specific features or for Pro users, track hours worked or commission sales. 
By requiring employee logins, you can control access to features by assigning employees to one of four predefined 
security groups, each with a specified set of security rights. You can also define your own custom security groups 
with the access rights you prefer. 
  

Program Preferences 
The Company and Workstation preferences allow you to configure QuickBooks Point of Sale to work with your 
hardware and accessories, establish data control, and customize many features.  
There are two preferences modules that are accessible from accessible from File > Preferences: 
Company Preferences - affects all Point of Sale functions and workstations. 
Workstation Preferences - applies to an individual workstation. 
This arrangement allows you to maintain central control over critical program features through Company settings, 
while also allowing individual workstation setups to be optimized for a particular purpose or hardware. 
  

Data Protection 
The electronic data that you gather during day-to-day business operations is invaluable and must be protected from 
harm. Power failure, media defects, disgruntled employees, or hardware problems can destroy days or weeks of 
accumulated information. Backing up your data on a regular basis enables you to recover from such events as 
quickly and painlessly as possible. Failure to do so puts your entire business at risk. 
Note: If you have Free Online Backup through your Point of Sale or Quickbooks support plans, it is a separate 
software that needs to be installed and configured for you to be protected.   
Please read the data backup/restore overview and implementing a comprehensive data protection strategy for 
more information and suggestions. 
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Return to top 

Sign Up for an Intuit Payments Account 
Merchant Service Overview 
  
Most retailers will want to sign up for a merchant account with Intuit to perform credit and debit/ATM card 
transactions. An Intuit Payment Account offers an integrated processing solution that allows you to authorize, 
settle, and record all your credit/debit card sales from within QuickBooks Point of Sale. 

Getting set up is easy!   Learn more 
  

To sign up for an Intuit Payments Account: 
1. From the Point of Sale File menu, select Setup Interview. 
2. Select the Payments tab. 
3. Click Yes to accept credit and debit cards.  
4. Click Sign In.  
5. Be sure to sign in using the User ID (email) and password that you had previously created. 
6. If there is more than one account, you will be prompted to select the right account.  

  
Note:  You will also need your Intuit Payments Account to take advantage of the available  mobile features.  
  
Learn More 
  
Related Topics 
Merchant Service reports 
Protecting your customer's payment card data 

Sign up for the QuickBooks POS Gift Card Service 
How do I?   | QuickBooks POS Gift Card Service Overview 
  
The QuickBooks POS Gift Card Service, provided by Innovative Merchant Solutions, LLC (IMS), an Intuit company, 
allows you to sell, redeem, and track the balance of gift cards from within Point of Sale. An Intuit Payments Account 
is required.  
  

Getting set up is easy!  Learn more 
  
You can sign up from within QuickBooks Point of Sale 2013: 

To sign up for an account with QuickBooks POS Gift Card Service: 
1. From the Point of Sale File menu, select Setup Interview. 
2. Select the Gift Cards tab.  
3. Click Yes.  
4. Type in your Gift Card account number in the field provided. 
5. Click Verify.  

Once your account is approved and you have received your Gift Card Account Number (typically in 2-3 business 
days), configure Point of Sale to work with the Gift Card Service. 
  
Related Topics 
Gift Card Service overview 

http://www.youtube.com/user/IntuitQuickBooksPOS?feature=mhee
http://payments.intuit.com/products/quickbooks-payment-solutions/custom-gift-card-program.jsp
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Sell or redeem gift cards 
Order custom gift cards 

Configure Store Exchange 
How do I?  | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 

  

Pro - Multiple Stores 

Which type of store are you configuring? 
Headquarters 
Remote store 
  
Configuring Store Exchange includes specifying or confirming: 

• Whether you are a Headquarters or remote store 

• The number of stores you have and assigning store codes to each (Headquarters only) 

• The Store Exchange method you will use to communicate with other stores 

• The license number for the Server Workstation at the other store(s) in your company 

• The e-mail address, file transfer path, or drive that will be used to send files to other stores 

• Protecting Store Exchange files with a security password (required: Learn more) 
Important: Before beginning, be sure you have the license numbers from the Server Workstation at the other 
store(s). Until you have entered the license number from the other store(s) in your Store Exchange preferences, 
you will not be able to receive and process files from the store(s). 
License numbers can be found on the Point of Sale CD holder, in the e-mail you received if downloading the 
program, or by selecting About Point of Sale from the Help menu at the Server Workstation in each store after 
installing. 
  

Upgrader Note:  Each store may have a new license number when upgrading from a previous version. Store Exchange will fail 
with a "License numbers do not match" error until your Store Exchange preferences have been updated with the new license 
numbers. 

Configure Your Firewall 
Help and Support | Troubleshoot 
  
A firewall, on either the Client or Server workstation, can block communication between workstations and the Point 
of Sale company data or to the Internet. You may see a message from the firewall if this is the case. 
Note: Some firewalls don’t display a message and others display messages only if the current user has Windows 
Administrator rights. Make sure you are logged into Windows with Administrator rights to ensure you are seeing 
any messages your firewall might be generating. Read configure Windows user rights for more information. 
  

Get Latest Firewall Updates 
Several major firewall applications are updated regularly with the latest Point of Sale file and port information and 
will automatically allow access to the ports and files needed. Use your firewall application’s instructions to be sure 
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you have the most recent updates available before installing Point of Sale and each time you install a Point of Sale 
update. 
  

Windows Integrated Firewall 
If you use the Windows integrated firewall, and it is blocking access, Point of Sale will alert you on startup and offer 
to automatically configure the firewall for you. It is strongly recommended that you allow the automatic 
configuration. 
  

Manually Configuring Firewalls 
Each firewall program presents its interface in a slightly different manner; each provides its own phrase for asking 
what you would like to do regarding the action it views as a possible threat. You will see some form of the question, 
"What do you want to do about this?" That question will be followed by a list of options, such as allow, grant, deny, 
block, permit, or something similar, from which you must choose an action. 
You should select the option to allow, grant or permit the action. There should not be a prompt the next time 
the same action is performed. However, permitting one action for one file will not automatically enable all actions 
from anywhere in the Point of Sale program. Several different Point of Sale files perform actions that might be seen 
by your firewall as an attempt to connect to the Internet. Permission must be granted separately for each action. 
If firewall messages continue to appear, it may be necessary to manually configure the firewall to allow access for 
the required program files. 
If you need to manually configure your firewall application, you should review the appropriate sections of the 
manual or help file that was supplied with the firewall program. 
  
Note: Windows 64 bit version is shown below.  
          For 32 bit versions, (x86) is not shown in the path. For example: C:\Program Files\Intuit\QuickBooks Point of 
Sale 11.0 
The program files to grant access to are: 

• QBPOSShell.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0 

• QBPOS.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0 

• QBDBMgrN9.exe 
C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0\DatabaseServer 

• QBDBMgrN10.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0\DatabaseServer 

• QBPOSDBService.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0\DatabaseServer 

The services to grant access to are: 

• Intuit Update Service 

• Intuit Entitlement Service 

• QBPOS Database Manager 
Note: Folder locations shown assume the default installation location on Windows 7/Vista.  
         Adjust accordingly if you installed to a different location. If necessary, use Windows Search from My 
Computer to locate these files. 
  
Related Topics 
POS company data connection issues 
Performance and networking issues 
Troubleshoot QuickBooks Financial Exchange 
Configure port filters 
Help and support overview 



Printed Documentation 

12 

Contact Technical Support 

Enter Data 

Departments Overview 
How do I?  | Plan Your Departments 
  
In most retail businesses, related merchandise is grouped into departments. Establishing and using departments is 
a good way to monitor sales performance, manage inventory, and run meaningful reports, which will help you to 
make informed buying decisions. A well-designed department structure will also save you time and give you greater 
flexibility when conducting a physical inventory, changing prices, and printing tags. 
How many departments should you have? That depends on the level of detail you wish to see on reports and how 
you want to work with categories of items with tasks, such as changing prices or talking inventory. Use the Plan 
Your Departments link above for some ideas and guidance on this important decision. 
Each department must be identified by a unique department name. Departments can also be identified by a 
department code which can be used to search for a department record and is printed on price tags. Each item 
added to your inventory then must be assigned to one of your departments. Department options, such as default 
tax codes and profit margin/markup are automatically suggested when you assign new items to a department in 
inventory. Assigning inventory items to departments allows Point of Sale to track and report on the merchandise in 
each department as it is ordered, received, and sold. 
View an example department structure  
(Pro) Remote stores can view department records and use them to filter reports, but only Headquarters can add or 
edit departments. 
  
Related Topics 
Department field descriptions 
Security rights for departments 

Add a Customer 
How do I?  | Customer Information Fields | Customer Overview 

Add a Customer 
Edit a Customer Record 
Merge Customer Records 
Offer Customer Charge Accounts 
Offer Customer Discounts and Price Levels 
Handle Special Customer Tax Status 
Track Customers by Type 
View Customer Purchase History 
Print my Customer List 
Export my Customer List 
Create an E-mail Marketing List 
E-mail a Customer 
Write Letters to Customers 
Track Business Customers 
Offer a Customer Rewards Program 
Use Customer IDs and Cards 

  
  

Basic  
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Note: If you have accessed this topic after copying a customer record, start with Step 2. Edit the information brought from the 
copied record as needed. 

  
It is helpful to be consistent when entering customer information. Consistently using the same data format makes it 
easier to sort, search, and look up customer records. 

To add a customer: 
1. From the Home Page Customers menu, select  New Customer. 

OR 
From your Customer List, click the Add button. 
OR 

From the Customer field on a sales receipt, click the  icon and then choose Add New Customer. 
A blank customer form is displayed. 

2. Navigate through the sections on the customer form and enter name, contact, and optional 
information for the customer: 

Expand each section of the form by clicking the small triangle icon to the right of the label: 

 
• Name: The Last (Name) field is required to save a customer record, unless Track as Company 
is selected (see below). 

• Track as Company (Pro):  Allows you to record customer PO numbers on transactions for the 
customer and display the company name throughout Point of Sale (in the Full Name field). With this 
selection, Company (Name) is a required entry. Learn more. 

• Contact Info:  Enter the customer's phone, e-mail, and address. 

• Customer Notes: Add whatever notes might be helpful, such as birthday, clothing sizes, gift 
preferences, etc. 

• Custom Fields (Pro):  You can define and use custom fields to record additional information. 
Using custom fields allows you to use the information to filter reports. 

• QuickBooks Options: Use these settings to control sharing of customer information with 
QuickBooks financial software and to set up and maintain charge accounts for the customer. 

o   Use with QuickBooks: Select this checkbox share this customer's information with 
QuickBooks. A company preference controls the default setting of this option. 
o   Charge Account: Select to allow charges for this customer and enter an account 
limit. Learn more 

• Customer Settings: Use this area to set other options: 
o Customer ID (Pro): Customer IDs are automatically assigned to new customers and 
can be used to print scannable ID cards. Learn more 
o Rewards Member (Pro):  If offering a Rewards program, elect the checkbox to enroll 
this customer. Learn more 
o Alternate contact info: Enter additional phone numbers. 
o Customer Type: Categorize your customers in ways that are meaningful to your 
business. Learn more 
o Tax Location: Specify a customer tax location for special tax handling (Set up can use a 
0% tax location for tax-exempt customers).  Learn more 
o Customer Discounts:  If applicable, click the Discount button and specify a customer 
discount or price level to suggest on all sales to the customer. Learn more 
o Accept Checks: Select the checkbox if checks are to be accepted for payment from this 
customer. 
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• Addresses (Pro):  Use this area to enter additional shipping addresses and print shipping labels. 
The address entered in the Contact Info section is automatically added as the default shipping address. 
Select the Do not mail to Bill To Address checkbox to prevent this and then click Add to enter alternate 
shipping addresses (up to ten). Designate one as the default. The default shipping address will be 
suggested when you add shipping information to sales receipts. 
3. Select Save. 

  

Notes: 
• If an existing customer record is very similar to a new one you are creating, copying and editing the 
existing record might be the quickest way to create the new record. 

• If you are integrated with QuickBooks financial software: 
 Customer names can be sent to QuickBooks in the order you prefer (e.g. <first, last> or <last, 
first>). Learn more 
 Charge account balances and limits are shared between the programs. You cannot track account 
charges without also having the Use with QuickBooks option selected. Learn more 

Note: The availability of customer tracking features can be controlled by your Features to Use preference settings. 

  
Related Topics 
Track customers by type 
Track business customers 
Edit customer records 

Add a New Vendor 
How do I?   | Vendors Overview | Import Vendors 

Basic  

Note: If you have accessed this topic after copying another vendor record, start with Step 2. Edit the information brought from the 
copied record as needed. 
 
Pro Note: In a multi-store configuration, only Headquarters can add or edit vendors. 

To create a new vendor record: 
1. Select New Vendor from the Purchasing menu. 

A blank vendor form is opened. 
2. Make entries in the vendor information fields, as needed. 

Company is a required field. 
3. Select Save. 

  
Related Topics 
Copy a vendor record 
Add a vendor directly in the vendor list 
Enter vendor payment terms 
Track multiple vendors for an item (Pro) 

Add a New Inventory Item 
How do I?  | Import Items  

Add an item 
Edit an item 
Delete or merge items 

Use service items 
View inventory reminders 
View an item's history 
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User reorder points 
Find an item 
Customize item list columns 
Filter the item list 
Export my item list 

Track item price and cost 
Use Price Manager 
Adjust cost or quantity 
Take a physical inventory 
Print price tags 
More...   

  
  
Use this procedure to add a new item to your inventory. You can also read specific procedures for adding non-
inventory, assembly, group, style or service items. 
  

Notes: 
Your ability to perform this task may be limited by security rights. 
You can add a new item while making a sale or creating another document. Learn more. 

To add a new inventory item: 
* Indicates a required field. 

1. Open your item list, and then click Add from the window toolbar. 
A new item form is opened. View Sample  

 

  
2. Enter the * Item Name/Item Name. This is the short item description that is printed on sales 
receipts. The field label can be customized.   
3. Navigate through the sections and fields of the item form, entering information as appropriate . 
Following are descriptions of the most commonly used fields in each section. More detailed explanation 
are located in the item fields topic. 

Basic Info  

• *Item Type: Leave set to Inventory. If you wish to add a different item type, click a link for 
specific instructions: non-inventory, assembly, group, style or service items. 

• *Department: Select the department to which the item belongs from the drop-down list. 
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• Item/Description 2: Secondary, long description field used to record additional information. 
This field label can be customized to meet your needs. 

• Size: Enter the size for the item (if applicable). If using abbreviations, try to be consistent, 
e.g., Sm, Md. and Lg for example. Consistent entries will make filtering and finding items in inventory 
and on reports easier.  This field can also be used to describe a second item attribute other than size if 
desired. This field label can be customized. 

• (Pro) To add a line of related items differing only by size/attribute, click the Style 
button to enter the size and attribute combinations.  Learn more. 

• Attribute: Use to describe an item characteristic, such as the color, pattern, material, or a 
second size.  This field label can be customized. 

• Reg Price: Enter your regular sale price or leave blank and let Point of Sale use a department 
pricing formula to calculate it for you. 

• Click the Pricing button for additional price fields. 

• Avg Unit Cost: Enter a value if this is an existing item in your store on program startup or if 
you know the cost for a newly ordered item. If you leave this field blank, Point of Sale will auto-fill it 
with the cost when the item is received on a receiving voucher and maintain it by averaging the item 
cost over time. Learn more 

• On-Hand Qty: Enter a value if this is an existing inventory item in your store on program 
startup. If you are defining a new item that you will be ordering, leave this field blank for now and Point 
of Sale will auto-fill it when you receive the item on a receiving voucher. Learn more 

• (Pro HQ) Click the Available button to enter existing on-hand quantities at other 
stores. 

• Tax: Review the tax field and select a tax code if necessary.  If you defined a default  tax code 
in the associated department record it will be suggested for the item. 

• UPC: Scan or type the UPC code. Learn more about these item identifiers. 

• Quick Pick Group: If you've defined Quick Pick Groups in your inventory preferences, you 
can assign an item to one of those groups to use with the Quick Pick Item feature on sales receipts 
and receiving vouchers. 

  
More Info  

• Vendor. Select the primary vendor from which you order this item.  (Pro) Click the Alt Vend 
button to add alternate vendors and their order costs. 

• Order Cost. Enter an order cost, if known, for your primary vendor. This is what you currently 
pay your vendor for one unit of the item.  Learn more. 

• Reorder Point. Enter a quantity if you want Point of Sale to remind you when it is time to 
order more of the item. 

• (Pro HQ) Click the View All button to enter/view reorder points for each store 
individually. 

• *Item Number. Suggested by the system, but can be edited. 

• Alternate Lookup. Enter an alternate lookup value that can be used to quickly add the item 
to documents. Learn more about these item identifiers. 

• Base Unit. When using multiple units of measure, the smallest quantity by which an item is 
sold or purchased. Learn more. 

• (Pro) Click the Units button to add additional units of measure. 

• Manufacturer. Enter the item manufacturer. This name can be used to search for an item or 
to filter reports. 

  
Comments  
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• Use this free-form text Comments field to enter any pertinent item information not covered by 
another item field. 

  
Misc and Shipping  

• Print Tags – Select to include this item when printing tags. For items that you do not tag, 
clear the checkbox. This will help prevent inadvertently printing the tags when the item is included on a 
document or in a list for which you are printing tags. 

• Add to Mobile – Select to include this item to display on your mobile device. 

• Unorderable – select to have the item’s reorder point temporarily ignored and  alerted if the 
item is added to a purchase order or receiving voucher. This option can be used to remove seasonal 
or discontinued merchandise from your reorder reminders and reports. 

• Use Serial # –  (Pro) Select to be prompted to enter serial numbers when this item is listed on 
a document. Learn more 

• Earn Commission  –  (Pro) Select to include sales of this item when calculating commissions 
for your associates. Learn more 

• Shipping Weight, Height, Length, Width –  (Pro) Enter shipping specifications to use when 
shipping the item. 

  
QuickBooks Options  

Define QuickBooks Item Account Information 
Available only if integrated with QuickBooks financial software. You can customize the way item transactions 
are sent to QuickBooks by specifying QuickBooks accounts here. 
By default, the item accounts are auto-filled using the default item accounts specified in company preferences, 
but you can change them on an item basis on this window. Learn more. 

  

  
5. To add the item to your Mobile device, click the Sync to Mobile box in the Misc and Shipping 
section. 
OR 
Click the Mobile box next to the Item # on the Item List. 
6. Click Save. 

  
  
  
Related Topics 
Copy one item to add another 
Add pictures to an item 
Define multiple units of measure 

Import QuickBooks Items 
Overview | Customize Financial Exchange | FAQs 
  
(Pro) This option is available at Headquarters only. 
You may have existing items in QuickBooks that you now want to track in Point of Sale. You can easily import 
these items to Point of Sale at any time, making them available to list on Point of Sale documents. Importing your 
QuickBooks items is optional. After importing, inventory items are not routinely exchanged between the two 
programs. The imported items should be tracked only in Point of Sale after import. 
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After the two programs are integrated, you will be prompted to import your QuickBooks items each time you open 
your item list in Point of Sale until you elect to import or indicate that you do not want to import. Choose Ask Me 
again Later if you plan to import, but are not ready to do at this time. 

To manually initiate an import of your QuickBooks items: 
1. Make sure your QuickBooks financial software is running and in single-user mode. 
2. Select Import QuickBooks Items from the Financial menu or from the Advanced Options page 
of the Financial Center. 

  

More Information about Importing QuickBooks Items 
What are the benefits of importing my QuickBooks Items? 
Are there reasons I may not want to import my QuickBooks Items? 
Can I import QuickBooks items later? 
Can I import some items and not others? 
Can I control how my imported inventory items are described in Point of Sale? 
  

Notes: 
• Importing of items from QuickBooks can be done multiple times. This can be helpful if you import only 
selected items the first time and later want to import the others, want to import from multiple QuickBooks 
company files, or have added new items to QuickBooks after the initial import. Be careful not to import the 
same items a second time or duplicate item records will be created in Point of Sale. 

• Once imported, the imported items should no longer be tracked in QuickBooks. It is strongly recommended 
that all purchasing, receiving, and selling of these items be done in Point of Sale only. 

• The on-hand quantity of imported items is set to zero (0) in QuickBooks and a compensating General 
Journal transaction is created to debit the Inventory Asset account. On the Point of Sale side, inventory 
adjustment memos are created to record the addition of the items to inventory. The memos are sent to 
QuickBooks, balancing against the General Journal transaction so that no net change in inventory value 
occurs. 

• Imported items should be reviewed and edited to take advantage of the inventory tracking and control 
features in Point of Sale. 

• If you have existing items (and customers and vendors) in an application other than QuickBooks financial 
software, you may be able to import this data using the Data Import Wizard. 

Related Topics 
Financial Exchange overview 
Troubleshoot Financial Exchange 

Data Import Wizard Overview 
Data Import Instructions | Tips | Data Export Wizard 
  

Note: This topic may refer to data types not applicable to your Point of Sale installation. For example, Point of Sale Free users 
cannot import customer, vendor, or item quantity information and Basic users cannot import item pictures. 

  
When you first begin using QuickBooks Point of Sale, you may already have existing customer, vendor, and/or item 
information in another application (other than QuickBooks financial software). Or, you may receive data from an 
outside source that you wish to enter into the program periodically, such as from your vendors. 
The Data Import Wizard is designed to spare you the time-consuming task of having to manually enter large 
amounts of existing data into Point of Sale, such as items, item pictures, customers and vendors, allowing you to 
import this data instead. This tool is particularly useful for: 

• New users of Point of Sale who want to import data from another software application. The other software 
application must be able to export the data into an Excel spreadsheet or comma-delimited text file (.csv). 
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• Existing users of Point of Sale who want to import data provided by vendors, such as catalog information 
or new pricing for new or existing inventory items 

You can import data from: 

• An Excel spreadsheet by copying and pasting into a predefined template we have supplied for you 

• A custom Excel spreadsheet in another format (generated by another program, from a vendor, or that you 
have created) 

• A comma-delimited text file (file extension must be .csv) 

• (Pro) A folder of picture files; on your computer or on a CD, DVD or other media. Special considerations 
apply to picture imports; click here to learn more. 

Information from any of the above sources is mapped into the correct data fields in Point of Sale. If the imported 
data affects your inventory value (item cost or quantity), Point of Sale creates adjustment memos with an entry in 
the Source field of Import. 
View the complete instructions for using the wizard to import your data or select Help on each page of the wizard 
for additional information about the choices on that page. 
  

Notes: 
(Basic, Pro) The Data Import option can be accessed from the File  Utilities menu on the Server Workstation 
only. 
(Pro) In a multi-store configuration, remote stores can import only customers. 
  

Getting Started: Notes on Item Quantities and Cost 
Available Quantities | Decimal Quantities | Decimal Costs  

Basic  

The Average Unit Cost field in inventory reflects the average cost of the currently on-hand quantity of an item. 
This value is automatically recalculated by Point of Sale when you create a voucher to receive an item at a cost 
different than what is currently recorded. How does order cost differ from average unit cost? 
The On-Hand Quantity field reflects the number of units of an item currently in stock. This value is automatically 
updated as you create vouchers, receipts, and, if applicable, transfer slips. 
Item quantities and costs have significant impact on your inventory value and your financial records. For this 
reason, it is recommended that you manually enter or edit these values only when entering items already in your 
store when you begin using Point of Sale. From that point on, Point of Sale maintains an accurate ledger of 
changes in these values with the use of transactional documents (receiving vouchers, receipts, transfer slips, and 
adjustment memos) and the Physical Inventory utility. The table below summarizes how quantities and/or costs are 
updated in various ways. 
  

Method Comments 

Receiving 
vouchers 

Updates on-hand quantity, average unit cost, 
and order cost in inventory. Should be used for 
receiving all new and reordered items into 
inventory. When you define a new item in 
inventory that is to be received later, we 
recommend you leave the On-Hand Quantity 
and Average Unit Cost fields blank in 
inventory and allow the receiving voucher to 
update them. 

Receipts When an item is sold or returned on a receipt, 
the on-hand inventory quantity is adjusted up 
or down accordingly. 

Adjustment 
memos 

A memo is used anytime quantity or cost must 
be manually adjusted (because it is not 
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handled by a receiving voucher, receipt, or 
physical inventory count). Many actions, such 
as conducting a physical inventory, or 
manually editing the cost or quantity fields, 
automatically create adjustment memos for 
you. 

Physical 
Inventory 

Updates on-hand quantities only. Updating a 
physical inventory automatically creates 
adjustment memos to update inventory. 

Transfer slips 
 (Pro) 

A transfer slip has no affect on company 
inventory quantities, though it does increase or 
decrease the on-hand quantities at the specific 
stores involved in the transfer. 

Return to top 

Routine Tasks 

Understanding Point of Sale Documents 
How do I? 
  

Note: References to tracking item quantities or costs in this topic do not apply to Point of Sale Free. 

There are two general document types used in Point of Sale: transactional documents and order documents. 
Transactional documents record changes to inventory and provide a permanent history of those changes. 
Transactional documents can never be deleted, and in most cases cannot be edited after being saved. For this 
reason, transactional documents, after being saved, are also referred to as history documents. History documents 
are used to run reports, to build customer, vendor and item histories, and if you use QuickBooks financial software 
are sent to update your financial records. 
The transactional documents available in Point of Sale include: 

• Sales and return receipts, which record item sales, returns, and exchanges, i.e., quantities 
removed from or returned to inventory. Upon saving, receipts are added to your sales history list. Learn 
more. 

• Receiving and return vouchers, which record item quantities added to or removed from 
inventory when received from or returned to your vendors. Vouchers also update item costs and may, in 
the case of items being received for the first time, also update item price(s) in inventory. Upon saving, 
vouchers are added to your receiving history list. Learn more. 

• Adjustment memos, which are used to record changes to item quantities or costs not covered 
by other transactional documents. Adjustment memos are automatically created by Point of Sale for 
certain activities, such as when you conduct a physical inventory or manually edit an item’s quantity or cost 
in inventory. Adjustment memos can also be manually created to correct errors or update inventory for 
shrinkage, donations, or the removal of damaged merchandise. Upon saving, adjustment memos are 
added to your adjustment history lists (separate lists for quantity and cost memos). Learn more. 

• Transfer slips (Pro), which record the movement of item quantities between stores. Transfer 
slips have no affect on your company inventory value, but are used to maintain an accurate count of item 
quantities at each store, as well as recording freight charges related to the transfer. Upon saving, transfer 
slips are added to your transfer history list. Learn more. 

Order documents are used to plan the purchase or sale of merchandise or services. The information recorded on 
an order document, such as items, costs, prices, deposits, fees, and terms can be easily transferred to a 
transactional document when the merchandise is actually received or sold. Once recorded on a transactional 
document, the order document can be safely deleted. 
The order documents available in Point of Sale include: 

• Purchase orders (Basic), which are used to record the planned purchase of merchandise from a 
vendor. A purchase order indicates to your vendor that you wish to purchase a specified quantity of an 
item or items at a specified cost. When the ordered merchandise is received, it is recorded on a receiving 
voucher, which updates inventory accordingly. Learn more. 
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• Customer orders (Pro), including layaways, sales orders, and work orders, which are used to 
record the planned sale of merchandise or services to customers. Customer orders typically involve taking 
a deposit when the order is placed, optional additional deposits over a period of time, and ultimately final 
payment when the merchandise or service is recorded on a sales receipt. Items listed on customer orders 
are deducted from inventory only after you record them on a sales receipt to fulfill the order. Learn more. 

Note: The In Progress field at the top of the page provides a drop-down list that displays tasks that you are 
currently working on. By making a selection from this drop-down list, you will be taken directly to the work area for 
that particular task.  This allows you to more effectively multi-task.  

Make a Sale 
How do I?  | Store Charges or Credits | Take Payment | Returns 

Add items to receipt 
Edit receipt items 
Add customer to receipt 
Change receipt price level 
Give discounts 
Sales tax ..   
Take payment...   

Sell gift card or certificate 
Hold or cancel receipt 
Print gift receipt 
Take return or exchange 
Pay cash out of drawer 
Sales history tasks...   
Setup & troubleshoot...   
Additional Pro options...   

  
  
This topic provides the basic instructions for making a sale. Use the How Do I? and other links on this page for 
advanced options and more information. 

Click the symbols in this procedure to view detailed instructions. 
Only Basic and Pro users can track customers on receipts. 

This symbol indicates more information is available. Click to expand the information. 

  

To make a sale: 
1. Select Make a Sale button or the Make a Sale icon within the Navigator.  
2. In the Scan or enter item information drop-down box, scan or type item information to search 
for the item being sold.   

2.  

• Scan the bar code from the item tag. 

• Type the item's UPC, Item #, or alternate lookup value and press <Enter>  Learn more about 
these item identifiers 

• Search by item name (type beginning characters) or other item keyword. A list of matching 
items is displayed. Select an item from the list by clicking  it (keyboard users, press the down 
arrow key to scroll, then <Enter> to select). The selected item is added with a sales quantity of 
1. 
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 If no matching item is found, check your spelling or the identifier you entered. 
Entering fewer characters will find more matches. 

 To see your entire item list, click the  icon with no entry in the item search field. 
You can scroll through the list looking for the needed item. 

• Click Sell a Miscellaneous Item or Add a New Item to Inventory. 
Learn more about adding items to documents 
  

3.   
OR 
Click Quick Pick Item to select an item from your pre-defined lists of frequently sold items. 

3. If necessary, click the action buttons below the line item to edit the quantity, price, give item 
discounts, etc. 
4. Repeat until all items being sold have been listed. 
5. (Optional) In the Enter customer name or phone box, type or scan customer information to add 
the customer to the receipt.  

4.  

In the Customer field, begin typing the customer last name (recommended) or other search keyword 
(first name, phone number, company name, etc). 

• As you type, Point of Sale shows a drop-down list of your matching customers, separated into 
last name matches and matches using all customer fields. If there are last name matches, they 
are displayed first. Click the results line to open all field matches if necessary. 

 

• Option: With no entry in the field, click the  icon to show your entire customer list. You can 
scroll through the list to look for the customer. 

• Click a name to select it. Keyboard users can use the arrow up/down keys to move through 
the list and <Enter> to make a selection. 

• If the selected customer has an associated discount, price level, or special tax handling, you 
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are prompted to apply it to the sale. 

• If the customer isn't found, click the  Add New Customer to create a new customer record. 

• Click the View/Edit button to open the customer record or the Delete button to remove the 
customer from the receipt. 

 
Not all customer information is displayed on a receipt. For example, the customer's address, charge 
account information, and check acceptance status are not displayed. However, you will be notified if a 
credit limit is exceeded, if checks are not accepted, or if a reward is available for the customer. 
  

5.   
6. (Optional) To discount the entire sale (called a global discount), select  Give Discount from the I 
Want To menu. Select or enter a discount percentage or amount in the popup dialog. Global discounts are 
shown in the totals area of the receipt. 
7. Click the button for the payment type used by the customer (Cash, Credit, Debit,  etc.) and enter 
the tendered amount and any requested information. If taking payment by more than one payment type, 
repeat for each type.  Details 
8. Select Print Receipt to record the sale and give the customer a receipt. If change is due the 
customer, the change amount is displayed. 

  

Notes: 
• The Quickbooks Point of Sale Mobile Sync feature gives you the power to make sales and track 
your inventory using your mobile phone or tablet.  Make sure to sync to your mobile device to take full 
advantage of this feature.  

• In a Pro configuration with multiple stores, Headquarters can make receipts for another store. From the I 
Want To menu, select Change Store and specify the store for which you are making the receipt. 

Learn more 
  
Related Topics 
E-mail receipts to customers 
Receipt field descriptions 
Customize printed receipts and other documents 
Multi-store Sales 

Purchasing Overview 
How do I?  | Create a New PO | Receive Ordered Items 

Create a PO 
Edit item order costs 
Enter discounts and fees 
E-mail a PO 
Receive against a PO 
View open POs by item 
Purchase from multiple vendors 

Find a PO 
Edit a PO 
Track POs by status 
Delete filled POs 
View suggested POs 
Handle special orders 

  

Pro 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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Note: The availability of purchase orders is controlled by your Features to Use preference settings. 

  
When merchants need to restock or add new merchandise, they create and send temporary documents called 
purchase orders (POs) to vendors. A PO typically includes the following information: 

• The vendor’s name 

• Order, shipping, and cancel dates 

• A list of the items ordered, including description, order cost, and quantity ordered 

• The total cost of the order, including applicable discounts and fees 

• Optionally, terms of payment and payment due date (for tracking purposes) 

• A summary of the PO fill status (what has been received and what has not) 

• Ship To and Bill To stores 
The merchandise ordered on a PO is added to inventory when its arrival is recorded on a receiving voucher. When 
a PO has been filled, it can safely be deleted. The receiving voucher(s) that reference the PO provide the 
permanent record of the item purchased. 
Purchase orders are not shared between Point of Sale and your QuickBooks financial software. Since they are 
planning documents, they have no effect on inventory valuation. 
Remote stores can generate POs only for special order items. Regular POs are created only by Headquarters and 
are sent to each remote store for merchandise destined for their store. The remote store can reference those POs 
to create receiving vouchers. Learn More. 
  

Note: If you have defined Reorder Points for your inventory items, you can easily view a list of the items whose on-hand 
quantities are at or below the reorder point on the Reminders window. Pro users can have Point of Sale suggest POs for the 
items on the reorder reminders. 

  
Related Topics 
Track PO fill status 
PO field descriptions 
Security Rights for Purchase Orders 
Preferences for Purchase Orders 
Multi-Store Purchasing & Receiving 

Going Mobile 
How do I?  |  

Receive against a PO 
Receive without a PO 
Update cost of received item 
Update price of received item 
Enter vendor billing information 
Enter discounts, freight, and fees 
Record item serial numbers 

Find a saved voucher 
Edit a voucher 
Reverse (correct) a voucher 
View a vendor's receiving history 
Return merchandise to vendors 
Print tags from a voucher 
Transfer items to other stores 

  

Basic  

The Quickbooks Point of Sale Mobile Sync feature gives you the power to make sales and track your inventory 
using your mobile phone or tablet . Mobile Sync allows you to share your items with your mobile devices and make 
sales wherever and whenever you need.   
  

Why Sync to your Phone or Tablet?  
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The QuickBooks Point of Sale Mobile Sync feature gives you the freedom to ring up credit card sales anywhere 
inside - or outside - of your store. 

• With an Intuit Payments Account and our free GoPayment app, you can make payments 
anywhere, anytime. 

• Start accepting payments instantly. Simply activate your payments account and you are 
ready to go. No application required. 

• All sales and inventory information instantly syncs with your Point of Sale software so 
your records are always accurate and up-to-date. 

• The Sync feature automatically records new payments as QuickBooks Sales Receipts. 
• Never miss a sale whether you are on the road, at a conference, or working a convention. 
• Long lines at the store?  Provide the best in customer service by completing sales on the 

spot.  
• If you are a QuickBooks user, all your information automatically syncs with your 

QuickBooks financial program. No more entry errors from re-keying data. Plus, you'll 
have everything ready for tax time. 
 
Note:  Intuit values your privacy and the security of your information. When using the 
Mobile Sync feature, your data is safely stored and securely transmitted through our 
servers directly to and from your mobile device. Intuit adheres to rigorous banking 
industry protection standards for secure data transmission. 

 

Get Your Intuit Payment Account first 
 
Before using the Mobile Sync feature, you'll want to first obtain an Intuit Payments Account. 
With an Intuit Payments Account, you can accept all major credit and debit cards as well as add Gift Card Services 
to your business. 
To start accepting credit cards in QuickBooks Point of Sale 2013: 

1. Launch QuickBooks Point of Sale 2013. 
2. From the File menu, select Setup Interview and choose the Payments tab. 
3. Click Yes to accept credit and debit cards. 
4. Click Sign In. 
5. Be sure to sign in using the User ID (email) and password that you had previously created. 

If there is more than one, you will be prompted to select the right account.  

  
Learn more 

 
  
  

Printing Tags: Overview 
How do I?  | Supported Tags | Printing Preferences | FAQs 

Print tags 
Specify tag printing templates 
Disable tag printing for an item 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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Print the MSRP on tags 
Print markdown or discount tags in Price Manager 
Print cost on tags in code 
View supported tag and label styles and sizes 
Customize my tag templates 
Import print templates 
Installing supported printers 
Troubleshoot my Zebra tag printer 
Order printing supplies 

  
  
Item price tags can be printed from inventory, purchase and receiving documents, transfer slips, the Price Change 
reminders window, and from the Price Manager and Physical Inventory windows. 
The appearance of printed tags is determined by the default print template you have specified in workstation 
preferences or you can change the template at time of printing.  Pro users can also customize or create new tag 
templates to meet their individual needs. 
Tag printing is supported to compatible dedicated tag printers (e.g. the Zebra LP2824) and to standard inkjet/laser 
printers (using sheet labels). A dedicated tag printer allows you to print to hang tag, jewelry tag, and adhesive tag 
templates available on roll stock. 
  

 
  
Tags can be printed with or without bar codes or the reference MSRP (manufacturer's suggested retail price). 
When printing tags with bar codes and using the default tag templates, Point of Sale uses the inventory item 
number to produce the bar code, not the UPC code. This allows you to print bar-coded tags and list items on 
documents by scanning them, even if you do not have a vendor-provided UPC code for the items. Learn more. 
The MSRP is included on printed tags if it has been entered on the item record. If you do not wish to include the 
MSRP, don't enter it on the item record or remove the field from the template you are using with Print Designer. 
  
Return to top 
  
Other Tag Printing Topics 
List of compatible tag printers 
Installing supported printers 
Common issues with Zebra tag printers 
Printing mailing and shipping labels 
Printing shipping labels 
Printing tags for alternate vendors  

Item tags printed from inventory always include the information for your primary vendor. To print tags that 
include alternate vendor information, such as the alternate lookup or UPC values, print the tags from either the 
purchase order or receiving voucher used to purchase the items from the alternate vendor. 
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Ordering printing supplies 

End of Day Overview 
How do I?   
  
The retail day is over; the doors are locked. It is time to tally up the sales, count the money, exchange information 
with your financial software, and back up your data before you head home. 
When you initiate the End of Day procedure, these tasks are carried out as you specify, prompting you for input as 
needed. 

Note:  In a multi-workstation configuration, the End of Day procedure must be run from the Server Workstation if you wish to 
include a data backup or Financial Exchange. 
Pro Note:  In a multi-workstation configuration, the End of Day procedure must also be run from the Server Workstation if you 
wish to include Store Exchange. 

To run the End of Day procedure: 
1. Select End Of Day Procedure from the Point of Sale menu. 

The End of Day window is displayed. 
2. Select the individual procedures you wish to run by selecting or clearing the checkboxes for each 
and specifying options: 

• Run an End of Day report (drawer count, store close, or status). Select the specific X/Z-Out 
report type, specify a date (default: today), and optionally select the checkbox to print the report 
immediately without previewing. Learn more 

• Back up your company data. Specify the default location or an alternate location. Learn more 

• Send data to other stores. Learn more 

• Settle Merchant Account (send credit and debit card transactions to processor). Learn more 

• Exchange data with QuickBooks financial software. Learn more 
3. Select Start. 
4. Enter additional information as prompted. 

  

Notes: 
• If you have scheduled data backups, you may not want to include another backup in your End of Day 
procedure. 

Run a Report 
How do I?  | Memorize a Report | Report Dashboard 

Modify a report 
Drill down to report detail 
Memorize a report 
Manage my reports 
Export a report to Excel 
Use security access levels 

Run cash drawer reports 
Run Merchant Service reports 
Use the report Dashboard 
Refresh report data 
View a chart or graph 
Run multiple reports 

  
  
These are the basic instructions for running a report from the Report Center. Use the links below or read the Report 
Overview to learn about additional options and access points for reports. In addition to reports listed below, there 
are now Mobile reports to select as well.  

To run a report: 
1. Select Report Center from the Reports menu. 
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2. On the Report Center window, select the Overview tab. 
  

 
  

3. Select one of the following: 

• A report link on the left – These are the most common reports in each category. After selecting 
a report, you will have the opportunity to specify certain options, such as the date range, appearance, and 
data to include (choices which vary by report). 

• A memorized report – When a memorized report is selected, it is immediately ran using the 
saved settings. Steps 4-5 below do not apply. You can further modify the report after it is displayed if 
necessary. 

• Create a Report – Launches the report wizard that will help you build the report you need. 

• All Reports – To view all available report categories and individual reports.  Learn more about 
this option. 
4. Follow the on-screen prompts to modify various report options. Select Help on each options page 
for more information. 
5. Select Run. The report is displayed. 

You can further modify the report and drill down to view additional detail and related records with the report 
displayed. Learn more. 

6. From the top toolbar, choose how you want to output the report: 

• Select Print to send the report to your printer. Note: Printing large reports  

• Select Excel to export the report as a spreadsheet (you must have Microsoft Excel installed for 
this option). 

Or, from the I Want To menu: 

• Select Add this Report to Dashboard. Learn more. 

• Select Memorize this Report and give it a name to add the report to your memorized reports list 

Notes: 
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• The printer used for your reports is specified on the Documents & Printers page of workstation 
preferences. 

• Specific information about running cash drawer reports (X/Z-Out) is available here. 

• (Pro) Headquarters can run reports for any store, a selected group of stores, or all stores, while remote stores 
can run reports only for their own store. When running reports at Headquarters, use the Modify Report > 
Filters option to specify the stores to be included in the report. 

Getting Started: Conducting a Physical Inventory 
Physical Inventory Overview 

Basic  

A physical inventory (PI) is an actual count of the merchandise in stock. The Physical Inventory utility is the 
quickest way to update on-hand quantities for a large number of items in inventory. 
A physical inventory is always recommended as part of the startup procedure and periodically thereafter to verify 
and adjust inventory counts. 
A physical inventory involves: 

• Recording physical counts for every individual item in the store 

• Entering these physical counts into Point of Sale so the program can compare the counted quantities to 
the currently recorded quantities on hand in inventory 

• Reviewing any discrepancies found 

• Updating your inventory on-hand quantities to reflect your physical inventory counts 

• The automatic creation of adjustment memos by Point of Sale to track the quantity changes and update 
your inventory value in QuickBooks financial software 

For more information about conducting a physical inventory, click the Physical Inventory Overview link at the top 
of this page. 

Quick Pick Item 
List Items on Documents: Overview 
  
Quick Pick allows you to  group items in inventory and then quickly add items from these groups to be purchased 
 with fewer mouse clicks. Quick Pick works especially well for frequently sold items or services that you do not tag. 
One example: In a sports shop, you keep a barrel of ice-cold sports drinks in several flavors near the checkout 
counter. The icy wet conditions make tagging impractical.  So, you complete the following steps to make them 
Quick Pick items. 

Note: These procedures illustrate using Quick Pick for sales.  They can also be set up and used when receiving items from your 
vendors. 

  

Define Quick Pick Groups 
  

1. On the Make a Sale page, click Quick Pick Items from the left sidebar. 
2. Click Add Group. 
3. Type the name of the new Group on the new icon that displays.  
4. Right-click on any Group icon to change the Group color, rename the Group, or remove the 
Group from Quick Pick.  

There is no limit to how many Quick Pick groups you can add; add one group for each collection of related items 
you wish to add as Quick Pick items.   
  

Add Items to Quick Pick Groups 
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1. On the Make a Sale page, click Quick Pick Items from the left sidebar. 
2. Click on the Group to which you want to add items. 
3. Click Add Item. 
4. In the Select an Item box, type, search, and select the item you wish to place into this Group. 
Once selected, the item information will display within the Group.  An item can be assigned to only one 
Quick Pick Group at a time. 
5. Repeat steps 3 and 4 to add more items to the same Group. 
6. To select another Group, click Groups.  

  
For Quick Pick to work effectively, try to keep the number of items to 12 or less (so they can all be displayed on a 
single Quick Pick page from a receipt).  
  

Remove Items from Quick Pick Groups 
  

1. On the Make a Sale page, click Quick Pick Items from the left sidebar. 
2. Click on the Group with the item you wish to remove. 
3. Double-click on the item you want to remove and select  Remove Item from Quick Pick.  

  
The removed item was only removed from the Quick Pick Group.  It still remains in the Item List.  
  

Sell the Item 
1. On the sales receipt, click Quick Pick Item from the left sidebar. 
2. From the Quick Pick Item dialog, click the desired  Group. If more than 12 groups exist, previous 
and next page buttons are added to this dialog. 
3. Click the specific item to add it to the receipt.  

  

Note: 
• You can use the Quick Pick Item List report (In Items > Current Inventory category) to view or print a 
list of all your Quick Pick groups and items. 

Related Topics 
Make a sale 
Receive items 
Run a report 
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How do I? 
Help & Support | Glossary 

What area do you need help with? 
Inventory  
Sales and returns  
Sales tax  
Customers  
Customer Orders  
Vendors  
Purchasing  
Receiving  
Employees and security  
End of Day procedure  
Reports  
Store Exchange  
Integration with QuickBooks financial software  
Entering or editing records  
Program navigation, lists and forms, finding records  
Configuring or customizing Point of Sale  
Accepting credit & debit cards  
Accepting & selling gift cards  
Printing  
Hardware  
Working with your company data file  
Point of Sale licensing  
Getting updates to Point of Sale  
Import/Export Data and Write Letters 
Troubleshooting 
Finding other applications that work with Point of Sale 

Security and Program Preferences 
Employees/Security | Company Preferences | Workstation Preferences 
  
Security settings and program preferences can control the availability of many program features. If a feature is not 
available to you, your security group assignment or the program preference settings may not be set to allow you 
access to that feature. 
Ask your system administrator  to review these settings. 
  

Employees & Security 
Employees can be added and passwords and security rights assigned by selecting Security from the Employees 
menu. You must log in as the System Administrator to add employees. 
Employees must be defined if you want to list their names on documents, create sales performance reports, limit 
access to specific features or for Pro users, track hours worked or commission sales. 
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By requiring employee logins, you can control access to features by assigning employees to one of four predefined 
security groups, each with a specified set of security rights. You can also define your own custom security groups 
with the access rights you prefer. 
  

Program Preferences 
The Company and Workstation preferences allow you to configure QuickBooks Point of Sale to work with your 
hardware and accessories, establish data control, and customize many features.  
There are two preferences modules that are accessible from accessible from File > Preferences: 
Company Preferences - affects all Point of Sale functions and workstations. 
Workstation Preferences - applies to an individual workstation. 
This arrangement allows you to maintain central control over critical program features through Company settings, 
while also allowing individual workstation setups to be optimized for a particular purpose or hardware. 
  

Data Protection 
The electronic data that you gather during day-to-day business operations is invaluable and must be protected from 
harm. Power failure, media defects, disgruntled employees, or hardware problems can destroy days or weeks of 
accumulated information. Backing up your data on a regular basis enables you to recover from such events as 
quickly and painlessly as possible. Failure to do so puts your entire business at risk. 
Note: If you have Free Online Backup through your Point of Sale or Quickbooks support plans, it is a separate 
software that needs to be installed and configured for you to be protected.   
Please read the data backup/restore overview and implementing a comprehensive data protection strategy for 
more information and suggestions. 
  
Return to top 

Messages 
  
The Message board, displayed on the Home Page and accessible from the receipts, inventory, receiving, and 
customer areas, allows you to leave notes for yourself or other employees. Point of Sale will also post messages 
for you when something needs your attention, such as inventory reminders. 
 
Messages can be displayed in "sticky note" format or as a list and are searchable. System notes, such as inventory 
reminders, will contain a link to take you to the screen on which you can review or complete the task. 

• Click the + icon at the top to add a new message. 

• To search for a message, begin typing a search keyword in the Search message box. Point of Sale 
dynamically locates messages with matching characters as you type and displays them. Clear the Search 
box to see all messages again. 

• Click one of the icons to the right of the Search message box to change the display to list format or the 
stickies format, which is the default. The list format allows you to see more messages at one time. 

• To delete a message, move your mouse over the message, then click the Remove link that appears in the 
lower right corner. 

• Use the Minimize feature at the bottom to close or open the Message view.  
Related Topics 
Note, Comment, and Instruction Fields 

Work with Forms and Lists 

Work with a Form 
How do I?   | Find a Record or Document | Work with a List 
  
A Point of Sale form is a detailed view of a single record or document. Forms are used when creating or editing a 
document or record.   
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Point of Sale has three form styles: sectioned, tabbed, and document.   
Sectioned Form Example:  Customer    

 
  
  

  
Tabbed Form Example:  Vendor   

 
  
  

  
Document Form Examples:    Sales Receipt        Purchase Order  

  
 
  

  

  
 
  

  
  
  
Following are descriptions of available form functions: 

To Do this 

Navigate fields Touch or click the field you wish to select. 
Use <> or <Tab> to move forward through 
fields. 
Use <> or <Shift + Tab> to move back 
through fields. 
Only fields yellow/white in color can be edited. 
Gray fields cannot be selected or changed. If 
you believe you should be able to edit a field 
but cannot, check the logged-in user's security 
rights or read the following: 
Why is a Point of Sale feature not available to 
me? 
Editing Documents 

Change Tabbed 
Page 

(Tabbed Forms) 

Click or touch a tab at the top of the form. 
Keyboard: Press <Ctrl+1>, <Ctrl+2>, etc. to 
move to each tab in sequence. 

Expand/Collapse 
Section 

(Sectioned 
Forms) 

Click or touch the section titlebar. 

Cycle through 
records 

(Tabbed Forms) 

Use <Ctrl + Page Up> to display the previous 
record in the associated list. 
Use <Ctrl + Page Down> to display the next 
record in the associated list. 
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This function is only available from the primary 
tabbed page (Name & Address page in a 
customer record) and cannot be used while in 
the process of creating a new record. 

Enter or edit 
data in a field 

How do I?   

Select an editable field and begin typing to 
overwrite the current entry. Click in the field a 
second time to edit character-by-character. 
To edit the items listed on a document, select 
the item and then click Edit or another action 
button on that row. 

Return to top 
  
Related Topics 
Enter data 

Work with a List 
How Do I?   

Note: Not all tasks apply to all list types. 

Sort and scroll in a list 

Filter a list 

Customize list columns 

Customize a list information panel 

Print a list 

Export a list 

Customize my printed documents 

  
  
Lists present all (or a filtered subset) of the documents or records created in an area in a format similar to a 
spreadsheet. A list can be sorted, filtered, and searched to help you locate a record or group of records. 
There are two list types in Point of Sale, with slightly different features and procedures. Choose the list type you are 
working with for more information: 
Item, Customer, Sales History, or Receiving History lists    

This information applies to item, customer, sales history, and receiving history lists. Shown is an item list for 
example. 
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The same list is shown below with Show Details for the selected record shown. Drag the divider line between 
the list and the details to resize the detail pane. Details will stay open, even if you select another record, until 
you click Hide Details. Click Edit to make changes to the current record. 
  

 
  
The following functions are available in these lists: 

To: Do this: 

Add, 
remove, 

or 
rearrange 
columns 

Right-click anywhere in the list and select customize 
columns, or drag and drop a column header to a new 
position. You can add, remove, and rearrange columns to 
meet your needs. 

Sort the 
list 

Click any column header to sort the list by the values in 
that column. Click the same header a second time to 
change the sort order (ascending or descending). A  
indicates the column and order by which the list is 
currently sorted. 



Printed Documentation 

36 

Scroll 
through 

the list 

Use the scroll bar (on the right of window) to scroll 
through the list of records. 
If the list is too wide to display on the screen, there will 
also be a horizontal scroll bar along the bottom of the 
screen to move left or right. 

Filter the 
list 

Select a pre-defined  Filter from the drop-down list at the 
top of the window and your records are instantly filtered, 
displaying only the matching records. Shown is the item 
list filter. 

 

Search for 
a record 

Enter search keywords in the Search field at the top of 
the list and matching records are instantly displayed. 

 
The Filter button shows "Search Results" and the total 
number of returned items is shown in the bottom-left of 
the window. 

Record 
selection 

& list 
navigation 

The selected record is highlighted in blue (as shown 
above).  With a record or records selected, choose an 
action from the I Want To menu or toolbar. 
Mouse/Touchscreen: Click or touch the record you wish 
to select or select multiple records.   
Keyboard: 

• Use the up/down arrow keys to navigate through 
the rows to select a different record. 

• Use <Ctrl + Home> to move to the first record in 
the list and <Ctrl + End> to move to the last. 

• Use <Page Up> to move to the first record 
displayed on the screen and <Page Down> to move 
to the last displayed record. 

• Use your arrow keys or <Tab> and <Shift + 
Tab> to move one column right or left, respectively, 
within the selected row. 

• Press <Home> and <End> to move to the first 
or last column in the selected row, respectively. 
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View 
record 
details 

Double-click the record or select it and click Details 
above the list. 

Edit a list 
item 

Select the record and then click Edit above the list. 

Change 
column 
widths 

Drag and drop the separator lines between column 
headers to change column width. 

  
  

  
All other lists   

This information applies to department, vendor, employee, customer order, purchase order, transfer history, and adjustment 
history lists. 

Shown is an example purchase order. 

 
The same list is shown below in collapsed view. The information panel on the right contains data from the 
record selected on the left. The top portion of this panel is customizable and the bottom shows the items listed 
on the selected PO. 
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Following are descriptions of the various functions available in these lists: 

To: Do this: 

Add, remove, 
or rearrange 

columns 

Right-click any column header and select 
customize columns, or drag and drop a column 
header to a new position. You can add, remove, 
and rearrange columns to meet your needs. 

Sort the list Click any column header to sort the list by the 
values in that column. Click the same header a 
second time to change the sort order (ascending 
or descending). A triangle icon indicates the 
column by which the list is currently sorted. You 
can also sort the list by multiple columns. 

Go to a 
record in the 
sort column 

To instantly go to an entry in the currently sorted 
column, begin typing the first few characters of the 
entry. For example, to go to a customer with the 
last name of Jones, first sort your customer list by 
the Last Name column (as described above), then 
start typing "Jo…" 
The typed characters are not displayed, but the 
closest matching record to what you typed is 
instantly located. You need only type enough 
characters to uniquely identify the entry for which 
you are looking. Learn more. 

Scroll 
through the 

list 

Use the scroll bar (on the right of window) to scroll 
through the list of records. The scrolling indicator  
displays your current position in the list. 
If the list is too wide to display on the screen, 
there will also be a horizontal scroll bar along the 
bottom of the screen to move left or right. 
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Filter the list Select a pre-defined or previously saved  Filter 
from the drop-down View menu at the top of the 
list and your records are instantly filtered, 
displaying only the matching records. Select 
Create Filter to enter custom criteria. You can 
save the custom filter for later use. Learn more. 

View list 
summary 
statistics 

Hover your mouse over the statistics field in the 
status bar at the bottom of the window. 

 
The statistics displayed pertain only to the 
currently displayed records and vary by list. Learn 
more. 

Search for a 
record 

Enter search keywords in the Find field at the top 
of the list and press <Enter>. The Find window 
displays all matching records, from which you can 
choose the one you want to work with. Advanced 
options to narrow filter results are also available. 
Learn more. 

Record 
selection & 

list 
navigation 

The selected record is highlighted and has an 
indicator arrow () pointing to it. With records 
selected, choose an action from the I Want To 
menu. 
Mouse/Touchscreen: Click or touch the record you 
wish to select or select multiple records.   
Keyboard: 

• Use <> to navigate through the 
rows to select a different record. 

• Use <Ctrl + Home> to move to the first 
record in the list and <Ctrl + End> to move to 
the last. 

• Use <Page Up> to move to the first 
record displayed on the screen and <Page 
Down> to move to the last displayed record. 

• Use your arrow keys or <Tab> and <Shift 
+ Tab> to move one column right or left, 
respectively, within the selected row. 

• Press <Home> and <End> to move to 
the first or last column in the selected row, 
respectively. 
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Editing fields 
in the list 

This feature applies to department, vendor, 
and employee lists only. 
To make edits in a list, you must turn on list edit 
mode. List edit mode is useful if you wish to make 
edits to multiple records on the same screen. 

To enable/disable list editing: 
Select List Edit On from the Edit menu. When 
finished editing, select List Edit Off to disable this 
feature. Leaving the list in any manner also turns 
off List Edit Mode. 
Advanced users may also want to use list edit 
mode to add new records. Just turn list edit mode 
on before selecting New in a list. 

Change 
column 
widths 

Drag and drop the separator lines between 
column headers to change column width. To 
adjust all columns to the width of their largest 
entry, right-click any column header and select 
Adjust Column Widths from the popup menu. 

View record 
in a form 

Double-click the record or press (<F8>). 

Tip: Right-click context menus in lists  
  
  

  
  
 These actions are common to both list types: 

To: Do this: 

Add, remove, 
or rearrange 

columns 

Right-click any column header and select 
customize columns, or drag and drop a column 
header to a new position. You can add, remove, 
and rearrange columns to meet your needs. 

Sort the list Click any column header to sort the list by the 
values in that column. Click the same header a 
second time to change the sort order (ascending 
or descending). A  small triangle symbol   
indicates the column by which the list is currently 
sorted. Select a link above to see additional 
options, that vary by list type. 

Scroll 
through the 

list 

Use the scroll bar (on the right of window) to scroll 
through the list of records. 
If the list is too wide to display on the screen, 
there will also be a horizontal scroll bar along the 
bottom of the screen to move left or right. 
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Search for a 
record 

Enter search keywords above the list. The system 
finds and displays matching entries.  Select a link 
above to see additional options, that vary by list 
type. 

Record 
selection & 

list 
navigation 

The selected record is highlighted. With records 
selected, choose an action from the I Want To 
menu. 
Mouse/Touchscreen: Click or touch the record you 
wish to select or select multiple records.   
Keyboard: 

• Use your up/down arrow keys to move 
through rows. 

• Use <Ctrl + Home> to move to the first 
record in the list and <Ctrl + End> to move to 
the last. 

• Use <Page Up> to move to the first 
record displayed on the screen and <Page 
Down> to move to the last displayed record. 

• Use your arrow keys or <Tab> and <Shift 
+ Tab> to move one column right or left, 
respectively, within the selected row. 

• Press <Home> and <End> to move to 
the first or last column in the selected row, 
respectively. 

Change 
column 
widths 

Drag and drop the separator lines between 
column headers to change column width. 

View record 
in a form 

Double-click the record. 

Return to top 
  
Related Topics 
Work with a form 
Program capacities 
Clean up your company data 

Customize List Columns 
How Do I?  

Note: Not all tasks apply to all list types. 

Sort and scroll in a list 

Filter a list 

Customize a collapsed list information panel 

Export a list 

Print a list 
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Complete other list tasks 

Customize my printed documents 

  
  
Use these procedures to add, remove, or rearrange the columns in a Point of Sale list. The procedure varies 
slightly depending on your list. Select the list type you are working with for specific instructions: 
Item, Customer, Sales History, or Receiving History lists    

This information applies to item, customer, sales history, and receiving history lists. 

To customize list columns: 
1. Right-click on any list column header. 

A list of available columns is displayed. The columns already shown in the list are at the top of the list with 
checkmarks. The remainder of the list is the available columns in alphabetical order. 

2. Scroll through the list and click the columns you wish to add (or click an existing column to 
remove it). 
3. When done, click anywhere outside the list to close it. 
4. In the list, drag column headers to put them in to the position you prefer and/or drag header 
divider lines to re-size the column width. 

  
All other lists   

This information applies to department, vendor, employee, customer order, purchase order, transfer history, and adjustment 
history lists. 

To customize list columns: 
1. Right-click on any list column header. 
2. From the popup menu, select either: 

• Adjust Column Widths to adjust the width of all columns to the width of the largest entry in 
the column. 

• Customize Columns to add, remove, or rearrange columns (see below). 

To add or remove columns, or to rearrange their order: 
1. Select Customize Columns as described above. 
2. Perform the appropriate actions: 

• To add a column: Select a column name in the Available Columns list on the left, then select 
Add. The selected column is added to the Chosen Columns list on the right. 

• To remove a column: Select a column name in the Chosen Columns list on the right, then 
select Remove. The selected column is added back to the Available Columns list on the left. 

• To rearrange column order: Select a column name in the Chosen Columns list on the right, 
then select Move Up or Move Down until it is in the desired position. 

• To reset columns to the default settings: Select Default. All columns are returned to the 
same state as when you first installed Point of Sale. 
3. Select Save. 

  

  
  

Notes: 
• You can rearrange column order or column widths directly in the list: 
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• To move a column, click and hold on the column header and drag it to the desired position. 

• To adjust a column’s width, click and hold on the separator (the small vertical line) between 
column headers and drag the separator until the column is the desired width. 

• Some columns (fields) in your item list can be renamed to better suit your business needs. Read the 
customizing field labels topic for more information. 

• Customizing the columns in a list does not affect how columns appear in reports or on printed documents. 
Read modifying report options for more information on customizing reports.  Read the Print Designer 
overview  fro information on customizing printed documents. 

Related Topics 
Locate a record or document 
Use custom fields 

Customize List Information Panels 
How Do I?   

Note: Not all tasks apply to all list types. 

Sort and scroll in a list 

Filter a list 

Customize list columns 

Export a list 

Print a list 

Complete other list tasks 

Customize my printed documents 

  
  

This topic applies to department, vendor, employee, customer order, purchase order, transfer history, and adjustment history lists. 

  
When a Point of Sale list is in collapsed format, the right side of the window is called the information panel. The 
information displayed is for the selected record in the collapsed list to the left and varies depending on the record 
type. 

• The bottom half of the information panel typically includes a history for the selected record or, in the case 
of a document, the list of items that were included in the transaction. Other information may appear for some 
record types. This information is often presented in report format and some report viewing options are 
available. 

• The top portion of the information panel, shown below, contains specific information fields from the 
selected record and task buttons that can be customized by adding, removing, or rearranging the fields to 
best suit your information needs. 
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To customize a list information panel: 
1. Select the Customize this window link at the bottom-right of the panel. 
2. In the window displayed: 

• Drag and drop fields and task buttons to position them where you want. 

• To add a field or button, drag it from the Available Fields area to the panel at the top. To remove 
a field, drag it down to the Available Fields area or press <Delete> on your keyboard. 

• Each panel column is split into two sub-columns. When placing data fields in a column, the field 
label is on the left and the actual data on the left. You can drag the separator (dotted line) between right 
and left sub-columns to change their relative widths. Right-clicking in a cell brings up a menu with other 
options, such as text alignment. 
3. Select Apply to implement your changes. 

  

Related Topics 
Work with Forms 

View a List Summary (Basic Statistics)) 
Work with Lists | Filter Lists 
  
The list summary, available for each Point of Sale list, displays basic statistics allowing you to quickly and easily 
obtain key information about your business without having to run a report. For example, while viewing your item list 
you can see at a glance your total number of items and the total on-hand quantity, cost, and price for those items. 
Other Point of Sale list summaries include statistics relevant to that particular area. 

To view a list summary: 
1. Display the list for which you wish to view the summary. 
2. Make sure the list View drop-down is set to show all records. 

OR 
Filter the list to show only certain records. The statistics displayed reflect the currently set list filter. 

3. Observe the list summary field in the status bar at the bottom of the window. In this example, the 
number of items in the item list (294) is the default statistic: 

 
Where more than one statistic 
value is available: 

• Hover your mouse over the displayed statistic to display a 
popup of the complete list summary. 

• Click the small down arrow on the status bar to change the 
default statistic displayed in the status bar. 

Notes: 
• Two security rights can be used to limit an employee's ability to view list statistics. In the General area, the 
View List Statistics right can block all rights to this feature or the View Cost Fields right can block viewing 
of cost-related statistics only. 

• Statistics are updated when a list is refreshed (exit/re-enter, re-sort, re-filter, save, etc.). Statistics are not 
dynamically updated when making changes in list edit mode. 

• A Statistics report, with item and customer list information, is available to add to your Dashboard. 

• When going to your item list to select items for a document, the statistics displayed reflect only the items 
for which a document quantity  has been entered. 

• (Pro) On-hand quantity information in list statistics do not reflect available or committed quantities. If using 
multiple units of measure, quantity information shown is for your base unit only. 
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• (Pro) Statistics are for the local store only. 

Filter a  List 
How Do I?  

Note: Not all tasks apply to all list types. 

Sort and scroll a list 

Customize list columns 

Customize a list information panel 

Print a list 

Export a list 

Customize my printed documents 
Show me an overview of Point of Sale lists 

  
  
Filters allow you to group and work with records or documents that have information in common. 
There are two list types in Point of Sale, with different filtering capabilities. Choose the list type you are working with 
for more information: 
Item, Customer, Sales History, or Receiving History lists    

This information applies to item, customer, sales history, and receiving history lists. 
  
Select a pre-defined  Filter from the drop-down list at the top of the window and your records are instantly 
filtered, displaying only the matching records. Shown is the item list filter. 

 
  

  
All other lists   

This information applies to department, vendor, employee, customer order, purchase order, transfer history, and adjustment 
history lists. 

In these lists you can select a pre-defined filter or create and save your own. 
You enter the criteria you wish to match and the program gathers and displays only the appropriate records. 
This is a highly useful feature when you want to view or work with a subset of a list or wish to restrict the data 
included in a report. 
This general filtering topic covers the basics of filtering in Point of Sale. Not all options shown here are available 
in every area, but the general instructions remain the same. 
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Tip: Define and save a custom filter  

To filter a list: 
1. Display your list, and then select one of the following from the drop-down list in the View field 
at the top of the window: 

• A predefined filter, such as All Records, This Month, This Week, etc. (choices vary by list) 

• A previously defined and saved custom filter (your custom names displayed) 

• Create Filter to define custom filter criteria, and optionally save it for future use 

• Manage Filters to edit, rename, delete, or rearrange the display order of your previously 
saved filters 

If you select a predefined or saved filter, the list is immediately filtered and the steps below do not apply. 
2. If creating a new filter, enter filter criteria values in any of the available fields. Learn more 
about entering filter criteria 

  

 
  

3. click Apply  (or Save, if you want to memorize the filter for future use. If saving, give your new 
filter a unique name and then click OK). 

  
The records matching your criteria are displayed (or included in a report). To return to the display of all possible 
records in a list, select the All <records> option from the View drop-down. 
  
Related Topics 
Manage list filters 
View list summary statistics 
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Notes: 
• When filtering for a time period, we recommend you select the shortest time frame practical for your 
current task. For example, filtering your sales history list for receipts made This Week or This Month results 
in a much faster display that filtering for All Receipts. 

Related Topics 
Locate a record or document 

Sort & Scroll a Record List 
How Do I?  | Find a Record 

Note: Not all tasks apply to all list types. 

Filter a list? 

Customize list columns? 

Customize a list information panel? 

Print a list? 

Export a list? 

Show me an overview of Point of Sale lists 

Customize my printed documents? 

  
  
Record lists can be sorted in either ascending or descending order by the information in the column or columns you 
choose. 
There are two list types in Point of Sale, with slightly different capabilities. Choose the list type you are working with 
for more information: 
Item, Customer, Sales History, or Receiving History lists    

This information applies to your item, customer, sales history, and receiving history lists. 

A  denotes the column and order by which the list is currently sorted. 
  

 

To sort a list: 

• Click or touch any column header. The list is sorted by the values in that column. Click the same 
column header a second time to reverse the sort order in that column (ascending or descending). 

To scroll to a record: 
1. Click a column header to sort the list as needed. 
2. Use the right-side scroll bar to move up/down through the list. 

  

  
All other lists   

This information applies to department, vendor, employee, customer order, purchase order, transfer history, and adjustment 
history lists. 



Printed Documentation 

48 

In column headings, a   indicates columns by which the list can be sorted and a  denotes the column and 
order by which the list is currently sorted. 
  

 

To sort a list: 
There are two ways to change the column by which this type of list is sorted. 

• Click or touch any column header displaying a  to sort by the values in that column. Click the same 
column header a second time to reverse the order of the sort (ascending or descending). 

• Right-click anywhere in the list, and select Sort List by and then choose a sort column from the 
choices displayed, or select Sort on multiple columns. If sorting by multiple columns, up to three 
columns can be selected in sort priority. 

To go to a specific record in the sorted column: 
This option does not apply to an item list on a document. 

1. Sort the list as described above. 
2. Begin typing the first few characters of the column entry for the record you wish to locate. The 
characters are not displayed as you type, but you are taken to the closest matching record. 

If you are sorted on multiple columns, the first column selected is the active column for purposes of this 
feature. 

To scroll to a record: 
1. Select a sort column. 
2. Use the right-side scroll bar to move up/down through the list. 

The scrolling indicator (see picture above) shows the record you are on as you scroll through the list. Release 
the scroll bar to access the displayed record. Note that the scrolling indicator displays the values in the currently 
sorted column. 
  

  
  
Related Topics 
Filter lists 
View list summary statistics 

Finding a Record or Document 
Quick Find | Point of Sale Basics 
  
There are three ways to locate records or documents in a Point of Sale list. Select a link for more information about 
an option. 

• Searching by keywords, across all  information fields. 
Area-specific search instructions: Customers, Items, Receipts, Customer Orders, Vendors, Departments, 
Adjustment Memos, Transfer Slips, Purchase Orders. 

• Sorting the list by a selected value (column). In many lists, you can then jump to a specific record by typing 
the first few characters of the record's entry in that column (the characters you type are not displayed). 

• Filtering the list by one of the predefined filter options. Some lists allow you to create and save your own 
list filters.   
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Related Topics 
Customizing list columns 

Using Quick Find from the Retail Navigator 
Locating a Record or Document 
  
The Home Page offers a Quick Find field to locate customers, inventory items, receipts, help, and more.  You can 
scan item or receipt bar codes into this field, or manually type customer names, document numbers, or any search 
keywords. 

 
  
As you type, the results are instantly displayed, broken down by record types. In the example shown, the letters 
"Pa" have been typed and records have been found in several categories. As more letters are typed, the results are 
narrowed helping you quickly find the record or help you need. 

 
• The first five matching records in each category are displayed. Click a record to open it or click 
Show all matching items to display additional records in a category. 

• To narrow or change your search, type additional characters or a new keyword. 

• The I Want To section lists matching Point of Sale tasks. Clicking an entry will open the screen 
from which you can complete that task. 

• (Pro) You can also enter item serial numbers to find all documents on which the serial number is 
listed.   

About the "I Want To" Menus 
 Work with Lists | Work with Forms 
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The I Want To menus provides you quick access to the various tasks related to your current window. The options 
on this menu vary depending on what screen you are currently working in.  

• To perform a task, click the I Want To button and then select a task. 
Related Topics 
Customize the navigation toolbar 
Switch between tasks 
Point of Sale basics 
Keyboard Shortcuts 

Export Point of Sale List Data 
Office Integration Overview | Import Data | Export Reports 
  

Note: This topic may refer to data types not applicable to your Point of Sale installation. For example, Point of Sale Free users 
cannot export customer, vendor, or item quantity/cost information and Basic users cannot export item pictures. 
 
Note: Excel must be installed on the workstation using this option. 

  
The Data Export Wizard walks you through exporting list data to an Excel spreadsheet, where you can then utilize 
Excel's features to further manipulate the data. You can choose to export all records in a list, all records currently 
displayed in a filtered list, or only selected records. 
Export templates determine the data fields included in the export and how that data appears in columns in Excel. A 
default template is provided for each record type. You can customize the default templates or create and save new 
ones to meet your needs. 

What would you like help with? 
Export records directly from a list (customers, vendors, items, departments, employees)  

1. Display the list you wish to export and filter, sort, or select the records you wish to export. 
2. From the I Want To menu, select Export to Excel. The Export Data Wizard is opened. 
3. Specify the records you want to export (selected, entire list, etc.) and select Next. 
4. Select a destination Excel file (.xls format) for the exported data: 

View example screen  

 
Sample Customer Export Screen 
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• Accept the default location and file name, or 

• Enter a location and file name to create a new file, or 

• Browse to an existing custom file that will receive the exported information 
5. Select the worksheet and starting row number in the spreadsheet file that you want to receive 
the data. The column headers will begin on the row you specify. 
6. Select the export template that you wish to use. The default template for the record type is 
suggested. Select Manage Templates to review, edit or create export templates. 
7. Select Next. 
8. Continue following the on-screen prompts to complete the export. 

  
Export customers from the Customer Center  (provides additional options for filtering by customer sales history) 

1. On the home page Navigator, click Customer Center. The Customer Center is opened. 
2. In the Reach Out to Your Customers section, click Export list to a file. The Export Wizard is 
opened. Make entries as needed on the following wizard pages. Click Next on each when ready to 
move to the next page. 
3. Select Customers: Select one of the choices on which to filter your customer list. View 
example screen  

 

4.   

• Recent Purchase—Include only customers that have made a purchase in the last x number 
of days (enter x). 

• No Activity—Contact only customers that haven't made a purchase in x number of days 
(enter x). Optionally, you can also elect to include only those customers that have made at least one 
purchase from you anytime. 

• Merchandise Interest—Contact only customers that have made a purchase from a particular 
department or vendor. Click the Select Department/Vendor button to specify which 
department/vendor. Optionally, you may limit the sales period to the last x number of days. 

• Custom—Create list based on filter criteria you enter. 
4. Custom Filter Pages: Displayed only if you selected Custom above. Learn more about using 
filters 
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• On the first page,enter filter criteria for information stored in your customer records (city, ZIP 
Code, customer type, reward program members, charge account customers, etc.). 

• On the second page, enter criteria to filter for information contained in your customer sales 
history. 
5. Review Customer List: This page displays the list of customers resulting from your previous 
entries and provides an opportunity to remove customers.  By default, all customers in this proposed 
list are selected for inclusion in the final list ( = selected). Remove customers by clearing their 
checkboxes. Clear/select checkboxes by clicking on them or by using the button options on the right. 
6. Destination File and Export Template: View example screen  

 
Sample Customer Export Screen 

  

7.   

• Select a destination Excel file (.xls format) for the exported data: 
 Accept the default location and file name, or 
 Enter a location and file name to create a new file, or 
 Browse to an existing custom file that will receive the exported information 

• Select the worksheet and starting row number in the spreadsheet file that you want to receive 
the data. The column headers will begin on the row you specify. 
 Select the export template that you wish to use. The default template for the record type is 
suggested. Select Manage Templates to review, edit or create export templates. 
7. Select Next and continue following the on-screen prompts to complete the export. 

  

  
Export item pictures 
  

Notes: 
• You can also select Utilities  Export from the File menu without displaying a list first. You can choose to 
export any of your lists or your item pictures.    However, the entire list is always exported with this selection. 

• Excel Worksheet Display Limit  
Related Topics 
Customer Center 
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E-mail Marketing from Point of Sale 
Write Letters from Point of Sale 

Work with Documents 

Understanding Point of Sale Documents 
How do I? 
  

Note: References to tracking item quantities or costs in this topic do not apply to Point of Sale Free. 

There are two general document types used in Point of Sale: transactional documents and order documents. 
Transactional documents record changes to inventory and provide a permanent history of those changes. 
Transactional documents can never be deleted, and in most cases cannot be edited after being saved. For this 
reason, transactional documents, after being saved, are also referred to as history documents. History documents 
are used to run reports, to build customer, vendor and item histories, and if you use QuickBooks financial software 
are sent to update your financial records. 
The transactional documents available in Point of Sale include: 

• Sales and return receipts, which record item sales, returns, and exchanges, i.e., quantities 
removed from or returned to inventory. Upon saving, receipts are added to your sales history list. Learn 
more. 

• Receiving and return vouchers, which record item quantities added to or removed from 
inventory when received from or returned to your vendors. Vouchers also update item costs and may, in 
the case of items being received for the first time, also update item price(s) in inventory. Upon saving, 
vouchers are added to your receiving history list. Learn more. 

• Adjustment memos, which are used to record changes to item quantities or costs not covered 
by other transactional documents. Adjustment memos are automatically created by Point of Sale for 
certain activities, such as when you conduct a physical inventory or manually edit an item’s quantity or cost 
in inventory. Adjustment memos can also be manually created to correct errors or update inventory for 
shrinkage, donations, or the removal of damaged merchandise. Upon saving, adjustment memos are 
added to your adjustment history lists (separate lists for quantity and cost memos). Learn more. 

• Transfer slips (Pro), which record the movement of item quantities between stores. Transfer 
slips have no affect on your company inventory value, but are used to maintain an accurate count of item 
quantities at each store, as well as recording freight charges related to the transfer. Upon saving, transfer 
slips are added to your transfer history list. Learn more. 

Order documents are used to plan the purchase or sale of merchandise or services. The information recorded on 
an order document, such as items, costs, prices, deposits, fees, and terms can be easily transferred to a 
transactional document when the merchandise is actually received or sold. Once recorded on a transactional 
document, the order document can be safely deleted. 
The order documents available in Point of Sale include: 

• Purchase orders (Basic), which are used to record the planned purchase of merchandise from a 
vendor. A purchase order indicates to your vendor that you wish to purchase a specified quantity of an 
item or items at a specified cost. When the ordered merchandise is received, it is recorded on a receiving 
voucher, which updates inventory accordingly. Learn more. 

• Customer orders (Pro), including layaways, sales orders, and work orders, which are used to 
record the planned sale of merchandise or services to customers. Customer orders typically involve taking 
a deposit when the order is placed, optional additional deposits over a period of time, and ultimately final 
payment when the merchandise or service is recorded on a sales receipt. Items listed on customer orders 
are deducted from inventory only after you record them on a sales receipt to fulfill the order. Learn more. 

Note: The In Progress field at the top of the page provides a drop-down list that displays tasks that you are 
currently working on. By making a selection from this drop-down list, you will be taken directly to the work area for 
that particular task.  This allows you to more effectively multi-task.  

Item Identifiers 
UPCs | Alternate Lookups | Bar Codes in Point of Sale 
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The term item identifiers refers to the Item #, Universal Product Code (UPC), and Alternate Lookup values for 
items in inventory. Item identifiers are used for looking up and listing items on documents, and for other program 
functions as described below. 
  

Item Numbers 
Every item (except special order items) has an Item # associated with it in inventory. You can edit the item number 
but cannot delete it. Valid entries are 1 through 999,999, 999. Item numbers above 999,999 are not recommended 
as the bar code would be too large to fit on the default tag templates. 
Item numbers are used to print bar codes on tags in Point of Sale. 
  

 
(Pro) If you prefer, you can use Print Designer to make bar codes printed from Point of Sale to reflect UPC or 
alternate lookup values instead. 
  

Universal Product Codes (UPC) 
Manufacturer-supplied tags with UPCs can be used to lookup and list items on documents, provided the UPC has 
been recorded in the UPC field on the item record in inventory. UPCs must be unique and can contain numbers 
only. 
The UPC field on an item record can be used to record UPC-E, UPC-A, EAN, or similar identifiers up to 18 digits. 
Point of Sale will convert UPC formats of less than 13 digits (such as UPC-A and UPC-E) to a 13-digit form using a 
standard conversion algorithm. 
Record UPC numbers manually or scan the preprinted tags from your vendors into the UPC field. 
Important: Do not scan bar codes created in Point of Sale from the item number into the UPC field. 
Likewise, if a vendor provides alphanumeric bar codes that are not true UPC codes, do not enter those codes into 
the UPC field. UPC codes have a required format, and other code formats are not accepted. Consider using the 
Alternate Lookup field for these codes instead (see below). 
  

Alternate Lookups 
An Alternate Lookup (ALU) is an optional field in inventory that can be used to lookup, list, and print items on 
documents. The use of Alternate Lookups is particularly well suited to retailers that do not tag merchandise or 
those that want to print documents, such as purchase orders, with alphanumeric product identifiers (such as a 
vendor’s part number). 
This field can contain text descriptions, catalog/part numbers, alphanumeric entries, abbreviated names, 
duplications of the Item Name field, etc., anything that allows you to quickly and positively identify a unique item. 
Alternate Lookups must be unique for each item for which they are defined. 
To be effectively used to list items on documents, each Alternate Lookup entry: 

• Should be a unique character string that can be easily remembered by cashiers. 

• Should not duplicate any items Item # or UPC code. 

• It is suggested that they start with a letter rather than a number. This helps ensure that Alternate 
Lookups do not duplicate an item or UPC number. If you have an Alternate Lookup of 1234 and item 
number of 1234, both will be returned as matches when you enter 1234 in the item lookup field on a 
document. 

To print documents that list your Alternate Lookup values, select document templates that have the "-ALU" suffix. 
Templates can be selected on the Print Options page in workstation preferences. 
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For more information about item identifiers, search the help index using the keywords UPC, Alternate Lookup, or 
Item Number. 

Use Bar Codes and Scanners 
Compatible Bar Code Scanners | FAQs | Physical Inventory Scanner 
  
Point of Sale can print bar codes and supports the use of bar code scanners to list items on documents make 
entries on item records. No special procedures are required to use a bar code scanner with Point of Sale. Follow 
the instructions supplied with your scanner to connect it to your PC. 
The program can read bar codes containing any of these item identifiers: 

• UPCs 

• Item numbers 

• Alternate lookup 
Assuming you have the scanned information recorded in inventory for the item, you can quickly list the item on 
documents by scanning the bar code. 
  

Printing Bar Codes on Tags in Point of Sale 
Every item has an item number associated with it in inventory. When you print tags from within the program using 
the default tag templates, it is the item number that is used to create the bar code. This allows you to print and scan 
barcoded tags for all your inventory items, whether or not they have UPC or Alternate Lookups defined. 
Using the item number for bar codes has several advantages: 

• You can print bar-coded tags for any item in inventory and then list them on documents using a bar code 
scanner, even if you do not have a vendor-provided UPC code. 

• Item number bar codes are generally smaller than bar codes created from UPC or alternate lookup values, 
meaning they fit better on smaller tag sizes. 

• If a tag bar code is unscannable, it is quicker to manually enter an item number (also printed on the tags) 
than the longer UPC or alternate lookup. 

(Pro) If you prefer, you can use Print Designer to change bar codes printed from within Point of Sale to reflect UPC 
or alternate lookup values instead. 
  
Print Tags:Overview 
  

Using a Scanner to Enter Information in Inventory 
Your scanner can also be used to quickly enter the bar code data into item records in inventory. For example, if 
your vendor supplies you merchandise pre-tagged with the UPC number, you can quickly and accurately enter the 
information into the UPC field on the item record by scanning the tag. You can scan vendor-provided bar codes 
containing catalog numbers into the Alternate Lookup field in the same manner. 
Edit item records 
Return to top 
  

Using a Scanner to List Items on Documents 
When scanning to list items on documents, Point of Sale assumes a quantity of one for each scan. To record a 
different quantity, press <F5> or navigate to the Qty field in the document item list to manually enter the correct 
quantity after each scan. 
Although scanning is extremely accurate, scanning errors can occasionally occur, especially when tags have been 
damaged or defaced. The scanner typically rejects read errors caused by defaced tags, and this scanned 
information never reaches Point of Sale. An error is reported if the scanned number is not currently defined in 
inventory or if the Alternate Lookup is not unique. 
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List Items on Documents: Overview 
Return to top 
  

Using a Scanner for a Physical Inventory Count (Basic) 
A physical inventory scanner is an optional, portable scanner that can record thousands of item scans and counts 
while moving around your store. You then connect the scanner to your computer and upload the counts to Point of 
Sale.   
Use a Physical Inventory Scanner 
Return to top 

List Items on Documents: Overview 
Use Bar Codes | About Item Identifiers | Find an Item 
  
The item list included on documents lists the items to be processed (received, sold, ordered, etc.). This list contains 
item details such as the description, price or cost, item discounts, etc. 
The default columns included in the item list will vary depending on the document you are completing. Most list 
navigation procedures apply, including the ability to customize the columns included in the list. 

Which type of document do you need help with? 
Sales Receipts or Receiving Vouchers  

In the Scan or enter item information drop-down box, scan or type item information to search for the item 
being listed (receipt example shown): 

 
Use any of these methods to add items to the document : 

• Scan the bar code from the item tag. 

• Type the item's UPC, Item #, or alternate lookup value and press <Enter>  Learn more about these 
item identifiers 

• Search by item name (beginning characters) or other item keyword. Just begin typing the name or 
keyword and a list of matching items is displayed. Select an item from the list by clicking  it (keyboard 
users, press the down arrow key to scroll, then <Enter> to select). The selected item is added to the 
document with a quantity of 1. 

 
 If no matching item is found, check your spelling or the identifier you entered. Entering fewer 
characters will find more matches. 

 To see your entire item list, click the  icon with no entry in the Add Item field. You can scroll 
through the list looking for the needed item. 

• Click Sell a Miscellaneous Item or Add a New Item to Inventory if needed. 
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Related Topics 
Quick Pick Items 
  

  
All Other Documents (Purchase Order, Customer Order, Adjustment Memo, Transfer Slip)  

 
  
With the cursor in the Enter Items field, do one of the following. Each of these procedures, except the last, 
adds the item to the document with a quantity of one. 

• Scan the item bar code; if one unique match is found in your item list, it is instantly listed. 

• Type the item UPC number, item number or alternate lookup value (collectively called item identifiers) 
and press <Enter>; if one unique match is found, it is instantly listed. 

• Begin typing the item description (based on Description 1 field in inventory); a drop-down list of your 
items is displayed with a match highlighted. Select it or another item from the list. 

• Type an item search keyword or keywords and then choose Find Items to the right of the Enter Items 
field. The Find Item window displays all item matches found, select an item or refine your search 
keywords and select Find again .until the item is located and listed. 

• From the I Want To menu, choose Select from Item List (<F4>) to open your item list in a special 
selection mode. Locate the item(s) and enter the quantities needed in the Doc Qty column of this screen. 

• (Pro) To choose style items, display the style grid and enter document quantities in the cells of the grid. 
Then choose Select from the bottom toolbar to return them to the document. 

Learn More 
Searching for an item by keyword 
Selecting items from inventory 
  

  
  

For general information about listing document items, select a topic: 
Scan or enter a UPC, Item #, or Alternate Lookup 

Quick Pick Items (receipt and voucher only) 

Using service or non-inventory items 

Enter decimal item quantities 

Add a new item to inventory while making a document 

Handle special orders 
List a group item 
List an assembly item 
List different units of measure 
View item quantities at other stores 

Editing Listed items: 

Edit items 
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Remove items from a document 

Select Items from Inventory 
Find an Item | Filter the Item List | Sort the Item List 
  

This topic applies to purchase orders, inventory adjustment memos, and transfer slips only. 

  
You can go directly to inventory to select items to list on a document or for other tasks. Once in inventory, the item 
list can be sorted, searched, or filtered to locate the correct item or an item can be added or edited before listing. 

To look up and select items in inventory: 
1. Choose Select from Item List (<F4>) from the document or task I Want To menu. 

This opens your item list in a special selection mode. 
2. Locate the items you want to list. 
3. Once you have located an item, use one of the following methods to bring it to the document: 

• To immediately return one item to the document, double-click it. The item is listed with a quantity 
of one. 

• From a document: Enter the quantity of each item to be listed in the Doc Qty  column in your 
item list. You can also specify the Doc Price  (if making a receipt or customer order) or the Doc Cost  (if 
making a PO, voucher, or cost memo). Navigate through the item list, making entries for all items you 
want to list on the document. When finished, choose Select from the bottom toolbar to return selected 
items to the document with the specified quantities and prices/costs. 

 
• From other tasks: Select the checkboxes to the left of an item to select it. You can also use the 
selection options from the I Want To menu to select all, clear all, or select multiple items. When finished, 
choose Select from the bottom toolbar to return selected items to the task form or list. 

 
• If you need to list a large number of style items, as you might on a PO, voucher, or adjustment 
memo, highlight a style item and then, from the I Want To. menu select Edit/Add Style. Enter document 
quantities (or select checkboxes for other tasks) directly in the style grid cells corresponding to each style 
item. When done, choose Select. 
4. Repeat steps 2-3 to locate and list all the items you need. 

  
Full item editing is possible while in the item selection screen. This feature allows the flexibility to perform tasks, 
such as adding items as new merchandise is being ordered, received, or sold. 
  
Tip: Filter your item list to display a single vendor's items  
Note: Add a new style while creating a document  
  
Related Topics 
Add a new item while creating a document 
List items on documents 
Inventory overview 

Edit Items Listed on Documents 
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List Items | Delete Items | Edit Saved Documents 
  

You can edit an item on a transactional document only until the document has been saved. You can edit items on order 
documents at any time. 

These edits will affect only the listed items on the document; they will not affect the corresponding items in 
inventory. The fields that can be edited vary by document, but typically edits are made to: 

• Change the quantity, price, cost, or give an item discount 

• Change an item’s tax code, when special tax handling is needed 

• Edit the item description; sometimes used on service or non-inventory items 

• (Pro) Enter item serial numbers 

• (Pro) Change the sales Associate on a line-item basis for commission tracking 
The procedure here is for editing an item on a sales receipt. The general procedure is the same on other 
documents, though choices may vary slightly. 

To edit a listed item: 
1. Highlight the item you wish to edit on the receipt.. 

If you just listed the item, it is automatically highlighted and this step is not necessary. 
2. Make edits as necessary: 

• Click Qty + and Qty –  to increase or decrease the item quantity respectively. 

• Select Return Item to change the quantity to negative (a negative quantity adds the item back to 
inventory) 

• Click Qty/Price/Discount to open a dialog allowing you to edit any or all  of these things in a 
single window 

• Click Edit to open the Item Information window to access other editable fields. 

• Or, make changes directly in the item list. You may have to add columns to the list for this option 
to be available. 
3. Make other entries on the document as necessary and then take payment and save. 

  
Related Topics 
List and edit a group Item 
List an item assembly on a document 
List different units of measure on documents 

Enter a Customer on a Receipt 
Customer Overview | Make a Sale 

Basic  

Entering customers when making sales is optional; though it can be required with a company preference setting. 
Entering customers allows you to build customer purchase histories and to offer customer-specific discounts, price 
levels, and tax locations. 
Any customer on file can be entered and a new customer can be added while completing a sale. 

To enter a customer on a receipt: 
1. In the Customer field, begin typing the customer last name (recommended) or other search 
keyword (first name, phone number, company name, etc). 

As you type, Point of Sale shows a drop-down list of your matching customers, separated into last name 
matches and matches using all customer fields. If there are last name matches, they are displayed first. Click 
the results line to open all field matches if necessary. 
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Option: With no entry in the field, you can click the  icon to show your entire customer list. You can scroll 
through the list to look for the customer. 

2. Click a name to select it. Keyboard users can use the arrow up/down keys to move through the 
list and <Enter> to make a selection. 

The customer is added to the customer field on the receipt and their phone number and address is displayed 
for confirmation. 

• If the customer has an associated discount, price level, or special tax handling, it is suggested or 
automatically applied to the sale 

• If the customer isn't in your list, click Add New Customer to create a new customer record 

• Click the View/Edit button to open the customer record or the Delete button to remove the 
customer from the receipt 

 
Not all customer information is displayed on a receipt. For example, the customer's charge account information and 
check acceptance status are not displayed. However, you will be notified if a credit limit is exceeded, if checks are 
not accepted, or if a reward is available for the customer. 
  
Related Topics 
Customer charge accounts 
Customer rewards program 
Add a new customer 

History Documents 
Find a Document | Copy a Document | Edit a Document 
  

Updated transactional documents, including receipts, vouchers, adjustment memos, and transfer slips are called 
history documents and are stored in your document history lists. History documents provide a permanent record of 
all transactions that have affected your inventory and provide an accurate audit trail of changes. 

To view your document history lists: 
1. From the specified menu, select: 

• Sales History from the Point of Sale menu to view saved receipts 

• Receiving History from the Purchasing menu to view saved vouchers (Basic) 

• Adjustment History from the Inventory menu to view saved memos (Basic) 

• Transfer History from the Inventory menu to view saved transfer slips (Pro) 
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2. Use standard sort, search, and filter procedures to locate the desired document. 
  

Notes: 
• Your transactional history is used for reporting, to build customer, vendor, and item histories, and can be 
accessed to view, reprint, or copy a saved document. 

• History documents can never be deleted and, with the exception of some informational fields, generally 
cannot be edited. But they can be reversed if necessary to make a correction. Reversing a history document 
does not remove the original document; rather it creates a new document with the opposite effect. 

• If integrated with QuickBooks financial software, all history documents are sent to update your financial 
records. You can view the linked QuickBooks documents and transactions related to any Point of Sale history 
document by selecting the document and then selecting View Financial Details from the I Want To menu. 
Learn more. 

• (Pro) All history documents created at remote stores are sent to Headquarters to update inventory and 
QuickBooks and are included in Headquarters history lists and reports. Documents made at Headquarters 
are not sent to remote stores; therefore remote store histories only reflect the documents made at that store. 

Related Topics 
How documents affect inventory 
Remove old documents 

Edit Documents 
Enter Data in a Field | Find a Document 
  
This discussion assumes you require employee logins and are using default settings. Your actual ability to edit 
documents will vary based on your security rights, features used, and in a multi-store configuration, your store 
location (Headquarters or remote). 
  

Order Documents 
Purchase orders and customer orders, since they have no direct effect on inventory, can be freely edited at anytime 
(edits to some fields may be restricted if deposits have been accepted towards the order). 
How do I edit a purchase order? 
How do I edit a customer order? 
  

Transaction (History) Documents 
Before saving, all information on transaction documents can be edited. 
However, transaction documents immediately affect your inventory as soon as saved. If integrated with QuickBooks 
they may have also already affected your financial records. After saving, only certain informational fields can be 
edited. Edits that affect the items, total, or payments are generally not allowed (see voucher exceptions below). 
Once sent from a remote store to Headquarters or to your QuickBooks financial software, the ability to edit is even 
more limited. 

What can be edited? 
Receipts: After saving, you can edit the customer, comments, promotional code, and, if a Pro user, the shipping 
information (except amount). After sending to Headquarters or to QuickBooks, you can no longer edit the customer 
or promotional code. Edit options are available from the I Want To menu in Sales History. 
Receiving Vouchers: Certain voucher fields, such as discounts, freight, fees, and vendor billing information may 
be edited after saving and, at Headquarters, even after sending to QuickBooks, depending on where you enter 
vendor billing information and if you spread discount, freight, and fees across item costs. Edit options are available 
from the I Want To menu in Receiving History. 
Adjustment Memos: Memo comments can be edited after saving. Once sent to Headquarters or QuickBooks, no 
fields are editable. Select Edit from the toolbar in your Adjustment History. Editable fields are white in color. 
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Transfer Slips: Slip comments, carrier, and freight can be edited after saving. Once sent to Headquarters or 
QuickBooks, no fields are editable. Select Edit from the toolbar in your Transfer History. Editable fields are white in 
color. 
  

Correcting a Document When Editing Isn't an Option 
If you discover an error on a history document that is not editable, it can still be corrected by reversing the original 
document and then creating a new, corrected one. This feature is intended for correcting errors and should be used 
only when necessary. 
Select a link below to learn more about reversing various documents: 
Reverse and correct a receipt 
Reverse and correct a receiving voucher 
Reverse and correct an adjustment memo 
Reverse and correct a transfer slip 

Copy a Document 
Find a Document | Edit a Document | Reverse History Documents 
  
Copying a previously saved document is sometimes the fastest way to create a new document, especially if you 
want to list the same items, costs, prices, customer or vendor, etc. 
See examples of when you might use this procedure  
(Pro with multiple stores) Headquarters can copy documents originally made at other stores. Remote stores are 
limited to viewing and copying documents made at their own store. 

To copy a document: 
1. Locate and highlight/display the document to be copied in the appropriate document list. 
2. Select Copy from the I Want To menu (or from the window toolbar in some areas). 

A new document is created with most of the same information as the original. See the note below for what is 
not copied. 

3. Edit the new document, as necessary. 
You can add or delete items, change quantities, costs, or prices, and edit other fields as needed. 

5. If making a receipt or customer order, take payment or a deposit, and give change (refund), as 
applicable. 
6. Print/Save the document. 

  

Notes: 
• The following information is not copied from the original document: 

 Document number and date 
 Payments, deposits,or shipping information on receipts and customer orders 
 Gift card/certificate sales 
 Item serial numbers 

• If an item listed on the original document has been deleted from inventory, the deleted item is removed 
from the copy automatically. Changes to an item's description or other information in inventory will not affect 
copying. 

• You cannot copy a held document, a Pay Out receipt, or a deposit receipt. 

Cancel or Hold a Transaction in Progress 
Find a Document | Edit Documents | Reverse Documents 
  
A sales receipt or other transactional document can be canceled or put on hold at any time before saving. 
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Exception: Sales receipts with authorized credit, debit/ATM, or gift card payments cannot be put on hold. See note 
below. 

• Canceling permanently discards the document; no record is kept and inventory is not affected. 

• Holding a document temporarily saves it in its present state. Holding a document does not affect inventory 
quantities. Later, you can return to a held document, complete and save it, at which time inventory will be 
updated. 

What would you like to do? 
Cancel a transaction in progress  

1. Select Cancel from the bottom of the document anytime before saving. 
2. In the confirmation dialog, answer Yes to discard the document. 

Or, answer No to return to the transaction. 

  
Hold a transaction in progress  

• From the bottom of the document, select Put on Hold (or Hold <document type>). 
While a document is on hold, you can print, view, or delete it. (May be subject to security rights) 

  
View or take a transaction off hold and complete it  

1. Access the held document list by selecting, as appropriate: 

• Held Receipts from the Point of Sale menu 

• Held Vouchers from the Purchasing menu 

• Held <Quantity or Cost> Memos from the Inventory menu 

• Held Transfer Slips from the Inventory menu 
You can also make this selection from the bottom of a blank document of the same type. 

2. Locate and highlight the document, then select Unhold. 

• You can also print, view, or delete held documents. (May be subject to security rights. No 
copy of a deleted document it is kept.) 

• (Pro) Held receipts can be converted to customer orders. With the held document selected, 
choose Make Customer Order  and an order type from the I Want To menu. 

• To leave the held list without un-holding a document, select Go Back (or Close). 
2. Complete and save the document in the usual manner. 

  

  
  

Notes: 
• Placing a document on hold temporarily sets it aside. With a document on hold you can carry out other 
activities, make another document of the same type, run reports, or even exit from Point of Sale. There is no 
time limit for how long a document can be left on hold. 

• If changes are made to your sales tax rates, item prices, a customer's discount, etc. while a document is 
on hold, that document will not automatically reflect the new information when it is unheld. The unheld 
document retains the original information. If necessary, delete and re-list the item(s) and/or customer in order 
to reflect changes. 

• The document number field on held documents is temporarily changed to "Held". A new document number 
is assigned when the document is taken off hold and completed. 

• If using the QuickBooks POS Merchant or Gift Card Services, you cannot hold authorized credit card or gift 
card sales receipts. You will have to cancel/void the payment first. When canceling a credit card sales, the 



Printed Documentation 

64 

customer’s account is never charged. When canceling a gift card receipt, Point of Sale contacts the gift card 
service to update the card balance. 

• Once authorized, debit/ATM receipts cannot be held or canceled. This is because the cardholder's account 
has already been debited for the sale amount. 

• In a multi-workstation environment, a held document can be accessed and unheld from any workstation on 
the network. 

Reverse a History Document 
Find a Document | Copy a Document | Edit a Document 
  

Note: Note: This is a general procedure for reversing documents. See the related links at the end of the topic to learn more about 
the effect of reversing specific document types. 

  
Reversing a history document has the opposite effect on inventory of the original. For example, if the original 
document was a sales receipt that subtracted items from inventory, then reversing it adds the items back to 
inventory. It does this by creating a new reversing document. In the case of a sales receipt, the reversing document 
is a return receipt. 

To reverse a history document: 
1. Locate and highlight/display the document to be reversed in the applicable history list. 
2. Select Reverse <document type> from the I Want To menu. 
3. The Reversing Document dialog is displayed. If necessary, select your name from the Associate 
field drop-down list and select OK. 

If necessary, a new, corrected document can then be made as described here. 
  

Notes: 
• The reversing document with your name is automatically created and added to the history list. 

• When completed, the original document will be flagged Reversed in the Status field and the new 
document that was created will be marked Reversing. The Status field is displayed in the history list of each 
document type. 

• If the reversed document references an order document, the fill status and balances of the order document 
are updated to reflect the change, provided it has not been deleted. 

• If an item previously deleted from inventory is included on the document being reversed, Point of Sale 
automatically adds the item back to inventory. Learn more  

• (Pro) The reversal of history documents at a remote store is allowed only until the document has been sent 
to Headquarters. 

• If integrated with QuickBooks financial software and if the original document has already been sent to 
QuickBooks, then the reversing document is also sent and posts in the normal manner for that document type 
(for example, as a return receipt or return voucher.) These new records and account entries in QuickBooks 
cancel the effect of the original document. The original entries are not edited or removed. If the original 
document has not yet been sent, then both are flagged "Do Not Send" and there will be no entries made in 
your financial software for the transaction. 

Related Topics 
Reverse sales receipt 
Reverse a receiving voucher 
Reverse an adjustment memo 
Reverse a transfer slip 

Email a PO  
Basic  
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You can e-mail Point of Sale documents to your vendors and customers. All documents are e-mailed using the 
same basic procedure. 
When e-mailing documents, Point of Sale automatically launches your default Windows e-mail client, creates the e-
mail, and attaches the document in PDF format. 
(Pro) Other document e-mailing preferences allow you to create the document attachment in the format of your 
choice (PDF, Excel, HTML, or plain text) and define the default message text for each document type. 
You must have entered e-mail addresses for the customer and/or vendor being e-mailed on their respective 
records. 
  
To e-mail a document: 

1. Create the document following normal procedures. 
2. Display or select the document to be e-mailed: 

• Optionally, you can set your printing preferences to be prompted to e-mail each sales receipt to your 
customers (in addition to printing the receipt). This option also provides you an opportunity to collect 
customers' e-mail addresses if you don't already have them. 

• Order documents, such as purchase orders and customer orders, can be e-mailed while creating them or 
from the order list.  

• Transactional documents, other than sales receipts as described above, must be saved before they can 
be e-mailed from the document history list. 

4. Select Send as E-mail from the I Want To menu (or from window toolbar in some lists). 
 
Point of Sale creates the e-mail, attaches the document, and displays it in your default e-mail client.  
 
Important: Your e-mail client may display a permissions dialog for access to your e-mail application. In 
some cases, the message may be hidden under the POS window. Press <Alt+Tab> on your keyboard to 
switch to the message and give permission for the access. 

5. Review and edit the e-mail address, subject line, and message as necessary, and then select Send. 
Note: If you also have Microsoft Outlook installed, the e-mail and attachment will be generated in Outlook instead. 
You can either select Microsoft Outlook as your default e-mail client or, if you wish to continue using Outlook 
Express, use the Add or Remove Programs option from the Windows Control Panel to uninstall Microsoft Outlook. 

Record Item Serial Numbers 
List Items on Documents | Find a Document 

Pro 
Item serial numbers can be recorded on documents for purposes of warranty tracking or meeting legal 
requirements. Once recorded, former documents can be quickly located by searching by serial number. 

To record serial numbers: 
1. In inventory, specify those items for which you want to record serial numbers by selecting the 
checkbox for Use Serial #, located in the Misch and Shipping section of the item record. (Note: For an 
existing item, select Edit first.) 
2. When listing these items on documents (except purchase orders and cost memos), you will be 
prompted to enter a serial number for each unit being processed. 

  

Notes: 
• The serial numbers entered are saved and printed on documents. Serial numbers listed on a customer 
order are carried to the sales receipt when the items are sold, saving you the time of re-entering them. 

• The recording of serial numbers on documents is optional, even when you have enabled serial number 
tracking. To continue creation of a document without entering a serial number, click Cancel from the Enter 
Serial Number dialog. 

• You can record serial numbers even when not prompted. After listing the item, click  Edit and make an 
entry in the Serial # field. 
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• Point of Sale does not keep track of the serial numbers of items currently in inventory. 

• If you decrease an item quantity on a document after having entered serial numbers, the previous numbers 
are cleared and you are prompted to re-enter numbers for each unit of the revised quantity. This is because 
the program has no way of knowing which specific unit(s) you are removing when you adjust quantities 
downward. 

Locating a Former Document by Serial Number 
You can locate a former document by serial number using search. For example, a former receipt for the sale of an 
item with serial number 23487497 could quickly be located by entering the serial number in the Quick Find  box on 
the home page or in the Search field at the top of your Sales History list and. 

Navigation and Data Entry 

Home Page 
Keyboard Shortcuts | Mouse & Touchscreen 
  
The Point of Sale Home Page provides access to program areas, analytical tools, and assistance in setting up and 
learning to use Point of Sale. In most cases, you return to the Home Page anytime you want to start a new task. 
 The Home button, located at the top-left of all Point of Sale task windows will bring you back to the Home Page at 
any time.  
Here are the main features of the Home Page:  

• The Navigator is a graphical representation of the work flows used  to perform routine retail tasks. Click on 
any enabled icon on the Navigator to go directly to the screen for the selected task. The Navigator is 
divided into four sections: 

• Point of Sale 

• Purchasing 

• Employees 

• Operations (vertical section on the right)  

• To the left of the Navigator, are buttons for commonly used tasks. These left navigation buttons can be 
changed by doing a right-click just below the buttons and then click on Customize Buttons. 

• If you turn off a feature in company preferences, the related menu choices and icons are removed from 
the Home Page. 

• The In Progress field at the top of the Home page provides a drop-down list that displays tasks that you 
are currently working on. By making a selection from this drop-down list, you will be taken directly to the 
work area for that particular task.  This allows you to more effectively multi-task.  

• Use the pull-down text menus at the top of the screen to access other tasks. 

• Use the Quick Find Search field to look up a customer, item, or sales document directly from the 
Navigator window. 

• To the right of the Navigator is the Message Board, displayed on the Home Page and accessible from the 
receipts, inventory, receiving, and customer areas, allows you to leave notes for yourself or other 
employees. Point of Sale will also post messages for you when something needs your attention, such as 
inventory reminders.  Use the Search message to find a specific note.  

• Click the cloud icon to sync to Mobile or to check on sync preferences and activity.  

• Click the monitor icon at the top right to expand your screen view. Click again to decrease the view.  

• Select Home from the top of the screen to return to the Home Page at any time. 

Note:   The icons and activities available on the Home Page will vary depending on the level of Point of Sale you 
have purchased, the features you are using, and your assigned security rights. 
  
Related Topics 
Customize the navigation toolbar 
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Home Page Dashboard 
Point of Sale Basics 

Customize the Navigation Toolbar Buttons 
Use this procedure to add or remove buttons on the navigation toolbar on the left of the Home Page, receipts, and 
vouchers. 

To add or remove navigation buttons: 
1. Right-click the button toolbar. 
2. Click Customize. 
3. Select the field for the button you'd like to add and click the right-arrow to move it to the selected 
fields column. 
4. When done, click Finish.  

  
Related Topics 
Mouse & Touchscreen Navigation 
Keyboard Navigation 

Switch Between Tasks 
Home Page 
  
There may be times when you are working on one task in Point of Sale and you need to do another, but you aren't 
done with the first. 
For example: 

• You are making a receiving voucher for a shipment that just arrived when a customer walks up ready to be 
rung up. 

• Your making a purchase order but need to check inventory or a report for information to complete the PO. 
Point of Sale allows you to switch to another area to complete a second task and then switch back to the original 
task to complete it. 

To switch between tasks: 
1. From your current window, select Switch To from the I Want To menu. 
A list of tasks in progress is displayed (Make a Sale is always displayed even if you don't have a receipt in 
progress). 
2. Select the task or document you wish to switch to. 
3. When done with the second task, use Switch To again to return to your original task. 

  

Notes: 
• Only one task in a give area can be on the Switch To list at one time, for example one receipt, one PO, etc. 

• It is a good practice to close tasks you are not actively working on. On transaction documents, you can put 
the document on Hold. On other documents and records, you can save them at anytime and return to them 
later to finish. 

• Some features, such as editing and saving some company preferences, require that all areas be closed 
before the action can be completed. 

  
Related Topics 
Keyboard Navigation 
Mouse & Touchscreen Navigation 

About the "I Want To" Menus 
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 Work with Lists | Work with Forms 
  
The I Want To menus provides you quick access to the various tasks related to your current window. The options 
on this menu vary depending on what screen you are currently working in.  

• To perform a task, click the I Want To button and then select a task. 
Related Topics 
Customize the navigation toolbar 
Switch between tasks 
Point of Sale basics 
Keyboard Shortcuts 

Finding a Record or Document 
Quick Find | Point of Sale Basics 
  
There are three ways to locate records or documents in a Point of Sale list. Select a link for more information about 
an option. 

• Searching by keywords, across all  information fields. 
Area-specific search instructions: Customers, Items, Receipts, Customer Orders, Vendors, Departments, 
Adjustment Memos, Transfer Slips, Purchase Orders. 

• Sorting the list by a selected value (column). In many lists, you can then jump to a specific record by typing 
the first few characters of the record's entry in that column (the characters you type are not displayed). 

• Filtering the list by one of the predefined filter options. Some lists allow you to create and save your own 
list filters.   

Related Topics 
Customizing list columns 

View Records or Documents 
Find a Record or Document | Point of Sale Basics 
  
There are two ways to view Point of Sale records and documents. Click a link for more information about working in 
each view. 

• Lists display many records or documents at one time in a format similar to a spreadsheet. The list can be 
easily sorted, searched, or filtered to help you find a particular record or to group similar records. 

• Forms provide a more detailed view of an individual record or document on a single screen. Form View is 
typically used when creating or editing records or documents. 

Related Topics 
Enter data 
Program capacities 
View list summary statistics 

Add a New Record Using Copy 
Point of Sale Basics | Find a Record or Document 
  

Note: This is a general procedure. For a list of topics related to using the copy function for specific document or record types, 
search the help index using keyword "Copying" and choose a specific topic. 

To add a new record by copying an existing record: 
1. Select the record you want to copy from the record list. 
2. Select Copy from the I Want To menu. 
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OR 
 Click Copy <record> on the window toolbar (where available). 
A new document/record form is opened, with information from the original record copied to the appropriate 
fields. 

3. Make edits to the copied information, as necessary. 
4. Select Save. 

Enter Data in a Field 
How Do I?   | Forms | Lists 
  
Use standard navigation techniques (such as arrow keys, <Tab>, click, or touch) to access the field in which you 
want to enter data. To accept an entry or bypass the field, press <Tab> if in a form or <Enter> in a list or navigate 
to the next field in any other manner. Most data entries require that you navigate out of the field to record the entry. 
Quick topics for various field types. 

Blank fields  Quantity fields  

Read-only fields  Note fields  

Checkbox fields  Drop-down lists  

Currency fields  Suggested entries  

  
Related Topics 
Document/record data field descriptions 
Enter dates and times 
Program capacities 

Edit a Non-Document Record 
Point of Sale Basics | Find a Record 
  
This general procedure applies to editing items, departments, vendors, customers, and employees. 
Click here for information about editing documents. 
  
Use the general edit procedure below, or select a record type for specific instructions: 

Edit a department Edit a customer record 

Edit an item Edit a vendor record 

Edit an employee record Edit a time entry 

To edit a non-document record: 
1. Use standard sort, search, and filter procedures to locate the desired record in the applicable list. 
2. Highlight the record and select Editfrom the window toolbar or I Want To menu. 
3. Navigate through the fields of the record, making changes as necessary. 
4. Select Save. 

Or, select Cancel at any time before saving to discard your edits. 
  

Notes: 
• Only fields white in color can be edited. Gray fields cannot be selected or changed. If you believe you 
should be able to edit a field but cannot, check the logged-in user's security rights or read Why is a Point of 
Sale feature not available to me? 

• In some non-document lists, you can edit records directly in the list using list edit mode. 
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• Use caution when editing information that is a component of other records or documents. For example, if 
you edit a department or vendor name you must also edit any items in inventory that contain that department 
or vendor name as part of the item record. 

Related Topics 
Enter data 
List items on documents 

Edit or Add Records in a List 
Filter Lists | Sort Lists | List Overview 
  

This topic applies only to department, vendor, and employee lists. 

  
With list edit mode turned on, you can make changes in editable fields or add new records directly in a list, moving 
field-to-field in a single row or between rows, similar to working in a spreadsheet. 
Technical Note: How editing in a Point of Sale list differs from a spreadsheet  
  

To enable/disable list editing: 
1. Display your record list and, if necessary, add columns for the values to be edited . 
2. From the window toolbar, click the small down arrow next to the Edit button and then click Turn 
List Edit On. 

  
3. Make edits by navigating field-to-field and entering new values. 
4. When done making edits, repeat Step 2, selecting Turn List Edit Off. 

Leaving the list in any manner also turns off list edit mode. 
  

Notes: 
• To select a record (row) or field for editing, touch or click once, or use the arrow keys to navigate between 
fields. Immediately begin typing to make an entry in an empty field or to overwrite an existing entry. Click a 
second time to edit an existing entry character-by-character. Press <Enter> or navigate out of a field to 
accept the entry and move to the next field. 

• Your changes are automatically saved when you navigate out of a row; you do not have to select Save. To 
cancel the edits made in a row, select Cancel from the bottom toolbar before navigating out of the row. 

• You can select multiple rows  for certain group operations, such as printing, exporting, or deleting. 

• If you need to make the same change to many records (such as updating an area code or ZIP code), sort 
or filter the list to display just those records. Enter the new value in the first record, then highlight it and press 
<Ctrl+C> to copy the value. Use your up and down arrow keys to move to the same cell in all th eother 
records and press <Ctrl+V> to paste the updated value. 

Related Topics 
Edit a single record 
Edit a document 
Edit item styles in inventory 

Date Fields 
Quick Entry Date Formats | Time Fields 
  
Entering Dates 
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There are two types of Point of Sale dates: fixed dates and dynamic dates. 

• Fixed dates are fixed in time. For example, if you enter 05/20/06 or a date range of 01/01/2006 – 
12/31/2006, then this will be the recorded date, no matter how much time has passed. Document dates are 
fixed dates; but most allow you to change the date while creating it (subject to security rights). 

• Dynamic dates allow you to define a single date or date range relative to the current Point of Sale date, 
such as Today or Month-to-Date. As the Point of Sale date changes, so does the dynamic dates. Dynamic 
dates are typically used to define date ranges for filtering lists and for reporting purposes. 

Note: A security right is available to block your employees from changing the date on a receipt. 

To enter data in a fixed date field: 
1. Select the date field and do one or a combination of the following: 

• Enter the date directly. 

• Select  (<F4>) to access a drop-down calendar. 

• Today’s date is highlighted in red, and the currently selected date is shown in blue. Use the arrow 
keys to move from day to day in the displayed month. 

• To view the previous or following month, select  (PageUp) or  (PageDown) respectively. Click 
the date you want to select, or highlight the date and press <Enter>. 
2. Press <Tab> or navigate out of the field. 

  

 Warning: Do not change your Windows® system date to record a different date on a Point of Sale document. Data loss 
could result. 

  

To enter data in a dynamic date field: 
1. Choose a range from the Date filter type field in the Dynamic Date Filter dialog. 

• Use your mouse or touchscreen or press <> or <> to move between the selections and 
press <Enter> to choose a range. See dynamic date range options for help with selecting a range. 

• If you choose a fixed period (Custom), use the fixed date procedure for picking dates. To access 
calendars, select  (<F4>). 
2. Select OK to apply your selected date range. 
3. Press <Tab> or move out of the field. 

Return to top 
  
Related Topics 
Filter lists 
Define filter criteria 
Change report dates 
Enter data 

Lookup Fields 
Point of Sale Basics | Entering Data 
  
Lookup fields are used to bring data from another file to the document or record in which you are working. An 
example is the Customer field on sales receipts, as shown below. 
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Lookup fields are directly linked to the associated file. You have the following options from a lookup field: 

• Search for a record by keyword 

• With no entry, click  the field to display all records in the associated file 

• Select Add New <record> from the drop-down list to add a new record of this type and list it on 
the document 

Note: Looking up items from documents is slightly different (see listing items on documents). 

To use lookup fields: 

• Scan or begin typing an entry in the lookup field. You need only enter enough characters to 
ensure a unique match in the associated file. 

The drop-down list is automatically activated and the closest match(es) to what you type is shown. Click a 
record (<Enter>) to bring it to the document. Otherwise continue with the following steps. 

  

Lookup alternative (not available from all documents): 
1. Choose the Select from <record type> List from the I Want To menu to directly access the 
associated file. 

Example: Select from Vendor List to access the vendor file. 
2. In the list, use standard sort, search, or filtering procedures to locate an existing record. 
3. Once the record is selected, choose Select or double-click to add the record to your document. 

When you access the customer, department, or vendor files during a lookup, you have full editing capabilities in 
that module. This makes it possible to add or edit records without closing the original module. 
  
Related Topics 
Listing items on documents 

Use Bar Codes and Scanners 
Compatible Bar Code Scanners | FAQs | Physical Inventory Scanner 
  
Point of Sale can print bar codes and supports the use of bar code scanners to list items on documents make 
entries on item records. No special procedures are required to use a bar code scanner with Point of Sale. Follow 
the instructions supplied with your scanner to connect it to your PC. 
The program can read bar codes containing any of these item identifiers: 

• UPCs 

• Item numbers 

• Alternate lookup 
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Assuming you have the scanned information recorded in inventory for the item, you can quickly list the item on 
documents by scanning the bar code. 
  

Printing Bar Codes on Tags in Point of Sale 
Every item has an item number associated with it in inventory. When you print tags from within the program using 
the default tag templates, it is the item number that is used to create the bar code. This allows you to print and scan 
barcoded tags for all your inventory items, whether or not they have UPC or Alternate Lookups defined. 
Using the item number for bar codes has several advantages: 

• You can print bar-coded tags for any item in inventory and then list them on documents using a bar code 
scanner, even if you do not have a vendor-provided UPC code. 

• Item number bar codes are generally smaller than bar codes created from UPC or alternate lookup values, 
meaning they fit better on smaller tag sizes. 

• If a tag bar code is unscannable, it is quicker to manually enter an item number (also printed on the tags) 
than the longer UPC or alternate lookup. 

(Pro) If you prefer, you can use Print Designer to change bar codes printed from within Point of Sale to reflect UPC 
or alternate lookup values instead. 
  
Print Tags:Overview 
  

Using a Scanner to Enter Information in Inventory 
Your scanner can also be used to quickly enter the bar code data into item records in inventory. For example, if 
your vendor supplies you merchandise pre-tagged with the UPC number, you can quickly and accurately enter the 
information into the UPC field on the item record by scanning the tag. You can scan vendor-provided bar codes 
containing catalog numbers into the Alternate Lookup field in the same manner. 
Edit item records 
Return to top 
  

Using a Scanner to List Items on Documents 
When scanning to list items on documents, Point of Sale assumes a quantity of one for each scan. To record a 
different quantity, press <F5> or navigate to the Qty field in the document item list to manually enter the correct 
quantity after each scan. 
Although scanning is extremely accurate, scanning errors can occasionally occur, especially when tags have been 
damaged or defaced. The scanner typically rejects read errors caused by defaced tags, and this scanned 
information never reaches Point of Sale. An error is reported if the scanned number is not currently defined in 
inventory or if the Alternate Lookup is not unique. 
List Items on Documents: Overview 
Return to top 
  

Using a Scanner for a Physical Inventory Count (Basic) 
A physical inventory scanner is an optional, portable scanner that can record thousands of item scans and counts 
while moving around your store. You then connect the scanner to your computer and upload the counts to Point of 
Sale.   
Use a Physical Inventory Scanner 
Return to top 

Use UPCs in Point of Sale 
Bar Codes & Scanners | Item Identifiers 
  
Some merchandise comes from the vendor pre-tagged with UPC (Universal Product Code) bar codes. If you record 
those UPCs in inventory, you can scan the UPC bar codes to list the items on documents. 



Printed Documentation 

74 

The UPC field on an item record can be used to record UPC-E, UPC-A, EAN, or similar identifiers up to 18 digits. 
Point of Sale will convert UPC formats of less than 13 digits (such as UPC-A and UPC-E) to a 13-digit form using a 
standard conversion algorithm. 
Every UPC # recorded must be unique and contain only numbers. UPCs can be entered on an item’s record by any 
of the three methods described below. 

Important Note 
Bar codes created in Point of Sale are based on the item numbers, not the UPC. Do not scan a Point of 
Sale-created item number bar code into the item UPC field. Likewise, if a vendor provides alphanumeric bar codes 
that are not true UPC codes, do not enter those codes into the UPC field. UPC codes have a required format, and 
other code formats are not accepted. Consider using the Alternate Lookup field for these codes instead. 
(Pro) You can use the Print Designer to customize your tags to print the UPC bar code if you prefer. 

To record UPCs in inventory: 

• Method 1: Scanning 
UPC #s can be efficiently and accurately entered by scanning in the UPC bar code on the manufacturer's 
label. Position the cursor in the UPC field on the item record and scan the tag. 

• Method 2: Manual Entry 
Refer to the selections below in making manual UPC entries. 

  

Type of 
code 

# of 
digits 

If you 
enter... 

Point of Sale will... 

UPC-E 6 all 6 digits expand those 6 to a 13-
digit form 

UPC-A 12 the first 11 
digits 
   
Example: 
12345612345 
   
all 12 digits 

add the 12th digit 
(checksum) & leading 
zero 
Example: 
0123456123458 
  
   
add the leading zero 

EAN 13 all 13 digits add nothing 

Other <13 all digits expand the entry to a 13-
digit form, if necessary 

Other >13 all digits no change (note: this 
ability is to support future 
UPC technologies) 

When an item with a defined UPC is listed on a receipt, voucher, memo, or slip, the UPC is 
recorded on the document. Thus, merchandise can be filtered by UPC when running history reports 
even if the item has been deleted from inventory. 
• Method 3: Transfer from Documents 

If you enter a UPC code on a purchase order or receiving voucher, and that UPC code is not 
already entered in the item record in inventory, Point of Sale will populate the UPC field in inventory 
with your entry. 

Return to top 
  
Related Topics 
Item identifiers 
Alternate lookups 
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Mouse and Touchscreen Navigation 
Keyboard Shortcuts 
  
When the documentation says to select, highlight, or place the focus on a button, field, or toolbar, mouse or 
touchscreen users can simply click or touch that button or field. 
Note: Not all Point of Sale windows support touchscreen use. For example, managerial tasks, such as running 
reports and creating purchase orders, are not efficient touchscreen tasks and therefore touchscreen use is not 
supported in those areas. 
  
Enabling Touchscreen Controls 
Enable touchscreen use and add the touchscreen controls to Point of Sale by selecting Enable Touchscreen 
Features in workstation preferences. (From the File menu, choose Preferences, and then select Workstation.) 
  
Note: Touchscreen Controls in Dialogs  
  

Touchscreen Tips 

• Reducing your video resolution to 800 x 600 can make touching small fields easier, but there may be 
tradeoffs with the display of other features at this resolution. 

• Double-touching in quick succession has the same effect as double-clicking with a mouse. 

• Touch, hold, and drag to reposition column headers and separators. 

• Your touchscreen controls may be customized through software provided by the manufacturer. Generally, 
you can access this software from the Windows Control Panel. 

• The size of your scrollbars can be changed to make touch scrolling easier. Go to Control Panel  Display 
 Appearance. Select Advanced and then Scrollbar from the Item list and set the size that works best for you. 
Note: This changes the scrollbar size for all of your Windows programs. (Directions are for Windows XP; may 
vary in other Windows versions.) 

• Touchscreen monitors are ideal for certain activities, such as ringing up sales, where you are making 
selections from predefined data lists. However, when data must be entered into records, such as when 
initially setting up the system, running reports, or entering your preference settings, you will find that a hybrid 
system including a keyboard (for entering data) is more efficient. 

• Consider turning on your Microsoft Windows touchscreen keyboard to facilitate typing within QuickBooks 
Point of Sale.  

Return to top 

Keyboard Shortcuts 
Mouse & Touchscreen Navigation 
  
The keyboard shortcuts shown below are common to all program areas. 
  
  
Common Keyboard Shortcuts: 

Keystroke Action 

Basic Navigation   

<F10> Cycle focus between window and menu 

<Ctrl+Q> Log in/out 

<Alt+O> Open I Want To… menu 

<Alt> Underscores shortcuts for menus 

<Alt+PgUp/PgDn> Cycle through open windows 
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<Tab> Accept entry and/or move from one field to 
the next in a form 

<Shift+Tab> Reverse tab navigation 

<Enter> Accept entry and/or move to next field in a 
list and on receipt payment window 

<Arrow keys> Navigate in and between fields and columns 

<Esc> Cancels current operation; backs out one 
screen; exits program from Navigator screen 

<Home> Move cursor to first column in list 

<End> Move cursor to last column in list 

<Spacebar> Select/clear a checkbox 
Cycle through choices on drop-down lists 

Function Keys   

<F1> Get Help on current task 

<F3> Open the Find window for the active field 

<F4> From lookup fields, access associated list to 
select 

<F5> On document: Edit selected item. 
(Pro) Edit selected style item. 

<F8> Toggle between list view and form view of 
the selected record 

<F10> Toggle focus between the menu and window 

<F11> Save (without printing transactional 
documents) 

<F12> 
  
  

Return to top 

1. Save (record, order document) or save & 
print (transactional document ) 
2. Go to payment screen (from receipt body) 
  

  

Control (Ctrl) Keys 

<Ctrl+F> Open the Find window for the active field 

<Ctrl+Q> Log in/out 

<Ctrl+F4> Go to Item List (from documents) 

<Ctrl+F7> Access Held documents (from history list) 

<Ctrl+F8> Open installed cash drawer 

<Ctrl+F10> Print tags (where applicable) 

<Ctrl+n> Switch tabbed pages, n = 1,2,3, etc. 

<Ctrl+Home> Go to first record in list 

<Ctrl+End> Go to the last record in list 

<Ctrl+PageUp> Display previous record or form 

Alternate (Alt) Keys 

<Alt> Access text menus 

<Alt+underlined 
letter> 

Access visible options that contain an 
underlined letter by pressing <Alt + the 
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underlined letter>. For example, to access 
Copy, use <Alt+C>. 

<Alt+Page Up/Page 
Down> 

Cycle through open windows 

<Alt+F4> Exit Point of Sale 

  
Return to top 

Customize Field Labels 
Data Field Overview | Define Inventory | Program Capacities 
  
You can specify custom field labels for the four item description fields in inventory (Inventory Name, Inventory 
Description, Size, and Attribute). The field labels you specify are displayed throughout the program, on printed 
documents, and on reports. 

Default Labels: The default labels for new users are Item Name, Item Description, Size, and Attribute. Upgraders from earlier 
versions may have labels of Description 1 and Description 2 for the name and description fields. Click Restore To Defaults at the 
bottom of the screen to return to the default field labels. 

(Pro) You can also create and use custom fields on customer, vendor, item, and employee records. And, if you use 
Print Designer to customize your print templates, you can specify different labels for printed documents as well. 

To customize field labels: 
1. From the POS Home Page,  select Preferences  Company from the File menu. 
2. In the left pane, choose General  My Field Labels. 
3. Scroll down to locate the field labels you wish to customize and enter new label text in the My 
Label column. 
4. Select Save. 

  
Related Topics 
Customize List Columns 

Custom Fields 
Data Field Overview | Program Capacities 

Pro 
Point of Sale provides you the ability to create and use custom fields. Once defined, the custom fields can be 
displayed and used to filter lists and reports, and can be added to your printed documents using Print Designer. 
For example, on your customer records you may wish to add fields for birthday and spouse's name. In inventory, 
you may wish to track the vendor’s catalog number, or you may need to record and print an item part number on 
your purchase orders. 
You can define and use custom fields in the following records: 

• Customers 

• Vendors 

• Items 

• Employees 

Defining Custom Field Labels 
Custom fields are enabled and labeled on the My Field Labels page of company preferences. The My Field Labels 
preferences page allows you to add and define all custom fields in Point of Sale in one place. How Do I? 
  
How do I add my custom fields to lists? 
How do I add custom fields to my printed documents? 
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Related Topics 
Filter lists 
Modify and filter reports 

Printing 

Printing in Point of Sale 
How do I?  | Printing Tags | Printing Preferences | FAQs 

Print lists or documents 
Print price tags 
Print mailing or shipping labels 
Print letters to customers or vendors 
Add my logo to sales receipts 
Specify document printers and templates 
Import print templates 
Install a supported printer 
Troubleshoot my receipt printer 
Customize my printed documents 
  

  
  
Point of Sale can print documents, lists, price tags, labels, reports, letters, and graphs. 
Before you can print from Point of Sale, you must set up Windows to use your printer or printers. Once set up in 
Windows, your printer(s) are available to assign to the various types of documents you can print from within Point 
of Sale. 
The printed output is determined by the printer and print template you specify in your printing preferences. Each 
workstation sets up its own print options. 
A default selection of templates for each area is provided with Point of Sale. Pro users can customize these 
templates or create new ones to fit your printing needs. 
Printing options are accessed in various ways: 
Item, customer, and sales history lists:  Select from the I Want To Menu...: 

 
All other lists:  Select from the Print  menu (located on the window toolbar as shown) or from the File menu at the 
top of the screen... 
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When making new documents: Select the Print or Save & Print option at the bottom of the document... 
  

 
  
At the time of printing, the Print dialog allows you in many cases to change the printer. template, number of copies, 
or preview the output on screen before sending it to the printer. (Options available vary with document.) 
  
Other Printing Topics 
Changing print templates at time of printing 
Compatible printer list 
Ordering printing supplies 
Troubleshooting 

Printing Lists or Documents 
How do I?  | Printing Overview | FAQs 

Print lists or documents 
Print price tags 
Print mailing or shipping labels 
Print letters to customers or vendors 
Add my logo to sales receipts 
Specify document printers and templates 
Import print templates 
Install a supported printer 
Troubleshoot my receipt printer 
Customize my printed documents 

  
  
Use these procedure to print record lists or individual documents. 

To print a non-document list: (item, customer, vendor, department, and employee) 
1. Display the list you wish you print. 
2. If you want to print only a subset of the list, filter the list to display only the records you want 
included. To print the entire list, make sure the filter is set to display all records. 
3. From the File menu, select Print. 
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You can also run list reports, which provide greater flexibility in customizing or exporting the printed output. 

To print documents: 
Transactional documents (receipts, vouchers, and memos, and transfer slips) are normally printed at the time you 
save them. Use this procedure to reprint those documents from your history lists or to print order documents. 

1. Highlight (list) or display (form) the document you want to print. 
2. Select Print from the File menu. 

Most documents also have a Print or Reprint button at the bottom of the document window, which can be 
selected instead. 

3. If presented with a Print Document dialog (a workstation preference), you can: 

• Change the printer you want to use if necessary 

• Specify a print quantity 

• Select Preview to view the document or Print to send it to your printer 
Notes: 

• If you choose to print a receipt, voucher, or memo as you are creating it (but before you have saved it), the 
document will be both printed and saved. 

• You can order tags, labels, and receipt paper for printing directly from QuickBooks. Refer to the ordering 
supplies topic. 

• The print templates and printer specified in workstation preferences determine what your printed 
documents look like. 

• (Pro) The default templates can be customized to meet your specific needs. 
Related Topics 
Compatible hardware list 
Installing supported printers 
Previewing printed documents 
Running Point of Sale reports 
Troubleshooting a receipt printer 

Adding your Logo to Sales Documents 
Printing Overview | Print Designer | FAQs 
  
You can easily add your store logo to printed sales receipts,  gift receipts, customer orders, and other documents. 
You can even add several logos to Point of Sale and then switch between them for seasonal or holiday purposes. 
Pro users can add different logos to different documents using Print Designer. 

To add your logo to printed sales documents: 
1. From the File menu, select Preferences  Company. 
2. Select the General  Store Info page from the left-side menu. 
3. Select the checkbox for Use Image as Default Logo. 
4. Select Specify. 
5. In the Images Collection window, select Add and browse for a graphic file. See notes below for 
file requirements. 
6. Repeat to add additional logos. Choose the one logo you want printed on documents and choose 
Select. 
7. Select Save on the preference page. 

  
Notes: 
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• Standard .BMP, .JPG, and .GIF file formats are supported. Note that some files with these extensions, 
such as those from some digital cameras, may contain extra file information that will prevent them from 
working in Point of Sale. If this occurs, use a graphics, paint, or photo application to open and re-save the file 
with a standard format. Tip: Test the file to see if it opens in Internet Explorer. If it does, it should work in Point 
of Sale. 

• Logo colors must be RGB (not CMYK) and maximum 24-bit resolution. 

• Logo file size should not exceed 100 KB. Larger file sizes may slow printing. We recommend reducing 
color resolution or logo dimensions to reduce file size, if necessary. 

• Point of Sale will scale the graphic, if necessary, to fit in the allotted space on a document. Some loss in 
graphic quality may result when scaling. For best results, use a graphics application to size your logo to the 
recommended sizes: 

• 40-column documents: 248 pixel maximum width 

• Letter-size documents: 381 pixel maximum width 

• The specified default logo is automatically added to your printed sales documents. Simply return here and 
change the default logo to print a different logo. 

• (Pro) If you use Print Designer to customize your printed document templates, you can change the size 
and position of the logo, use different logos for different documents, and add logos to other document types. 

• (Pro with multiple stores) Each store can define their own logos. 

Printing Tags: Overview 
How do I?  | Supported Tags | Printing Preferences | FAQs 

Print tags 
Specify tag printing templates 
Disable tag printing for an item 
Print the MSRP on tags 
Print markdown or discount tags in Price Manager 
Print cost on tags in code 
View supported tag and label styles and sizes 
Customize my tag templates 
Import print templates 
Installing supported printers 
Troubleshoot my Zebra tag printer 
Order printing supplies 

  
  
Item price tags can be printed from inventory, purchase and receiving documents, transfer slips, the Price Change 
reminders window, and from the Price Manager and Physical Inventory windows. 
The appearance of printed tags is determined by the default print template you have specified in workstation 
preferences or you can change the template at time of printing.  Pro users can also customize or create new tag 
templates to meet their individual needs. 
Tag printing is supported to compatible dedicated tag printers (e.g. the Zebra LP2824) and to standard inkjet/laser 
printers (using sheet labels). A dedicated tag printer allows you to print to hang tag, jewelry tag, and adhesive tag 
templates available on roll stock. 
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Tags can be printed with or without bar codes or the reference MSRP (manufacturer's suggested retail price). 
When printing tags with bar codes and using the default tag templates, Point of Sale uses the inventory item 
number to produce the bar code, not the UPC code. This allows you to print bar-coded tags and list items on 
documents by scanning them, even if you do not have a vendor-provided UPC code for the items. Learn more. 
The MSRP is included on printed tags if it has been entered on the item record. If you do not wish to include the 
MSRP, don't enter it on the item record or remove the field from the template you are using with Print Designer. 
  
Return to top 
  
Other Tag Printing Topics 
List of compatible tag printers 
Installing supported printers 
Common issues with Zebra tag printers 
Printing mailing and shipping labels 
Printing shipping labels 
Printing tags for alternate vendors  

Item tags printed from inventory always include the information for your primary vendor. To print tags that 
include alternate vendor information, such as the alternate lookup or UPC values, print the tags from either the 
purchase order or receiving voucher used to purchase the items from the alternate vendor. 

Ordering printing supplies 

Print Mailing or Shipping Labels 
Printing Overview | Printing FAQs | Supported label styles/sizes 

Basic  

You can print mailing or shipping labels from your customer list, from individual customer records, and from the 
Customer Center. 
(Pro) You can also print shipping labels from sales receipts and customer orders. 
  

Print a Label for an Individual Customer 
From the customer list, display the customer details. In the Addresses section, select one of the entered addresses 
from the drop-down list and then click Print Label. 
With this option, you can print a mailing label for one, all, or a selected group of customers. 
Step-by-step instructions  

1. Display your customer list or an individual customer record. 
2. If on an individual customer record, select Print Label below the customer address fields. Pro 
users can print using either the Bill To or Ship To address. 

OR 
If in the customer list, select the customer or customers for which you wish to print labels and then select 
Print Labels from the Print menu.  How do I select multiple customers?   
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• You may find it helpful to filter the list to display a specific group of customers, such as by ZIP 
code or last purchase date, before selecting. 

• If you intend to print labels for all customers, you do not have to select them. You can specify 
that option in the next step. 
3. Specify or change options in the Print Labels dialog: 

• Change the printer to be used, if necessary 

• Specify if printing for selected customers or all displayed customers 

• Specify the number of labels to print for each customer 

• Preview and/or change the label template used (select More Options, if necessary, to 
access) 
4. Select Print or Preview. 
5. If printing to sheet labels, specify a label start position (for printing on partial pages of labels) 
and then select Continue. If necessary, you can also align your printer from this dialog. 

  

  
  

Print Mailing Labels from the Customer Center 
Printing labels from the Customer Center gives you the added advantage of being able to create a mailing 
campaign list filtered by customer record information and/or by sales data. Labels printed from the Customer 
Center always use the customers' billing addresses. 
Step-by-step instructions  

1. On the home page Navigator, click Customer Center. The Customer Center is opened. 
2. In the Reach Out to Your Customers section, click Print Mailing Labels. The Print Mailing 
Labels wizard is opened. 

The wizard includes the following pages. Click Next when ready to move to the next page. 

• Choose Campaign Type: Select one of the predefined mailing campaigns or choose 
Custom to define other criteria: 

 Recent Purchase—Include only customers that have made a purchase in the last x 
number of days (enter x). 
 No Activity—Contact only customers that haven't made a purchase in x number of 
days (enter x). Optionally, you can also elect to include only those customers that have made 
at least one purchase from you anytime. 
 Merchandise Interest—Contact only customers that have made a purchase from a 
particular department or vendor. Click the Select Department/Vendor button to specify 
which department/vendor. Optionally, you may limit the sales period to the last x number of 
days. 
 Custom—This selection presents two additional pages for entering specific filter 
criteria. On the first, you can filter for any information stored in your customer records (city, 
ZIP Code, customer type, charge account customers, etc.). The second page allows you to 
filter for information contained in your customer sales history. Click Help on these pages for 
assistance. 

• Review Customer List: This page displays a proposed list of customers based on your 
selections. By default, all customers in the proposed list are selected for inclusion in the final list ( = 
selected). You can remove customers from the final list by clearing their checkboxes. Clear/select 
checkboxes by clicking on them or by using the button options on the right. 
3. Specify or change options in the Print dialog: 

• Change the printer or printer properties, if necessary 

• Specify the number of copies (labels) to print for each customer 

• Preview and/or change the label template used (select More Options, if necessary, to 
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access) 
4. Select Print or Preview. 
5. If printing to sheet labels, specify a label start position (for printing on partial pages of labels) 
and then select Continue. If necessary, you can also align your printer from this dialog. 

  
  

Print Shipping Labels from a Sales Receipt or Customer Order (Pro) 
You can print shipping labels from a receipt or customer order. If you use Shipping Manager, special considerations 
apply as explained below. 
Directions  

1. Enter a customer and shipping information on the receipt or customer order. 
2. Select Options in the Shipping Info area on the document and then choose Print Store 
Mailing Label. 

If you used Shipping Manager to add the shipping information to the document, select Re-print <Carrier> 
Shipping Label from Options instead. 

3. Specify or change options in the Print dialog: 

• Change the printer to be used, if necessary 

• Specify if printing for selected customers or all displayed customers 

• Specify the number of labels to print for each customer 

• Preview and/or change the label template used (select More Options, if necessary, to 
access) 
4. Select Print or Preview. 
5. If printing to sheet labels, specify a label start position (for printing on partial pages of labels) 
and then select Continue. If necessary, you can also align your printer from this dialog. 

  

  
  

Print Shipping Manager Labels (Pro) 
If you use Shipping Manager to make shipments, a shipping label that includes tracking information and scannable 
bar code is automatically printed when entering the shipment. 
Laser/inkjet and thermal printers are supported by Shipping Manager. The printer and options for Shipping 
Manager labels are set up in Shipping Manager, not in Point of Sale preferences. See Shipping Manager Overview 
and Setup. 
The Zebra LP2844 thermal printer, a Point of Sale compatible printer that can print 4" x 6" shipping labels, is also 
ideal for use with Shipping Manager. 
  

Notes: 
• A default label printing template and options can be specified on the Documents & Printers page of 
workstation preferences. This selection does not apply to labels printed from Shipping Manager. 

• For information about ordering labels directly from QuickBooks, refer to the ordering supplies topic. 

• (Pro) A shipping label can be printed from any of the shipping addresses entered on the customer record. 
When shipping information is added to a sales receipt, the shipping information, including carrier and tracking 
number is printed on the receipt given the customer. 

Back to top 
  
Related Topics 
Supported label styles and sizes 
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Print your customer list 
Compatible label printers 
Enter shipping information on sales receipts 
Customize printed documents 

Write Letters from Point of Sale 
Manage Letter Templates | Office Integration Overview | FAQs 
  
Point of Sale provides Microsoft Word integration for writing letters to customers and vendors. The letters can 
include data from the customer and vendor records as well as from documents made for the customer or vendor. A 
variety of letter templates is provided for your use. You can customize the provided templates and create more of 
your own. 
Letters can be initiated from the I Want To menu in your customer or vendor list or from your document lists. If you 
want a letter to include data from a document, such as specific item information, the letter must be initiated from 
that document. 
You can create a letter for a single recipient or send letters to a group of selected or filtered recipients. 

To write letters: 
1. Select the record or documents for which you wish to print letters. 

If sending letters to a filtered list, you do not need to select specific records in this step. 
2. From the I Want To menu, select Write Letters  and then choose to Currently Selected or to 
Filtered List. 

If using the filtered list option, follow the prompts to enter filter criteria to include/exclude customers or vendors. 
Learn more. 

3. Select the template you wish to use for the current printing and select Next. 
4. Enter the name and title of the person that the letter will be from and select Next. 

The letter(s) are opened in Word. If you are printing multiple letters they are all in a single Word document with 
each letter starting on a new page. 

5. Review and modify in Word if necessary and then print the letter(s). 
  

Notes: 
• You can select  Modify Template when selecting a template if necessary to customize the template before 
creating the letters. Learn more about modifying templates. 

• If the selected template includes data fields for which no data exists in your Point of Sale records or 
documents, the fields will be auto-filled with **MISSING <data field>**. Review your letter(s) and edit or 
remove these fields to complete the current letter. You can remove the fields from the template if you never 
want them included in future letters. 

• You may save the Microsoft Word document if you wish; doing so will not affect the template. 
Related Topics 
E-mail Marketing from Point of Sale 

Supported Tag and Label Styles and Sizes 
How Do I?  | Printing FAQs 

Print tags 
Print mailing or shipping labels 

Specify the templates I want to use 
Customize my print templates 
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The following tag/label styles and sizes are supported for printing in Point of Sale. Be sure to observe your printer's 
capabilities when selecting a template; some listed styles can be used for both tags and mailing/shipping labels. 
 Not all sizes and styles listed below are available in every area or compatible with every printer. 
  
Laser and inkjet templates for tags or labels: 

 Size Number Per Sheet Use Template 

1" × 2.625" 30 
(3 across) 

Avery 5160* 

1" x 4" 20 
(2 across) 

Avery 5161 

0.5" × 1.75" 80 
(4 across) 

Avery 5167* 

3.33" x 4" 6 
(2 across) 

Avery 5524**, 8164 

* Multiple tag templates within category 
** Weatherproof tag, for laser printer only 
  
Roll-stock tags/labels, for use with the Zebra LP2824/LP2844 and other compatible tag or label printers: 

Tag/Label Type Size (approx.) Use Template 

Hang Tag: 2.25" x 1.35" Intuit Hang Tag* 

Jewelry Tag with 
Flaps: 

2.1875" x 0.5" Intuit Jewelry Tags 
with flaps* 

Jewelry Tag 
without Flaps: 

2.1875" x 0.5" Intuit Jewelry Tags 
without flaps* 

Small Label, 
adhesive: 

1.19" x 0.84" Intuit Small Label* 

Label, adhesive: 2.25" x 1.25" Intuit (Mailing) Label* 

Label, adhesive: 4" x 3" Label (4x3) 

Label, adhesive: 4" x 6" Label (4x6) 

*multiple tag templates within category 
  
For information about ordering tags and labels directly from QuickBooks, refer to the ordering supplies topic. 
  
Related Topics 
List of compatible tag and label printers 

Printing the MSRP on Tags 
Tag Printing: Basic Instructions | Supported Tags | FAQs 
  
You can print the manufacturer’s suggested retail price (MSRP) on your price tags to demonstrate savings to your 
customers. If you have entered the MSRP on the item record, this value is included when you print tags for the 
item. 
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Some jewelry tags are too small to print both the MRSP and a bar code. If you want to print the MSRP and not the 
bar code on jewelry tags, you must specify a tag template with "MSRP" in its name in workstation preferences. 
  
Related Topics 
Customizing your printed tags 
Ordering tag supplies from Intuit 
  

Printing Tags in Code 
Overview | Tag Printing: Basic Instructions | FAQs 
  
You can print an item’s cost and its last received date on price tags in a code that is defined in company 
preferences. Only informed employees will know how to read the code. 

To define and use a price tag code: 
1. From the File menu, select Preferences  Company. 
2. Select Price Levels from the preferences menu on the left. 
3. In the Price Tag code area, specify one letter or number to represent each number 0-9. 

 
4. In your workstation document & printer preferences, select a tag template with a suffix of "+ cost". 
These templates contain the Cost Code and Last Rcvd Code fields. 

  
Example: You have an item with a cost of $9.00, last received on 11/26/07. You define your tag code as shown 
above. The printed tag, using a "+cost" template, would look like this: 
  

 
  
Cost: i00 = 9.00 (decimal omitted) 
Last Received Date: aabf0g = 112607 (mmddyy format) 
  
Related Topics 
Customize your printed tags 

Specifying Document Printers & Templates 
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Printing Overview | Printing Preferences | Importing Templates | Print Designer 
  
Printers and templates for documents, tags, and labels are specified on the Documents & Printers page of 
workstation preferences. When specifying templates, make sure you take into consideration your printer’s 
capabilities and the size of the printer paper, i.e., do not select a "Letter" sized sales receipt template if using a 40-
column receipt printer. You can also change the printer and/or template used each time you print if you set your 
printing preferences to display the print dialog. 

To specify printers and templates in preferences: 
1. From the File menu, select Preferences > Workstation. 
2. Select Documents & Printers from the left-side preferences menu. 
3. From the drop-down lists for each document, tag, and label type: 

• Select the printer to be used 

• Select a template to use 

• Specify the number of copies of the document to print 
4. If you want the ability to change printers or templates when printing, select the Print Options 
preference page and select the checkbox for each document type in the Print Dialog section. 

Note: When printing tags,  and labels, and customer orders, the print dialog is always displayed  so no checkboxes are 
displayed in the list for these document types. 

5. click Save. 
  

Notes: 
• If you have not specified print templates, the first time you go to print in each program area you will be 
prompted to select a template. The template selected will be saved to your preferences and used from that 
point on unless changed. 

• (Pro) If the default templates do not meet your needs, you can customize them using the Print Designer. 
Select Print Designer from the Tools menu. If you modify a template and save it with a new name, answer 
Yes when prompted to make the new template the default for that document type. 

Print Designer Overview 
How do I?   | Print Designer FAQs 

Pro 
Using Print Designer, you can customize your printed documents, labels, packing slips, and tags. The following 
actions are available to you in Print Designer: 

• Add, remove, size, and position data fields, static text, bar codes, and logos 

• Add borders and graphic lines 

• Change the printed labels on fields 

• Change the fonts used for printing 

• Control certain printing characteristics, such as the behavior of headers and footers 
Note that not all options are available on every template. 
Point of Sale comes with default templates for each document, tag, and label type. You can directly edit the default 
templates or copy them and then modify the copy to create and save new templates. Once modified, templates can 
be exported and imported to share them with other workstations or stores. 
Print Designer is not a "WYSIWYG" ("what you see is what you get") editor. As you position data fields on a design 
page, keep in mind that you are defining relative position, not absolute position, especially as it relates to vertical 
positioning. Every field that is placed on a template is not necessarily filled with data with each transaction. Many 
unused fields are removed from the template at the time of printing, so that the printed document does not have 
blank, wasted spaces. A good example of this behavior is the payment type fields included on sales receipt 
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templates. While all of the possible payment types are included in the design, most sales only utilize one payment 
type, thus it is the only one actually printed. 
Most document templates are separated into sections. There can be up to five different sections on a template, 
each with a unique printing behavior. These sections control how the printed output looks. For example, the 
information included in the Repeating Header section prints at the top of each page of a multi-page document, 
while the information in the Body Header section prints only once, near the top of the first page. Learn more about 
template sections and spacing. 
  
Related Topics 
Recommended sequence and tips for modifying templates 
Print Designer preferences 

Previewing Documents, Reports, and Tags 
Printing Overview | Print Option Preferences | Printing FAQs 
  
The Previewer is used throughout Point of Sale to view documents, reports, tags, labels, and records (collectively 
called documents here) on the screen before sending them to the printer. 
Tip: Zoom preview display to see small print  
  
Preview Options 
To access these options, right-click in the preview window. Not all options are available on all documents. 

• Find and Find Next:  Select Find (<F3> ) to locate a specific alphanumeric string of characters contained 
in the document. Enter the string you wish to locate, and then click Find Next to move the focus forward to 
the next occurrence.  Checkbox options can be used to refine the search to match your entry exactly and/or 
to match the case as entered. 

• Zoom: Select a zoom percentage or page magnification from the list displayed. Zooming in can be 
particularly helpful in viewing small print, such as on price tags. 
• Show Rulers, Show Toolbar, Status Bar:  Select or clear to toggle on/off the display of the Rulers, 
Toolbar, and Status Bar. A check mark indicates the feature is active. Choosing to not display any of these 
items frees more screen space for viewing your document. 

Related Topics 
Printing lists or documents 
Printing tags 
Reports overview 
Customizing printed documents and tags 

Printing FAQs 
Printing Overview | Compatible Printers | Hardware Setup 
  
The following lists include common questions about printing. Under the appropriate category below, click on a 
question to view the answer. 
If you have problems printing, we recommend you use the Hardware Troubleshooter (access from the Help 
menu) for assistance. The troubleshooter will help you identify and correct your specific issue. 
  

Printer Configuration & Preferences 
My printer is not printing. What could cause this? 
The Print or Print Tags buttons are grayed out. Why can't I access this option? 
After upgrading, I can't find the same print template I used for a document/area before. Why is this? 
  

Document & Report Printing 
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What is wrong when the right side of the text is truncated when printing the Z-Out Store Close report on the Star 
TSP600 receipt printer? 
How can I change font size on a report? 
What happens if I select print while viewing a document before the document has been updated? 
What should I do if a printed document does not contain a field I want? 
Can I customize my printed documents? 
Can I change printing options at the time of printing? 
How do I cancel a printing job after it has started? 
When printing a X/Z-Out report to my 40-column printer, I get the error message "There was an error found when 
printing the document to LPT1: Do you want to retry or cancel the job?" If I cancel the print job Point of Sale freezes 
up. What can I do to correct this? 
I am using the Epson TMU200 and am experiencing poor print quality. What is wrong? 
  

Tag and Label Printing 
How do I cancel a tag printing job after it has started? 
When printing tags using the Zebra tag printer, tags are printed erratically, skipped, printed upside down, or not 
properly centered on tag stock. How can I fix this? 
Tags are skipped when printing on a Zebra tag printer, even after a calibration. What could be the problem? 
I accidentally sent a print job to the Zebra tag printer that was meant for another printer. What should I do? 
The Zebra tag printer prints one tag, advances past several blank tags, and then the printer light becomes red, or 
the printer light becomes red when sending a job to the printer. How can I correct this? 
When printing tags with cost there are unusual characters, but no cost. What has happened? 
What is wrong when nothing prints on hangtags? 
Can I customize my printed tags? 
I changed fonts and font sizes in Print Designer, but my printouts are now messed up. Why? 
See also Common issues with Zebra tag printers 
Back to top 
  

Didn’t find an answer to your question? Try these other free resources: 

Visit the Point of Sale Community Message Board to ask questions and share ideas, solutions, and advice with 
other Point of Sale users and experts. 

Check out our support website to search our online Knowledgebase of answers to frequently asked questions at 
www.quickbooks.com/support. 
  
Related Topics 
Print records or documents 
Print tags 
Print the cost and last-received date on tags 
Print customer labels 
Workstation preferences: Printing 
Compatible hardware list 
  
  
  
  

Printer Configuration & Preferences Answers 
My printer is not printing. What could cause this? 

http://www.qbinproduct.com/community/help/pos
http://www.quickbooks.com/support
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A number of things could cause this problem. Check for the following: 

• No power/printer is offline 

• No paper in printer 

• Printer is not properly installed 

• Printer is not properly connected to computer 

• Workstation preferences are not properly configured for the printer (use the Hardware Setup 
Wizard, accessible from the File menu, to connect and configure new hardware) 

• No template is selected in workstation preferences for the document type you are trying to print 

• More than one printer is connected to the port assigned (use the Hardware Troubleshooter, 
accessible from the Help menu, to identify and correct the problem) 

• You plugged a USB printer into a port other than the one on which it was originally installed. 
Replug the printer into the same USB port used before. 

Receipt printer troubleshooter 
Return to question list 
  
  
The print or print tags button is grayed out. Why can’t I access this option? 
Typically, this happens when no printer has been set up in Windows or assigned in Point of Sale. Selecting 
Preferences  Workstation from the File menu and then select Available Printers from the preferences menu on 
the left. If your printer is not listed, select Hardware Setup Wizard to install it now. Then select Documents & 
Printers and specify the printer for documents as necessary. 
Return to question list 
  
  
After upgrading to this version, I can’t find the same print template I used for a document/area in earlier 
versions. Why is this? 
Improved print templates (called "designs" in some previous versions) have replaced previous templates. Review 
your template choices in workstation preferences and make new selections as appropriate. If you do not have a 
print template selected when selecting to print, a dialog will be presented from which you can make your selection. 
Return to question list 
  
  

Can I customize how my printed documents and tags look? 
Yes, if you are a Pro-level user, you can customize printed documents and tags using the Print Designer. Learn 
more. 
Return to question list 
  
  

Document & Report Printing 
What is wrong when the right side of the text is truncated when printing the Z-Out Store Close report on 
the Star TSP600 receipt printer? 
Go to File  Preferences  Workstation  Print Options  X/Z-out and change the template assigned to X/Z-
Out reports to 40-column X/Z-Out. 
Return to question list 
  
  
How can I change font size on a report? 
You can change a number of report options, including font, header/footer information, and the columns of 
information displayed in the report. In the Report Center, choose the report you wish to run. Depending on how you 
run the report, the Modify Report wizard may be displayed before running or you can select Modify from the toolbar 
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after it is displayed. Choose Change Report Appearance and then select an area of the report in the Fonts 
section to review or change font characteristics. 
Return to question list 
  
  
What happens if I select print while viewing a document before the document has been saved? 
In this case, selecting Print has the same effect as selecting Save & Print. The document is saved, then printed. 
Return to question list 
  
  
What should I do if a printed document does not contain a field I want? 
Try a different document template at File  Preferences  Workstation  Documents & Printers and see if the 
new template contains the field/information you want. A number of templates are provided for each document type, 
each containing different information and fields. 
(Pro) f the provided templates don’t meet your needs, you can customize them or create new ones to meet your 
needs using Print Designer. 
Return to question list 
  
  
Is there a way I can change printing options at the time of printing? 
At File  Preferences Workstation  Print Options, make sure the checkbox for Display Print Dialog... is 
selected for each type of document for which you would like to change options at the time of printing. You will be 
able to change the printer, number of copies, template, and various other options depending on the document type. 
Return to question list 
  
  
When printing a X/Z-Out report to my 40-column printer, I get the error message "There was an error found 
when printing the document to LPT1: Do you want to retry or cancel the job?" If I cancel the print job Point 
of Sale freezes up. What can I do to correct this? 
There are really two separate issues here. First, ignore the error message and let the printer continue printing. This 
error is caused by an overrun in the Windows print buffer, and if you just ignore it the message will disappear as 
soon as the buffer catches up. If it is a large report, this may take a few minutes but the message will disappear on 
its own and the print job will finish correctly. 
The second issue, Point of Sale freezing when you do cancel the print job, is most likely because your printer 
properties are set to "Print directly to printer." If this is the case, system control is never returned from Windows to 
Point of Sale after canceling the print job. Open your Windows Printers folder, right-click your 40-column printer 
and select Properties. Locate the setting for spooling print jobs (typically on the Advanced page) and be sure the 
"Spool print jobs…" and "Start printing immediately" settings are selected. 
Return to question list 
  
  

I am using the Epson TMU200 and am experiencing poor print quality. What is wrong? 
Try the following suggestions to improve the print quality with this printer. 

• Uninstall the printer from the Windows Printers dialog. Then run the ADT206E.exe file from the 
Extras\Drivers\Epson Printer & USB drivers folder on your Point of Sale installation CD, choosing the 
Status API and TMU 210 ReceiptA(R) options. This will reinstall the printer with the correct driver. 

• Select print templates that use the Arial font at File  Preferences  Workstation  
Documents & Printers. Look for the {Arial} suffix on the template names. 

• If you have a cash drawer attached and get extra characters printing, try changing the Cash 
Drawer settings in workstation preferences to "Connected through Epson Generic". 

• If extra paper is fed after a receipt is cut, try switching report/partial cut settings to assigned paper 
size on the Windows Printer Properties  Device Settings tab. 
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• This is a dot matrix printer and does not support printing of scannable bar codes. 
Return to question list 
  
  

Tag Printing 
When printing tags using the Zebra tag printer, tags are printed erratically, skipped, printed upside down, 
or not properly centered on tag stock. How can I fix this? 
There are two possible reasons for this. 1) A dirty printhead, or 2) the printer needs to be calibrated. Calibration is 
offered required right after switching between label types, changing the roll, or just because tag printers can be 
finicky. 
See Common issues with Zebra tag printers for advice on these issues and more. 
  
Return to question list 
  
  
Tags are skipped when printing on a Zebra tag printer, even after a calibration. What could be the problem? 
Earlier models of the Zebra LP2824 printer work erratically with the current driver. Ensure that the manufacture 
date of the Zebra LP2824 is after October 2002. 
See Common issues with Zebra tag printers for advice on these issues and more. 
  
Return to question list 
  
  
I accidentally sent a print job to the Zebra LP2824 that was meant for another printer. What should I do? 
Jobs meant for other printers are likely to have embedded commands that will create printing problems on the 
Zebra LP2824 printer. When this happens: 

1. Delete all pending print jobs for all printers (this may require rebooting Windows). 
2. Power the printer off, and then back on. 
3. Recalibrate the printer by selecting the Calibrate button on the Print dialog. 

Return to question list 
  
  
The Zebra tag printer prints one tag, advances past several blank tags, and then the printer light becomes 
red, or the printer light becomes red when sending a job to the printer. How can I correct this? 
This problem may be caused by accidentally sending a printer job meant for another printer to the Zebra LP2824. 

1. Delete all pending print jobs for all printers (this may require deleting jobs and rebooting Windows). 
2. Power the printer off, and then back on. 
3. Recalibrate the printer by selecting the Calibrate button on the Print dialog. 

Return to question list 
  
  
When printing tags with cost there are unusual characters, but no cost. What has happened? 
Tags can be printed in code to prevent inadvertent disclosure of Cost and Last Received Date information. The 
default at Edit  Preferences  Company  Pricing  Price Tag Codes maps the first 10 letters of the alphabet 
to the numbers 0-9 (a=1, b=2, c=3, etc.). Cost will print on tags in this code when you use a tag template with a 
suffix of "+ cost" (for example, "Zebra Label +cost"). Change the cost codes to suit your taste. 
Return to question list 
  
  
What is wrong when nothing prints on hang tags? 
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Only one side of tag stock is designed for thermal printing. Reverse the direction that the tag stock feeds and try 
printing again. 
Return to question list 
  
  

(Pro) I changed fonts and font sizes in Print Designer, but my printouts are now messed up. Why? 
Print Designer allows you to change almost everything about a print template, including fonts, special characters, 
font sizes, colors, etc. But Print Designer doesn't know what printer you will use to actually print your tags or 
documents. Take care to not make changes that your printer won't support. For example, receipt and tag printers 
may not support all font characters, sizes, or color. Always test template changes to be sure the output is what you 
expected before putting the template into use in your store. 

How do I cancel a printing job after it has started? 
Point of Sale "spools" a printing job to Windows and Windows then sends the job to your printer. This allows you to 
begin another task sooner in Point of Sale, while Windows handles the printing chores. You can cancel the print job 
using the Cancel button on the print progress dialog in Point of Sale. Unfortunately, on many print jobs the spooling 
and this dialog are visible for only a few seconds in Point of Sale. 
You may still be able to cancel the print job in Windows. Look for the printer icon in your system tray and double-
click it. This opens the Windows print queue window for the printer. Your print job and its status is displayed. To 
cancel the print job, select the document and then from the Document menu, select Cancel. 
Another, and possibly quicker, method of canceling a print job is too power off the printer itself. Cycling the printer 
power off and on typically clears any printer buffer (memory) that the printer itself may be using to hold the print job. 
You may still have to cancel or delete the job in the Windows print queue or it will remain there and possibly 
attempt to restart later. 
Refer to Windows help for more information on working with printers or changing your print settings. 
  
Return to question list 

Available Printers/Add Printer 
Preference Instructions | Compatible Printers 
  

This information applies to the Available Printers page of workstation preferences. 

  
This workstation preference page lists the printers currently installed on this workstation. 
Check the list to see if your printer is installed. If not, select the Hardware Setup Wizard button to install it now. 
Follow the wizard prompts to complete the installation. 
If you purchased your printer from Intuit (i.e. a supported printer), follow any instructions included with the printer or 
select from the installation instructions below. 
  

Select a link for more information about installing supported printers: 
Citizen CT-S300 Receipt Printer (USB) 
Star TSP100/TSP600 receipt printer (USB) 
Star TSP600 receipt printer (parallel) 
Zebra LP2824 tag printer (USB) 
Zebra LP2824 tag printer (parallel) 
  
Related Topics 
Print option preferences 
General printing instructions 
Troubleshooting printing 
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Setting up an Inkjet or laser printer 

Workstation Preferences: Documents and Printers 
Preference Instructions | Printing FAQs | Company Preferences 
  
Use the Documents & Printers page of workstation preferences to specify the default printer, print template and 
number of copies to print for each document type in Point of Sale. Set these options at each workstation that will 
print from within Point of Sale. 

Printer: Select from the drop-down list of available printers. 
Template: Select from a list of available templates to be used when printing the document type. The template 
determines the print layout of fields for a particular document type and printer. Point of Sale includes several 
template choices for each document type for use with various printers and for various needs. 
Copies: Enter the number of copies to print each time the document type is printed. 

Highlight a document line and select Preview or Print Test Page to view or test that the printer/template 
combination results in the desired output. If you need to add or configure a printer, select the Hardware Setup 
Wizard button. 
If you also specify to display the Print dialog on the Print Options page, you can change these settings at the time 
of printing. 
  
Shipping Manager Label Printer (Pro) 
If you use Shipping Manager, select Shipping Manager Setup to open this application and set up a printer for your 
shipping labels. 
  
Related Topics 
General printing instructions 
Customizing print templates (Pro) 
Workstation preferences overview 

Work with Company Data 

Create a New Company Data File 
  
Use this procedure to create a new Point of Sale company data file.  
  

Note:  In a multi-workstation configuration, this feature is available only from the Server Workstation. 
Note:  If this is the first time you are running Point of Sale and you have been prompted to create a company file, start with step 4 
below.  

To create a new company data file :   
1. In a multi-workstation configuration, close Point of Sale on all client workstations.  
2. From the File menu, select Company Operations. 
3. In the dialog displayed, select Create new company and click Next. 
4. Enter a unique name for the new company data, then click OK. 

(Pro) Also specify your store type and, if a remote, specify a store number before clicking OK. 
Point of Sale displays a status indicator as it creates the new company data. 

5. Click OK when the confirmation dialog is displayed. 
The registration screen (if applicable) and then the Hardware Setup Wizard and Setup Interview will launch to 
assist you in configuring the program for your store(s). 

  

Connect to the Company Data on the Server 
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Data Overview | About Server/Client Workstations | Troubleshoot 
  
In a networked, multi-workstation configuration, use this procedure to connect a Client Workstation to the Point of 
Sale company data on the Server Workstation. Your computers must be properly networked. 

To connect a Client to the company data: 
1. Ensure that the Server Workstation is running. 
2. Launch Point of Sale on the Client Workstation. 
3. Point of Sale searches your network and locates the server installation of your company data. 

• If a single company data file is located, the Client is automatically connected to it. And the 
following steps do not apply. 

• If more than one Point of Sale company data file exists on the network, a window is displayed 
listing the names of the files. Continue with the following steps. 
4. Select the company data you wish to access and select OK. 
5. If prompted, select a workstation number for this computer, and select OK. 

If you require employee logins (previously set up), the Log In window is displayed. Use your user name and 
password to log in to the program. 

6. Repeat this procedure for each Client Workstation. 
On subsequent launches of the Client Workstation, Point of Sale automatically reconnects to the same 
server/company data. 
  

Note: Virtual Private Networks (VPN) and wireless networks tend to be low bandwidth (slow) and therefore are not recommended 
for use with Point of Sale. These network configurations may be unreliable. 

  
Related Topics 
Install additional workstations 
About Point of Sale licensing 

Open a Company Data File 
Data Overview | Backup/Restore Data | Troubleshoot 
  
Point of Sale automatically opens the last company file that you worked with when you start the program. 
You can use this procedure to open a different Point of Sale company file stored on the Server Workstation or to 
browse to a file on your network. 

To open a company data file: 
1. Close Point of Sale on client workstations. 
2. From the File menu, select Company Operations. 
3. Select Open existing company, and select a file from the drop-down list displayed. The list 
includes all company data files detected on the Server Workstation. 
4. Click Next. 

Point of Sale opens the specified company data. 
  
Related Topics 
Share your data with an advisor or accountant 

Convert Data from a Previous Version 
Data Overview | Backup/Restore Data | Troubleshoot 
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Point of Sale prompts you to convert company data from a previous version, if detected, when the program is first 
started on the Server Workstation. You can also use the second procedure below to convert previous version data 
at anytime in the future. 
  

Note: In a multi-workstation configuration, this feature is available only from the Server Workstation. 

To convert company data when prompted on initial startup: 
1. Answer Yes to converting your prior version data when Point of Sale alerts you it has been 
detected. 
2. Enter a unique name for the new company data file and select OK. 
3. On the dialog displayed, confirm the location of the previous installation of Point of Sale and 
select OK. 

Alternatively, you can browse to a different location or specify that the conversion should be done from a 
backup file of previous data. 

4. If prompted, be sure all workstations have closed the previous version and then answer Yes to 
continue with the conversion. 

Point of Sale copies the data files from the previous version and then converts the copied files to the current 
format. This process may take several minutes, as customer, vendor, and item histories are built. The total 
time required will vary with the size of your existing data file and hardware configuration. Your data files in the 
previous version are left unchanged in this process. 

5. Select OK to close the import confirmation window when displayed. 
6. If you require employee logins, the Log In window is displayed. Use your previous version user 
name and password to log in to the program. 

To convert company data from a previous version later: 
1. Close all open windows and have all other workstations exit Point of Sale. 
2. From the File menu, select Company Operations. 
3. In the dialog displayed, select Convert from previous version and click Next. 
4. Follow the prompts (same as above) to complete the conversion, identifying the location and 
version number of your previous installation when requested. 

  
Related Topics 
Open a company data file 
Share your data with an advisor or accountant 

Share Your Company Data with an Advisor or Accountant 
Company Data Overview | Protect Customers' Payment Card Data 
  
If you engage the services of an advisor or accountant, you can easily send them a copy of your company data for 
review. Your advisor must have the same version and level of Point of Sale that you use to view your file. 
You should give your advisor a copy of your data, not your original company data file. You can continue to carry on 
normal activities in Point of Sale while your advisor is reviewing your data. 
Security Note: We strongly recommend that you require user logins if sharing your data with other parties. Add 
your advisor as an employee and assign a user name and password for access. Typically, you would give your 
advisor full access rights (Owner or custom security group), but you can assign more limited rights if preferred. 

To create a copy of your Point of Sale data for an advisor: 
1. From the File menu, select Back Up Data. 
2. In the Backup Data dialog, select Backup to an alternate location and then click Browse. 
3. Give the backup file a unique name (leave the .qpb extension) and save it to a removable disk, 
CD, memory stick, or other media that you can provide to your advisor. 
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(Advisor) To access your client’s data: 
1. From the File menu, select Company Operations. 
2. In the dialog displayed, select Create new company and click Next. 
3. Enter a unique name for the new company data, then click OK. 

The new data file is created and confirmed. 
3. From the File menu, select Company Operations. 
4. In the dialog displayed, select Restore from backup and click Next. 
5. Select Browse to alternate backup file and then browse to locate the client’s backup file on the 
provided media. Look for a file with the .qpb extension and then select Open. 
6. Select OK to restore the client’s data to the new data file created in Step 2. The client’s data is 
opened on your computer. 

This procedure adds the client’s data to your database server list. You can subsequently reopen this data by 
selecting Company Data  Open from the File menu. 
  
Related Topics 
Create a new company data file 
Open a company data file 
  

Backing Up Your Company Data 
How do I?  | Restore from a Backup | Data Protection Strategy 
  

Note: Data backups can be done only from the Server Workstation. There is no need to do backups on client workstations. 

  
The data that you gather during day-to-day business operations is invaluable and must be protected. Power failure, 
media defects, disgruntled employees, or hardware problems can corrupt or destroy your company information. 
Backing up your data on a regular basis enables you to recover from such events as quickly and painlessly as 
possible. Failure to do so puts your entire business at risk. 
Point of Sale provides several backup and restore features: 

• An automatic backup is made once a day when the Server Workstation exits the program or at a specific 
time that you schedule; the most recent ten backup files are maintained 

• Backups are also made or suggested by Point of Sale anytime you run certain data-related tasks, such as 
when installing program updates, running the Clean Up Data utility, or importing data 

• You have the option to include making a backup in your End of Day procedure and the ability to make 
manual backups at anytime to the default or an alternate location 

• If necessary, you can restore your company data from any available backup file; Point of Sale will 
automatically suggest the most recent backup to the default location for the restore 

• (Pro) You can optionally include item pictures in your backup (will increase backup time and file size) 
For maximum protection, it is recommended that you do regular backups to removable media that you store off-
site. 
If you create a backup while other workstations are still using Point of Sale, only those transactions that have been 
updated (saved) are included in the backup file. We recommend that all workstations complete and save any 
pending transactions before a backup is made. 
It is important to note that Point of Sale only backs up your Point of Sale data. Therefore, it should serve as only 
one component of a comprehensive data protection strategy. You must take separate action to back up other 
important information for your business (QuickBooks financial software records, payroll records, other applications, 
etc.). 
  
Related Topics 
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Security rights for back up/restore 
Backup file names and location 
Scheduling third-party backup applications 

Implement a Comprehensive Data Protection Strategy 
Data Overview | Backup and Restore Data | Troubleshoot 
  
The data you accumulate in your business is extremely valuable. Keeping it safe should be a top priority. Point of 
Sale provides several methods to help you protect your data: 

• By requiring employee logins and assigning security rights you can limit access to your data and program 
features. Learn more 

• Changes that affect your inventory value (cost and quantity) are automatically tracked on transactional 
documents and adjustment memos, creating an audit "trail." Learn more 

• Backup copies of your company data can be made each time you run the End of Day procedure, 
automatically once each day when the Server Workstation exits the software, or at any scheduled time you 
specify. Additional protection can be gained by following a regular manual backup routine. 

• Your data files are automatically checked for integrity and repaired if necessary as backups are made. This 
procedure is automatic and no user action is necessary. 

• If you use the QuickBooks POS Merchant Service to process credit and debit card transactions, you must 
take measures beyond the general recommendations listed below to protect your customer's card information. 
Refer to the electronic Implementation Guide for assistance in using Point of Sale within an overall system 
that meets the Payment Card Industry (PCI) Data Security Standard (DSS) requirements. 

General System and Network Protection 
While the steps above are intended to protect your Point of Sale data, you should also be concerned about general 
system protection. Here are several more suggestions for protecting your data and the systems on your company 
network. 

• Require password logins – Assign a unique username and password to each person in your company 
using Point of Sale. Each employee should have a unique user name and password for Windows and for 
Point of Sale. Point of Sale, like any Windows application, relies on security features within Windows. These 
features are most effective when each user on the system can be accounted for. With password protection 
set, access to your company file can only be granted with the assigned passwords. If you share your data file 
with an accountant or other business advisor, assign user names and passwords to them as well. 

• Restrict Security Rights – Configure Point of Sale security rights appropriate for your business and the 
needs of your employees to access specific features and data. Point of Sale comes with four default security 
groups (sets of rights) and you can create custom groups as needed. 

• Install and use anti-virus software – and keep it up to date! 

• Install a network-based or PC-based firewall – If you install a firewall on your Internet connection, you 
can reduce the likelihood that uninvited persons will use the Internet to access systems on your network. 
Firewall products will help you to ensure that your computers only conduct the traffic you allow. Most major 
brands of anti-virus software also offer firewalls. Firewalls may have to be configured to allow Point of Sale to 
communicate between workstations on a network. 

• Use Windows security and Windows Update – To obtain and install the latest security updates for your 
computer. Find out more about Windows security and Windows Update services from Microsoft at 
http://www.microsoft.com/security/. 

• Backup your data frequently – Keep backups of your data file in a safe location, preferably off-site. Keep 
your backups in a fireproof safe, or at a business records management facility. 

• Install a UPS – A UPS (uninterruptible power supply) helps ensure data integrity in the event of a sudden 
power loss by providing a few critical minutes of backup power in which you can complete and save in-
progress transactions. Without a UPS, these transactions are usually lost and, as with any software, the data 
file can become corrupt if disk-write operations were in progress when the power was lost. We recommend a 
UPS on each Point of Sale workstation, but most importantly on the Server Workstation which stores your 
data. 

http://www.microsoft.com/security/
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• Restart your computer at least a couple times a week. – Restarting or "rebooting" is how your 
computer cleans up the bits and pieces (i.e., files) of applications and data that inevitably get stranded in its 
memory and temporary file locations over time. Left to accumulate, these files eventually can cause conflicts 
as applications compete for your computer’s resources. Restarting occasionally wipes the slate clean and 
helps resolve these conflicts. We also recommend completely shutting down your computer at least once per 
week or anytime you are having hardware-related issues (leave it off for at least 15 seconds before powering 
on again). 

Configure Your Firewall 
Help and Support | Troubleshoot 
  
A firewall, on either the Client or Server workstation, can block communication between workstations and the Point 
of Sale company data or to the Internet. You may see a message from the firewall if this is the case. 
Note: Some firewalls don’t display a message and others display messages only if the current user has Windows 
Administrator rights. Make sure you are logged into Windows with Administrator rights to ensure you are seeing 
any messages your firewall might be generating. Read configure Windows user rights for more information. 
  

Get Latest Firewall Updates 
Several major firewall applications are updated regularly with the latest Point of Sale file and port information and 
will automatically allow access to the ports and files needed. Use your firewall application’s instructions to be sure 
you have the most recent updates available before installing Point of Sale and each time you install a Point of Sale 
update. 
  

Windows Integrated Firewall 
If you use the Windows integrated firewall, and it is blocking access, Point of Sale will alert you on startup and offer 
to automatically configure the firewall for you. It is strongly recommended that you allow the automatic 
configuration. 
  

Manually Configuring Firewalls 
Each firewall program presents its interface in a slightly different manner; each provides its own phrase for asking 
what you would like to do regarding the action it views as a possible threat. You will see some form of the question, 
"What do you want to do about this?" That question will be followed by a list of options, such as allow, grant, deny, 
block, permit, or something similar, from which you must choose an action. 
You should select the option to allow, grant or permit the action. There should not be a prompt the next time 
the same action is performed. However, permitting one action for one file will not automatically enable all actions 
from anywhere in the Point of Sale program. Several different Point of Sale files perform actions that might be seen 
by your firewall as an attempt to connect to the Internet. Permission must be granted separately for each action. 
If firewall messages continue to appear, it may be necessary to manually configure the firewall to allow access for 
the required program files. 
If you need to manually configure your firewall application, you should review the appropriate sections of the 
manual or help file that was supplied with the firewall program. 
  
Note: Windows 64 bit version is shown below.  
          For 32 bit versions, (x86) is not shown in the path. For example: C:\Program Files\Intuit\QuickBooks Point of 
Sale 11.0 
The program files to grant access to are: 

• QBPOSShell.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0 

• QBPOS.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0 

• QBDBMgrN9.exe 
C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0\DatabaseServer 
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• QBDBMgrN10.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0\DatabaseServer 

• QBPOSDBService.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0\DatabaseServer 

The services to grant access to are: 

• Intuit Update Service 

• Intuit Entitlement Service 

• QBPOS Database Manager 
Note: Folder locations shown assume the default installation location on Windows 7/Vista.  
         Adjust accordingly if you installed to a different location. If necessary, use Windows Search from My 
Computer to locate these files. 
  
Related Topics 
POS company data connection issues 
Performance and networking issues 
Troubleshoot QuickBooks Financial Exchange 
Configure port filters 
Help and support overview 
Contact Technical Support 

Company Data Connection Issues 
Help & Support Overview | Networking Issues 
  
Point of Sale must be able to access the POS company data that is stored on the Server Workstation. In a 
networked installation, the connection issues outlined below most commonly apply when a Client workstation is 
unable to locate or connect to the data on the Server Workstation.  About Server and Client Workstations 
  

Note: Virtual Private Networks (VPN) and wireless networks tend to be low bandwidth (slow) and therefore are not recommended 
for use with Point of Sale. These network configurations may be unreliable. 

  

Data Connection Requirements 
There are certain prerequisites to being able to access the Point of Sale data, whether it is being accessed from the 
Server or Client Workstation. 

1. The Server Workstation must be turned on (but Point of Sale need not be running). 
2. Firewall software must be configured to allow Point of Sale components to access needed ports. 

  

POS Data Connection Error Messages 
If a workstation cannot locate or connect to the POS company data, you may see an error message similar to that 
shown below. 

Application could not find, could not connect to, or could not open company data. 
Review the list of possible causes and solutions below to correct the problem. When encountering connection 
difficulties on a Server Workstation, the first step is for the user to sign onto the computer as a user with Windows 
Administrator rights. 
When encountering connection difficulties on a Client Workstation, the first step is for the user to sign-on to the 
Client Workstation as an administrator AND that an administrator also sign-on to the Server Workstation. 

  

Possible Cause: Solution: 
Company data was renamed, A list of the data files and Server 
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moved, or deleted. Workstations found on the network is 
listed. Select the correct data/server 
and then select OK. On subsequent 
startups, the client workstation will 
reconnect to this same data. 

The data file does not have a 
unique name. 

Ensure that the POS data file has a 
unique name. 

The Server Workstation is not 
running. In order for a client 
workstation to access the data 
stored on the Server 
Workstation, the Server 
Workstation must be running. 

Once you are sure the Server 
Workstation and network are 
working, enter the Server 
Workstation computer name (can be 
found at Windows Control Panel  
System  Computer Name on the 
Server) and POS company data file 
name (can be found in the Point of 
Sale title bar on the server) and then 
select OK. 

Return to top 

  

The Server Workstation has a 
different data file open than the 
one to which a client workstation 
is trying to connect. 

Open the correct company data on 
the Server Workstation or select to 
connect the currently open data. 

The network connection or 
configuration is not working. 

Check your network connections and 
cables on both Client and Server 
Workstations. Can you access other 
information on the Server 
Workstation from the client? Check 
the Performance and Networking 
FAQs or consult with a qualified 
computer network specialist for help. 

Firewall settings, on either the 
client or server workstation, are 
blocking the connection. In most 
cases, you will see a message 
from the firewall if this is the 
case. (Note: Some firewalls don’t 
display a message at all in this 
case and others display 
messages only if the user has 
Windows Administrator rights.) 

Check your firewall settings. Be sure 
you are signed on to Windows as a 
user with Administrator rights and 
then try to connect again. If you 
receive a firewall message saying 
that Point of Sale (or the applications: 
QBUpdate, QBDBMgrN, Adaptive 
Server Anywhere Network Server) 
are trying to access the Internet, 
answer Yes, always to allow the 
connection. This should prevent this 
problem in the future. Note: Firewalls 
may vary in their message and the 
solution to this problem. Click the link 
above or refer to your firewall 
documentation for additional 
assistance. 

Return to top 

  

Selected data is not a Point of 
Sale database. 

Select a valid Point of Sale data file. 

There are more workstations 
running than are allowed by 
license. 

Shut down excess workstations or 
purchase additional Point of Sale 
licenses. 

The workstation is not running 
the same level or version of 
Point of Sale as another 

Update or upgrade all workstations to 
the same level and/or version of 
Point of Sale. 
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workstation that is currently 
accessing the database. 

Insufficient user rights to create 
a database or to change the 
currently accessed database. 

Ensure that you are logging in to 
Point of Sale with sufficient rights to 
create or change the currently 
accessed database. Also, be sure 
that your Windows user rights are not 
blocking access. 

Client Workstation is still logged 
into a database, preventing 
Restore, Open Database or 
Rename Database. 

Close the Client Workstation 
database connection or exit Point of 
Sale on the client. 

Return to top 
  
Related Topics 
Advanced settings that might affect connection 
Configure port filters 
Performance and networking issues 

Office Integration 
  
Point of Sale supports data import/export with Microsoft Excel, letter writing with Microsoft Word, e-mailing of 
documents via your default Windows e-mail client, and creation of targeted customer lists for use in e-mail 
marketing campaigns. 
  
Click a link below for more information on a specific feature. 

You can: 

• Import or export your Point of Sale list data with Excel 

• Export reports to Excel 

• Write letters to customers or vendors with Word using Point of Sale templates and your company file 
information 

• E-mail Point of Sale documents to vendors or customers 

• Create targeted customer lists for use in e-mail marketing campaigns and export them to Excel or send 
them directly to an integrated marketing partner 

The use of Excel and Word features requires that you have a supported version of Excel and/or Word installed on 
the workstation performing the task. Refer to the system requirements in the Point of Sale User Guide (launches 
PDF version). 

Clean Up Company Data 
  
The Clean Up Company Data procedure optimizes your Point of Sale data file, resulting in faster searches, 
lookups, and reporting. This procedure also allows you to remove old transactions and other information from your 
data file. 
Optionally, you can also choose to compress the data file so that it takes less hard disk space. How is compressing 
different than optimizing the data file?   
  

Note: In a multi-workstation configuration, this feature is available only from the Server Workstation. 

 Warning!  Compressing the data file will significantly add to the amount of time this process takes and may not provide 
additional improvement to performance. Compressing a large data file may take several hours and is recommended only if you 
are running out of physical disk space. Complete this process during off-hours as it cannot be canceled once started. 
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A backup of your current data, before cleanup, will automatically be created during this procedure. 

Before beginning: 

• Read What do I need to know about cleaning up my company data?   

• If desired, delete unneeded records from your item, customer, vendor, and employee lists. These records 
are not removed by the Clean Up Company Data procedure; however the lists are optimized if records have 
been manually deleted. 

• Close Point of Sale on all workstations except the Server Workstation. 

To clean up your data: 
1. From the File menu at the Server Workstation, select Utilities > Clean Up Company Data. 

The Clean Up Company Data wizard is launched. 
2. Select Next to move through the wizard pages, selecting cleanup options: 

• Specify if the data file is to be compressed. 

• Select the records and/or documents you want to remove. 

• If removing history documents, specify a cleanup date. All selected history documents created 
prior to the specified date are removed. 
3. Select Cleanup. 

A progress dialog is displayed as the cleanup procedure is carried out. 
  

Notes: 
• Transactions and records removed are no longer available on Point of Sale reports, customer history, or 

vendor history. However, all transactions are retained on the item history screen (but you can't QuickZoom to 
view them). 

• Even if no records or documents are selected for removal, this procedure will optimize your data file for 
better performance. 

Related Topics 
Restore from a data cleanup backup 

Work with Mobile 

Going Mobile 
How do I?  |  

Receive against a PO 
Receive without a PO 
Update cost of received item 
Update price of received item 
Enter vendor billing information 
Enter discounts, freight, and fees 
Record item serial numbers 

Find a saved voucher 
Edit a voucher 
Reverse (correct) a voucher 
View a vendor's receiving history 
Return merchandise to vendors 
Print tags from a voucher 
Transfer items to other stores 

  

Basic  

The Quickbooks Point of Sale Mobile Sync feature gives you the power to make sales and track your inventory 
using your mobile phone or tablet . Mobile Sync allows you to share your items with your mobile devices and make 
sales wherever and whenever you need.   
  

Why Sync to your Phone or Tablet?  
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The QuickBooks Point of Sale Mobile Sync feature gives you the freedom to ring up credit card sales anywhere 
inside - or outside - of your store. 

• With an Intuit Payments Account and our free GoPayment app, you can make payments 
anywhere, anytime. 

• Start accepting payments instantly. Simply activate your payments account and you are 
ready to go. No application required. 

• All sales and inventory information instantly syncs with your Point of Sale software so 
your records are always accurate and up-to-date. 

• The Sync feature automatically records new payments as QuickBooks Sales Receipts. 
• Never miss a sale whether you are on the road, at a conference, or working a convention. 
• Long lines at the store?  Provide the best in customer service by completing sales on the 

spot.  
• If you are a QuickBooks user, all your information automatically syncs with your 

QuickBooks financial program. No more entry errors from re-keying data. Plus, you'll 
have everything ready for tax time. 
 
Note:  Intuit values your privacy and the security of your information. When using the 
Mobile Sync feature, your data is safely stored and securely transmitted through our 
servers directly to and from your mobile device. Intuit adheres to rigorous banking 
industry protection standards for secure data transmission. 

 

Get Your Intuit Payment Account first 
 
Before using the Mobile Sync feature, you'll want to first obtain an Intuit Payments Account. 
With an Intuit Payments Account, you can accept all major credit and debit cards as well as add Gift Card Services 
to your business. 
To start accepting credit cards in QuickBooks Point of Sale 2013: 

1. Launch QuickBooks Point of Sale 2013. 
2. From the File menu, select Setup Interview and choose the Payments tab. 
3. Click Yes to accept credit and debit cards. 
4. Click Sign In. 
5. Be sure to sign in using the User ID (email) and password that you had previously created. 

If there is more than one, you will be prompted to select the right account.  

  
Learn more 

 
  
  

Mobile Sync Steps 
 
 Once you have your Intuit Payment Account, you're ready to go.  Follow these steps to activate the Sync 
feature: 

1. From the Navigator screen, click Mobile Sync. 
2. Click Sign-in. 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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3. Type in your email and password for your Intuit Payments Account. 
4. Click Sign-in. 
5. If you have multiple accounts, click Select on the account you wish to use. 
6. Click Close.  The Payments screen will now show that you are connected and display your 
account details. 
7. Click Edit settings to customize your payment preferences and select the items that apply to 
your business. 
8. Back on the Navigator screen, click the Cloud icon near the top right of your screen. 
9. Click View Sync Preferences. 
10. Select Sync Data and then Save. 
Auto Sync is on. 

To sync specific inventory items to your mobile device: 
1. From the Misc and Shipping section of the Inventory Item Detail screen, click the Sync to 
Mobile.  
OR 
Click the Mobile box next to the Item # on the Item List. 
2. Click Save. 

To complete the sync:   
1. From your mobile device, click the GoPayment app. 
2. Launch the GoPayment app and sign in to your Intuit Payments Account. 
3. Select Settings. 
4. Turn on Items.  GoPayment will begin syncing with QuickBooks Point of Sale 2013.  

  
To sync more items or receipts: 

1. From the Navigator screen, click the cloud icon. 
2. Click Sync Now. 

  
To view syncing activity: 

1. From the Navigator screen, click the cloud icon. 
2. Click View Activity Log. 

  
To view or change Sync Preferences: 

1. From the Navigator screen, click the cloud icon. 
2. Click View Sync Preferences. 
3. If you make any changes, click Save. 

  
To turn off Syncing: 

1. From the Navigator screen, click the cloud icon. 
2. Click View Sync Preferences 
3. Click Do not Sync Data. 
4. Click Save. 

  
To change sync frequency: 

1. From the Navigator screen, click the cloud icon. 
2. Click View Sync Preferences 
3. Move the slider to increase or decrease sync frequency. 
4. Click Save. 
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Learn more 

GoPayment Basics 
Intuit GoPayment lets your customers make credit and debit card payments to you - on the spot - using their mobile 
phones. You can process any major card, credit or debit. There's no need to write down payment information or call 
into your back office. Intuit GoPayment works in conjunction with QuickBooks Point of Sale 2013. 
Learn more 

Manage your GoPayment Account 
If you're the account administrator, you can manage GoPayment Service using the Merchant Service Center web 
site. This site lets you customize your sales receipt, add GoPayment users, reset passwords and learn about 
GoPayment features. You can also review transactions, deposits and fees. 
Sign in with your GoPayment User ID and Password here.  
 
GoPayment Security 
To protect data in transit, GoPayment adheres to online banking industry protection standards, using an https 
connection over SSL (Secure Socket Layer) at 128-bit encryption. 
Sensitive credit card information is never permanently stored on your mobile device. When you swipe cards with 
GoPayment, an additional layer of encryption (3DES combined with DUKPT) protects communication between your 
device and the card reader. 
Note: Never use an unsecured wireless network connection to process transactions. 
Unsecured wireless networks are neither secure nor PCI-compliant. To meet PCI-compliance standards, a wireless 
network must be password-protected and feature strong encryption for authentication and transmission. 

GoPayment Support 
Manage your account (add users, change passwords, customize receipts and more).  
Sign in with your GoPayment User ID and Password here.  
Note: This site is not optimized for mobile browsers.  You must be the account administrator to sign in.  
Contact GoPayment support: 
1-800-558-9558 
 
Authorize payments by phone: 
 - MasterCard/Visa 1- 800-228-1122 
- American Express 1- 800-528-2121 
-  Discover  1- 800-347-1111 
  
  

Basic  

GoPayment Password 
Basic  

Forgot your GoPayment Password? 
 
Ask your administrator to reset your password. When you are provided  a temporary password, use it to sign in and 
create a new password. 
If you are the GoPayment administrator, you can reset passwords directly from your iPad: 

1.   Sign in with your Administrator credentials here.  
2.    From the menu, choose Account > Manage GoPayment. 
3.    Locate and tap the User ID.  
4.  Tap Reset Password and click OK. 
5.    Use your new password to sign into GoPayment on your mobile device. 

  
Note: Passwords must contain between 6 and 25 letters, numbers or special characters, but no sequential strings 
like 123456. The password cannot be your User ID. 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
http://www.youtube.com/user/IntuitQuickBooksPOS/videos
https://merchantcenter.intuit.com/
https://merchantcenter.intuit.com/
https://merchantcenter.intuit.com/
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Using GoPayment 
Basic  

Swiping Cards 
 
One of the following card readers should be used with GoPayment on an iPhone:  
  
Mophie card reader 
The Mophie card reader is available at Apple Retail Stores and at www.apple.com.  
To use this reader, follow these instructions: 

1. Insert your iPhone in the Mophie credit card reader and launch GoPayment.  
2. When prompted, run the card through the bottom of the card reader. 

Note: The Mophie reader is currently compatible with iPhone 3G , 3GS and 4.  (Currently not compatible with the 
iPod Touch or the first-generation EDGE network iPhone).  
  
  
Audio jack card reader 
Intuit offers a card reader that plugs into the audio jack.  
To use this reader, follow these instructions: 

1. Plug the device into your audio output jack. This card reader works best when you turn the volume to full.  
2. In Settings, turn Audio Jack Card Reader ON.  

When the Audio Jack Card Reader setting is on, do not plug in another audio device (such as 
headphones) or a beep will sound. 

3. Choose the card reader model you have. (You can match the image. Your reader will be either grey or 
white.)  

4. When you initiate a charge, GoPayment prompts you to swipe a card at the payment screen.  
 
Note: Remove the card reader before you make or accept a call. 

Basic  

GoPayment Features 
 
Location of transactions - Turn on location, and email receipts, You can also show customers a map indicating 
exactly where the transaction took place.  
  
Memo to self - Lets you enter additional information related to the transaction (e.g., an invoice number or other 
notes).  Only you see the memo, the customer doesn't. 
  
Tips - Your customer can add a tip to the total amount. Turn on Tips to show the Add Tip button on the Signature 
page. 
  
Items - Create and store a list of products and/or services. When Items is on, you start transactions by selecting 
item(s) from the list to generate the charge amount. 
  
Edit Items - Tap this button to edit, add or delete items. 
  
Sales Tax - If you use items, tap this button to enter the sales tax percentage that applies to some or all items. For 
charges that don't feature items, you must calculate the tax yourself and include it in the total amount charged. To 
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have GoPayment automatically calculate sales tax based on your location, click in the Location-based tax rate 
checkbox.  
  
Change Account - If you have more than one GoPayment merchant account associated with your User ID, you 
can choose which account you want to use to process payments.  
In Settings, the current account appears within the Change Account button. (You won't see this button if you only 
have one merchant account.)   To switch to a different account, tap Change Account and tap the desired account. 
 When you view transactions in History, you will see transactions for all your accounts, not just the currently 
selected account.  
  
  
Learn more 

GoPayment:  Frequently Asked Questions 
Basic  

What if I experience a low signal while processing a payment? 
 
If there's no response due to a low signal, keep GoPayment open and try moving to a better spot. If you lose your 
connection during a payment, try to continue where you left off.  If you close GoPayment before getting a 
connection, you will need to re-enter all payment information.  
  

Why can't I void a payment? 
 
If the transaction has been submitted to the bank (batched), it cannot be voided.  
At that point, you or your account administrator can process a refund online using the Merchant Service Center 
site.  
  

How do I use GoPayment to store a list products or services?  
 
Use the  Items feature  to store a priced list of products or services.  
With Items on, you can start transactions by selecting item(s) that comprise the purchase.  
GoPayment uses item prices to tally the charge amount. Customers can see what they bought and you can track 
inventory and services. 
  
To turn on Items: 

•  In Settings, turn Items on.  

• Tap Get Paid.  The Items list displays.  
To add an item: 

• From the  top right of the screen tap +.  

• Then complete the Item form. 
  
To edit an item: 

• Tap the > next to the item you want to edit.  Or, from  Settings, tap Edit Items. 
  
To charge for an item: 

• Tap the > next to the item you want to add to the order.  
  

How do I locate past charges? 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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To view past charges: 

• Tap History.   
You will see the last 25 transactions. (Payments appear in black. Voids display in red).  

  
To open a transaction: 

• Tap the transaction line.  
You can view transaction details, send a receipt, or void the charge. 

.  
  

How do I set the sales tax? 
  
To set the sales tax: 

• At the bottom of the GoPayment screen, tap Settings.  

• In the Sales Tax field, enter the desired tax rate.  
Or, to have GoPayment automatically calculate sales tax based on your location,click the Location-based tax rate 
checkbox.  When sales tax should be applied to an item, open the item and tap its Sales Tax On button.  (The 
sales tax you enter applies only to items).  For charges that do not feature items, you'll need to calculate the tax 
yourself and include it in the total amount charged.  
  

Is a customer signature required? 
 
Getting a signature is optional.  However, Intuit GoPayment lets customers sign for charges on your iPhone screen 
using their finger.  
The charge has already been processed. But in the case of a later chargeback, a signature can help verify that the 
customer was present and approved the charge.  
  

When does a merchant get paid? 
 
Your GoPayment transactions are totaled each day at 3:00pm PST, and that amount normally appears in your 
account within 2-3 business days.  
However, the waiting period, known as “time to funding,” varies depending on a number of variables: 

• Time of day the transaction was processed; 

• The bank account  in which funds were deposited; 

• The length of time it takes your bank to verify and process electronic deposits. 
To update your deposit account information, sign in with your GoPayment User ID and Password here.   
From the web page, choose Account > Account Profile.  
Note:  This site is not optimized for mobile browsers, so you may wish to use your computer's browser.  
  
  

How do customers leave a tip? 
  
To activate the Tips feature: 

• At the bottom of the GoPayment screen, tap Settings.  

• Turn on Tips.  
For a customer to leave a tip: 

https://merchantcenter.intuit.com/
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• Once Tips is turned on, go to the Signature screen. 

• Tap Add Tip. 

• Tap a percentage amount (automatically calculates) or type a dollar amount directly in the Tip field.  

• Tap Apply Tip.   

• To make a change prior to leaving the Signature screen, tap Change Tip.  
  

How do I match a GoPayment charge in QuickBooks? 
 
You can apply a payment to an existing invoice in QuickBooks, create an invoice for the charge, or just credit a 
customer. 
  
To match a charge in QuickBooks: 

• In QuickBooks, choose Customers > Credit Card Processing Activities > Get Online Payments. 

• Select Mobile Transactions. 

What are the requirements for my wireless network? 
 
If wireless is used or implemented in the payment environment or application, the wireless environment must be 
configured per PCI DSS version 1.2 requirements 1.2.3, 2.1.1, and 4.1.1.  
Wireless technology must be securely implemented and transmissions of cardholder data over wireless networks 
must be secure. 
To be PCI-compliant, wireless network administrators must: 

• Install and configure perimeter firewalls between wireless networks and systems that store credit card 
data, per PCI DSS version 1.2, 1.2.3. 

• Modify default wireless settings, as follows, per PCI DSS 2.1.1: 
o Change default encryption keys upon installation and when anyone who knows the keys leaves or 

changes positions. 
o Change default service set identifier (SSID). 
o Change default passwords or passphrases on access points. 
o Change default SNMP community strings. 
o Enable WiFi protected access (WPA and WPA2) technology for encryption and authentication. 
o Update firmware on wireless access points to support strong encryption and authentication (WPA/WPA2). 
o Other security related wireless vendor defaults. 
o For wireless networks transmitting cardholder data or connected to the cardholder data environment, 

implement industry best practices for strong encryption of data transmission and authentication (e.g.,IEEE 
802.11i).  

o All newly implemented wireless networks are prohibited from using WEP as of March 31st, 2009.  
o For current wireless implementations, it is prohibited to use WEP after June 30, 2010. 

Learn more 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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Inventory 

Inventory Overview 
How do I?  | How Documents Affect Inventory | About Item Types 

Add an item 
Import items  
Edit an item 
Delete or merge items 
User reorder points 
Find an item 
Add item list columns 
Filter the item list 
Export my item list 

Use service items 
View inventory reminders 
View an item's history 
Track item price and cost 
Use Price Manager 
Adjust cost or quantity 
Take a physical inventory 
Print price tags 
More...   

  
  
The Point of Sale inventory is designed to help you easily define, track, view, and edit your items in a convenient, 
accurate, and efficient manner. Each row in your item list represents a unique inventory item, service, or fee. 
Transactions — such as receiving and selling merchandise — instantly update your inventory quantities and costs. 
Your item list stores all item information, including on-hand quantities, costs, price(s), UPC numbers, tax status, 
reorder points, and much more. 
  
Related Topics 
Item Definitions 
Import items 
Inventory reports 
Security rights for inventory 
View item list summary statistics 
Define QuickBooks item accounts 
  

Point of Sale Free 
References to entering or tracking inventory quantities or costs and related features, such as margin/markup and 
price levels, do not apply to you. 
  

Multi-Store Notes 
All item quantities at all stores comprise a single inventory, with Headquarters having central control over that 
inventory. Point of Sale tracks the quantities of each item located at each store within that inventory. Transactions 
update inventory at the local store. When the next Store Exchange of information is completed, all stores and 
Headquarters are updated with the updated inventory information, reflecting activity at all stores. If you also use 
QuickBooks financial software, transactions are sent to QuickBooks so that your inventory valuation and related 
financial records are updated. 
Inventory items and related files (departments, vendors, costs, prices etc.) can only be added or edited at 
Headquarters. Remote stores can view this information and use it to process transactions, but cannot edit the item 
information. 
Exception: Special order items can be created and ordered by remote stores, typically done while creating a 
customer order. The special order item is sent to Headquarters on the first transactional document listing it. 
Headquarters can make a special order item a permanent addition to inventory by converting it to an inventory 
item. Allowing remote stores to create special order items introduces the possibility of creating items with duplicate 
UPC or Alternate Lookups. Headquarters is alerted to and can fix duplicate items from the duplicate item reminders 
screen. 
Remote stores can be made aware of new items added at Headquarters via the new items reminders screen. 
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Item Types 
Inventory Overview | Add Items 
  
The inventory Item Type field is used to specify what type of item is being added: 

• Inventory – Merchandise that you purchase and resell, and for which you track on-hand 
quantities. 

• Service – Services such as miscellaneous fees, charges, or hourly labor for which on-hand 
quantities are not tracked. Learn more. 

• Non-Inventory – Same properties as service items, but often used for incidental items such as 
store supplies or small items that you do not wish to count. Allow you to have two categories for non-
merchandise items; and the ability to post them to different accounts in your QuickBooks financial 
software. On-hand quantities are not tracked. Learn more. 

• Assembly – (Pro) An item built from other pre-existing inventory items and optionally sold at a 
discount. The component items, once added to the assembly are no longer available individually. Learn 
more. 

• Group – (Pro) Provides a method to quickly sell a group of items that are already in your item list, 
optionally at a discounted group price. Unlike an assembly, groups are not pre-built and the included 
items remain available individually. Learn more. 

• Special Order – (Pro) Used to sell custom or one-time merchandise that you do not currently 
carry in inventory and may never carry. Special order items can only be added to inventory while creating 
a document to order, receive, or sell them. Later, the special order item can be converted to a regular 
inventory item, if desired. Learn more. 

Note: Miscellaneous items are not inventory items, so are not included here. 

Add a New Inventory Item 
How do I?  | Import Items  

Add an item 
Edit an item 
Delete or merge items 
User reorder points 
Find an item 
Customize item list columns 
Filter the item list 
Export my item list 

Use service items 
View inventory reminders 
View an item's history 
Track item price and cost 
Use Price Manager 
Adjust cost or quantity 
Take a physical inventory 
Print price tags 
More...   

  
  
Use this procedure to add a new item to your inventory. You can also read specific procedures for adding non-
inventory, assembly, group, style or service items. 
  

Notes: 
Your ability to perform this task may be limited by security rights. 
You can add a new item while making a sale or creating another document. Learn more. 

To add a new inventory item: 
* Indicates a required field. 

1. Open your item list, and then click Add from the window toolbar. 
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A new item form is opened. View Sample  

 

  
2. Enter the * Item Name/Item Name. This is the short item description that is printed on sales 
receipts. The field label can be customized.   
3. Navigate through the sections and fields of the item form, entering information as appropriate . 
Following are descriptions of the most commonly used fields in each section. More detailed explanation 
are located in the item fields topic. 

Basic Info  

• *Item Type: Leave set to Inventory. If you wish to add a different item type, click a link for 
specific instructions: non-inventory, assembly, group, style or service items. 

• *Department: Select the department to which the item belongs from the drop-down list. 

• Item/Description 2: Secondary, long description field used to record additional information. 
This field label can be customized to meet your needs. 

• Size: Enter the size for the item (if applicable). If using abbreviations, try to be consistent, 
e.g., Sm, Md. and Lg for example. Consistent entries will make filtering and finding items in inventory 
and on reports easier.  This field can also be used to describe a second item attribute other than size if 
desired. This field label can be customized. 

• (Pro) To add a line of related items differing only by size/attribute, click the Style 
button to enter the size and attribute combinations.  Learn more. 

• Attribute: Use to describe an item characteristic, such as the color, pattern, material, or a 
second size.  This field label can be customized. 

• Reg Price: Enter your regular sale price or leave blank and let Point of Sale use a department 
pricing formula to calculate it for you. 

• Click the Pricing button for additional price fields. 

• Avg Unit Cost: Enter a value if this is an existing item in your store on program startup or if 
you know the cost for a newly ordered item. If you leave this field blank, Point of Sale will auto-fill it 
with the cost when the item is received on a receiving voucher and maintain it by averaging the item 
cost over time. Learn more 

• On-Hand Qty: Enter a value if this is an existing inventory item in your store on program 
startup. If you are defining a new item that you will be ordering, leave this field blank for now and Point 
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of Sale will auto-fill it when you receive the item on a receiving voucher. Learn more 

• (Pro HQ) Click the Available button to enter existing on-hand quantities at other 
stores. 

• Tax: Review the tax field and select a tax code if necessary.  If you defined a default  tax code 
in the associated department record it will be suggested for the item. 

• UPC: Scan or type the UPC code. Learn more about these item identifiers. 

• Quick Pick Group: If you've defined Quick Pick Groups in your inventory preferences, you 
can assign an item to one of those groups to use with the Quick Pick Item feature on sales receipts 
and receiving vouchers. 

  
More Info  

• Vendor. Select the primary vendor from which you order this item.  (Pro) Click the Alt Vend 
button to add alternate vendors and their order costs. 

• Order Cost. Enter an order cost, if known, for your primary vendor. This is what you currently 
pay your vendor for one unit of the item.  Learn more. 

• Reorder Point. Enter a quantity if you want Point of Sale to remind you when it is time to 
order more of the item. 

• (Pro HQ) Click the View All button to enter/view reorder points for each store 
individually. 

• *Item Number. Suggested by the system, but can be edited. 

• Alternate Lookup. Enter an alternate lookup value that can be used to quickly add the item 
to documents. Learn more about these item identifiers. 

• Base Unit. When using multiple units of measure, the smallest quantity by which an item is 
sold or purchased. Learn more. 

• (Pro) Click the Units button to add additional units of measure. 

• Manufacturer. Enter the item manufacturer. This name can be used to search for an item or 
to filter reports. 

  
Comments  

• Use this free-form text Comments field to enter any pertinent item information not covered by 
another item field. 

  
Misc and Shipping  

• Print Tags – Select to include this item when printing tags. For items that you do not tag, 
clear the checkbox. This will help prevent inadvertently printing the tags when the item is included on a 
document or in a list for which you are printing tags. 

• Add to Mobile – Select to include this item to display on your mobile device. 

• Unorderable – select to have the item’s reorder point temporarily ignored and  alerted if the 
item is added to a purchase order or receiving voucher. This option can be used to remove seasonal 
or discontinued merchandise from your reorder reminders and reports. 

• Use Serial # –  (Pro) Select to be prompted to enter serial numbers when this item is listed on 
a document. Learn more 

• Earn Commission  –  (Pro) Select to include sales of this item when calculating commissions 
for your associates. Learn more 

• Shipping Weight, Height, Length, Width –  (Pro) Enter shipping specifications to use when 
shipping the item. 

  
QuickBooks Options  
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Define QuickBooks Item Account Information 
Available only if integrated with QuickBooks financial software. You can customize the way item transactions 
are sent to QuickBooks by specifying QuickBooks accounts here. 
By default, the item accounts are auto-filled using the default item accounts specified in company preferences, 
but you can change them on an item basis on this window. Learn more. 

  

  
5. To add the item to your Mobile device, click the Sync to Mobile box in the Misc and Shipping 
section. 
OR 
Click the Mobile box next to the Item # on the Item List. 
6. Click Save. 

  
  
  
Related Topics 
Copy one item to add another 
Add pictures to an item 
Define multiple units of measure 

Search for an Item 
 Sort the Item List | Filter the Item List 
  
From the Point of Sale Home Page, use Quick Find. 

Searching in your item list: 
  

1. Open your Item List. 
2. Begin typing keywords in the Search Inventory field.   

 
• A unique word from the item description is recommended. 

• You can also search by any other item field (department, vendor, size, color, etc.). The more 
unique the keyword, the fewer search results will be returned. 

• You can also scan the item's barcode tag. 

• As you type, the list is instantly filtered to display only matching items. Note how the filter button 
now indicates the list is showing Search Results and the number of records found is shown at the bottom 
of the list. In this case, typing "Orange" returned three sports drink items. 

 
3. If no results are found, use the backspace key on your keyboard to go back and re-enter new 
characters. 
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4. Select the item you wish to work with and then click Show Details or choose an appropriate task 
from the I Want To menu. 

  
Related Topics 
Add a New Item 
List items on documents 
  

Edit an Inventory Item 
How do I?  | Overview | Delete an Item | Add an Item 

Add an item 
Import items  
Delete or merge items 
User reorder points 
Find an item 
Add item list columns 
Filter the item list 
Export my item list 

Use service items 
View inventory reminders 
View an item's history 
Track item price and cost 
Use Price Manager 
Adjust cost or quantity 
Take a physical inventory 
Print price tags 
More...   

  

Pro 
This is the general procedure for editing most inventory items. 
(Pro) See the related topic links below for special instructions when editing assembly, group, or style items. 

To edit an inventory item: 
1. Highlight an item in your item list. 
2. Click Edit from the window tool bar. 

The item is opened in a editable form. 
3. Make necessary edits. 

• Refer to the item information fields table for assistance with specific fields. 

• If you edit the item average unit cost or on-hand quantity, Point of Sale creates adjustment 
memos to update your inventory value. If integrated with QuickBooks financial software, these memos are 
sent with the next Financial Exchange. Learn more about inventory adjustments. 
4. Select Save. 

  

Pro Note: 
• If using multiple units of measure, average unit cost and on-hand quantity are editable only for your base 
unit. 

Related Topics 
Making edits directly in your item list 
View an item's history 
Edit an assembly item or a group item 
Edit a style 

Delete an Item 
Find an Item | Merge Items | Edit Items | Delete Style Items 
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Inventory items can be deleted when you no longer need them, with some restrictions. Deleting an item does not 
affect the ability to see the item on saved documents or on reports based on history documents. 

To delete items: 
1. Select the item or items to be deleted from your item list.  How do I select multiple records?   
2. From the I Want To menu, select Delete. 

The Delete Items window is displayed, showing the status of the selected items and whether deletion is 
possible. Tell me more.   

3. Select Delete to delete the eligible item(s) or Cancel to return to your item records. 
4. If prompted, confirm the deletion. 

If you choose to delete an item that has an on-hand quantity, Point of Sale creates an adjustment memo to adjust 
your inventory value. If you delete items that are listed on an open order, you should edit the order document to 
remove the items. 
  
Note: Deleted item added back to inventory if document listing it is reversed  
  
If you are deleting an item because you have inadvertently created a duplicate of the same item, consider merging 
the items instead, as this will combine the two item histories into one record and remove the other. 
  
Related Topics 
Clean up your company data 

Merge Item Records 
Find an Item | Delete an Item | Edit an Item 
  
Occasionally you may find that you inadvertently entered the same item into inventory twice or that you have two 
items you prefer to track as a single item. Merging them allows you to combine the two items into a single item 
record with the combined history of both. You specify which of the item records is kept and which is removed. 
The following rules apply to merging items. See the notes below for additional information. 

• Only two items can be merged at a time 

• Both items must be of the same item type 

• (Pro) Merging of assembly or group items requires that both items include the same component items 

• (Pro) Merging items can be done at Headquarters only 

To merge two items: 
1. From your item list, select one or both of the items you wish to merge. How do I select multiple 
records?   
2. From the I Want To menu, select Merge. 

The Merge Items window is opened. The item to be kept is shown on the left and the item to be removed is on 
the right. Review the items to ensure they are correct: 

• Select Swap between the items to reverse positions of the items 

• Use the drop-down list and normal item Find procedures to add the second item or change items 
if necessary 
3. Select Merge Items. 

If the item being removed was included on prior transactions or is a component item of another assembly or 
group item, a list of the documents and item records that will be affected by the merge is displayed. How are 
they affected?   

4. Select Merge Items. 
A confirmation dialog is displayed when the merge process is complete. 
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Notes: 
• Quantities of the merged items are combined. All other values are preserved from the item record you 
select to keep. If necessary, you can edit the retained item after merging to revise these values. 

• Point of Sale automatically creates adjustment memos to combine item quantities and to update your 
inventory value (if the removed item had an average unit cost different than the retained item). These 
adjustment memos will have a Reason field entry of Merge Item. 

• All instances of the removed item on history documents, order documents, and active (but not saved) 
physical inventory counts are replaced with the retained item. However, the item cost is not recalculated on 
affected history documents. 

• If you have an on-hand quantity of the removed item with printed price tags, you may have to reprint those 
tags from the retained item record so they include the correct item identifier, bar code, price, etc. 

• ( Pro)  Inventory changes resulting from an item merge are sent to remote stores with the next Store 
Exchange file. However, remote store history documents that are updated at Headquarters when merging 
items are not sent back to remote stores. The remote store history will continue to reflect the item 
circumstances in place at the time the original document was made at that store. The merge item procedure 
can also be initiated from the Duplicate Item Reminders window. 

Inventory Reminders 
Inventory Overview 

Pro 
Inventory reminders help you track and manage your inventory by alerting you to situations that may need your 
attention. 
When an item’s combined on-hand quantity and on-order quantity has fallen below their reorder point, it is added to 
the Reorder Item reminders screen. You can print this list to help in creating purchase orders to replenish your 
inventory. 
Besides reorder reminders, you also are reminded  when item prices change,  when new items have been added to 
inventory, or when items have arrived to fill open customer orders. 

To view inventory reminders: 
1. From the home page, select Reminders from the Inventory menu. 
2. Select one of the available tabs. 

Reorder items reminders 
Price change reminders 
New item reminders 
Duplicate item reminders 
Fill Customer Order Reminders 

  

Notes: 
• With the reminders window displayed, you can print the list or double-click a displayed record to view it. 

• Reminders are a handy way for remote stores to learn of price changes and new items. 
Related Topics 
Reminders Message Alert 
Security rights for reminders 

Service and Non-Inventory Items 
Item Types | Inventory Overview 
  
Either service and non-inventory items can be used to sell or charge for non-merchandise services and fees, such 
as for tailoring, repairs, gift-wrapping, recycling fees, and delivery charges. The on-hand quantity of both these item 
types is always zero (0). 
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Non-inventory items are also sometimes used for incidental merchandise items for which you do not wish to track 
quantities. Example  
Having two item types for these uses allows you to categorize and post the sales to different income accounts in 
your QuickBooks financial software and on Point of Sale reports. 
  
To define a service or non-inventory item: 

1. Start adding a new item as usual. 
2. In the item Type field, select Service or Non-Inventory. 
3. Enter information in the other item fields as needed. 

• Use the Item Name field to record a description of the service or fee, such as Gift Wrap, Repair 
Labor, Delivery Charge, Recycling Fee, or Alteration. 

• Typically, the average unit cost of these items is $0. Exceptions are when you sub-let a service to 
an outside company or are purchasing an incidental item, in which case you should enter the unit cost. 

• Assign a tax code, if applicable. 

• Use the Unit of Measure field, if applicable, to specify the sales unit, e.g. hour, each, piece, etc. 
4. Select Save. 

  
Charge for services by the hour 
List service or non-inventory items on documents 
Learn more about using service items 
Collect Government-mandated fees 
Use a service item for shipping charges 

Add Pictures to Your Items 
Add New Items | Import/Export Pictures 

Pro 
Why add pictures to my items?  

Nothing can replace the simplicity of identifying items by seeing them. There are many in-store advantages to 
adding pictures or photos to your item records. An item can be mislabeled in error, or the tag swapped 
intentionally by an unscrupulous customer. 
By associating an image of the item in the item’s record, you can easily identify if the item has the correct tag. It 
can also be easier to find an item on the shelf or on a rack if you can first see a picture of the item. 

  
Are there any disadvantages to adding item pictures?  

If you have a large inventory, adding pictures to all your items can significantly increase the size of your data 
file and the time it takes to back up your data. 
These issues can be minimized by not routinely including the item pictures in your data backups. 

  
Picture file formats and attributes  

You can assign or import pictures in JPG, GIF, BMP and TIF formats. However, Point of Sale converts and 
stores all pictures in the JPG format. 
The maximum picture size is 1000 pixels by 1000 pixels. If you attempt to add a picture larger than this, Point of 
Sale will resize it to this dimension. Since these pictures are intended for viewing on your computer monitor, the 
recommended resolution is 72 dpi. Higher resolutions will increase file sizes, which in turn increases disk space 
and loading time. 
Picture file information is preserved when the picture is brought into Point of Sale. Additionally, information for 
the picture name, size, and last edit date is also saved. 

  
Making the picture fields available in inventory and on documents  
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To add the picture fields to Point of Sale: 
1. From the File menu, select Preferences > Company. 
2. Select Inventory from the preferences list on the left. 
3. Select the checkbox labeled I want to associate pictures with my inventory items. 
4. Click Save. 

A thumbnail of the default picture added to the item record will be displayed on sales receipts, customer orders, 
purchase orders, and receiving vouchers. Click the thumbnail to view the full-size picture. 

 
You can turn on/off the display of pictures on order documents, if you prefer. With a document displayed, from 
the I Want To menu, click Show Item Picture. 

  
  
You can associate up to two pictures with each item or item style in inventory. The pictures can then automatically 
be viewed at all workstations on your network when you display the item record and when adding the item to most 
Point of Sale documents. 
The default picture is used to generate the thumbnail picture displayed throughout Point of Sale. An alternate 
picture can also be assigned so you can switch between them. 

To quickly add one picture to an item: 
1. Make the picture fields available as described above. 
2. Find the item in your item list and click Show Details. 
3. Click the Click here to assign a picture field adjacent 
to the Item Name. 
4. In the Open file window, browse to the picture file and double-click it. 

To add a second picture, remove a picture, or swap between 
pictures: 

1. Find the item in your item list and click Show Details. 
2. Click the current picture adjacent to the Item Name. 
3. Click Edit. The Pictures window is opened in edit mode as shown below. 
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4. Use the action buttons to edit the picture(s): 

• Clear to delete a picture. 

• Browse to picture to add a picture or to replace an existing picture. 

• Swap to change positions of the primary (left) and alternate pictures (right). 
5. When done, click Close Picture Window in the upper-left. 
6. Click Save to save your edits. 

To add pictures to a style: 
All items in the style will display the pictures assigned in this manner. After assigning a style picture, you can 
change the pictures for individual items within the style using the procedure above. 

1. Display a style item record. 
2. Click the Style button on the item form. The Style window is opened. 
3. Add a picture at the top of the Style window in the same manner as above . 
4. Save the style record. 

  

The Inventory Picture Album 
The Inventory Picture Album displays your default item pictures and provides an alternate method for viewing and 
working with your item list. Most actions available in the item list are also available from the picture album. 

• From the inventory I Want To menu, select View Inventory Picture Album. 

• Double-click a picture to open the item record for viewing or editing. 

• Right-click a picture or open the I Want To menu to select other available tasks. 

Notes: 
• You can also add item pictures by dragging-and-dropping the picture file unto one of the picture slots. 
Reduce the size of the Point of Sale window before opening the item record so you can position Windows 
Explorer alongside to facilitate dragging the needed file. 

• If you need to add pictures for a lot of items at once, consider importing them with the Data Import Wizard. 
Use the link at the top of this page top learn more about importing pictures. 
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• Your item list can be customized to include the Picture Assigned column which indicates whether a 
picture has been assigned to an item. Item reports can also be modified to show whether an item has a 
picture assigned, and to display the picture name. 

• (Multi-store) Only Headquarters can add or edit item pictures. Headquarters can then send the pictures to 
remote stores, making them available to view there. 

Return to top 

Units of Measure 
Inventory Overview 

Basic  

There are two levels of item unit of measure in Point of Sale. 

Single Unit of Measure (Basic) 
A unit of measure can be added to item records and can then be used to filter and sort your item list and reports. 
For example, a candy store might define units of measure of "ounces" and "lbs" and then assign one of those units 
to each of their candy items. 
Define the allowed units on the Inventory page of company preferences. 
  

Multiple Units of Measure (Pro) 
Using multiple units of measure allows you to purchase and sell items by different units. For example, when you 
purchase an item by the case but sell it by the bottle, or buy in bulk but sell by the pound. 
Select the I Want to set up multiple units of measure… checkbox on the Inventory page in company preferences 
to enable this feature. Then, on the item record, you can define a base unit of measure and up to three alternate 
units that you buy or sell by (such as case, six pack, can, 100 lb bag, one pound, etc.). Each unit of measure can 
have a different UPC code, alternate lookup value, and sales price, allowing you to list any of the units of measure 
on documents. You can also specify your default purchase and sell-by units. 
If the multiple unit of measure feature is turned off, you still retain the single unit of measure capability. 
Learn more about using multiple units of measure 

Item History and Statistics 
Inventory Overview | Item Ratings & Trends | Inventory Reports 
  
Item history provides a listing of every transactional document that has affected an item and a running tally of 
changes in on-hand quantity. You can click any listed document to view it. 
Item Statistics include an item summary, including cost and profit information and total quantities in/out. 

Item History   
(Pro) Item history can be viewed only at Headquarters. Headquarters can filter to view the history for any one store 
or for the entire company. 
To view an item's history, with the item record in Edit mode (displayed in a form), expand the History section. 

 
The most recent documents are at the top of the list. 
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• To view a listed document, double-click it.  You are taken to the appropriate history list with the document 
pre-selected. Normal copy, reverse, and edit capabilities are available for the document. When done, click Go 
Back at the bottom of the document to return to inventory. 

• The Change column lists the document’s effect on item on-hand quantities. For example, a sale results in 
the on-hand quantity being reduced, therefore the Qty Change is a negative number. Likewise, receiving a 
quantity into inventory is shown as a positive number. 

• The On-Handy column displays a running total of the on-hand quantity, after being adjusted by the 
document. 

• If the item is listed multiple times on a document (example: a customer exchange for the same item), the 
document is listed twice, once for the return (a positive quantity) and once for the new sale (negative quantity) 

Item Statistics 
Expand the Statistics section on the item record to view a graphical rating of the item's relative performance in 
your inventory as well as total sales, cost, profit, and  quantities in/out. This information reflects the time period 
specified for item ratings in preferences. 
Learn more about item ratings 

 
  
  
Related Topics 
Reverse a history document 

Item Ratings & Trends 
View Item History | Inventory Overview 
  
Item ratings and trends provide graphical rankings of sales performance based on profit, net sales quantity, or net 
sales dollars, over a specified time period. 
This feature helps you quickly identify hot-selling items that you might want to feature and slow-movers that require 
corrective action. 
Shown below is the Statistics section of  an item record, which includes the graphical item rating and quantitative 
sales, profit, and margin information for the item. Trends are not included in this  window. 
Both Ratings and Trends columns can be added to your item list using the customize list columns feature.. 
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Turning on Ratings & Trends 
Ratings and trends can be turned on/off and the performance criteria and time period set by the Server Workstation 
on the Ratings & Trends page of company preferences. You may also have to customize your item list columns or 
information panel to view the rankings. 
  

About Item Ratings 
Item ratings use a familiar five star system, reflecting the performance of the item over the specified time period. 
Each additional star represents the next 20th percentile of the range between the highest and lowest values in the 
ranked value. Hover your mouse over the star icons to view the actual ranked values for an item and the maximum 
in the period for all items. 

Items with no sales in the period are rated at 0 stars. Items that have never been sold display . 
View Ratings Example  
  

About Item Trends 
The sales performance trend of an item is indicated by up/down arrow icons. The icons are representative of the 
degree of performance change between the current period compared to the previous period of the same duration. 
Hove your mouse over the icon to see actual values for both periods and the change percentage. 
For example, if you select in preferences to rank for the last 90 days, the trend compares sales in the last 90 days 
to sales in the previous 90 day period (i.e., 91-180 days ago). 
View Trend Example  
  

Notes: 
• The ranking period can be set from 1 to 999 days. If you choose a 999 day current ranking period, trends 
will not apply as sales data is not read for the previous 999 days. 

• Rankings are updated at least once a day (on program startup or automatically between 1 am and 5 am if 
your computer is running). Rankings are not updated for the current day’s sales as they are made. 

• The ability to view item rankings can be controlled by a security right. 

• Group items are never ranked; but the group component items are ranked individually. 

• (Multi-Store) Rankings are calculated at Headquarters only and reflect sales at all stores. They are sent to 
remote stores where they can be viewed. 

Print Your Item List or Tags 
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Print Tags: Basics | Tags Styles and Sizes | Overview 

To print your item list: 
1. Display your item list and select the items to include in the printout: 

• If printing all items, you do not need to make an item selection. Make sure the list filter is set to 
display All Items. 

• If printing a subset of your list, filter or search the list first, or select those you want to print. How 
do I select multiple items?   
2. Select Print Items from the I Want To menu. 
3. In the Print Items dialog, select: 

• Print all items – to include all items currently displayed in the list 

• Print selected items – to include only the items selected 
4. Click Print in the Print dialog. You can also change the printer or number of copies on this dialog. 

  

To print item price tags: 
  

1. Select the item(s) for which you want to print tags: 

• To print tags for a single item, highlight or display the item. 

• To print tags for several items, select them all. How do I select multiple items?   

• To print tags for a larger group of related items, filter or search your item list to display only the 
group of items. 
2. Select Print Tags from the I Want To menu. 
3. Follow the on-screen prompts to specify print settings and print: 

• The printer to use 

• Whether to print tags for the selected items or all displayed items 

• The number of tags to print, i.e. the on-hand quantity or a specified quantity 

• The tag template to use; be sure the template matches your selected printer 

• If printing to a sheet of labels, the start position on the sheet. Tip: Click on the sheet label position 
where you want printing to start. 

Tag Printing Options 
• You can include an item’s MSRP (Manufacturer’s Suggested Retail Price) on your price tags to 
display savings to your customers. 

• You can also print tags that include the item cost and last received date printed in code. Only 
informed employees will be able to read these values. 

• Don’t want to print tags for an item? Clear the Print Tags checkbox in the Misc and Printing 
section of the item record. This will help prevent accidental printing of tags for an item even if it is 
displayed or selected on-screen when printing. 

Track Items from Multiple Vendors 
Inventory Overview | Vendors Overview 

Pro 
The multi-vendor feature allows you to track and purchase an item from one primary vendor and up to four 
alternate vendors. Unique UPCs, Alternate Lookups, and order costs can be defined for each vendor from whom 
you purchase the item. This allows you to purchase the same item from any of several vendors as availability or 
costs change. 
All purchases of the item, regardless of vendor, are pooled in inventory once received, and are tracked with a 
single on-hand quantity, averaged cost, price, etc. However, the unique UPC, order costs, and alternate lookups 



Printed Documentation 

128 

allow you to list the item on documents using the information for any of the vendors. This feature also allows 
purchasing and receiving reports to be filtered by actual vendor used. 

What would you like help with? 
Define alternate vendors for an item in inventory  

1. Add each vendor from whom you will purchase the item to your vendor list. 
2. Add or edit the item in inventory in the normal manner, entering the first (primary) vendor’s 
name, UPC, and Alternate Lookup on the item form. 
3. In the More Info section, click Alt Vend. 

 
The Vendors window is opened. 

4. Enter information for up to four alternate vendors and then close the window. 
If the alternate vendors do not have a unique UPC or Alternate Lookup, leave these fields blank. 

7. Select Save. 
  

Notes: 
• If you want to print tags for an item with specific vendor information (alternate lookup value or UPC), 
print the tags from the purchase order or receiving voucher. When printing tags from inventory, the 
primary vendor's information is used. To print tags with UPC codes requires that you first customize your 
tag template using Print Designer. 

• If tracking multiple units of measure for an item, enter alternate vendor information (UPC, alternate 
lookup, and order cost) for your default order-by unit. If no order-by unit is specified, enter information for 
the base unit. 

  
Make a PO or receiving voucher for multi-vendor items  

1. Enter the vendor from whom you are making the purchase at the top of the PO or voucher form. 
2. List the item(s) to be purchased or received: 

• If you list an item by entering or scanning UPC or Alternate Lookups (ALU), be sure to enter 
or scan the correct value for the vendor from whom you are making the purchase. 

• If you track multiple units of measure for an item being purchased, be sure to use the UPC or 
ALU for the default order-by unit. 

• The correct order cost for the vendor used is suggested for the item. Edit this order cost as 
necessary. 

3. Complete and save the PO or voucher in the normal manner. 
  
If creating a voucher by referencing a PO, the specific vendor and order costs listed on the PO will be carried to 
the voucher automatically. 
Purchase and receiving history is maintained for each vendor separately. 

  
List multi-vendor items on other documents  

No special procedure need be followed when listing multi-vendor items on documents other than a PO or 
receiving voucher. Scanning or entering the Item #, or any of the primary or alternate UPCs or Alternate 
Lookups for the item will list the item on the document with the correct inventory cost or price. 
Sales of a multi-vendor item are not tracked separately for each alternate vendor. All sales are reported using 
the primary vendor you identified in inventory for the item. 
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Multi-vendor items on reports  

Merchandise Reports 
Merchandise reports, which draw their information from inventory, will show all of the item's quantities under 
your primary vendor's name. Quantities purchased from alternate vendors are not broken out separately. 
  
Purchasing Reports 
Purchasing, receiving, and on-order reports, which draw their information directly from purchase orders and 
receiving vouchers, will break out ordered quantities by alternate vendors. 

  
Print tags for alternate vendors  

Item tags printed from inventory always include the information for your primary vendor. To print tags that 
include alternate vendor information, such as the alternate lookup or UPC values, print the tags from the 
purchase order or receiving voucher used to purchase the items from the alternate vendor. 

  

Item Fields 
Data Field Overview | Inventory Overview | Program Capacities 
  
Refer to the tables below for descriptions of available item fields. 
Fields shown in brackets, e.g. [field name], are suggested  or read-only  fields auto-filled by Point of Sale. 
* indicates a required field. 

What would you like more information about? 
Item Description/Lookup Fields 
Price/Cost and Tax Fields 
Quantity Fields 
Other Item Fields 
Create Custom Item Fields 
Customize Item List Columns 
  

Item Description/Lookup Information 
Field Usage 

Type* Used to designate the type of item: Default is 
Inventory. Select a different type from the 
drop-down list, as necessary. 

Department* Department to which the item belongs. 
Required field for all items. To access your 
department list, press (<F4>) from the field. 
(Pro) Must be the same for all members of a 
style. 

Vendor The primary vendor from whom you purchase 
the item. To search for or look up a vendor, 
press (<F4>) from the Vendor field. 
(Pro)  Learn about using multiple item vendors. 

Item Name* 
( Description 1 for 
some upgraders) 

The principal item description field. Printed on 
sales receipts. Required field. Label can be 
customized. 
(Pro) Must be the same for all members of a 
style. 

Item Description Secondary, long description field used to 
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(Description 2 for 
some upgraders) 

record additional information. Also can be used 
to record additional information while making a 
sales receipt. Label can be customized. 

Attribute A field used to describe an item characteristic, 
typically color, pattern, material, or a second 
size. 1 to 12 characters. Label can be 
customized. 

Size The size of an item; 1 to 12 characters. This 
field can also be used to describe a second 
item attribute other than size if desired. Label 
can be customized. 

[Item #] Unique number that identifies each item; 
corresponds to the inventory row number. 
Suggested by the program, but editable. Used 
to print item bar codes on tags and to list items 
on documents. Numbers greater than 99,999 
not recommended as the resulting bar code 
would not fit on some price tags. This field 
supports numerical values only. If you need to 
enter an identifier that includes letters, use the 
Alternate Lookup field (described below). 
You can have suggested numbering sequence 
restart from your entry in a company 
preference. 

UPC Universal Product Code: The item's unique 
UPC/EAN identifier. Once entered, can be 
used to scan vendor-tagged merchandise to 
list on documents. This field is normally 13 
characters. If a shorter number is entered, 
Point of Sale uses an appropriate algorithm to 
lengthen the entry to fill the 13-character field. 
Learn more. 
(Pro) If multiple vendors or multiple units of 
measure are being used for an item, each can 
be assigned a unique UPC. 

Tag User-defined group tag assigned to items to 
facilitate use of the Quick Pick feature for 
adding items to a document. 

Alternate Lookup 
(ALU) 

A user-defined identifier that can be used to 
look up items. This field can contain text 
descriptions, catalog numbers, etc. Duplicate 
Alternate Lookups are not allowed. 
Do not duplicate the Item # or UPC in this field. 
Inefficiencies in item lookups would result. 
(Pro) If multiple vendors or multiple units of 
measure are being used for an item, each can 
be assigned a unique alternate lookup. 

Return to top 
  

Price/Cost and Tax Fields 
Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

Field Usage 
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Reg Price The regular price for which you sell the item. 
 Calculated by Point of Sale on new items if you 
are using a department pricing formula. 
Markdown price levels, if used, are calculated 
from this price. 

[Avg Unit Cost] The average unit cost of the on-hand units of 
the item; updated by receiving vouchers, 
adjustment memos, or manually. If you 
manually edit this field, Point of Sale creates an 
adjustment memo to send to QuickBooks. See 
price and cost for more information. 

[Order Cost] The current cost of an item charged by your 
vendor. The order cost is suggested on 
purchase orders and vouchers and 
automatically updated when a voucher is 
updated with a new item cost. 
(Pro) If multiple vendors are being used for an 
item, each can be assigned a unique order cost. 

MSRP Manufacturer’s Suggest Retail Price. Optional 
reference price that is printed on most price 
tags if entered. Leave blank if you do not want 
the MSRP printed on tags. 

[Margin%] The profit expressed as a percentage of the 
price. If defined in a department record, is auto-
filled and used to calculate the regular price of 
new items. Editable. Manually editing the 
margin in inventory automatically causes your 
item prices and the Markup % to be 
recalculated. Learn more 
Margin % = (Price – Cost)/Price x 100 

[Markup%] The item profit expressed as a percentage 
markup over the cost. Works in the same 
manner as Margin %. Making an entry in this 
field causes Point of Sale to recalculate the item 
prices and margin. Learn more 

[Price Levels 1-
4] 

Optional item price levels, each marked down 
from your regular price. Used to offer different 
prices to different customer groups (employee, 
wholesale, etc.) or for other purposes, such as 
for a discounted sale. You define price level 
names and markdown percentages in company 
preferences and these names will be displayed 
in the item record and item list. 
Once defined, price level prices are 
automatically updated anytime your regular 
price changes, or can be manually edited as 
needed. Learn more 

[Tax] Tax code name: A drop-down list containing 
each of the tax code names defined in company 
preferences. By default, each new item is 
assigned a default tax code as specified for the 
associated department. Edit by selecting a 
different tax code as necessary. Learn more 

Return to top 
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Quantity Fields 
Field Usage 

[On-Hand Qty] On-hand Quantity: The quantity of an item on 
hand at this store. Automatically updated each 
time an item is received, sold, transferred, or 
adjusted on a memo. A manual entry in this field 
results in an adjustment memo being created 
and sent to QuickBooks. Decimal quantity 
entries are acceptable. 

Reorder Point User-specified company quantity at which an 
item should be reordered. When the combined 
on-order and on-hand quantity is at or below 
this level, the item is added to the reorder items 
reminder list. 
(Pro) In the case of assembly items, indicates 
the point at which more should be rebuilt. 

Doc Qty Document Quantity. Used to enter the quantity 
of an item to be listed on a document. Displayed 
only when accessing the item list from a 
document to select items. Enter the item 
quantity you want to list on the document. 
(Pro) You can also switch to Style View and 
enter document quantities in the style item grid 
cells when coming to inventory from a 
document. 

[On Order] Quantity of the item listed on open purchase 
orders and not yet received. Displayed in item 
list. 
(Pro) Also visible by selecting Available from 
the Quantities area of the item form. 

[Quantity 
Available] (Pro) 

Quantity available for immediate sale. 
Calculated by subtracting the quantity 
committed on active customer orders from the 
current on-hand quantity. Learn more 

BackOrd Qty 
(Pro) 
  

Quantity of this item needed for active customer 
orders. 

[Qty] in 
Assembly or 
Group (Pro) 

In Assembly/Group item grid. Specifies the 
quantity of an item included in an assembly or 
group item. 

[Company 
Total] 
[Cmp Qty] (Pro) 

Total on-hand quantity for the entire company 
(all stores). Select View All in the Quantity area 
of the item form to view. Called Cmp Qty in 
your item list. 

[Store On-Hand 
Quantities] 
 (Pro) 

On-hand quantity for each store; designated by 
your assigned store codes. Select Available 
from the Quantities area of the item form to 
view. Also available in the Item Information 
window (<F5>) from a receipt and your 
inventory item list. 

[Quantities for 
Store #]  (Pro) 

(Style View) Drop-down list of store locations. 
Select a store or All Locations to view 
quantities at the store or for the company for 
each style item. 
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Return to top 
  

Other Item Fields 
Field Usage 

[Last Received] The most recent date this item was received. 

Print Tags Checkbox. Select to specify that you want to 
print price tags for the item. If you clear the 
checkbox, tags will not be printed for the item 
even if it is listed in a group of items for which 
you are printing tags. Default is selected. 

[Rating] Graphical indicator of item performance over 
time, based on user-defined time period and 
familiar five-star system. Learn more 

[Trend] Graphical representation of item performance in 
user-defined current period compared to prior 
period. Learn more 

Unorderable Checkbox. Select to have the item’s reorder 
point temporarily ignored and to be alerted if the 
item is listed on a purchase order or receiving 
voucher. This option can used to remove 
seasonal merchandise from your reorder 
reminders and reports. 

QuickBooks 
Accounts 
[COGS] [Income] 
[Asset] 

Item mappings to QuickBooks cost of goods 
sold, income, and asset accounts. Defaulted to 
the item accounts specified in company 
preferences, but can be edited for individual 
items by selecting a different account from the 
drop-down list. Learn more 

Unit of Measure Display field that can be used to indicate the 
measurement or quantity units by which the 
item is sold, such as each, inch, gallon, case, 
etc. Used to filter and sort the item list and 
reports. Select a unit from the drop-down list or 
select Add New to create and use a new unit. 
Units of measure can be managed (added, 
deleted, reordered) in company preferences. 
(Pro) Read Using Multiple Units of Measure and 
see additional fields below if you purchase and 
sell items in more than one unit size. 

Base Unit of 
Measure (Pro) 

When using multiple units of measure, the 
smallest quantity by which an item is sold or 
purchased. 

[Earn 
Commission] 
(Pro) 

Checkbox. Select to identify Items that qualify 
for payment of employee commissions. Default 
is checked (eligible). Clear the checkbox if 
employees are not to be paid commissions on 
the sale of the item, Learn more 

Use Serial # 
 (Pro) 

Checkbox. Select to be prompted to enter a 
serial number when the item is listed on 
documents. 

Custom Fields 
1-5 (Pro) 

Custom item fields can be used to enter any 
other item information you need to track. Once 
defined, the fields can be used to filter lists and 
reports, and can be added to your printed 
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documents using Print Designer.  Learn more 

[Open Purchase 
Orders] (Pro) 

List of open purchase orders for the item and 
the total quantity on order. Select Available 
from the Quantities area of the item form to 
view. 

Select a Style 
Template (Pro) 

Select a pre-defined attribute/size template from 
the drop-down list to apply it to the style grid or 
select Add New to create a new template. 
Learn more. 

Vendors – 
Alternate 2 -5 
(Pro) 

(More Info section) Fields for entering one 
preferred and up to four alternate vendors for an 
item. Each vendor can have a unique UPC, 
Alternate Lookup, and order cost. 

Return to top 

Tracking Item Quantities 

Quantity Fields 
In-help popup 
  
Quantity fields are blank or have a suggested entry until a different quantity is entered. Numbers are the only 
acceptable entries in these fields. Decimals are allowed (up to five places), but Point of Sale only displays two and 
does not display trailing zeroes, i.e. if you enter 2.40, Point of Sale will display 2.4. 
Even though Point of Sale displays a maximum of two decimal places, it actually stores and uses five decimal 
places for quantity calculations. 

To enter data in quantity fields: 
1. Enter the appropriate data. 

• To enter negative numbers, press <-> before entering the value. 
2. Press <Tab> or navigate to the next field. 

Using Inventory Reorder Points for Purchase Decisions 
Reminders Overview | Purchasing Overview 

Pro 
You can define a reorder quantity (Reorder Point field) for your inventory items, allowing you to quickly see which 
items need to be purchased. 
You can prevent an item from being added to the Reorder Reminders by flagging it as unorderable on the item 
record. This is handy for removing seasonal merchandise from the reminders list. 
You can also run Reorder and Build Point reports. 
  

Basic 
Items at or below their reorder point are listed on the inventory Reorder Reminders window. Point of Sale takes into 
consideration any quantities already on order before adding an item to the reorder reminders list. 

Pro 
A company preference setting specifies the value used to determine when an item is added to your reorder 
reminders: 

• On-hand quantity:  With this option, Point of Sale adds an item to the reorder reminders when the combined 
on-hand and already on-order quantities is at or below the reorder point. 

• Available quantity:  With this option, Point of Sale adds an item to the reorder reminders when the combined 
on-hand and already on-order quantities, minus the quantity committed on active customer orders, is at or 
below the reorder point. 

Point of Sale can suggest POs to reorder the items on the Reorder Reminders list. 
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For assembly items, the reorder point indicates that quantity at which you want to build more of the assembly item. 

Multi-Store   
You can specify reorder points for the company (all stores combined) and for individual stores. The Reorder 
Reminders shows reminders for the company and each individual store as well. 
  
Related Topics 
Inventory overview 

Reorder Items Reminder 
Item Reorder Points | Reminders Overview | Inventory Overview 

Pro 
The Reorder Items reminder screen displays items whose quantity has fallen below the reorder point set in 
inventory. Use this screen to assist in replenishing your inventory. 

• You can print this list to help in creating purchase orders. 

• Double-click a listed item to view the item record. 
Point of Sale takes into consideration item quantities already on order (from unfilled purchase orders) when 
determining if an item should be added to the reorder reminder list. Learn more  
To display this screen, select Reminders from the Inventory menu and then click the Reorder Items tab. 
  

Pro Notes 
•  The reminder screen also includes items that are on backorder. 

•  Depending on your preference settings, quantities committed on customer orders may be taken into 
account when deciding if an item is added to this screen. 

Having Point of Sale Suggest POs for Reorder Items (Pro) 
You also have the option of having Point of Sale suggest and generate purchase orders to order these items. 

• With your reorder reminders displayed, select Suggest PO from the I Want To menu. Learn more about 
using Suggest PO 

Related Topics 
Reminders Message Alert 
Security rights for reminders 

Track Decimal Quantities 
Notes on Quantities and Costs | Multiple Units of Measure 

Basic  

Sometimes it is beneficial to track items in decimal quantities. For example, you might sell an item by the yard (e.g., 
fabric), by weight (e.g., bulk candy), or by the hour (labor). Point of Sale allows you to order, inventory, and sell 
items by decimal units. 
For example, if you order and price fabric by the yard you can easily sell 1/4 yard or 1-1/2 yards by entering .25 or 
1.5 in the Qty field on receipts. The correct fractional price will automatically be calculated for you. 
To charge an hourly fee for labor define a service or non-inventory item called Labor or similar, assigning your 
hourly rate as the price. On a receipt or customer order, you can now list the service or non-inventory item Labor 
and charge for partial hours by entering a decimal quantity in the Qty field. 
You can enter decimal quantities in any quantity field. Point of Sale will round your entry to two decimal places for 
display purposes and does not display trailing zeroes, i.e., if you enter 2.50, the display will be 2.5. However, the 
program stores and uses up to five decimal places for its calculations. 

Getting Started: Notes on Item Quantities and Cost 
Available Quantities | Decimal Quantities | Decimal Costs  

Basic  
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The Average Unit Cost field in inventory reflects the average cost of the currently on-hand quantity of an item. 
This value is automatically recalculated by Point of Sale when you create a voucher to receive an item at a cost 
different than what is currently recorded. How does order cost differ from average unit cost? 
The On-Hand Quantity field reflects the number of units of an item currently in stock. This value is automatically 
updated as you create vouchers, receipts, and, if applicable, transfer slips. 
Item quantities and costs have significant impact on your inventory value and your financial records. For this 
reason, it is recommended that you manually enter or edit these values only when entering items already in your 
store when you begin using Point of Sale. From that point on, Point of Sale maintains an accurate ledger of 
changes in these values with the use of transactional documents (receiving vouchers, receipts, transfer slips, and 
adjustment memos) and the Physical Inventory utility. The table below summarizes how quantities and/or costs are 
updated in various ways. 
  

Method Comments 

Receiving 
vouchers 

Updates on-hand quantity, average unit cost, 
and order cost in inventory. Should be used for 
receiving all new and reordered items into 
inventory. When you define a new item in 
inventory that is to be received later, we 
recommend you leave the On-Hand Quantity 
and Average Unit Cost fields blank in 
inventory and allow the receiving voucher to 
update them. 

Receipts When an item is sold or returned on a receipt, 
the on-hand inventory quantity is adjusted up 
or down accordingly. 

Adjustment 
memos 

A memo is used anytime quantity or cost must 
be manually adjusted (because it is not 
handled by a receiving voucher, receipt, or 
physical inventory count). Many actions, such 
as conducting a physical inventory, or 
manually editing the cost or quantity fields, 
automatically create adjustment memos for 
you. 

Physical 
Inventory 

Updates on-hand quantities only. Updating a 
physical inventory automatically creates 
adjustment memos to update inventory. 

Transfer slips 
 (Pro) 

A transfer slip has no affect on company 
inventory quantities, though it does increase or 
decrease the on-hand quantities at the specific 
stores involved in the transfer. 

Return to top 

Item History and Statistics 
Inventory Overview | Item Ratings & Trends | Inventory Reports 
  
Item history provides a listing of every transactional document that has affected an item and a running tally of 
changes in on-hand quantity. You can click any listed document to view it. 
Item Statistics include an item summary, including cost and profit information and total quantities in/out. 

Item History   
(Pro) Item history can be viewed only at Headquarters. Headquarters can filter to view the history for any one store 
or for the entire company. 
To view an item's history, with the item record in Edit mode (displayed in a form), expand the History section. 
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The most recent documents are at the top of the list. 

• To view a listed document, double-click it.  You are taken to the appropriate history list with the document 
pre-selected. Normal copy, reverse, and edit capabilities are available for the document. When done, click Go 
Back at the bottom of the document to return to inventory. 

• The Change column lists the document’s effect on item on-hand quantities. For example, a sale results in 
the on-hand quantity being reduced, therefore the Qty Change is a negative number. Likewise, receiving a 
quantity into inventory is shown as a positive number. 

• The On-Handy column displays a running total of the on-hand quantity, after being adjusted by the 
document. 

• If the item is listed multiple times on a document (example: a customer exchange for the same item), the 
document is listed twice, once for the return (a positive quantity) and once for the new sale (negative quantity) 

Item Statistics 
Expand the Statistics section on the item record to view a graphical rating of the item's relative performance in 
your inventory as well as total sales, cost, profit, and  quantities in/out. This information reflects the time period 
specified for item ratings in preferences. 
Learn more about item ratings 

 
  
  
Related Topics 
Reverse a history document 

View Quantities on Order 
Inventory Overview | Purchasing Overview | Item History 
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Pro 
You can view item quantities currently on order for an item in the On Order column of your item list . You may have 
to add this column to the list. You can also initiate the creation of a new purchase order from inventory. 

To view on-order quantities: 

• Display your item list and sort, search or filter to find an item. 
The current quantity on order is displayed in the On Order column. 
  

 
  

(Pro) You can also view on-order quantities and a list of pending purchase orders from the Available Quantity 
window in inventory. 

To initiate a new PO from inventory: 
1. Display the item or items you wish to order. 

• Select Out of Stock Items or Items to Reorder from the drop-down filter at the top of the 
window, or 

• Search for items by keyword, or 

• Sort or scroll to find item(s) 
2. Select the items to be ordered from the displayed items. How do I select multiple items?   

 Tip: Select only those to be ordered from the same vendor at one time. One PO will be made with all selected 
items.   

2.  Select Order Items from the I Want To menu. 
A new purchase order is opened with the item(s) already listed. 

3. Complete and save the purchase order in the normal manner, adjusting the order quantity and 
cost, and adding other items, as necessary. 
4. Select Go Back to return to inventory. 
5. Repeat for other items if necessary. 

  

View Item Quantities at Other Stores 
Store Exchange Overview | Track Available Quantities 

Pro - Multiple Stores 
Each store can view item quantities at every other store, accurate as of the last completed store exchange cycle. 

To view available item quantities at other stores: 
1. From your item list, display the item record (select View Details). 
2. In the Basic Info section, click the Available button.  

The Available Quantities window is displayed. 
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This window allows you to view the on-hand, on-order, and available item quantities as well as a list of open orders 
for your store. 
Also displayed are item quantities at other stores, current as of the last completed Store Exchange. If you run out of 
an item, you can use this window to see if another store has the item in stock. If needed, you can request the other 
store to transfer the item to you or you can send the customer to the other store to purchase the item. 
Learn more about the Available Quantities window. 

Other places to view item quantities at other stores: 

• Purchase Order: In the Item Information window, accessed by selecting Edit Item for an item listed on a 
purchase order. 

• Item List: A column for each store's on-hand quantity can be added to your item list. 

• Report: Run the Inventory by Store report (From the Report Center, select Items > Multi-Store - Store 
Inventory. 

Note: Importance of Store Exchange Sequencing. Item quantities viewed at other stores are only as current as the last 
successful complete Store Exchange cycle. The closer you follow the recommended exchange sequence, the more meaningful 
these quantities will be. 

  
Related Topics 
Automatic quantity adjustment at remote stores 
Transfer merchandise between stores 
Multi-store overview 

Track Available Quantities 
Inventory Overview | Reorder Item Reminders 

Pro 
The term available quantity refers to the current on-hand quantity of an item minus the quantity of that item already 
committed to active customer orders. The available quantity is sometimes referred to as the available to promise 
quantity. Knowing the available quantity helps you make sales decisions and plan for additional purchases of the 
item. 
Available quantity calculations are used in Point of Sale to: 

• Alert you when you don't have sufficient available quantity of an item to complete a sales transaction. 

• Determine when items should be added to your reorder reminders list. If you prefer, you can set your 
company preferences to create reorder reminders based on the on-hand quantity instead. 
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Where can I see an item's available quantity? 

• In the Basic Info section of the New/Edit Item form, select Available to open the Available Quantities window. 
This window summarizes all item quantity information, including current on-hand, on-order, and committed to 
customer orders, as well as a listing of the documents affecting those quantities. 

 
• In the Avail Qty  column, available in your item list and on many Point of Sale documents and inventory 

reports. You may have to add the column to view it. 

 
• In the Item Information window, accessed by selecting Edit Item (<F5>) for an item listed on a document. 

Notes: 
• Quantities of an item on held documents or on customer orders assigned a status of Pending (such as those 

used to give estimates or quotes) are not reflected in the available quantity of the item. 

Inventory Adjustments Overview 
How do I?  | Memo Fields | Making an Adjustment Memo 

Access adjustment memos and history  
Create an adjustment memo 
Temporarily hold a memo 
Find a memo 
Reverse or correct a memo 
Copy a memo 
Print a memo 

  

Basic  

Adjustment memos are used to make changes to item quantities or costs. The changes tracked are those that 
would not otherwise be recorded on another transactional document. 
Typical uses for manually-created adjustment memos include: 

• Adjust quantity for theft and other shrinkage 

• Adjust quantity for donated items 

• Remove defective or damaged returned items from inventory 

• Correct cost or quantity errors in inventory 
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When you create an adjustment memo, the affected On-hand Quantity or Average Unit Cost fields are 
automatically updated in inventory and a permanent record of the change is added to your adjustment and item 
history. 
Some actions in Point of Sale, such as deleting an item with an on-hand quantity, conducting a physical inventory, 
or manually entering or editing an item’s average cost or on-hand quantity result in program-generated adjustment 
memos. 
Saved memos are permanently stored in your adjustment history lists. A separate list is maintained for each memo 
type, quantity and cost. Memos can be reversed to correct errors, but never deleted. 
(Pro w/multiple stores) Item quantities can be adjusted at either Headquarters or remote stores. Headquarters can 
adjust quantities for any store, while remote stores can adjust only their own local quantities. Only Headquarters 
can create cost memos, although both quantity and cost memos are generated automatically at remote stores for 
certain activities. 
  

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  
Related Topics 
Security rights for adjustments 
How adjustment memos are sent to QuickBooks 
Note: Automatic quantity adjustments at remote stores 

Physical Inventory Overview 
How do I?   | Basic Steps | Using a Physical Inventory Scanner 

Basic  

A physical inventory is the process of verifying or correcting the on-hand item quantities in your Point of Sale 
inventory by conducting a physical count. 
It is recommended that a physical inventory be done after initially entering your inventory when first starting to use 
Point of Sale and periodically thereafter. 
Conducting a physical inventory involves going through the store and recording the actual item quantities on hand. 
Counts can be recorded on a printed Store Count worksheet or scanned into the optional physical inventory 
scanner, and then transferred to Point of Sale. 
The entire store does not have to be counted at the same time. You may find it easier to conduct your physical 
inventory by department, aisle, or some other discreet physical sections, entering counts and saving for one section 
of your store at a time. A physical inventory can be saved as you go and then inventory updated when you are 
done. Point of Sale provides several ways for you to review changes before updating inventory and alerts you if a 
new transaction has affected an item between when a count was entered and inventory updated. 
You can review or reverse the last updated physical inventory. 
(Pro) A physical inventory is for one store only. When a remote store updates a physical inventory, quantity 
adjustment memos are automatically created and sent to Headquarters during the next Store Exchange. 
Headquarters can create and update a physical inventory for itself or for any store. 
  
Related Topics 
Security rights for Physical Inventory 
Update QuickBooks financial software after a physical inventory 

Tracking Price and Cost 

Currency Fields (Cost and Price) 
In-help popup 
  
Point of Sale supports the use of decimal amounts with up to five decimal places, but displays only two decimal 
places. You can enter even more than five decimal places, but Point of Sale will round to and store only five. 
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If you enter an amount less than $0.005 (one-half penny), Point of Sale displays $0.00, but is indeed storing the 
fractional cent amount you entered. You can also make an entry in the extended cost/price on a document and 
then enter the quantity. Point of Sale will calculate the unit cost/price with decimals for you. This feature makes it 
easier to order, price, and sell items whose cost or price is less than a penny or in fractional cents. 
In the case of item cost and price on documents, the extended cost/price is calculated using the stored five 
decimals. 

To enter data in the currency fields: 
1. Enter the amount, including decimals. 

• If entering an amount in whole currency units, such as 2.00, 47.00, or 103.00, it is not necessary 
to type the decimal place or trailing zeroes. You can simply type 2, 47, or 13 respectively. 

• To enter negative amounts, press the dash (–) key on your keyboard before entering the amount. 
Such as: –10.00 
2. Press <Tab> or navigate out of the field. 

  

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

Price/Cost Relationship 
Average Unit Cost | Order Cost | Enter Item Cost and Prices 

Basic  

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  
Margin (Margin % field) expresses the profit relationship between what you paid for an item (average unit cost) and 
its regular price. Markup (Markup % field) is an alternative way to express the difference between an item’s cost 
and it’s price. Markup is a simple percentage increase from the item cost. 
There is an inter-relationship between the margin/markup fields and the other price/cost fields as follows: 

• Enter either a margin or a markup percentage, and Point of Sale will calculate and display the other value 
for you. The two fields have identical behavior. 

• Define a margin or markup in a department record, and Point of Sale will calculate your regular price and 
the prices at your optional price levels for you as new items are added to inventory in this department (if the 
regular price is not manually entered). 

• If you or a receiving voucher update the average unit cost, the margin and markup percentages are 
recalculated. Prices are recalculated only if previously $ 0 (zero), although you can edit the price yourself 
from the receiving voucher. 

• Edit the margin or markup manually for an existing item in inventory, and Point of Sale will recalculate your 
regular price and the prices at your optional price levels. 

• Edit your regular price; the prices at other price levels are recalculated to maintain your specified 
markdown percentages. The margin and markup are also recalculated. 

• Edit the price or markdown percentage of any optional price level; the change to one price level has no 
affect on other prices. 

Related Topics 
Use department pricing formulas for new items 
Edit an Item 

About the Average Unit Cost 
About Order Cost | Enter/Edit Costs | Price/Cost Relationship 

Basic  
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Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  
The Avg Unit Cost field in inventory reflects the average cost you have paid for the current on-hand quantity of an 
item. 
  

 
  
Point of Sale recalculates the average unit cost each time you receive additional quantities of the item at a different 
cost by proportionally averaging the old cost and the new cost. Receiving vouchers update your Point of Sale 
inventory and, if applicable, your QuickBooks financial software inventory value with item cost changes. 
For example, if you have five shirts on hand with an average cost of $10 and you receive 10 more shirts costing 
$12 each, the new average unit cost is calculated as follows: 
  

(On Hand Qty × Current Cost) + (Rcvd Qty × Purchase Cost) 
On-Hand Qty + Rcvd Qty 

Or, using the example above: 

(5 × 10) + (10 × 12) 
5 + 10 

= 170 
15 

= New average unit cost of $11.33 

  
We recommend that you not manually enter or edit the average unit cost. Point of Sale uses this value to send cost 
of goods sold information on item sales to your QuickBooks financial software. If it does become necessary to edit 
this value manually, typically to correct an error, see Creating an Adjustment Memo. 
  
Related Topics 
Tracking decimal costs  

About the Order Cost 
About Average Cost | Enter/Edit Cost | Price/Cost Relationship 

Basic  

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  
Order cost (Order Cost field, located in the More Info section of the item record) is different than the average unit 
cost. An item's order cost is the cost you are currently paying your vendor for one unit of the item. 
Over time, with cost increases, it is normal for your order cost to move higher than your average unit cost, as you 
may have some quantity left in stock that was purchased at a lower cost when new shipments are received. 
When you make a purchase order, the order cost in inventory is suggested as the purchase order cost. You can 
edit this cost on the PO, if necessary. When you receive the ordered items, the voucher that references the PO will 
automatically take its cost from the PO (if not referencing a PO, the order cost from inventory is suggested as the 
voucher cost). 
When a voucher with a changed cost is saved it will automatically update the Order Cost field in inventory, so that 
the new order cost is suggested on the next PO or voucher made for the item. Point of Sale also calculates the new 
average unit cost for you in this situation. 
  
Related Topics 
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Track decimal costs  
Cost on POs 
Cost on receiving vouchers 

Enter Item Price and Cost 
Overview | Price and Cost Relationship | Price Manager 

Basic  

(Pro)  This option is available at Headquarters only. 

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  
The item Pricing window allows you to enter or edit an item’s cost and price information, including markdown price 
levels, an MSRP price, and margin/markup values on a single window. 
You can open this window while adding, editing, or viewing an item. 

To access the Pricing window: 
1. Select an item in your item list. 
2. Click Edit. This step is not necessary if you just want to view the pricing information. 
3. Click the Pricing button in the Basic Info section. The Pricing Window is opened as shown below. 
4. (Pro) If using the multiple units of measure feature, select the unit for which you want to view/edit 
this information from the drop-down menu (not shown). 

  

 

Explanation of Price/Cost Fields 
• Regular Price – Your everyday retail price of the item. If you wish to use a department pricing 
formula to calculate your price, leave this field blank when adding a new item. Learn more. 

• MSRP – Manufacturer’s Suggested Retail Price; a reference price that, if entered here, is printed 
on your price tags to demonstrate savings to your customers. Note: Some tag templates may not display 
the MSRP, due to size limitations. 

• Cost – The average unit cost for the item quantity currently on hand. Enter this cost ONLY if you 
have an on-hand quantity of the item when initially setting up Point of Sale. Otherwise, as you make 
receiving vouchers, Point of Sale automatically updates this field. Learn more. 

• Margin % – Gross margin or profit margin percentage. Auto-filled from department record (if 
defined) on new items and updated automatically as average unit cost changes. Manually editing the 
margin results in a recalculation of your price(s). 

• Markup % – Alternate way to express profit; markup by n% over average unit cost. Same 
behavior as margin. When either are edited, the other is recalculated automatically. 

Price Levels 
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Optionally, enter prices and markdown percentages for your markdown price levels for the item (your custom price 
level names displayed). If you use Point of Sale’s pricing formula to calculate your regular prices and have defined 
price level markdown percentages, Point of Sale automatically calculates the price at each price level for you on 
new items. 

• Enter/edit a price or markdown percentage for each price level if this item’s pricing is to be 
different from your default markdowns. 

• You can define or change your default price level names and markdown percentages in company 
preferences.  Note that changing your default markdown levels do not update existing item prices. You 
can use Price Manager to quickly change existing item prices if desired. 

• (Pro) You can set different prices at each level for each unit of measure of an item. 
Learn more about using price levels 
  

Pricing Notes: 
• If you prefer to manually define all of your own prices, rather than have Point of Sale calculate 
them for you on new items, do not define a margin or markup in your department records and enter 
the price(s) as you are adding items to inventory. 

Return to top 
  
Related Topics 
About the average unit cost 
About the order cost 
Change prices for a style 
Cost and price in a multi-store configuration 

Inventory Adjustments Overview 
How do I?  | Memo Fields | Making an Adjustment Memo 

Access adjustment memos and history  
Create an adjustment memo 
Temporarily hold a memo 
Find a memo 
Reverse or correct a memo 
Copy a memo 
Print a memo 

  

Basic  

Adjustment memos are used to make changes to item quantities or costs. The changes tracked are those that 
would not otherwise be recorded on another transactional document. 
Typical uses for manually-created adjustment memos include: 

• Adjust quantity for theft and other shrinkage 

• Adjust quantity for donated items 

• Remove defective or damaged returned items from inventory 

• Correct cost or quantity errors in inventory 
When you create an adjustment memo, the affected On-hand Quantity or Average Unit Cost fields are 
automatically updated in inventory and a permanent record of the change is added to your adjustment and item 
history. 
Some actions in Point of Sale, such as deleting an item with an on-hand quantity, conducting a physical inventory, 
or manually entering or editing an item’s average cost or on-hand quantity result in program-generated adjustment 
memos. 
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Saved memos are permanently stored in your adjustment history lists. A separate list is maintained for each memo 
type, quantity and cost. Memos can be reversed to correct errors, but never deleted. 
(Pro w/multiple stores) Item quantities can be adjusted at either Headquarters or remote stores. Headquarters can 
adjust quantities for any store, while remote stores can adjust only their own local quantities. Only Headquarters 
can create cost memos, although both quantity and cost memos are generated automatically at remote stores for 
certain activities. 
  

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  
Related Topics 
Security rights for adjustments 
How adjustment memos are sent to QuickBooks 
Note: Automatic quantity adjustments at remote stores 

Department Pricing Formula 
Enter/Edit Item Price and Cost | Use Price Levels 
  
You have the option of entering your new item prices manually or letting Point of Sale calculate them for you using 
a department pricing formula. When Point of Sale calculates new prices, it does so by applying the department 
margin (or markup) to the average item cost to arrive at the regular price. 
You specify the profit margin or markup to be used in your department records or on individual item records in 
inventory. If you enter one value, Point of Sale calculates the other. 
Point of Sale uses the following pricing formula: 

Regular Price  = Cost × 100 

100 – Margin 

Example 
With an average unit cost of $10 and a 40% margin. 
(10 x 100)/(100 – 40) = $16.67 regular price 

If you want Point of Sale to calculate new item price(s) with a department pricing formula: 

• Enter a margin or markup in your department records 

• Assign items to departments as you add them to inventory 

• DO NOT enter item prices when adding the new item to inventory, Point of Sale will calculate them for you 
The pricing formula is applied only to new items in inventory (previous price = $0). Receiving reorder merchandise 
at a new cost on a voucher does not automatically update item prices, however Point of Sale alerts you so you can 
adjust your price if desired. You can maintain your desired profit margin by manually editing the margin or markup 
on the item record back to the original level. 
Why aren't reorder item prices automatically updated when cost changes? 

If you DO NOT want Point of Sale to calculate new item price(s): 

• Do NOT define department or item margins or markups 

• Enter your item prices manually at anytime in inventory 

• Point of Sale will still calculate and display the margin and markup on the item record, but does not use 
them to calculate the item price(s) unless you manually edit them 

Markdown Price Levels 
Inventory Overview | Price Levels on Sales | Edit Item Prices 
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Point of Sale can maintain up to four price levels in addition to your regular price for each item in inventory (i.e., five 
separate prices). Price levels are markdowns from your regular price. 
Use price levels to offer different prices for different purposes or to different groups of customers. Common uses for 
price levels include: 

• To offer reduced prices to employees, family members, and VIP customers 

• For wholesale sales 

• For special sales, e.g., "10% Off Sale" (Price Manager offers more flexibility for this.) 
A typical price level setup and the prices at each level might look like this: 
  

 
  
Your price level markdowns are applied and the price at each level recalculated anytime your regular price is 
changed, either manually or when Point of Sale applies its pricing formula. On the other hand, editing the price or 
markdown percentage of any of your markdown price levels has no effect on any other price. 
  

How do I define price levels? 
You define price level names and default markdown percentages in company preferences . Enter a name and 
default markdown percentage for each level you wish to use, and specify the default price to suggest for all sales. 
Your default price can be your regular price or one of your markdown price levels. 
(Pro)  Each store can specify its own default sales price. 

• The price level markdowns you specify are defaults. They are applied to new items added to inventory, but 
the markdowns and price at any price level can be manually edited on an item-by-item basis. 

• You can define a price level price to be a markup from your regular price by entering a negative markdown 
value. 

• Changing your default price level markdowns does not update existing item prices. To update prices for a 
single item, edit the prices or markdown percentages directly in the Pricing window on the item record. If you 
want to update prices for many or all your items, we recommend using Price Manager. 

• You can also select Edit Price Levels in the Pricing window from an item record to change your price level 
names or default markdown percentages. Changes made here are the same as making these changes in 
company preferences. 

• (Pro) If you use multiple units of measure, you can set separate prices for each price level for each unit of 
measure. Select the unit of measure for which you want to view or change price levels from the drop-down list 
at the top of the Pricing window. (Not shown in example above) 

• (Pro) Using Print Designer, you can specify which price is printed on your price tags. 
Return to top 

Using Margin/Markup to Update Prices 
Department Pricing Formulas | Enter Cost and Price 
  
When an item is received at a new cost, the item prices in inventory are not automatically updated (unless the 
previous regular price = $0, as would be the case for a new item). Point of Sale will alert you that the cost has 
changed, but revising your prices to reflect the new cost is at your discretion. 
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Since the cost has changed, Point of Sale does recalculate and display new average unit costs and margin/markup 
values on the item record. You can use the margin/markup values to see at a glance your profit margin on the item 
and to quickly adjust the prices to maintain your desired margin. 
  
Example: 
You have five units on hand with an average unit cost of $5.00 and priced at $10 to deliver a profit margin of 50%. 
You reorder and receive five additional units on a receiving voucher, costing $6.00 each. Point of Sale alerts you 
that the cost has changed, but does not automatically update the item price. The new average unit cost ($5.50) and 
margin/markup are calculated and displayed as shown below. 
You have the option to update your price(s) or not. One way to quickly update the price and maintain your profit 
level is to edit the margin or markup back to their original values on the item record. In the example below, editing 
the margin back to 50% results in a new regular price of $11.00. 
  

  Old New After margin edit 

Quantity 5 10 10 

Unit Cost 5.00 5.50 5.50 

Regular Price 10.00 10.00 11.00 

Margin % 50 45 50 

Markup % 100 82 100 
  
Don’t forget to print new price tags! 
  
My markup value sometimes changes right after I enter it. Why?   
  
If you use markdown price levels, the price at each level is also recalculated automatically anytime your regular 
price is changed. 
  
Related Topics 
Update prices when receiving items 

Update Item Prices from a Receiving Voucher 
Receiving Overview | Print Price Tags 

Basic  

It's inevitable. Your vendor raises their price for an item and you need to decide whether to pass on the increase to 
your customers. 
Point of Sale alerts you when a reorder item cost on a voucher is different than the current inventory cost, but does 
not automatically update the price. Whether you change your price and by how much is at your discretion. 
You can change the price and print new tags from the voucher, if you wish. 

To update the price and print new tags from the receiving voucher: 
1. When you go to print/save the voucher, you are alerted that you are receiving an item or items at 
a new cost. Answer Yes, that you want to review  the prices before saving the voucher. 
2. Select the item with the new cost in the voucher item list and then click Edit. 

The Item Information window opens, as shown here, displaying price and margin information (other information 
removed from illustration for clarity). 
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The item price shown is your current Regular Price from inventory. The margin and markup numbers show 
what your profit margin would be at this price relative to the cost on the voucher (not relative to your average 
unit cost; see note below). 

3. Adjust the item price by entering a new price or by adjusting the margin or markup and then 
select OK. 
4. To print new price tags from the voucher, with the item highlighted select Print Tags from the I 
Want To menu. 
5. Repeat for other items, if applicable. 
6. Print/save the voucher. 

  

Notes: 
• The new regular sales price (and markdown price levels if you use them) are updated in inventory when 
you save the voucher. 

• Use the margin and markup shown on the voucher as a guideline in setting price. When saving the 
voucher, these values will be recalculated in inventory relative to the new average unit cost. 

• If items received on a voucher are brand new (i.e., do not yet have a regular price defined in inventory, but 
do have a margin or markup defined) Point of Sale will automatically calculate the regular price by applying 
the specified margin or markup to the voucher cost upon saving. If you use markdown price levels, those 
prices are also calculated based on the markdown percentages specified on the item record (and defined in 
company preferences). 

Related Topics 
Use Markdown Price Levels 
Price Change Reminders 
Price/Cost Relationship 

Price Manager Overview 
How Do I?  

Access Price Manager  

Start a new price change 
Mark down prices for a temporary sale 

Print markdown price tags 

Restore my previous prices 

Delete a Price Manager record 

Customize my Price Manager lists 

Additional Pro features: 

Set up a new discount price 
Inactivate or edit a discount 
Print discount price tags 
Apply discount pricing to sales 
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Price Manager allows you to create and manage promotional price changes and discounts. Using the employee 
security and reporting features of Point of Sale, you can easily control and track the effectiveness of your 
promotional pricing. 

Pro users can also set up coupons  and have additional discount options as explained below and in related topics.   

  
When you first access Price Manager, a list of your recent price changes is displayed in the right panel and choices 
for setting up price discounts are displayed in the left panel. 
View example screen  

Price Manager screen, Pro level shown (Basic users have fewer options) 

 
  
  
  
  
  

  
  
Here's how the two components of Price Manager differ: 

Change Item Prices 
A price change is typically a permanent change to your item prices, though the changes can be reverted if 
necessary. In a price change, you can calculate new prices for your items in a variety of ways. The resulting prices 
can be reviewed, edited, and temporarily saved until you are ready to implement them, at which point you "apply" 
them to inventory. 
Price change records are maintained in your Change Item Prices list. Price changes can be restored, returning the 
item prices to the level they were at before the change was applied.  A prior price change can also be copied (and 
then edited) to quickly set up a new similar price change. 
From Price Manager, you can print markdown tags with both old and new prices to communicate the savings to 
your customers. 

To work with Price Changes: 
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• Select Make Price Changes to start a new price adjustment, or 

• Double-click the name of a recent price change record in the displayed list to open it, or 

• Select View All to go to your full list of saved price changes 
Learn more about changing item prices 
Starting a price change 
  

Discount Pricing 
(Free and Basic) You can use Price Manager's discount pricing options to set up and manage manually applied, 
line item discounts. 
(Pro) You can use Price Manager's discount pricing options to set up and manage automatic and coupon 
discounts, in addition to manually applied discounts. Discount prices  may be temporary, scheduled discounts that 
are in effect for a specified period of time.  Each discount price you set up is maintained as a record in your 
Discount Pricing list. These records can be reviewed, printed, or copied and you can print discount price tags for 
your items to demonstrate potential savings to your customers. 

To work with price discounts: 

• Select a Set Up button to start a new price discount (choices vary with level) 

• double-click a current discount to edit it 

• Select View all Discounts to go to your full list of saved discounts. 
Learn more about Discount Pricing 
  

Notes: 
• Only one workstation can be in each area of Price Manager at any time. 

• (Pro) Only Headquarters can use Price Manager to change item prices or set up discounts. However, the 
price change and discount records are sent to remote stores, where they can be viewed and used to print 
markdown and/or discount price tags for the merchandise in their store. 

Price Change Reminders 
Reminders Overview | Inventory Overview | Using Price Levels 

Pro 
The Price Change reminders screen displays both the old price and new price when item prices change. Your 
regular price and the prices at your other price levels are also displayed for reference. This list reminds you to print 
updated price tags, so that your records and the tagged merchandise on the shelf match. 
Once tags are printed, the items on the list should be removed so the list remains current and useful. 
(Multi-store) Reminders are a handy way to communicate price changes to remote stores. 

To select items and print: 
1. From the Inventory menu, select Reminders and then click the Price Changes tab. 
2. Use standard list selection procedures to select items or choose Select All from the I Want To menu. 
3. Select Print Tags to print price tags for the selected items (or Print List). 
4. When prompted to remove the selected items from the list, select Yes to remove them or No to retain 

them. 
You can also remove selected items from the list at anytime by selecting Remove Selected Item (s) from the I 
Want To menu. 
  

Notes: 
• If you change your default price in preferences, the Price Change reminders are cleared. 

• Double-click an item in the list to go to inventory to view the full record. 



Printed Documentation 

152 

Related Topics 
Security rights for reminders 
Reminders Message Alert 

Spread Discounts, Fees, and Freight Across Item Costs 
Receive Purchase Order Items | Enter Voucher Discounts, Feels, and Freight 

Basic  

Discounts, fees, and freight entered on a receiving voucher can be spread across the costs of the items being 
received. Spreading these amounts helps you track a truer average cost for your items. 

To spread these amounts on a voucher: 
1. List all items being received on the voucher, either manually or by referencing the purchase order 
on which they were ordered. 
2. From the I Want To menu, select Enter Discount/Fee/Freight and enter amounts as applicable. 

 
3. Select the Spread Discount, Freight, and Fee checkbox. 

Note that the amounts previously entered are zeroed out as these amounts are now spread across the 
individual item costs on the voucher. The total remains the same. 

 
4. Click Close. 
5. Complete and print/save the voucher. 

  

Notes: 
• When spread, the sum of discounts, freight, and fees is distributed across all items on the voucher 
proportionally based on each item’s extended cost. Due to rounding, this amount may result in fractional 
cents applied to the voucher cost. 

• The discount, freight, and fee fields at the bottom of the voucher form are no longer editable after 
spreading, since these amounts are now reflected in the individual item extended costs and in the voucher 
subtotal. 
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• Clearing the spread checkbox before saving the voucher will restore the costs to their prior state and make 
the discount, freight, and fee fields editable again. 

• Once the voucher is saved, these amounts cannot be unspread or changed. Likewise, if the voucher is 
saved without spreading, it cannot be edited later to spread (though in this case the fields themselves are 
editable, since the amounts may not have been known at the time the voucher was created and saved). 

• When spreading, it is the item average unit cost that is affected in inventory. Item order cost is not 
adjusted. How does order cost differ from average unit cost? 

Getting Started: Notes on Item Quantities and Cost 
Available Quantities | Decimal Quantities | Decimal Costs  

Basic  

The Average Unit Cost field in inventory reflects the average cost of the currently on-hand quantity of an item. 
This value is automatically recalculated by Point of Sale when you create a voucher to receive an item at a cost 
different than what is currently recorded. How does order cost differ from average unit cost? 
The On-Hand Quantity field reflects the number of units of an item currently in stock. This value is automatically 
updated as you create vouchers, receipts, and, if applicable, transfer slips. 
Item quantities and costs have significant impact on your inventory value and your financial records. For this 
reason, it is recommended that you manually enter or edit these values only when entering items already in your 
store when you begin using Point of Sale. From that point on, Point of Sale maintains an accurate ledger of 
changes in these values with the use of transactional documents (receiving vouchers, receipts, transfer slips, and 
adjustment memos) and the Physical Inventory utility. The table below summarizes how quantities and/or costs are 
updated in various ways. 
  

Method Comments 

Receiving 
vouchers 

Updates on-hand quantity, average unit cost, 
and order cost in inventory. Should be used for 
receiving all new and reordered items into 
inventory. When you define a new item in 
inventory that is to be received later, we 
recommend you leave the On-Hand Quantity 
and Average Unit Cost fields blank in 
inventory and allow the receiving voucher to 
update them. 

Receipts When an item is sold or returned on a receipt, 
the on-hand inventory quantity is adjusted up 
or down accordingly. 

Adjustment 
memos 

A memo is used anytime quantity or cost must 
be manually adjusted (because it is not 
handled by a receiving voucher, receipt, or 
physical inventory count). Many actions, such 
as conducting a physical inventory, or 
manually editing the cost or quantity fields, 
automatically create adjustment memos for 
you. 

Physical 
Inventory 

Updates on-hand quantities only. Updating a 
physical inventory automatically creates 
adjustment memos to update inventory. 

Transfer slips 
 (Pro) 

A transfer slip has no affect on company 
inventory quantities, though it does increase or 
decrease the on-hand quantities at the specific 
stores involved in the transfer. 

Return to top 
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Item Costs/Prices in a Multi-Store Configuration 
Enter/Edit Item Price and Cost | Use Price Levels 

Pro - Multiple Stores 

Note: The ability to see cost fields can be controlled by security rights. If you do not have the right to view item costs, the fields 
will be masked like this "*****". This right affects cost fields in inventory and on all documents and reports. 

  
Item costs are averaged as receiving vouchers are saved/received at Headquarters. 
Headquarters defines all price levels, item prices, and item order costs. Remote stores cannot directly enter or edit 
costs or prices in inventory, therefore cost adjustment memos and Price Manager are only available at 
Headquarters. 
Remote stores have the capability to select their own default price level and to discount prices at point of sale. 
Price changes implemented at Headquarters are conveyed to remote stores, using the price change inventory 
reminders. Remote stores can display the price changes made at Headquarters and print updated price tags or 
shelf stickers accordingly. 
  
Related Topics 
Give sales discounts 
Multi-store overview 
Inventory overview 

Price Manager 

Price Manager Overview 
How Do I?  

Access Price Manager  

Start a new price change 
Mark down prices for a temporary sale 

Print markdown price tags 

Restore my previous prices 

Delete a Price Manager record 

Customize my Price Manager lists 

Additional Pro features: 

Set up a new discount price 
Inactivate or edit a discount 
Print discount price tags 
Apply discount pricing to sales 

  
  
Price Manager allows you to create and manage promotional price changes and discounts. Using the employee 
security and reporting features of Point of Sale, you can easily control and track the effectiveness of your 
promotional pricing. 

Pro users can also set up coupons  and have additional discount options as explained below and in related topics.   

  
When you first access Price Manager, a list of your recent price changes is displayed in the right panel and choices 
for setting up price discounts are displayed in the left panel. 
View example screen  

Price Manager screen, Pro level shown (Basic users have fewer options) 
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Here's how the two components of Price Manager differ: 

Change Item Prices 
A price change is typically a permanent change to your item prices, though the changes can be reverted if 
necessary. In a price change, you can calculate new prices for your items in a variety of ways. The resulting prices 
can be reviewed, edited, and temporarily saved until you are ready to implement them, at which point you "apply" 
them to inventory. 
Price change records are maintained in your Change Item Prices list. Price changes can be restored, returning the 
item prices to the level they were at before the change was applied.  A prior price change can also be copied (and 
then edited) to quickly set up a new similar price change. 
From Price Manager, you can print markdown tags with both old and new prices to communicate the savings to 
your customers. 

To work with Price Changes: 

• Select Make Price Changes to start a new price adjustment, or 

• Double-click the name of a recent price change record in the displayed list to open it, or 

• Select View All to go to your full list of saved price changes 
Learn more about changing item prices 
Starting a price change 
  

Discount Pricing 
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(Free and Basic) You can use Price Manager's discount pricing options to set up and manage manually applied, 
line item discounts. 
(Pro) You can use Price Manager's discount pricing options to set up and manage automatic and coupon 
discounts, in addition to manually applied discounts. Discount prices  may be temporary, scheduled discounts that 
are in effect for a specified period of time.  Each discount price you set up is maintained as a record in your 
Discount Pricing list. These records can be reviewed, printed, or copied and you can print discount price tags for 
your items to demonstrate potential savings to your customers. 

To work with price discounts: 

• Select a Set Up button to start a new price discount (choices vary with level) 

• double-click a current discount to edit it 

• Select View all Discounts to go to your full list of saved discounts. 
Learn more about Discount Pricing 
  

Notes: 
• Only one workstation can be in each area of Price Manager at any time. 

• (Pro) Only Headquarters can use Price Manager to change item prices or set up discounts. However, the 
price change and discount records are sent to remote stores, where they can be viewed and used to print 
markdown and/or discount price tags for the merchandise in their store. 

Change Item Prices: Overview 
How Do I?  | Price Manager Overview 

Start a new price change  
Mark down prices for a temporary sale 

Print markdown price tags 

Restore my previous prices 

  
  
Using Price Manager, you can calculate new prices for all or selected items in a variety of ways, from either the 
current price or the average unit cost. 
A "price change" can be calculated and temporarily saved, applied to inventory when appropriate, and the previous 
prices restored later if necessary. From Price Manager, you can print markdown tags with both old and new prices, 
or inventory tags with just the new prices. 
(Pro) Only Headquarters can change item prices. The price change records are sent to remote stores, where they 
can be viewed and used to print markdown price tags for the merchandise in their store. 
When you access Price Manager, a list of your recent price changes is displayed: 

• To open a recent price change record, double-click its name in the list, or 

• Select View All to go to your full price change list, or 

• Select Make Price Changes to start a new price change record. 

About the Change Item Prices List 
This list includes all price changes you have made. There are three possible status conditions for price changes: 

Pending: New prices have been calculated but not applied to inventory. You can still review, edit, or clear the 
new prices. 
Applied: New prices have been applied to inventory and are in effect for sales. 
Restored: Your previous prices have been restored. 

To view or work with a price change record, select it in the list and then select View or Edit Price Change. Your 
options for the displayed record are outlined in the yellow help area on the record. See Working with Lists for 
general information on navigating and customizing the list. 
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What's important about making price changes? 
• A "price change" refers to one Price Manager operation. It can include any number of your items. Each 
price change is stored as a single record in your Change Item Prices list. 

•  Changing item prices at one price level has no affect on the prices at your other price levels. 

• A price change is applied to only one of your price levels. You can calculate new prices from one price 
level but then apply them to a different price level if desired. This feature allows you to quickly calculate prices 
for one level relative to another or to copy prices from one price level to another. 

• You can calculate item prices in different ways for different groups of items in a single price change. For 
example, you could reduce all items in your Shoe department by 10%, in your Clothing Departments by 20%, 
and in your Accessories department by 30% and apply all to inventory at one time. 

• You always have an opportunity to review price changes before applying them to inventory. 

• A price change can be temporarily saved without the new prices being applied to inventory. This allows 
you to prepare a price change ahead of time and then apply it when ready. 

• A price change can be copied. This is a quick way to make subsequent price changes on the same group 
of items. Once copied, you can edit the new price change as necessary. 

• (Pro) If you use multiple units of measure for an item, the Unit of Measure field is added to the Price Manager 
item list. This field reflects your default sell-by unit of measure , and price changes apply to this unit only. If 
no default sell-by unit is defined, the base unit of measure  is displayed and affected. 

Changing Prices for a Temporary Sale 
Price Manager Overview 
  

Pro Note: Pro users may want to use Price Manager's automatic discounting option for this purpose. 

  
The restore feature in Price Manager makes it easy to temporarily markdown prices for a sale and then return them 
to the previous level when the sale is over. 
For example, you might mark down your regular prices by 15% for a weekend sale and then restore them before 
opening for business Monday morning. 
This is the basic procedure for a temporary price reduction. Use the links in each step for detailed instructions. 

To mark down prices for a temporary sale: 
1. Start a new price change and enter the price calculation criteria. 

If marking down different groups of items by different amounts, select the first group of items in the Price 
Change wizard and enter pricing just for that group. After completing the wizard and with the price change item 
list displayed, use the Select Items button to specify the second group of items and then Calculate Prices to 
enter pricing criteria for them, and so on until all of your new prices are calculated. 

2. From the View menu, select Items with New Price. 
This choice displays all items for which a new price has been entered, allowing you a final review before 
updating inventory with the prices. 

3. If desired, print markdown price tags. 
4. Select Apply Changes to Inventory. 
5. When the sale is over, restore the prices to their previous level. 

  

Notes: 
• It is recommended you not make other manual price changes to the same items while the sale is going on. 
When you restore prices at the end of the sale, all old prices will be restored, overwriting any manual changes 
you made in the interim. 

Price Change: Rounding the New Prices 
Price Change Overview 
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This information is applicable to the Price Change wizard, accessed from Price Manager. 

  
On this wizard page you have the option of rounding your new prices to any ending value that you prefer. 

Your rounding choices are: 

• Don't round 

• Round new prices to the nearest dollar. (Examples: $1.00, $2.00, $9.00, $75.00) 

• Round new prices to the nearest ten cents (Examples: $0.10, $0.20, $1.90, $25.70) 

• End new prices with 99 cents (Examples: $0.99, $1.99, $2.99, $59.99) 

• End new prices with 9 cents (Examples: $0.09, $0.19, $6.49, $99.79) 

• End new prices with custom values that you define. Click Define Values after selecting this 
option. You can enter up to four ending values for your prices. You can view how rounding works with this 
option by entering trial prices in the test field provided. 

Notes: 
• To round all prices at one of your price levels at one time, use the procedure for copying one price level to 
another with the following differences. 

• Select the same price level to calculate prices from and to apply new prices to. 

• Calculate from Price and select As Is for the price adjusting method. 

• Enter your rounding instructions on this page. 

Restoring Previous Prices 
Price Change Overview | Printing Tags 
  
Use this procedure to restore item prices to the levels that existed prior to the original price change. The previous 
prices are restored for all included items. 
Important: Any other price changes made to the same items in the interim are overwritten when restoring a price 
change. 

To restore to your previous prices: 
1. Display the Price Change record you want to restore. 
2. Select Restore Prices. 

A confirmation dialog is displayed. 
3. Select Restore Prices to confirm. 

  

Notes: 
• You can print inventory tags from Price Manager reflecting the restored (old) prices when done. But be 
aware the restored price change record will always display the prices current as of the date of restoration. If 
you return to it at a later date and print tags, the tags will print at the current item price, not necessarily that 
shown on the restored record. 

Discount Pricing: Overview 
How Do I?  | Price Manager Overview | Discount Reports 

Set up an automatic discount 

Set up a coupon 

Deactivate or edit a discount 

Print discount price tags 
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Apply discount pricing to sales 

Customize my discount pricing list 

  
  
(Basic) Price Manager’s discount pricing section allows you to define manual item discount names, which are then 
available to select from when giving a manual discount on sales. Discount reports can be filtered by the discount 
names. 
(Pro) Price Manager’s discount pricing options lets you define discount pricing for your items in any of three 
discount types: Manual, Automatic, Coupons.  A virtually unlimited number of discounts can be defined and saved 
in Point of Sale. 
(Pro) Only Headquarters can add, edit, schedule, or inactivate a discount. The discount records are sent to remote 
stores, where they can be viewed and used to print discount price tags for the merchandise in their store. 
After accessing Price Manager, do one of the following to work with discount prices: 

• (Basic) Click  Set Up Manual Discount 

• (Pro) Click the button corresponding to the discount type you wish to set up 
OR 

• Select View all Discounts to go to your full list of saved discounts and then double-click an existing 
 discount name to edit it 

The combination of customer and items may result in more than one discount applying to a sale. When this 
happens, Point of Sale will compare the discounts and apply them according to these rules. 
  

Manual Discounts 
As the name suggests, these discounts are manually applied to specific items at the time a sale is made. Examples 
include: 

• Discount for a damaged, defective, demo, or discontinued item 

• Discount to meet or beat a competitor's price 

• Discount given for any other reason you might have 
You name your manual discount reasons in Price Manager, but manually apply and enter a discount amount or 
percentage when the sale is rung up. Several default manual discount names are provided; you can add to or 
change them to meet your needs. 
By specifying the discount reason on the receipt (a drop-down list lets the cashier choose from your predefined 
choices) you can track the discounts with Point of Sale reports. 
Optional preference: Require manual discount reason on receipts 
Applying a manual discount 
  

Automatic Discounts (Pro) 
Define an automatic discount and Point of Sale will automatically apply it to qualifying sales during the period the 
discount is active. You can specify start and stop dates and times or manually activate/deactivate the discount as 
needed. 

Notes  

• You can include any combination of items, except group items, in an automatic discount 

• An item can be included in more than one automatic discount, subject to some restrictions. Read the 
discount tips and rules for more information. 

• The combination of customer and items may result in more than one discount applying to a sale. When 
this happens, Point of Sale will compare the discounts and apply them according to these rules. 

• If you use multiple units of measure, a quantity discount can be set up for any one of the defined units. 
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Four automatic discount types are supported:  (T-shirts used as an example): 

% Off Offer a percentage off on any purchase of T-shirts. 
There is no purchase quantity requirement. 
Example  

You sell a variety of T-shirts for $15 each. 
You set up a discount of 10% off the T-shirts. 
Your customers can buy any quantity of the T-
shirts and get 10% off the T-shirt price, or $13.50 
each. 

  
  

$ Off Offer a percentage off on any purchase of T-shirts. 
There is no purchase quantity requirement. 
Example  

You sell a variety of T-shirts for $15 each. 
You set up a discount of $2.00 off the T-shirts. 
Your customers can buy any quantity of the T-
shirts and will automatically be charged $13.00 
each. 

  
  

Buy X for $Y Buy a specified quantity (X) of T-shirts for a specified 
amount (Y). 
Option:  Apply the discount to additional quantities 
(other than multiples of the specified quantity, which 
automatically qualify for the discount price). 
Example  

Normally, you sell a variety of T-shirts for $15 
each. 
You set up a "Buy 3 for $35" discount on the T-
shirts. 
If three of the T-shirts are added to a sales 
receipt, Point of Sale discounts the shirts to 
$11.67 each. 
If you selected the option to discount additional 
quantities, a customer would get the $11.67 
price on the 4th or 5th T-shirt purchased as well. 
If you didn't select this option, these shirts would 
revert to $15 each. 
Note: If six (or any multiple of three) T-shirts are 
purchased, the customer would automatically 
receive the discount on all of them even if the 
additional quantities option wasn't selected. 

  
  

Buy X and get 
Y% Off 

Buy a specified quantity (X) of the T-shirts and get a 
percentage (Y) off. 
Option:  Apply the discount to additional quantities 
(other than multiples of the specified quantity, which 
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automatically qualify for the discount price). 
Example  

You normally sell a variety of T-shirts for $15 
each. 
You set up a "Buy Three and Get 15% Off" 
discount 
If three of the T-shirts are added to a sales 
receipt, Point of Sale discounts the shirts to 
$12.75 each. 
If you selected the option to discount additional 
quantities, a customer would get the $12.75 
price on the 4th or 5th T-shirt purchased as well. 
If you didn't select this option, these shirts would 
revert to $15 each. 
Note: If six (or any multiple of three) T-shirts are 
purchased, the customer would automatically 
receive the discount on all of them even if the 
additional quantities option wasn't selected. 

  

• An item can be included in more than one automatic discount, subject to some restrictions. Read the 
discount tips and rules for more information. 

Setting up an automatic discount 
Tips and Rules 
  

Coupons (Pro) 
Create store coupons with bar codes that can then be scanned or entered at point of sale to give item discounts. 
Coupons can be printed on your customer's sales receipts (optionally based on their purchase level ), include 
expiration dates, and include either a percentage or dollars-odd discount. 
You can also copy the coupon barcode from Point of Sale to your Windows clipboard and then use it to create and 
distribute your own coupons via e-mail or another application. 
Learn more about using store coupons 
Setting up a coupon 
Optional preference: Print Coupon with Sales Receipts 
  

Discount Pricing: Set Up or Edit an Automatic Discount 
How Do I?  | Discount Pricing Overview 

Inactivate or edit a discount 

Print discount price tags 

Apply discount pricing to sales 

Access Price Manager  

Customize my discount pricing list 

  

Pro 
Use this procedure to define and save an automatic pricing discount. A virtually unlimited number of discounts can 
be defined and saved. 

If you wish to edit an existing discount, start with Step 6 below or click here. 
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Tip: If the discount you want to create is similar to an existing one, the quickest way to start is to copy the existing one. Go to your 
discount list and select the existing discount, then select Copy. Edit as necessary and save the new discount. 

To set up a new discount: 
1. Access Price Manager and then select Set Up a New Discount from the overview page. The 
New Discount wizard is opened. 

OR 
From your Discount Pricing list, select New Discount and then on the first page of the New Discount wizard, 
select Automatic Discount. 
Use the Next and Previous buttons to navigate through the wizard pages. 

2. Discount Rules page: Enter or edit the following. View Sample  

 
  

3.   

• Discount type: Select  % Off, $ Off, Buy X for $Y, or Buy X and Get Y% Off and enter the 
requested information to define the discount: 

• Read a description and examples of each discount type here. 

• On the quantity discount options, select or clear the checkbox to discount additional 
quantities. 

• Start/end dates: Optionally, select the checkbox and enter the starting and ending date/time for 
the discount to be applied. Prices will revert to the pre-discount level when the end date/time is reached. 
3. Price Level page: Specify the price level or price levels to which the discount applies. View 
Sample  
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4.   
The discount will not apply to sales made at price levels other than what is selected here. 
Your Regular Price is pre-selected by default. Make changes by selecting or clearing the checkbox for each of 
your price levels. At least one price level must be selected. 

4. Choose Items page: Tell Point of Sale which items qualify for the discount.  View Sample  

 
  

5.   
You can choose all items*, items from a specific department or vendor, items with a particular name, or select 
Custom to enter filter criteria to select other groups of items. 

5. Review Items page:  If you selected Custom on the previous page or if you are editing a saved 
discount, a list of the included items is displayed for your review.  View Sample  
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6.   
If this is a new discount, click Apply Filter to enter criteria for selecting items. Click Help on the Filtered View 
window for additional instructions. 
By default, all items listed are included in the discount. If necessary, clear item checkboxes to remove items. 

6. Name and Notes page: A unique name is required for each discount. Use a descriptive name so 
you can easily find it later in your Discount Pricing list. Notes can help you recall details of the promotion. 

About discount names  
7. Select Finish. The wizard is closed and your Discount Pricing list is displayed. 

• Discount Price Tags: Highlight the discount in the list and select Print > Price Discount Tags to 
print discount tags if desired. 

• Editing the discount: You can revise the discount type, items, schedule, or make the discount 
inactive at anytime  Learn more about editing a discount. 

  

Notes: 
• * "All Items" means all items in inventory at the time the discount is defined. New items you add to 
inventory after this are not automatically added to the list of eligible items for the discount. To make newly 
added items eligible, edit the discount record and choose "All Items" again. 

• If you attempt to add an item that is included in another active discount, you will be blocked or warned. 
Read the rules about adding the same item to more than one discount. 

• (Multi-Store) The discount record is sent to remote stores on your next Store Exchange. The remote stores 
can open and view the record and print discount price tags for the merchandise in their store. 

Related Topics 
Applying discounts to sales 
Tips and rules for discounts 

Discount Pricing: Set Up or Edit a Coupon 
How Do I?  | Using Store Coupons: Overview 

Print coupons on sales receipt (preference) 
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Redeem coupons on sales 

Access Price Manager  

Customize my discount pricing list 

  

Pro 

To add or edit a store coupon: 
Tip: Create new coupon by copying an existing one  

If the coupon you want to create is similar to an existing one, the quickest way to add it is to copy the existing 
one. Go to your discount list and select the existing coupon, then select Copy. Edit as necessary and save. 
  

  
1. Access Price Manager and then: 

• To add a coupon:  Select Set Up Coupon from the overview page (or New Discount from your 
Discount Pricing list). 

• To edit a coupon:  Display your Discount Pricing list, select the coupon and then select Edit from 
the window toolbar. 

The Discount wizard is opened. Use the Next and Previous buttons to navigate through the wizard pages. 
2. Coupon Rules page: Enter or edit the following. View Sample  

 
  

3.   

• Discount: Specify either % Off (percentage) or $ Off (dollars) off and enter the percentage or 
dollar discount to be applied. 

• Barcode: Accept the program-generated barcode or scan/enter one of your own in this field. 
Tip: Use coupon barcodes in other applications  

You can quickly copy your coupon barcode to the Windows clipboard using the button provided. You can then 
paste it into another application or in an e-mail to send to your customers. 
Note: The ability to scan a copied/pasted bar code will vary with the application and printer used. Test your 
application, printer, and scanner to be sure coupons work before printing and distributing a large quantity. We 
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also recommend you always include the actual numbers below the bar code so that you can manually enter it 
on a sales receipt if necessary. 
  

  
Tip: Honor manufacturer or competitor coupons  

You can honor (or even beat) a manufacturer's or competitor's using the Point of Sale coupon feature. Scan the 
barcode on the coupon into the Barcode field in the Set Up Discount wizard, and enter the discount, expiration, 
and item information. Now, when a customer brings that same coupon in, you can scan it on a sales receipt it 
will apply the discount you defined to the applicable items! 
Note: Point of Sale does not include the ability to track sales using manufacturer's coupons for the purpose of 
redemption with the manufacturer.  All discounts given by coupon are reported in one single category and, if 
applicable, are sent to QuickBooks financial software as a single discount category. 
  

  

• Expiration Date: Optionally, select the checkbox and enter the last date on which the coupon will 
be accepted. After this date, cashier will receive a "coupon expired" message if attempting to use it. 
3. Price Level page: Specify the price level or price levels to which the coupon will apply. View 
Sample  

 
  

4.   
The coupon will not apply to sales made at price levels other than what is selected here. 
Your Regular Price is pre-selected by default. Make changes by selecting or clearing the checkbox for each of 
your price levels. At least one price level must be selected. 

4. Choose Items page: Tell Point of Sale what items qualify for the coupon discount.  View Sample 
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5.   
You can choose all items, items from a specific department or vendor, items with a particular name, or select 
Custom to enter filter criteria to select other groups of items. 

5. Review Items page:  If you selected Custom on the previous page or if you are editing a 
previous coupon, a list of the included items is displayed for your review.  View Sample  

 
  

6.   
If this is a new coupon, click Apply Filter to enter filtering criteria to populate the item list. Click Help on the 
Filtered View window for additional instructions. 
By default, all items listed are included in the discount. If necessary, clear item checkboxes to remove items. 

6. Name and Notes page: A unique name is required for each active coupon. Use a descriptive 
name so you can easily find it later in your Discount Pricing list. Notes are printed on the coupon and can 
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be used to summarize what items are eligible, restrictions that apply, a thank you, or whatever other 
information you may wish to include. 

View Sample  

 
  

  
About discount names  

7. Select Finish. The wizard is closed. 
8. (Optional) In company preferences, set options for printing the coupon on sales receipts. 

  

Notes: 
• If you attempt to add an item that is included in another active discount, you will be blocked or warned. 
Read the rules about adding the same item to more than one discount. 

• "All Items" means all items in inventory when the coupon is defined. New items you add to inventory after 
this are not automatically added to the list of eligible items for the coupon. If you want newly added inventory 
items to be eligible, return to the wizard and edit the item page to choose "All Items" again. 

• (Multi-Store) The coupon record is sent to remote stores on your next Store Exchange. The remote stores 
can immediately begin printing and redeeming the coupons. 

Related Topics 
Applying discounts to sales 

Discount Pricing: Overview 
How Do I?  | Price Manager Overview | Discount Reports 

Set up an automatic discount 

Set up a coupon 

Deactivate or edit a discount 

Print discount price tags 

Apply discount pricing to sales 

Customize my discount pricing list 
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(Basic) Price Manager’s discount pricing section allows you to define manual item discount names, which are then 
available to select from when giving a manual discount on sales. Discount reports can be filtered by the discount 
names. 
(Pro) Price Manager’s discount pricing options lets you define discount pricing for your items in any of three 
discount types: Manual, Automatic, Coupons.  A virtually unlimited number of discounts can be defined and saved 
in Point of Sale. 
(Pro) Only Headquarters can add, edit, schedule, or inactivate a discount. The discount records are sent to remote 
stores, where they can be viewed and used to print discount price tags for the merchandise in their store. 
After accessing Price Manager, do one of the following to work with discount prices: 

• (Basic) Click  Set Up Manual Discount 

• (Pro) Click the button corresponding to the discount type you wish to set up 
OR 

• Select View all Discounts to go to your full list of saved discounts and then double-click an existing 
 discount name to edit it 

The combination of customer and items may result in more than one discount applying to a sale. When this 
happens, Point of Sale will compare the discounts and apply them according to these rules. 
  

Manual Discounts 
As the name suggests, these discounts are manually applied to specific items at the time a sale is made. Examples 
include: 

• Discount for a damaged, defective, demo, or discontinued item 

• Discount to meet or beat a competitor's price 

• Discount given for any other reason you might have 
You name your manual discount reasons in Price Manager, but manually apply and enter a discount amount or 
percentage when the sale is rung up. Several default manual discount names are provided; you can add to or 
change them to meet your needs. 
By specifying the discount reason on the receipt (a drop-down list lets the cashier choose from your predefined 
choices) you can track the discounts with Point of Sale reports. 
Optional preference: Require manual discount reason on receipts 
Applying a manual discount 
  

Automatic Discounts (Pro) 
Define an automatic discount and Point of Sale will automatically apply it to qualifying sales during the period the 
discount is active. You can specify start and stop dates and times or manually activate/deactivate the discount as 
needed. 

Notes  

• You can include any combination of items, except group items, in an automatic discount 

• An item can be included in more than one automatic discount, subject to some restrictions. Read the 
discount tips and rules for more information. 

• The combination of customer and items may result in more than one discount applying to a sale. When 
this happens, Point of Sale will compare the discounts and apply them according to these rules. 

• If you use multiple units of measure, a quantity discount can be set up for any one of the defined units. 
  

  
Four automatic discount types are supported:  (T-shirts used as an example): 

% Off Offer a percentage off on any purchase of T-shirts. 
There is no purchase quantity requirement. 
Example  
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You sell a variety of T-shirts for $15 each. 
You set up a discount of 10% off the T-shirts. 
Your customers can buy any quantity of the T-
shirts and get 10% off the T-shirt price, or $13.50 
each. 

  
  

$ Off Offer a percentage off on any purchase of T-shirts. 
There is no purchase quantity requirement. 
Example  

You sell a variety of T-shirts for $15 each. 
You set up a discount of $2.00 off the T-shirts. 
Your customers can buy any quantity of the T-
shirts and will automatically be charged $13.00 
each. 

  
  

Buy X for $Y Buy a specified quantity (X) of T-shirts for a specified 
amount (Y). 
Option:  Apply the discount to additional quantities 
(other than multiples of the specified quantity, which 
automatically qualify for the discount price). 
Example  

Normally, you sell a variety of T-shirts for $15 
each. 
You set up a "Buy 3 for $35" discount on the T-
shirts. 
If three of the T-shirts are added to a sales 
receipt, Point of Sale discounts the shirts to 
$11.67 each. 
If you selected the option to discount additional 
quantities, a customer would get the $11.67 
price on the 4th or 5th T-shirt purchased as well. 
If you didn't select this option, these shirts would 
revert to $15 each. 
Note: If six (or any multiple of three) T-shirts are 
purchased, the customer would automatically 
receive the discount on all of them even if the 
additional quantities option wasn't selected. 

  
  

Buy X and get 
Y% Off 

Buy a specified quantity (X) of the T-shirts and get a 
percentage (Y) off. 
Option:  Apply the discount to additional quantities 
(other than multiples of the specified quantity, which 
automatically qualify for the discount price). 
Example  

You normally sell a variety of T-shirts for $15 
each. 
You set up a "Buy Three and Get 15% Off" 
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discount 
If three of the T-shirts are added to a sales 
receipt, Point of Sale discounts the shirts to 
$12.75 each. 
If you selected the option to discount additional 
quantities, a customer would get the $12.75 
price on the 4th or 5th T-shirt purchased as well. 
If you didn't select this option, these shirts would 
revert to $15 each. 
Note: If six (or any multiple of three) T-shirts are 
purchased, the customer would automatically 
receive the discount on all of them even if the 
additional quantities option wasn't selected. 

  

• An item can be included in more than one automatic discount, subject to some restrictions. Read the 
discount tips and rules for more information. 

Setting up an automatic discount 
Tips and Rules 
  

Coupons (Pro) 
Create store coupons with bar codes that can then be scanned or entered at point of sale to give item discounts. 
Coupons can be printed on your customer's sales receipts (optionally based on their purchase level ), include 
expiration dates, and include either a percentage or dollars-odd discount. 
You can also copy the coupon barcode from Point of Sale to your Windows clipboard and then use it to create and 
distribute your own coupons via e-mail or another application. 
Learn more about using store coupons 
Setting up a coupon 
Optional preference: Print Coupon with Sales Receipts 
  

Discount Pricing List 
How Do I?  | Discount Pricing Overview 

Set up a new discount 

Deactivate or edit a discount 

Print discount price tags 

Apply discount pricing to sales 

Customize my discount pricing list 

Access Price Manager  

  

Pro 
The Discount Pricing list displays all of your non-deleted automatic, manual, and coupon discount price records. 

What's important about this list? 
You can customize the columns or filter the list to provide a snapshot of your discounting activities. The example 
shown is filtered to show only active discounts with sales and profit columns added to help evaluate the 
effectiveness of the discount. 
View example list  
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What can I do from this list? 

• Change View — Select Collapse/Expand to switch views between the full list and a tri-pane view with the 
information panel on the right (shows details of the selected discount on the right). 

• Add a Discount — Select New Discount to set up a new discount price or select Copy to quickly start a 
new discount by copying an existing one. Just edit the copy in the discount wizard for changes and save with 
a new name. 

• Edit a Discount — Highlight an existing discount and then select Edit Discount to open the discount 
wizard and make changes. 

• Activate/Deactivate a Discount — Automatic and coupon discounts can be activated/deactivated from 
the list. Select a discount, and then from the I Want To menu, select Activate/Deactivate Discount. An 
inactive discount is not applied to sales. 

• Delete a Discount — Select a discount or discounts (How do I select multiple discounts in the list?  ) in 
the list and choose Delete Discount(s) from the I Want To Menu. You can still use the discount reports to 
evaluate the effectiveness of a discount after deleting it since the discount information is recorded on sales 
receipts. 

• Print Options — Choices from the Print menu include printing discount or regular price tags, a Discount 
Price List (by item, for currently selected discount) or a List of Discounts (all discounts). Printing are limited 
for some discount types. 

• Review Conflicts — Look for the conflict warning icon    at the left of the list. Pause your mouse 
pointer over the icon for further information on what the conflict might be. Typically, this icon indicates that the 
same item is included in multiple discounts. 

Automatic Discount Tips and Rules 
How Do I? | Discount Pricing Overview | Discount Reports 

Set up a new discount 

Inactivate or edit a discount 

Print discount price tags 

Apply discount pricing to sales 

Customize my discount pricing list 

  

Pro 

General Discount Tips 
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• Discounts set up in Price manager do not change your inventory item prices. They are applied only at the 
time of sale or on a customer order when active. 

• To view discount price information, select Edit Discount, and then navigate to the items page of the Edit 
Discount wizard. You can then customize the columns in the item list to include both the regular and discount 
prices for each of the price levels included in the discount. In the sample shown, the discount is being applied 
to both the Regular Price and the Sale price levels, so the discount price column for each has been added to 
the column display. 

 
• To see the regular and discount prices of an item at all selected price levels without adding columns for 
each, rest your mouse pointer over the Regular Price Discount column: 

 
  
Conflicting Items Rules 

• The same item is never allowed in two active, unscheduled discounts. Point of Sale will force you to 
remove the item from one of the discounts. 

• An item can be included in multiple scheduled discounts or in a combination of scheduled and active 
unscheduled discounts at the same time. However, this may result in a discount conflict and Point of Sale will 
alert you with messages and by adding icons to the discount record and item list. Hover your mouse over an 
icon for additional information. 

 
o A yellow warning icon is more serious; it typically means that the item is in two currently active 
discounts. To resolve the conflict, remove the item from one of the discounts or change the schedules so 
they don't overlap or make one of the discounts inactive. 
o A yellow warning icon could also be alerting you that the discount price is higher than your normal 
inventory price. Review the discount price to ensure it is what you had intended. 
o A blue information icon means the same item is included in another future discount. This doesn't 
demand your immediate attention, but you should be aware of the condition as it could become a conflict 
if the future discount begins before this one ends. 

• If an item is in multiple active discounts when you sell it, Point of Sale follows these rules in determining 
which of the discounts to apply. Only one of the discounts is ever applied. 
o A scheduled discount takes priority and is applied over an unscheduled discount 
o Among two scheduled discounts, the one with the later start date takes priority and is applied 
o See complete discount priority rules, including interaction with other discount types, here 

Printing Price Tags from Price Manager 
Price Manager Overview | Tag Printing Overview 
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When using Price Manger to change item prices or set up an automatic discount, you can print markdown, 
discount, or regular inventory price tags. Markdown and discount tags are a good way to communicate savings to 
your customers. 

• Markdown Tags: Includes both old (lined out) and new price. Available for price changes only.  View 
Sample  

 
• Discount Tags: (Pro) Includes the regular item price and the discount terms and price. Shown is a sample 
tag for a "X for $Y" discount type. Available for discount prices only. View Sample  

 
• Inventory Tags: Includes the current item price only. This is the same as printing tags from your item list. 
Note that on a price change, this value will be different depending on the status of the price change. If 
 Pending, the old price is printed since the new price has not yet been applied. If Applied, the tag will print 
with the new price. And if Restored, it will again print the old price. View Sample  

 

To print tags in Price Manager: 
1. Calculate a price change or set up an automatic discount and display the record. 

If a price change is still pending, it is recommended that you select Items with New Price from the View drop-
down list to ensure you are viewing all the items for which a new price has been entered. 

2. If printing tags for only some of the included items, select them. How do I select just some 
items?   
3. From the Print menu, select the tag type you wish to print. 
4. Change options in the Print dialog as necessary: 

• Whether printing tags for all items or selected items. 

• The quantity of tags to print (the on-hand quantity or a specified number). 

• The tag template to be used.  How do I select a template? 
5. Select Print. 

  
For additional information, read the basic tag printing instructions. 

Deleting Price Manager Records 
Price Manager Overview 
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Price Changes — Only "pending" price change records can be deleted. Once a price change has been applied to 
inventory it becomes a permanent record of the change. Even after restoring a price change, the record still 
remains permanently in your price change list. 
Keep in mind that once you delete a record, it cannot be recovered, copied, or printed. We suggest you review and 
print new price tags if necessary and consider making a backup of your data before proceeding. 
Price discounts — Discount records (such as manual item discounts) can be deleted at anytime. This is because 
discount records do not actually change your inventory prices. Rather, they apply the discount to qualifying sales at 
the time of sale. 

To do this task: 
1. Display your Change Item Prices or Discount Pricing list. 
2. Select the records you wish to delete.  How do I select multiple records?   
3. From the I Want To menu, select Delete Price Changes or Delete Discounts. 
4. Confirm the deletion when prompted. 

  

Note : You can still use the discount reports to evaluate the effectiveness of a discount after deleting it since the discount 
information is recorded on your sales receipts. 

Using Departments 

Departments Overview 
How do I?  | Plan Your Departments 
  
In most retail businesses, related merchandise is grouped into departments. Establishing and using departments is 
a good way to monitor sales performance, manage inventory, and run meaningful reports, which will help you to 
make informed buying decisions. A well-designed department structure will also save you time and give you greater 
flexibility when conducting a physical inventory, changing prices, and printing tags. 
How many departments should you have? That depends on the level of detail you wish to see on reports and how 
you want to work with categories of items with tasks, such as changing prices or talking inventory. Use the Plan 
Your Departments link above for some ideas and guidance on this important decision. 
Each department must be identified by a unique department name. Departments can also be identified by a 
department code which can be used to search for a department record and is printed on price tags. Each item 
added to your inventory then must be assigned to one of your departments. Department options, such as default 
tax codes and profit margin/markup are automatically suggested when you assign new items to a department in 
inventory. Assigning inventory items to departments allows Point of Sale to track and report on the merchandise in 
each department as it is ordered, received, and sold. 
View an example department structure  
(Pro) Remote stores can view department records and use them to filter reports, but only Headquarters can add or 
edit departments. 
  
Related Topics 
Department field descriptions 
Security rights for departments 

Plan your Departments 
Add a Department | Department Overview 
  
The number of merchandise departments you use will depend on how you plan to evaluate sales performance and 
on your buying strategy. You can put all merchandise into a single department, but you may want to consider the 
benefits of setting up a more detailed department structure. Carefully planned departments allow you to view, edit, 
conduct physical counts, or run reports for selected groups of merchandise. 

Consider the following when planning your departments: 
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• How do you want to break out sales, merchandise, and purchasing reports? 

• Do you want to be able to filter your item list for purposes of changing prices, printing price tags, or 
conducting physical inventory counts by merchandise categories? 

• Do you have categories of merchandise that are taxed differently or that you price differently than others? 

• Point of Sale can maintain a virtually unlimited number of departments; however too many departments 
can result in too much detail on reports, which makes it difficult to get useful, consolidated data. It is 
recommended that you define only as many departments as you need to effectively manage your 
merchandise purchasing and reporting. 

Department Codes 
While not required, department codes provide an efficient way to locate a department record and can be useful 
when you wish the item department to be included on price tags where space is limited. Department codes can be 
one to three alphanumeric characters of your choosing. 
View an example department structure  
  
Related Topics 
Edit a department record 
Find a department record 

Access Departments Records 
How do I?  | Departments Overview 

Access your department records in one of these ways: 

• From the Inventory menu, select New Department to create a new department record or 
Department List to view existing departments 

• With the cursor in the Department field on an item record, click the down arrow to display a list of 
your departments from which you can choose 

Add a New Department 
How do I?  | Plan Your Departments | Department Overview 

To add a new department: 
1. Select New Department from the Inventory menu. 

Or, if your department list is already displayed, select New Department from the window toolbar. 
A blank department form is opened. 

2. Enter a Department name (required). 
3. Enter any additional information in the optional department fields. 
4. Select Save or Save & New (if immediately adding another record). 

  

Notes: 
• If you imported inventory items from QuickBooks, all the imported items were put into a single department 
named QuickBooks. Review, add, or edit departments as needed to make them useful for your purposes. If 
you edit a department name, be sure to reassign the new name to items in inventory that are in that 
department. 

• New departments can also be added directly in the department list using list edit mode. 

• (Pro) Only Headquarters can add or edit departments. 

• My markup value sometimes changes right after I enter it. Why?   
Related Topics 
Copy a department record 
Use a pricing formula for new items 
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Print department records 

Search for a Department 
Sort a List | Filter a List | Department Overview 

To search for a department record: 
1. Enter a search keyword or keywords for the department name or department code in the Find 
Department field at the top of your department list. 
2. Click the magnifying glass icon or press <Enter>. 
4. In the Find window, you can confirm and select the correct department or narrow your search: 

• Highlight a record and double-click, press <Enter>, or choose Select Department. 
The department form is displayed. 
OR 

• Select Advanced Find to narrow your search to a specific field or specify other search criteria 
and search again 

• Select Add New to add a new department 

• Select Go to Department List to display your full department list 
Back to top 
  
Related Topics 
Customize the columns in the Find window 

Edit a Department Record 
Department Field Descriptions | Department Overview 
  
You can freely edit department records as needed. However, read the notes below about the effect of editing 
specific department fields. 

To edit a department record: 
1. Highlight or select the department record you want to modify. 
2. Select Edit from the window tool bar. 
3. Modify the department fields, as necessary. 
4. Select Save. 

  
If you want to edit multiple records at one time in your department list, you can do so by turning on list edit mode. 
  

Notes: 
• Editing a department name in the department file does not change the name on item records in inventory. 
To correct inventory items, you must edit the department name for each item assigned to that department to 
reflect the new name. 

• Changes to a department name are automatically reflected in other program areas and on reports. 

• Editing the margin/markup or tax code does not update existing items in inventory. These values are used 
only when adding new items to inventory. My markup value sometimes changes right after I enter it. Why?   

Related Topics 
Find a department record 
Delete a department 
Edit an item 

Delete a Department Record 
Find a Department Record | Department Overview 
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Use this procedure to delete a department that you no longer use. Deleting a department record does not affect 
existing inventory records or history documents. The department name remains in place in both of those areas and 
reports can still be generated for the deleted department. 

To delete a department record: 
1. Highlight the department record that you want to delete. 
2. From I Want To.., choose Delete Department(s). 

  

Notes: 
• Deleting a department record does not remove the department from item records. If the department is still 
in place on item records, the item records should be updated to reflect your new department structure. 

Related Topics 
Edit a department 
Add a new department 

Copy a Department Record 
Department Field Descriptions | Department Overview 
  
If an existing department is similar to one you want to add, copy the existing department and edit the copy to reflect 
the new department information. 

To create a department by copying an existing department record: 
1. In your department list, highlight the department record to be copied. 
2. Select Copy from the window toolbar. 

All the fields from the original department are copied to a new record. 
3. Enter a unique Department Name and modify the other department fields, as necessary. 
4. Select Save or Save & New (if immediately adding another record). 

  
Related Topics 
Find a department record 
Edit a department record 
Delete a department 

Use a Department Pricing Formula for New Items 
Item Price and Cost | Department Overview 
  
Point of Sale’s pricing formula can be used to calculate item prices when they are first added or received into 
inventory. 
When a new item is added and assigned to a department with a predefined margin or markup, Point of Sale will 
calculate your regular price from the average unit cost by applying the specified margin/markup. Prices for your 
other price levels are calculated based on the price level markdowns defined in company preferences. 
  

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

To define a default department margin or a markup: 
1. Display the department record. 
2. Enter a margin value in the Margin % field or a markup value in the Markup % field. Entering 
either results in the other being calculated and auto-filled by Point of Sale. 
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My markup value sometimes changes right after I enter it. Why?   
3. Select Save. 

  

Notes: 
• The department pricing formula is applied only to new items (previous price = $0) added to inventory. It is 
not applied to the prices of existing items when item costs change. 

• If you prefer not to use Point of Sale’s pricing formula, do not enter a margin or markup on the department 
record. Manually enter item prices as you add items to inventory. 

• Margin and markup can be edited in inventory for individual items as necessary. Just edit the Margin % or 
Markup % fields of individual item records. 

Related Topics 
Edit a department 

Print or Export your Department List 
Printing Basics | Department Overview 

To print or export your department list: 
1. Display your department list and select those you want to include in the output: 

• If including all departments, you do not need to make a selection. Ensure the list filter is set to 
display All Departments. 

• To include a subset of your list, filter the list first or select those you want included. How do I 
select multiple departments?   
2. Select Print departments from the Print menu or Export to Excel from the I Want To menu. 
3. If printing, in the Print Departments dialog, select: 

• Print all departments – to include all departments currently displayed in the list 

• Print selected departments – to include only the departments selected 
A preview of the department list is displayed. Select Print to finish. 

If exporting, follow the on-screen prompts. Select Help on the export dialogs for more information. 
  
Related Topics 
Export List Data 

Department Fields 
Department Overview | Adding a Department 
  
Refer to the table below for descriptions of each department field. Fields shown in brackets, e.g. [field name], are 
suggested  or read-only  fields auto-filled by Point of Sale. 
If, when viewing a record list, columns (fields) shown below are not visible, you can use the customize columns 
feature to add them. 

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  

Field Usage 

Dept Code Optional: Enter a 1-3 character code for use in 
listing a department on an item record and 
printing on price tags. 

Dept Name Required: Enter a descriptive name for the 
department to assist in easy identification. This 
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name helps you identify the department on 
reports and in lists. Read about planning your 
departments. 

Margin% Enter a default margin percentage for use with a 
pricing formula. If you do not wish Point of Sale 
to calculate prices for new items as they are 
added to inventory, leave this field and the 
Markup% field at 0. Default = 0%. 

Markup% Markup percentage is an alternate way to 
display your desired profit margin, by marking 
up from item cost. Entering either a margin or a 
markup will display an automatic calculation in 
the other field. Default = 0%. 
My markup value sometimes changes right after 
I enter it. Why?   

[Tax Code] Suggested as the default department tax code 
specified in company preferences. Select 
another tax code from the drop-down list, as 
needed. When a new item is added to inventory 
with this department code, the tax code 
specified here is suggested for the item. 

Data field overview 
Department overview 

Assembly and Group Items 

Should I use an Assembly or a Group Item? 
Assembly Overview | Group Overview 

Pro 
Item assemblies and groups both offer a way to sell a predefined set of items by listing a single item on a sales 
document. However, the two item types vary in several ways, as outlined below. 

Key questions to ask when deciding between an assembly and a group? 
Do you want to physically pre-build the set, thus removing the component item quantities from inventory? 
Do you want the component item quantities in the set to remain available for individual sale? 
Do you want the individual items printed on customer receipts or just the set as a single item? 
Do you sell more of the items individually or as a set? 
Will there be both taxable and non-taxable component items? 
  

Key Differences Between Assembly and Group Items 
Option Assembly Group 

Pre-built? Yes No 

Sell component items 
individually? 

No* Yes 

Can include service and 
non-inventory items? 

Yes Yes 

Can include assembly item 
as component? 

Yes Yes 

Can include group item as 
component? 

No No 
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Assembly/group item 
printed on receipt? 

Yes Yes 

Assembly/group item price 
printed on receipt? 

Yes Optional** 

Component items printed 
on receipt? 

No Yes 

Component item prices 
printed on receipt? 

No Optional** 

Can contain both taxable 
and non-taxable items? 

No*** Yes 

Can assign discounted 
price? 

Yes Yes 

Track costs and quantities? Yes No**** 

      * Quantities of component items not pre-built into assemblies can be sold individually and built assemblies can 
be 
     broken, freeing the component items for individual sale. 
    ** Controlled with a preference setting. 
  *** After assembly, the single tax code assigned to the assembly item determines if it is taxed or not. The entire 
assembly is subject to the same tax code, so taxable and non-taxable items should not be mixed. 
**** Quantities and costs of group component items are tracked individually, not as a group. 

Assembly Items Overview 
Inventory Overview | About Item Types | Group Items 

Pro 
An assembly item is an item that is itself composed of two or more other inventory items and sold as a set. For 
example, a "Ski Slope Package" could be defined as an assembly item made up of a pair of skis, bindings, and 
boots, all of which already exist in your inventory as individual items. Assembly items are often used to sell a set of 
items at a discount. 
You "build" assembly items from the existing items in inventory, which are referred to as the component items. An 
assembly item can also be a component item of another assembly. When you build an assembly, the on-hand 
quantity of each component item is reduced by the quantity of the item included in the assembly and the on-hand 
quantity of the assembly item is increased by one. The number of assemblies you can build is dependent on the 
on-hand quantity of the component items. Assemblies can also be broken, thus freeing the component items to be 
sold individually again. 
The assembled item has a single associated tax code; the entire assembly is taxed or not based on this code. Use 
judgement and observe local tax regulations if mixing taxable and non-taxable items in an assembly. Consider 
listing a non-taxable component as a separate service or non-inventory item on the receipt or use a group item 
instead. You can even include an assembly item in a group item. 
How does an assembly item differ from a group item? 
Once an assembly is defined and built, it can be listed on documents in the same manner as other items. Sales 
reports include assembly items as unique items and do not report on the component items that are included. Keep 
reporting needs in mind when you assign a department, vendor, and descriptions to your assembly items. 
(Multi-store) Only Headquarters can define assembly items, but remote stores can build and break assemblies as 
necessary to meet local sales demand. 
  
Related topics 
Add and build assembly items 
Break, edit, and delete assembly items 
List assembly items on documents 

Add and Build Assembly Items 
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Assembly Item Overview | Break or Edit Assemblies 

Pro 
  
An assembly must be defined and then built to make it available to sell. 
Should I be using a group item instead? 
(Multi-store) Only Headquarters can define an assembly item. Once defined, both Headquarters and remote stores 
can build (or break) assemblies as needed; Headquarters for any store; remote stores for the local store only. 

To define and build assemblies: 
1. Be sure all component items have been added to inventory individually. 
2. From you item list, click Add. 
3. Enter a descriptive name for the assembly item in the Item Name field. 

4. In the item Type field, select Assembly. 
5. Specify a department (required) and a vendor (optional). 

If the items included in the assembly come from more than one department or vendor, you may want to set up 
a new department and/or vendor called Assemblies, or similar, to track and report the sale of assembly items. 

6. Enter information in other item fields as appropriate. 

• You cannot enter an On-Hand Quantity or Average Unit Cost at this time. The quantity will be 
created when you "build" the assemblies; the average unit cost will be automatically calculated as the sum 
of the average unit costs of the component items. This cost will be recalculated each time you build or 
break assemblies. 

• Optionally, enter a Regular Price. If a price isn’t entered, Point of Sale will auto-fill the field with 
the sum of the component item prices once they are added. You can edit the price later, if needed. 

• Enter a Tax Code. The entire assembly will be taxed (or not) based on this code. You cannot mix 
taxable and non-taxable item component items in an assembly. 

• To include the assembly item on Build Point reports and reorder Reminders (to be reminded to 
build more of the assembly) enter the minimum desired on-hand quantity in the Reorder Point field. 
7. Click Save. The assembly item is added to your item list and displayed with details. 
8. Click the Assembly button next to the item Type field. 

The Assembly Details window is displayed. The information entered so far is shown on the left and the grid on 
right is used  to display the component items in the assembly. 
View Example  
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8.   

9. Click Edit Assembly. 
10. In the Scan or enter item information drop-down box, scan or type item information to search 
for the item to add. . 

9.  

Use any of these methods to add items to the group: 

• Scan the bar code from the item tag. 

• Type the item's UPC, Item #, or alternate lookup value and press <Enter>  Learn more about 
these item identifiers 

• Search by item name (beginning characters) or other item keyword. Just begin typing the 
name or keyword and a list of matching items is displayed. Select an item from the list by clicking 
 it (keyboard users, press the down arrow key to scroll, then <Enter> to select). The selected 
item is added to the to the group with a quantity of 1. 

 
 If no matching item is found, check your spelling or the identifier you entered. 
Entering fewer characters will find more matches. 

 To see your entire item list, click the  icon with no entry in the Add Item field. You 
can scroll through the list looking for the needed item. 

• Click Add New Item to Inventory if needed. 
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Learn more about adding items to documents 

10.   
11. Specify the quantity of the component item. 
12. By default, each item is listed with a quantity of one. Click the Qty+ and Qty- button to quickly 
increase/decrease by one or click the Qty button to enter another number.  Quantity is the only editable 
field for the component items. 
13. Repeat to add all items in the assembly. 
14. Click Build at the top of the window. 

• Headquarters in multi-store only: Specify the store for which you are building the assemblies. 

• The Build Assembly dialog is displayed, notifying you of the maximum number of assemblies that 
can be built. This number is based on the available on-hand quantities of the component items. 
15. Specify the number of assemblies you wish to build and then select Build. 
16. Click OK on the confirmation dialog. 
17. Click Save. 

  

Notes: 
• When assemblies are built, the on-hand quantity of the assembly item is increased by the quantity you 
choose to build. The on-hand quantity of each component item is reduced by the total number included in the 
built assemblies. 

• Quantity and cost adjustment memos are automatically created to adjust inventory when building 
assemblies. The logged in user’s name will be entered on the memo, along with appropriate comments 
("Assembly created from inventory") and reason ("Creat Asm"). If users are not required to log in, you will be 
prompted to enter a user name for the memo(s) upon creation. 

• An assembly item can be a component item of another assembly item. 
Return to top 
  
Related Topics 
Sell an Assembly Item 

List an Assembly Item on a Document 
Assembly Item Overview | List Items on Documents 

Pro 
An assembly item is a discrete item that can be listed on documents, such as sales receipts, in the normal manner. 
When listing an assembly item: 

• The assembly item is listed, the individual component items are not 

• The assembly item price (defined in inventory) and tax code is automatically suggested 

• Normal item editing procedures are available 

• If necessary, an assembly item can be "broken" to free the component items for individual sale 
Related Topics 
Edit listed items 

Break, Edit, or Delete Assembly Items 
Assembly Items Overview | Add/Build Assembly Items 

Pro 
You can break, edit, or delete assemblies as needed to free the individual component items, to change the 
component items or quantities, or to discontinue using the assembly. 
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Breaking an assembly makes the component items available for sale individually. This option is only available if the 
on-hand quantity of the assembly item is greater than zero (0). 
(Multi-store) Remote stores are limited to breaking assemblies at their own store and cannot edit or delete the 
assembly item. 

To break assemblies: 
1. Locate and highlight the assembly item in your item list. 
2. Click Show Details. 
3. Click the Assembly button next to the item Type field. The Assembly Details are shown. 
4. Click Edit Assembly. The Edit Assembly window is opened. 
5. Click Break at the top of the Edit Assembly window. 

Headquarters in multi-store only: Specify the store for which you are breaking the assemblies. 
The Break Assembly dialog displays the number of existing assemblies that can be broken. 

6. Specify the number of assemblies you would like to break and then click  Break in the dialog. 
7. Click OK on the confirmation dialog. 
8. Click Save. 

  

Notes: 
• Breaking an assembly reduces the on-hand quantity of the assembly item by one (for each assembly 
broken) and increases the on-hand quantity of each component item by the total number included in the 
broken assemblies. 

• Quantity and cost adjustment memos are automatically created to adjust inventory when breaking 
assemblies. The logged in user’s name will be entered on the memo, along with appropriate comments 
("Assembly broken from inventory") and reason ("Brk Asm"). If users are not required to log in, you will be 
prompted to enter a user name for the memo(s) upon creation. 

• If an assembly item includes a second assembly item as one of its components, then breaking the first 
assembly does not break the second assembly contained therein. 

Return to top 
  

To edit an assembly (Headquarters only in multi-store): 
Assembly item descriptive fields, price, vendor, etc. can be edited at any time using standard inventory editing 
procedures. However, the component items can only be changed if the on-hand quantity of the assembly item is 
zero (0). Existing assemblies must be broken before changes to the component items are allowed. 

1. Highlight the assembly item in your item list. 
2. Click Show Details. 
3. Click the Assembly button next to the item Type field. The Assembly Details are shown. 
4. Click Edit Assembly. The Edit Assembly window is opened. 
5. If the on-hand quantity is not zero (0), click Break and break all existing assemblies. 

(Multi-store) All assemblies at all stores must be broken before the assembly component items can be edited. 
5. Use normal procedures to add, edit, or delete component items. 
6. Select Save to record your changes. 

You can now build new assemblies with the changed component items. 
Return to top 
  
  

To delete an assembly item (Headquarters only in multi-store): 
Deleting an assembly item requires that you first break all existing assemblies and remove the component items 
from the assembly item. 
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1. Break all existing assemblies, remove the component items, and save (select the links above for 
instructions, if necessary). 
2. With the assembly item highlighted (list) or displayed (form), select Delete from the I Want To 
menu. 

• If the assembly item is listed on active order documents, you will be alerted and asked to confirm 
the deletion. If you answer yes, the item will be deleted and cost/quantity memos created to adjust 
inventory. It is recommended that you then edit any order documents to remove the deleted assembly 
item. 

  
Related Topics 
Assembly item overview 
Add and build assembly items 

Group Items: Overview 
How do I?  | About Item Types 

Add a group item to inventory 
Edit or delete a group item 
List a group item on documents 

  

Pro 
Overview 
A group item is not really an item at all, even though it is defined in inventory in the same manner as other items. 
Rather, a group item merely provides an efficient method to list all of the component items on a document by 
entering a single item identifier, optionally at a discounted price. Quantities and costs are not tracked for the group 
item; they are tracked for the individual component items included in the group. 
The component items included in a group remain in inventory individually and can be sold individually. 
When a group is listed on a sales document, the price of each component item is proportionally adjusted so that the 
total equals the specified group price. The group price cannot be edited on the document, but the component item 
prices can be edited, if desired. The printed receipt given to the customer can include the group price, the individual 
item prices, or both, based on your company preference setting. 
Unlike an assembly, sales taxes are computed on each component item individually, based on the sales tax code 
assigned to each. Therefore, taxable and non-taxable items can be mixed in a group. 
How else do group and assembly items differ? 
  
(Multi-Store) Only Headquarters can define group items, but all stores can list group items on documents. 
  
Related Topics 
Add a group item to inventory 
Edit or delete a group item 
List a group item on documents 
Using assembly items 

Add a Group Item 
Group Overview | Sell a Group Item | Edit a Group Item 

Pro 
Should I be using an assembly item instead? 

To add and define a group item (at Headquarters only in multi-store): 
1. Be sure all the items to be included in the group have been added to inventory individually. 
2. Display your item list and then select Add. 
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3. Enter a descriptive name for the group in the Item Name field. 
4. In the item Type field, select Group. 
5. Specify a Department (required). 

If the items included in the group come from more than one department, you may want to add a new 
department called Groups, or similar, to track and report the sale of group items. 

6. Enter information for the group: 

• You cannot enter quantity or cost information for a group. These values are not tracked for a 
group item. 

• Optionally, enter a Regular Price for the group. If you do not enter a price now, it will be auto-
filled as the sum of the group item prices upon saving the group. You can edit the group price later, if 
needed. 

• Enter a unique UPC or Alternate Lookup for use in listing the group on receipts and other 
documents (the program-assigned Item # can also be used for this purpose). 

• Enter information in other item fields as appropriate to define the group. 
7. Click Save. The group item is added to your item list, and the details are automatically displayed. 
8. Click the Group button next to the item Type field. 

The Group Details window displays the information entered so far on the left of the window and the grid on the 
right is used to add the component items to the group. 
View Example  

 
9. Click Edit Group. 
10. In the Scan or enter item information drop-down box, scan or type item information to search 
for the item to add. . 

9.  

Use any of these methods to add items to the group: 

• Scan the bar code from the item tag. 

• Type the item's UPC, Item #, or alternate lookup value and press <Enter>  Learn more about 
these item identifiers 
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• Search by item name (beginning characters) or other item keyword. Just begin typing the 
name or keyword and a list of matching items is displayed. Select an item from the list by clicking 
 it (keyboard users, press the down arrow key to scroll, then <Enter> to select). The selected 
item is added to the to the group with a quantity of 1. 

 
 If no matching item is found, check your spelling or the identifier you entered. 
Entering fewer characters will find more matches. 

 To see your entire item list, click the  icon with no entry in the Add Item field. You 
can scroll through the list looking for the needed item. 

• Click Add New Item to Inventory if needed. 
Learn more about adding items to documents 

10.   
11. Specify the quantity of the component item. 

By default, each item is listed with a quantity of one. Click the Qty+ and Qty- button to quickly 
increase/decrease by one or click the Qty button to enter another number.  Quantity is the only editable field 
for the component items. 

12. Repeat to add all items in the group. 
13. Select Save. 

If no price was entered earlier, the group price automatically is set to equal the sum of the component item prices. If 
a price was previously entered, Point of Sale alerts you if the sum of the component item prices is different.  Select 
OK to set the price to the sum of the component item prices or No to stay with the existing price. 
Return to top 
  

Notes: 
• Only Headquarters can define group items, but all stores can sell group items (or list on other documents). 

• Once defined, you can enter all the items included in a group on a sales receipt or other document by 
entering the group identifier (UPC, Alternate Lookup, or Item #). 

• A group item cannot be a component of a second group. All other item types are allowed in a group. 

• The component items are displayed on the group item form for reference. 
Related Topics 
Using assembly items 
Inventory overview 

List a Group Item on a Document 
Group Item Overview | List Items on Documents 

Pro 
Once defined in inventory, a group item can be listed on any document except adjustment memos, though typically 
they are listed on sales receipts and customer orders to sell a collection of items and/or services, optionally at a 
discounted price. 

To list a group item on a document: 
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• Follow normal item listing procedures, scanning or entering the group item identifier, rather than the 
individual item identifiers. 

Listing the group item on a document adds all of the items included in the group to the document. This example 
shows a group (baseball package) listed on a sales receipt. 
  

 

Notes: 
• The group item is at the top of the list in bold type, while the component items are displayed in contrasting 
row colors for easy identification. 

• The quantity of each item in the group and the group price is pulled from inventory. The price of each 
component item is proportionally discounted so that the sum of extended item prices equals the group price. 

• Editing the quantity of the group proportionally changes the respective quantities of the included items. 
Deleting the group item, deletes all component items. 

• You can edit the individual group items on the receipt in the normal fashion; to change quantity, price, give 
additional discounts, etc. Editing a component item does not trigger a recalculation of other items to maintain 
the group price. 

• The printed sales receipt can include the group price only, the individual item prices only (default), or both 
group and item prices. Set this preference on the Sales page of company preferences. 

• You can list additional unrelated items on the same receipt, as necessary. 

Edit or Delete Group Items 
Add a Group Item | List Group Items on Documents 

Pro 

To edit the group or component items: 
1. Locate the group item in your item list. 
2. Click Show Details. 
3. Click the Group button next to the item Type field. 
4. Click Edit Group on the Group Details window. 
5. Edit the group item information on the left side of the window or add, delete, or edit the quantity of 
component items in the grid on the right. 
6. Select Save. 

To delete a group item: 
1. Highlight or display the group item in your item list. 
2. Select Delete from the I Want To menu. 

If the group item is listed on active documents, such as layaways or sales orders, you will be reminded and asked 
to confirm the deletion. If you answer Yes, the item will be deleted. You should delete or edit the affected 
documents to remove the group item. 
  
Related Topics 
Group Items: Overview 
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Using assembly items 
Inventory overview 

Item Styles 

Item Styles: Overview 
How do I?   | Add a New Style | Style Grid Basics 

Pro 

Note: The availability of the style feature can be controlled by your Features to Use preference settings. 

  
Many retailers sell merchandise that is grouped into styles. A style is a means of grouping inventory items that 
share the same basic item information but differ in one or two item traits, such as size, color, and pattern. 

Example: A line of T-shirts might be carried in three sizes (Small, Medium, Large) and two colors (Black, 
White). This line of T-shirts, with six distinct items, constitutes a style. 

When viewing your inventory or planning a vendor purchase, it can be very helpful to view and work with all the 
members of a style on a single screen. Point of Sale makes this easy with the use of the Style window and the style 
grid. To view and work on the Style window, click the  Style button from the item form. 
Our T-shirt style, as viewed in a style grid, looks like this: 
  

 
  
About the Style window 
A style grid allows you to see the on-hand quantities for each item in the style (each cell represents a size/color 
combination), as well as the total quantities for each color and size. You can quickly spot items that need to be re-
ordered or are out of stock and slow moving items. Accessed while making a purchase order or other document, 
the grid can be used to enter the quantity to order or process on the document. 
From a data standpoint, every item belongs to a style, though that item may be the only member of the style. Style 
items are defined by a common combination of its Department and Item Name (Description 1) values. 
  
Return to top 
  

Style Templates 
Imagine that you carry 20 different shoe lines, all of which have the same or similar size and color combinations. 
Having to re-enter the same sizes and colors for every shoe you carry would quickly become tedious. 
Enter the style template. A style template is a user-defined array of item attributes: sizes, colors, patterns, 
material, etc., that can be used repeatedly to quickly add a style to inventory. Each template can be used for an 
unlimited number of styles. 
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Define and save a style template with the repeated sizes or other attributes along the  x and/or y axes of the style 
grid. When you add a new line of shoes, select the style template to quickly set up the grid. You can edit an 
individual grid, as necessary, for variations from the template. 
The use of style templates is particularly well suited to lines of merchandise that vary only in size, color, pattern, or 
some other item trait. Typical examples include 

 

• Apparel • Housewares 

• Footwear • Linens 

• Luggage • Furniture 

  
Learn more about using style templates 
Return to top 

About the Style Window 
Style Grids | Add a Style | Style Overview | Style Templates 

Pro 
The Style window displays an item style in a split view, with one section showing information that applies to the 
style as a whole and the other section displaying the individual style items and their quantities in a style grid. 
You can open the style window while viewing, adding, or editing items.   

• With an item form displayed, click the Style button. 

• If you are adding items you will automatically be in edit mode. If you want to edit an existing style, click 
Edit either before or after opening the Style window. 

Note: This window was undergoing design review as of this writing and may not exactly match this example. 

 
  

What's important about the Style window? 
• The upper section of this window displays the information for the selected item when you switch to the 
style window. In most cases, this information is common for all style items. It is important to note that 



Printed Documentation 

192 

making changes in this section of the Style window will affect all style items. Be careful making edits 
in this section. 

• Each cell of the style grid represents an individual style item with a unique size/color (or other attributes) 
combination. 

• The number in the cells is typically the current on-hand quantity of each item. See exception in the next 
note. 

• When coming to the Style window from a document (such as a purchase order), the style grid initially 
displays zeroes and can be used to enter the item quantities to order, receive, or sell. 

• The Style Template drop-down list at the top of the grid is used to attach an existing template to the style 
or create and save a new one. 

• Multi-store users can view quantities for any one store or the entire company by selecting a store from the 
drop-down list above the style grid. 

Style Grid Basics 
Style Overview | Add a Style | Edit a Style | Style Templates 

Pro 

This information applies to the lower half of the Style window, displayed after selecting the Style button from an item record. 

  

 

Style Grid Notes 
• Each cell of the style grid containing a number (including zero) represents a unique item in inventory, with 
a unique size/color (or other attribute) combination. A blank cell means that attribute combination is not 
included in your inventory. 

• Though "size" and "attribute" is used when talking about styles in this help system, the grid axes will reflect 
the custom item labels you have defined in company preferences. Any item attribute can be used in a grid 
and placed on either axis, regardless of the labels. For example, your style items might vary by pattern or 
material rather than size or color. 

• The number of items that can be included in a style is virtually unlimited. You may have to use vertical 
and/or horizontal scroll bars to view the cells for all items in the grid. 

• If in Add or Edit mode, click the Click to Add labels to add a new size or attribute, then enter a zero (or the 
known on-hand quantity) in the cells corresponding to the new size/attributes combinations being added. 

Grid Values 
When accessing and viewing a style grid from your item list, the values displayed are the on-hand quantities of 
each style item. 
(Multi-Store)  You can view quantities for a specific store or the entire company by making a selection from the 
View:  field at the top of the grid. 
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If you come to inventory from a document, such as a purchase order, and then display the style grid, you are in 
"item select" mode. In this case the style grid cells initially display zeroes (0). To select items and order quantities 
to return to your document, enter order quantities in the grid and then choose Select from the bottom toolbar. 

Showing Totals on a Grid 
The style grid contains the totals for all the sizes in each attribute (row), and each size (column), and a grand total 
for all items in the style. You can choose to show or hide these totals. 

• From the grid, right-click in any column or row label and select Show Totals to toggle the display 
on/off. 

Navigating a grid: 
  

Keyboard action Description 

<>, <>, <>, <> Move the cursor up, down, left, or right 
from one grid cell to another 
consecutively. 

<Page Up> Move the cursor to the first displayed cell 
of a column. 

<Page Down> Move the cursor to the last displayed cell 
of a column. 

<Home> or 
<Ctrl + > 

Move the cursor to the first cell in a row. 
  

<Ctrl + Home> Move the cursor to the upper left cell of 
the grid. 

<Ctrl + End> Move the cursor to the lower right cell of 
the grid. 

  
Return to top 
  
Related Topics 
Delete a style or style item 

Add a New Style 
Item Style Overview | Style Templates | Edit a Style 

Pro 
Use this procedure to add a group of items to inventory as a style.  What is a style?   
  

Note: The availability of the style feature can be controlled by your Features to Use preference settings. 

To add a new style: 
1. Display your item list and select Add. 

A blank Add Item form is displayed. 
3. Enter the Item Name, Item Type (typically Inventory), and Department. These values must be 
the same for all members of a style. 
4. Click the Style button.    

The Style window is displayed. 
5. Enter information that is common to all items in the style in the 
item fields in the upper section of the window. 
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Important: Enter only information that is common to ALL items in the style. If the style items differ in cost or 
price, leave these fields blank. Point of Sale will auto-fill these fields when you make receiving vouchers to 
receive the items from your vendor or you can edit the fields later for individual items. 

6. In the bottom section, choose a predefined template from the drop-down list in the Select a Style 
Template field to apply it to the new style. 

OR 
Select Add New from the template drop-down list to define a new style template and then apply it to the style. 
OR 
Add style sizes and attributes directly on the style grid in the lower pane, using these guidelines: 

• Click the Click to add labels on the horizontal and/or vertical axes’ and enter the various sizes 
and attributes included in the style. Note: The axes labels will reflect your custom item description labels. 

• Right-click a column or row header to access a popup menu with additional options for 
rearranging the order, deleting, or adjusting widths of columns. You can also select to turn on/off the grid 
totals or to save the grid as a new template from this menu. 
7. Enter a 0 (zero) in each grid cell corresponding to the items you are or will be carrying in the style. 

 
This creates a line in your item list for those items. When you first receive the new items on a receiving 
voucher, Point of Sale will add the received quantities. Leave a cell blank if you do not plan to carry a particular 
size/attribute combination. 
Note: If the style items are already physically in the store and not being received on a voucher, you can enter 
the actual on-hand quantities instead of zeroes. 

8. Select Save. 
9. Edit individual style items, as necessary, to reflect unique UPCs, costs, prices, etc. There are two 
efficient ways to do this: 

• Select a cell in the style grid corresponding to an item you want to edit and press <F5>  (or right-
click and select Edit Item Details). Make changes in the Item Information window and then select OK. 

• Display the style in your item list and use list edit mode to make necessary changes. 
Return to top 
  
Related Topics 
Add pictures to a style 
Style grid basics 
Delete a style item 

Style Templates 
Style Overview | Add a Style | Edit a Style 

Pro 
A style template is a user-defined array of item attributes (sizes, colors, patterns, etc.) that is used as a template 
when adding a new style. Each template can be used for an unlimited number of styles. Of course, you can instead 
create each style grid from scratch in inventory, but using templates makes the process much faster since all the 
predefined sizes and attributes are included in the new grid for you. 

To work with style template: 
1. From your item list or form, begin adding or editing a style. The Style Window is displayed. 
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2. To immediately apply an existing template to the style grid, select a template from the Style 
Template drop-down list at the top of the grid. 

 
Or 

To preview, edit, or add templates, click the magnifying glass icon.  
The Select a Style Template window is opened. Use this window to manage your style templates using the 
procedures below. 
View Example  

 
  
  
  

  

To preview and apply a template to the style you are working on: 
1.  Select a template name on the left side of the window. A preview of the template is shown. 
2. Click Apply Selected Template.  The template is immediately applied and the template window 
closed. 
3. Continue adding or editing your style. 

To add a new template: 
1. Click Add New Template at the top of the window. A new template, with the default name New 
Template n, is displayed in the preview pane. 
2. Type a unique name to overwrite the default. 
3. Select the Click to add fields on the template preview and enter style sizes, colors, or other 
attributes as appropriate along the vertical and horizontal axes. 
4. When done select Save. 

Or 
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If you want to immediately apply this template to the style you were working on, select Apply Selected 
Template, which saves and applies the template in one step. 

To edit, delete, or copy a style template: 
1. Highlight a template in the list on the left of the template window and then complete actions as 
desired: 

• Editing the template: The same procedures used to create a template apply when editing it. 
Additional choices for adding, deleting, and moving rows/columns and for undoing edits are available from 
the Edit menu under the displayed template. After editing, select Save or, if you want to update the 
current style with the changes, select Apply Selected Template. 

• Deleting the template: Choose delete selected template from the Options menu. Deleting a 
template does not effect existing styles the have the deleted template applied. 

• Copying the template: Select Copy Selected Template from the Options menu. Enter a unique 
name for the template and edit as needed before saving. This is a fast way to create a template very 
similar to an existing template. 

• Renaming the template: Select rename selected template from the Options menu. Renaming a 
template does not effect existing styles that have the template applied. 

Notes: 
• Style templates are particularly effective for soft goods retailers (clothing, shoes, etc.) where item lines 
tend to have common sizes, colors, or other attributes. 

• When applying a template to a style, if the applied template contains sizes or attributes you do not want to 
include in the particular style, you need not define items for those cells (i.e. don’t enter a quantity or zero). An 
inventory row (item) will be created only for those attribute combinations (cells) in which you enter a quantity. 

• For some merchandise, attributes vary from style to style and from season to season. In this case, you 
typically won’t know what attributes you need until you are actually ordering the items. Here it is often easier 
to define a template with a single attribute, such as sizes, only along one axis of the template. This gives you 
the flexibility you need to add other specific attributes, such as color for each style independently as you add 
it, while still avoiding repeated manual entry of your commonly used sizes. 

• If you modify an individual style grid in inventory that has a template applied, the original template is not 
affected. 

Return to top 

Edit a Style 
Overview | Style Grids | Style Templates | Delete a Style 

Pro 
Use this procedure to directly edit a style in inventory. If the style has a template applied and the changes are 
permanent, you can also edit the template. 

To edit an existing style: 
1. Select any member of the style in your item list and click View Details. 
2. In the Basic Info section of the item record, click the Style button. 

The Style window is displayed. 
2. Make necessary edits in the top pane. Editing these fields will affect all items in the style. 
3. Make specific style item edits in the style grid: 

• To add a new style item:  Select a Click to add label for a column or row and type a new size or 
attribute entry. Enter a 0 (zero) in the new cells created to add the new style item(s) to inventory. 

• To edit sizes and/or attributes of style items:  Click the labels on the horizontal or vertical axes 
and type a new value. Note that changing a size or attribute in the grid changes it for all items in that row 
or column. A confirmation window is displayed to alert you to this fact. 

• To add, remove, rearrange columns or rows or make other changes in style grid: Right-click 
in a row or column label and choose the appropriate option from the popup menu: 
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 Add or delete column or row – This action adds or deletes items in inventory. Use with 
caution. 
 Move – Move row or column in a specified direction. 
 Auto-arrange by name – Rearranges the columns or rows into alphabetical or 
numerical sequence. 
 Auto-adjust columns widths – Adjusts all column widths to the width of the longest 
entry. 
 Show totals – Turns on/off the display of style quantity totals in the grid. 
 Save as new style template – Saves the displayed arrangement of sizes/attributes to 
your style template list. 

• To edit individual style items: Select an item cell in the style grid and press <F5> or right-click 
in the cell and select Edit Item Details from the popup menu. Make necessary changes and select OK. 
4. Select Save. 

  

Notes: 
• The values displayed in the upper pane are those of the specific item selected when the Style window was 
entered. However, editing these values in the style grid will affect all items in the style. For example, if you 
have different prices within the style, don’t change the prices shown in the upper pane of the Style window or 
you will change all style item prices. 

• Anytime you edit the Department or Item Name for a style item, Point of Sale will ask if you want to have 
that change affect just the item or the entire style. If you update only the item, then that item will no longer be 
a member of that style. 

• If a template was previously applied to the style, editing the style sizes and attributes on the style grid has 
no effect on the saved template. 

• Just as in an item form, edits to an item’s on-hand quantity or average unit cost result in Point of Sale 
creating adjustment memos, which are sent to QuickBooks financial software to update your inventory value. 

Return to top 

Delete Style Items or Entire Styles 
Style Overview | Edit a Style 

Pro 

Note: This process should be carried out with caution so that items with on-hand quantities or listed on active documents are not 
accidentally deleted. If you delete style items with on-hand quantities, Point of Sale creates adjustment memos to update 
inventory and your QuickBooks financial software. If the deleted item(s) are listed on an active order document, the item(s) are 
NOT removed from that document. Review and edit documents as necessary. 

To delete a style item: 
Use the normal item deletion procedure from your item list. 

To delete an entire style: 
Since all style items have the same Item Name, searching inventory by the Item Name is the quickest way to 
display all of the style items (and only the style items). Use caution when taking the following steps as all items in 
the style will be deleted. 

1. Enter the Item Name for the style in the Search field at the top of your item list. 
2. All of the style items (and only the style items) should be displayed. Scroll through the list to 
ensure other items aren't displayed. 
3. Press Ctrl+A on your keyboard to select all of the items. If you only want to delete some of the 
items, select only them. How do I select multiple records?   
4. Select Delete from the I Want To menu. 
5. Confirm the deletion when prompted. If any of the style items still have a quantity on hand or are 
listed on open order documents, you will be warned. 
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6. Select Save. 
  
Related Topics 
Find an item record 

Multiple Units of Measure (Case-to-Unit) 

Multiple Units of Measure 
Inventory Overview | Preferences 

Pro 
This feature, which is enabled in company preferences, allows purchasing and selling an item in up to four different 
units of measure (sizes, or pack quantities). 

Examples: 

• You buy bottled water by the case and sell by single bottles or cases. 

• You buy animal feed by 50 lb. bags and sell it in 5, 10, and 25 lb. bags. 

• You buy fabric by the yard, and sell by the yard and foot. 

With multiple units of measure enabled: 

• You can define multiple units for inventory, non-inventory, and service items. 

• Unit of measure fields and options are added to the item form and other documents and lists. 

• Each unit of measure can have unique UPC, alternate lookup, and prices associated with it. 

• You define a base unit  and default order-by and sell-by units. Point of Sale will automatically suggest 
these defaults when purchasing and selling the item. 

• Your base unit is used for most inventory values (average cost, quantities, reorder point, etc.) and on 
reports, though these values are calculated and displayed for alternate units as well. 

• You can choose in company preferences to add the transaction unit to the quantity field on printed 
documents. 

• If importing item information, you can import the unique information for each of your units. 
Related Topics 
Define multiple units of measure in inventory 
Use units of measure on documents 

Define Multiple Units of Measure 
Overview | Use Units of Measure on Documents 

Pro 
The use of multiple units of measure allows you to purchase and sell an item in up to four different units (sizes, or 
pack quantities). For example, you might buy a canned item by the case but sell it by both the case and individual 
can. You can define a separate UPC, alternate lookup, sales price, and default purchase-by and sell-by units in 
inventory and Point of Sale will automatically suggest the correct unit on documents. 

To define multiple units of measure in inventory: 
1. Turn on the multiple unit of measure feature and add the various units you are likely to use on the 
Inventory page of company preferences. 
2. As adding or editing an item, specify the base unit  for the item in the Base Unit field. Select 
from the units defined in preferences in Step 1 or enter a new unit (it will be added to preferences when 
you save). 

It is strongly recommended you make the smallest unit in which you buy or sell the item the base unit. This 
helps avoid fractional calculations. Other information entered on the main item form (UPC, price and cost, 
quantities, etc.) should be for your base unit. 
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3. Click the Units button adjacent to the Base Unit  field. The Units of Measure window is opened. 
View Example  

 
  
  

  
4. Enter each alternate unit of measure. Click the Unit of Measure 1, 2, or 3 labels to expand the 
section and then enter or select: 

•  Unit: Select from the drop-down list of previously defined units or type a new one. 

• # of Base Units: How many base units there are in this unit? 

•  UPC and ALU: Unique values in these fields allow you to list the item in the correct unit by 
scanning or entering the unique value on documents. If these values are not different for each unit, leave 
them blank for alternate units. 

• Regular Price: For selling this unit; click Pricing to add additional markdown price levels. 

• Average Cost and Quantity on Hand for alternate units are calculated from your base unit 
values and are not editable for alternate units.   

In this example, the base unit is a 12 oz. bottle and now we are entering a case unit which contains 12 bottles. 

 
5. At the top of the window, specify default order-by and sell-by units. Learn more about the default 
units.   

If your default order-by unit is different than your base unit, you will be prompted to enter an order cost. Enter 
the order cost and click OK. 

6. Select Close to return to the main item form. 
7. Enter information in other item fields as necessary. 
8. Select Save. 
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Notes: 
• Each unit can only be added once per item. For example, if you selected "case" as the base unit of 
measure, case will not be available to select as an alternate unit of measure. To use a unit in another 
position, first remove it from the previous defined position (remove by selecting blank as a unit). 

• If using the Data Import Wizard to import item information, you can import information for your base unit 
only. If exporting item list information, the base unit information is exported. 

 Changing Base Units of Measure:  Use caution if you need to change your base unit of measure after having been in 
operation for awhile. Review and update all item fields for each of your units after the change, paying particular attention to cost, 
price, and quantity values. Point of Sale will create adjustment memos for any cost and quantity edits related to the change, but 
there should be no net change in your inventory value. 

  

Special Order Items 

Add a Special Order Item 
Special Orders Overview | Inventory Overview   

Pro 
A special order item can only be added to inventory while making a document (customer order, sales receipt, 
purchase order, or receiving voucher). 
When you add a special order item to a document, you are prompted to define the item on a modified inventory 
window, allowing only certain information to be entered. The item type is automatically set to Special Order. Later 
the item can be converted to a regular inventory item, if desired. 

To create and list a new special order item on a document: 
1. Start the document in the usual fashion. 
2. Select Add New Special Order Item from the I Want To menu. 
3. Define the item in the inventory Special Order Item window. 

Use normal add item procedures to enter information about the item. Certain item fields/features are not 
available for special order items, such as item type, item number, reorder point, the ability to define multiple 
vendors, styles, assemblies or groups, and you cannot print tags. 

4. When finished, choose Save & Select to record the item in inventory and list it on the document. 
  
Related Topics 
Convert a special order item to an inventory item 

Convert a Special Order Item to an Inventory Item 
Handling Special Orders | Add a Special Order Item 

Pro 
A special order item created while making a document can later be converted to a regular inventory item if you plan 
to carry it in inventory in the future. 

To convert a special order item: 
1. Locate the special order item in your item list. 

Hint: Filtering is a good way to display only special order items. 
2. Click Edit. 
3. Change the item Type to Inventory. 
4. Make any other edits necessary, such as the Reorder Point which was previously disabled. 
5. Click Save. 

  

Multi-Store Notes: 
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When a special order item is created at a remote store, the remote store can temporarily define all item fields for 
use on local documents. However, when the special order item is received at Headquarters, the following fields are 
not populated with information from the remote and must be redefined by Headquarters: 

• Tax Code 

• Unorderable Flag 

• Prices at all price levels 

• MSRP (reference price) 

• Order Cost 
On the next Store Exchange, the new values entered at Headquarters will overwrite the item information at the 
remote store that created the item as well as being made available at all other stores. 

  
Related Topics 
Multi-store purchasing 

Transferring Items between Stores 

Transfer Merchandise between Stores 
How do I?  | Multi-Store Overview | Create a Transfer Slip 

Access transfer slips or transfer history 
View item quantities at other stores 
Create a transfer slip 
Hold a transfer slip 
Find a transfer slip 
Reverse or correct a transfer slip 
Print a transfer slip 
E-mail a transfer slip 

  

Pro - Multiple Stores 
The transfer of merchandise from one store to another is recorded on a transfer slip. A transfer slip is a 
transactional document that deducts the transferred merchandise from the source store's item quantity and adds it 
to the destination store's quantity. 
Headquarters can make transfer slips to move merchandise from any store to any other store. Remote stores are 
limited to making slips that transfer merchandise out of their store to another store. 
If one store runs out of an item, they can look to see if another store has the item in stock. Typically, a follow-up 
phone call is made to confirm that the item is still available. At this point, the first store can either send the customer 
to the second store or arrange for the second store to transfer the item to them, in which case the customer can 
purchase it when it arrives. The second store or Headquarters would make a transfer slip to move the item. 
Transfer slips are often made at Headquarters to reallocate fast or slow selling merchandise among stores. Since 
Headquarters has ultimate inventory control, handles purchasing, and has the ability to run company reports, they 
are in the ideal position to assess when merchandise transfers of this nature are beneficial. 

Keep the following in mind as you work with transfer slips: 
 Transfers have no net effect on total inventory quantity or value; they simply move the specified quantity of 
an item from one store to another. 
 The transfer slip is the mechanism that updates Point of Sale inventory for a transfer. You might find it 
helpful to print and FAX or e-mail a copy of the transfer slip to the store(s) involved to assist with the physical 
movement of the merchandise. 
 The store receiving transferred merchandise should NOT record the merchandise on a receiving voucher. 
Transfer slips update the quantities at both stores (called the "From Store" and "To Store" on the slips, 
respectively). Making a voucher that lists the same merchandise would add the item quantity to the master 
inventory and cause errors in the company inventory valuation. 
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 Transfer slips are saved to your Transfer History list and, if applicable, sent to QuickBooks financial 
software. 

Transfer reports, which detail the movement of merchandise between stores are available at both Headquarters 
and remote stores. 
  
Related Topics 
Transfer slip field descriptions 
Transfer security rights 
How transfers are sent to QuickBooks financial software 
Store Exchange overview 

View Item Quantities at Other Stores 
Store Exchange Overview | Track Available Quantities 

Pro - Multiple Stores 
Each store can view item quantities at every other store, accurate as of the last completed store exchange cycle. 

To view available item quantities at other stores: 
1. From your item list, display the item record (select View Details). 
2. In the Basic Info section, click the Available button.  

The Available Quantities window is displayed. 

 
  
This window allows you to view the on-hand, on-order, and available item quantities as well as a list of open orders 
for your store. 
Also displayed are item quantities at other stores, current as of the last completed Store Exchange. If you run out of 
an item, you can use this window to see if another store has the item in stock. If needed, you can request the other 
store to transfer the item to you or you can send the customer to the other store to purchase the item. 
Learn more about the Available Quantities window. 

Other places to view item quantities at other stores: 

• Purchase Order: In the Item Information window, accessed by selecting Edit Item for an item listed on a 
purchase order. 

• Item List: A column for each store's on-hand quantity can be added to your item list. 

• Report: Run the Inventory by Store report (From the Report Center, select Items > Multi-Store - Store 
Inventory. 
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Note: Importance of Store Exchange Sequencing. Item quantities viewed at other stores are only as current as the last 
successful complete Store Exchange cycle. The closer you follow the recommended exchange sequence, the more meaningful 
these quantities will be. 

  
Related Topics 
Automatic quantity adjustment at remote stores 
Transfer merchandise between stores 
Multi-store overview 

Create a Transfer Slip (Transfer Merchandise) 
How do I?  | Transfer Slip Information Fields | Transfer Overview 

Access transfer slips or transfer history 
View item quantities at other stores 
Hold a transfer slip 
Find a transfer slip 
Reverse or correct a transfer slip 
Print a transfer slip 
E-mail a transfer slip 

  

Pro - Multiple Stores 

To create a new transfer slip: 
1. Select New Transfer Slip from the Inventory menu. 
2. Specify the From Store (source of merchandise) and To Store (destination of merchandise). 

• Remote stores cannot change the From Store; it is auto-filled with the local 
store 

• Headquarters can change either field to create slips for other stores 
3. List the items and quantities to be transferred.   

2.  

• Scan the bar code from the item tag 

• Type an item identifier (UPC, alternate lookup value, or item #) and press <Enter> 

• Type the first few letters of the item's description (from inventory) or another search keyword. 
A drop-down list of all your items is displayed with the closest match highlighted. Select an item 
from the list by clicking or touching it (keyboard users, press the down arrow key to scroll, then 
<Enter> to select). 

 
 If no matching item is found, click the Find icon or press <Enter> to open the Find 
Item window, where you can select an item or refine your search.  You can also select Add 
New to go to inventory to add a new item and immediately sell it. 

• Choose Select from Item List from the I Want To menu to go to your full item list and select 
items. 

Learn more about adding items to documents 

3.   
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4. Optionally, enter an estimated date of arrival (ETA), Carrier, Comment, or Freight charges. 
5. Select Save & Print to record the slip and print a copy or Save Only to record the transfer 
without printing. 

When the transfer slip is saved, the quantities for both stores are immediately updated at the store making the slip. 
The store quantity changes are not visible at other stores until after the next completed Store Exchange cycle. 
  
Related Topics 
Record item serial numbers on slips 
View item quantities at other stores 
Multi-store overview 

Copy and/or Correct a Transfer Slip 
Transfer Overview | Find a Slip | Edit a Slip 

Pro - Multiple Stores 

To reverse, copy and correct a slip: 
Copying and correcting a reversed slip allows you to adopt the parts of the original slip that you want to keep, and 
correct the parts that were in error, to make a new, correct slip. 

1. Reverse the original slip as described here. 
2. Highlight or display the original slip again (marked Reversed in the Status field in the transfer 
history list). 
3. Select Copy. A new slip is created and displayed with the same information as the original. 
4. Make the necessary corrections to the information on the new slip. 
5. Select Save & Print or Save Only. 

  

Notes: 
• When done, you will have three slips in your transfer history: the original slip (status of Reversed), the 
second slip that reversed the original (status of Reversing), and the new corrected slip (status of Regular). 

Related Topics 
Basic document reversing information 
Store Exchange overview 
Multi-store overview 

Hold a Transfer Slip 
How do I?   | Slip Information Fields | Transfer Overview 

Access transfer slips or transfer history 
View item quantities at other stores 
Create a transfer slip 
Find a transfer slip 
Reverse or correct a transfer slip 
Print a transfer slip 
E-mail a transfer slip 

  

Pro - Multiple Stores 
A slip can be put on hold to allow you to carry out other activities. For example, you might temporarily hold a slip in 
progress while you make a sale, then unhold and complete it after the sale is completed. If a transfer is not 
physically completed the same day you make the slip you may also want to place the slip on hold until the transfer 
is completed. This ensures that item quantities are not updated until the merchandise physically is moved from one 
store to the other. 
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To hold a slip: 
1. Create a slip, but do not save it. 
2. Select Hold Slip from the bottom tool bar. 

The slip is added to the list of held slips. A slip can be viewed, printed, or deleted while on hold. A held slip is not 
sent to Headquarters (if made at a remote) and does not update inventory until it has been unheld and saved. 

To unhold a slip: 
1. From the Inventory menu or the bottom of the transfer history window, select Held Transfer 
Slips. 

The list of slips on hold is displayed. 
2. Highlight the slip you want and select Unhold Slip from the bottom tool bar. 
3. The selected slip is made active again. Make any necessary modifications and then save and 
print. 

  
Related Topics 
Store Exchange overview 
Multi-store overview 

Reverse a Transfer Slip 
How do I?  | Transfer Overview | Find a Transfer Slip 

Access transfer slips or transfer history 
View item quantities at other stores 
Create a transfer slip 
Hold a transfer slip 
Find a transfer slip 
Print a transfer slip 
E-mail a transfer slip 

  

Pro - Multiple Stores 
Editing of saved transfer slips is limited to freight charges and some informational fields and then only until the slip 
has been sent to Headquarters and/or to QuickBooks financial software. 
If an uneditable error is discovered on a slip, it is necessary to reverse the slip and then you can create a new, 
corrected one to update your history files and store quantities. 

To reverse a saved transfer slip: 
1. Locate and highlight the former slip in your transfer history. 
2. Select Reverse Slip from the I Want To menu. 

The Reversing Document dialog is displayed. 
3. If not using security, select your name in the Associate field and then select OK. 

A reversing slip is automatically created and added to the transfer history list. If necessary, a corrected slip can 
then made as described here. 
  

Notes: 
• Transfer slips can only be reversed at a remote store prior to sending the slip to Headquarters. If the slip 
has already been sent to Headquarters, then it can only be reversed at Headquarters. 

• Reversing a slip cancels the original slip’s effect on inventory. For example, if the original slip transferred a 
unit quantity of three from Store 1 to Store 2, when the slip is reversed a quantity of three is transferred back 
to Store 1. When completed, the original slip will be marked Reversed in the Status field and the new slip that 
is created will be marked Reversing. (Note: the Status field is only displayed in the Transfer History list). 
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• A Reverse, Copy, and Correct approach can be used to undo the effects of the original slip and make a 
new, corrected slip. First, reverse the original slip as described above. Then, begin a new slip by copying the 
original. Finally, make corrections to the copy and save. 

• Headquarters: If integrated with QuickBooks financial software and if the original slip has already been 
sent to QuickBooks, then the reversing slip is also sent and posts in the same manner as any slip. The new 
posting cancels the effect of the original on your financial records. The original entries are not edited or 
removed. If the original document has not yet been sent, then both are flagged and neither is sent, so there 
will be no entries in your financial software for the transaction. 

Related Topics 
Store Exchange overview 
Multi-store overview 

Counting Inventory (PI) 

Physical Inventory Overview 
How do I?   | Basic Steps | Using a Physical Inventory Scanner 

Basic  

A physical inventory is the process of verifying or correcting the on-hand item quantities in your Point of Sale 
inventory by conducting a physical count. 
It is recommended that a physical inventory be done after initially entering your inventory when first starting to use 
Point of Sale and periodically thereafter. 
Conducting a physical inventory involves going through the store and recording the actual item quantities on hand. 
Counts can be recorded on a printed Store Count worksheet or scanned into the optional physical inventory 
scanner, and then transferred to Point of Sale. 
The entire store does not have to be counted at the same time. You may find it easier to conduct your physical 
inventory by department, aisle, or some other discreet physical sections, entering counts and saving for one section 
of your store at a time. A physical inventory can be saved as you go and then inventory updated when you are 
done. Point of Sale provides several ways for you to review changes before updating inventory and alerts you if a 
new transaction has affected an item between when a count was entered and inventory updated. 
You can review or reverse the last updated physical inventory. 
(Pro) A physical inventory is for one store only. When a remote store updates a physical inventory, quantity 
adjustment memos are automatically created and sent to Headquarters during the next Store Exchange. 
Headquarters can create and update a physical inventory for itself or for any store. 
  
Related Topics 
Security rights for Physical Inventory 
Update QuickBooks financial software after a physical inventory 

Access Physical Inventory 
How do I?   | Entering Counts | Using a Physical Inventory Scanner 

Basic  

To start or continue a physical inventory: 

• Select Start Physical Inventory or Continue Physical Inventory from the Inventory menu. 

• (Pro) If you are Headquarters in a multi-store configuration, select the store for which you will 
enter physical counts 

Physical Inventory: Basic Steps 
How do I?   | Physical Inventory Overview 

Basic  

Note: Only one workstation can be working in the physical inventory at any one time. 
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These are the basic steps to complete a physical inventory. Use the links on this page for specific instructions to 
complete a step. 

1. Select Start Physical Inventory from the Inventory menu. 
(Pro Headquarters) Enter the Store for which you are entering counts. 
2. Physically count item quantities on hand using one or both of these methods: 

• Print a Store Count Worksheet and take it with you through the store recording counts. Select 
Run a Report  PI Worksheet from the I Want to menu. Modify the report as necessary to display and 
group your items in a manner that makes sense for counting in your store. 

• Use the optional QuickBooks-approved physical inventory scanner to go through your store 
scanning item bar codes and entering counts. Since the physical inventory scanner is portable, you can 
move freely around your store and scan thousands of items in one session. (physical inventory scanner 
sold separately) 
3. Transfer your counts to Point of Sale by: 

• Using the Add Counts by Hand option. This is usually the fastest manual way to enter counts, 
even if an item is counted several places in the store on different worksheets. Enter an item identifier 
(UPC, alternate lookup, or item number) and then the count, pressing <Enter> after each entry. Point of 
Sale consolidates multiple entries and then transfers the counts to the Physical Inventory window. 

• Entering counts directly in the Counted column on the Physical Inventory window. This is 
convenient for entering a small number of items or items that are grouped together, but may be time 
consuming if the same items are scattered throughout your store. Tip: Filtering or sorting the list on this 
window can help make entry of counts faster. 

• Upload counts from the portable scanner. 
3. Review your counts and the totals summary displayed on screen and, if applicable, select the Set 
all items not counted to zero. This setting ensures that all inventory items for which no physical count 
was entered are zeroed out when you update inventory. 
4. Select Apply Changes to Inventory to update your inventory on-hand quantities with the 
counted quantities. 

  

Notes: 
• You can choose Save & Continue at anytime to pause in your physical inventory. After saving you can 
exit and return later to finish. Choose Continue Physical Inventory from the Inventory menu to resume. 

• If transactions affecting the quantity of previously counted items occur during a physical inventory, the 
items are flagged on the Physical Inventory window and you are alerted. You should recount these items. 

• If you have entered counts but wish to cancel them and start again, select Clear Counts and Restart from 
the I Want To menu. 

• If your computer loses power or crashes during a physical, Point of Sale retains the counts you have 
entered to that point and automatically recovers them for you. 

• If necessary, you can select Print Tags from the Print menu to create new tags for items as counting. 

• (Pro) If you use multiple units of measure for some of your items, read the specific instructions for counting 
them. 

Print and Use a Store Count Worksheet 
Basic Steps of a Physical Inventory | Physical Inventory Overview 

Basic  

Printing a store count worksheet or worksheets is the most common way of recording physical inventory counts if 
you don't use a physical inventory scanner. 

• You can filter your physical item list by logical groupings, such as by department, and print a worksheet for 
each so several people can be counting simultaneously or so can you split the work over multiple sessions 

• The worksheets are generated as Point of Sale reports and are customizable to include the items and 
layout that works best for you 
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• Changes you make to the columns and other display options are remembered and used until you change 
them again 

To print store count worksheets: 
1. With the Physical Inventory window open, select: 

• PI Worksheet from the Print menu. When run from here, the worksheet will automatically include 
only the items currently displayed in the filtered Physical Inventory item list. You can customize other 
display options. 

• Run a Report  PI Worksheet from the I Want to menu. Using this option allows you to 
customize the report as needed, including the items included. 

The report is run and displayed on-screen. 
  

 
  

2. To add/remove columns or make other changes, select Modify or a specific customization option 
from the I Want To menu. 
3. When satisfied with the layout, select Print. 
4. Repeat to create worksheets for other item groupings, if needed. 
5. Go though your store, recording item counts on  the worksheets. 
6. Transfer the item counts to Point of Sale using the Add Counts by Hand option or enter them 
directly in the Physical Inventory window item list. 

Add Counts by Hand 
Basic Steps of a Physical Inventory | Overview 

Basic  

The Add Counts by Hand window is an efficient way to manually transfer item counts from a store count worksheet 
to Point of Sale. There's no need to enter counts in any particular order and Point of Sale will combine the counts of 
an item if entered multiple times. 
  

 
  

To enter item counts using the Add Counts by Hand window: 
1. With the Physical Inventory window open, Select Add Counts by Hand from the I Want To 
menu. 
2. Select the preferred workflow sequence for item entry in After pressing Enter key: 
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• Select Go to quantity field to enter an item then enter the counted quantity, then another item, 
etc. 

• Select Add item to enter one item after another quickly, each with a quantity of one. The cursor 
never moves to the Quantity field with this choice. This might be a good choice if you are scanning each 
and every item unit to enter them. 
3. Scan or enter an item identifier (UPC, Alternate Lookup, or Item #) and press <Enter>. Audio 
and visual warnings are given if an unrecognizable identifier is entered. 

The program will search items in the order shown above. The first match to the entry is listed, e.g., if you have 
an item with an Alternate Lookup that matches an Item #, an entry matching both will cause the item with the 
Alternate Lookup match to be listed. 

4. If you selected Go to quantity field in step 2, enter the counted quantity and press <Enter> or 
click Add. 
5. Repeat Steps 3 and 4 until you are finished entering all the items and their counts. 
6. Select Save. The counts entered are transferred to the Physical Inventory window. 
7. When all counts have been entered on the Physical Inventory window, review the counts and 
then proceed to updating your inventory. 

  

Notes: 
• You can edit entered counts directly in the Counted column on this window if necessary 

• Use the Remove Item button at the bottom of the window to remove an item if it was entered in error 
Related Topics 
Add counts from a scanner 
Enter counts of Items with multiple units of measure 

Use a Scanner for Physical Inventory 
Physical Inventory Overview | Physical Inventory: Basic Steps 

Basic  

Using the QuickBooks-approved physical inventory scanner is an easy and efficient way to record and update your 
physical inventory. With the physical inventory scanner, you can review your inventory counts and resolve errors 
before you transfer the counts to your physical inventory. Since the scanner is portable, you can move freely 
around your store and scan the bar codes of all your inventory items. This option not only saves you time, but also 
helps to reduce inventory errors. 
A physical inventory scanner allows you to scan thousands of units in inventory without needing to stop and upload 
the data. The scanner connects to your workstation via a USB interface, which makes it very convenient to use. 
Using the scanner for a physical inventory includes these basic steps. Select a link for step-by-step instructions: 

1. Scan your items and enter counts. 
2. Upload the scanned data from your scanner to Point of Sale. 
3. Review the retrieved scans. 
4. Save the scans to the Physical Inventory window. 
5. Update inventory on-hand quantities with your counts. 
6. Clear scans from the physical inventory scanner unit, making it ready for the next scanning 
session. 

You can use the physical inventory scanner in conjunction with manually entered counts. When you update your 
physical inventory, the on-hand quantities are adjusted in your inventory for all item counts on the Physical 
Inventory , regardless of how they got there. 
  

Note: Two models of physical inventory scanner are supported. While the procedures for using them are the same, you may see 
slight differences in menu wording and button colors, names, or locations. 
Illustration of the CipherLabs 8000 Scanner  
Illustration of the Metrologic SP5500 Optimus Scanner  
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Related Topics 
Use bar codes in Point of Sale 
Install Supported Hardware 

Review Counts Before Updating Inventory 
Physical Inventory Overview | PI Reports 

Basic  

  
It is highly recommended that you review your physical inventory counts before updating a physical inventory. No 
mater how you've entered your item counts, they all end up in the item list on the main Physical Inventory window. 
From this window, you have several options for reviewing your counts to help determine if investigation or recounts 
are necessary before updating your inventory with the counts. 
  

1. Do you need to set all items not counted to zero (0)? 
When updating inventory with your counts, only the items with a count entered will be updated. It is important to 
enter a zero for items that are out of stock during the count so that your inventory is updated accordingly. You can 
enter a zero manually for these items or you can select the checkbox labeled Set all items not counted to zero to 
accomplish this in one step. 
  

Do not use this option if you are counting and updating inventory for only a portion of your store (such as for one 
department). All items in your inventory that do not have a count entered are set to zero, not just those currently displayed in the 
Physical Inventory item list. Always review the results before updating inventory. Clearing the checkbox before updating will 
remove the zero counts. 

  
  

2. Recount items whose quantity may have changed since starting. 
While it is not recommended, sometimes a physical is done while your store is open and you continue selling. Or 
maybe you have started, saved, and restarted a physical with a period of sales between. Point of Sale will track 
and alert you when any transaction (receiving, sale, adjustment, transfer) affects items you have already counted. 
This gives you an opportunity to recount the item(s) in question before updating your inventory. 
  

 
  
  

3. Review the physical inventory difference totals. 
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At the bottom right of the window is a summary of the differences in quantity, price, and cost of the counted items 
compared to what was expected. If the numbers are way off what you expected, review the counts in the item list 
looking for large discrepancies. 
Tip: Filter the item list by Differences Only to quickly find suspect counts. 

 

Update Inventory with Physical Counts 
Physical Inventory Overview | Basic steps of a Physical Inventory 

Basic  

Important: If you haven't already done so, review your item counts before updating inventory. 

  
When all of your counts have been entered and reviewed, use this procedure to update inventory on-hand 
quantities to the values you have entered. 

1. With the Physical Inventory  window displayed, ensure that All Items is selected in the View drop-
down filter list at the top of the window. 

Requiring that all items be displayed is a precaution to help make sure you are not updating inventory with 
"hidden" entries. 

2. Select Apply Changes to Inventory. 
A confirmation window is displayed. 

3. Select Yes to update inventory quantities. 
4. At the prompt, specify if you would like to run one of the physical inventory reports. 

  
Note: Adjustment memo(s) created  
Note: Update QuickBooks financial software  
Clear the physical inventory scanner's memory (if applicable) 

Review or Reverse the Last Physical Inventory 
Physical Inventory Overview | Physical Inventory Reports 

Basic  

Note: Only the last updated physical inventory is saved and can be reversed. Each time you update inventory with count 
changes, that update replaces the previous saved physical. 

  
Point of Sale allows you to go back and review the last updated physical inventory. You can print reports and even 
reverse the effect the physical had on your inventory. 
Access the options for a previous physical from the I Want To menu: 

• Select Show Previous Physical to display the information from the last physical in the Physical Inventory 
window. 

• Select Show Current Physical to return to the new physical. 

• Select Run a Report and then select one of the available PI reports with (previous) in it s name. 

• Select Reverse Previous Physical to "undo" the changes the physical had on your inventory quantities. 
This option reverses the quantity memos that were created when the physical was originally updated. If the 
previous physical is reversed, the options to access it are removed from the I Want To menu. 



Printed Documentation 

212 

Physical Inventory Reports 
Basic Steps of a Physical Inventory | Physical Inventory Overview 

Basic  

Three physical inventory reports can be viewed or printed. 

• PI Differences Report – Includes only those items whose counted quantity was different than the 
expected quantity (on-hand quantity from inventory before physical). This report includes a list of items and 
differences in quantity, price, and cost. 

• PI Detail Report – Similar to the differences report, but includes all counted items (including those with a 
zero entry). 

• PI Store Count Worksheet – This report is intended as a working document on which you record your 
item counts while doing a physical inventory. More information. 

The PI differences and detail report are also available for the last updated physical inventory as well as the physical 
in progress. 

To access the PI reports: 

• With the Physical Inventory window displayed, select a report from the I Want To menu or the Print menu. 

Notes: 
• These reports are available only from the Physical Inventory window. They cannot be accessed from the 
Report Center or main Report menu. 

• Other than customizing the store count worksheet, these reports cannot be filtered, memorized, or added 
to the Report Dashboard. 

Making Inventory Adjustments 

Inventory Adjustments Overview 
How do I?  | Memo Fields | Making an Adjustment Memo 

Access adjustment memos and history  
Create an adjustment memo 
Temporarily hold a memo 
Find a memo 
Reverse or correct a memo 
Copy a memo 
Print a memo 

  

Basic  

Adjustment memos are used to make changes to item quantities or costs. The changes tracked are those that 
would not otherwise be recorded on another transactional document. 
Typical uses for manually-created adjustment memos include: 

• Adjust quantity for theft and other shrinkage 

• Adjust quantity for donated items 

• Remove defective or damaged returned items from inventory 

• Correct cost or quantity errors in inventory 
When you create an adjustment memo, the affected On-hand Quantity or Average Unit Cost fields are 
automatically updated in inventory and a permanent record of the change is added to your adjustment and item 
history. 
Some actions in Point of Sale, such as deleting an item with an on-hand quantity, conducting a physical inventory, 
or manually entering or editing an item’s average cost or on-hand quantity result in program-generated adjustment 
memos. 
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Saved memos are permanently stored in your adjustment history lists. A separate list is maintained for each memo 
type, quantity and cost. Memos can be reversed to correct errors, but never deleted. 
(Pro w/multiple stores) Item quantities can be adjusted at either Headquarters or remote stores. Headquarters can 
adjust quantities for any store, while remote stores can adjust only their own local quantities. Only Headquarters 
can create cost memos, although both quantity and cost memos are generated automatically at remote stores for 
certain activities. 
  

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  
Related Topics 
Security rights for adjustments 
How adjustment memos are sent to QuickBooks 
Note: Automatic quantity adjustments at remote stores 

Actions that Generate Memos 
Adjustments Overview | Inventory Overview 

Basic  

The actions listed below will result in adjustments to inventory quantities or costs. Certain actions result in program-
generated memos; in these cases you may be prompted for your name and a reason for the adjustment, but the 
memo is automatically created. The Source and Type columns refer to the entries automatically recorded in the 
corresponding fields in the memo header. 
  

Action Created by Reason Source Type 

Manually 
creating a 
memo 

User User-defined or 
selected 
(damaged, 
shrinkage, etc.) 

Manual Quantity 
or Cost 

Reversing a 
memo 

Point of Sale ManAdj Reverse Quantity 
or Cost 

Deleting an 
item with an 
on-hand 
quantity 

Point of Sale Item Deleted Inventory Quantity 

Applying 
 physical 
inventory 
changes 

Point of Sale Physical Physical 
Inventory 

Quantity 

Manually 
entering item 
quantity or 
cost 

Point of Sale ManAdj Manual Quantity 
or Cost 

Merging 
items 

Point of Sale MergedItem Manual Quantity 
or Cost 

Importing 
items with 
the Data 
Import 
Wizard 

Point of Sale Data Import 
or 
QBFS Import 

Import Quantity 
or Cost 

Building an 
Assembly 
(Pro) 

Point of Sale CreatAsm Assembly Quantity 
or Cost 
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Breaking an 
Assembly 
(Pro) 

Point of Sale Brk Asm Assembly Quantity 
or Cost 

  

Creating an Adjustment Memo: Basic Steps 
How do I?  | Memo Fields | Adjustments Overview 

Access adjustment memos and history  
Create an adjustment memo 
Temporarily hold a memo 
Find a memo 
Reverse or correct a memo 
Copy a memo 
Print a memo 

  

Basic  

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

To create a memo: 
1. From the Inventory menu, select New Quantity Memo or New Cost Memo. 
2. Enter information into the appropriate memo fields at the top of the form. 

• The Reason field must have an entry. 
3. List the items to be adjusted, using standard item listing procedures.  

2.  

• Scan the bar code from the item tag 

• Type an item identifier (UPC, alternate lookup value, or item #) and press <Enter> 

• Type the first few letters of the item's description (from inventory) or another search keyword. 
A drop-down list of all your items is displayed with the closest match highlighted. Select an item 
from the list by clicking or touching it (keyboard users, press the down arrow key to scroll, then 
<Enter> to select). 

 
 If no matching item is found, click the Find icon or press <Enter> to open the Find 
Item window, where you can select an item or refine your search.  You can also select Add 
New to go to inventory to add a new item and immediately sell it. 

• Choose Select from Item List from the I Want To menu to go to your full item list and select 
items. 

Learn more about adding items to documents 

3.   
4. Enter the New Qty or New Cost for the item in either of these ways: 

• Highlight the item and select Edit Item (<F5>) to open the Item Information window. Enter the 
adjusted value and then select OK (<F5>) to close the window, or 
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• Navigate to the respective field in the item list and make changes directly there. 
5. Select Save & Print or Save Only. 

  

Notes: 
• You cannot list non-inventory or service items on a quantity adjustment memo since these items, by 
definition, have no on-hand quantity in inventory. 

• (Pro) Likewise, group items cannot be added to quantity or cost memos, since neither the quantity or the 
cost of the group is tracked. You can adjust the cost of the component items included in a group item. 

• (Pro) If using multiple units of measure, all adjustments are done relative to the base unit of measure. 

• (Pro w/multiple stores) Headquarters only: If making a memo for a store other than HQ, select the store 
from the drop-down list in the Store field. 

Notes on the quantity/cost difference Fields  
Tip: Changing the quantity of a large number of items or a style  
  
Related Topics 
Copying a memo 
Canceling or holding a memo in progress 

Edit Items Listed on Documents 
List Items | Delete Items | Edit Saved Documents 
  

You can edit an item on a transactional document only until the document has been saved. You can edit items on order 
documents at any time. 

These edits will affect only the listed items on the document; they will not affect the corresponding items in 
inventory. The fields that can be edited vary by document, but typically edits are made to: 

• Change the quantity, price, cost, or give an item discount 

• Change an item’s tax code, when special tax handling is needed 

• Edit the item description; sometimes used on service or non-inventory items 

• (Pro) Enter item serial numbers 

• (Pro) Change the sales Associate on a line-item basis for commission tracking 
The procedure here is for editing an item on a sales receipt. The general procedure is the same on other 
documents, though choices may vary slightly. 

To edit a listed item: 
1. Highlight the item you wish to edit on the receipt.. 

If you just listed the item, it is automatically highlighted and this step is not necessary. 
2. Make edits as necessary: 

• Click Qty + and Qty –  to increase or decrease the item quantity respectively. 

• Select Return Item to change the quantity to negative (a negative quantity adds the item back to 
inventory) 

• Click Qty/Price/Discount to open a dialog allowing you to edit any or all  of these things in a 
single window 

• Click Edit to open the Item Information window to access other editable fields. 

• Or, make changes directly in the item list. You may have to add columns to the list for this option 
to be available. 
3. Make other entries on the document as necessary and then take payment and save. 
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Related Topics 
List and edit a group Item 
List an item assembly on a document 
List different units of measure on documents 

Search for an Adjustment Memo 
Sort a List | Filter a List | Adjustment Overview 

Basic  

Instructions for searching for a memo are given below. You can also locate memos by viewing item history. 
(Pro with multiple stores) Remote stores only have access to memos made at the local store, while Headquarters 
can find memos made at any store (assuming Store Exchanges have been completed). 

To search for an adjustment memo: 
1. In the Find Memo field above your adjustment history list, enter a search keyword: 

Keyword Notes 

Memo #: Enter the memo number 

Memo Date: Enter in mm/dd/yyyy or mm/yyyy format, including slashes, Example: 10/05/2005 
finds all memos made on October 5; 10/2005 finds all memos made in October 

Associate: Enter the Associate login name 

Source: Enter keyword matching the entry in the Source field on the memo, e.g. Manual, 
Physical Inventory, etc. 

Reason: Enter keyword matching the entry in the Reason field on the memo, e.g. Qty Adj, 
Cost Adj, Shrinkage, Damaged, etc. 

(Pro) Serial #: Enter an item serial number that was recorded on the memo 

3. Click Find (magnifying glass icon) or press <Enter>. 
All matching memos are listed in the Find window. 

4. Confirm and select the correct memo or select from other options: 

• Highlight a memo and double-click, press <Enter>, or choose Select Memo. 
The memo is displayed and all normal options to copy,.reverse, or reprint are available. 
OR 

• Select Advanced Find to narrow your search to a specific field or specify other search criteria 
and search again 

• Select Add New <type> Memo to make a new adjustment 
Return to top 
  

Note: 
• To search for a memos currently on hold, you must first display the held slip list. 

Related Topics 
Reverse and correct a memo 
Customize the columns in the Find window 

Reversing and Correcting an Adjustment Memo 
Finding a Memo | Adjustments Overview 

Basic  

Saved memos are permanent records that cannot be deleted. To undo an adjustment, you must create a new 
adjustment. 
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A quick way to accomplish this is to reverse the original memo, which automatically creates another adjustment to 
cancel the effect of the original. 

To reverse a memo: 
1. In your adjustment history list, highlight or display the memo that you want to reverse. 
2. Select Reverse from the I Want To menu. 

The Reversing Document dialog is displayed. 
3. Confirm or enter your name in the Associate field. 
4. Select OK. 

  
If necessary, the original memo can then be copied and the copy edited to create a new, corrected memo. 
  

Notes: 
• Reversing a memo does not alter the original memo; other than marking it as Reversed in its Status field. 
Instead, a second memo is created that has the opposite effect on inventory. For example, reversing a 
quantity memo that removed three units of an item from inventory will add three units back to inventory. 

• Reversing a cost memo creates a new memo that reverses the total dollar amount of the original cost 
adjustment. It also adjusts the current average unit cost in inventory for each included item. 

• When completed, the original memo will be marked Reversed in the Status field. The new memo that is 
created will be marked Reverse in its Source field and Reversing in the Status field. 

• If an item listed on a reversed memo has been deleted from inventory, the reversing action adds it back to 
inventory. Learn more  

• If integrated with QuickBooks financial software and if the original memo has already been sent to 
QuickBooks, then the reversing memo is also sent as part of the next consolidated inventory adjustment 
cancelling the effect of the original. The original financial entries are not edited or removed. If the original 
document has not yet been sent, then both are flagged and neither is sent, so there will be no entries made in 
your financial software for the transaction. 

• (Pro w/multiple stores) A remote store can only reverse a memo up until the time it has been sent to 
Headquarters. After that time, the memo can still be reversed at Headquarters. In the case of a quantity 
memo, a remote store can also create a new memo adjusting the quantity back to the original value to undo 
the effects of the original. 

Related Topics 
Creating a memo manually 
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Sales & Returns 

Sales Overview 
How do I?   

Make a sale 
Add items to receipt 
Edit receipt items 
Add customer to receipt 
Change receipt price level 
Give discounts 
Collect sales tax ..   
Take payment...   

Sell gift card or certificate 
Hold or cancel a receipt 
Print gift receipt 
Take return or exchange 
Pay cash out of drawer 
Sales history tasks...   
Setup & troubleshoot...   
Additional Pro tasks..   

  
  
Sales and returns/exchanges are recorded on receipts: 

• Sales receipts record merchandise sales and returns/exchanges. 

• Payout receipts record money paid out of the cash drawer for various reasons. 

• (Pro) Deposit receipts record deposits taken on customer orders. Deposit receipts are 
discussed in the customer order topics. 

Saving a receipt removes the sold items from inventory (or adds them back, in the case of a return)  and places the 
receipt in your sales history list. Saved receipts are permanent transactional documents that are drawn upon for 
reports and can be edited (informational information only) or reversed, but never deleted. 

Multi-Store Notes 
• All basic receipt features are available at all stores. In addition, Headquarters can make receipts to sell or 
return merchandise for other stores. 

• Each store can setup, process, and settle credit/debit card transactions locally. In addition, each store can 
set many of its own sales preferences. 

• Each store maintains its own sales history, which contains all saved receipts made at that store. At 
Headquarters, the sales history file also contains all receipts that were made at remote stores and sent to 
Headquarters via Store Exchange. This allows Headquarters to run multi-store reports including all company 
sales information. 

Handling Sales Returns and Exchanges 
Merchandise returns and exchanges are recorded on receipts, in the same manner as sales. The returned quantity 
is simply entered as a negative number. 
Learn more about  Returns and Exchanges. 
  
Related Topics 
Set sales preferences 
Receipt field descriptions 
Security rights for receipts 
How receipts are transferred to QuickBooks financial software 

Make a Sale 
How do I?  | Store Charges or Credits | Take Payment | Returns 

Add items to receipt 
Edit receipt items 
Add customer to receipt 

Sell gift card or certificate 
Hold or cancel receipt 
Print gift receipt 
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Change receipt price level 
Give discounts 
Sales tax ..   
Take payment...   

Take return or exchange 
Pay cash out of drawer 
Sales history tasks...   
Setup & troubleshoot...   
Additional Pro options...   

  
  
This topic provides the basic instructions for making a sale. Use the How Do I? and other links on this page for 
advanced options and more information. 

Click the symbols in this procedure to view detailed instructions. 
Only Basic and Pro users can track customers on receipts. 

This symbol indicates more information is available. Click to expand the information. 

  

To make a sale: 
1. Select Make a Sale button or the Make a Sale icon within the Navigator.  
2. In the Scan or enter item information drop-down box, scan or type item information to search 
for the item being sold.   

2.  

• Scan the bar code from the item tag. 

• Type the item's UPC, Item #, or alternate lookup value and press <Enter>  Learn more about 
these item identifiers 

• Search by item name (type beginning characters) or other item keyword. A list of matching 
items is displayed. Select an item from the list by clicking  it (keyboard users, press the down 
arrow key to scroll, then <Enter> to select). The selected item is added with a sales quantity of 
1. 

 
 If no matching item is found, check your spelling or the identifier you entered. 
Entering fewer characters will find more matches. 

 To see your entire item list, click the  icon with no entry in the item search field. 
You can scroll through the list looking for the needed item. 

• Click Sell a Miscellaneous Item or Add a New Item to Inventory. 
Learn more about adding items to documents 
  

3.   
OR 
Click Quick Pick Item to select an item from your pre-defined lists of frequently sold items. 
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3. If necessary, click the action buttons below the line item to edit the quantity, price, give item 
discounts, etc. 
4. Repeat until all items being sold have been listed. 
5. (Optional) In the Enter customer name or phone box, type or scan customer information to add 
the customer to the receipt.  

4.  

In the Customer field, begin typing the customer last name (recommended) or other search keyword 
(first name, phone number, company name, etc). 

• As you type, Point of Sale shows a drop-down list of your matching customers, separated into 
last name matches and matches using all customer fields. If there are last name matches, they 
are displayed first. Click the results line to open all field matches if necessary. 

 

• Option: With no entry in the field, click the  icon to show your entire customer list. You can 
scroll through the list to look for the customer. 

• Click a name to select it. Keyboard users can use the arrow up/down keys to move through 
the list and <Enter> to make a selection. 

• If the selected customer has an associated discount, price level, or special tax handling, you 
are prompted to apply it to the sale. 

• If the customer isn't found, click the  Add New Customer to create a new customer record. 

• Click the View/Edit button to open the customer record or the Delete button to remove the 
customer from the receipt. 

 
Not all customer information is displayed on a receipt. For example, the customer's address, charge 
account information, and check acceptance status are not displayed. However, you will be notified if a 
credit limit is exceeded, if checks are not accepted, or if a reward is available for the customer. 
  

5.   
6. (Optional) To discount the entire sale (called a global discount), select  Give Discount from the I 
Want To menu. Select or enter a discount percentage or amount in the popup dialog. Global discounts are 
shown in the totals area of the receipt. 
7. Click the button for the payment type used by the customer (Cash, Credit, Debit,  etc.) and enter 
the tendered amount and any requested information. If taking payment by more than one payment type, 
repeat for each type.  Details 
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8. Select Print Receipt to record the sale and give the customer a receipt. If change is due the 
customer, the change amount is displayed. 

  

Notes: 
• The Quickbooks Point of Sale Mobile Sync feature gives you the power to make sales and track 
your inventory using your mobile phone or tablet.  Make sure to sync to your mobile device to take full 
advantage of this feature.  

• In a Pro configuration with multiple stores, Headquarters can make receipts for another store. From the I 
Want To menu, select Change Store and specify the store for which you are making the receipt. 

Learn more 
  
Related Topics 
E-mail receipts to customers 
Receipt field descriptions 
Customize printed receipts and other documents 
Multi-store Sales 

Working with Receipt Items 

List Items on Documents: Overview 
Use Bar Codes | About Item Identifiers | Find an Item 
  
The item list included on documents lists the items to be processed (received, sold, ordered, etc.). This list contains 
item details such as the description, price or cost, item discounts, etc. 
The default columns included in the item list will vary depending on the document you are completing. Most list 
navigation procedures apply, including the ability to customize the columns included in the list. 

Which type of document do you need help with? 
Sales Receipts or Receiving Vouchers  

In the Scan or enter item information drop-down box, scan or type item information to search for the item 
being listed (receipt example shown): 

 
Use any of these methods to add items to the document : 

• Scan the bar code from the item tag. 

• Type the item's UPC, Item #, or alternate lookup value and press <Enter>  Learn more about these 
item identifiers 

• Search by item name (beginning characters) or other item keyword. Just begin typing the name or 
keyword and a list of matching items is displayed. Select an item from the list by clicking  it (keyboard 
users, press the down arrow key to scroll, then <Enter> to select). The selected item is added to the 
document with a quantity of 1. 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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 If no matching item is found, check your spelling or the identifier you entered. Entering fewer 
characters will find more matches. 

 To see your entire item list, click the  icon with no entry in the Add Item field. You can scroll 
through the list looking for the needed item. 

• Click Sell a Miscellaneous Item or Add a New Item to Inventory if needed. 
Related Topics 
Quick Pick Items 
  

  
All Other Documents (Purchase Order, Customer Order, Adjustment Memo, Transfer Slip)  

 
  
With the cursor in the Enter Items field, do one of the following. Each of these procedures, except the last, 
adds the item to the document with a quantity of one. 

• Scan the item bar code; if one unique match is found in your item list, it is instantly listed. 

• Type the item UPC number, item number or alternate lookup value (collectively called item identifiers) 
and press <Enter>; if one unique match is found, it is instantly listed. 

• Begin typing the item description (based on Description 1 field in inventory); a drop-down list of your 
items is displayed with a match highlighted. Select it or another item from the list. 

• Type an item search keyword or keywords and then choose Find Items to the right of the Enter Items 
field. The Find Item window displays all item matches found, select an item or refine your search 
keywords and select Find again .until the item is located and listed. 

• From the I Want To menu, choose Select from Item List (<F4>) to open your item list in a special 
selection mode. Locate the item(s) and enter the quantities needed in the Doc Qty column of this screen. 

• (Pro) To choose style items, display the style grid and enter document quantities in the cells of the grid. 
Then choose Select from the bottom toolbar to return them to the document. 

Learn More 
Searching for an item by keyword 
Selecting items from inventory 
  

  
  

For general information about listing document items, select a topic: 
Scan or enter a UPC, Item #, or Alternate Lookup 
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Quick Pick Items (receipt and voucher only) 

Using service or non-inventory items 

Enter decimal item quantities 

Add a new item to inventory while making a document 

Handle special orders 
List a group item 
List an assembly item 
List different units of measure 
View item quantities at other stores 

Editing Listed items: 

Edit items 

Remove items from a document 

Select Items from Inventory 
Find an Item | Filter the Item List | Sort the Item List 
  

This topic applies to purchase orders, inventory adjustment memos, and transfer slips only. 

  
You can go directly to inventory to select items to list on a document or for other tasks. Once in inventory, the item 
list can be sorted, searched, or filtered to locate the correct item or an item can be added or edited before listing. 

To look up and select items in inventory: 
1. Choose Select from Item List (<F4>) from the document or task I Want To menu. 

This opens your item list in a special selection mode. 
2. Locate the items you want to list. 
3. Once you have located an item, use one of the following methods to bring it to the document: 

• To immediately return one item to the document, double-click it. The item is listed with a quantity 
of one. 

• From a document: Enter the quantity of each item to be listed in the Doc Qty  column in your 
item list. You can also specify the Doc Price  (if making a receipt or customer order) or the Doc Cost  (if 
making a PO, voucher, or cost memo). Navigate through the item list, making entries for all items you 
want to list on the document. When finished, choose Select from the bottom toolbar to return selected 
items to the document with the specified quantities and prices/costs. 

 
• From other tasks: Select the checkboxes to the left of an item to select it. You can also use the 
selection options from the I Want To menu to select all, clear all, or select multiple items. When finished, 
choose Select from the bottom toolbar to return selected items to the task form or list. 

 
• If you need to list a large number of style items, as you might on a PO, voucher, or adjustment 
memo, highlight a style item and then, from the I Want To. menu select Edit/Add Style. Enter document 
quantities (or select checkboxes for other tasks) directly in the style grid cells corresponding to each style 
item. When done, choose Select. 
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4. Repeat steps 2-3 to locate and list all the items you need. 
  
Full item editing is possible while in the item selection screen. This feature allows the flexibility to perform tasks, 
such as adding items as new merchandise is being ordered, received, or sold. 
  
Tip: Filter your item list to display a single vendor's items  
Note: Add a new style while creating a document  
  
Related Topics 
Add a new item while creating a document 
List items on documents 
Inventory overview 

Service and Non-Inventory Items 
Item Types | Inventory Overview 
  
Either service and non-inventory items can be used to sell or charge for non-merchandise services and fees, such 
as for tailoring, repairs, gift-wrapping, recycling fees, and delivery charges. The on-hand quantity of both these item 
types is always zero (0). 
Non-inventory items are also sometimes used for incidental merchandise items for which you do not wish to track 
quantities. Example  
Having two item types for these uses allows you to categorize and post the sales to different income accounts in 
your QuickBooks financial software and on Point of Sale reports. 
  
To define a service or non-inventory item: 

1. Start adding a new item as usual. 
2. In the item Type field, select Service or Non-Inventory. 
3. Enter information in the other item fields as needed. 

• Use the Item Name field to record a description of the service or fee, such as Gift Wrap, Repair 
Labor, Delivery Charge, Recycling Fee, or Alteration. 

• Typically, the average unit cost of these items is $0. Exceptions are when you sub-let a service to 
an outside company or are purchasing an incidental item, in which case you should enter the unit cost. 

• Assign a tax code, if applicable. 

• Use the Unit of Measure field, if applicable, to specify the sales unit, e.g. hour, each, piece, etc. 
4. Select Save. 

  
Charge for services by the hour 
List service or non-inventory items on documents 
Learn more about using service items 
Collect Government-mandated fees 
Use a service item for shipping charges 

Sell or Recharge a Gift Card 
Redeem a Gift Card | General Payment Procedure 
  
Gift cards are sold or recharged on sales receipts. Up to three gift cards can be sold on a single receipt. The gift 
card item and sales amount are printed on the customer receipt. 
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This topic applies to users of the QuickBooks POS Gift Card Service. What if I use another Service?  
 
Note: If you use the Ingenico 2100 or 3070 PIN pads to swipe cards, you must use the alternate procedure for selling gift cards, 
or set up a separate card reader for gift card sales. 

To sell or recharge a gift card: 
1. Start a new receipt with or without other items listed. 
2. Swipe the gift card while in the Enter Items field on the receipt. Alternatively, type Gift Card and then 

press <Enter> to add a gift card to the receipt item list. 
3. In the window displayed, enter the gift card sale amount and swipe the gift card (or manually enter the 

card number) and then select OK. 
4. Repeat for additional gift cards, up to three on the receipt. 
5. Use general payment procedures to accept the amount due or give change until the Payment Complete 

message is displayed. 
Point of Sale connects to the Gift Card Service and updates the balance for the card(s). Progress and 
confirmation messages are displayed. 

6. Save/print the receipt. 
  

Notes: 
• Price (sale amount) is the only editable field when listing a gift card on a receipt as an item. To sell multiple 
cards, enter each as a separate item. 

• If authorization of the gift card fails for some reason, the card is removed from the receipt. 
Related Topics 
Check a gift card balance 
Replace a lost gift card 
Correct or clear payments 
Gift Card Service overview 

Sell a Gift Certificate 
Redeem a Gift Certificate | General Payment Procedure 
  
A gift certificate is basically "store money" that can be used to purchase merchandise at a future date. When a 
customer buys a gift certificate, there is no net sale. Certificate numbers can be recorded both on the sale and the 
redemption for tracking purposes. 

To sell a gift certificate: 
1. Start a new sales receipt with or without other items listed. 
2. In the Scan or enter item information field of the receipt, begin typing Gift Cert... and then click 
Gift Certificate in the item list displayed. The Sell Gift Certificate dialog is opened. 
3. Enter the amount and certificate number and click OK. 
4. Select a payment type. 

The total amount due from the customer (any purchases plus the gift certificate amount) is suggested in the 
payment dialog. 

6. Use the general payment procedures to take payment and give change. 
7. Save/print the receipt. 

  

Notes: 
• Only one gift certificate can be added to a receipt; either a sale or a redemption. You cannot both sell and 
accept a gift certificate on the same receipt, or sell multiple certificates on a single receipt. 

Related Topics 
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Redeem a gift certificate 
Correct or clear payments 
Learn about gift cards 

Give a Discount 
Make a Sale 
  
There are several ways to discount a sale.  Click the discount type you wish to learn about? 
Manual item discount  

Manual item discounts are applied to line items and are always given against the active price level. 

To manually discount an item on a receipt: 
1. Select an item being sold on the receipt and then click the Qty/Price/Discount button. 

 
• Click a Quick Discount to apply one of the preset discounts (10%, 15%, etc.) 

• To discount by a different percentage, enter the percentage discount in the Discount % field. 

• To discount to a total amount, enter the new amount in either the Unit Price or the  Extended 
Price fields. 
2. Select a Discount Name/Reason if required or desired, from the drop-down list of available 
reasons. 
3. Select OK to close the dialog return to the receipt. 

  

Optional Method 
• Navigate to the Price,  Discount %, Unit Discount , and Discount Name/Reason fields in 
the item list, enter a value, and press <Enter>. You may have to add these columns. 

Notes: 
• When a value is entered in one of the item discount fields, Point of Sale calculates and displays the 
other fields. 

• In general, either the last or largest discount entered will override any previous discount. There is no 
"stacking" of item discounts. For example, if you list an item and manually give a 5% item discount, then 
list a customer with a defined 10% discount and apply it, the customer discount (10%) will replace the 
manually applied item discount. 

• Any time you manually edit the price of an item on a receipt it is considered a discount—even if you 
increase the price, which is counted as a negative discount. This amount will be shown as a discount on 
reports (including X/Z-Out reports). In addition, if you share data with QuickBooks financial software, the 
amount will be transferred to the QuickBooks account defined in Point of Sale company preferences as 
your Merchandise Discount account. 

• Discount reasons  are set up in Price Manager. 
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Global discount (to entire sale)  

A global discount is applied to the subtotal of the document, rather than to individual items. Global discounts 
are not "spread" across the items on the document. 
Exception: For tax calculation purposes, global discounts do reduce the individual item prices. 

To give a global discount on a receipt: 

• From the receipt I Want to Menu, click Give Discount. In the Price & Discount dialog, click a preset 
discount button, or enter another discount percentage or discount amount and click OK. The discount 
amount is carried to the Discount (amount) field in the receipt totals area. 

 
  

(Pro) To give a global discount on a customer order: 

• Enter a percentage discount in the Disc % field or an amount discount in the Discount (amount) field 
in the document totals area. An entry in either field will cause Point of Sale to automatically calculate and 
enter a value for the other field and the document total. 

 
Note: A percentage global discount is calculated on merchandise/service sales only. Sales of gift cards, gift 
certificates, and payments on account are not discounted even though they may be reflected in the document 
subtotal. 

  
Customer discount  

Basic 
A customer discount is a specified percentage off defined on the customer's 
record and suggested on all sales to the customer. Customer discounts are 
given as item discounts against the active price level; they reduce each item on 
the sale by the specified percentage. 

To apply a customer discount: 

• Begin a sales receipt and list the customer on the receipt. You are 
asked if you want to  apply the specified discount to this sale. Answer Yes 
or No. 

Learn more about defining customer discounts and price levels. 
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Pro Note: Customer discounts are also suggested when making a customer order for the customer. 

  
Customer reward  

Pro 
If a customer has an available reward to redeem, you are alerted when taking payment on a qualifying sale. 

 
The dialog lists available rewards, expiration dates, and the new sale total if a reward is applied. Select a 
reward and then click Redeem Now. 
Choose Redeem Later to save the reward for a future sale or Close to return to the receipt to make changes. 
Learn more about customer rewards 

  
Automatic discounts  

Pro 
Price Manger can be used to set up automatic discounts for selected items during a defined time period. Point 
of Sale then automatically applies the discounts to eligible item sales during the period. 
On the sales receipt, discount prices are applied as item discounts 

 
You can give a discount price even if the sale doesn't qualify by selecting the discount name from the drop-
down list in the Discount Name column. You may have to add this column to your receipt form. 
Example: Your Seasonal Clearance discount requires the purchase of 10 logo sport shirts. A good customer 
purchases 6 of the shirts and you decide to give him the discount even though his quantity doesn't qualify him 
for it. In the Discount Name column, select Seasonal Clearance from the drop-down list. 
Read the discount priority and conflict topic for information on how Point of Sale handles situations where a 
customer or the items being sold qualify for more than one discount. 

  
Coupons  

Pro 
Redeeming a coupon is as easy as scanning the coupon bar code (or typing the number below the bar code) 
into the Enter Items field on a sales receipt or customer order. 
The coupon discount will be applied only to qualifying items. 
IMPORTANT: List all items to be sold BEFORE scanning the coupon. The discount is applied only to items 
already on the receipt when the coupon is scanned. 

 
Read the discount priority and conflict topic for information on how Point of Sale handles situations where a 
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customer or the items being sold qualify for more than one discount. 

  
  
While not considered discounts for reporting purposes, you can also use markdown price levels  to give a customer 
a different price. 

Pro Note: The same discount options (except rewards) apply to customer orders. The procedures for applying discounts on 
customer orders is the same, although button names may be slightly different on the customer order forms. Discounts given on a 
customer order are automatically carried to the final sales receipt. 

  

Related Topics 
Discount priority and conflicts 
Discount pricing overview 
How are discounts sent to QuickBooks financial software? 
  

Edit Items Listed on Documents 
List Items | Delete Items | Edit Saved Documents 
  

You can edit an item on a transactional document only until the document has been saved. You can edit items on order 
documents at any time. 

These edits will affect only the listed items on the document; they will not affect the corresponding items in 
inventory. The fields that can be edited vary by document, but typically edits are made to: 

• Change the quantity, price, cost, or give an item discount 

• Change an item’s tax code, when special tax handling is needed 

• Edit the item description; sometimes used on service or non-inventory items 

• (Pro) Enter item serial numbers 

• (Pro) Change the sales Associate on a line-item basis for commission tracking 
The procedure here is for editing an item on a sales receipt. The general procedure is the same on other 
documents, though choices may vary slightly. 

To edit a listed item: 
1. Highlight the item you wish to edit on the receipt.. 

If you just listed the item, it is automatically highlighted and this step is not necessary. 
2. Make edits as necessary: 

• Click Qty + and Qty –  to increase or decrease the item quantity respectively. 

• Select Return Item to change the quantity to negative (a negative quantity adds the item back to 
inventory) 

• Click Qty/Price/Discount to open a dialog allowing you to edit any or all  of these things in a 
single window 

• Click Edit to open the Item Information window to access other editable fields. 

• Or, make changes directly in the item list. You may have to add columns to the list for this option 
to be available. 
3. Make other entries on the document as necessary and then take payment and save. 

  
Related Topics 
List and edit a group Item 
List an item assembly on a document 
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List different units of measure on documents 

Remove Items from a Document 
List Items on Documents | Edit Listed Items 
  
Items listed on a transactional document can be deleted at anytime before the document is saved. Items listed on 
order documents can be deleted at anytime, since order documents are planning documents that do not affect 
inventory. 
These procedures only delete the item from the document. They do not affect inventory. 

To delete listed items: 
Method 1 

1. Display the document form. 
2. Highlight the item(s) you want to delete. 
3. Select Remove This Item in the list or, if you have selected multiple items, select Remove 
Selected Items from the I Want To menu. 

The item is removed from the list. 
  
Method 2 
This method "zeroes out" the item, but leaves it listed on the document. 

1. Highlight the item you want to delete on the document. 
2. Use the Qty + or Qty – buttons to change the quantity to zero. 
3. Press <Tab> or navigate out of the field. 

List a Group Item on a Document 
Group Item Overview | List Items on Documents 

Pro 
Once defined in inventory, a group item can be listed on any document except adjustment memos, though typically 
they are listed on sales receipts and customer orders to sell a collection of items and/or services, optionally at a 
discounted price. 

To list a group item on a document: 

• Follow normal item listing procedures, scanning or entering the group item identifier, rather than the 
individual item identifiers. 

Listing the group item on a document adds all of the items included in the group to the document. This example 
shows a group (baseball package) listed on a sales receipt. 
  

 

Notes: 
• The group item is at the top of the list in bold type, while the component items are displayed in contrasting 
row colors for easy identification. 

• The quantity of each item in the group and the group price is pulled from inventory. The price of each 
component item is proportionally discounted so that the sum of extended item prices equals the group price. 
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• Editing the quantity of the group proportionally changes the respective quantities of the included items. 
Deleting the group item, deletes all component items. 

• You can edit the individual group items on the receipt in the normal fashion; to change quantity, price, give 
additional discounts, etc. Editing a component item does not trigger a recalculation of other items to maintain 
the group price. 

• The printed sales receipt can include the group price only, the individual item prices only (default), or both 
group and item prices. Set this preference on the Sales page of company preferences. 

• You can list additional unrelated items on the same receipt, as necessary. 

List an Assembly Item on a Document 
Assembly Item Overview | List Items on Documents 

Pro 
An assembly item is a discrete item that can be listed on documents, such as sales receipts, in the normal manner. 
When listing an assembly item: 

• The assembly item is listed, the individual component items are not 

• The assembly item price (defined in inventory) and tax code is automatically suggested 

• Normal item editing procedures are available 

• If necessary, an assembly item can be "broken" to free the component items for individual sale 
Related Topics 
Edit listed items 

Handle Special Orders 
Customer Order Overview 

Pro 
A special order refers to the tasks related to ordering, receiving and/or selling custom or one-time merchandise that 
you do not currently carry in inventory and may never carry. 
There are two ways to handle special orders. 

• Customize an Existing Item — With this option you list an existing item on the document and then edit its 
descriptive information to reflect customizations to the item. Use this option when you do not want to create a 
new inventory item, but do want the document and any other related documents (sales receipt referencing a 
 customer order, voucher referencing a purchase order, etc.) to reflect your changes. Editing an existing item 
on a document does not affect the original item’s description in inventory. 

Even though the document reflects the special order edits you have made when selling, purchasing, or 
receiving the item, it is the original item in inventory that is affected as far as on-hand quantity, cost, etc. 
View examples 

• Create a New Special Order Item — With this option, a new special order item is created in inventory. 
You can list the item on a customer order or receipt, generate a purchase order for it, and receive it on a 
voucher. Later, if you decide to carry the new item in inventory, you can convert it to a regular inventory item. 
Special order items can only be added while creating a document (customer order, receipt, voucher, or 
purchase order). 

In a multi-store configuration, the special order item type provides a means for a remote store to create a 
customer order or receipt for a new item and generate a PO for it. The special order item is sent to 
Headquarters with the first transactional document listing it. Headquarters can review the special order item 
and convert it to a regular inventory item, if desired. 
How do I create a new special order item? 

  
If creating a customer order, you can generate a purchase order right from the customer order to obtain the item 
from your vendor. 
  
Related Topics 
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Convert a special order item to an inventory item 
Create a customer order 
Tips for using sales orders 
Add a new item while creating a document 

Record Item Serial Numbers 
List Items on Documents | Find a Document 

Pro 
Item serial numbers can be recorded on documents for purposes of warranty tracking or meeting legal 
requirements. Once recorded, former documents can be quickly located by searching by serial number. 

To record serial numbers: 
1. In inventory, specify those items for which you want to record serial numbers by selecting the 
checkbox for Use Serial #, located in the Misch and Shipping section of the item record. (Note: For an 
existing item, select Edit first.) 
2. When listing these items on documents (except purchase orders and cost memos), you will be 
prompted to enter a serial number for each unit being processed. 

  

Notes: 
• The serial numbers entered are saved and printed on documents. Serial numbers listed on a customer 
order are carried to the sales receipt when the items are sold, saving you the time of re-entering them. 

• The recording of serial numbers on documents is optional, even when you have enabled serial number 
tracking. To continue creation of a document without entering a serial number, click Cancel from the Enter 
Serial Number dialog. 

• You can record serial numbers even when not prompted. After listing the item, click  Edit and make an 
entry in the Serial # field. 

• Point of Sale does not keep track of the serial numbers of items currently in inventory. 

• If you decrease an item quantity on a document after having entered serial numbers, the previous numbers 
are cleared and you are prompted to re-enter numbers for each unit of the revised quantity. This is because 
the program has no way of knowing which specific unit(s) you are removing when you adjust quantities 
downward. 

Locating a Former Document by Serial Number 
You can locate a former document by serial number using search. For example, a former receipt for the sale of an 
item with serial number 23487497 could quickly be located by entering the serial number in the Quick Find  box on 
the home page or in the Search field at the top of your Sales History list and. 

Take Payment/Give Change 

Take Payment and Give Change: General Procedure 
Correct or Clear Payments | Open the Cash Drawer 
  
This topic is the general instructions for taking payment and giving change on a sale. 
To see instructions for a specific payment type, click a link:  credit card, debit/ATM card, check, gift certificate, gift 
card, or account charge/store credit. 
When you have completed the receipt, the total Amount Due is shown at the bottom of the receipt. To the left of 
the amount due are the payment buttons, one for each payment type you accept. In the example shown, Debit is 
not an accepted payment type so is grayed out. 



Printed Documentation 

234 

 
Set sales preferences - Define the accepted payment types, a default payment type, and other sales options. 

To take payment and give change: 
You can accept the full amount by one payment type or split the payment over multiple types. 

1. Click the button for a payment type. 
The Amount field for the selected payment type shows the total amount 
due, in this case $75.37.  

2. Accept or enter the amount tendered by the customer: 

• If the customer tenders the exact full amount by this payment type, simply click OK. 

• If customer tenders a different amount, enter the new amount over the old amount. For example, 
if the customer gives you $80 cash for this $ 75.37 sale, type 80 over the 75.37. It is not necessary to type 
the decimal point and zeroes after the 80.   

3. Enter (or scan) any additional information requested for this payment method, such as check number or 
credit card information. Follow the instructions in the dialog to complete the payment. 

You are returned to the receipt, with the accepted payment type flagged (with a check mark). 
4. If there is a remaining balance due, repeat Steps 1-3 for each additional payment 

type until the amount tendered meets or exceeds the total amount due.   
5. If change is due the customer, it will default to cash change and be displayed in 

the Totals area of the receipt. 
To give change by a type other than cash, click the appropriate payment button. The 
selected payment dialog opens, this time with the change option pre-selected (refund, 
credit, sale of gift card, etc.) . Enter any requested information and save. 

6. Click Print Receipt and follow the print instructions. 
Alternatively, select Save Only to record the sale without printing the receipt. 
On applicable sales, the cash drawer opens and the change window is displayed to remind you of the change 
amount and type to give the customer. 

  
Tip: Give cash back while ringing up a purchase  
Tip: Handle payment by travelers check  
  
Related Topics 
Print gift receipts 
Make a sale 
Take customer order deposits 

Specific Payment Methods 
Payment Overview | Correct or Clear Payments 
  
Read the following topics for details about processing different payment methods at point of sale. 
Payment by cash 
Payment by credit card 
Payment by debit/ATM card 
Payment by check 
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Charge to customer account (or apply store credit) 
Take a payment on customer account (or give store credit) 
Redeem a gift card 
Redeem a gift certificate 
Tip: Handling payment by travelers check 
  
Related Topics 
Merchant Service overview 
Gift Card Service overview 
Make a sale 
Merchandise returns 
Sales overview 

Take Payment or Give Change by Check 
Payment Overview | Correct or Clear Payments 

To accept a check as payment: 
1. Click the Check button on the receipt. The check dialog is displayed with the balance due in the 
Amount field. 

 
2. Ensure that Accept Check is selected and enter the check amount and number. 
3. Click Save. 

You are returned to the receipt, with the check payment shown in the totals area and the Check button flagged 
(with a check mark). 
If the check amount was more than the purchase amount, the balance is shown as cash change 
to give the customer. 

To give change by check: 
After taking an overpayment, change is always defaulted to cash on the receipt. Use this procedure to write a store 
check to give change instead:   

1. Click the Check button. 
2. On the Check dialog, ensure that Write Check is selected, and then enter the check amount and 
check number. 
3. Click Save. The receipt totals area is updated to show the check issued as change. 

  
Tip: Take payment by travelers check  
  

Basic/Pro Notes 
• Whether or not checks should be accepted from a given customer is recorded in the Accept Checks field 
on the customer’s record. If check is selected as the payment method and the customer's record indicates 
that checks should not be accepted, you are alerted. 
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• An employee with sufficient security rights can override a customer’s Do not Accept Checks setting and 
accept a check anyway. An employee that does not have security rights to do so cannot accept a check as 
payment from such a customer, but an employee with override rights can log in over the first employee and 
accept the check at their discretion. (Refer to Employees and Security for more information about setting 
security rights.) 

Related Topics 
Open the cash drawer 
Other payment methods 
Make a sale 
Sales overview 

Take Payment by Credit Card 
Payment Overview | Credit Card Refunds 
  

This topic applies to users of the QuickBooks POS Merchant Service. What if I use another Service? 

To take full payment by one credit card: (modifications for splitting payment are covered here) 
Note for users of the Ingenico eNcrypt 2100 or 3070 PIN pad  

1. Click the Credit payment button. 
The Credit payment dialog is opened, with default options: 

 
• Charge card as the transaction type 

• Swipe as the transaction method 

• The total sales amount pre-filled in the Amount field 
2. Swipe the credit card. (recommended) 

Or 
Select Manual Entry, enter the card information and ZIP code, and optionally the fraud prevention information, 
and then select Authorize Now. At the prompt, specify whether the card is present or not. 
Or 
Select Voice to complete a voice authorization. This is recommended only if  your connection to the processor 
is down or you are requested to do so. 

4. Point of Sale connects to the Merchant Service to obtain authorization. 
If all of the following are true, Point of Sale will process the transaction and print the receipt without further 
action on your part. This allows you to return to servicing the customer. 

• The card was swiped (rather than manually entering card information) 

• The transaction is authorized 

• You are configured to automatically save/print upon authorization 
If any of these are not true, continue with the following steps. 

5. You will see one of the following messages: 
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Authorized: The charge has been approved. Select OK to close the window. 
Declined: The charge was not approved. Select Cancel to return to the payment screen. Ask the customer to 
provide a different form of payment, or select Authorize to try again. 
Referral: Voice authorization is required. Call the number listed on-screen and give the operator your 
Merchant Number. Enter the authorization number the operator gives you in the Voice Auth Number field 
 and click Authorize Now. 
Failed address or card verification check: The address or card verification code entered does not match 
the issuer’s records. Depending on your merchant service preferences, you may be allowed to continue or the 
transaction may be automatically voided. 

View the Address and Card Verification Results Guide  
6. Wait for the receipt to print, if configured to print automatically 

Or 
Select Save & Print to record and print the receipt. 

7. Have the customer sign the merchant copy of the receipt. 
  
Return to top 

Notes: 
• By default, the program is configured to print two copies of credit card receipts —one for the customer and 
one for the merchant (signature copy). If you are using double-ply paper, you may want to turn off this 
preference. Point of Sale is also set by default to pause between printouts so you have time to tear off the 
receipts. 

• Although credit card transactions are authorized immediately, funds are not transferred from the 
cardholder’s account to yours until transactions are settled by running the End of Day procedure. 

Related Topics 
Specify the credit cards you accept 
Cancel or reverse credit card charges 
Credit card fraud prevention tips 
Hardware requirements for Merchant & Gift Card Services 
General credit card guidelines 
Merchant Service FAQs 

Take Payment by Debit/ATM Card 
Payment Overview | Void a Debit Card Payment 
  

This topic applies to users of the QuickBooks POS Merchant Service. What if I use another Service? 

To take full payment with one debit card: (modifications for splitting payment are covered here) 
Note for users of the Ingenico eNcrypt 2100 or 3070 PIN pad  

1. Click Debit as the payment type. 
The Debit Card dialog is opened with the full sale amount pre-filled in the Amount field. 

3. Swipe or have customer swipe the debit card and, if allowed, select a cash back amount. 
4. Click Authorize. 
5. Have customer enter their PIN and select OK on the PIN pad. 
6. Have customer approve the total transaction amount by selecting OK. 

Point of Sale connects to the Merchant Service to obtain authorization. 
If both of the following are true, Point of Sale will process the transaction and print the receipt without further 
action on your part. This allows you to return to servicing the customer. 

• The transaction is authorized 
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• You are configured to automatically save/print upon authorization 
If either of these are not true, continue with the following steps. 

6. You will see one of the following messages: 
Authorized: The debit has been approved. Select OK to close the card dialog. 
Declined: The debit was not approved. Select Cancel to close the Debit window and return to the payment 
screen. Ask the customer to provide a different form of payment. 

7. Wait for the receipt to print, if configured to print automatically 
Or 
Select Save & Print to complete and print the receipt. 

8. If applicable, the change window displays the cash back amount to give the customer. Select OK to close 
the window. 

Return to top 
  
Related Topics 
Connection failed messages 
General debit/ATM card guidelines 
Hardware requirements for Merchant & Gift Card Services 
Configure debit preferences 
Merchant Service reports 
Merchant Service FAQs 

Redeem a Gift Card 
Sell a Gift Card | General Payment Procedure 
  

This topic applies to users of the QuickBooks POS Gift Card Service. What if I use another Service? 

To redeem a gift card on a purchase: 
1. After listing the items being sold, select the Gift payment type and then select Gift Card. The Gift 
Card dialog opens. 
2. Be sure Redeem Card is selected and enter the amount in the Amount field.  
3. Press <Enter>.  
4. Swipe the gift card. 
 
Or 
 
Enter the gift card number manually and select Authorize. 

• Point of Sale connects to the Gift Card Service and checks the balance of the card and a 
confirmation message displayed: 

• If the card balance is equal to or more than the amount due, the payment amount is deducted 
from the card balance and payment is complete. 

• If the card balance is less than the amount due, the card balance is adjusted to zero and the 
authorized amount is auto-populated to the Gift Card Redeem field. You will need to take additional 
payment by another gift card or any other method for the remaining amount due. 
5. Save/print the receipt. 

  
  

Notes: 
• Up to three gift cards can be sold/redeemed on a single receipt. 
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Related Topics 
Check a gift card balance 
Replace a lost gift card 
Correct or clear payments 
Make a sale 
Gift Card Service overview 

Redeem a Gift Certificate 
Sell a Gift Certificate | General Payment Procedure 

To redeem a gift certificate on a purchase: 
1. After listing the items being sold, select the Gift payment type and then select Gift Certificate. 
The Gift Certificate dialog opens. 
2. Ensure that Redeem a gift certificate is selected and then enter the certificate amount and 
number. 
3. Click Save. 
4. Take additional payments and/or return change, if necessary. 
5. Save/print the receipt. 

  
Related Topics 
Correct or clear payments 
Learn about gift cards 

Charge a Purchase to Customer Account (or Apply a Credit) 
Maintain Customer Accounts | Take Payments on Account 

Basic  

Use this procedure to charge a purchase to a customer's account or to apply a store credit to a sale. 

Note: Applying a store credit is essentially the same as charging a purchase on account and the same procedure is used. 

To charge a sale to a customer’s account: 
1. List the items and customer on the receipt. 
2. Click the Account payment button. The Charge Account dialog is opened with Charge to 
account pre-selected and the full sale amount suggested in the Charge Amount field. The customer's 
current account balance is displayed for reference. 

 
3. To charge the full amount to the customer's account, just click Save. 

To charge other than the full amount, type the new amount and then click  Save. 
4. If only a portion of the purchase amount was charged, take payment for the remaining balance by 
another payment type. 
5. Save and print the receipt. 
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Notes: 
• You must enable account charges and assign an account limit on the customer record before the account 
charge option is available. If you attempt to enter an account charge on a non-account customer, and you 
have security rights to edit account information, Point of Sale will prompt you to enable charges and set a limit 
directly from the sales receipt. 

• The customer's account balance and available credit is immediately updated on the customer's record at 
this store. 

• Point of Sale will block additional charges if insufficient credit is available. The block can be overridden by 
an employee with adequate security rights or by using the manager override function. 

• You can configure Point of Sale to print two copies of account charge receipts —one for the customer and 
a signature copy for you to keep. 

If Point of Sale is integrated with QuickBooks Financial Software the following also apply: 

• On the next Financial Exchange, the account charge receipt is sent to QuickBooks and posted to the 
customer’s account. 

• QuickBooks will return the new account balance and any amount past due so that you have an updated 
balance and available credit amount to reference on the next sale. 

• Account statements can be sent to customer's from QuickBooks. Customer payments on account can be 
entered in either program and will update the balance in the other with the next Financial Exchange. 

Related Topics 
Take a payment on account 
Make a sale 
Correct or clear payments 

Correct or Clear Receipt Payments 
Take Payments | Sales Overview 
  
If a payment is entered in error, it can be corrected or cleared anytime prior to saving the receipt. See the notes 
below this procedure for restrictions and additional information on clearing specific payment types. 

To correct or clear receipt payments: 
1. Click the payment button for the payment type/change that was entered in error. 
2. Click Remove this Payment to remove the amount. 

• For some payment types, the remove option is labeled Void. 
3. Enter new payment amounts/types to complete the sale. 
4. Save and/or print normally. 

  

Notes: 
• If the receipt has already been saved, you cannot remove payment types, you will have to reverse the 
receipt and create a new one instead. 

• If a credit card payment has already been authorized, but the receipt not yet saved, the charge will be 
voided and does not appear on the cardholder’s statement. Enter revised payment information and save/print 
normally. Learn more. 

• Voiding a gift card transaction results in the amount being returned (or subtracted) from the gift card 
balance. Point of Sale connects to the service again to adjust the card balance. 

• Debit payments, if authorized via the QuickBooks POS Merchant Service, have already affected the 
customer’s bank account. Debit payments cannot be refunded to the debit card. Therefore, a debit payment 
cannot be deleted from the receipt, nor can the receipt be canceled or voided. The receipt must be finished 
as is, or the cashier can manually enter an equal amount by another payment and change method, such as 
cash, to balance the receipt and refund the debit amount to the customer. 
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• Any information related to the deleted payment (e.g., check or gift certificate number) are cleared. 

• (Pro) If deposits have been used as payment on the sale (as might be the case when selling customer 
order items), clearing the deposit will return it to the referenced order. 

Related Topics 
Specific payment methods 

Sales Tax 

Sales Tax Overview 
How do I?  | Tax FAQs 

Set up sales tax 
Use sales tax codes 
Use sales tax locations 
Associate a customer with a tax location or as tax-exempt 
Applying tax to sales 
Collect multi-rate taxes 
Collect tax based item price thresholds 
Collect tax on shipping amounts 
Run sales tax reports 
Send tax information to QuickBooks 

  
  
If you charge sales tax, you can setup a sales tax structure in Point of Sale so that sales taxes are automatically 
collected on sales of taxable merchandise or services. 
How taxes are applied to sales depend on the tax codes and tax locations you have set up. 

• Tax codes specify the specific taxing instructions (taxable or not, tax rate, if price-dependent, and other 
tax options) and are assigned to your items in inventory. Learn more. 

• Tax locations allow you to customize the taxing instructions for each of your tax codes based on where 
the item is sold or to whom it is sold. Learn More. 

A simple tax structure might have just two tax codes, one for taxable merchandise and one for non-taxable 
merchandise, in a single tax location with a single tax rate. If you entered a tax rate during the Setup Interview, 
such a structure was set up for you, using two default tax codes and one default tax location. 
If your tax requirements aren't that simple, you can set up additional tax codes, tax locations, and other options in 
company preferences. Point of Sale provides support for the collection of different tax rates based on merchandise 
categories, item price thresholds, where an item is sold, to whom it is sold, and collection and reporting for multiple 
taxing agencies. 
When you make a sale, sales tax is automatically calculated and added to all taxable items according to your tax 
setup. Customers can be flagged as tax exempt or assigned to a specific tax location, so that the correct sales tax 
is automatically calculated on sales to that customer. You can also change tax codes or locations on individual 
sales if needed for special circumstances. 
Point of Sale provides sales tax reports to help you make your tax payments to the taxing agency or agencies. If 
integrated with QuickBooks financial software, Point of Sale sends sales tax information to QuickBooks along with 
other sales information each day. Sales tax reports can be ran in Point of Sale or in your financial software, broken 
out by tax codes, tax agency, store, or tax location for any time period. 
  
Return to top 

Apply Tax to Sales 
Sales Tax Overview | Sales Tax FAQs | Configure Sales Tax 
  
If you are configured to collect sales tax, the tax is automatically calculated and applied to each sale: 
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• The sales tax locations and sales tax codes you have set up in company preferences 

• How your tax codes are assigned to inventory items 

• (Basic) Whether or not the customer has been assigned to a sales tax location or flagged as tax-
exempt, in which case you are prompted to collect (or not collect) tax appropriately 

• (Pro) If you have multiple stores, the default tax location selected at each store 
If necessary, the tax code assigned to an item or the tax location applied to the entire sale can be manually 
changed on a sales receipt before saving. 

To change the tax code of an item being sold: 
1. List the item on the document. 
2. Highlight the item and then click Edit. 
3. On the Item Properties dialog, select a new tax code from the drop-down list in the Tax Code 
field. 
4. Click OK. 

The item tax amount and the receipt total are recalculated. 

To change the tax location for the entire sale: 
1. With the  receipt displayed, select Change Tax Location from the I Want To menu. 
The Change Tax Location window is displayed. 
2. Select a new tax location. 
3. Choose Select to close the window. 

This change can be made before or after items are added to the receipt.  If items were previously added, the sales 
tax will be recomputed to reflect the new tax location. 
  

Pro Note: The same procedures apply to customer orders. You can also change the tax code directly in the item list on Customer 
Orders, if the Tax Code column is displayed. 

  
Related Topics 
How do I change the default tax location used for all sales at my store? 
How do I collect tax on shipping amounts? 
How do I collect tax only when an item’s unit price exceeds a set threshold? 

Company Preferences: Sales Tax 
Preference Instructions | Tax Overview | Tax FAQs 
  

Pro Note: If you have multiple stores, sales tax must be set up at Headquarters. Remote stores can select the default tax location 
applicable to sales at their store on this page. 

  
Use the procedures below to set up the collection of sales tax in Point of Sale. You can add or edit tax codes or 
locations, and set specific taxing instructions for each. We recommend you set up all of the tax codes you will use 
in the default tax location first, then add additional tax locations and edit the codes for each as necessary. 
From the File menu, select Preferences > Company and then select Sales Tax from the list on the left. 

To specify that you collect sales tax: 

• Select (check) the Collect Sales Tax checkbox. Clear the checkbox if you do not collect sales taxes. 
Adding or editing a tax code  

If you use multiple tax locations, adding or deleting a tax code in one location adds or deletes that code in all 
locations. If the taxing instructions for a code are different in different locations, edit the tax code as appropriate 
for each affected location. Editing a tax code in one location does not affect that tax code in other locations. 
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To add or edit a tax code: 
1. Select Add Tax Code or Edit Tax Code within a tax location. You may have to scroll the 
page to view all of your choices. 

The Add/Edit Tax Code Wizard is displayed. Select Next or Back to move between pages of the Wizard. 
2. Enter or edit the Tax Code (3-character maximum) and Tax Name, specify the tax rate(s), 
and set other tax options for this code as appropriate. Select Help (<F1>)on any page for more 
information about the settings on that page. 
3. When done, select Finish. 
4. Specify the default tax code when creating a new department at the bottom of the preference 
page. 

The taxing instructions of the specified code, as defined for your default tax location (see below), will be 
suggested for new departments and to the items in that department. 

5. Select Save. 

• If a tax code is no longer needed, it can be deleted by selecting Remove to the right of the 
window. 

  
Adding or editing a tax location  

1. Select Add Tax Location or Edit Tax Location, as applicable. You may have to scroll the 
page to view all of your choices. 

The Tax Location Wizard is displayed. 
2. Enter or edit the Tax Location Name. 

(Pro) If shipping charges in this location are taxable, select the checkbox for that option and select a tax 
code to assign to the shipping charges. 

3. Select OK. 
4. Add or edit your tax codes for this location, if necessary (see above). 
5. Select the default tax location for this store at the bottom of the page. 

The taxing instructions of the specified location will be the default for all sales. 
6. Select Save. 

The first tax location in the list, named Local Sales TAXES, cannot be deleted, but it can renamed or edited to 
specify additional taxing instructions. Other tax locations can be deleted by selecting Remove to the right of the 
window. 
  

Basic Note: The tax location Exempt is hard-coded and not displayed in your tax preferences. This location is used for 
customers you have marked as tax-exempt and has an automatic 0% tax rate for all tax codes. You can filter sales reports by 
this hidden tax location. 

  
  
Related Topics 
How do I use tax codes? 
How do I use tax locations? 
Sales tax Integration with QuickBooks financial software 

Sales Tax Codes 
How do I?  | Tax FAQs | Tax Overview 

Set up sales tax 
Use sales tax locations 
Associate a customer with a tax location or as tax-exempt 
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Applying tax to sales 
Collect multi-rate taxes 
Collect tax based item price thresholds 
Collect tax on shipping amounts 
Run sales tax reports 
Send tax information to QuickBooks 

  
  

Pro: If you have multiple stores, sales tax codes must be set up at Headquarters. 

Sales tax codes identify the specific taxing instructions for sales of the inventory items to which they are assigned. 
Once you have defined your tax codes, you assign them to your inventory items so the correct tax is collected. If all 
the items in a department are taxed the same, associate a tax code with the department record and all new items 
added to the department will automatically be assigned this tax code. 
The simplest of tax structures might just include two sales tax codes: taxable and non-taxable. However, you may 
need to collect different tax rates for certain items, to tax items differently depending on their price, or collect and 
pay taxes to multiple agencies. In these cases, a separate tax code can be defined and then assigned to applicable 
items in inventory. 
  
Example: Collecting different tax rates by merchandise category  
Example: Single-rate, price-dependent tax codes  
Example: Multi-rate tax code, for different agencies and/or price thresholds  
  
Sales tax codes are defined on the Sales Tax page of company preferences. 
  
Using Tax Codes in Conjunction with Tax Locations 
Tax locations can be used to have different taxing instructions for sales of the same items depending on the 
geographic location (e.g. out of state sales) or to meet special customer tax needs. Learn more. 
  

Notes: 
• In inventory, assign tax codes to your items based on the class of merchandise they fall in. Select the 
correct tax code from the drop-down list in the Tax Code field on the item record. 

• If you use multiple tax locations, adding or deleting a tax code in one location adds or deletes that code in 
all locations. If the taxing instructions for a code are to be different in different locations, edit the tax code as 
appropriate for each affected location in company preferences. Editing a tax code in one location does not 
affect that tax code in other locations. 

• If a tax code is no longer needed, it can be deleted. However, be aware that deleting a tax code from one 
tax location deletes it from all locations. If the deleted code is assigned to items in inventory, you will have to 
reassign those items to another tax code. 

• When using price thresholds to determine if an item sale is taxable, you can also specify whether tax is 
applied to the entire item price, just the amount over the threshold, or just the amount within a price range. 

Assign Sales Tax Codes to Items 
Sales Tax Overview | Set Up Sales Tax 
  
The tax code assigned to an item determines if and how much sales tax is collected when the item is sold. 
By default, all new items added to inventory are assigned a default tax code based on the department to which the 
item belongs. 
The tax code may be changed for individual items in inventory, as necessary. 

To assign an item tax code: 
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1. Add a new item or select Edit for an existing item. 
2. Navigate to the Tax field in the Basic Info section and select the appropriate tax code from the 
drop-down list. 
3. Click Save. 

  
Related Topics 
Apply Tax to Sales 
Collect Tax on Shipping Amounts 

Sales Tax Locations 
How do I?  | Tax FAQs | Tax Overview 

Set up sales tax 
Use sales tax codes 
Use sales tax locations 
Associate a customer with a tax location or as tax-exempt 
Applying tax to sales 
Collect multi-rate taxes 
Collect tax based item price thresholds 
Collect tax on shipping amounts 
Run sales tax reports 
Send tax information to QuickBooks 

  
  

Pro: If you have multiple stores, sales tax locations must be set up at Headquarters. Remote stores can select the default tax 
location applicable to sales at their store in company preferences. 

  
Sales tax locations can be used to define different taxing instructions for each of your tax codes to handle sales in 
different tax jurisdictions or for customers that qualify for special tax rates. 
One default tax location named Local Sales Tax is defined for you; you can rename this location if you want. The 
use of additional tax locations is optional. 
  
Sales tax locations are configured on the Sales Tax page of company preferences. 
  
Example: Tax-Free Sales Based on Customer Location  
Example: Selling to Customers with Special Tax Handling  
Example: Stores in Different Tax Jurisdictions  
  

Notes 
• A second tax location, named Exempt, is hard-coded and not displayed in your sales tax preferences. This 
location is used for customers you have marked as tax-exempt and has an automatic 0% tax rate for all tax 
codes. You can filter sales reports by this hidden tax location. 

• If you use multiple tax locations, adding or deleting a tax code in one location adds or deletes that code in 
all locations. 

• If the taxing instructions for a code are different in different locations, edit the tax code as appropriate for 
each location. Editing a tax code in one location does not affect that tax code in other locations. 

Related Topics 
Associating a tax location with a customer 
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Changing tax locations at time of sale 

Sales Tax: Price-Dependent Taxes 
Tax FAQs | Tax Reports | Tax Overview 
  
Point of Sale supports the collection of sales tax based on the item unit price. The price threshold can be set up as 
a minimum price, maximum price, or price range that triggers the collection of tax. You can collect tax on the entire 
price of the item or just that portion of the price that falls blow, exceeds, or is within the specified price range. 
Combined with Point of Sale's multi-rate tax option, you can define a tax code with almost any combination of price 
thresholds and tax rates to meet the tax requirements of one or multiple taxing agencies. 
  
Example: Single-rate, price-dependent tax codes  
Example: Multi-rate tax code, for different agencies and/or price thresholds  
  

To set up price-dependent taxes: 
1. Follow the general instructions for add/edit a tax code in company preferences. 
2. On the Tax Options page of the Tax Code wizard, select either Price-dependent single-rate tax 
or Multi-tax rate, depending on your needs. 
3. Follow the on-screen instructions (select Help if necessary) in the wizard for assistance in setting 
up your price thresholds and options. 

If tax is collected only on the amount exceeding the price threshold, or within the specified price range, be sure 
to select the checkbox indicating such. 
  

 
Example price-dependent, single-rate tax setup 

  
4. Select Save. 

When done configuring your taxes, be sure to assign tax codes to applicable items in inventory. 
  
Notes: 

• If setting up a multi-rate price-dependent tax code, select the Test button on the last page of the wizard to 
verify the taxes collected at various prices. 
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• If an entire department is subject to the price threshold, assign this tax code as the default department tax 
code in the department record. In this way, all new items added to the department are automatically assigned 
this tax code. 

• If you use multiple tax locations, adding a tax code to one location adds it to all of your locations. If the 
taxing instructions need to be different for each location, select Edit Tax Code under affected locations and 
revise the instructions that apply to that location. 

• If taxable shipping charges are assigned this tax code, the threshold identified here applies to shipping 
amounts as well. If shipping amounts are not subject to a threshold, set up and use a different tax code for 
them. See collect tax on shipping amounts for more information. 

Related Topics 
Use sales tax codes 
Use sales tax locations 
   
Sales Tax: Using Multi-Rate Tax Codes 
Tax FAQs | Tax Reports | Tax Overview 
  
A Point of Sale tax code can include up to three separate tax rate components, each collecting a portion of the total 
tax rate. 
This allows you to track taxes payable to different agencies (city, county, and state, for example) and/or to collect 
tax for each component based on item unit price thresholds or price ranges. 
Your sales tax reports can be set up to sort and subtotal taxes by tax agency or tax components, depending on 
how you have to report and pay them. 
Examples of multiple tax rate components in a tax code  
To set up a multi-rate tax code in Point of Sale, follow the instructions provided here. 
  

Alternative Method of Collecting Taxes for Multiple Agencies 
This method requires that you are integrated with QuickBooks financial software. You collect a single combined tax 
rate in Point of Sale and use a tax group in your financial software to break out the taxes payable to each agency 
on tax reports. 
Example: You are required to collect and pay 0.5% sales tax to your city, 1.5% to the county, and 5.25% to the 
state. 

1. In QuickBooks, set up a sales tax group, comprised of the three agencies and individual rates. 
Refer to your QuickBooks documentation or in-program help for instructions. 
2. In Point of Sale, set up a sales tax code, selecting Single-Rate Tax and entering just the total 
combined tax rate (i.e. 7.25%). The agency name you enter for the Point of Sale tax code won’t effect how 
the information is transferred to QuickBooks but will show up on sales tax reports ran in Point of Sale. You 
may want to enter Combined Sales Tax or similar. 
3. In the QuickBooks Information area of the Edit Tax Calculation page in Point of Sale, select the 
QuickBooks tax group from the drop-down list labeled Assigned to QuickBooks Tax Item/Group, and 
then select the corresponding QuickBooks tax code in the second drop-down list. 

Sales taxes collected in Point of Sale are sent to QuickBooks and your sales tax reports in QuickBooks will 
separate the taxes due to each agency. 
  

Notes: 
• When printing a receipt where multiple tax rates have been collected, the Tax % field is left blank. 

Related Topics 
Use sales tax codes 
Sales tax integration with QuickBooks 

Sales Tax: Collecting on Shipping Amounts 
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Tax FAQs | Tax Reports | Tax Overview 
  
(Free, Basic) To collect sales tax on shipping amounts, set up a service item called "Shipping Charges" or similar 
and assign the appropriate tax code to it. List this item on sales receipts and edit the amount for the specific sale. 
(Pro) To collect sales tax on shipping amounts, edit your tax location(s) and select the checkbox labeled Shipping 
to this location is taxable… and specify the tax code that should be used for the shipping amount. 
Sales tax will be calculated on the shipping amount and added to the sale according to the instructions specified for 
the tax code assigned. 
  
Related Topics 
Set up sales tax 
Use sales tax codes 
Use sales tax locations 
Assign tax codes to items 

Using Customer Tax Locations and the Tax-Exempt Flag 
Sales Tax Overview | Using Tax Locations 

Basic  

There are two ways You can automatically have Point of Sale collect the correct amount of sales tax on sales to 
customers that qualify for special tax handling. 

• Specify that the customer is tax-exempt. This is the easiest option if sales tax is never charged on sales 
to the customer, such as may be the case with charitable organizations or certain re-sellers. 

Example: The customer is from another state and your tax regulations do not require sales tax to be collected 
on out-of-state sales. 
  

A hard-coded tax location, named Exempt, is used on sales to customers you have marked as tax-exempt and has an 
automatic 0% tax rate for all tax codes. The Exempt tax location is not displayed in your sales tax preferences, but is 
available for filtering sales reports. 

• Set up and assign a tax location to the customer. This option is best if the customer is taxed, but at a 
different rate than your normal tax rates. You are prompted to apply the customer tax location when making a 
sale to the customer, but can elect to do so or not on individual sales. 

To set up special customer tax handling: 
1. While adding or editing a customer record, select the Customer Settings section. 
2. Select a tax location from the Tax Location drop-down list. Only tax locations previously set up in 

company preferences are available. 
Or 
Select the Tax-exempt checkbox. 
3. Complete the record and save. 

  
Related Topics 
Edit a customer record 
Customers overview 

Sales Tax: Reports 
Tax FAQs | Tax Overview | Reports Overview 
  
Point of Sale offers two reports for viewing the sales tax amounts you have collected: 

• Sales Tax Summary – Sales tax collected in a specified date range, sorted and totaled by tax 
location/code. 
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• Tax Activity Detail – Journal of all taxable sales receipts in a specified date range. 
Either report can be modified to filter, sort, and display your tax information in the manner you prefer, and 
memorized if you wish to use the same settings for the future. 

To view sales tax reports: 
1. From the Point of Sale Reports menu or Report Center, choose Sales. 
2. From the Sales sub-menu, select either Taxes – Sales Tax Summary or Taxes – Tax Activity 
Detail. 

Point of Sale displays the report. 
3. Modify the report date range, included tax locations an codes, or other options as necessary. 

Point of Sale displays the report with your changes. 
  
If you also use QuickBooks financial software, you can view sales tax reports in that program as well. Refer to your 
QuickBooks documentation for instructions. 

Sales Tax Integration with QuickBooks 
Tax FAQs | Tax Reports | Tax Overview 
  
Sales tax amounts collected in Point of Sale are sent to QuickBooks financial software according to the sale tax 
mappings specified for each Point of Sale tax code used. Tax codes and the QuickBooks tax mappings used by 
Point of Sale are defined on the sales tax page of company preferences. 
When configuring your Point of Sale sales taxes, you can leave the QuickBooks tax mappings blank and Point of 
Sale will automatically create matching tax items and codes in your QuickBooks financial software. 
  
View example  
  
If you set up a Point of Sale multi-rate tax code, one tax item is created in QuickBooks for each component rate 
included in the code. 
  
Custom Mapping of Sales Tax to QuickBooks 
If you prefer, and you have already set up sales tax items/codes in QuickBooks, you can manually map your Point 
of Sale tax codes to those when setting up your tax codes in Point of Sale. 
If you are required to collect and pay sales taxes to multiple agencies (city, county, and state, for example) you 
should set up a sales tax group in QuickBooks and then map your Point of Sale tax code(s) to the group. Learn 
more. 
  
Related Topics 
Setting up sales tax in QuickBooks 
Setting up sales tax codes in Point of Sale 
Using sales tax codes 
Using sales tax locations 
Assigning tax codes to items 
  

Sale Prices and Discounts 

Give a Discount 
Make a Sale 
  
There are several ways to discount a sale.  Click the discount type you wish to learn about? 
Manual item discount  

Manual item discounts are applied to line items and are always given against the active price level. 
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To manually discount an item on a receipt: 
1. Select an item being sold on the receipt and then click the Qty/Price/Discount button. 

 
• Click a Quick Discount to apply one of the preset discounts (10%, 15%, etc.) 

• To discount by a different percentage, enter the percentage discount in the Discount % field. 

• To discount to a total amount, enter the new amount in either the Unit Price or the  Extended 
Price fields. 
2. Select a Discount Name/Reason if required or desired, from the drop-down list of available 
reasons. 
3. Select OK to close the dialog return to the receipt. 

  

Optional Method 
• Navigate to the Price,  Discount %, Unit Discount , and Discount Name/Reason fields in 
the item list, enter a value, and press <Enter>. You may have to add these columns. 

Notes: 
• When a value is entered in one of the item discount fields, Point of Sale calculates and displays the 
other fields. 

• In general, either the last or largest discount entered will override any previous discount. There is no 
"stacking" of item discounts. For example, if you list an item and manually give a 5% item discount, then 
list a customer with a defined 10% discount and apply it, the customer discount (10%) will replace the 
manually applied item discount. 

• Any time you manually edit the price of an item on a receipt it is considered a discount—even if you 
increase the price, which is counted as a negative discount. This amount will be shown as a discount on 
reports (including X/Z-Out reports). In addition, if you share data with QuickBooks financial software, the 
amount will be transferred to the QuickBooks account defined in Point of Sale company preferences as 
your Merchandise Discount account. 

• Discount reasons  are set up in Price Manager. 

  
Global discount (to entire sale)  

A global discount is applied to the subtotal of the document, rather than to individual items. Global discounts 
are not "spread" across the items on the document. 
Exception: For tax calculation purposes, global discounts do reduce the individual item prices. 

To give a global discount on a receipt: 

• From the receipt I Want to Menu, click Give Discount. In the Price & Discount dialog, click a preset 
discount button, or enter another discount percentage or discount amount and click OK. The discount 
amount is carried to the Discount (amount) field in the receipt totals area. 
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(Pro) To give a global discount on a customer order: 

• Enter a percentage discount in the Disc % field or an amount discount in the Discount (amount) field 
in the document totals area. An entry in either field will cause Point of Sale to automatically calculate and 
enter a value for the other field and the document total. 

 
Note: A percentage global discount is calculated on merchandise/service sales only. Sales of gift cards, gift 
certificates, and payments on account are not discounted even though they may be reflected in the document 
subtotal. 

  
Customer discount  

Basic 
A customer discount is a specified percentage off defined on the customer's 
record and suggested on all sales to the customer. Customer discounts are 
given as item discounts against the active price level; they reduce each item on 
the sale by the specified percentage. 

To apply a customer discount: 

• Begin a sales receipt and list the customer on the receipt. You are 
asked if you want to  apply the specified discount to this sale. Answer Yes 
or No. 

Learn more about defining customer discounts and price levels. 

Pro Note: Customer discounts are also suggested when making a customer order for the customer. 

  
Customer reward  

Pro 
If a customer has an available reward to redeem, you are alerted when taking payment on a qualifying sale. 
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The dialog lists available rewards, expiration dates, and the new sale total if a reward is applied. Select a 
reward and then click Redeem Now. 
Choose Redeem Later to save the reward for a future sale or Close to return to the receipt to make changes. 
Learn more about customer rewards 

  
Automatic discounts  

Pro 
Price Manger can be used to set up automatic discounts for selected items during a defined time period. Point 
of Sale then automatically applies the discounts to eligible item sales during the period. 
On the sales receipt, discount prices are applied as item discounts 

 
You can give a discount price even if the sale doesn't qualify by selecting the discount name from the drop-
down list in the Discount Name column. You may have to add this column to your receipt form. 
Example: Your Seasonal Clearance discount requires the purchase of 10 logo sport shirts. A good customer 
purchases 6 of the shirts and you decide to give him the discount even though his quantity doesn't qualify him 
for it. In the Discount Name column, select Seasonal Clearance from the drop-down list. 
Read the discount priority and conflict topic for information on how Point of Sale handles situations where a 
customer or the items being sold qualify for more than one discount. 

  
Coupons  

Pro 
Redeeming a coupon is as easy as scanning the coupon bar code (or typing the number below the bar code) 
into the Enter Items field on a sales receipt or customer order. 
The coupon discount will be applied only to qualifying items. 
IMPORTANT: List all items to be sold BEFORE scanning the coupon. The discount is applied only to items 
already on the receipt when the coupon is scanned. 

 
Read the discount priority and conflict topic for information on how Point of Sale handles situations where a 
customer or the items being sold qualify for more than one discount. 

  
  
While not considered discounts for reporting purposes, you can also use markdown price levels  to give a customer 
a different price. 
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Pro Note: The same discount options (except rewards) apply to customer orders. The procedures for applying discounts on 
customer orders is the same, although button names may be slightly different on the customer order forms. Discounts given on a 
customer order are automatically carried to the final sales receipt. 

  

Related Topics 
Discount priority and conflicts 
Discount pricing overview 
How are discounts sent to QuickBooks financial software? 
  

Change the Sale Price Level 
Sales Overview | Make a Sale | Use Price Levels 
  
Your default sales price level, specified in company preferences is automatically used when you make a sale. You 
can change the price level on a receipt as necessary before taking payment and saving. 
The current price level is referred to as the active price level and any discounts given are applied against this active 
price level. 

To change the price level on a sales receipt: 
1. Display the receipt. 
2. From the I Want To menu, select Change Price Level. 
3. Select a new price level from the Price Level dialog. 
4. Click Close. 

If you already had items on the receipt when changing the price level, you are asked if you want to update those 
items to the new price level. 

• Answer Yes and the prices of previously listed items are changed to the new price level. Any 
previously given item discounts are overwritten by the new price. 

• Answer No and the previously listed items are left as is. This option allows you to price different 
items at different levels on a single sale. 

• Items listed after the change will automatically reflect the new price level. 

(Pro) To change the price level on a customer order: 
1.  Display the customer order. 
2. In the Price Level field (in the Totals area), select a new price level from the drop-down list. 

The same procedure applies to updating items already on the customer order as described above for receipts. 
  

Notes: 
• The next sale will automatically revert to your default price level. If you want to change the price level used 
for all sales, change the default level in company preferences. 

• Temporarily changing your default price level is one way to hold a sale. For example, if you have a 10% off 
price level, you could have a weekend 10% off sale just by changing your default price level for the weekend. 
Don't forget to change the default price level back to your normal price level when the sale is over!. Pro users 
might find Price Manager's discount pricing feature a better way to accomplish this. 

• (Basic, Pro) When selling to customer with an associated price level different than the default price level 
you are prompted to change to the customer's pricing. If you answer Yes, and items were previously listed on 
the receipt, they are automatically updated to the customer’s price level. 

• (Pro) In a multi-store configuration, each store can set its own default price level. 
Related Topics 
Give a discount 
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Shipping Merchandise 

Shipping Overview 
How do I?  

Enter shipping information on sales receipts 

Enter shipping estimates on customer orders 

Set up Shipping Manager 

Print shipping labels 

Edit or delete shipping information 

Track Shipping Manager shipments 

Collect tax on shipping 

  

Pro 
Point of Sale offers two way to enter shipping information on sales receipts and customer orders. 

• Manually enter the shipping provider, charges, tracking numbers, etc. 

• Use the integrated Shipping Manager, which interfaces with UPS to process and track shipments online, 
print shipping labels, and add the charges and tracking numbers to your sales receipts. Learn more. 

Notes: 
• To add the shipping fields to receipts and customer orders go to company preferences and on the General 
page select I want to record shipping addresses on sales receipts. Shipping Manager requires additional 
setup. 

• You can apply sales tax to shipping amounts if required. Learn more 

• If requiring user logins, the security right labeled POS > Edit shipping amount can be used to allow or 
prevent editing of the shipping amount on a receipt. 

• Shipping information and the carrier's tracking number, if applicable, is included on the customer's printed 
receipt. 

Enter Shipping Information on Receipts 
How Do I? | Shipping Manager Overview 

Print shipping labels 

Edit or cancel shipping information 

Track Shipping Manager shipments? 

Use an electronic scale with Shipping Manager 

Enter shipping estimates on customer orders 

Collect tax on shipping 

  

Pro 

Note: The availability of the shipping fields on receipts is controlled by your Features to Use and Sales: Shipping preference 
settings. 

  
Use these procedures to record shipping information and charges on sales receipts. 

How are you shipping? 
Using Shipping Manager  

1. List the items and customer on the sales receipt. 
2. From the I Want To menu, select Ship Items. 
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The Enter Shipping Information window is opened. 
3. Select an existing customer shipping address or select Add an Address. If you add or edit an 
address in this window, you have the choice to save the changes to the customer record. 
4. Select Ship via UPS. 
5. If using an electronic scale, place the parcel on the scale. 
6. Select OK. 

Shipping Manager is launched and the shipping form is displayed, with the customer's shipping address and 
the weight (if using scale) pre-filled. 

 
  

7. Enter the shipment weight and other shipping options. Note: Missing, but required, fields will be 
highlighted in red. 
8. Select options as needed from the shipping form: 

• Add or Delete in the upper right to add or remove parcels from this shipment. A shipment can 
contain multiple parcels. 

• Estimate Cost, Transit Time, or List All Services across the bottom to get estimates of costs 
and shipping times. 

• View to display a list of prior shipments made, track or cancel them, and run reports. 

• Cancel to return to the receipt without making the shipment. 

• Help for assistance. 
9. Select Ship to complete the shipment and print a shipping label. A confirmation is displayed, 
which can be printed or copied. Select OK to return the shipping information to the sales receipt. 
10. Complete the receipt and take payment in the normal manner. 

  
The shipping Options drop-down list on the receipt has additional shipping choices. 

• Track Shipment to connect to the carrier's Web site and get tracking information for this 
shipment. 

• Remove Shipment to remove the shipment from the receipt. Available only until shipment has 
been physically made, and once the receipt has been saved the shipping amount cannot be removed. 
Learn more. 

• Re-print UPS Shipping Label to print another copy of the Shipping Manager shipping label. 

• Print Mailing Label – Select to print a Point of Sale shipping label. 

• Print Packing Slip to print a list of items and the Ship To/Bill To addresses. 
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Not using Shipping Manager  

1. List the items and customer* on the sales receipt. 
2. From the I Want To menu, select Ship Items. 

The Enter Shipping Information window is opened. 

 
3. Select an address from the drop-down Ship To list (all addresses from the customer record are 
available). Click Edit If you need to change the address. The edited address can be saved to the customer 
record from the dialog (click Update Address in the edit box). 
4. Enter or select: 

• Shipping Amount – Shipping charge (amount). 

• Shipping Date – the date shipment is to occur. 

• Ship By – Select a shipping provider and method from the drop-down list of carriers (must be 
previously defined in company sales preferences.) 

• Tracking Number – Enter the provider’s tracking number, if known. 
5. Select OK to save and return to the receipt. The shipping information and charges are added to 
the receipt. 

 
To edit or remove the shipping charges: Click the Options button in shipping information area and select the 
appropriate action. If editing, the Enter Shipping Information dialog is re-opened. Edit as necessary and save. 
Additional choices are available from the Options menu: 

• Print Packing Slip – Select to print a list of items and the Ship To/Bill To addresses. 

• Print  Mailing Label – Select to print a shipping label (supported formats include Avery 5160, 
5167, 8164, and 5524*) with or without your store logo. 
6. Complete the receipt and take payment in the normal manner. 

*If no customer is added to the receipt first, you can type a shipping address directly into the Enter Shipping 
Information dialog. 
  

Notes: 
• If selling customer order items on the receipt, any shipping information recorded on the customer order is 
carried to the sales receipt. If the order is only being partially filled (i.e. some items remain due), you are 
asked if you want to apply the shipping charge to the current receipt. 

• Subject to security rights and these limitations, you can edit the shipping amount recorded on the receipt; 
even if that amount was brought over from the Shipping Manager. 

• You can apply sales tax to shipping amounts if required. Learn more 
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• If requiring user logins, the security right "POS > Edit shipping amount", can be used to allow or prevent 
editing of the shipping amount on a receipt. 

• You can customize your packing slip and store shipping label print templates if needed. 

• The ability to add or edit shipping information or amounts after saving a receipt may be limited. Learn 
more. 

Related Topics 
Making Sales Receipts 
Estimating Shipping on Customer Orders 

Enter Shipping Estimates on Customer Orders 
How Do I? | Create a Customer Order | Fill an Order 

Create a sales order 

Collect tax on shipping 

Set up to use Shipping Manger 

Report and tracking shipments 

  

Pro 
Shipping information and an estimate of the charges can be entered on a sales order or work order and then 
transferred to the sales receipt made when the order is filled. If using Shipping Manager, you can retrieve an 
estimate of shipping charges from UPS and enter that estimate on the order. 
The actual shipment is always done from a sales receipt. 

To enter a shipping estimate on a customer order: 
1. Create the order, adding the items and customer. 

Specify how you are shipping to continue: 
Using Shipping Manager  

2. Select Estimate Shipping Charges at the bottom of the receipt. 
The Shipping window is opened. 

3. Select Estimate Shipping for UPS. 
4. Select an existing customer shipping address or select Add an Address. 

A complete address and phone number is required to get an estimate. If you add or edit an address in this 
window, you can save the changes to the customer record. 

5. Select the Shipping Method (ground, 2nd day air, etc.) and enter the parcel Weight. 
6. Select Get Estimate. 

Point of Sale connects to the Shipping Manager and retrieves and displays the estimate (Shipping Manager 
isn't opened). 

 
  

What's important on this window? 

• To see how the shipping charges vary, change any of the information (method, weight, address) 
and select Get Estimate again. 

• Select Go To Shipping Manager if you need to access other options, such as checking transit 
times, changing settings, or check requirements for oversize packages. 
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• Transfer the shipping estimate to the order by selecting OK. 
7. Complete the order as usual. 

  
You can return to the order at anytime to revise shipping information or get a new 
estimate using the choices from the Options drop-down menu.  

• Estimate Shipping Charges to get a new estimate. 

• Edit or Clear the shipping address or details. You can manually 
change the carrier or estimate in the Shipping Details window. 

• Print Store Mailing Label – Select to print a Point of Sale shipping 
label.  Note: If you use Shipping Manager to later ship the items from a 
receipt, you can print a UPS shipping label at that time. 

  
Not using Shipping Manager  

2. Select Enter Shipping Information at the bottom of the order. 
The Shipping window is opened, with a list of available shipping addresses from the customer record. 

4. Select a shipping address or choose Add an Address to enter a new shipping address. If you 
add or edit an address, you can save the changes to the customer record. 
5. Select OK. 
6. In the Shipping Details window, enter or select: 

• Shipping Amount – Shipping charge (may be an estimate at this point). 

• Ship By – Select a shipping provider and method from the drop-down list of carriers (must be 
previously defined in company shipping preferences.) 
7. Select OK to record the shipping information on the order. 

  
You can return to the order and edit the shipping information at anytime by making a choice from the Options 
button in the Shipping Info area: 

• Edit or Clear Shipping Address. 

• Edit or Clear Shipping Details - amount or carrier/service. 

• Print Store Mailing Label – Select to print a shipping label. 
  

Notes: 
• Shipping information recorded on a customer order is carried to a sales receipt that fills the order. If the 
sales order is only being partially filled (i.e. some items remain due), you can choose whether to transfer the 
shipping amount. Once on the receipt, you can edit or enter additional shipping information or charges as 
necessary. 

• You can apply sales tax to your shipping amounts if required. Learn more 

• Shipping information is not available on a layaway. 
Related Topics 
Enter Shipping Information on Receipts 
Shipping Manager Overview 

Edit or Delete Shipments 
How Do I?  | Shipping Manager Overview 

Print shipping labels 

Track Shipping Manager shipments 

Use an electronic scale with Shipping Manager 
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Enter shipping estimates on customer orders 

Collect tax on shipping 

  

Pro 
The ability to edit or delete shipping information may be limited as follows: 

• Before a receipt has been saved: No restrictions. The shipping information or shipping amount can be 
edited or deleted. 

• After a receipt has been saved: The shipping information, except amount, can be edited or removed. The 
amount cannot be removed because payment has already been taken with the shipping included.* 

• In Shipping Manager: If the shipment was made through Shipping Manager, the shipment or a specific 
parcel can be edited or deleted in Shipping Manager until the carrier has physically received the package, 
even if it can no longer be edited or deleted in Point of Sale. However, a change initiated in Shipping 
Manager does not update the receipt in Point of Sale. 

To edit shipping information before saving the receipt: 
1. Click anywhere in the shipping information area on the receipt. The Enter Shipping Info dialog 
opens. 
2. Edit the information and click Save. 

To delete the shipping information, including the amount, before saving: 
1.  Click the Options button in the shipping information area on the receipt. 
2. Click Remove Shipping Info. 

The information and shipping charge is immediately removed. 

To edit shipping information after saving the receipt: 
1. Find and open the receipt in sales history. 
2. From the I Want To menu, select Add/Edit Shipping Information. 
3. In the Shipping Info section of the receipt, make a selection from the drop-down Options list: 

Ship Items via Shipping Manager: Available only if Shipping Manager is enabled. Launches Shipping 
Manager for shipping or tracking the shipment. If a tracking number is recorded on the receipt, this option will 
connect to the carrier's web site to track the progress of the package. 
Edit Shipping Info: Allows you to change or remove the shipping address, shipping provider, ship date, and 
tracking number. You cannot however remove the shipping amount. 
Remove Shipping Info: Removes all shipping information except the shipping amount. 
Print  Mailing Label: This option prints a shipping/mailing label using the printer and template set up in Point 
of Sale. 
Print Packing Slip: Prints a listing of items to be shipped and both the Bill To and Ship To addresses. 

3. Select Save. 
  

Notes: 
• *The only way to remove or edit the shipping amount after a receipt has been saved is to reverse the 
receipt and then create a new corrected one with the updated shipping information. If canceling the shipment, 
you may find it quicker to create a new receipt to refund the shipping amount to the customer. 

• Since they are just estimates, shipping amounts and information on customer orders can be edited or 
removed at anytime. 

Reporting and Tracking of Shipments 
Shipping Overview | Shipping Manager | Shipping from Receipts 

Pro 
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Point of Sale offers two reports to help you track your shipments. If you use Shipping Manager, you have reports 
and  package tracking capabilities in Shipping Manager and in Point of Sale. 
  

Shipping Reports and Tracking in Point of Sale 
The shipping reports are available in the Sales > Shipping report category. Note: Only shipments recorded on 
Point of Sale receipts show up in these reports. 

• Shipping Summary Report - A quick view of the number and cost of shipments by carrier/service for the 
specified period. This report can be modified to add additional data. Double-click when the QuickZoom icon is 
shown to drill down to the detail report. View Example  

 
• Shipping Detail Report - A more detailed look at your shipments, with tracking numbers and information 
from the sales receipts. You can run this report directly or reach it by drilling down from a summary report 
(shown is a drill-down from the summary report above). If run directly, this report can be modified to add 
additional data.  View Example  

 
If using Shipping Manager, tracking numbers are automatically added to Point of Sale receipts. If you have an 
Internet connection, you can go to the carrier's Web site to track the status of a package without having to open 
Shipping Manager and without having to retype the tracking number. 

• Sales Receipt Form - The tracking number is displayed in the Shipping Info area of the form. Click the link 
or select Track Shipment from the drop-down Options button. 

• Sales History - When viewing your collapsed Sales History list (example below), a tracking link is added 
to the Information Panel on the right. Click the link to connect to the tracking site. 
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Note: If a Shipping Manager shipment contains multiple packages, each has its own tracking number. The link displayed in Point 
of Sale is for the first package. You can track the other packages from the shipping history window in Shipping Manager as 
described below. 

  
  

Reports and Tracking in Shipping Manager 
Report and tracking features are also available from the Shipping History window in Shipping Manager, if you use 
it. 

To access Shipping History window: 
1. From the Point of Sale menu, select QuickBooks Shipping Manager. 
2. Select UPS Shipping Options. 
3. Select Track or Cancel a Shipment. 

The Shipping Manager is launched and your shipping history, defaulted to today's shipments, is displayed. Each 
line in the table represents a package, not a shipment (which could have multiple packages). View Example  

 
Some of the options available from this window are: 

• Change the date range, search for a specific parcel, or customize the columns. 

• Highlight a package and then select Track to go online and view the status. 

• Select Report to run, and optionally print, a detailed report of shipments. View Example  

 
• Right-click a parcel to see additional options. 

• Select Delete to cancel the shipment. This option is available only until the carrier accepts the package. 
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Select Help on this window for more information about managing your shipments. 
  

Notes: 
• If you are integrated with QuickBooks financial software, shipping charges, including any handling or 
markup from Shipping Manager, are sent to a single Shipping Expense account as mapped in company 
preferences. 

Shipping Manager: Overview and Setup 
How Do I?  

Enter shipping information on sales receipts 

Enter shipping estimates on customer orders 

Print shipping labels 

Edit or delete shipping information 

Collect tax on shipping 

Track Shipping Manager shipments 

  

Pro 
With the QuickBooks Shipping Manager, you can process a shipment and prepare a shipping label with United 
Parcel Service (UPS) —with the "ship to" information pre-filled—directly from Point of Sale sales receipts and 
customer orders. You can also track or cancel shipments and view online shipping reports. 
The UPS functionality of this product is available only for packages shipped from the United States of America. 

What would you like to know more about? 
Shipping Manager Requirements  

• You must have an account with UPS. Links are provided within Shipping Manager to sign up for an 
account, if necessary. 

• The workstation(s) on which you will use Shipping Manager must have Internet access. 

• You must set up Shipping Manager on each workstation that will use it. You can share the same 
account number on all your workstations. 

  
Turn Shipping Manager On  

1. From the File menu, select Preferences > Company. 
2. From the preference menu at the left, select General, and in the Select Feature to Use 
group make sure the option I want to record shipping addresses on sales receipts is selected. 
3. From the preference menu at the left, select Sales > Shipping. 
4. Select the checkbox to Use QuickBooks Shipping Manager. 

Optionally, select the I do not charge my customers for shipping checkbox. This option allows you to 
make shipments without adding the shipping amount to the sale total. This might be used, for example, if 
you have already built shipping charges into your sale prices. 

5. In the Shipping Providers list, add or remove providers and service 
6. Select Save. 

Shipping Manager is now available as an option from the Point of Sale menu and from individual sales receipts 
and customer orders. 
(Pro) The Shipping Manager preference settings are sent from Headquarters to remote stores and cannot be 
edited at the remote. 

  
Set Up Shipping Manager  
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1. From the Point of Sale menu, select QuickBooks Shipping Manager and then UPS 
Shipping Options > Settings. 

The Shipping Manager Setup Wizard is launched. 
2. Follow the wizard's instructions to enter your account number, company information, and 
other basic shipping options. 

The wizard will connect to UPS and confirm your account is set up. 
3. When the Shipping form is displayed, select Settings from the menu at the right to configure 
more advanced options, such as: 

• Rate options, such as a preset shipping markup, minimum charge, or handling charges 

• Printer and label setup 

• Electronic scale setup 

• Other default shipping and connection settings 
4. Select OK. 

Shipping Manager is now ready to use for your sales! 
  

  
  

Notes: 
• Shipping Manager has its own help system to assist you with settings and its shipping forms. Select Help 
from the right-hand menu within Shipping Manager. 

• All amounts from Shipping Manager are estimates only, based on information provided by you, and subject 
to final verification by the carrier. 

• Once set up, you can make shipments by accessing Shipping Manager from the Point of Sale menu, 
however the shipping information in this case is not added to Point of Sale receipts nor is it available on Point 
Of Sale reports. To ship and report on items sold in Point of Sale, select a shipping option from a sales 
receipt instead. Note: Shipping reports are available within Shipping Manager for all shipments made. 

• If integrated with QuickBooks financial software, shipments made from QuickBooks appear on the same 
shipping reports in Shipping Manager as those made from Point of Sale (unless you have set up separate 
accounts). 

Shipping Manager: Use an Electronic Scale 
How Do I?  

Enter shipping information on sales receipts 

Enter shipping estimates on customer orders 

Print shipping labels 

Edit or delete shipping information 

Collect tax on shipping 

Track Shipping Manager shipments 

  

Pro 
Shipping Manager supports the use of an electronic scale. This allows Shipping Manager to pull the shipping 
weight from the scale when attached  to the Point of Sale workstation via a USB connection. 
Supported Scale:  Mettler Toledo PS60 USB 
  

Note: This scale integrates with Shipping Manager only; it is not supported in Point of Sale inventory or on transaction 
documents. The instructions given below come from Shipping Manager and since hardware compatibility or setup instructions 
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may change from time-to-time you should consult the help system within Shipping Manager to ensure you have the latest 
information. 

To set up the scale in Shipping Manager: 
1. Attach the scale to an available USB port  on the workstation running Shipping Manager. 
2. Turn on the scale and test that the scale correctly displays a known weight. 
3. From the Point of Sale menu, select QuickBooks Shipping Manager and then UPS Shipping 
Options > Settings. 
4. Select Scales from the Setting menu. 
5. Select the checkbox to Use Electronic Scale and select USB-connected scale as the model. 

 
6. Select Test. The weight from your scale should be displayed. 
7. Select OK to save your settings. 

  

Note: 
• When shipping from a sales receipt, put the package on the scale before selecting Ship These Items. 
When the Shipping Manager form comes up the weight will be pre-filled in the Weight field. 

Related Topics 
Shipping Manager Overview and Setup 

Returns and Exchanges 

Returns and Exchanges from Customers 
Display Customer Purchase History  | Sales History 
  
Merchandise returns and exchanges are recorded on receipts. 

To process a merchandise return or exchange: 
1. Follow the basic procedure for Making a Sale, listing the return items on a sales receipt and 
clicking  Return Item to make the quantity negative. 

 
OR 
In your sales history, find and select the original receipt and then select Accept Return/Exchange from the I 
Want To menu. 

• The Take Return/Exchange wizard is opened, with the items and prices from the original receipt 
listed. Select the checkbox in the Return column for the items being returned and then click Add Selected 
Items. The selected item(s) are added to a new receipt with a return quantity of one (- 1) and at the same 
price as the original sale. 
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• If you select Accept Return/Exchange before selecting a receipt, the initial page of the wizard is 
a receipt search function. Enter the customer name or another search keyword to find the original receipt 
and then proceed as above. 
2. On the new receipt, adjust quantities of returned items if necessary and list any new purchase 
items. 
3. Enter any other requested item information, such as serial numbers (Pro). 
4. Take payment or give a refund as appropriate: 

• If money is due the customer, it is suggested as cash change. Click a different payment 
type button to give the refund by another method. Ensure that the refund option is selected in the 
payment dialog. 

• Refunds cannot be made to a debit/ATM card. Refund the amount as cash, gift 
card/certificate, or another method per your store policy. 

5. Save and print the receipt. 
  

Notes: 
• You can sell new items on the same receipt on which you are accepting returns. Simply take payment or 
give change based on the net total of the receipt . 

• If integrated with QuickBooks financial software and the exchange is for a charge account customer, be 
aware that putting both return and sales items on a single receipt will create only one document in your 
financial software, based on the net amount of the receipt. If negative, a customer payment or credit memo is 
created. If positive, a customer invoice is created. If you always want customer payments/credit created for 
returns and invoices for sales, record returns and sales on separate receipts. 

• The item(s) returned by the customer are added back to inventory. If the merchandise is unsalable, you 
should create a quantity adjustment memo to remove it from inventory or a return voucher if the merchandise 
is being returned to your vendor for credit. 

Related Topics 
Display a customer's purchase history 
Make a sale 
Reverse a receipt 
How receipts are transferred to QuickBooks financial software 

Take Payment on Account (or Issuing Store Credit) 
Maintain Customer Accounts | Charges on Account 

Basic  
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Payments on a customer's charge account are recorded on a receipt.   
  

Note: Issuing store credit is essentially the same as taking payment on account and the same procedures are used. If you are 
issuing store credit due to a merchandise return, create a return receipt and use the second procedure below. 

To record a payment on account: 
1. Start a new receipt, with or without sales items listed. List the customer on the receipt. 
3. Click the Account button. The Charge Account dialog is opened. The current account balance is 
displayed for reference. 
4. Click the Make payment on account option. 
5. Enter the amount the customer is paying. 

The full account balance is suggested. Type over this amount if the customer is paying a different amount. 
3. Click Save. The receipt is updated with the balance due from the customer (account payment 
plus any new purchases). 
4. Take payment by any other payment type.   
5. Save/print the receipt. 

  
  

Notes: 
• Payment on Account and the amount is added to the receipt item list and, when saved, the payment 
receipt is added to your sales history. 

• A customer cannot make a payment on account by charging it to his account. 

• The customer’s account balance and available credit is updated accordingly at this store. 

If integrated with QuickBooks financial software: 

• Payments/credits on account can be entered directly into QuickBooks financial software if you prefer, using 
the Customers  Receive Payment option (see your QuickBooks documentation for more information). If 
choosing this method, the payment should NOT also be entered in Point of Sale. Payments on account 
recorded in QuickBooks will be reflected in Point of Sale after the next Financial Exchange. 

• When you take payments or give credit on account in Point of Sale, a customer payment is created in 
QuickBooks with the next Financial Exchange. How, or if, this payment is applied to open invoices for the 
customer is determined by your Receive Payments preferences in QuickBooks. Learn more. 

Related Topics 
Set up an account for a customer 
Make a sale 
Correct or clear payments 

Credit Card Returns 
Sales Returns | Fraud Prevention Tips 
  
If the transaction has already been settled with the bank, you should issue a credit refund to the customer by 
making a return receipt. 

To make a return credit card receipt: 
1. Create a new receipt, listing the return items as negative quantities (click Return Item after 
adding to the receipt). 
2. If necessary, edit the returned item prices and quantities to be the same as the original purchase 
and then click Credit as the payment type. 
3. In the Credit dialog, ensure that Refund Card is selected. 
4. Swipe the customer's card (recommended). 
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Or 
Click Manual and type the credit card number, expiration date and cardholder’s ZIP Code and then click 
Authorize Now. 

5. Save and print the receipt. Have the customer sign the merchant copy. 
  
Tip: If the customer is returning all of the merchandise on the original receipt , you can also reverse the original 
receipt. Reversing the receipt is typically done when the customer is not present to swipe their card. (Pro: This 
option is not available at a remote store after a receipt has been sent to Headquarters.) 
  
Related Topics 
Cancel and reverse credit card payments 
Take payment by credit card 
Merchant Service reports 
Merchant Service overview 

Handling Gift Card Returns 
Gift Card Service Overview 
  
Use this procedure to refund amounts for returned merchandise to a gift card. Enter the return on either a sales or 
return receipt and then enter the refund amount in the Gift Card Sell column on the payment window. Entering the 
refund amount as a sale adds the refund amount back to the gift card balance (if using the QuickBooks POS Gift 
Card Service). 

To make a return gift card receipt: 
1. Add the items to a receipt as return items using the same prices at which the merchandise was 
purchased, using normal return methods. 
2. Click Gift Payment Method. 
3. Be sure purchase/recharge card is selected and then swipe the gift card. 
4. Click Save.  
5. Print the receipt.  

  

Notes: 
• At your discretion or according to your store policy, you can also return the refund amount by another 
payment method, such as cash. 

• If the customer wants to return the gift card itself for a refund, and your store policy allows it, use a sales 
receipt with no items listed. Go to the payment window and check the balance of the card. Then enter the 
balance in the Gift Card Redeem field and authorize. A refund of the amount will be suggested as cash 
(change it to a different change method if necessary). 

Related Topics 
Reverse a gift card transaction 
Sell or redeem a gift card 
Replace a lost gift card 
Gift Card Service reports 

Working in Sales History 

Sales History 
Make a Sale | Display Customer Purchase History 
  
Your sales history list stores all previously saved receipts.    
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By default, your sales history shows all saved receipts sorted by date in a list format. There are several options for 
changing the display. 

 
  

Things you can do from sales history 
Find a receipt 
Accept a return or exchange 
Copy a receipt 
Edit a receipt 
Reverse a Receipt 
E-mail a receipt 
  

Notes: 
• Saved receipts can never be deleted and, with the exception of some informational fields, generally cannot 
be edited. But they can be reversed if necessary to make a correction. Reversing a receipt does not remove 
the original document; rather it creates a new receipt with the opposite effect (return to cancel a sale). 

• If integrated with QuickBooks financial software, all receipts are sent to update your financial records. You 
can view the linked QuickBooks documents and transactions related to a Point of Sale receipt by selecting 
the receipt and then selecting View Financial Details from the I Want To menu. Learn more. 

• (Pro) Receipts created at remote stores are sent to Headquarters to update inventory and QuickBooks and 
are included in Headquarters sales history and sales reports. Receipts made at Headquarters are not sent to 
remote stores; therefore remote store histories only reflect the documents made at that store. 

  

Search for a Receipt 
Sort a List | Filter a List 

There are three ways to find a saved receipt: 

• From the POS home page, use Quick Find 

• From a customer record, view the customer's purchase history 

• Search directly in your sales history as described below 

To search for a receipt in sales history: 
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1. Open your sales history.  
2. Begin typing keywords in the Search field above the list.   

 
• If you know the receipt number, enter it or scan the bar code from the original, printed receipt. 

• You can also search by customer name, company name, cashier, or associate. The more unique 
the search keyword, the fewer search results will be returned. 

• To search by the date the receipt was made, enter the date in mm/dd or mm/dd/yyyy format, 
including the slashes. 

• (Pro) If recorded on the receipt, you can search by item serial number or shipping tracking 
number. 

• As you type, the list is instantly filtered to display only matching receipts. Note how the filter 
button now indicates the list is showing Search Results and the number of records found is shown at the 
bottom of the list. In this case, typing "06/14" returned three receipts made on June 14. 

 
  

3. If no results are found, use the backspace key on your keyboard to go back and re-enter new 
characters. 
4. Select the receipt you wish to work with and then click Show Details or choose an appropriate 
task from the I Want To menu. 

  
Note: 

• To search for a held receipt, you must display the held receipts list first. 
Related Topics 
Returns and Exchanges from Customers 
Edit Documents 
Copy a Document 
Reverse a Receipt 
  

Edit Documents 
Enter Data in a Field | Find a Document 
  
This discussion assumes you require employee logins and are using default settings. Your actual ability to edit 
documents will vary based on your security rights, features used, and in a multi-store configuration, your store 
location (Headquarters or remote). 
  

Order Documents 
Purchase orders and customer orders, since they have no direct effect on inventory, can be freely edited at anytime 
(edits to some fields may be restricted if deposits have been accepted towards the order). 
How do I edit a purchase order? 
How do I edit a customer order? 
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Transaction (History) Documents 
Before saving, all information on transaction documents can be edited. 
However, transaction documents immediately affect your inventory as soon as saved. If integrated with QuickBooks 
they may have also already affected your financial records. After saving, only certain informational fields can be 
edited. Edits that affect the items, total, or payments are generally not allowed (see voucher exceptions below). 
Once sent from a remote store to Headquarters or to your QuickBooks financial software, the ability to edit is even 
more limited. 

What can be edited? 
Receipts: After saving, you can edit the customer, comments, promotional code, and, if a Pro user, the shipping 
information (except amount). After sending to Headquarters or to QuickBooks, you can no longer edit the customer 
or promotional code. Edit options are available from the I Want To menu in Sales History. 
Receiving Vouchers: Certain voucher fields, such as discounts, freight, fees, and vendor billing information may 
be edited after saving and, at Headquarters, even after sending to QuickBooks, depending on where you enter 
vendor billing information and if you spread discount, freight, and fees across item costs. Edit options are available 
from the I Want To menu in Receiving History. 
Adjustment Memos: Memo comments can be edited after saving. Once sent to Headquarters or QuickBooks, no 
fields are editable. Select Edit from the toolbar in your Adjustment History. Editable fields are white in color. 
Transfer Slips: Slip comments, carrier, and freight can be edited after saving. Once sent to Headquarters or 
QuickBooks, no fields are editable. Select Edit from the toolbar in your Transfer History. Editable fields are white in 
color. 
  

Correcting a Document When Editing Isn't an Option 
If you discover an error on a history document that is not editable, it can still be corrected by reversing the original 
document and then creating a new, corrected one. This feature is intended for correcting errors and should be used 
only when necessary. 
Select a link below to learn more about reversing various documents: 
Reverse and correct a receipt 
Reverse and correct a receiving voucher 
Reverse and correct an adjustment memo 
Reverse and correct a transfer slip 

Reverse a Receipt 
Merchandise Returns |  | Find a Receipt 
  
Saved receipts cannot be deleted and editing of receipts is restricted to certain informational fields. If information 
other than what can be edited needs to be corrected, you can reverse the receipt. Reversing a receipt corrects your 
sales history, inventory quantities, and customer records by creating an equal, but opposite, transaction. 
This procedure is not recommended for processing routine merchandise returns from a customer. 

To reverse a receipt: 
1. Find and display the receipt in your Sales History list. 
2. From the I Want To menu, click Reverse. 
3. If prompted, enter additional information. For some payment types (credit, debit) a message 
informs you that continuing will automatically result in credits back to the customer on their credit/debit 
account. 

A reversing receipt is automatically created and added to the Sales History list, marked Reversing in the 
Status field (displayed in the Sales History list only). The original receipt will be marked Reversed. 

  

Notes: 
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• Reversing creates a new receipt with the opposite effect of the original. It does this by creating a new 
receipt of the opposite type, in other words a sales receipt is reversed by creating an identical return receipt. 
Reversing a sales receipt adds the sold items back to inventory and reversing a return receipt deducts items 
from inventory. 

• You can use a Reverse, Copy, and Correct approach to make a new receipt with the correct information. 
First, reverse the original, incorrect receipt as described here. Then, begin a new receipt by copying the 
original. Finally, make corrections to the copy and save as usual to record the new corrected receipt. Learn 
more 

• Read how reversing receipts of specific payment types is handled (e.g., credit card, debit, check, gift card, 
etc.). 

• If integrated with QuickBooks financial software and if the original receipt has already been sent to 
QuickBooks, then the reversing receipt is also sent and posts in the normal manner. The new records and 
account entries created in QuickBooks cancel the effect of the original receipt. The original entries are not 
edited or removed. If the original receipt has not yet been sent, then both are flagged "Do Not Send" and 
there will be no entries made in your financial software for the transaction. 

Pro Notes: 
• Special considerations apply to reversing receipts at remote stores. Learn more. 

• If you delete an item from inventory, but then reverse a receipt that includes that item, Point of Sale 
recreates the item in inventory, so that quantity changes resulting from the reversal can be recorded. Learn 
more  

Related Topics 
Merchandise returns and exchanges 
Display a customer's purchase history 
Find a receipt 
Sales overview 

Notes on Reversing Receipts of Specific Payment Methods 
Reverse a Receipt | Find a Receipt 
  
When you reverse a sales receipt, the reversing receipt created is a return receipt. The amounts taken in payment 
on the original receipt are returned as change (on paper) to the customer as credits on the return receipt. In this 
way, the accounting is automatically corrected along with the other changes you make on the receipt. The following 
are brief descriptions of how reversing a sales receipt of specific payment methods, and then creating a new 
corrected receipt are handled. Reversing a return receipt works the same way but the payment and change (credit) 
amounts are the opposite. 
  
Cash: The reversing receipt (return) shows the original payment returned to the customer as cash change. Record 
payment on the new corrected sales receipt as cash as well. If there is a difference between the amounts on the 
two receipts, you will need to handle collecting or refunding from/to the customer according to your store policy. 
Check: The reversing receipt (return) shows the original payment returned to the customer as change by check. 
Record payment on the new corrected sales receipt by check as well. If there is a difference between the amounts 
on the two receipts, you will need to handle collecting or refunding from/to the customer, changing the amount of 
the check, or getting a new check according to your store policy and legal requirements in your area. 
Credit Card: The reversing receipt (return) shows the original payment returned to the customer as change by 
credit card. If you use the QuickBooks POS Merchant Service, this receipt will automatically be sent to the card 
processor as part of the next settlement batch. This will result in a credit on the cardholder's account. Record 
payment on the new corrected sales receipt by the same credit card, authorizing and updating the charge by 
manually entering the card information, if necessary. This new receipt will also be sent with the next settlement 
batch, resulting in a new charge on the cardholder's account. If you do not use the QuickBooks POS Merchant 
Service, follow the same procedure but use the third-party processor's instructions for handling the card credit and 
new authorization. For more information, read canceling and reversing credit card payments. Reversing credit card 
receipts processed through Point of Sale is limited to 60 days after the sale. 
Debit/ATM: Reversing a debit receipt does not create a credit back into the customer’s bank account. When you 
reverse a debit receipt, the change is automatically assigned to cash. If you want to return the money to the 
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customer by another method, create a return receipt instead and choose the payment method. Then create a new, 
corrected receipt. 
Gift Card: If you use the QuickBooks POS Gift Card Service and reverse a sale paid by gift card, Point of Sale 
automatically connects to the Gift Card Service servers and adds the original payment amount back to the card 
balance. The refund amount is placed in the Gift Card Purchase field on the payment screen. If you reverse a 
receipt which originally sold (added value) to the gift card, reversing it deducts the reversed amount from the stored 
value of the card. If not using the QuickBooks POS Gift Card Service, the reversing process is the same, but you’ll 
have to use the procedure outlined by your service to add/deduct the value back to the customer’s card. 
Gift Certificate: The reversing receipt (return) shows the original payment returned to the customer as change by 
gift certificate. Record payment on the new corrected sales receipt by gift certificate as well. If you track gift 
certificates by number, enter the same number as the original certificate. If there is a difference between the 
amounts on the two receipts, you will need to handle collecting or refunding from/to the customer according to your 
store policy and legal requirements in your area. 
Account Charge: The reversing receipt (return) shows the original payment returned to the customer as an 
account credit. Record payment on the new corrected sales receipt by account charge. Both receipts are sent to 
your QuickBooks financial software, and any difference between the receipt amounts is reflected in the customer’s 
new account balance after credits are applied to invoices in QuickBooks. 
   
QuickBooks Financial Software Users: In all cases, both the reversing (return) receipt and the new corrected 
receipt will be sent to QuickBooks as part of the next Financial Exchange, thus automatically updating your 
accounting records accurately. 
  
Return to top 
  
Related Topics 
Copy and correct a reversed receipt 
Sales overview 

Cancel or Reverse Credit Card Payments 
Merchant Service Overview | Fraud Prevention Tips 
  
If the customer cancels a purchase in-process, or returns the purchased merchandise for a refund, the following 
apply if using the QuickBooks POS Merchant Service: 

• If the receipt has not been saved/printed, click Credit to re-open the Credit Card payment dialog. Click 
Remove to clear the payment.  If the credit card payment had already been authorized, it is voided and the 
charge will not show up on the cardholder’s statement.  Enter new payment information or cancel the entire 
receipt, as applicable. 

• If the receipt has been saved/printed, but the transaction not yet settled, locate the original receipt in 
your sales history and reverse it. Both the original and reversing receipt retain the credit card charge 
information, but are marked as being voided and neither are sent for settlement. Neither transaction shows up 
on the cardholder’s statement. 

• If the transaction has been settled, the recommended procedure is to create a return receipt, giving 
change as a credit to the same credit card. Alternatively, if the receipt contains only the item(s) being returned 
and was paid entirely by credit card, then reversing the entire receipt may be the fastest way to void the 
transaction and/or issue a refund. If the customer is not returning all items on the original receipt, then a 
return receipt is your best choice.  In either case, since the original transaction was already settled, the return 
transaction is sent with the next Merchant Service batch, and both sale and return show up on the 
cardholder’s statement. 

  

Note: 
• If a credit card receipt is older than 60 days or if it has already been sent from a remote store to 
Headquarters, it can no longer be reversed. In this case, make a return receipt instead. 

Related Topics 
Take payment by credit card 
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Settle credit card transactions 
Merchant Service reports 

Using GoPayment 
Basic  

Swiping Cards 
 
One of the following card readers should be used with GoPayment on an iPhone:  
  
Mophie card reader 
The Mophie card reader is available at Apple Retail Stores and at www.apple.com.  
To use this reader, follow these instructions: 

1. Insert your iPhone in the Mophie credit card reader and launch GoPayment.  
2. When prompted, run the card through the bottom of the card reader. 

Note: The Mophie reader is currently compatible with iPhone 3G , 3GS and 4.  (Currently not compatible with the 
iPod Touch or the first-generation EDGE network iPhone).  
  
  
Audio jack card reader 
Intuit offers a card reader that plugs into the audio jack.  
To use this reader, follow these instructions: 

1. Plug the device into your audio output jack. This card reader works best when you turn the volume to full.  
2. In Settings, turn Audio Jack Card Reader ON.  

When the Audio Jack Card Reader setting is on, do not plug in another audio device (such as 
headphones) or a beep will sound. 

3. Choose the card reader model you have. (You can match the image. Your reader will be either grey or 
white.)  

4. When you initiate a charge, GoPayment prompts you to swipe a card at the payment screen.  
 
Note: Remove the card reader before you make or accept a call. 

Basic  

GoPayment Features 
 
Location of transactions - Turn on location, and email receipts, You can also show customers a map indicating 
exactly where the transaction took place.  
  
Memo to self - Lets you enter additional information related to the transaction (e.g., an invoice number or other 
notes).  Only you see the memo, the customer doesn't. 
  
Tips - Your customer can add a tip to the total amount. Turn on Tips to show the Add Tip button on the Signature 
page. 
  
Items - Create and store a list of products and/or services. When Items is on, you start transactions by selecting 
item(s) from the list to generate the charge amount. 
  
Edit Items - Tap this button to edit, add or delete items. 
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Sales Tax - If you use items, tap this button to enter the sales tax percentage that applies to some or all items. For 
charges that don't feature items, you must calculate the tax yourself and include it in the total amount charged. To 
have GoPayment automatically calculate sales tax based on your location, click in the Location-based tax rate 
checkbox.  
  
Change Account - If you have more than one GoPayment merchant account associated with your User ID, you 
can choose which account you want to use to process payments.  
In Settings, the current account appears within the Change Account button. (You won't see this button if you only 
have one merchant account.)   To switch to a different account, tap Change Account and tap the desired account. 
 When you view transactions in History, you will see transactions for all your accounts, not just the currently 
selected account.  
  
  
Learn more 

GoPayment:  Frequently Asked Questions 
Basic  

What if I experience a low signal while processing a payment? 
 
If there's no response due to a low signal, keep GoPayment open and try moving to a better spot. If you lose your 
connection during a payment, try to continue where you left off.  If you close GoPayment before getting a 
connection, you will need to re-enter all payment information.  
  

Why can't I void a payment? 
 
If the transaction has been submitted to the bank (batched), it cannot be voided.  
At that point, you or your account administrator can process a refund online using the Merchant Service Center 
site.  
  

How do I use GoPayment to store a list products or services?  
 
Use the  Items feature  to store a priced list of products or services.  
With Items on, you can start transactions by selecting item(s) that comprise the purchase.  
GoPayment uses item prices to tally the charge amount. Customers can see what they bought and you can track 
inventory and services. 
  
To turn on Items: 

•  In Settings, turn Items on.  

• Tap Get Paid.  The Items list displays.  
To add an item: 

• From the  top right of the screen tap +.  

• Then complete the Item form. 
  
To edit an item: 

• Tap the > next to the item you want to edit.  Or, from  Settings, tap Edit Items. 
  
To charge for an item: 

• Tap the > next to the item you want to add to the order.  
  

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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How do I locate past charges? 
 
To view past charges: 

• Tap History.   
You will see the last 25 transactions. (Payments appear in black. Voids display in red).  

  
To open a transaction: 

• Tap the transaction line.  
You can view transaction details, send a receipt, or void the charge. 

.  
  

How do I set the sales tax? 
  
To set the sales tax: 

• At the bottom of the GoPayment screen, tap Settings.  

• In the Sales Tax field, enter the desired tax rate.  
Or, to have GoPayment automatically calculate sales tax based on your location,click the Location-based tax rate 
checkbox.  When sales tax should be applied to an item, open the item and tap its Sales Tax On button.  (The 
sales tax you enter applies only to items).  For charges that do not feature items, you'll need to calculate the tax 
yourself and include it in the total amount charged.  
  

Is a customer signature required? 
 
Getting a signature is optional.  However, Intuit GoPayment lets customers sign for charges on your iPhone screen 
using their finger.  
The charge has already been processed. But in the case of a later chargeback, a signature can help verify that the 
customer was present and approved the charge.  
  

When does a merchant get paid? 
 
Your GoPayment transactions are totaled each day at 3:00pm PST, and that amount normally appears in your 
account within 2-3 business days.  
However, the waiting period, known as “time to funding,” varies depending on a number of variables: 

• Time of day the transaction was processed; 

• The bank account  in which funds were deposited; 

• The length of time it takes your bank to verify and process electronic deposits. 
To update your deposit account information, sign in with your GoPayment User ID and Password here.   
From the web page, choose Account > Account Profile.  
Note:  This site is not optimized for mobile browsers, so you may wish to use your computer's browser.  
  
  

How do customers leave a tip? 
  
To activate the Tips feature: 

• At the bottom of the GoPayment screen, tap Settings.  

• Turn on Tips.  

https://merchantcenter.intuit.com/
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For a customer to leave a tip: 

• Once Tips is turned on, go to the Signature screen. 

• Tap Add Tip. 

• Tap a percentage amount (automatically calculates) or type a dollar amount directly in the Tip field.  

• Tap Apply Tip.   

• To make a change prior to leaving the Signature screen, tap Change Tip.  
  

How do I match a GoPayment charge in QuickBooks? 
 
You can apply a payment to an existing invoice in QuickBooks, create an invoice for the charge, or just credit a 
customer. 
  
To match a charge in QuickBooks: 

• In QuickBooks, choose Customers > Credit Card Processing Activities > Get Online Payments. 

• Select Mobile Transactions. 

What are the requirements for my wireless network? 
 
If wireless is used or implemented in the payment environment or application, the wireless environment must be 
configured per PCI DSS version 1.2 requirements 1.2.3, 2.1.1, and 4.1.1.  
Wireless technology must be securely implemented and transmissions of cardholder data over wireless networks 
must be secure. 
To be PCI-compliant, wireless network administrators must: 

• Install and configure perimeter firewalls between wireless networks and systems that store credit card 
data, per PCI DSS version 1.2, 1.2.3. 

• Modify default wireless settings, as follows, per PCI DSS 2.1.1: 
o Change default encryption keys upon installation and when anyone who knows the keys leaves or 

changes positions. 
o Change default service set identifier (SSID). 
o Change default passwords or passphrases on access points. 
o Change default SNMP community strings. 
o Enable WiFi protected access (WPA and WPA2) technology for encryption and authentication. 
o Update firmware on wireless access points to support strong encryption and authentication (WPA/WPA2). 
o Other security related wireless vendor defaults. 
o For wireless networks transmitting cardholder data or connected to the cardholder data environment, 

implement industry best practices for strong encryption of data transmission and authentication (e.g.,IEEE 
802.11i).  

o All newly implemented wireless networks are prohibited from using WEP as of March 31st, 2009.  
o For current wireless implementations, it is prohibited to use WEP after June 30, 2010. 

Learn more 

Cancel or Hold a Transaction in Progress 
Find a Document | Edit Documents | Reverse Documents 
  
A sales receipt or other transactional document can be canceled or put on hold at any time before saving. 
Exception: Sales receipts with authorized credit, debit/ATM, or gift card payments cannot be put on hold. See note 
below. 

• Canceling permanently discards the document; no record is kept and inventory is not affected. 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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• Holding a document temporarily saves it in its present state. Holding a document does not affect inventory 
quantities. Later, you can return to a held document, complete and save it, at which time inventory will be 
updated. 

What would you like to do? 
Cancel a transaction in progress  

1. Select Cancel from the bottom of the document anytime before saving. 
2. In the confirmation dialog, answer Yes to discard the document. 

Or, answer No to return to the transaction. 

  
Hold a transaction in progress  

• From the bottom of the document, select Put on Hold (or Hold <document type>). 
While a document is on hold, you can print, view, or delete it. (May be subject to security rights) 

  
View or take a transaction off hold and complete it  

1. Access the held document list by selecting, as appropriate: 

• Held Receipts from the Point of Sale menu 

• Held Vouchers from the Purchasing menu 

• Held <Quantity or Cost> Memos from the Inventory menu 

• Held Transfer Slips from the Inventory menu 
You can also make this selection from the bottom of a blank document of the same type. 

2. Locate and highlight the document, then select Unhold. 

• You can also print, view, or delete held documents. (May be subject to security rights. No 
copy of a deleted document it is kept.) 

• (Pro) Held receipts can be converted to customer orders. With the held document selected, 
choose Make Customer Order  and an order type from the I Want To menu. 

• To leave the held list without un-holding a document, select Go Back (or Close). 
2. Complete and save the document in the usual manner. 

  

  
  

Notes: 
• Placing a document on hold temporarily sets it aside. With a document on hold you can carry out other 
activities, make another document of the same type, run reports, or even exit from Point of Sale. There is no 
time limit for how long a document can be left on hold. 

• If changes are made to your sales tax rates, item prices, a customer's discount, etc. while a document is 
on hold, that document will not automatically reflect the new information when it is unheld. The unheld 
document retains the original information. If necessary, delete and re-list the item(s) and/or customer in order 
to reflect changes. 

• The document number field on held documents is temporarily changed to "Held". A new document number 
is assigned when the document is taken off hold and completed. 

• If using the QuickBooks POS Merchant or Gift Card Services, you cannot hold authorized credit card or gift 
card sales receipts. You will have to cancel/void the payment first. When canceling a credit card sales, the 
customer’s account is never charged. When canceling a gift card receipt, Point of Sale contacts the gift card 
service to update the card balance. 

• Once authorized, debit/ATM receipts cannot be held or canceled. This is because the cardholder's account 
has already been debited for the sale amount. 
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• In a multi-workstation environment, a held document can be accessed and unheld from any workstation on 
the network. 

Print Gift Receipts 
Sales Overview | Printing Overview 
  
You can print a gift receipt that does not include specific item, price or payment information. This feature is useful 
around Holidays or if you specialize in gift merchandise. 
With a gift receipt, customers can safely include the receipt inside a gift package or give the receipt to the recipient. 
If the recipient needs to return or exchange the gift, they already have the receipt and there’s no need to 
inconvenience the gift giver. 
The bar code printed at the bottom of the gift receipt indicates the original receipt number and you can quickly find 
the original sale receipt by scanning the gift receipt bar code (or typing the receipt number) in the Quick Find 
window on the home page Navigator or the Find Receipt window in sales history. 
With the gift receipt preference turned on, you are prompted to print a gift receipt every time you save a receipt. 
Each workstation can enable gift receipt prompting individually. 

To be prompted to print a gift receipt on every sale: 

1. Return to the Home Page if not already there.  
2. From the File menu, select Preferences  Workstation. 
3. Select Documents & Printers from the preferences list on the left. 

Verify the printer and print template to be used for gift receipts. Note: The gift receipt printer is automatically 
set to the same printer used for regular sales receipts, but a different print template can be used if desired. 

3. Select the Print Options page from the preferences list on the left. 
4. Select the Prompt for gift receipt with each sale checkbox. 
5. Select Save. 

To turn off prompting of gift receipts, return to the same page and clear the checkbox. 
  

Alternate Method 
If you have your Print Options preferences set to show the Print dialog for each 
sales receipt, you can select to print a gift receipt on the dialog when needed 
instead of setting the global preference to prompt you. 
  
  
  
Related Topics 
Customize your print templates 

Email a PO  
Basic  

You can e-mail Point of Sale documents to your vendors and customers. All documents are e-mailed using the 
same basic procedure. 
When e-mailing documents, Point of Sale automatically launches your default Windows e-mail client, creates the e-
mail, and attaches the document in PDF format. 
(Pro) Other document e-mailing preferences allow you to create the document attachment in the format of your 
choice (PDF, Excel, HTML, or plain text) and define the default message text for each document type. 
You must have entered e-mail addresses for the customer and/or vendor being e-mailed on their respective 
records. 
  
To e-mail a document: 

1. Create the document following normal procedures. 
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2. Display or select the document to be e-mailed: 

• Optionally, you can set your printing preferences to be prompted to e-mail each sales receipt to your 
customers (in addition to printing the receipt). This option also provides you an opportunity to collect 
customers' e-mail addresses if you don't already have them. 

• Order documents, such as purchase orders and customer orders, can be e-mailed while creating them or 
from the order list.  

• Transactional documents, other than sales receipts as described above, must be saved before they can 
be e-mailed from the document history list. 

4. Select Send as E-mail from the I Want To menu (or from window toolbar in some lists). 
 
Point of Sale creates the e-mail, attaches the document, and displays it in your default e-mail client.  
 
Important: Your e-mail client may display a permissions dialog for access to your e-mail application. In 
some cases, the message may be hidden under the POS window. Press <Alt+Tab> on your keyboard to 
switch to the message and give permission for the access. 

5. Review and edit the e-mail address, subject line, and message as necessary, and then select Send. 
Note: If you also have Microsoft Outlook installed, the e-mail and attachment will be generated in Outlook instead. 
You can either select Microsoft Outlook as your default e-mail client or, if you wish to continue using Outlook 
Express, use the Add or Remove Programs option from the Windows Control Panel to uninstall Microsoft Outlook. 

Open the Cash Drawer 
Take Payments on Sales | Record Cash Drawer Payouts 
  
Point of Sale is set up to automatically open a configured cash drawer as you complete a receipt using certain 
payment methods, such as cash or check. You can specify which payment methods open the cash drawer in 
company sales preferences. 
The cash drawer also can be opened manually as explained below. 

To open the cash drawer manually: 

• From the POS Home Page, select Open the Cash Drawer from the Point of Sale menu. 
Or 

• Press <Ctrl + F8> 
  
Related Topics 
Sales overview 
Compatible cash drawers 
Troubleshoot the cash drawer 

Pay Money out of the Cash Drawer (Payouts) 
Open the Cash Drawer | Sales Overview 
  
Cash sometimes needs to be removed from the cash drawer. For example, you may remove cash from the cash 
drawer to buy office supplies, make a donation,  purchase pizza for the office party, or to have less cash on hand 
for security reasons. 

To record a cash drawer payout: 
1. From the Home Page, select New Payout from the Point of Sale menu 

OR 
From a new receipt or your sales history, select New Payout from the I Want to Menu. 
The Cash Paid Out dialog is displayed. 

2. If you are not requiring employee logins, enter your name in the Cashier field. 
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3. Enter the amount in the Amount field. 
4. If you are using QuickBooks financial software, select a QuickBooks account from the drop-down 
list in the Account field. 
 This is the account that the payout amount will be balanced against in QuickBooks. Learn more. 
 A default payout expense account can be defined in company preferences and will be suggested. 
 If paying out tip/gratuity amounts collected on sales, select the Employee Tips Payable liability 
account (or a custom account if you have created custom account mappings). 
5. (Required) Record the reason for the payout in the Comment field. 
6. Click OK. 

A Payout receipt is generated and placed in your sales history. The amount of the payout is recorded as a negative 
amount. 
  

Notes: 
• On X/Z-Out reports, the term "paid out" typically refers to money or other payment given to the customer 
for any reason, such as giving change for a normal sales receipt or refunding cash to a customer on a return. 
However, in the list of non-currency media contained at the end of X/Z-Out reports, there is a list of payouts, 
meaning cash removed from the cash drawer using the payout feature as described above. It is important to 
be aware of the distinction. 

Related Topics 
Handling bank deposits after Financial Exchange with QuickBooks 

Receipt Fields 
Sales Overview | Data Field Overview | Program Capacities 
  
Refer to the table below for descriptions of each receipt field. Fields shown in brackets, e.g. [field name], are 
suggested  or read-only  fields auto-filled by Point of Sale. 
If, when viewing a record list, columns (fields) shown below are not visible, you can use the customize columns 
feature to add them. 
  

Field Usage 

Promo Code Used to record an optional promotional note 
on a receipt. Sales reports can be filtered by 
this field. You can also set your company 
preferences to require an entry in this field. 
For example, if you are having a mail 
promotion to celebrate your business 
anniversary, you could record an entry of 
Anniv for all sales made during the 
promotion. Later, you could run a sales 
report, filtered for the Anniv entry in the 
Promo Code field to evaluate the 
effectiveness of the promotion. 

[Store]  (Pro) The store from whose inventory the 
merchandise is being sold/returned. At 
Headquarters, can be changed to create a 
receipt for any store. At remote stores, this 
field defaults to the local store and cannot be 
changed. 

[Date] Defaults to today's date; but is editable 
subject to security rights.  Never change your 
computer's system date for this purpose; 
doing so could result in lost data! 
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[Cashier] If security is used, the Cashier field is auto-
filled with the name of the logged-in user and 
cannot be changed. If not using security, 
select a name from the drop-down list of 
defined employees. 
(Pro) The cashier is the employee making the 
receipt and may be different than the sales 
Associate. 

[Associate] 
 (Pro) 

(Optional Field) Used to identify the employee 
to be paid a commission on the sale. 
Above the item list: Suggested as the logged 
in user (if security used) but can be edited to 
identify the sales associate for the receipt. If 
you change the associate after listing items, 
you are asked if you want to assign this 
associate to the items already listed. 
In the receipt item list or Item Information 
window: Suggested as the same employee 
listed at the top of the form, but editable item-
by-item. This allows commissions to be paid 
to multiple employees on a single receipt. 
Exception: If the receipt was initiated from a 
customer order to sell the ordered items, the 
Associate field is populated with the 
associate recorded on the order. 
Learn more. 

Item Fields These fields pertain to individual items being 
sold. See also item fields for a description of 
common item fields that may be available on 
receipts. 

[Item Name] 
[Attribute] 

[Size] 

Item description fields; suggested from item 
record in inventory. Can be edited for 
individual sales if necessary. 

[Qty] Sales Quantity: Suggested as 1. Directly edit 
or use the Qty + and Qty – buttons to 
change. 

[Price] Item unit sale price at the active price level. 
The default active price level is set in 
company preferences. Editable. 

[Ext Price] Extended item price: Qty x Price. If you sell 
items costing a fraction of a cent, you can list 
a quantity and enter an extended price and 
Point of Sale will calculate and display the 
unit price. 

[Original Price] Item price at the active price level, from 
inventory. Does not change if Price field 
edited. Not editable. 

[Custom Price 
Levels] 

Item price at each of your price levels, from 
inventory. Your custom price level names 
displayed. 

Item Discount 
Fields 

  

Entering a discount percent, amount, or 
changing the item price causes other 
discount fields to be auto-calculated. See 
giving discounts for more information. 
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Discount % Item discount expressed as a percentage of 
the active price. 

Unit Discount Discount amount per item unit being sold. 

Ext Discount Extended item discount. Qty X Unit 
Discount. 

Discount 
Reason 

Can be used to filter sales reports. For 
manual item discounts, select from the 
discount reasons predefined in company 
preferences. 
(Pro)  For Price Manager discounts or 
customer rewards, is auto-filled with reason 
from the applicable area. 

[Tax Code] Suggested as the tax code assigned to the 
item in inventory. Select a different tax code 
to change the tax collected on this sale. 
Learn more about changing tax at time of 
sale. 

[Tax %] Tax percentage applied to the item. If multiple 
rates apply, this field is blank. 

[Tax] Tax amount collected per item unit. 

[Ext Tax] Extended tax on item. Qty x Tax. 

[Cost] Average unit cost of the item as recorded in 
inventory. Not editable. 

[Receipt Cost] Extended cost of receipt item. Qty x Average 
Unit Cost. Not editable. 

[Unit of 
Measure] 

Used to indicate the measurement or quantity 
by which the item is sold. From inventory, 
such as case, each, lb., yard, etc. Learn 
more. 
(Pro) Can be added to printed documents, 
using the Print Designer. If using multiple 
units of measure, defaults to your sell-by unit 
but can be changed to sell by another unit. 

Serial # 
(Pro) 

Field used to track serial numbers of sold 
items. Items can be designated as requiring a 
serial number entry on the item record in 
inventory (by selecting the Prompt option in 
the Serial # Tracking field,) in which case 
you will be prompted to enter a serial number 
for each unit of the item sold. 

[Commission] 
[Commission %] 

(Pro) 

Optional fields that display commission 
information for the sale, based on the 
employee recorded in the Associate field. 
Learn more. 

Return to top 
  

  

Customer 
[Name, Address 
and other 
information] 
Not available in 
Point of Sale Free 

Customer information fields that display the 
name of the customer to whom the sale is 
being made. Also used as the customer 
lookup/search field. Read more about 
searching for and listing a customer on a 
receipt here. You can require that a customer 
be listed on all receipts in company 
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preferences. 
Individual Customers: Customer full name, 
including specified combination and order of 
first and last names, and title is printed on 
receipts in the format specified in company 
preferences. 
(Pro) Business Customers: The customer 
company name is displayed. Learn more. 
After listing a customer, use the Edit  button 
to view or edit the customer record. 

Comments Used to record pertinent information about 
the sale. Printed on copy of receipt given to 
customer. 

Totals Area These fields apply to the entire receipt and 
located at the bottom right. 

[Price Level] Active receipt price level. Suggested as your 
default price level from company preferences. 
Change by selecting a new level from the 
drop-down list. 

[Subtotal] 
  

The sum of the extended prices for all items 
listed on a receipt. 

Disc % 
Discount 

Global discount percent. 
Global discount amount. 
Global discounts are taken from the receipt 
subtotal and not spread across the sold 
items. Entering a value in either discount field 
causes the other to be auto-calculated. See 
giving discounts for more information. 

[Tax %] Tax percentage applied to the sale. If multiple 
rates apply, or some items taxed and others 
not, this field is blank. 

[Tax] Total tax amount collected on the sale. 

Ship Date 
Shipping 

(Pro) 

Scheduled date of shipment. 
Shipping charges. 
Select Ship These Items to enter shipping 
information and charges. Learn more. 

Total Total amount due from customer (or to 
customer in case of a return). This amount is 
carried to the payment window. 

[Tax Location] Current tax location is displayed in the receipt 
status bar at bottom of form. Defaults to the 
tax location specified in company 
preferences. The tax location (for entire sale) 
or tax codes (for individual items) can be 
edited, if necessary. Learn more. 

[Printed Receipt 
Message] 

User-definable message, specified in 
company preferences, which is printed on the 
copy of the receipt given to the customer. 
These messages are not displayed on screen 
and cannot be changed at the time of sale. 
For example, you could use the message 
field to print "We Appreciate Your Business" 
or your return policy on every receipt. 
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Sales history list 
fields 

These fields are available only in the your list 
of saved receipts. 

[Receipt #] 
  

Sequential number assigned to receipts as 
they are created. 

[Receipt Type] Indicates type of receipt: Sale, Return, 
Payout, or Deposit. 

[Status] Indicates status of receipt as: Regular, 
Reversed, Reversing. Learn more about 
reversing receipts. 

Payment The payment method used for the receipt. If 
more than one payment method was used, 
Split is displayed. 

[QB Status] If integrated with QuickBooks, displays the 
Financial Exchange status of the receipt: not 
posted (not yet sent to QuickBooks), 
complete (sent to QuickBooks), or error 
(attempting to send the receipt to QuickBooks 
resulted in an error). Learn more. 

  
Return to top 

Company Preferences: Sales 
Preference Instructions | Sales Overview 
  
Sales preferences allow you to define various options related to sales transactions.   
The Sales page covers the general sales preferences. Other sales preferences are discussed on sub-pages (select 
a link for instructions). 
Discounts – define and optionally require manual item discount reasons 
Receipt message – printed on every sales receipt 
Shipping – list of shipping providers 
Receipt tendering – payment options 
  
Sales – General 
Preference Function 

Order to display full 
name field 

Choose the order in which to display/print 
customer names on receipts. 
Example: A record has Sara in the First 
field, Edward in the Last field, and Ms. in 
the Title field. If you choose to display 
the name as last, title, first, Point of Sale 
will print the name as Edwards, Ms. 
Sara. 

Require a 
promotional code 
entry 

 = Requires an entry in the Promo 
Code field on a receipt before payment 
can be accepted and the document 
saved. This field facilitates filtering for 
viewing or reporting purposes. 
(Pro) This also applies to customer 
orders. 

Require a manual 
media count for X/Z-
Out 

 = If selected, associates are required 
to manually count each denomination of 
currency when running a Z-Out Drawer 
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Count report. 

When printing group 
item on receipt or 
customer order (Pro) 

Select to print the group item price only, 
the individual component item prices 
only, or both. Default is to print individual 
item prices only. 

Open Cash Drawer  = Select the payment types that will 
open an attached, compatible cash 
drawer. Defaults: Cash, Check. 

Return to top 
  
Related Topics 
Customizing receipt item list columns 
Customizing printed receipts and other documents 
Company preference: removing unused features 
Company preferences overview 
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Customers  

Customers Overview 
How do I?  | Customer Preferences | Add a Customer 

Add a Customer 
Edit a Customer Record 
Merge Customer Records 
Offer Customer Charge Accounts 
Offer Customer Discounts and Price Levels 
Handle Special Customer Tax Status 
Track Customers by Type 
View Customer Purchase History 
Print my Customer List 
Export my Customer List 
Create an E-mail Marketing List 
E-mail a Customer 
Write Letters to Customers 
Track Business Customers 
Offer a Customer Rewards Program 
Use Customer IDs and Cards 

  
  

Basic  

Point of Sale can store a great deal information for each of your customers, including name and contact 
information, wether personal checks should be accepted, charge account information, and extensive notes. 
Customer information can be used for marketing purposes, reporting, and printing mailing labels. 
Recording of customers on sales receipts (referred to as customer tracking) allows you to: 

• Build customer sales history, giving you the ability to quickly look up a past purchase and run reports and 
marketing programs for your best customers 

• Offer store charge accounts 

• E-mail sales receipts from Point of Sale 

• Automatically adjust sales tax for customers eligible for special tax handling 

• Automatically give discounts or use markdown price levels for selected customers 

• If also using QuickBooks financial software, share customer and account information so invoices and 
payments can be created/taken in QuickBooks 

Pro-level user have these additional options: 

• Set up and track customer purchases in a rewards program 

• Record and use customer shipping addresses and charges on sales 

• Record and track business customer PO numbers on sales and orders 

• (Multiple stores) Customers can be added, edited, or deleted at any store, with the resulting changes 
propagated to all stores with the next fully completed Store Exchange cycle. Headquarters maintains the 
master customer list, which is sent to all stores in its entirety during every Store Exchange. Learn more. 

Note: The availability of customer tracking features can be controlled by your Features to Use preference settings. 

  
Related Topics 
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Customer Center 
View customer list summary statistics 
Security rights for working with customer records 
How customer information is shared with QuickBooks 
Protecting customers' payment card data 

Access your Customer List 
How do I?  | Customer Overview 

Add a Customer 
Edit a Customer Record 
Merge Customer Records 
Offer Customer Charge Accounts 
Offer Customer Discounts and Price Levels 
Handle Special Customer Tax Status 
Track Customers by Type 
View Customer Purchase History 
Print my Customer List 
Export my Customer List 
Offer a Customer Rewards Program 
Use Customer IDs and Cards 

  

Basic  

To access your customer list: 

• From the Home Page, select Customer List from the left side bar or from the Customers menu 
  

Customer Center 
How do I?  | Customers Overview 

Add a Customer 
Edit a Customer Record 
Merge Customer Records 
Offer Customer Charge Accounts 
Offer Customer Discounts and Price Levels 
Handle Special Customer Tax Status 
Track Customers by Type 
View Customer Purchase History 
Print my Customer List 
Export my Customer List 
Create an E-mail Marketing List 
E-mail a Customer 
Write Letters to Customers 
Track Business Customers 
Offer a Customer Rewards Program 
Use Customer IDs and Cards 
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Basic  

The Customer Center provides a summary of key customer statistics for a specified time period, one-click access 
to customer contact options, and links to FAQs and tools to help make managing your customers easier. 

To access the Customer Center: 

• Select Customer Center from the Customers menu. 

Customer Statistics 
Set the time period for statistics from the Edit drop-down list. Current period statistics are compared to the 
preceding period of the same length (year-to-date is compared to year-to-date last year). 
(Pro) At a remote store, customer statistics reflect activity at that store only. 
View definitions of the displayed statistics  

• Total customers—The number of customers in your customer list; not affected by the time 
period specified. 

• New customers—New customers added during the time period specified. 

• Returning customers—Count of sales receipts made to non-new customers during the 
specified time period. Does not include reversed/reversing receipts. 

• Average daily receipts—Average number of sales receipts made per day. Does not include 
reversed/reversing receipts. 

• Average receipt total—Average sales receipt total. Does not include reversed/reversing 
receipts. 

• Average items—Average number of items sold per sale receipt. Does not include 
reversed/reversing receipts. 

• New customers per month (bar graph)—Shows number of new customers added per 
month, over last 12 months. Not affected by time period selected. 

  
  

Reach Out to Your Customers 
Use the links in this section to launch the Point of Sale wizards that guide you through contacting your customers 
via: 
E-mail marketing campaign lists 
Write letters 
Print mailing labels 
Export your customer list to a file 
  
Related Topics 
Office Integration 
E-mail Customers 

Company Preferences: Customers 
Preference Instructions | Customer Overview 

Basic  

Customer preferences allow you to specify if you want to share customer information with your QuickBooks 
financial software and if you want to require that a customer be recorded on all sales. Recording customers on 
sales allows you to offer customer-specific discounts, use charge accounts, and to build customer sales history. It 
is not necessary to require that a customer be recorded to use these features. 
  

Note: You must have customer tracking enabled in your general  preferences for the following customer-specific preferences to 
be applicable. 
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Preference Function 

Use with QuickBooks Choose Yes if you want information for 
all new customers to be shared with 
QuickBooks by default. You can still 
change this setting for individual 
customers on their record. 

Customer tracking 
options 

 Require a customer entry on receipts. 
If selected, a receipt cannot be saved 
until a customer is entered. 
Note that this option is not required to list 
a customer on a sale. 

E-mail Marketing If you have an account with the POS e-
mail marketing partner , enter your login 
name and password here. Targeted 
customer lists you create in Point of Sale 
can then be sent automatically to the 
partner. Learn more. 

Customer Type Create categories of customer types for 
your business. Customer types can then 
be assigned in the customer record and 
used for filtering the customer list and 
reports. 

Company preferences overview 

Add a Customer 
How do I?  | Customer Information Fields | Customer Overview 

Add a Customer 
Edit a Customer Record 
Merge Customer Records 
Offer Customer Charge Accounts 
Offer Customer Discounts and Price Levels 
Handle Special Customer Tax Status 
Track Customers by Type 
View Customer Purchase History 
Print my Customer List 
Export my Customer List 
Create an E-mail Marketing List 
E-mail a Customer 
Write Letters to Customers 
Track Business Customers 
Offer a Customer Rewards Program 
Use Customer IDs and Cards 

  
  

Basic  

Note: If you have accessed this topic after copying a customer record, start with Step 2. Edit the information brought from the 
copied record as needed. 
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It is helpful to be consistent when entering customer information. Consistently using the same data format makes it 
easier to sort, search, and look up customer records. 

To add a customer: 
1. From the Home Page Customers menu, select  New Customer. 

OR 
From your Customer List, click the Add button. 
OR 

From the Customer field on a sales receipt, click the  icon and then choose Add New Customer. 
A blank customer form is displayed. 

2. Navigate through the sections on the customer form and enter name, contact, and optional 
information for the customer: 

Expand each section of the form by clicking the small triangle icon to the right of the label: 

 
• Name: The Last (Name) field is required to save a customer record, unless Track as Company 
is selected (see below). 

• Track as Company (Pro):  Allows you to record customer PO numbers on transactions for the 
customer and display the company name throughout Point of Sale (in the Full Name field). With this 
selection, Company (Name) is a required entry. Learn more. 

• Contact Info:  Enter the customer's phone, e-mail, and address. 

• Customer Notes: Add whatever notes might be helpful, such as birthday, clothing sizes, gift 
preferences, etc. 

• Custom Fields (Pro):  You can define and use custom fields to record additional information. 
Using custom fields allows you to use the information to filter reports. 

• QuickBooks Options: Use these settings to control sharing of customer information with 
QuickBooks financial software and to set up and maintain charge accounts for the customer. 

o   Use with QuickBooks: Select this checkbox share this customer's information with 
QuickBooks. A company preference controls the default setting of this option. 
o   Charge Account: Select to allow charges for this customer and enter an account 
limit. Learn more 

• Customer Settings: Use this area to set other options: 
o Customer ID (Pro): Customer IDs are automatically assigned to new customers and 
can be used to print scannable ID cards. Learn more 
o Rewards Member (Pro):  If offering a Rewards program, elect the checkbox to enroll 
this customer. Learn more 
o Alternate contact info: Enter additional phone numbers. 
o Customer Type: Categorize your customers in ways that are meaningful to your 
business. Learn more 
o Tax Location: Specify a customer tax location for special tax handling (Set up can use a 
0% tax location for tax-exempt customers).  Learn more 
o Customer Discounts:  If applicable, click the Discount button and specify a customer 
discount or price level to suggest on all sales to the customer. Learn more 
o Accept Checks: Select the checkbox if checks are to be accepted for payment from this 
customer. 

• Addresses (Pro):  Use this area to enter additional shipping addresses and print shipping labels. 
The address entered in the Contact Info section is automatically added as the default shipping address. 
Select the Do not mail to Bill To Address checkbox to prevent this and then click Add to enter alternate 
shipping addresses (up to ten). Designate one as the default. The default shipping address will be 
suggested when you add shipping information to sales receipts. 
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3. Select Save. 
  

Notes: 
• If an existing customer record is very similar to a new one you are creating, copying and editing the 
existing record might be the quickest way to create the new record. 

• If you are integrated with QuickBooks financial software: 
 Customer names can be sent to QuickBooks in the order you prefer (e.g. <first, last> or <last, 
first>). Learn more 
 Charge account balances and limits are shared between the programs. You cannot track account 
charges without also having the Use with QuickBooks option selected. Learn more 

Note: The availability of customer tracking features can be controlled by your Features to Use preference settings. 

  
Related Topics 
Track customers by type 
Track business customers 
Edit customer records 

Search for a Customer 
Sort Lists | Filter Lists 

Basic  

From the Point of Sale Home Page, use Quick Find. 

Searching in your customer list: 
  

1. Open your Customer List. 
2. Begin typing customer keywords in the Search Customers field.   

 
• Last name or company name is recommended 

• You can also search by phone number, e-mail address, street name, or any other customer field 

• As you type, the list is instantly filtered to display only matching customers. Note how the filter 
button now indicates the list is showing Search Results and the number of records found is shown at the 
bottom of the list. In this case, typing "sky" returned two customers living on Skyline Drive. 

 
3. If no results are found, use the backspace key on your keyboard to go back and re-enter new 
characters. 
4. Select the customer you wish to work with and then click Show Details or choose an appropriate 
task from the I Want To Menu. 

  
Related Topics 
List a Customer on a Receipt 
View Customer Purchase History 
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Edit a Customer Record 
Find a Customer | Customer Fields | Customer Overview 

Basic  

To edit a customer record: 
1. Find and select the record you wish to edit in your customer list. 
2. Select Edit. The record is opened in an editable form. 
3. Edit the customer information fields as necessary. 
4. Select Save. 

  
If you have to edit many customer records at once, such as when a ZIP Code or phone area code changes, 
consider using list edit mode. List edit mode allows you to make changes directly in your customer list, similar to 
working in a spreadsheet. 
  
Related Topics 
Delete a customer record 
Merge duplicate customer records 
Manually issuing or canceling a customer reward 
Tracking customers in multiple stores 

Delete Customer Records 
Find a Customer Record | Merge Customer Records 

Basic  

To delete customers: 

1. Select the customer record or records you wish to delete in your customer list.  How do I select 
multiple records?   
2. Select Delete from the I Want To menu. 

Point of Sale will alert you if a selected customer cannot be deleted. 
3. If prompted, confirm the deletion and specify if you want to delete the customer(s) from your 
QuickBooks financial software as well. 

  

Notes: 
• You cannot delete a customer with a non-zero account balance. To delete such a customer the account 
balance must be reduced to zero, typically by taking a payment on account. 

• If you are deleting a customer because you have duplicates, consider merging the customer records 
instead, as this will combine the two customer histories into one and remove the other. 

• We recommend deleting the customer in QuickBooks financial software if prompted. To guard against 
accidental deletion, if a customer record is deleted in only one program, it is re-created upon the next 
Financial Exchange. Note that if the customer is listed on documents in your financial software, the record is 
made inactive instead of deleting it. Making the customer inactive also prevents the record from being re-
created with the next Financial Exchange. 

• (Pro) If you delete a customer, but later list that customer on a sales receipt (by referencing a customer 
order listing the customer) the customer is re-created in both Point of Sale and your financial software with 
the next Financial Exchange. 

• (Pro) Read more about handling customers in a multi-store configuration. 
Related Topics 
Edit a customer record 
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Customers overview 

Merge Customer Records 
Delete a Customer | Edit a Customer | Customers Overview 

Basic  

Occasionally, you may find that a customer has been entered twice in your customer list. This might happen, for 
example, if an associate spells the name slightly different when looking up the customer, and believing the 
customer isn’t in the list, adds them again with the different spelling. Merging the customer records combines the 
sales history of the two records into a single record and then deletes the other. 
If you are integrated with QuickBooks financial software, you will be prompted to delete the duplicate record in 
QuickBooks as well. 
(Pro) This feature is available at Headquarters only. 

To merge customer records: 
1. In your Point of Sale customer list, select one or both of the customer records you wish to merge. 
How do I select multiple records in my list?   
2. Select Merge from the I Want To menu. 

The Merge Customers window opens with the pre-selected customer(s) listed. 

 
3. Review the customers and make changes as necessary: 

• To add or change a customer, use the drop-down lists to select or search for the customer. 

• Ensure the customer record you want to keep is displayed on the left side of the window. You can 
reverse positions of the records (which to keep and which to remove) by selecting the Swap button 
located between them. 

• If you are integrated with QuickBooks financial software, the name(s) as shown in your 
QuickBooks customer list are shown to help verify you have the correct customers selected. 
4. Select Merge Customers. 

If the customer being removed has a sales history, a listing of the number of sales receipts and customers 
orders to be updated is displayed. The customer on these documents will be replaced by the customer you 
selected to keep. Tell me more. 

5. Select Merge Customers. 
6. If prompted, specify if you want to delete the duplicate from your QuickBooks financial software 
as well. See notes below for more information. 

  

Notes: 
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• If selected, the deletion in QuickBooks will occur with the next Financial Exchange. If the customer to be 
deleted has a transaction history in QuickBooks, the customer is made inactive instead of being deleted. If 
the customer is not deleted or made inactive in QuickBooks, it will be re-created in Point of Sale with the next 
Financial Exchange. 

• Updated documents resulting from a merge in Point of Sale are not resent to QuickBooks and the 
customer records in QuickBooks are not merged. However, all new transactions will be recorded in 
QuickBooks for the customer you selected to keep. 

Related Topics 
How customer records are exchanged with QuickBooks 

View Customer Purchase History 
Locate a Customer Record | Merge Customer Records 

Basic  

Customer history reports allow you to view summarized statistical data for customer purchases and returns, as well 
as a list of all receipts and all non-deleted customer orders made for the customer. You can expand the documents 
included in the report to view item detail or QuickZoom to view the associated documents. 

To view a customer’s history report: 
1. Access the customer history in one of these ways: 

• In your customer list, select the customer and click Details. 

• List the customer on a sales receipt or customer order and then click the View/Edit button to 
open the customer record. 

 
A list of transactions for the customer is summarized in the History section of the customer details. 

 
  
With customer history displayed, you can click a transaction in the list to open it for review.: 
   
Notes: 

• If you came to the Customer History window from a sales receipt (or customer order), you can't open a 
receipt from sales history. (Only one instance of a document type can be opened at a time). 

• (Pro) If you delete customer orders once they are filled, the deleted orders are no longer displayed on the 
Customer History window. However, the sale of the merchandise on deleted customer orders is reflected in 
the history. 

• (Pro) Customer history at remote stores reflects only the documents made at the local store. Headquarters 
sees completed sales at all stores, but not pending customer orders made at remotes. 

Customer Ratings 
View Customer Purchase History   
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Basic  

Customer ratings provide a graphical ranking of your customers based on profit realized or total dollar sales volume 
over a specified time period. 
  

Turning on Customer Ratings 
You can turn on/off customer ratings and specify the performance criteria and time period on the Ratings & Trends 
page of company preferences. Only the Server Workstation can change the ratings preferences. 
Ratings are displayed in the Statistics section of the customer form. In addition to the graphical rating, other 
statistics are provided for the customer, such as the last sale date and total sales, returns, and discount amounts. 
You can customize your customer list columns to view the graphical ratings directly in the list. 
  

 
  

About Customer Ratings 
Customer ratings use a familiar five star system, reflecting the performance of the customer over the specified time 
period. Each star represents 20% of the range between the highest and lowest values for your customers. 
For example, if ranking by sales volume and the range of customer purchases for the period is from $1 to $100, 
customers buying from $1 and $20 would receive 1 star, buying $21-40 is rated two stars, etc., up to a five-star 
rating for purchases of $81-100. In theory, all of your customers could be five-star performers. 
  

Rating Description 

 

5 Stars (81st - 100th percentile) 

 

4 Stars (61st - 80th percentile) 

 

3 Stars (41st - 60th percentile) 

 

2 Stars (21st - 40th percentile) 

 

1 Star (0 - 20th percentile) 

 

0 Stars (No purchase this period) 

 

No purchase ever 

  

Notes: 
• The rating period can be set from 1 to 999 days. 

• Ratings are updated at least once a day (on program startup or automatically between 1 am and 5 am if 
your computer is left running). Ratings are not updated real-time with the current day’s. 

• The ability to view customer ratings can be controlled by a security right. 

• (Pro) Ratings are calculated at Headquarters only and reflect sales at all stores. They are sent to remote 
stores where they can be viewed. 

Related Topics 
Customer Rewards Program 
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Track Customers by Type 
Customer Overview | Report Overview 

Basic  

Customer types let you categorize your customers in ways that are meaningful to your business. For example, you 
could set up your customer types so that they indicate whether a customer is a business* or individual customer, 
their geographic location, or how they first heard about your business. 
You can filter reports and do special mailings that are based on your customer types. For example, if you use 
customer types to categorize your customers by location, you could print mailing labels for all the customers in a 
particular region. 
Define your customer types in company preferences and then associate a type with each customer on their 
individual records. 
  

Notes: 
• *Pro users have another option for tracking business customers. 

• When printing customer mailing or shipping labels or lists, sort the list by customer type and then select 
them all. 

• Its generally better to use customer types to categorize customers for only one purpose. Don’t try, for 
example, to set up customer types for both tracking geographic area and how customers heard about you. 

Related Topics 
Edit a customer record 

Customer Discounts and Price Levels 
Price Levels | Give Discounts on Sales | Customers Overview 

Basic  

A percentage discount or a markdown price level, but not both, can be associated with a customer, so that it is 
automatically suggested on sales to the customer. You have the option of applying the discount or price level to 
each sale. 
If using a percentage discount, it is applied as an item discount to all items being sold (except gift cards/certificates) 
and it is applied against the active price level. 

To define a customer discount or price level: 
1. On the Add or Edit Customer form, open the Customer Settings section. 
2. Click the Disc(count) button. 
3. On the Customer Discount window, select Apply fixed percentage discount to all items and 
enter a discount percentage 

OR 
Select Use a markdown price level for this customer and then select a price level from the drop-down list. 
You must have your price levels predefined in company preferences to be available for selection here. 

4. Click the Close Customer Discount Window link. 
  

Note: If you click Save at the bottom right, the customer record is saved and closed. Simply re-open it if you have additional 
information to add/edit. 

  
Related Topics 
Edit a customer record 

Using Customer Tax Locations and the Tax-Exempt Flag 
Sales Tax Overview | Using Tax Locations 
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Basic  

There are two ways You can automatically have Point of Sale collect the correct amount of sales tax on sales to 
customers that qualify for special tax handling. 

• Specify that the customer is tax-exempt. This is the easiest option if sales tax is never charged on sales 
to the customer, such as may be the case with charitable organizations or certain re-sellers. 

Example: The customer is from another state and your tax regulations do not require sales tax to be collected 
on out-of-state sales. 
  

A hard-coded tax location, named Exempt, is used on sales to customers you have marked as tax-exempt and has an 
automatic 0% tax rate for all tax codes. The Exempt tax location is not displayed in your sales tax preferences, but is 
available for filtering sales reports. 

• Set up and assign a tax location to the customer. This option is best if the customer is taxed, but at a 
different rate than your normal tax rates. You are prompted to apply the customer tax location when making a 
sale to the customer, but can elect to do so or not on individual sales. 

To set up special customer tax handling: 
1. While adding or editing a customer record, select the Customer Settings section. 
2. Select a tax location from the Tax Location drop-down list. Only tax locations previously set up in 

company preferences are available. 
Or 
Select the Tax-exempt checkbox. 
3. Complete the record and save. 

  
Related Topics 
Edit a customer record 
Customers overview 

Enter a Customer on a Receipt 
Customer Overview | Make a Sale 

Basic  

Entering customers when making sales is optional; though it can be required with a company preference setting. 
Entering customers allows you to build customer purchase histories and to offer customer-specific discounts, price 
levels, and tax locations. 
Any customer on file can be entered and a new customer can be added while completing a sale. 

To enter a customer on a receipt: 
1. In the Customer field, begin typing the customer last name (recommended) or other search 
keyword (first name, phone number, company name, etc). 

As you type, Point of Sale shows a drop-down list of your matching customers, separated into last name 
matches and matches using all customer fields. If there are last name matches, they are displayed first. Click 
the results line to open all field matches if necessary. 
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Option: With no entry in the field, you can click the  icon to show your entire customer list. You can scroll 
through the list to look for the customer. 

2. Click a name to select it. Keyboard users can use the arrow up/down keys to move through the 
list and <Enter> to make a selection. 

The customer is added to the customer field on the receipt and their phone number and address is displayed 
for confirmation. 

• If the customer has an associated discount, price level, or special tax handling, it is suggested or 
automatically applied to the sale 

• If the customer isn't in your list, click Add New Customer to create a new customer record 

• Click the View/Edit button to open the customer record or the Delete button to remove the 
customer from the receipt 

 
Not all customer information is displayed on a receipt. For example, the customer's charge account information and 
check acceptance status are not displayed. However, you will be notified if a credit limit is exceeded, if checks are 
not accepted, or if a reward is available for the customer. 
  
Related Topics 
Customer charge accounts 
Customer rewards program 
Add a new customer 

Customers in Simple View 
  
If the company preference to track customer is enabled, basic customer functionality is supported in Simple View, 
including: 

• The ability to list the customer on the receipt 

• Applying customer discounts and price levels 

• Using customer charge accounts 

• Giving customer loyalty rewards 
Selling items from customer orders 

• Quick-adding a customer to your Customer List while making a sale (see below) 

To list an existing customer in Simple View: 
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1. In the Customer field, begin typing customer information (last name is suggested, but you can 
also type first name, phone number, company name, or a search keyword). 
2. Press Enter. 

 
3. Select the correct name from the displayed list of customers matching your entry. 

Alternatively, select the down arrow to the right of the customer field to display your entire customer list. Scroll 
through the list to locate the customer name. 
Discounts, tax handling, and other customer-specific sales information is automatically suggested or applied to the 
receipt. 

To QuickAdd a new customer in Simple View: 
1. Click Add Cust from the left side of the Simple View screen. The New Customer window is 
opened. 

 
2. Enter basic customer information. Last Name is required. 
3. Select Save and Select. 
4. Complete the sale normally. 

You can add additional information for the customer later by editing the customer record. 
  

Notes: 
• Not all customer information is displayed on a Simple View receipt. For example, the customer's address, 
charge account information, reward information, and check acceptance status are not displayed. However, 
you will be notified if a credit limit is exceeded, if checks are not accepted, or if a reward is available for the 
customer. 

• The integrated shipping features are not available from the Simple View receipt screen, although you can 
record a shipping amount. 

Related Topics 
Customer Overview 
  

Customer IDs and Cards 
Printing | Add a Customer 

Pro 
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Customer IDs are automatically assigned to new customers and can be used 
to print scannable ID cards.  
The printed ID cards, with bar codes, can then be scanned while making a 
sales receipt to quickly lookup and add the customer to the receipt. Provided 
you don't change the default ID number format, you can scan the card while 
in either the Enter Items field or the Customer field on the receipt to add the 
customer. 
  
Tips and format of Customer IDs  
Print templates for ID cards  

Size 
(H x W) 

Number Per 
Sheet 

Sheet Size Use Template 

1" × 2.625" 30 
(3 across) 

8.5" x 11" Avery 5160 

2" x 3.25" 3 
laminated 
badges 

8.5" x 11 Avery 5361 

3.33" x 4" 6 
(2 across) 

8.5" x 11" 8164 + Logo 

  

To print customer ID cards: 
1. From your customer list, select the customer or customers for whom you wish to print ID cards. 
How do I select multiple customers?   

If printing for all customers, you do not have to select any. 
2. From the I Want To menu, select Print ID Card. 
3. On the Print dialog, specify if printing cards for the selected customer(s) or for all customers, and 
make any changes necessary to the printer, template or number of copies. 
4. Select Print. 

  

Notes: 
• When printing paper customer ID cards, it is recommended that these be laminated to protect the legibility 
and scan-ability of the bar code on the card. 

• To create ID cards using a different numbering system, remove the program-generated number in the 
Customer ID field and then enter the alternate number (up to 30 digits) or scan the bar code if using 3rd 
party cards with preprinted codes. With a different format, you'll have to be in the Customer field on the 
receipt to lookup a customer by scanning her ID card. 

• (Pro) If upgrading from a previous version of Point of Sale that lacked this feature, ID numbers for existing 
customers are generated at Headquarters only and sent to remote stores via the next Store Exchange file. ID 
numbers for new customers are created at the store where they are added to the customer list. 

Related Topics 
Customer Rewards Program 

Print your Customer List 
Printing Overview | Export your Customer List | Customer Overview 

Basic  

Your customer list can be printed as a report. 

To print your customer list: 
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1. Display your customer list and select the customers you want included in the printout: 

• To print the entire list, make sure the list filter is set to display All Customers. 

• To print a sub-set based on a common data point (ZIP Code or city, for example) use the search 
function to display only those records. 

• Or manually select  (highlight) the records you want to print. 
2. Select Print from the I Want To menu. 
3. Specify which to print:  All Displayed Customers or Selected customers only, and then select 
OK. 
4. On the Print dialog, choose Print or Preview. 

  
Many report viewing options are available, including rearranging columns and drilling down to see customer detail. 
Printing customer lists from the reports area gives you even more flexibility in customizing the layout, records 
included, and other display properties. 
  

Notes: 
• If you filter the Customer List report by store, only customers to which a sale has been made at that store 
will be included. 

• You can also print customer mailing labels for all or selected customers by selecting Print Labels from the 
Print menu with your customer list displayed. 

Related Topics 
Finding a customer record 
Tracking customers by type 
Printing mailing and shipping labels 
Printing shipping labels from sales receipts 

Print Mailing or Shipping Labels 
Printing Overview | Printing FAQs | Supported label styles/sizes 

Basic  

You can print mailing or shipping labels from your customer list, from individual customer records, and from the 
Customer Center. 
(Pro) You can also print shipping labels from sales receipts and customer orders. 
  

Print a Label for an Individual Customer 
From the customer list, display the customer details. In the Addresses section, select one of the entered addresses 
from the drop-down list and then click Print Label. 
With this option, you can print a mailing label for one, all, or a selected group of customers. 
Step-by-step instructions  

1. Display your customer list or an individual customer record. 
2. If on an individual customer record, select Print Label below the customer address fields. Pro 
users can print using either the Bill To or Ship To address. 

OR 
If in the customer list, select the customer or customers for which you wish to print labels and then select 
Print Labels from the Print menu.  How do I select multiple customers?   

• You may find it helpful to filter the list to display a specific group of customers, such as by ZIP 
code or last purchase date, before selecting. 

• If you intend to print labels for all customers, you do not have to select them. You can specify 
that option in the next step. 
3. Specify or change options in the Print Labels dialog: 
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• Change the printer to be used, if necessary 

• Specify if printing for selected customers or all displayed customers 

• Specify the number of labels to print for each customer 

• Preview and/or change the label template used (select More Options, if necessary, to 
access) 
4. Select Print or Preview. 
5. If printing to sheet labels, specify a label start position (for printing on partial pages of labels) 
and then select Continue. If necessary, you can also align your printer from this dialog. 

  

  
  

Print Mailing Labels from the Customer Center 
Printing labels from the Customer Center gives you the added advantage of being able to create a mailing 
campaign list filtered by customer record information and/or by sales data. Labels printed from the Customer 
Center always use the customers' billing addresses. 
Step-by-step instructions  

1. On the home page Navigator, click Customer Center. The Customer Center is opened. 
2. In the Reach Out to Your Customers section, click Print Mailing Labels. The Print Mailing 
Labels wizard is opened. 

The wizard includes the following pages. Click Next when ready to move to the next page. 

• Choose Campaign Type: Select one of the predefined mailing campaigns or choose 
Custom to define other criteria: 

 Recent Purchase—Include only customers that have made a purchase in the last x 
number of days (enter x). 
 No Activity—Contact only customers that haven't made a purchase in x number of 
days (enter x). Optionally, you can also elect to include only those customers that have made 
at least one purchase from you anytime. 
 Merchandise Interest—Contact only customers that have made a purchase from a 
particular department or vendor. Click the Select Department/Vendor button to specify 
which department/vendor. Optionally, you may limit the sales period to the last x number of 
days. 
 Custom—This selection presents two additional pages for entering specific filter 
criteria. On the first, you can filter for any information stored in your customer records (city, 
ZIP Code, customer type, charge account customers, etc.). The second page allows you to 
filter for information contained in your customer sales history. Click Help on these pages for 
assistance. 

• Review Customer List: This page displays a proposed list of customers based on your 
selections. By default, all customers in the proposed list are selected for inclusion in the final list ( = 
selected). You can remove customers from the final list by clearing their checkboxes. Clear/select 
checkboxes by clicking on them or by using the button options on the right. 
3. Specify or change options in the Print dialog: 

• Change the printer or printer properties, if necessary 

• Specify the number of copies (labels) to print for each customer 

• Preview and/or change the label template used (select More Options, if necessary, to 
access) 
4. Select Print or Preview. 
5. If printing to sheet labels, specify a label start position (for printing on partial pages of labels) 
and then select Continue. If necessary, you can also align your printer from this dialog. 
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Print Shipping Labels from a Sales Receipt or Customer Order (Pro) 
You can print shipping labels from a receipt or customer order. If you use Shipping Manager, special considerations 
apply as explained below. 
Directions  

1. Enter a customer and shipping information on the receipt or customer order. 
2. Select Options in the Shipping Info area on the document and then choose Print Store 
Mailing Label. 

If you used Shipping Manager to add the shipping information to the document, select Re-print <Carrier> 
Shipping Label from Options instead. 

3. Specify or change options in the Print dialog: 

• Change the printer to be used, if necessary 

• Specify if printing for selected customers or all displayed customers 

• Specify the number of labels to print for each customer 

• Preview and/or change the label template used (select More Options, if necessary, to 
access) 
4. Select Print or Preview. 
5. If printing to sheet labels, specify a label start position (for printing on partial pages of labels) 
and then select Continue. If necessary, you can also align your printer from this dialog. 

  

  
  

Print Shipping Manager Labels (Pro) 
If you use Shipping Manager to make shipments, a shipping label that includes tracking information and scannable 
bar code is automatically printed when entering the shipment. 
Laser/inkjet and thermal printers are supported by Shipping Manager. The printer and options for Shipping 
Manager labels are set up in Shipping Manager, not in Point of Sale preferences. See Shipping Manager Overview 
and Setup. 
The Zebra LP2844 thermal printer, a Point of Sale compatible printer that can print 4" x 6" shipping labels, is also 
ideal for use with Shipping Manager. 
  

Notes: 
• A default label printing template and options can be specified on the Documents & Printers page of 
workstation preferences. This selection does not apply to labels printed from Shipping Manager. 

• For information about ordering labels directly from QuickBooks, refer to the ordering supplies topic. 

• (Pro) A shipping label can be printed from any of the shipping addresses entered on the customer record. 
When shipping information is added to a sales receipt, the shipping information, including carrier and tracking 
number is printed on the receipt given the customer. 

Back to top 
  
Related Topics 
Supported label styles and sizes 
Print your customer list 
Compatible label printers 
Enter shipping information on sales receipts 
Customize printed documents 
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Customer Fields 
Data Field Overview | Customers Overview | Program Capacities 

Basic  

Refer to the table below for descriptions of each customer field. Fields shown in brackets, e.g. [field name], are 
suggested  or read-only  fields prefilled by Point of Sale. 
If, when viewing a record list, columns (fields) shown below are not visible, you can use the customize columns 
feature to add them. 
  

Field Usage 

Accept Checks? The customer’s check-acceptance status, 
Yes or No. When No is selected, the 
cashier will be alerted when trying to accept 
payment by check on a receipt. With 
sufficient security rights (owner, manager, 
assistant manager pre-defined groups), the 
check can still be accepted at the user’s 
discretion. 
If security is not used, the warning message 
is displayed, but any employee can accept 
the check. 

Account Fields 
Charge Account 
[Account Limit] 
[Account Balance] 
[Available Credit] 
[Past Due] 

Select the Charge Account checkbox to 
allow charge account for this customer and 
then enter a credit limit. 
Customer's current charge account limit, 
balance, and remaining credit available 
always displayed here and available to view 
from sales receipts. 
If a new charge sale exceeds the available 
credit, Point of Sale blocks the charge. 
Learn more. 
The Past Due amount comes from your 
QuickBooks financial software. You can 
block additional charges when an account 
is in a past due state. 

Address fields Bill To Address: The customer’s complete 
mailing address. 
(Pro) Ship To Address: Address where 
customer prefers to receive shipped 
merchandise. Default is same as Bill To 
address. Clear the checkbox and enter a 
different Ship To address as necessary. 
When making sales to this customer, 
shipping information can be added to the 
sales document. 

Alt Contact Allows for an alternate contact name for the 
customer. 

Company Name of the customer’s company. 
(Pro) Required when Track by Company is 
selected for a business customer. 

Customer Discount Percent: A percentage discount 
automatically suggested against the active 
price level to items listed on a receipt, 
layaway, or sales order made for the 
customer. You decide whether to apply the 
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discount or not at the time of sale. Editable 
(subject to security rights). 
Price Level: Use to assign one of your 
predefined price levels to the customer. 
When making a receipt for this customer 
you will be prompted to apply the specified 
price level, which you can choose to do or 
not at your discretion. 

Customer ID (Pro) 
 
 
 
 
 
 
 
 
  
Custom Fields 1-7 
(Pro) 
 
 
 
 
  
Customer Notes 

Customer identification number; can be 
used to print barcoded ID cards. Those 
cards can then be scanned to add a 
customer to a sales receipt. Automatically 
generated by Point of Sale; editable but use 
the link above read about the special format 
of this number before making changes. 
Custom fields can be used to enter any 
other customer information you need to 
track. Once defined, the fields can be used 
to filter lists and reports, and can be added 
to your printed documents using Print 
Designer.  Learn more. 
Use to record optional information about the 
customer, e.g. birthday, requested items, 
clothing sizes, etc. Customer notes are not 
exchanged with QuickBooks financial 
software. 

Customer Type Use to categorize your customers in ways 
that are meaningful to your business, such 
as their geographic location, or how they 
first heard about your business. Learn 
more. 

E-mail 
 
  
  

OK to 
e-mail this 
customer 

Customer’s e-mail address. Entry allows 
you to send send e-mail or to e-mail 
documents to the customer. 
   
Checkbox indicates if customer is willing to 
receive e-mail communications. Clear the 
checkbox if customer wishes to "opt out" of 
your e-mail communications. Learn more 
about e-mail marketing. 

Full Name Displayed on documents and is comprised 
of First, Last, and Title in the order 
specified in Preferences  Company  
Sales. 
(Pro) For business customers: If Track by 
Company is selected on the customer 
record, then the company name is always 
displayed in the Full Name field. 

First Name Customer's first name. 

Last Name Customer's last name. Required for 
individual customers. 

Title Title for customer name: Mr., Mrs., or Ms. 

[Last Sale] The date of the customer's last purchase. 
Automatically updated when a receipt is 
updated. 
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Phone 
Phone 2 
Alt Phone 

Three phone numbers, each up to 15 
characters, allowing entry of an area code 
and a notation such as H, F or WK. 
Note: For easy customer lookup by phone 
number, use a consistent format when 
entering the numbers. We suggest typing in 
the area code last so you can quickly find a 
customer by his or her basic seven-digit 
number. You can use or omit the hyphen, 
but you must be consistent in order to be 
able to search by phone number. Example: 
854-4207 (818) H. 
If desired, the Alt Phone field can be used 
to sort, search, and look up customers by 
information other than a second phone 
number. For example, you could enter 
customer driver license numbers and then 
search and look up your customers by 
entering their driver license numbers. 
(Subject to local regulations). 

QB Status 
(QuickBooks financial 
software users only) 

Customer list only. Displays the Financial 
Exchange status of the record: Not Posted 
(not yet sent to QuickBooks), Completed 
(sent to QuickBooks), or Error (attempting 
to send QuickBooks resulted in an error). 
Learn more. 

[Rating] Graphical indicator of customer purchase 
volume over time, based on user-defined 
time period and familiar five-star system. 
Learn more. 

Rewards Member 
(Pro) 

Checkbox to indicate customer participates 
in your rewards program. Can be added as 
a column to your customer list and used to 
filter the list and various reports. If the 
rewards program is active, a Rewards tab is 
added to the customer form with specific 
reward information for the customer. Learn 
more. 

Tax Location Specify a tax location to be used for this 
customer on sales. When making a sale to 
the customer, Point of Sale will prompt you 
to use this tax location. 
Note:If Tax-Exempt is selected for the 
customer (see below),a hidden exempt 
location is automatically applied and this 
filed is disabled. . 
The Tax Location column/field can be 
added to your customer list or information 
panel. 

Tax-Exempt If checked, no sales tax is collected on 
sales to this customer. 

Track by Company 
(Pro) 

Select this checkbox to use the company 
name throughout the program (in the Full 
Name field) and to add a Customer PO# 
field to sales receipts and customer orders, 
allowing you to track transactions by the 
customer PO number. Learn more. 
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Use with 
QuickBooks 
(QuickBooks financial 
software users only) 

Select to share the customer information 
with QuickBooks financial software. 
Required to offer a store charge account to 
the customer. Default selection can be 
specified in company preferences. 

ZIP ZIP code or other postal code, up to 10 
characters (e.g., 12345-6789). 

Return to top 

Write Letters from Point of Sale 
Manage Letter Templates | Office Integration Overview | FAQs 
  
Point of Sale provides Microsoft Word integration for writing letters to customers and vendors. The letters can 
include data from the customer and vendor records as well as from documents made for the customer or vendor. A 
variety of letter templates is provided for your use. You can customize the provided templates and create more of 
your own. 
Letters can be initiated from the I Want To menu in your customer or vendor list or from your document lists. If you 
want a letter to include data from a document, such as specific item information, the letter must be initiated from 
that document. 
You can create a letter for a single recipient or send letters to a group of selected or filtered recipients. 

To write letters: 
1. Select the record or documents for which you wish to print letters. 

If sending letters to a filtered list, you do not need to select specific records in this step. 
2. From the I Want To menu, select Write Letters  and then choose to Currently Selected or to 
Filtered List. 

If using the filtered list option, follow the prompts to enter filter criteria to include/exclude customers or vendors. 
Learn more. 

3. Select the template you wish to use for the current printing and select Next. 
4. Enter the name and title of the person that the letter will be from and select Next. 

The letter(s) are opened in Word. If you are printing multiple letters they are all in a single Word document with 
each letter starting on a new page. 

5. Review and modify in Word if necessary and then print the letter(s). 
  

Notes: 
• You can select  Modify Template when selecting a template if necessary to customize the template before 
creating the letters. Learn more about modifying templates. 

• If the selected template includes data fields for which no data exists in your Point of Sale records or 
documents, the fields will be auto-filled with **MISSING <data field>**. Review your letter(s) and edit or 
remove these fields to complete the current letter. You can remove the fields from the template if you never 
want them included in future letters. 

• You may save the Microsoft Word document if you wish; doing so will not affect the template. 
Related Topics 
E-mail Marketing from Point of Sale 

E-mail Marketing with Point of Sale 
E-mail a Document | E-mail FAQs | Office Integration 

Basic  

Unlock the hidden value in your retail data with e-mail marketing to get customers into your store more often and 
getting them to spend more when they do visit. Point of Sale makes it easy to create targeted customer lists to use 
in e-mail marketing campaigns.* 
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Highlights of this feature include: 

• Targeted customer lists can be created based on previous sales data and/or on information stored in your 
customer records. The Create an E-mail Campaign wizard walks you through the steps to create the 
customer lists. 

• You can set up an account with the Point of Sale e-mail marketing partner , in which case your customer 
lists are sent automatically from Point of Sale to the partner. 

• If you prefer, you can export the customer list to Microsoft Excel. The Excel file can then be manually 
uploaded to an alternative e-mail marketing provider of your choice. 

• You create, send, and track the actual marketing campaign e-mails through the service provider you have 
selected. 

• Optionally, you can set Point of Sale to prompt your cashiers to e-mail a copy of sales receipts to your 
customers. This is a great way to collect customer e-mail addresses for future use in your e-mail marketing. 
Enable this prompt in workstation preferences. 

• Your customers can "opt out" of receiving marketing e-mails, in which case they will never be included in 
the customer lists you create for marketing. 

*This feature requires an account with a third-party e-mail marketing provider. Terms and conditions, pricing, and 
service options are set by the e-mail marketing provider you choose. 
  
Related Topics 
Customer Center 

Track Business Customers 
Customer Overview | Add a Customer | Edit a Customer 

Pro 
You can easily identify and track business customers in Point of Sale (as opposed to an individual customer). 
Identifying a business customer turns on the following features for that customer: 

• Record and print customer purchase order numbers on sales receipts and customer orders 

• Search for sales receipts and customer orders by the customer PO # 

• The Full Name field on Point of Sale documents, lists, and reports will display the company name 

• Your customer list and Reports can be filtered to distinguish between business and individual customers 

• When synchronizing with your QuickBooks financial Software, the customer PO # will be shown on 
receipts and invoices created in QuickBooks 

To identify a business customer: 
1. When adding or editing a customer record, select the Track as Company checkbox. 
2. Record the customer's Company name (required). 
3. Select Save. 

  

Notes: 
• Including an individual's first and last name is optional, but recommended, for a business customer. 

• The Customer PO# field is added to receipts and customer orders made for this customer, as shown 
below, and the Full Name field will display the company name throughout the program. 
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Related Topics 
How customer records are exchanged with QuickBooks 

Multi-Store: Working with Customers 
Multi-Store Overview | Customers Overview 

Pro - Multiple Stores 
Customers can be added, edited, or deleted at any store, with the resulting changes propagated to all stores with 
the next fully completed Store Exchange cycle. Headquarters maintains the master customer list, which is sent to 
all stores in its entirety during every Store Exchange. 

General guidelines for customers at multi-stores: 

• Any store can add, edit, or delete a customer, but the customer record is not revised in the master 
customer list at Headquarters until certain synchronization checks are completed during the next Store 
Exchange cycle. 

• Adding, editing, or deleting a customer "flags" the customer record with the action taken and adds a 
date/time stamp at the originating store. This date/time stamp is used in synchronization checks to ensure 
proper handling of customer records in the event that the same record is edited at multiple stores on a given 
day. 

• If a customer is a charge account customer with an account balance, deletion is not allowed. 

• If a store makes a charge account sale or accepts a payment on a customer account, Headquarters sends 
that information to QuickBooks financial software (only Headquarters exchanges data with QuickBooks). 

• Be aware that it is possible for a customer to make two or more purchases by account charge at different 
stores between Store Exchanges, neither individually exceeding the customer's available credit but in total 
exceeding it. After the next completed data exchange, the new balance will exceed the credit limit until a 
payment is made, but no further charges will be allowed  Example  

• Customer history at Headquarters will show customer sales from all stores (but not pending customer 
orders). Customer history at a remote store shows all sales and order documents made locally, but not those 
made at other stores. 

Related Topics 
Exchange of data between stores 

Charge Accounts 

Customer Charge Accounts and Store Credits 
Charges to Account | Payments on Account | Past Due Accounts 

Basic  

Store Credit: Even if you don't wish to allow customers to charge purchases, you may still want to set up customer accounts for 
the purpose of giving store credit when merchandise is returned. Point of Sale will track the customer's credit balance and you 
can apply the credit towards a future purchase. For purposes of store credit, issuing a credit uses the same procedure as taking a 
payment on account, while applying a credit uses the same procedure as charging to account.     

  

Overview 
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You can offer and track customer charge accounts in Point of Sale. As the customer makes charges to and 
payments on her account, Point of Sale tracks the account balance and the remaining credit available. 
When making a sale to the customer, this information is displayed on the receipt and further charges are blocked if 
the sale amount exceeds the available credit (manager override, with sufficient security, is possible). 
If you are integrated with QuickBooks financial software, you have additional account tracking capabilities: 

• Posting of customer charges and payments to your financial software, automatically creating invoices and 
customer payments 

• The ability to print and mail account statements, apply finance charges, and apply payments to specific 
invoices in your financial software, with updated balances being sent back to Point of Sale 

• The ability to track past due amounts and block additional charges 

Settings for Charge Accounts 
Use the following customer fields in the QuickBooks Options section of the customer record to set up and 
maintain customer charge accounts: 

 
•  Use with QuickBooks. If you are integrated with QuickBooks financial software, this checkbox 
indicates if the customer information will be shared with QuickBooks. If you select the Use charge account 
checkbox, this option is automatically selected for you. You can set the default selection of this field for new 
customers in company preferences. 

•   Charge account  –  Select to allow charges for this customer. 

• Account Limit – Enter the maximum charge balance allowed for the customer. If integrated with 
QuickBooks financial software, you can set the limit in either program and it will be updated in the other with 
your next Financial Exchange. 

• Account Balance. The customer’s current account balance; updated with each charge to or payment on 
account. If integrated with QuickBooks, is overwritten during each Financial Exchange by the balance from 
QuickBooks, so that it reflects finance charges and/or payments taken in your financial software. 

• Available Credit. Calculated field. Account Limit  –  Account Balance = Available Credit. When charging a 
purchase to the account, the available credit is checked and the charge blocked if the purchase amount 
exceeds this value (manager override, with sufficient security, is possible). 

• Past Due. Available only if integrated with QuickBooks and if blocking of past due accounts is enabled in 
company preferences. Indicates amount that is 30, 60, or 90 days past due, depending on preference setting. 
Actual amounts and aging comes from QuickBooks. 

Notes: 
• The current account information is displayed on the sales receipt when a customer is listed on the receipt. 

• Until an account limit is set for a customer, the Available Credit in Point of Sale is suppressed and 
charges on account are not allowed. With sufficient security rights, you can establish an account and set a 
limit while making a sale by clicking the Account payment button. 

• To send itemized statements (including item detail) to customers from QuickBooks, choose one of the 
detailed item posting methods on the Financial page of company preferences. 

• The ability to modify account settings can be controlled by a security right. 

• If you have existing customers with account balances in another program or spreadsheet when beginning 
to use Point of Sale, the customer information and account balances can be imported using the Data Import 
wizard. 
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• (Pro) Be aware that it is possible for a customer to make two or more purchases by account charge at 
different stores between Store Exchanges, neither individually exceeding the customer's available credit but 
in total exceeding it. After the next Financial Exchange, the new balance will exceed the credit limit until a 
payment is made, but no further charges will be allowed  Example  

Related Topics 
How account transactions are sent to QuickBooks 
Edit a customer record 
End of Day Financial Exchange 

Charge a Purchase to Customer Account (or Apply a Credit) 
Maintain Customer Accounts | Take Payments on Account 

Basic  

Use this procedure to charge a purchase to a customer's account or to apply a store credit to a sale. 

Note: Applying a store credit is essentially the same as charging a purchase on account and the same procedure is used. 

To charge a sale to a customer’s account: 
1. List the items and customer on the receipt. 
2. Click the Account payment button. The Charge Account dialog is opened with Charge to 
account pre-selected and the full sale amount suggested in the Charge Amount field. The customer's 
current account balance is displayed for reference. 

 
3. To charge the full amount to the customer's account, just click Save. 

To charge other than the full amount, type the new amount and then click  Save. 
4. If only a portion of the purchase amount was charged, take payment for the remaining balance by 
another payment type. 
5. Save and print the receipt. 

  

Notes: 
• You must enable account charges and assign an account limit on the customer record before the account 
charge option is available. If you attempt to enter an account charge on a non-account customer, and you 
have security rights to edit account information, Point of Sale will prompt you to enable charges and set a limit 
directly from the sales receipt. 

• The customer's account balance and available credit is immediately updated on the customer's record at 
this store. 

• Point of Sale will block additional charges if insufficient credit is available. The block can be overridden by 
an employee with adequate security rights or by using the manager override function. 

• You can configure Point of Sale to print two copies of account charge receipts —one for the customer and 
a signature copy for you to keep. 

If Point of Sale is integrated with QuickBooks Financial Software the following also apply: 
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• On the next Financial Exchange, the account charge receipt is sent to QuickBooks and posted to the 
customer’s account. 

• QuickBooks will return the new account balance and any amount past due so that you have an updated 
balance and available credit amount to reference on the next sale. 

• Account statements can be sent to customer's from QuickBooks. Customer payments on account can be 
entered in either program and will update the balance in the other with the next Financial Exchange. 

Related Topics 
Take a payment on account 
Make a sale 
Correct or clear payments 

Take Payment on Account (or Issuing Store Credit) 
Maintain Customer Accounts | Charges on Account 

Basic  

Payments on a customer's charge account are recorded on a receipt.   
  

Note: Issuing store credit is essentially the same as taking payment on account and the same procedures are used. If you are 
issuing store credit due to a merchandise return, create a return receipt and use the second procedure below. 

To record a payment on account: 
1. Start a new receipt, with or without sales items listed. List the customer on the receipt. 
3. Click the Account button. The Charge Account dialog is opened. The current account balance is 
displayed for reference. 
4. Click the Make payment on account option. 
5. Enter the amount the customer is paying. 

The full account balance is suggested. Type over this amount if the customer is paying a different amount. 
3. Click Save. The receipt is updated with the balance due from the customer (account payment 
plus any new purchases). 
4. Take payment by any other payment type.   
5. Save/print the receipt. 

  
  

Notes: 
• Payment on Account and the amount is added to the receipt item list and, when saved, the payment 
receipt is added to your sales history. 

• A customer cannot make a payment on account by charging it to his account. 

• The customer’s account balance and available credit is updated accordingly at this store. 

If integrated with QuickBooks financial software: 

• Payments/credits on account can be entered directly into QuickBooks financial software if you prefer, using 
the Customers  Receive Payment option (see your QuickBooks documentation for more information). If 
choosing this method, the payment should NOT also be entered in Point of Sale. Payments on account 
recorded in QuickBooks will be reflected in Point of Sale after the next Financial Exchange. 

• When you take payments or give credit on account in Point of Sale, a customer payment is created in 
QuickBooks with the next Financial Exchange. How, or if, this payment is applied to open invoices for the 
customer is determined by your Receive Payments preferences in QuickBooks. Learn more. 

Related Topics 
Set up an account for a customer 
Make a sale 
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Correct or clear payments 

Past Due Customer Accounts 
Account Overview | Charges to Account | Payments on Account 

Basic  

If you are integrated with QuickBooks financial software and offer customer charge accounts, Point of Sale can let 
you know when a customer’s account is past due and block additional charges to the account. By default, the alerts 
and blocking of additional charges takes effect when an account is past due by 30 days. You can turn off blocking 
or change the past due period to 60 or 90 days in company preferences. 
The past due amount and periods are based on your QuickBooks financial software settings and are received from 
QuickBooks during Financial Exchanges. 
Setting Account Aging Preferences in QuickBooks Financial Software  

There are two settings in QuickBooks that control how past due amounts are calculated and then displayed in 
Point of Sale: 
Customer Terms:  The terms you associate with a customer or with customer invoices in QuickBooks 
determines the payment due dates. 
If no terms are set, the due dates for transactions are the same as the transaction (sale) dates. 
Accounts Receivable Aging Report Preference: Determines if past due aging is based on the payment due 
date or the transaction date. 
Edit this report preference in QuickBooks by selecting Preferences from the Edit menu. Then, on the left select 
Reports and Graphs. On the Company Preferences tab, make a selection in the Aging Reports area. 

  
  
With the past due preference turned on and when a sale is made to a customer with a past due account, Point of 
Sale displays the past due alert and amount on the sales receipt and payment window. This reminds the cashier to 
request a payment on account or alerts them to follow other store policies, such as not giving discounts to past due 
customers. 
If requiring employee logins, the ability to allow an additional charge under this circumstance is controlled by the 
logged-in employee's security rights. If not requiring logins, the cashier is alerted but can still allow the new charge. 
  

Notes: 
• If the cashier doesn't have rights to accept a new charge, the manager override option is displayed. This 
allows a store manager, with adequate rights, to exercise their discretion in allowing the new charge. 

• The past due amount is displayed with other account information on the customer record, is available to 
add as a column to your customer list and on customer reports, and is included on the customer's printed 
receipt. 

• If you take a payment on account, the past due and account balance amounts and status are immediately 
updated in Point of Sale and synchronized with QuickBooks with the next financial exchange. 

• In a multi-store configuration, payments on customer accounts at a remote store aren't reflected at 
Headquarters or other stores until after the next Store Exchange. 

• You can write letters to customers with past due accounts from Point of Sale. A "Past Due" letter template 
is included and the past due amount field is available to add to letter templates you create. Additional letter 
templates may be available within your QuickBooks financial software. 

Related Topics 
How account information is exchanged with QuickBooks 

Rewards Program 

Customer Rewards Program Overview   
How do I? | Reward Manager | Redeem Rewards 

Set up my Rewards Program 
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Modify my program 
Redeem a reward 
Track earned rewards 
Manually issue or cancel a reward 

  

Pro 
Many retailers offer incentives to repeat customers, based upon their spending level. Also referred to as a 
Customer Loyalty program, this can be a very effective tool for maintaining and expanding your customer base. 
You define the parameters of your rewards program in the Reward Manager, available from the Customers menu. 
Customers can be added to the program automatically or selectively as you make sales (or on their customer 
record). 

Members are indicated by the rewards program icon in various 
places in the program. 
Point of Sale tracks purchases for each program member and alerts 
the cashier when a reward is earned or when a reward is available for 
redemption. Merchandise returns are subtracted from the current 
purchase tracking balance. 
Rewards earned and rewards redeemed are printed on customer 
receipts, as is the spending amount needed to qualify for the next 
reward. 
Reward redemption reports are available for tracking purposes. 
Reward discounts are also added to the item grid of saved receipts for 
later viewing. 
If you are requiring employees to log in, security rights control access 
to the Rewards Manager and to redemption reports. 
In a multiple store configuration, all stores share a single reward 
program, which can be defined only at Headquarters. Customer purchases and redemptions made at any store are 
updated to Headquarters with each Store Exchange and the updated information sent back out to remote stores. 
Important Note  

What would you like to know more about? 
Legal Considerations for a Rewards Program  
What items qualify for earning and redeeming reward?  

Item/Payment Type Qualifies to Earn Reward Qualifies for Redemption 

Inventory, Service, Non-
inventory, Group, Assembly 

Yes Yes 

Sales Tax No No 

Shipping Charges No No 

Gift card/certificate purchase No No 

Gift card/certificate redemption No Impact No Impact 

Charges to customer account No impact No impact 

Payments on customer account No No 

  
Reward Program Terminology  

Reward Manager: Point of Sale program window where you define the parameters of your Rewards program. 
Rewards Member: Any customer that has been enrolled as a member in your program. Point of Sale 
automatically tracks reward members’ purchases and rewards. 
Purchase Threshold: The amount a customer must purchase during the purchase tracking period to earn a 
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reward. Another reward is earned each time the customer purchases reach this amount. 
Purchase Tracking Period: Time period within which purchases must be made to qualify for rewards. Specify 
a start and end date; or leave end date open-ended. 
Reward Amount: The reward value earned when a customer meets the purchase threshold. This can be 
defined as a dollar amount or as a percentage off a future purchase. 
Reward Expiration: (Optional) Specifies how long a reward is valid for redemption. Measured from the earned 
date, adjusted for a reward blocking period if used (see below). 
Earned Reward: Pending reward that has been earned but not yet redeemed. 
Purchase Balance: A customer’s current sales accumulation toward earning the next reward. 
Reward Redemption: The act of applying a customer reward to discount a new purchase. 
Redemption Blocking Period: Period after the qualifying sale in which redemption of an earned reward is not 
allowed. This can be set to the length of your return policy to help avoid returns of items for which a customer 
has already earned and redeemed a reward. 
Qualifying Purchases/Redemptions: The list of items whose purchase qualifies toward earning a reward 
and/or that qualifies for reward redemption. To qualify, items must be purchased within the purchase tracking 
period. The return of a qualifying item reduces the customer’s current purchase balance. 

  
Write Letters to Rewards Members  

Point of Sale integration with Microsoft Office allows you to write letters to your rewards program members to 
remind them they have earned a reward and to reinforce the benefits of their reward membership. 
Filter your customer list to display these members and then choose Write Letters from the I Want To menu. 
Select the Customer Rewards Earned template and customize as necessary. 
Learn more about writing letters. 

  
How are rewards reflected in my QuickBooks financial software?  

Because no money changes hands when a reward is earned, it is a non-accounting event and has no 
immediate effect on your financial accounts. Likewise, the expiration or cancellation of an unredeemed reward 
has no effect on your financial records. Point of Sale reports can be used to track earned, but unredeemed 
rewards. 
A reward redemption is a discount that is accounted for in the same manner as other sales discounts. 
By default, Point of Sale sends net sales amounts to QuickBooks income accounts and doesn't account for the 
discount separately. However, if you elect the preference to send separate original and discounted values, 
Point of Sale creates (if necessary) and reports reward discounts in the Sales: Rewards Discounts income 
account. 

  

To set up your Reward Program: 

Note: You must have company preference I want to track customers enabled to use a customer rewards program. You can turn 
this preference on the General page of company preferences (access from File menu). 

These are basic steps of a rewards program. Press F1 or select the help links on any screen for more detailed 
instructions for that task. 

1. From the Customers menu, select Reward Manager. 
2. Define your program (purchase amount required, reward amount or percentage off, reward 
expiration date, qualifying purchase dates, and other options). 
3. Enroll customers: You can enroll all customers, be prompted to enroll customers as sales are 
made, or manually enroll customers by editing their individual record. 
4. Sell and promote your program! Point of Sale tracks reward purchases, and cashiers are 
alerted when a reward is earned and when one is available for redemption. 

  
Related Topics 
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Use Customer IDs and Membership Cards 

Reward Manager 
How do I? | Rewards Program Overview 

Modify my rewards program? 

Redeem a reward? 

Track earned rewards? 

Manually issue or cancel a reward? 

  

Pro 
All settings for your Customer Rewards program are controlled through the Reward Manager. 
Legal Considerations for a Rewards Program  
Reward Program Terminology  

Reward Manager: Point of Sale program window where you define the parameters of your Rewards program. 
Rewards Member: Any customer that has been enrolled as a member in your program. Point of Sale 
automatically tracks reward members’ purchases and rewards. 
Purchase Threshold: The amount a customer must purchase during the purchase tracking period to earn a 
reward. Another reward is earned each time the customer purchases reach this amount. 
Purchase Tracking Period: Time period within which purchases must be made to qualify for rewards. Specify 
a start and end date; or leave end date open-ended. 
Reward Amount: The reward value earned when a customer meets the purchase threshold. This can be 
defined as a dollar amount or as a percentage off a future purchase. 
Reward Expiration: (Optional) Specifies how long a reward is valid for redemption. Measured from the earned 
date, adjusted for a reward blocking period if used (see below). 
Earned Reward: Pending reward that has been earned but not yet redeemed. 
Purchase Balance: A customer’s current sales accumulation toward earning the next reward. 
Reward Redemption: The act of applying a customer reward to discount a new purchase. 
Redemption Blocking Period: Period after the qualifying sale in which redemption of an earned reward is not 
allowed. This can be set to the length of your return policy to help avoid returns of items for which a customer 
has already earned and redeemed a reward. 
Qualifying Purchases/Redemptions: The list of items whose purchase qualifies toward earning a reward 
and/or that qualifies for reward redemption. To qualify, items must be purchased within the purchase tracking 
period. The return of a qualifying item reduces the customer’s current purchase balance. 

  

To define your program: 
1. Select Rewards Manager from the Customer menu. 
2. If not already set, select Turn Tracking ON. 
3. Enter an amount for the Purchase Threshold. This is the 
amount a customer must spend in your store to earn a reward. 
4. Specify the Reward Amount (dollar amount or percentage) 
and then select $ off or % off from the drop-down list. 
5. (Optional) Select a Reward Expiration period. 
6. Specify the Purchase Tracking Period. 

You must enter a Start date; the End date is optional. To leave the program open-ended, select the No End 
Date checkbox. All qualifying items purchased during this period accumulate towards earning rewards. 

7. In the Rewards Options area, make selections for how you wish to enroll members, be alerted 
when rewards are earned, and set a redemption blocking period. 
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If you enter a redemption blocking period, the entered number of days will be added to the reward expiration 
date. Example: With a 30-day expiration date, and a 10-day blocking period, the reward will expire 40 days 
after the purchase date. 

8. Select Save. 
If you get the Reward Change dialog, click OK to close it. This dialog is displayed anytime you modify your rewards 
program, to alert you to potential effects the change may have on current and future rewards. 

Other tasks/information available from Reward Manager: 

• Reward Program Status: Displays the total value of rewards redeemed under your program, and options 
to turn the program on/off and to view reward reports (Member List and Redemption History). 

• I Want To menu: This menu includes two powerful options: 

• Enroll All Customers in Rewards Program. All existing customers are enrolled in the program. 
Customers you add later are not enrolled unless you also select Automatically enroll new customers in 
the Rewards Options area. 

• Clear All Rewards. Removes all existing earned rewards from all customers. Current purchase 
tracking balances are not affected. 

Related Topics 
Modify your Rewards Program 
Use Customer IDs and Cards 

Modify Your Rewards Program 
Reward Manager | Reward Program Overview 

Pro 
You can modify your reward program at anytime. But we recommend you do so with great care and take into 
account the Legal Considerations for a Rewards Program.  Some modifications may cause previously earned 
rewards to be lost or result in the creation of new rewards that didn't previously exist. 
The terms and conditions you set for your program, and communicate to your customers, should clearly spell out 
the reward program parameters, but just as importantly, should specify under which conditions the program can be 
revised, how revisions affect the status of current members and rewards, and how the changes are to be 
communicated (be sure to adhere to all local regulations). 
Program changes are made from the Reward Manager. Point of Sale will summarize how proposed changes will 
affect your program, including the number of rewards that may be removed or created, before implementing the 
changes. 

To modify your rewards program: 
1. From the Customer menu, select Reward Manager. 
2. Make changes as necessary to the program parameters. 
3. Select Save. 
4. Depending on changes you make, you may be asked how you want to handle the following. 
Select Help on the Reward Setup Change dialog to learn more about how these choices affect your 
program. Example  

You set up your reward program on an annual basis as follows: 
Purchase Tracking Dates:  1/1 - 12/31 in the current year 
Purchase Threshold:  $300 
Reward:  $20 off future purchase, good for 60 days 
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When the current year ends, you modify the tracking dates of the program to be 1/1 - 12/31 of the new 
year. Point of Sale is going to ask you how to handle existing rewards and how to handle the current 
customer purchase balances. 
In this case, you would probably choose to keep existing rewards. Customers that have earned them 
have until the expiration date to redeem them. But, when prompted about the current customer 
purchase tracking balances you would probably choose to adjust amounts based on the new 
tracking period, resetting all customer balances to zero to start the new rewards year. 

5.   

• Existing Rewards. Do you want to remove any earned, but not yet redeemed, rewards or keep 
them. 

• Current Purchase Tracking Balances. Again, do you want to maintain the current balances or 
recalculate them based on your new reward criteria? 

Based on your answers, Point of Sale will display the Reward Change summary page. 
5. Select Finish to make the changes, or Cancel to leave your program unchanged. 

  

Note: You can also choose Previous and change your choices to see how that affects your program. 

  

Manually Issuing or Canceling a Reward 
Rewards Program Overview | Legal Considerations  

Pro 
You can manually issue or cancel a previously issued customer reward if necessary. 

To do this task: 
1. Open the customer record in edit mode and navigate to the Rewards section. 

A list of the customer's current rewards is displayed. 
2. To issue a reward, click New. When prompted, indicate if you want to reset the customer's 
purchase balance toward their next reward to zero (0). 

OR 
To cancel a reward, select the reward in the list and then click Remove. Select Yes in the confirmation dialog. 

3. Click Save. 
  

Notes: 
• The customer's future purchases will continue to accumulate toward a future reward unless you clear the 
Rewards Member checkbox. 

• The Reward Reason  will be prefilled with Manually Issued or Manually Removed. 
Related Topics 
Redeem a Reward 

Redeem a Customer Reward 
Rewards Program Overview | Price/Discount Conflict and Priority 

Pro 
When you are ringing up a sale, if the items being sold qualify and 
the customer has a reward to redeem you will be prompted to apply it 
when going to take payment. 
You can choose to apply the reward to the current sale or save it for 
a future purchase. The reward amount or percentage, expiration 
date, and new sale total is listed for reference. 
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To redeem a reward: 
1. When alerted that a reward is available, select Redeem Now. To save the reward for a future 
sale, select Redeem Later. 

If a customer has multiple rewards available for redemption, all available rewards are displayed. Select the 
reward the customer wishes to redeem before clicking Redeem Now. 

2. The reward is applied to the sale and the new balance due is displayed. 
3. Take payment for any remaining balance as usual. 

  

Rewards cannot be redeemed to purchase gift cards or gift certificates, to make a payment on account, or to pay for sales tax or 
shipping charges. Only one reward redemption is allowed per sales receipt. 

  

Notes: 
• Percentage-off rewards are applied to each qualifying sale item individually as item discounts. The 
Discount Reason field is prefilled with Reward Discount. 

• Dollar-off rewards are added as a separate line item to the receipt and act like a global discount. 

• Occasionally, the combination of customer and items on a sale may qualify for more than one discount. 
The Price Markdowns and Discounts: Priority and Conflicts topic explains how Point of Sale handles these 
situations. 

Related Topics 
Customer IDs and cards (Pro) 
Give a discount 

Track Customer Rewards 
How do I? | Rewards Program Overview 

Set up my rewards program? 

Modify my rewards program? 

Redeem a reward? 

Manually issue or cancel a reward? 

  

Pro 
There are several ways to track your reward program, by individual customer or for the program as a whole. 
Individual Customer Rewards  

 
The Rewards tab of the customer record shows the current reward and program status of the customer. 

Information and actions available include: 

• Rewards Member.   Indicates customer status as a member of your program. Select or clear the 
checkbox to enroll or remove, respectively, the customer from the program. 
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• Rewards Earned. A listing of pending and available rewards, with issue and expiration dates. Select 
Detail to see how and when the reward was earned; or Remove to delete the reward. 

• Issue New Reward. Use this button to manually give the customer a new reward, which will be added 
to the Rewards Earned list. When selecting this option, you have the option to reset the customer's 
current purchase balance to zero. 

• Participation History. Includes the total of the customer's purchases and rewards redeemed during 
the tracking period. Select the Print Redemption History link to run a reward report specifically for this 
customer. 

• Required Purchases for Next Reward. Purchase amount necessary for customer to earn next 
reward. 

  

  
Work with Rewards Members in Your Customer List  

The Rewards Member column (checkbox: selected = member) can be added to your customer list to allow 
quick sorting to display all your rewards members. Once sorted and grouped, you can easily select them for 
group tasks, such as printing, writing letters, exporting to Excel, or making Customer ID cards. 
  

 
  

  
Reward Program Reports  

Reward reports allow you to view a snapshot of your entire reward program. Modify the report to add/remove 
columns, change appearance, or filter the data to fit your needs. Once run, the reports can be viewed, printed, 
or exported to Excel. 

• Rewards Member List. Listing of all members, including the total number of rewards earned, 
available, and redeemed, and the dollar amount of redeemed rewards. 

• Reward History. (sample shown). Detailed history, with dates, reason, customer names, amounts, 
and dates of all rewards earned, pending, available, redeemed, or expired. 

 
  

  
  

Notes: 
• Reward information (other than as discounts on sales) is not sent to QuickBooks financial software. 
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Purchasing 

Work with Vendors 

Vendors Overview 
How do I?   | Add a New Vendor | View a Vendor's History 

Basic  

Each vendor from whom you purchase merchandise must be identified by a unique company name. When you 
assign a vendor to each item defined in inventory, Point of Sale can track and report on the merchandise by vendor 
as it is ordered, received, and sold. 
You can also assign each vendor a user-defined code of one to three alphanumeric characters. These vendor 
codes can be a useful alternate way of searching for a vendor record and appear on printed price tags where the 
printable space is often limited. 
If you have integrated Point of Sale with QuickBooks financial software, you can elect to enter vendor invoices (for 
the merchandise you have purchased) in either program. This Point of Sale company preference choice affects 
how receiving vouchers are transferred to QuickBooks. 
  
(Pro) Remote stores can view and filter reports by vendor, but only Headquarters can add or edit vendors. 
  
Related Topics 
Vendor field descriptions 
Security rights for vendors 
Import items from a Vendor Catalog 
How vendors are exchanged with QuickBooks financial software 

Access your Vendor Records 
How do I?   | Add a New Vendor | View a Vendor's History 

Basic  

To work with vendors: 

• From the Retail Navigator or Purchasing menu, select Vendor List 

• From the Vendor field on an item record or document, choose Select from Vendor List (<F4>) 

Notes: 
• If requiring employee logins, only the Owner, Manager, and Assistant Manager predefined security groups 
have the right to access the vendor list from the Navigator, menus, or toolbars. However, with the default 
settings, all employees have access via the Select from Vendor List option on documents and in your the 
item list, and when filtering reports. To fully restrict access to the vendor list requires that rights specific to 
those areas also be restricted. 

Add a New Vendor 
How do I?   | Vendors Overview | Import Vendors 

Basic  

Note: If you have accessed this topic after copying another vendor record, start with Step 2. Edit the information brought from the 
copied record as needed. 
 
Pro Note: In a multi-store configuration, only Headquarters can add or edit vendors. 

To create a new vendor record: 
1. Select New Vendor from the Purchasing menu. 

A blank vendor form is opened. 
2. Make entries in the vendor information fields, as needed. 
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Company is a required field. 
3. Select Save. 

  
Related Topics 
Copy a vendor record 
Add a vendor directly in the vendor list 
Enter vendor payment terms 
Track multiple vendors for an item (Pro) 

Copy a Vendor Record 
Vendors Overview | Import Vendors 

Basic  

To create a new vendor using copy: 
1. In your vendor list, highlight the vendor record to be copied. 
2. Select Copy from the window toolbar to copy all fields to a new record. 
3. Make any edits you need to modify the new vendor. 

At a minimum, a new Company name must be assigned to the new vendor. See vendor information fields for 
information about the various information that can be recorded for a vendor. 

4. Select Save. 
  
Related Topics 
Add a new vendor 
Delete a vendor 

Search for a Vendor 
Sort a List | Filter a List | Vendor Overview 

Basic  

To search for a vendor: 
1. In the Find Vendor field above your vendor list, enter a search keyword or keywords: 

Keyword Notes 

Company: Enter one or more words in company name. 

Vendor Code: Enter the entire vendor code. 

Name: Enter last or first name of vendor contact. 

Phone: Dashes and area code not required. 

ZIP Code: Enter the full zip code. To ensure that phone numbers including the same digits are not 
matched, select ZIP as the search field. See Advanced Find option below. 

(Pro) Custom 
Field 

Your custom named fields. 

3. Click Find (magnifying glass icon) or press <Enter>. 
All matching records are listed in the Find window. Note: If searching by company name from a 
vendor lookup field on a document or item record and one unique matching record is found, it is 
immediately listed in the field and the Find window is not displayed. 

4. In the Find window, you can confirm and select the correct record or narrow your search: 

• Highlight a record and double-click, press <Enter>, or choose Select Item. 
If searching from a lookup field, the vendor is listed. Other wise, the vendor form is opened. 
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OR 

• Select Advanced Find to narrow your search to a specific field or specify other search criteria 
and search again 

• Select Add New to add a new vendor 

• Select Go to Vendor List to display your full vendor list 
Back to top 
  
Related Topics 
Customize the columns in the Find window 

Edit a Vendor Record 
Overview | Find a Vendor Record | Make a Vendor Inactive 

Basic  

To edit a vendor record: 
1. Highlight the vendor record in your vendor list. 
2. Select Edit. 
3. Modify the vendor fields, as necessary. 

Read the warning below about editing vendor company names. 
4. Select Save. 

  
Warning: Changing a vendor company name  
  
Related Topics 
Delete a vendor 
Add a new vendor 
Merge vendor records 
Vendors overview 

Delete a Vendor Record 
Vendors Overview | Edit a Vendor Record | Find a Vendor Record 

Basic  

To delete a vendor record: 
1. Select the vendor records that you want to delete from your vendor list. 

How do I select multiple records?   
2. Select Delete Vendors from the I Want To menu. 
3. If prompted, confirm the deletion and specify if you want to delete the vendor from QuickBooks as 
well. 

  

Notes: 
• If you are deleting a vendor because you have duplicates, consider merging the records instead, as this 
will combine the two vendor histories into one record and remove the other. 

• Deleting a vendor record does not affect inventory items or history documents. The vendor remains in 
place in both of those areas and reports can still be generated for the deleted vendor. 

• We recommend deleting the vendor in QuickBooks if prompted. To guard against accidental deletion, if a 
vendor record is deleted in only one program, it is re-created upon the next Financial Exchange. Note that if 
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the vendor is listed on documents in QuickBooks, the record is made inactive instead of deleting it. Making 
the vendor inactive also prevents the record from being re-created with the next Financial Exchange. 

• If you delete a vendor, but later list that vendor on a receiving voucher (by referencing a purchase order 
listing the vendor, for example) the vendor record is re-created in both Point of Sale and QuickBooks with the 
next Financial Exchange. 

Related Topics 
Make a vendor inactive 
Add a new vendor 

Merge Vendor Records 
Find a Vendor Record | Delete a Vendor Record | Make a Vendor Inactive 

Basic  

Occasionally, you may find that a vendor has been entered twice in your vendor list. Merging the vendor records 
combines the purchase history of the duplicate entries into a single record and then deletes the other. 
If you are integrated with QuickBooks financial software, you will be prompted to delete the duplicate vendor in 
QuickBooks as well. 
(Pro) This task is available at Headquarters only. 

To merge vendor records: 
1. In your Point of Sale vendor list, select one or both of the vendor records you wish to merge. How 
do I select multiple records in my list?   
2. Select Merge Vendors from the I Want To menu. 

The Merge Vendors window opens with the pre-selected vendor(s) listed. 

 
3. Review the vendors and make changes as necessary: 

• Ensure the vendor record you want to keep is displayed on the left side of the window. You can 
reverse positions of the records (which to keep and which to remove) by selecting the Swap button 
located between them. 

• To add or change a vendor, use the drop-down lists to select or search for the vendor. 

• If you are integrated with QuickBooks financial software, the vendor name(s) as shown in your 
QuickBooks vendor list is shown to help verify you have the correct vendors selected. 
4. Select Merge Vendors. 

If the vendor being removed has a purchase history, a listing of the number of receiving vouchers and 
purchase orders to be updated is displayed. The vendor on these documents will be replaced by the vendor 
you selected to keep. Tell me more 

5. Select Merge Vendors. 
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6. If prompted, specify if you want to delete the duplicate from your QuickBooks financial software 
as well. See related notes below for more information. 

  

Notes: 
• If selected, the deletion in QuickBooks will occur with the next Financial Exchange. If the vendor to be 
deleted has a transaction history in QuickBooks, the vendor is made inactive instead of being deleted. If the 
vendor record is not deleted or made inactive in QuickBooks, it will be re-created in Point of Sale with the 
next Financial Exchange. 

• Updated documents resulting from a merge in Point of Sale are not resent to QuickBooks and the vendor 
records in QuickBooks are not merged. However, all new transactions will be recorded in QuickBooks for the 
vendor you selected to keep. 

Related Topics 
How vendor records are exchanged with QuickBooks 

View a Vendor's History 
Vendor Overview | Purchasing Overview | Find a Vendor Record 

Basic  

A vendor history report allows you to view summarized statistical data for the merchandise you have purchased 
and returned from/to a vendor, as well as displaying a list of vouchers and non-deleted purchase orders made for 
that vendor. You can expand the documents included in the report to view item detail or QuickZoom to view the 
document itself. 

To view a vendor’s history report: 
1. Highlight or display a vendor record from your vendor list. 
2. Display the list in collapsed format: the vendor's history is shown on the bottom of the information 
panel. 

Or 
Select Edit and then select the HISTORY tab on the vendor form. 
The vendor’s history report is displayed. 

 
How do I refresh a vendor's history?   

With a vendor history report displayed, you can: 

• Select the expand icon  to view the specific items listed on a document or Expand All above the list to 
show the items for all documents. 

• Change the column order/widths, sort the report by the values in any column, and, when available, use 
QuickZoom to view the associated documents. Learn more. 

• With a document selected, select an option from the I Want To menu: 
 Go To Document to view the document. Once you are in the document, you can view, edit, copy, 
or reverse it, using normal procedures. 
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 Print History to send the vendor history to your printer (or Print Preview) 

Notes: 
• If you delete purchase orders once they are filled, the deleted purchase orders are no longer displayed on 
the vendor history report, and their information is not included in the summarized statistical information. 
However, the receipt of the merchandise on deleted purchase orders is reflected in the receiving vouchers 
and receiving information on the report. 

• If you have a voucher or purchase order window open when you come to vendor history, you will have to 
switch back to the open document and cancel or complete it before you can copy from history to another new 
document of the same type. Only one of any document type can be open at a time. 

• It is suggested you not mix items from different vendors on purchase orders and receiving vouchers as this 
would hamper your ability to get accurate vendor histories. 

• Multi-Store Note: Vendor history at remote stores reflects only the documents made at that store. 
Headquarters will see all transactions at all stores. 

Track Items from Multiple Vendors 
Inventory Overview | Vendors Overview 

Pro 
The multi-vendor feature allows you to track and purchase an item from one primary vendor and up to four 
alternate vendors. Unique UPCs, Alternate Lookups, and order costs can be defined for each vendor from whom 
you purchase the item. This allows you to purchase the same item from any of several vendors as availability or 
costs change. 
All purchases of the item, regardless of vendor, are pooled in inventory once received, and are tracked with a 
single on-hand quantity, averaged cost, price, etc. However, the unique UPC, order costs, and alternate lookups 
allow you to list the item on documents using the information for any of the vendors. This feature also allows 
purchasing and receiving reports to be filtered by actual vendor used. 

What would you like help with? 
Define alternate vendors for an item in inventory  

1. Add each vendor from whom you will purchase the item to your vendor list. 
2. Add or edit the item in inventory in the normal manner, entering the first (primary) vendor’s 
name, UPC, and Alternate Lookup on the item form. 
3. In the More Info section, click Alt Vend. 

 
The Vendors window is opened. 

4. Enter information for up to four alternate vendors and then close the window. 
If the alternate vendors do not have a unique UPC or Alternate Lookup, leave these fields blank. 

7. Select Save. 
  

Notes: 
• If you want to print tags for an item with specific vendor information (alternate lookup value or UPC), 
print the tags from the purchase order or receiving voucher. When printing tags from inventory, the 
primary vendor's information is used. To print tags with UPC codes requires that you first customize your 
tag template using Print Designer. 

• If tracking multiple units of measure for an item, enter alternate vendor information (UPC, alternate 
lookup, and order cost) for your default order-by unit. If no order-by unit is specified, enter information for 
the base unit. 

  
Make a PO or receiving voucher for multi-vendor items  
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1. Enter the vendor from whom you are making the purchase at the top of the PO or voucher form. 
2. List the item(s) to be purchased or received: 

• If you list an item by entering or scanning UPC or Alternate Lookups (ALU), be sure to enter 
or scan the correct value for the vendor from whom you are making the purchase. 

• If you track multiple units of measure for an item being purchased, be sure to use the UPC or 
ALU for the default order-by unit. 

• The correct order cost for the vendor used is suggested for the item. Edit this order cost as 
necessary. 

3. Complete and save the PO or voucher in the normal manner. 
  
If creating a voucher by referencing a PO, the specific vendor and order costs listed on the PO will be carried to 
the voucher automatically. 
Purchase and receiving history is maintained for each vendor separately. 

  
List multi-vendor items on other documents  

No special procedure need be followed when listing multi-vendor items on documents other than a PO or 
receiving voucher. Scanning or entering the Item #, or any of the primary or alternate UPCs or Alternate 
Lookups for the item will list the item on the document with the correct inventory cost or price. 
Sales of a multi-vendor item are not tracked separately for each alternate vendor. All sales are reported using 
the primary vendor you identified in inventory for the item. 

  
Multi-vendor items on reports  

Merchandise Reports 
Merchandise reports, which draw their information from inventory, will show all of the item's quantities under 
your primary vendor's name. Quantities purchased from alternate vendors are not broken out separately. 
  
Purchasing Reports 
Purchasing, receiving, and on-order reports, which draw their information directly from purchase orders and 
receiving vouchers, will break out ordered quantities by alternate vendors. 

  
Print tags for alternate vendors  

Item tags printed from inventory always include the information for your primary vendor. To print tags that 
include alternate vendor information, such as the alternate lookup or UPC values, print the tags from the 
purchase order or receiving voucher used to purchase the items from the alternate vendor. 

  

Vendor Payment Terms 
Vendor Billing Information on Vouchers | Edit a Vendor Record   

Basic  

You can set up default payment terms for your vendors. The default terms that you specify are applied to purchase 
orders and receiving vouchers made for the vendor. 
How are vendor payment terms exchanged with QuickBooks? 

To define payment terms for a vendor: 
1. Display the vendor record in Form View (when adding or editing). 

2. Select the  button or press <F4> in the Terms field. 
The Terms dialog is displayed, as shown below. 

3. Enter information in the three fields to define the payment terms. 
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The example below shows that payment is due in 30 days (Net 30), with a 2% discount given if paid within 10 
days. 

4. Select OK. 
  

 
Related Topics 
Vendor field descriptions 
Security rights for vendors 
Import items from a Vendor Catalog 
How vendor records are exchanged with QuickBooks financial software 

Make a Vendor Inactive 
Overview | Find a Vendor Record | Edit a Vendor Record 

Basic  

Vendors in Point of Sale can be flagged as inactive. An inactive vendor: 

• Is not displayed when you filter your vendor list for active vendors (default view) 

• Is removed from most Vendor selection lists and filters 

• Is not exchanged with QuickBooks financial software (see note below) 
This allows you to flag utilities vendors (which may have been imported from your QuickBooks financial software) 
or any vendor not currently used in Point of Sale as inactive, so they do not display on your active vendor list. 

To make a vendor inactive: 
1. Select the Inactive checkbox on the vendor record. 
2. Select Save. 

  

Notes: 
• To view your inactive vendors, use the All Vendors filter or define a custom filter to display only inactive 
vendors. 

• To reactivate the vendor, clear the Inactive checkbox. 

• If you flag a new vendor as Inactive, that vendor will not be shared with QuickBooks financial software. 
However, if you later receive items from the inactive vendor on a voucher, the vendor will be created in 
QuickBooks when the voucher is sent to your financial software. 

Print your Vendor List 
Find a Vendor Record | Print Overview | Export Lists 

Basic  

To print a list of your vendors: 
1. Display the vendors you want included in the printed list. 
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• If you want to print a subset of your vendor list, filter the list to display only those vendors. For 
example, filter for active vendors if you want the printout to not include inactive vendors. 

• To include all of your vendors in the printed list, make sure the list filter is set to display all 
vendors. 
2. Select Print from the File menu. 

  

Printing Vendor List Reports 
You can also print your vendor list as a report, which gives you more freedom to customize the list for your 
particular needs or to export the vendor list to a spreadsheet. 
  
Related Topics 
Vendors overview 

Vendor Fields 
Data Field Overview | Vendors Overview | Program Capacities 

Basic  

This table lists the name and use of each vendor field. Fields shown in brackets, e.g. [field name], are suggested  
or read-only  fields auto-filled by Point of Sale. Fields marked with a * are required fields. 
If, when viewing a record list, columns (fields) shown below are not visible, you can customize the columns to add 
them. 
  

Field Usage 

Vendor Code Optional alphanumeric code, up to 3 
characters, identifying the vendor. This code 
is printed on price tags and can be used to 
lookup and list the vendor on another record 
or document. 

Company* Vendor company name. Required. 

Contact and 
Address Fields 

Vendor contact name(s), address, and phone 
numbers. 

Inactive Select this checkbox to hide unused vendors 
from the active vendor list and to stop 
exchanging the vendor’s information with 
QuickBooks Financial software. Learn more. 

Vendor Notes Optional notes, such as shipping lead time, 
FOB point, etc. 

Account # Your account number with the vendor. This 
number is printed on purchase orders and 
receiving vouchers that are created for the 
vendor. 

Terms Default payment terms for the vendor. These 
terms are suggested on purchase orders and 
receiving vouchers made for the vendor. 
Shared with QuickBooks, if integrated. Learn 
more. 

E-mail The vendor’s e-mail address. Entering an e-
mail address allows you to send an e-mail 
from the vendor record and to e-mail 
documents, such as purchase orders, from 
within Point of Sale. 

Vendor Website Record the vendor’s web address URL. Click 
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Go to Web to launch your browser and view 
the site. Internet connection required. 

Custom Fields 
(Pro) 

Define and use up to seven custom fields to 
track information not included in the basic 
fields. Once defined, these fields can be used 
to filter your vendor list and reports, and can 
be added to customized print templates (such 
as purchase orders and receiving vouchers). 

QB Status 
(QuickBooks 
financial software 
users only) 

Vendor list only. Displays the Financial 
Exchange status of the record: Not Posted 
(not yet sent to QuickBooks), Completed 
(sent to QuickBooks), or Error (attempting to 
send QuickBooks resulted in an error). Learn 
more. 

Return to top 

Purchasing Overview 
How do I?  | Create a New PO | Receive Ordered Items 

Create a PO 
Edit item order costs 
Enter discounts and fees 
E-mail a PO 
Receive against a PO 
View open POs by item 
Purchase from multiple vendors 

Find a PO 
Edit a PO 
Track POs by status 
Delete filled POs 
View suggested POs 
Handle special orders 

  

Pro 

Note: The availability of purchase orders is controlled by your Features to Use preference settings. 

  
When merchants need to restock or add new merchandise, they create and send temporary documents called 
purchase orders (POs) to vendors. A PO typically includes the following information: 

• The vendor’s name 

• Order, shipping, and cancel dates 

• A list of the items ordered, including description, order cost, and quantity ordered 

• The total cost of the order, including applicable discounts and fees 

• Optionally, terms of payment and payment due date (for tracking purposes) 

• A summary of the PO fill status (what has been received and what has not) 

• Ship To and Bill To stores 
The merchandise ordered on a PO is added to inventory when its arrival is recorded on a receiving voucher. When 
a PO has been filled, it can safely be deleted. The receiving voucher(s) that reference the PO provide the 
permanent record of the item purchased. 
Purchase orders are not shared between Point of Sale and your QuickBooks financial software. Since they are 
planning documents, they have no effect on inventory valuation. 
Remote stores can generate POs only for special order items. Regular POs are created only by Headquarters and 
are sent to each remote store for merchandise destined for their store. The remote store can reference those POs 
to create receiving vouchers. Learn More. 
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Note: If you have defined Reorder Points for your inventory items, you can easily view a list of the items whose on-hand 
quantities are at or below the reorder point on the Reminders window. Pro users can have Point of Sale suggest POs for the 
items on the reorder reminders. 

  
Related Topics 
Track PO fill status 
PO field descriptions 
Security Rights for Purchase Orders 
Preferences for Purchase Orders 
Multi-Store Purchasing & Receiving 

Inventory Reminders 
Inventory Overview 

Pro 
Inventory reminders help you track and manage your inventory by alerting you to situations that may need your 
attention. 
When an item’s combined on-hand quantity and on-order quantity has fallen below their reorder point, it is added to 
the Reorder Item reminders screen. You can print this list to help in creating purchase orders to replenish your 
inventory. 
Besides reorder reminders, you also are reminded  when item prices change,  when new items have been added to 
inventory, or when items have arrived to fill open customer orders. 

To view inventory reminders: 
1. From the home page, select Reminders from the Inventory menu. 
2. Select one of the available tabs. 

Reorder items reminders 
Price change reminders 
New item reminders 
Duplicate item reminders 
Fill Customer Order Reminders 

  

Notes: 
• With the reminders window displayed, you can print the list or double-click a displayed record to view it. 

• Reminders are a handy way for remote stores to learn of price changes and new items. 
Related Topics 
Reminders Message Alert 
Security rights for reminders 

Access Purchase Orders 
How do I?  | Purchasing Overview 

Create a PO 
Edit item order costs 
Enter discounts and fees 
E-mail a PO 
Receive against a PO 
View open POs by item 
Purchase from multiple vendors 

Find a PO 
Edit a PO 
Track POs by status 
Delete filled POs 
View suggested POs 
Handle special orders 
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Pro 
Select one of the following from the Purchasing menu: 

• Purchase Order List to view saved POs 

• New Purchase Order to create a new PO 

• Suggest PO to have Point of Sale recommend order quantities for items that have fallen below their 
reorder point (Pro) 

Create a Purchase Order – Basic Steps 
How do I?  | PO Overview | PO Fields 

Edit item order costs 
Enter discounts and fees 
E-mail a PO 
Receive against a PO 
View open POs by item 
Purchase from multiple vendors 

Find a PO 
Edit a PO 
Track POs by status 
Delete filled POs 
View suggested POs 
Handle special orders 

  

Pro 
Follow the steps below to create a new purchase order (PO). You can also make a new PO by copying an existing 
one. 
  

Note: The availability of purchase orders is controlled by your Features to Use preference settings. 

To create a new PO: 
1. Select New Purchase Order from the Purchasing menu. 

A blank PO form is displayed. 
2. Accept the suggested PO# (sequential order) or enter a unique alphanumeric number of your 
own. 
3. Select a vendor from the Vendor drop-down list. 

• Type the first few characters of the vendor company name to quickly jump to the vendor in the 
list. Select Add New if you need to add the vendor record while making the PO. 

• Press <F4> from the vendor field to go to your full vendor list to find the vendor. 

• The payment terms from the vendor’s record are suggested on the PO. 
4. If applicable, specify the store to which the items will be shipped in the Ship To Address field 
and the store to which the vendor bill should go in the Bill To Address field. 
5. Accept or edit the Order, Ship, and Cancel dates as necessary. 
6. List the items you want to order, entering an order quantity and cost for each item added. 

The purchase order cost is suggested as the Order Cost of the item in inventory, but can be edited as 
necessary. 

7. Enter information in other PO fields, including any applicable discount and/or fee that will apply to 
the order. 
8. Select Save. 

  

Pro Notes: 
• If using multiple units of measure, your default order-by unit and associated order cost is suggested. Use 
the Units of Measure field to order by a unit other than your default order-by unit. 

• You can also generate a PO from a customer order. 
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• With multiple stores, remote stores can generate POs only for special order items. 

• If you order the same item from multiple vendors you can list any of the item's vendors on the PO. 
Related Topics 
E-mail POs to vendors 
Handle special orders 
Purchase an item from multiple vendors 
Have Point of Sale suggest orders 
Multi-Store purchasing & receiving overview 
Track POs by status 

List Items on a Purchase order 
Purchasing Overview 

Pro 
Read the following sections to learn more about listing items on a purchase order. 
List items by UPC, alternate lookup, item #, or search keyword 
Select items from inventory 
Add new inventory items while making a PO 
Purchase by different units of measure 
List special order items 
  

Note: If you have defined Reorder Points for your inventory items, you can easily view a list of the items whose on-hand 
quantities are at or below the reorder point on the Reminders window. Pro users can have Point of Sale suggest POs for items on 
this list. 

  
Related Topics 
Create a new PO 
Edit a PO 
Delete items 
Enter order costs on a PO 
Have Point of Sale suggest orders 
Multi-store purchasing & receiving 

Handle Special Orders 
Customer Order Overview 

Pro 
A special order refers to the tasks related to ordering, receiving and/or selling custom or one-time merchandise that 
you do not currently carry in inventory and may never carry. 
There are two ways to handle special orders. 

• Customize an Existing Item — With this option you list an existing item on the document and then edit its 
descriptive information to reflect customizations to the item. Use this option when you do not want to create a 
new inventory item, but do want the document and any other related documents (sales receipt referencing a 
 customer order, voucher referencing a purchase order, etc.) to reflect your changes. Editing an existing item 
on a document does not affect the original item’s description in inventory. 

Even though the document reflects the special order edits you have made when selling, purchasing, or 
receiving the item, it is the original item in inventory that is affected as far as on-hand quantity, cost, etc. 
View examples 

• Create a New Special Order Item — With this option, a new special order item is created in inventory. 
You can list the item on a customer order or receipt, generate a purchase order for it, and receive it on a 
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voucher. Later, if you decide to carry the new item in inventory, you can convert it to a regular inventory item. 
Special order items can only be added while creating a document (customer order, receipt, voucher, or 
purchase order). 

In a multi-store configuration, the special order item type provides a means for a remote store to create a 
customer order or receipt for a new item and generate a PO for it. The special order item is sent to 
Headquarters with the first transactional document listing it. Headquarters can review the special order item 
and convert it to a regular inventory item, if desired. 
How do I create a new special order item? 

  
If creating a customer order, you can generate a purchase order right from the customer order to obtain the item 
from your vendor. 
  
Related Topics 
Convert a special order item to an inventory item 
Create a customer order 
Tips for using sales orders 
Add a new item while creating a document 

Order Costs on Purchase Orders 
Purchasing Overview 

Pro 
A purchase order (PO) is a document that asks a vendor to deliver goods at a certain cost. When listing items on a 
PO, Point of Sale will suggest the item Order Cost in inventory as the cost on the PO. You can change the cost on 
the PO by manually editing it. This does not affect the Order Cost assigned in inventory. 
When a receiving voucher is made to receive the PO items, the cost entered on the PO will be carried to the 
voucher, as will the vendor terms. When the receiving voucher is updated, the inventory Average Unit Cost and 
Order Cost will automatically be updated to reflect the change in the item cost. 
  
Printing tags when costs change: You have the option of printing tags for the items ordered on a PO. This way 
the tags are ready when the items are received. Be aware however, that if the PO is ordering items at a new cost 
and you print the tags from the PO, the tag price will be the current inventory price. It is recommended you review 
and update your item prices when receiving the items on a voucher or in inventory before printing tags in this case. 
  
Related Topics 
Create a new PO 
List items on a PO 
Use multiple vendors for an item 
Track item price and cost in inventory 

Purchase Order Discounts and Fees 
Purchasing Overview 

Pro 
Sometimes vendors will offer a discount or charge a miscellaneous fee on merchandise. You can add a discount 
and/or a fee in the totals area at the bottom of the purchase order. Discounts and fees are not spread over the cost 
of individual items listed on the PO. 

To enter a purchase order discount: 

• Enter a discount in the Discount (amount) or Disc % fields. 
AND/OR 

• Enter a fee amount in the Fee field. 
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Note that discounts entered on a purchase order are proportionally carried to receiving vouchers that reference the 
purchase order. For example, if a purchase order has a discount totaling $50.00 and you receive only half 
(calculated by value, not unit count) of the ordered items on a voucher, then $25.00 of the discount is applied to 
that voucher. The remaining discount amount will be carried to subsequent vouchers that receive the remaining 
due items. 
When a receiving voucher references a purchase order with a fee entered, you are alerted and can transfer the fee 
to the voucher at your discretion. This is because fees may not be not related to the value of ordered/received 
items, and may need to be applied differently if a partial shipment is received. Transferring a fee to vouchers that 
reference the purchase order is at your discretion. 

Email a PO  
Basic  

You can e-mail Point of Sale documents to your vendors and customers. All documents are e-mailed using the 
same basic procedure. 
When e-mailing documents, Point of Sale automatically launches your default Windows e-mail client, creates the e-
mail, and attaches the document in PDF format. 
(Pro) Other document e-mailing preferences allow you to create the document attachment in the format of your 
choice (PDF, Excel, HTML, or plain text) and define the default message text for each document type. 
You must have entered e-mail addresses for the customer and/or vendor being e-mailed on their respective 
records. 
  
To e-mail a document: 

1. Create the document following normal procedures. 
2. Display or select the document to be e-mailed: 

• Optionally, you can set your printing preferences to be prompted to e-mail each sales receipt to your 
customers (in addition to printing the receipt). This option also provides you an opportunity to collect 
customers' e-mail addresses if you don't already have them. 

• Order documents, such as purchase orders and customer orders, can be e-mailed while creating them or 
from the order list.  

• Transactional documents, other than sales receipts as described above, must be saved before they can 
be e-mailed from the document history list. 

4. Select Send as E-mail from the I Want To menu (or from window toolbar in some lists). 
 
Point of Sale creates the e-mail, attaches the document, and displays it in your default e-mail client.  
 
Important: Your e-mail client may display a permissions dialog for access to your e-mail application. In 
some cases, the message may be hidden under the POS window. Press <Alt+Tab> on your keyboard to 
switch to the message and give permission for the access. 

5. Review and edit the e-mail address, subject line, and message as necessary, and then select Send. 
Note: If you also have Microsoft Outlook installed, the e-mail and attachment will be generated in Outlook instead. 
You can either select Microsoft Outlook as your default e-mail client or, if you wish to continue using Outlook 
Express, use the Add or Remove Programs option from the Windows Control Panel to uninstall Microsoft Outlook. 

Print Purchase Orders 
Purchasing Overview 

Pro 
After completing a PO, you can print out a copy to send to a vendor or keep for your own records. 
For information about printing tags, see printing tags. 
Also read the general printing topic. 

To print a PO: 
1. Display the PO or select the PO(s) that you want to print. How do I select multiple POs?   
2. Select Print Purchase Orders from the Print menu. 
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3. If presented with a print option dialog: 

• Change the printer you want to use, if necessary 

• Specify to include All items or just Due items and the number of copies you want to print 

• Select More Options to preview or change the print template 
4. Select Print. 

  
Related Topics 
Find a PO 
Edit a PO 
E-mail a PO to the vendor 

Search for a Purchase Order 
Sort a List | Filter a List | Purchasing Overview 

Pro 
Instructions for searching for a purchase order are given below. 
You can also locate purchase orders in a vendor's history. 

To search for a purchase order: 
Searches are done by keyword across one or several selected fields (see the list of searchable fields below). 

1. In the Find PO field above your PO list, enter a search keyword: 

Keyword Notes 

PO #: Enter the purchase order number 

Date: 
(Order, Ship, or 

Cancel date) 

Enter in mm/dd/yyyy or mm/yyyy format, including slashes, Example: 10/05/2005 
finds all orders made on October 5; 10/2005 finds all orders made in October 

Associate: Login name of the associate that made the PO 

Vendor: Enter one or more words from the vendor company name 

3. Select Find (magnifying glass icon) or press <Enter>. 
All matching orders are listed in the Find window. 

4. Confirm and select the correct order or select from other options: 

• Highlight an order and double-click, press <Enter>, or choose Select PO. 
The order is displayed and all normal options are available to edit, print, e-mail, etc. 
OR 

• Select Advanced Find to narrow your search to a specific field or specify other search criteria 
and search again 

• Select Add New PO to create a new purchase order 
Back to top 
  
Related Topics 
Edit a PO 
Delete a PO 
Customize the columns in the Find window 
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Edit a Purchase Order 
How do I?  | Purchasing Overview 

Create a PO 
Edit item order costs 
Enter discounts and fees 
E-mail a PO 
Receive against a PO 
View open POs by item 
Purchase from multiple vendors 

Find a PO 
Track POs by status 
Delete filled POs 
View suggested POs 
Handle special orders 

  

Pro 
POs are order-planning documents, not transactional documents; therefore, they can be edited even after saving. 

To edit a PO: 
1. Locate and highlight a PO in your list. 
2. Select Edit from the main toolbar. The PO form is displayed. 
3. Navigate through the editable fields, making changes as needed. 

To edit a listed item, highlight the item and select Edit Item (<F5>). You can also add or delete items, if 
necessary. 

4. Select Save 
  
In a multi-store configuration, POs made for remote stores and later edited are resent to the remote store in the 
next Store Exchange. Remote stores cannot edit or delete POs received from Headquarters. 
  
Related Topics 
List items on a PO 
Delete a PO 

Delete a Purchase Order 
Purchasing Overview 

Pro 
Purchase orders are planning documents that have no direct affect on inventory. Therefore they can be safely 
deleted at anytime, whether because you have received all of the ordered items or because you are canceling the 
order. Vouchers made to receive the ordered items provide a permanent record. 

To delete a PO: 
1. Select Purchase Order List from the Purchasing menu. 
2. Locate and highlight the PO you wish to delete. 
3. Select Delete. 

  

Notes: 
• Once a PO has been deleted, it cannot be recovered. Deleted POs also are not displayed when viewing a 
vendor's history. However, the corresponding receiving vouchers are displayed in vendor history. 

• Deleting filled or canceled POs helps keep your PO list compact, so locating a PO when you need to is 
easier. 

• In a multi-store configuration: 
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• POs can be deleted only at Headquarters. (Exception: POs for special order items created at a 
remote store can be edited or deleted at the remote store.) Once a PO is filled, Headquarters can delete it, 
in which case it will be removed from the PO list at remote stores on the next Store Exchange. 

• A good practice at Headquarters is to regularly review your PO list and delete POs that have 
been filled. This helps keep the active PO file compact, making it easier to locate POs in the list, both at 
Headquarters and at remote stores, and makes Store Exchange mailbags smaller. Your receiving 
vouchers provide the permanent record of merchandise received. 

Related Topics 
Find a PO 
Create a new PO 
PO fill status 
Multi-store purchasing & receiving 

Receive Items Ordered on a Purchase Order 
Receiving Overview | Purchasing Overview 

Pro 
Receiving against a purchase order (PO) is the fastest and most accurate way to receive merchandise. A voucher 
can receive against one or more POs, and additional items can be added to the voucher using normal methods. 
  

Important Note: If maintaining accurate vendor histories, receiving reports, and being able to match up vendor bills and invoices 
in your financial software is important to you, we recommend against receiving against purchase orders from different vendors on 
a single receiving voucher. A good practice is to receive against a single PO from a single vendor with each voucher. Likewise, if 
you spread freight, fees, and discounts across item costs, it is a good practice to receive against only one purchase order per 
voucher. Otherwise, you may be spreading fees or discounts associated with one order over items from another. 

  
Receiving items ordered on a PO can be initiated from a new voucher (as described below) or directly from the 
purchase order against which you are receiving. From the purchase order you are receiving against:  Select 
Receive Items from the I Want to Menu 

To receive items ordered on a PO: 
1. From the Purchasing menu at the home page, select Receive Items. A blank receiving voucher is 
opened. 
2.  From the I Want To menu, select Receive from PO. The Select POs dialog is opened. 
3. At the top of the Select POs dialog, select the vendor. Only POs from the selected vendor are 
shown. 
4. Choose the PO(s) to receive against by selecting the checkboxes on the left. You can select one, 
multiple, or all POs in the list. 
5. Select Receive All Due to bring ALL the due items and quantities from selected POs to the 
voucher. 

OR 
Choose Select Items to Receive to receive only some of the items. Enter quantities for the items you want to 
bring to the voucher in the Doc Qty field and then select Continue. Learn more 

Tip: If receiving all but a few of the items, it may be faster to choose Receive All Due and then edit the quantities on the 
voucher. 

6. If the referenced PO(s) include fees, you are asked if you would like to apply them to this 
voucher. Select Yes or No. 
7. Review the Unit Cost and Qty of each item to be sure they reflect the actual order values. Edit it 
if necessary.  Learn more about voucher costs 
8. If applicable, add other received items (not on PO) using standard item listing methods. 
9. To enter or edit discounts, fees, and/or freight charges, select Enter Discount/Fee/Freight from 
the I Want To menu and enter the amounts. If applicable, select the Spread discount, freight and fee 
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checkbox to allocate these amounts over the individual item costs. Learn more about spreading these 
amounts 
10. If available, review or enter vendor billing information. Select Enter Billing Info from the I Want 
To menu. 
11. Select Save & Print. 

  

Notes: 
• Saving a voucher that references a PO automatically updates the PO’s fill status. 

• (Pro) If you generated a PO from a customer order (sales order), the customer order and purchase order 
numbers for the received items are shown in the voucher item list. Click the Show PO or Show SO buttons to 
view the orders. 

 
  
Related Topics 
Warn if PO is past its cancel date 
Enter vendor billing information 
Edit voucher items 
Update item prices from a receiving voucher 
Print tags 
Effects of saving a receiving voucher 
Multi-store purchasing & receiving 

Purchase Order Fill Status 
Purchasing Overview 

Pro 
The Qty Ordered, Qty Received, Unfilled %, and Qty Due fields are grouped together in 
the totals area of the PO form (also shown in the PO list). Together, they communicate the 
fill status of the entire PO. 
POs start with an initial Qty Received of 0 (zero) and Unfilled % of 100. The Qty Received 
increases, and the Qty Due and Unfilled % decrease as items are received on vouchers. 
For example, if you ordered 20 of a certain item and received only 15 on a voucher, the PO 
would show a remaining Qty Due of 5 and Unfilled % of 25. 
If a vendor substitutes items or quantities, the PO will show a remaining Qty Due and Unfilled %. If you want to 
accept the substitution and have the PO show that the order was filled, you can edit the PO to match the 
merchandise received, so that each item on the PO has a Qty Due of zero (0). The Unfilled % will be adjusted 
accordingly. 
To see the fill status of individual items, look at the Ordered (quantity) and Due fields for each item in the PO item 
list. 
  
Related Topics 
PO field descriptions 
Receive PO items on a voucher 
Track POs by order status 

Track Purchase Orders by Status 
Purchasing Overview 

Pro 
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The Status field on purchase orders allows you to track orders, filter order lists, and create reports based on the 
current entry. Point of Sale has these default purchase order status types. 

• Open - Assigned to all new orders. 

• Closed - Automatically assigned to POs that have been completely received. 

• Pending - Manually assigned status, typically used on orders that you have made but that you 
are not immediately placing with your vendor.  This  allows you to filter them out from purchasing reports 
and for Pro users, prevents unplaced orders from affecting your available quantity calculations and 
reorder reminders. 

• Suggested - (Pro) Automatically assigned to POs generated by the Suggest PO feature. 

To manually change the status of a purchase order: 
1. Display the purchase order in Form View. 
2. Select a new status from the drop-down list in the Status field. 
3. Select Save. 

To view the status history of a purchase order: 
1. Display the order in Form View. 
2. Click the icon next to the Status field. 

  

Notes: 
• If it fits your needs, you can add or rename status labels in company preferences. A purchase order’s 
status can be manually changed as the order is made and as it proceeds towards completion for tracking 
purposes. 

• As the status of an order is changed, Point of Sale records the date and the employee who made the 
change, so you have a running history of the order’s progression. 

• When a receiving voucher records the arrival of the ordered merchandise and the PO is 100% filled, the 
order’s status is automatically changed to Closed by Point of Sale. Closed POs don't show up in the default 
purchase order list view. 

Related Topics 
Create a purchase order 
Track PO fill status 

Generate Purchase Orders from a Customer Order 
Customer Order Overview | Purchasing Overview 

Pro 
You can quickly generate purchase orders from a customer order to order the listed items from your vendor(s). 
Point of Sale will propose a PO for all of the items listed (except service items), but allows you to review the 
proposed PO(s) and choose the items and quantities to actually order. Multiple items from a vendor are combined 
into a single purchase order. 

To generate purchase orders from a customer order: 
1. Complete and save the order document, if not already done. 
2. Highlight or display the customer order. 
3. Select Generate PO from the I Want To menu. 
4. The Select Items to Generate PO window is displayed, with all merchandise items from the 
customer order listed. 
5. Enter the quantity of each item to order from your vendor in the Doc Qty  column. 

• If you do not wish to order an item, enter 0 or leave the Doc Qty blank. 



Purchasing 

343 

• To order all of the items in the quantity needed for the customer order (Due column) choose 
Select All from the bottom of the window. 
6. Select Continue. 
7. A confirming message displays the number of POs created and gives you the opportunity to view, 
print, or e-mail the POs. 

If you want to add additional items to a PO created this way, select Show Me a List of POs created, select a 
PO and then select Edit to make changes before submitting the PO to your vendor. 

  

Notes: 
• You can generate multiple purchase orders from a single customer order. When generating subsequent 
purchase orders, the Due values are reduced by any item quantity on the order already sold. 

• Purchase orders generated from customer orders are numbered by Point of Sale by combining an order 
type prefix, the order number, and a sequential suffix. For example, the first purchase order generated from 
Sales Order # 24 would be numbered SO241, a second purchase order generated from this sales order 
would be numbered SO242, etc. Purchase orders generated from layaways or work orders would begin with 
LAY or WO respectively. 

• You can view the purchase orders generated from a customer order by displaying the order and selecting 
View POs from the I Want To menu. This selection takes you to a filtered purchase order list with only the 
PO’s generated from the selected order displayed. Select a purchase order and display it to review. 

• It is recommended that you review the generated purchase orders for correct order costs and quantities. 
Use your normal procedure to communicate the generated purchase orders to your vendors. 

• When receiving an item ordered this way, the customer name and Customer Order # is displayed on the 
receiving voucher to assist you in quickly filling the order. 

Related Topics 
Create a customer order: Basic steps 
E-mail orders to vendors/customers 

Using 'Suggest PO' 
Purchasing Overview | E-mail POs to Vendors 

Pro 
Point of Sale can suggest and generate purchase orders for items that are on your reorder reminders list. 
When this feature is used, Point of Sale displays a list of proposed items to order. 
  

 

To have Point of Sale suggest POs: 
1. Select Suggest POs from the Purchasing menu or from the Reorder Reminders I Want To menu. 

Point of Sale produces a list of suggested reorder items. 
2. Enter an Order Qty for each item. POs are not generated for an item if you leave the Order Qty 
field blank. 

Several item information fields, including current on-hand quantity, available quantity, and quantity already on 
order, are displayed or available to help you decide on new order quantities. 

3. If you purchase an item from multiple vendors, your primary vendor is suggested. If necessary, 
add and use the Order From column to change the vendor. 
4. Select Create POs from the I Want To menu. 
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Point of Sale generates purchase orders as specified using the item order costs from inventory. If multiple 
items are ordered for a vendor, they are combined on a single PO for that vendor. A confirmation message 
displays the number of POs created. 

5. The POs can be viewed, edited to change order costs or add additional items, and printed or e-
mailed to your vendor(s). 

Multi-Store Purchasing & Receiving 
How do I?  | Multi-Store Overview | Store Exchange Overview 

Manage a multi-store inventory 
View item quantities at other stores 
Order merchandise from vendors 
Receive merchandise from vendors 
View my vendor purchase history 
Transfer merchandise between stores 
Run multi-store reports 
Correct a remote receiving voucher after sending to HQ 
Handle special orders 
Exchange information among stores 

  

Pro - Multiple Stores 
Regular purchase orders (POs) are created at Headquarters only. 
A PO can be made for one store only. If you want to order quantities for all stores you must either make a separate 
PO for each store or make one PO for the entire quantity, receive that entire quantity at one location, and then use 
transfer slips to record the movement of the merchandise to the other stores. 
When a remote store receives a Store Exchange mailbag from Headquarters, only those POs made for that 
particular store are extracted and copied to the remote’s PO list. 
Each store can reference its own POs as it makes receiving vouchers to receive the ordered merchandise into 
inventory. A voucher updates the fill status of the PO both at the local store and at Headquarters, once Store 
Exchange is run to send the receiving voucher(s) there. When Headquarters deletes a filled PO, it is automatically 
deleted from the remote PO list after the next Store Exchange. Likewise, if edits are made to an active PO at 
Headquarters, the PO is resent to the remote store and overwrites the copy of the PO at the remote. 
Remote stores can create purchase orders only when creating special order items from a document (typically from 
a customer order). These POs are not sent to Headquarters, but the special order item is sent to Headquarters on 
the first transactional document listing it. Headquarters can make a special order item a permanent addition to 
inventory by converting it to an inventory item. 
Allowing remote stores to create special order items introduces the possibility of creating items with duplicate UPC 
or Alternate Lookups. Headquarters is alerted to and can fix these duplicate items from the duplicate item 
reminders screen. 
  
Tip: Good purchasing/receiving practices for multiple stores  
  
Related Topics 
Purchasing overview 

Purchase Order Fields 
Purchasing Overview | Data Field Overview | Creating a PO 

Pro 
Refer to the table below for descriptions of each purchase order (PO) field. Fields shown in brackets, e.g. [field 
name], are suggested  or read-only  fields auto-filled by Point of Sale. * designates a required field. 
If, when viewing a record list, columns (fields) shown below are not visible, you can customize the list columns to 
add them. 
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See also item fields for a description of common item fields that may appear on purchase orders. 

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  

Field Usage 

[PO #]* By default, a sequential number, starting 
with 1. 
If preferred, you can precede the number 
with a text string, such as the vendor name, 
vendor code, or the name of the associate 
making the PO. You can also change the 
starting number. See company preferences. 
Follow the instructions provided on the help 
sidebar on the preference page. 

Vendor* Required. The company name identifying 
the vendor listed on the PO. Select a vendor 
from the drop-down list, press (<F4>) to go 
to your vendor list, or select the Find 
Vendor button to search by keyword. 

[Status] The current status of the purchase order. 
Automatically set to Open on new POs and 
Closed on filled POs. Learn more. 

[Associate] The associate creating the PO. 
Automatically filled with the logged in user’s 
name or, if security is not used, name can 
be selected from the drop-down list of 
defined employees. 

Date Fields: Most date fields are editable. Select  
(<F4>) to access a pop-up calendar. 

[Order Date] Default: the date when the PO was created. 
Editable. 

[Ship Date] PO Ship Date: Enter the estimated shipping 
date for the order. Included on merchandise 
on-order reports. 

[Cancel Date] Optional field. Enter the date after which 
delivery may be refused. You can be alerted 
when receiving items against a PO past is 
cancel date via a company preference 
setting, but can still accept the shipment at 
your discretion. If this preference is not set, 
the Cancel date is ignored. 

[Payment 
Due] 

Calculated date field. Ship Date + Net Due 
Days from terms. Included for planning and 
reporting purposes. 

Item Fields These fields are located in the item list on 
the purchase order form. 

Ordered (Qty) Order Quantity: In the purchase order item 
list. Enter the quantity being ordered for the 
item. 

[On Order] On-Order Quantity: The quantity currently on 
order for the item. Updated with this PO’s 
order quantity when saved. May include 



Printed Documentation 

346 

order quantities from other POs. 

[Received] Received Quantity: The ordered item 
quantity already received on receiving 
vouchers. 

[Due] Due Quantity: The item quantity remaining to 
be received. 

[Cost] Order Cost: The cost at which an item is 
being ordered on the PO. Suggested as the 
current inventory order cost, but can be 
edited, as necessary. Up to five decimal 
places can be entered and are used in 
program calculations; though only two 
decimals are displayed. 

[Ext Cost] Extended cost: The quantity ordered 
multiplied by the unit cost. Editable. 
If ordering items with fractional cent costs, 
you can enter the quantity and extended 
cost, and Point of Sale will calculate the unit 
cost. Two decimals are displayed; five are 
stored and used in calculations. 

[Avail Qty] 
(Pro) 

Available Quantity. Quantity available for 
immediate sale. Equal to on-hand quantity 
less quantity committed on active customer 
orders. Learn More. 

[Unit of Measure] 
 (Pro) 

Used to display or change the unit (size) of 
the item being ordered when using the 
multiple units of measure feature. Defaults to 
your default order-by unit. 

Totals Fields These fields apply to the entire PO and are 
displayed at the bottom of the PO form and 
typically also in the purchase order list. 

[SubTotal] The total cost (sum of extended item costs) 
of the PO before applying any discounts or 
fees. 

Discount % Discount Percentage: Enter a percentage 
discount applicable to the PO. Discounts are 
applied to the PO subtotal. Entering a 
discount percentage causes the Discount 
(amount) field to be automatically calculated. 

Discount Discount Amount: Enter the amount of any 
discount applicable to the PO. Discounts are 
applied to the PO subtotal. Entering an 
amount causes the Discount % field to be 
automatically calculated. 

Fee Enter any fee applicable to the PO. For 
example, a special handling fee might be 
applied to an order. 

[Total] The total PO amount after discounts and 
fees are applied. 
Total = Subtotal – Discount + Fee 

[Qty Ordered] The total PO quantity ordered, combined for 
all items. 

[Qty Received] The total document quantity received to 
date. 
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[Unfilled %] The percentage of the total PO quantity that 
has not yet been received. Updated when a 
voucher that references the PO is updated. 
Unfilled % = (Qty Due / Qty Ordered) X 100 
See PO fill status. 

[Total Due] The total document quantity remaining to be 
received. Updated by receiving vouchers. 
Due = Qty Ordered – Qty Received. 

Instructions 1) Field on PO form for entering instructions 
to vendor regarding the order. Learn more. 
2) Up to two lines of optional text that print 
on POs, but are not displayed on-screen. 
Defined in company preferences. 

[No of Items] In PO List only: The total number of items 
(SKUs, not units) ordered on the PO. 

[Lay/SO/WO#] 
(Pro) 

PO list. If you generated the PO from a 
customer order, the order number populates 
this field for cross-reference. 

Ship To 
Store/Address 
 (Pro) 
  
Bill To 
Store/Address 
 (Pro) 

The number and address for the store being 
shipped the ordered merchandise. 
  
   
The number and address for the store where 
vendor should send the bill for the 
purchased merchandise. 

Return to top 
Program capacities 

Company Preferences: Purchasing 
Preference Instructions | Purchasing Overview 

Basic  

Use the Purchasing preferences to set various options related to the purchasing of merchandise from your vendors. 
  

Note: You must have purchase orders enabled in your Select Features to Use preferences for the following preferences to be 
applicable. 

  

Preference Function 

Purchase Order 
Numbering 

By default, purchase orders are 
sequentially numbered, starting with 1. 
If preferred, you can precede the number 
with a text string, such as the vendor 
name, vendor code, or the name of the 
associate making the PO. You can also 
change the starting number. 
Follow the instructions provided on the 
help sidebar on the preference page. 

Purchase Order 
Status 

There are default statuses for use in the 
Status field on purchase orders: 

• Open is automatically assigned to 
every new order. 
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• Closed is automatically assigned to 
the order once all listed items have 
been received on a voucher. 

• Pending should be assigned to 
planning orders that haven't been 
given to your vendor.  (Pro) And so 
they are not included when Point of 
Sale calculates available quantities. 

• Suggested is assigned to purchase 
orders generated by the Suggest 
PO feature. (Pro) 

You can change the name of these 
statuses, add new ones, and arrange the 
order they appear in the Status field 
drop-down list on order forms. Learn 
more. 

Purchase Order 
Instructions 

Enter up to two lines of optional 
instructions to print on POs. These 
instructions are not displayed on screen. 

  
Company preferences overview 
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Receiving 

Going Mobile 
How do I?  |  

Receive against a PO 
Receive without a PO 
Update cost of received item 
Update price of received item 
Enter vendor billing information 
Enter discounts, freight, and fees 
Record item serial numbers 

Find a saved voucher 
Edit a voucher 
Reverse (correct) a voucher 
View a vendor's receiving history 
Return merchandise to vendors 
Print tags from a voucher 
Transfer items to other stores 

  

Basic  

The Quickbooks Point of Sale Mobile Sync feature gives you the power to make sales and track your inventory 
using your mobile phone or tablet . Mobile Sync allows you to share your items with your mobile devices and make 
sales wherever and whenever you need.   
  

Why Sync to your Phone or Tablet?  
 
The QuickBooks Point of Sale Mobile Sync feature gives you the freedom to ring up credit card sales anywhere 
inside - or outside - of your store. 

• With an Intuit Payments Account and our free GoPayment app, you can make payments 
anywhere, anytime. 

• Start accepting payments instantly. Simply activate your payments account and you are 
ready to go. No application required. 

• All sales and inventory information instantly syncs with your Point of Sale software so 
your records are always accurate and up-to-date. 

• The Sync feature automatically records new payments as QuickBooks Sales Receipts. 
• Never miss a sale whether you are on the road, at a conference, or working a convention. 
• Long lines at the store?  Provide the best in customer service by completing sales on the 

spot.  
• If you are a QuickBooks user, all your information automatically syncs with your 

QuickBooks financial program. No more entry errors from re-keying data. Plus, you'll 
have everything ready for tax time. 
 
Note:  Intuit values your privacy and the security of your information. When using the 
Mobile Sync feature, your data is safely stored and securely transmitted through our 
servers directly to and from your mobile device. Intuit adheres to rigorous banking 
industry protection standards for secure data transmission. 

 

Get Your Intuit Payment Account first 
 
Before using the Mobile Sync feature, you'll want to first obtain an Intuit Payments Account. 
With an Intuit Payments Account, you can accept all major credit and debit cards as well as add Gift Card Services 
to your business. 
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To start accepting credit cards in QuickBooks Point of Sale 2013: 

1. Launch QuickBooks Point of Sale 2013. 
2. From the File menu, select Setup Interview and choose the Payments tab. 
3. Click Yes to accept credit and debit cards. 
4. Click Sign In. 
5. Be sure to sign in using the User ID (email) and password that you had previously created. 

If there is more than one, you will be prompted to select the right account.  

  
Learn more 

 
  
  

Access Receiving Vouchers & History 
How do I?  | Create a Voucher | Receiving Preferences 

Receive against a PO 
Receive without a PO 
Update cost of received item 
Update price of received item 
Enter vendor billing information 
Enter discounts, freight, and fees 
Record item serial numbers 

Find a saved voucher 
Edit a voucher 
Reverse (correct) a voucher 
View a vendor's receiving history 
Return merchandise to vendors 
Print tags from a voucher 
Transfer items to other stores 

  

Basic  

To access receiving vouchers: 

• From the Point of Sale home page, click the Receive Items button from the left sidebar. 

• Or, from the Purchasing menu, select one of the following: 

• Receiving History to view or work with saved vouchers 

• Held Vouchers to view or unhold a previously held voucher 

Create a Receiving Voucher: Basic Steps 
How do I?  | Voucher Information Fields 

Access receiving tasks 
Receive against a PO 
Update cost of received item 
Update price of received item 
Enter vendor billing information 
Enter discounts, freight, and fees 
Record item serial numbers 

Find a saved voucher 
Edit a voucher 
Reverse (correct) a voucher 
View a vendor's receiving history 
Return merchandise to vendors 
Print tags from a voucher 
Transfer items to other stores 

  

Basic  

A voucher adds items received from a vendor to your Point of Sale inventory.  A voucher can also be used to 
record the return of items to a vendor, which subtracts the returned quantity from inventory. 
Below is the basic procedure to create a voucher that is not receiving against a purchase order. 
Receiving items ordered on a PO?  Use this procedure instead. 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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Click the symbols in this procedure to view detail. 

This symbol indicates more information is available. Click to expand the information. 

  

To make a receiving voucher: 
1. At the Point of Sale home page, select Receive Items  from the Purchasing menu. A blank 
voucher is opened. 

View Example Voucher  

 
  

  
(Pro) Headquarters only: If creating the voucher for another store, select Change Store from the I Want To 
menu and enter the store number. 

2. In the Scan or enter item information drop-down box, scan or type item information to list the 
items being received.   

1.  

• Scan the bar code from the item tag. 

• Type the item's UPC, Item #, or alternate lookup value and press <Enter>  Learn more about 
these item identifiers 

• Search by item name (type beginning characters) or other item keyword. A list of matching 
items is displayed. Select an item from the list by clicking  it (keyboard users, press the down 
arrow key to scroll, then <Enter> to select). The selected item is added with a sales quantity of 
1. 

 
 If no matching item is found, check your spelling or the identifier you entered. 
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Entering fewer characters will find more matches. 

 To see your entire item list, click the  icon with no entry in the item search field. 
You can scroll through the list looking for the needed item. 

• Click Sell a Miscellaneous Item or Add a New Item to Inventory. 
Learn more about adding items to documents 

2.   
OR 
Click Quick Pick Item to select an item from your pre-defined lists of frequently received items. 

3. Click the action buttons below the line item to edit the quantity, cost, enter serial numbers, etc.  

2.  

•  Qty + and Qty –: Changes sales quantity up or down 1 unit 
with each click. 

•  Qty/Cost: Edit quantity or order cost.   

Tip: You can also enter the extended cost and quantity here and let Point of Sale calculate the order cost 
for you. This is especially useful for maintaining accurate cost tracking of (typically low-cost) items for 
which you want to track costs with several decimal places. The system will calculate and store the cost at 5 
decimal places (but only displays two). Learn more. 

• Edit: Open the Item Properties window and edit other information, such as item description or 
price. Pro users can enter a serial number or assign commissions on this window. 

• Return Item: If this item is being returned by the customer. This choice makes the quantity 
negative.  Learn more about taking returns. 

•  Remove: Delete the item from the receipt. 

3.   

 
4. Repeat until all items being received have been listed. 

Note: It is suggested you not mix items from different vendors on receiving vouchers as this would hamper your ability to 
view accurate vendor histories and reports, and make it difficult to match vendor invoices with the bills created by point of 
Sale in your QuickBooks financial software. 

5. In the Enter vendor name or phone box, type or scan vendor information to add the vendor to 
the voucher.  

4.  

Begin typing the vendor company name (recommended) or other search keyword ( phone number, 
contact  name, etc). 

• As you type, Point of Sale shows a drop-down list of your matching vendors, separated into 
company name matches and matches using all vendor fields. If there are company name 
matches, they are displayed first. Click the results line to open all field matches if necessary. 
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• Option: With no entry in the field, click the  icon to show your entire vendor list. You can 
scroll through the list to look for the customer. 

• Click a name to select it. Keyboard users can use the arrow up/down keys to move through 
the list and <Enter> to make a selection. 

• If the selected vendor has open POs you are prompted to receive against them. 

• If the vendor isn't in your list, click the  Add New Vendor to create a new vendor record. 

• Click the View/Edit button to open the vendor record or the Delete button to remove the 
vendor from the voucher (does not delete them from vendor list). 

 
  

5.   
6. Enter information in other voucher fields as appropriate. Commonly use fields on vouchers 
include comments and freight, fees, and discounts which can be spread across item costs at your 
discretion. 
7. If you want to print tags for the received items, select Print Tags from the I Want To menu. 

If item costs on this voucher are different than what is currently recorded in inventory, you are alerted – you 
may want to review and update your prices before printing tags. 

7. Click Print Voucher. 
  
How do I receive an item not yet in inventory? 
(Pro) If you order an item from multiple vendors read the notes about listing multi-vendor items on vouchers. 
  
Return to top 
  
Related Topics 
Copy a voucher 
Cancel or hold a voucher in progress 
Effects of saving a receiving voucher 

Receive Items Ordered on a Purchase Order 
Receiving Overview | Purchasing Overview 

Pro 
Receiving against a purchase order (PO) is the fastest and most accurate way to receive merchandise. A voucher 
can receive against one or more POs, and additional items can be added to the voucher using normal methods. 
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Important Note: If maintaining accurate vendor histories, receiving reports, and being able to match up vendor bills and invoices 
in your financial software is important to you, we recommend against receiving against purchase orders from different vendors on 
a single receiving voucher. A good practice is to receive against a single PO from a single vendor with each voucher. Likewise, if 
you spread freight, fees, and discounts across item costs, it is a good practice to receive against only one purchase order per 
voucher. Otherwise, you may be spreading fees or discounts associated with one order over items from another. 

  
Receiving items ordered on a PO can be initiated from a new voucher (as described below) or directly from the 
purchase order against which you are receiving. From the purchase order you are receiving against:  Select 
Receive Items from the I Want to Menu 

To receive items ordered on a PO: 
1. From the Purchasing menu at the home page, select Receive Items. A blank receiving voucher is 
opened. 
2.  From the I Want To menu, select Receive from PO. The Select POs dialog is opened. 
3. At the top of the Select POs dialog, select the vendor. Only POs from the selected vendor are 
shown. 
4. Choose the PO(s) to receive against by selecting the checkboxes on the left. You can select one, 
multiple, or all POs in the list. 
5. Select Receive All Due to bring ALL the due items and quantities from selected POs to the 
voucher. 

OR 
Choose Select Items to Receive to receive only some of the items. Enter quantities for the items you want to 
bring to the voucher in the Doc Qty field and then select Continue. Learn more 

Tip: If receiving all but a few of the items, it may be faster to choose Receive All Due and then edit the quantities on the 
voucher. 

6. If the referenced PO(s) include fees, you are asked if you would like to apply them to this 
voucher. Select Yes or No. 
7. Review the Unit Cost and Qty of each item to be sure they reflect the actual order values. Edit it 
if necessary.  Learn more about voucher costs 
8. If applicable, add other received items (not on PO) using standard item listing methods. 
9. To enter or edit discounts, fees, and/or freight charges, select Enter Discount/Fee/Freight from 
the I Want To menu and enter the amounts. If applicable, select the Spread discount, freight and fee 
checkbox to allocate these amounts over the individual item costs. Learn more about spreading these 
amounts 
10. If available, review or enter vendor billing information. Select Enter Billing Info from the I Want 
To menu. 
11. Select Save & Print. 

  

Notes: 
• Saving a voucher that references a PO automatically updates the PO’s fill status. 

• (Pro) If you generated a PO from a customer order (sales order), the customer order and purchase order 
numbers for the received items are shown in the voucher item list. Click the Show PO or Show SO buttons to 
view the orders. 

 
  
Related Topics 
Warn if PO is past its cancel date 
Enter vendor billing information 
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Edit voucher items 
Update item prices from a receiving voucher 
Print tags 
Effects of saving a receiving voucher 
Multi-store purchasing & receiving 

Handling Voucher Costs 
Receiving Overview | Update Item Prices When Costs Change 

Basic  

Point of Sale averages the cost of inventory items. This means that when items are received at a cost different from 
the current average unit cost in inventory, the received quantities and costs are averaged together with the existing 
inventory quantities and costs to determine the new average unit cost of the item. 

Example: If you have 10 of an item that was purchased at an order cost of $5 and then receive 10 more 
purchased at an order cost of $10, the new average unit cost of the item is $7.50. 

(10 x 5) + (10 x 10)/20 = 7.50 
  
This allows you to set an accurate profit margin for items and maintain an accurate inventory valuation when using 
Point of Sale in conjunction with QuickBooks financial software. 
When receiving merchandise, Point of Sale will suggest the cost  on the voucher as: 1) the order cost on a 
referenced purchase order, or, if no purchase order is involved, 2) the current order cost from inventory. 
Review and ensure that the correct cost information is entered on the voucher. 

To change the voucher cost of an item when receiving: 
1. Highlight the item in the voucher item list. 
2. Click Qty/Cost, enter the new cost, then click OK. 

If the voucher cost is different than what is recorded in inventory, Point of Sale will alert you that you may want to 
review and edit your item prices. 
  

Notes: 
• The order cost in inventory is not an averaged cost. When items are received at a new cost, that cost 
becomes the new order cost in inventory and will be suggested as the cost on future purchase orders and 
vouchers. 

• Point of Sale supports cost and price entries of up to five decimal places to facilitate ordering, receiving, 
and tracking items costing fractional cents. Learn more. 

• You can restrict an employee's rights to view item costs by using Point of Sale’s security features. 

• Your inventory prices are updated automatically by receiving vouchers only it the previous regular price is 
$0 (zero) AND you have a margin or markup entered on the item record. 

Related Topics 
How vouchers are transferred to QuickBooks financial software 

Enter Voucher Discounts, Freight, and Fees 
Create a Voucher: Basic Steps | Receiving Overview 

Basic  

Discounts, freight, and fees related to the purchase of merchandise can be added to receiving vouchers at your 
discretion. Optionally, you can spread these amounts over the cost of the items being received. 

To add discounts, freight, or fees: 
1. If receiving against a purchase order, discounts entered on the PO are automatically transferred 
proportionally to the voucher and you are prompted and have the option of transferring a fee from the PO. 
See the notes below for more information. 
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AND/OR 
From the I Want To menu, select Enter Discount/Fee/Freight. Place the cursor in the applicable field and 
manually enter or edit an amount. Discounts can be entered as a percentage (calculated from the voucher 
subtotal) or amount. 

 
2. To spread (allocate) these amounts over the cost of the items being received, select the Spread 
Discount, Freight and Fees checkbox. Note that once these amounts have been spread and the voucher 
saved, they cannot be edited or unspread.  Learn more. 
3. Complete the voucher and /printsave. 

  

Notes: 
• If a discount is entered on a referenced PO, it is transferred to a receiving voucher proportionally, i.e. if 
50% of the items (by value) ordered on the PO are received, then 50% of the PO discount is automatically 
suggested on the voucher. You can edit the voucher discount amount if you prefer to handle this differently. 

• If a fee has been entered on a referenced PO, you are alerted and can transfer the amounts to the 
voucher at your discretion. Since multiple vouchers can reference a single PO, you should be careful to 
transfer the fee amount only once, or edit the amount on the voucher to allocate the fee across the vouchers. 

• Discount, freight, and fee amounts may be edited even after a voucher has been saved, subject to the 
following: 

• If spread over the cost of the received items before saving, the amounts cannot be changed. 

• If not spread, integrated with QuickBooks financial software, and entering vendor billing 
information in QuickBooks, these amounts can no longer be edited after the voucher has been sent to 
QuickBooks. 

• If not spread, integrated with QuickBooks financial software, and entering vendor billing 
information in Point of Sale, these amounts can no longer be edited after adding the vendor billing 
information to the voucher and sending to QuickBooks (this may be the second time the voucher is sent to 
QuickBooks). 

Related Topics 
Enter vendor billing information 
Create a new voucher 
Copy a voucher 
Multi-Store purchasing & receiving 

Record Item Serial Numbers 
List Items on Documents | Find a Document 

Pro 
Item serial numbers can be recorded on documents for purposes of warranty tracking or meeting legal 
requirements. Once recorded, former documents can be quickly located by searching by serial number. 

To record serial numbers: 
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1. In inventory, specify those items for which you want to record serial numbers by selecting the 
checkbox for Use Serial #, located in the Misch and Shipping section of the item record. (Note: For an 
existing item, select Edit first.) 
2. When listing these items on documents (except purchase orders and cost memos), you will be 
prompted to enter a serial number for each unit being processed. 

  

Notes: 
• The serial numbers entered are saved and printed on documents. Serial numbers listed on a customer 
order are carried to the sales receipt when the items are sold, saving you the time of re-entering them. 

• The recording of serial numbers on documents is optional, even when you have enabled serial number 
tracking. To continue creation of a document without entering a serial number, click Cancel from the Enter 
Serial Number dialog. 

• You can record serial numbers even when not prompted. After listing the item, click  Edit and make an 
entry in the Serial # field. 

• Point of Sale does not keep track of the serial numbers of items currently in inventory. 

• If you decrease an item quantity on a document after having entered serial numbers, the previous numbers 
are cleared and you are prompted to re-enter numbers for each unit of the revised quantity. This is because 
the program has no way of knowing which specific unit(s) you are removing when you adjust quantities 
downward. 

Locating a Former Document by Serial Number 
You can locate a former document by serial number using search. For example, a former receipt for the sale of an 
item with serial number 23487497 could quickly be located by entering the serial number in the Quick Find  box on 
the home page or in the Search field at the top of your Sales History list and. 

Enter Vendor Billing Information 
Receiving Overview | How Vouchers are Sent to QuickBooks 

Basic  

You can enter vendor billing information, such as Invoice #, terms, bill and due dates, etc. for your merchandise 
purchases in either Point of Sale or in QuickBooks financial software. The setting that determines if the vendor 
billing fields are on the Point of Sale voucher form is located in company preferences. 
  

Note: This setting affects whether the necessary fields are included on the voucher form and how vouchers are sent to your 
financial software. We recommend you use the "How Vouchers are Sent..." link above to read about the differences before 
changing this setting. 

  
By default, the vendor billing fields are not on the Point of Sale voucher form. You can change this setting if you do 
not use QuickBooks financial software or if you prefer entering the information in Point of Sale. 

To change where vendor billing information is entered: 
1. From the File menu, select Preferences  Company. 
2. Select Receiving from the left-hand preference menu. 
3. Select or clear the checkbox labeled Enter vendor billing information in Point of Sale. 
4. Click Save. 

  
With the vendor billing fields added to Point of Sale, you can easily review and add billing information when you are 
making or editing a voucher. 

To enter vendor billing information on the voucher: 
1. With the voucher displayed, select Enter Billing Info from the I Want To menu. The Billing 
Information dialog is displayed. View example  
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2.   
3. Review and enter/edit information as needed. Typically, this information comes from the invoice 
from the vendor.  The vendor terms are suggested as the default terms from the vendor record or are 
carried from the PO. They can be edited here if necessary for this shipment. 

  
Related Topics 
Financial Exchange overview 

Printing Tags: Instructions 
How do I?  | Supported Tags | FAQs 

Specify tag printing templates 
Disable tag printing for an item 
Print the MSRP on tags 
Print markdown or discount tags in Price Manager 
Print cost on tags in code 
View supported tag and label styles and sizes 
Customize my tag templates 
Import print templates 
Install supported printers 
Troubleshoot my Zebra tag printer 

  
  
Item price tags can be printed from inventory, purchase and receiving documents, transfer slips, the Price Change 
reminders window, and from the Price Manager and Physical Inventory windows. 

To print tags: 
1. Select the item(s) for which you want to print tags. How do I select multiple items?   

• If working with a large item list, you may find it helpful to sort or filter the list first to group the 
items 

• If you want to print tags for all items on a document, you do not have to select the items; you'll 
have the choice of printing for all items in the Print dialog 
2. From the Print or I Want To menu, select Print Tags. 
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3. Depending on your program location, printer, and print option preferences, you may have the 
following choices in the Print dialog displayed: 

• Change the printer to which you are sending the tags 

• Choose to print tags for the selected item(s) or, on documents, all items 

• Specify a quantity of each tag to print:  the on-hand quantity, the document quantity, or any 
specified number of tags 

• Pro multi-store Headquarters only: Choose the store for which you printing tags 

• Calibrate your dedicated tag printer 

• Choose More Options to preview and/or change the tag template being used 
4. Select Preview or Print. 

If you are using a dedicated tag printer, your tags will immediately be previewed or printed. If you are using a 
laser or inkjet printer and sheet labels, the Print Tags/Labels window is displayed and the following additional 
steps apply. 

  
If Printing Tags on Sheet Labels 

5. Specify where you want to begin printing on the first page: 

 
• Specify the Column and Row numbers where you want the tags to begin printing (you can click 
the starting position on the diagram). This adjustment makes it possible to print on partial sheets of labels. 

• Optionally, select Alignment to check the start position of printed text and to adjust by 1/100-inch 
increments. You can print a sample page from the Alignment dialog. (Tip: use plain paper and hold up to a 
tag/label sheet to check alignment). 
6. Select Continue to print or preview your tags. 

  
Tip: Zoom preview to see small tag print  
Pro Tip: Print tags for alternate vendors  

Item tags printed from inventory always include the information for your primary vendor. To print tags that 
include alternate vendor information, such as the alternate lookup or UPC values, print the tags from either the 
purchase order or receiving voucher used to purchase the items from the alternate vendor. 

  
Return to top 
  
Related Topics 
Common Issues with Zebra Tag Printers 
List of compatible tag printers 
Order tag supplies from Intuit 

Search for a Voucher 
Sort a List | Filter a List | Receiving Overview 

Basic  

There are a couple ways of searching for a receiving voucher: 
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• Locate the voucher in the vendor's history or an item’s history. 

• Search directly in your receiving history as described below 

To search for a receipt in sales history: 
1. Open your receiving history. 
2. Begin typing keywords in the Search field above the list. 

 
• If you know the voucher number or vendor's invoice number, enter it. This is usually the fastest 
way to find a voucher. 

• You can also search by vendor name, associate that made the voucher, or any other voucher 
keyword. The more unique the search keyword, the fewer search results will be returned. 

• To search by the date the voucher was made, enter the date in mm/dd or mm/dd/yyyy format, 
including the slashes. 

• (Pro) If recorded on the voucher, you can search by item serial number. 

• As you type, the list is instantly filtered to display only matching vouchers. Note how the filter 
button now indicates the list is showing Search Results and the number of records found is shown at the 
bottom of the list. In this case, typing "renee" returned 11 vouchers made by Renee (not all shown). 

 
3. If no results are found, use the backspace key on your keyboard to go back and re-enter new 
characters. 
4. Select the voucher you wish to work with and then click Show Details or choose an appropriate 
task from the I Want To menu. 

  

Note: 
• To search for a voucher currently on hold, you must first display the held voucher list. 

Related Topics 
Edit a voucher 
Enter Vendor Billing Information 
Reverse and correct a voucher 

GoPayment Password 
Basic  

Forgot your GoPayment Password? 
 
Ask your administrator to reset your password. When you are provided  a temporary password, use it to sign in and 
create a new password. 
If you are the GoPayment administrator, you can reset passwords directly from your iPad: 

1.   Sign in with your Administrator credentials here.  
2.    From the menu, choose Account > Manage GoPayment. 
3.    Locate and tap the User ID.  

https://merchantcenter.intuit.com/
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4.  Tap Reset Password and click OK. 
5.    Use your new password to sign into GoPayment on your mobile device. 

  
Note: Passwords must contain between 6 and 25 letters, numbers or special characters, but no sequential strings 
like 123456. The password cannot be your User ID. 
  

Effects of Saving a Receiving Voucher 
How do I?  | Receiving Overview | Receiving Preferences 

Receive against a PO 
Receive without a PO 
Update cost of received item 
Update price of received item 
Enter vendor billing information 
Enter discounts, freight, and fees 
Record item serial numbers 

Find a saved voucher 
Edit a voucher 
Reverse (correct) a voucher 
View a vendor's receiving history 
Return merchandise to vendors 
Print tags from a voucher 
Transfer items to other stores 

  

Basic  

When you print/save a receiving voucher, Point of Sale performs the following actions: 

• Adds the quantities received into inventory (subtracts if a return voucher). 

• Re-calculates the received items' Average Unit Cost in inventory, if the cost has changed. 

• Updates received items' Order Cost in inventory, if changed, to the cost listed on the voucher. 

• Updates item prices if the item prices were formerly zero (i.e., new items being received for the first time) 
based on your defined margin or markup and any Price Level markdowns specified in company preferences. 

• Updates item Margin % and Markup%, and prices if you manually updated them from the voucher, if the 
cost has changed and the inventory price was not formerly zero (reorder items). 

• Updates the received items' Last Received Date. 

• Adds the voucher to your receiving history, item history, and the vendor’s history. 

• Updates any referenced PO’s fill status and item Received quantities. 

• Prints a copy of the voucher. 

• If integrated, sends the voucher to QuickBooks financial software on the next financial exchange. Learn 
more 

Related Topics 
Receiving overview 

Return Merchandise to Vendors 
Receiving Overview 

Basic  

Merchandise being returned to a vendor is recorded on a  voucher in the same way in which you receive items. The 
only difference is you enter a negative quantity for the returned items. 
If the merchandise being returned hasn't been received into your Point of Sale inventory via a receiving voucher, 
such as when discovering damaged goods upon arrival, you may choose to simply not receive it. No separate 
return document needs to be made in this case. 
  

Important  Note: If you need to match and reconcile vendor invoices, bills, and payments, such as in QuickBooks financial 
software, we recommend never mixing received and returned items on a single voucher. Doing so would result in "net" 
documents being created in your financial software, instead of individual bills and vendor credits. 
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You can create a return voucher by manually creating it or by copying the original voucher and making it a return. 
The second choice is best if returning all or most of  the items received on a voucher. 

To manually create a return voucher: 
Follow the basic procedure for creating a voucher: 

1. Select Receive Items from the Purchasing menu. 
2. List the quantities and cost of the items being returned. 

• The current order cost from inventory is suggested as the voucher cost. Edit to match original 
received cost as necessary. 

• Be sure to enter negative quantities. One way is to click the  Return Item for each item. 
3. Save the voucher. 

To make a return by copying the original receiving voucher: 
1. Locate the original receiving voucher in your receiving history. 
2. Select Return to Vendor  from the I Want To menu. 

A new voucher with the same information (except vendor billing information) as the original is opened with the 
quantities converted to negative quantities.. 

3. Edit the items and other information as needed. 
4. Save the voucher. 

  

Notes: 
• Do not make a return voucher for merchandise that has never been received into inventory, such as when 
you refuse delivery of merchandise that arrives damaged. 

• Upon saving, a return voucher deducts the returned item quantities from inventory, updates a referenced 
purchase order’s fill status, and is added to your receiving history. 

• If integrated with QuickBooks financial software, the vendor credit that results from a return voucher is not 
automatically applied to open bills in your financial software. In QuickBooks, select Pay Bills from the 
Vendors menu and apply the credit.  Refer to your QuickBooks financial software documentation if you need 
additional help. Learn More. 

Related Topics 
Find a voucher 
Multi-Store Purchasing & Receiving 

View a Vendor's History 
Vendor Overview | Purchasing Overview | Find a Vendor Record 

Basic  

A vendor history report allows you to view summarized statistical data for the merchandise you have purchased 
and returned from/to a vendor, as well as displaying a list of vouchers and non-deleted purchase orders made for 
that vendor. You can expand the documents included in the report to view item detail or QuickZoom to view the 
document itself. 

To view a vendor’s history report: 
1. Highlight or display a vendor record from your vendor list. 
2. Display the list in collapsed format: the vendor's history is shown on the bottom of the information 
panel. 

Or 
Select Edit and then select the HISTORY tab on the vendor form. 
The vendor’s history report is displayed. 
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How do I refresh a vendor's history?   

With a vendor history report displayed, you can: 

• Select the expand icon  to view the specific items listed on a document or Expand All above the list to 
show the items for all documents. 

• Change the column order/widths, sort the report by the values in any column, and, when available, use 
QuickZoom to view the associated documents. Learn more. 

• With a document selected, select an option from the I Want To menu: 
 Go To Document to view the document. Once you are in the document, you can view, edit, copy, 
or reverse it, using normal procedures. 
 Print History to send the vendor history to your printer (or Print Preview) 

Notes: 
• If you delete purchase orders once they are filled, the deleted purchase orders are no longer displayed on 
the vendor history report, and their information is not included in the summarized statistical information. 
However, the receipt of the merchandise on deleted purchase orders is reflected in the receiving vouchers 
and receiving information on the report. 

• If you have a voucher or purchase order window open when you come to vendor history, you will have to 
switch back to the open document and cancel or complete it before you can copy from history to another new 
document of the same type. Only one of any document type can be open at a time. 

• It is suggested you not mix items from different vendors on purchase orders and receiving vouchers as this 
would hamper your ability to get accurate vendor histories. 

• Multi-Store Note: Vendor history at remote stores reflects only the documents made at that store. 
Headquarters will see all transactions at all stores. 

Reverse a Voucher 
Find a Voucher | Edit a Voucher | Receiving Overview 

Basic  

If an error is discovered on a saved voucher, other than in the editable fields, it is necessary to reverse the voucher 
and then create a new, corrected one to update your receiving history and inventory. 

To reverse a voucher: 
1. Locate and highlight/display the voucher to be reversed in your receiving history. 
2. Select Reverse from the I Want To menu. 

If you are integrated with QuickBooks, a notice about the vendor credit that will be created is displayed. Read 
and confirm this message. 

If needed, create a new corrected voucher as described here. 
  

Notes: 
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• Reversing a receiving voucher takes the received quantity of each listed item back out of inventory and, if 
applicable, adjusts the average unit cost of the remaining on-hand quantity. It does this by automatically 
creating a new return voucher with an equal but opposite effect (lists negative quantities instead of positive). 

• When completed, the Status of the original voucher will be Reversed and the status of the new return 
voucher that is created will be marked Reversing. 

• If the original voucher referenced a purchase order (PO), reversing it will also revert the PO fill status and 
balances, providing the PO has not been deleted. 

• If an item listed on a reversed voucher has been deleted from inventory, the reversal causes the item to be 
added back to inventory. Learn more  

• If integrated with QuickBooks financial software, and the original voucher has already been sent to 
QuickBooks, the reversing (return) voucher is also sent and results in a vendor credit being created. The 
credit is not automatically applied to open bills in your financial software. In QuickBooks, select Pay Bills 
from the Vendors menu and apply the credit. Refer to your QuickBooks financial software documentation if 
you need additional assistance. Note: If the original voucher has not yet been sent to QuickBooks, then 
neither the original or reversing voucher are sent and no entries are made in your financial software for the 
transaction. 

• (Pro) Headquarters can reverse a former voucher without restrictions. Remote stores, however, can only 
reverse a voucher until it has been sent to Headquarters. Learn more 

Related Topics 
Multi-Store Purchasing & Receiving 

Multi-Store Purchasing & Receiving 
How do I?  | Multi-Store Overview | Store Exchange Overview 

Manage a multi-store inventory 
View item quantities at other stores 
Order merchandise from vendors 
Receive merchandise from vendors 
View my vendor purchase history 
Transfer merchandise between stores 
Run multi-store reports 
Correct a remote receiving voucher after sending to HQ 
Handle special orders 
Exchange information among stores 

  

Pro - Multiple Stores 
Regular purchase orders (POs) are created at Headquarters only. 
A PO can be made for one store only. If you want to order quantities for all stores you must either make a separate 
PO for each store or make one PO for the entire quantity, receive that entire quantity at one location, and then use 
transfer slips to record the movement of the merchandise to the other stores. 
When a remote store receives a Store Exchange mailbag from Headquarters, only those POs made for that 
particular store are extracted and copied to the remote’s PO list. 
Each store can reference its own POs as it makes receiving vouchers to receive the ordered merchandise into 
inventory. A voucher updates the fill status of the PO both at the local store and at Headquarters, once Store 
Exchange is run to send the receiving voucher(s) there. When Headquarters deletes a filled PO, it is automatically 
deleted from the remote PO list after the next Store Exchange. Likewise, if edits are made to an active PO at 
Headquarters, the PO is resent to the remote store and overwrites the copy of the PO at the remote. 
Remote stores can create purchase orders only when creating special order items from a document (typically from 
a customer order). These POs are not sent to Headquarters, but the special order item is sent to Headquarters on 
the first transactional document listing it. Headquarters can make a special order item a permanent addition to 
inventory by converting it to an inventory item. 
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Allowing remote stores to create special order items introduces the possibility of creating items with duplicate UPC 
or Alternate Lookups. Headquarters is alerted to and can fix these duplicate items from the duplicate item 
reminders screen. 
  
Tip: Good purchasing/receiving practices for multiple stores  
  
Related Topics 
Purchasing overview 

Voucher Fields 
Receiving Overview | Creating a New Voucher 

Basic  

Refer to the table below for descriptions of each voucher field. Fields shown in brackets, e.g. [field name], are 
suggested  or read-only  fields auto-filled by Point of Sale. 
If, when viewing a record list, columns (fields) shown below are not visible, you can use the customize columns 
feature to add them. 

Note: The ability to see cost fields, including margin and markup and other fields related to cost, can be controlled by security 
rights. If you do not have the right to view item costs, the fields will be masked like this "*****". This right affects cost fields in 
inventory and on all documents and reports. 

  

Field Usage 

Vendor* The vendor from whom the merchandise is 
received. Select the vendor in this drop-
down list or choose Select From Vendor 
List (<F4>). Brought from a referenced PO, 
if applicable. Required field. 
Upon entry, Point of Sale alerts you if open 
POs exist for the vendor. 

[PO #] The number of the purchase order that the 
voucher is receiving against.  Displays 
"Multiple POs" if receiving against more than 
one PO. 

[Date] The date when the voucher was created. 
Default: today’s date. Editable with security 
rights.  

[Associate] The person making the voucher. Populated 
with the logged-in user, if logins required. 

Item Fields These fields pertain to the received items 
listed on the voucher. See also Item Fields 
for a description of common item fields that 
may be available. 

[Qty] The number of units of an item received (or 
returned) on the voucher. From a referenced 
PO or suggested as one (1). Editable. 

[Unit Cost] For a voucher line item, the unit cost at 
which an item is being received (or 
returned). 
Default: The order cost from a referenced 
PO, or the current inventory Order Cost. 
Editable. 

[Ext Cost] Extended cost: For a voucher line item, the 
Qty x Voucher Cost. 



Printed Documentation 

366 

If receiving items with fractional cent costs, 
you can enter the quantity and extended 
cost, and Point of Sale will calculate the unit 
cost. Enter up to five decimals; only two 
decimals are displayed; but five are stored 
and used in calculations. 

[Original Order Qty] If referencing a PO, the item quantity 
ordered on the PO. 

[Order Qty 
Difference] 

The difference between the quantity that 
was ordered on a referenced PO and the 
quantity actually received. 

Serial #  (Pro) Used to record serial numbers of received 
items. Learn more. 

[Unit of Measure] 
 (Pro) 

Used to display or change the unit (size) of 
the item being received when using the 
multiple units of measure feature. Defaults to 
your purchase-by unit or the unit from a 
referenced PO 

[Store]  (Pro) The store receiving or returning the 
merchandise. At Headquarters, can be 
changed to create a voucher for any store. 
At remote stores, this field defaults to the 
local store and cannot be changed. 

Return to top   

Comments Text field for recording any pertinent 
information about the shipment. Select Edit 
Comments from the I Want to Menu if you 
need additional space. Comments are 
printed on the voucher. 

Billing Information 
Fields 

These fields appear only if you have elected 
to enter vendor billing information in Point of 
Sale in company preferences. These fields 
are editable even after the voucher is saved. 
This information affects how the voucher is 
sent to QuickBooks financial software. 

Already Paid Select this checkbox if you have already 
prepaid for the items, such as with a credit 
card. 

[Payee Name] Who is to be paid for the merchandise. 
Suggested as the vendor entered at the top 
of the voucher, but can be edited to another 
vendor from your vendor file. 

[Terms] Terms of payment. From the payee record, 
or if applicable, carried from a referenced 
PO. Can be edited for individual vouchers. 
Learn more. 

Bill Date Enter the billing date from the vendor’s 
invoice. 

[Invoice Due] The date that payment for the invoice is due 
to the vendor. Calculated from Bill Date and 
Terms. 

Invoice/Ref # Use to record the vendor’s invoice (bill) 
number for the shipment. Important: The 
entry in this field tells Point of Sale you have 
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received the invoice and that the voucher 
should be sent to your Accounts Payable in 
QuickBooks. 

[SubTotal] The sum of all extended item costs before 
discounts, fees, and freight are applied. 

Discount,Fee, and 
Freight  Fields 

Entered by selecting Enter 
Discount/Fee/Freight from the I Want To 
menu. Displayed in voucher totals area. 
These amounts may optionally be spread 
across the cost of the items being received. 
Learn more about spreading these amounts. 

Discount % 
Discount (amount) 

Enter a discount percent or amount. Making 
an entry in one field results in the other 
being calculated. If referencing a PO with a 
discount entered, the PO discount is 
proportionally carried to the voucher. These 
fields are editable after the voucher is saved, 
if not spread across items. 

Freight Use to record freight charges. This field is 
editable after the voucher is saved, if not 
spread across items. 

Fee Use to record vendor charges such as order 
fees. If referencing a PO with a fee entered, 
you are alerted and can transfer the fee to 
the voucher at your discretion. This field is 
editable after the voucher is saved, if not 
spreading across items. 

[Total] The voucher total after all discounts, fees, 
and freight are applied. 

[Printed Message] Not displayed on voucher form. One or two 
lines of optional text, defined in company 
preferences, that is printed on vouchers. 

Receiving History 
List Fields 

These fields are displayed only in your list of 
saved vouchers. You may have to customize 
the list columns to see them. 

[Voucher #] Sequential document number, assigned by 
Point of Sale. 

[Type] Type of voucher: Receiving or Return. 

[Status] Receiving History list. Indicates status of 
voucher: Regular, Reversed, or Reversing. 
See Reversing a Voucher for more 
information on reversing. 

[QB Status] 
(QuickBooks 

financial software 
users only) 

Receiving History list. Displays the status of 
financial exchange for a voucher: Not 
Posted (not yet sent to QuickBooks), 
Complete (sent to QuickBooks), Unbilled 
Purchases (merchandise has been received 
on a voucher but has yet to be billed), or 
error (attempting to send the voucher to 
QuickBooks resulted in an error). Learn 
more. 

  
Return to top 
Data field overview 
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Program capacities 

Company Preferences: Receiving 
Preference Instructions | Receiving Overview 

Basic  

Use the Receiving preferences to set various options related to receiving of merchandise from your vendors. 

Preference Function 

Warn when receiving 
against PO past its 
Cancel Date 

Alert employee when receiving against a 
PO that has passed the cancel date. If 
this preference is not selected, the 
cancel date is ignored. 

Enter vendor billing 
information in Point 
of Sale 

Select to enter vendor billing information 
on receiving vouchers in Point of Sale. 
By default, the vendor billing information 
fields are not available on Point of Sale 
receiving vouchers, as it is assumed you 
will track vendor billings in QuickBooks 
financial software. 
Learn more. 

Printed Voucher 
Message 

Enter optional default message to print 
on all vouchers. This message is not 
displayed on screen. 

  
Company preferences overview 
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Customer Orders (Pro) 

Customer Order Overview 
How do I?  | Customer Order Preferences 

Pro 
The term customer order collectively refers to layaways, sales orders, and work orders, which are used to record 
planned sales of merchandise and/or services to your customers. 
These versatile documents can be used for a variety of purposes, including: 

• Layaway of in-stock items, paid for via a series of deposits 

• Sales orders for out-of-stock merchandise 

• Special orders of new or custom merchandise 

• Customer quotes or estimates for merchandise and/or services 

• Tracking of repairs, alterations, warranty work, or any other service. 
Customer orders typically involve taking a deposit when the order is placed, optional additional deposits over a 
period of time, and ultimately final payment when the merchandise or service is recorded on a sales receipt. 
The ordered items are deducted from inventory only after you record them on a sales receipt to fulfill the order. 
However, they are immediately reflected in your available quantities, so you can see at a glance if on-hand items 
are already promised to another customer. Point of Sale alerts you when you receive an item that is on an open 
customer order. 
You can sell all the items on an order at one time, or partially "fill" the order by selling some of them as 
merchandise is received or services completed. When the sale is recorded, deposits previously taken are applied 
towards the final payment. 
A permanent record of the order and sale is provided by the receipt(s) in sales history. Fulfilled customer orders 
can be safely deleted at your discretion. 
In a multi-store configuration, each store creates and maintains its own customer orders. These order documents 
are exchanged between stores so that each store can view up-to-date available quantity information for all stores. 
However, customer orders created at one store cannot be viewed or filled at another store. The deposit and sales 
receipts created at remote stores to take deposits and fill customer orders are sent to Headquarters in the normal 
manner. 
  

Note: The availability of customer tracking features can be controlled by your Features to Use preference settings. 

  
Related Topics 
Tips for using sales orders 
Tips for using work orders 
Customer order field descriptions 
Customer order reports 
Security rights for customer orders 
How customer orders are sent to QuickBooks 

Create a Customer Order: Basic Steps 
How do I?  | Field Descriptions | Overview 

Pro 
The term customer order collectively refers to layaways, sales orders, and work orders. While each of these 
documents have specific uses, they share many procedural workflows. 

To create a new customer order: 
1. Select New for the appropriate order type from the Point of Sale menu. 
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2. In the Enter Item(s) field, scan or enter item information to list the merchandise or service items 
being ordered.  

1.  

• Scan the bar code from the item tag 

• Type an item identifier (UPC, alternate lookup value, or item #) and press <Enter> 

• Type the first few letters of the item's description (from inventory) or another search keyword. 
A drop-down list of all your items is displayed with the closest match highlighted. Select an item 
from the list by clicking or touching it (keyboard users, press the down arrow key to scroll, then 
<Enter> to select). 

 
 If no matching item is found, click the Find icon or press <Enter> to open the Find 
Item window, where you can select an item or refine your search.  You can also select Add 
New to go to inventory to add a new item and immediately sell it. 

• Choose Select from Item List from the I Want To menu to go to your full item list and select 
items. 

Learn more about adding items to documents 

2.   
3. Edit individual item information, such as quantity, price, tax code, and discounts, as necessary. 
4. Enter a Customer (required, How do I?). 
5. Enter any other pertinent information in the appropriate fields, such as: 

• Special instructions, such as the work to be performed 

• The status of the order for tracking purposes (defaults to Open) 

• On work orders, you may also want to enter a due date and/or assign the job to an employee. 
6. Select Deposit/Payment from the I Want To menu to take a deposit on the order. 

If a minimum initial deposit is required or suggested (optional preference setting), the Deposit window is 
automatically displayed if Save is selected before a deposit is taken. 

7. Select Save. 
  

Note: The availability of customer orders can be controlled by your Features to Use preference settings. 

  
Related Topics 
Handle special order items 
E-mail orders to customers 
Fill customer orders 
Tips for using sales orders 
Tips for using work orders 
Generate POs from a customer order 
Customer order overview 

Fill a Customer Order 
Locate a Customer Order | Make a Sale | Overview 

Pro 
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You fill a customer order by selling the ordered items on a sales receipt. You can sell some or all of the items on a 
customer order at any time. Selling items updates the Due and Sold fields on the order. When all the items on the 
order have been sold and the deposit and balance due are both zero, it is completely filled, and Point of Sale 
changes the status of the order to Closed. 

To sell the items listed on a customer order: 
1. Highlight or display the customer order. 
2. Select Sell Item(s) from the I Want To menu. 

The Select Items to Sell window is displayed. 
3. Choose Select All if you want to sell all the items on the order. 

Or 
Enter a quantity in the Doc Qty  column for each item you want to sell. 

4. Select Continue. 
The items you selected are listed on a new sales receipt. 

5. Add any additional items you are selling at the same time. 
6. Select Take Payment. 

If deposits have been taken on the order, the total amount of the deposit is automatically suggested as a 
payment method of Deposit. You can reduce or clear the deposit amount used, if you wish. You might do this 
if not selling all of the items at this time and you wish to maintain a deposit balance against the remaining items 
still due. 

7. Use normal payment procedures to enter amounts for additional payment methods or change as 
appropriate, and then save/print the receipt. 

  

Notes: 
• When receiving an item that has open customer orders against it, Point of Sale will alert you and add the 
item to your fill customer order reminders. 

• If you generated a purchase order from the customer order, information from the customer order (such as 
customer name and order #) are displayed right on the receiving voucher to assist in filling the order quickly. 

 
  
Related Topics 
View deposit/payment history 
Customer order reports 
How customer orders are sent to QuickBooks 

Handle Special Orders 
Customer Order Overview 

Pro 
A special order refers to the tasks related to ordering, receiving and/or selling custom or one-time merchandise that 
you do not currently carry in inventory and may never carry. 
There are two ways to handle special orders. 

• Customize an Existing Item — With this option you list an existing item on the document and then edit its 
descriptive information to reflect customizations to the item. Use this option when you do not want to create a 
new inventory item, but do want the document and any other related documents (sales receipt referencing a 
 customer order, voucher referencing a purchase order, etc.) to reflect your changes. Editing an existing item 
on a document does not affect the original item’s description in inventory. 
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Even though the document reflects the special order edits you have made when selling, purchasing, or 
receiving the item, it is the original item in inventory that is affected as far as on-hand quantity, cost, etc. 
View examples 

• Create a New Special Order Item — With this option, a new special order item is created in inventory. 
You can list the item on a customer order or receipt, generate a purchase order for it, and receive it on a 
voucher. Later, if you decide to carry the new item in inventory, you can convert it to a regular inventory item. 
Special order items can only be added while creating a document (customer order, receipt, voucher, or 
purchase order). 

In a multi-store configuration, the special order item type provides a means for a remote store to create a 
customer order or receipt for a new item and generate a PO for it. The special order item is sent to 
Headquarters with the first transactional document listing it. Headquarters can review the special order item 
and convert it to a regular inventory item, if desired. 
How do I create a new special order item? 

  
If creating a customer order, you can generate a purchase order right from the customer order to obtain the item 
from your vendor. 
  
Related Topics 
Convert a special order item to an inventory item 
Create a customer order 
Tips for using sales orders 
Add a new item while creating a document 

Take a Deposit on a Customer Order 
View Deposit History | Refund Deposits 

Pro 
When making a deposit on a customer order, a customer is, in essence, purchasing deposit credits that can later 
be used to pay for the merchandise/service purchase. Thus, receiving a deposit is an activity tracked on reports but 
is not a merchandise sale. A virtually unlimited number of deposits can be recorded for each customer order. 
You can configure Point of Sale company preferences so that a minimum initial deposit is suggested or required on 
new customer orders. 

To take a deposit: 
1. Create a new order or display an existing order. 
2. Select Deposit/Payment from the I Want To menu. 

The Take Deposit window is displayed. If this is the initial deposit and there is a suggested or required 
minimum deposit amount, it will be auto-filled. 

3. Enter an amount or accept the suggested/required amount. 
4. Select OK. 

The deposit receipt Payment screen is displayed. 
5. Take payment and save/print the deposit receipt. 

  
Related Topics 
Edit customer orders 
Customer orders on reports 
How deposits are sent to QuickBooks 
Preferences for customer orders 

Customer Order Payment History 
Take a Deposit | Refund a Deposit 
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Pro 
The Payment History window displays all deposits/payments for a particular order. Included in the Payment History 
for each deposit is the deposit amount, date, deposit receipt number, form of payment, and whether or not a 
deposit receipt has been reversed: 
You can take additional deposits or refund the amount on deposit directly from the Payment History window. 
When printing orders, the deposit history is included. 

To display an order’s payment history: 
1. Highlight or display the order. 
2. Select Payment History from the I Want To menu. 
3. Select Deposit/Payment to take an additional deposit. 

Or 
Select Refund to refund the amount currently on deposit. 

Select Cancel to close the Payment History window. 
  
Related Topics 
Locate a customer order 
Take a deposit 
Fill an order (selling items) 
Customer order overview 

Refund Customer Order Deposits 
View Deposit History | Take a Deposit 

Pro 
When a customer order is canceled, the entire amount on deposit is typically refunded and the order closed. 

To refund the entire deposited amount: 
1. Highlight or display the customer order. 
2. Select Issue a Refund from the I Want To menu. 

The refund confirmation window is displayed. 
3. Select Yes. 

The deposit receipt Payment screen is displayed with the refund amount listed in the Change column. 
4. Move or accept the amount for the change method (cash, credit card, etc.) you will use to refund 
the deposit and then save/print the receipt. 

The change window displays the refund amount and type. 
5. You are asked if you would like to close the unfilled order. Select Yes to change the status to 
Closed or No to leave the order open. 

  
If necessary, you can refund an individual deposit and leave the remainder by reversing the individual deposit 
receipt from sales history instead. This removes just the deposit amount made on that receipt from the customer 
order. 
  

Note: 
• If you charge a fee on canceled orders, such as a restocking fee, set the fee up as a service item in 
inventory, list it on the order, and sell it before issuing the refund. This will reduce the deposit balance and the 
refund by the fee amount. Be sure to follow local regulations regarding handling of customer deposits. 

Related Topics 
Fill an order (selling items) 
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Locate a customer order 
Delete a customer order 
Edit a customer order 
Customer order overview 

Search for a Customer Order 
Quick Find | Sort a List | Filter a List 

Pro 
Instructions for searching in your customer order lists (layaway, sales order, or work order) are given below. 
You can also locate customer orders by looking in the customer's history. 

To search for a customer order: 
1. Enter a search keyword in the Find field at the top of the order list: 

Keyword Notes 

Order #: Enter the order number 

Order Date: Enter in mm/dd/yyyy or mm/yyyy format, including slashes, Example: 10/05/2005 
finds all orders made on October 5; 10/2005 finds all orders made in October 

Associate: Enter Associate login name 

Customer Name Enter customer’s last or first name 

Company Name: Enter the customer’s company name 

Serial #: Enter an item serial number that was recorded on the order 

3. Click  Find (magnifying glass icon) or press <Enter>. 
All matching orders are listed in the Find window. 

4. Confirm and select the correct order or select from other options: 

• Highlight an order and double-click, press <Enter>, or choose Select <order type>. 
The order is displayed and all normal options are available to take or refund deposits, sell items, generate 
a purchase order, or print are available. 
OR 

• Select Advanced Find to narrow your search to a specific field or specify other search criteria 
and search again 

• Select Add New <order type> to create a new customer order 
Back to top 
  
Related Topics 
Customer order overview 
Customizing the columns in the Find window 

Edit a Customer Order 
Locate an Order | Take a Deposit | Edit an Order Item 

Pro 
If no deposits have been taken, you can edit any of the information on a customer order. If deposits have been 
taken, you are not allowed to change the customer. If you need to change the customer on a customer order for 
which deposits have been taken, you will have to refund the deposits first. You can then change the customer and 
re-enter the deposit. 

To edit a customer order: 
1. Locate and display the order you wish to edit. 
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2. Select Edit. 
3. Make any necessary changes and take any additional deposits. 
4. Select Save. 

  
Related Topics 
Delete a customer order 
E-mail an order to a customer 
Fill an order (selling items) 
Customer order overview 

Generate Purchase Orders from a Customer Order 
Customer Order Overview | Purchasing Overview 

Pro 
You can quickly generate purchase orders from a customer order to order the listed items from your vendor(s). 
Point of Sale will propose a PO for all of the items listed (except service items), but allows you to review the 
proposed PO(s) and choose the items and quantities to actually order. Multiple items from a vendor are combined 
into a single purchase order. 

To generate purchase orders from a customer order: 
1. Complete and save the order document, if not already done. 
2. Highlight or display the customer order. 
3. Select Generate PO from the I Want To menu. 
4. The Select Items to Generate PO window is displayed, with all merchandise items from the 
customer order listed. 
5. Enter the quantity of each item to order from your vendor in the Doc Qty  column. 

• If you do not wish to order an item, enter 0 or leave the Doc Qty blank. 

• To order all of the items in the quantity needed for the customer order (Due column) choose 
Select All from the bottom of the window. 
6. Select Continue. 
7. A confirming message displays the number of POs created and gives you the opportunity to view, 
print, or e-mail the POs. 

If you want to add additional items to a PO created this way, select Show Me a List of POs created, select a 
PO and then select Edit to make changes before submitting the PO to your vendor. 

  

Notes: 
• You can generate multiple purchase orders from a single customer order. When generating subsequent 
purchase orders, the Due values are reduced by any item quantity on the order already sold. 

• Purchase orders generated from customer orders are numbered by Point of Sale by combining an order 
type prefix, the order number, and a sequential suffix. For example, the first purchase order generated from 
Sales Order # 24 would be numbered SO241, a second purchase order generated from this sales order 
would be numbered SO242, etc. Purchase orders generated from layaways or work orders would begin with 
LAY or WO respectively. 

• You can view the purchase orders generated from a customer order by displaying the order and selecting 
View POs from the I Want To menu. This selection takes you to a filtered purchase order list with only the 
PO’s generated from the selected order displayed. Select a purchase order and display it to review. 

• It is recommended that you review the generated purchase orders for correct order costs and quantities. 
Use your normal procedure to communicate the generated purchase orders to your vendors. 

• When receiving an item ordered this way, the customer name and Customer Order # is displayed on the 
receiving voucher to assist you in quickly filling the order. 
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Related Topics 
Create a customer order: Basic steps 
E-mail orders to vendors/customers 

Track Customer Orders by Status 
Customer Order Overview | Customer Order Reports 

Pro 
The Status field on customer orders allows you to track orders, filter your order lists, and create reports based on 
the current entry. By default, Point of Sale assigns two order status types. New orders are assigned the Open 
status. The status of filled orders is automatically flagged as Closed. 
A third default status, Pending, should be applied to customer orders that don't commit item quantities to sales, 
such as orders made for estimates or customer quotes. Pending orders are not included in available quantity 
calculations, and thus don't affect reorder reminders or cause insufficient quantity prompts  when selling the items. 
If it fits your needs, you can rename the  default status types and define more of your own in company preferences. 
An order's status can be manually changed as an order is made and as it proceeds towards completion. Status 
field entries can be defined for each order type independently. 
As the status of an order is changed, Point of Sale records the date and the employee who made the change, so 
you have a running history of the order’s progression. 

To change the status of an order: 
1. Display the order form. 
2. Select a new status from the drop-down list in the Status field. 
3. Select Save. 

  
If you refund the deposit on a customer order, you are prompted to close the order. Select Yes to close the order or 
No if you want it to remain open. 

To view the status history of an order: 
1. Display the order form. 
2. Click the icon next to the Status field. 

All status changes which occurred after the order was created are displayed. 
  
Related Topics 
Locate a customer order 

Track Available Quantities 
Inventory Overview | Reorder Item Reminders 

Pro 
The term available quantity refers to the current on-hand quantity of an item minus the quantity of that item already 
committed to active customer orders. The available quantity is sometimes referred to as the available to promise 
quantity. Knowing the available quantity helps you make sales decisions and plan for additional purchases of the 
item. 
Available quantity calculations are used in Point of Sale to: 

• Alert you when you don't have sufficient available quantity of an item to complete a sales transaction. 

• Determine when items should be added to your reorder reminders list. If you prefer, you can set your 
company preferences to create reorder reminders based on the on-hand quantity instead. 

Where can I see an item's available quantity? 

• In the Basic Info section of the New/Edit Item form, select Available to open the Available Quantities window. 
This window summarizes all item quantity information, including current on-hand, on-order, and committed to 
customer orders, as well as a listing of the documents affecting those quantities. 
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• In the Avail Qty  column, available in your item list and on many Point of Sale documents and inventory 

reports. You may have to add the column to view it. 

 
• In the Item Information window, accessed by selecting Edit Item (<F5>) for an item listed on a document. 

Notes: 
• Quantities of an item on held documents or on customer orders assigned a status of Pending (such as those 

used to give estimates or quotes) are not reflected in the available quantity of the item. 

Fill Customer Order Reminders 
Fill Customer Orders | Reminders Overview 

Pro 
The Fill Customer Order Reminders screen displays open customer orders that can be filled or partially filled with 
your available (including just received) item quantities. When you receive backorder items on a receiving voucher, 
Point of Sale will alert you that there are customer orders pending for the received items. 
Use this screen to review the open orders, select those to fill, and then either go to the order or print fulfillment 
reports and pick lists. 

To view the customer order reminders: 
1. Select Go to Fill Customer Order Reminders from the alert when receiving backorder items. 
OR 
From the Inventory menu, select Reminders and then select the Fill Customer Orders tab. 
2. In the drop-down list on the right, choose to view orders that can be Filled Partially or only those that can 

be Filled Fully. 
Tip: Use normal list sorting and customize column procedures to display the list in the manner you prefer, e.g. 
by order number, order date, etc. 
3. Use the checkboxes in the Select column to select the order(s) you would like to fill. See note below about 

using this feature to optimize order fulfillment. 
4. Go to a selected order or print a fulfillment report and pick list: 

• To immediately go to an order to process it, double-click it in the list. 

• To print fulfillment reports for selected orders, select Print and then either Fill Order Report or Item Pick 
List. 

5. Process the selected orders individually using standard order fulfillment procedures. 
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Notes: 
• Optimizing Fulfillment: As you select orders to fill, Point of Sale recalculates the status of the remaining 

orders. If filling one order makes an item unavailable to fill another order, the second order is disabled for 
selection. To clear the selected orders and try different combinations, choose Clear All Selections from the I 
Want To menu. To have Point of Sale suggest orders to fill, giving priority to oldest orders first, clear any 
previous selections and then choose Auto-select Orders. The results of this option will vary depending on 
whether you have chose to see orders that can be partially or fully filled. 

Related Topics 
Security rights for reminders 
Inventory overview 
Reminders Message Alert 

Tips for Using Sales Orders 
Customer Order Overview | Order Field Descriptions 

Pro 
Sales orders are a type of customer order that allow you to record the planned sale of items currently out of stock 
or items that you don't currently carry. Sales orders can also be used to give a customer a quote for merchandise 
and/or services that you would like to sell. 

Sales order for out-of-stock items: 
1. List the out-of-stock item on the sales order. 
2. Complete other applicable fields, such as discounts, shipping information, etc. 
3. Take a deposit, if you require one. 
4. Print a copy of the order for the customer. 
5. Create a purchase order and receive the merchandise from your vendor. 

Tip: Generate a PO right from the sales order, if necessary 
6. When the item is in stock again, contact the customer and record the sale on a sales receipt, 
applying any deposits toward the final payment. 

Sales order for special order merchandise 
1. Start a new sales order and select New Special Order Item from the I Want To menu. 
2. Define the special order item and then list the item on the sales order. 
3. Edit the price, quantity, etc. on the sales order. 
4. Take a deposit, if you require one. 
5. Select Generate PO to create a purchase order for the new item from the sales order. 
6. Print a copy of the order for the customer. 
7. Create a voucher when the item arrives to receive it into inventory. 
8. Contact the customer and record the sale on a receipt. Apply the deposit balance to the sales 
receipt. 

Sales order for a customer quote 
If the quote is for services only, you may want to use a work order instead. 

1. List the items and/or service items included in the quote. 
2. Change the order status to Pending. This prevents the item quantities from affecting available 
quantity calculations, since they are not yet committed to a sale. 
3. Save and print the order. Give the customer a copy of the quote/sales order. 
4. When the customer accepts your quote, deliver the merchandise and/or services and record the 
sale on a receipt, accepting payment as usual. 
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Customer orders not available to you? This could be due to your security level or customer orders may be disabled in your 
Features to Use company preference settings. 

  
Related Topics 
Create a customer order: Basic steps 
Track an order by status 
Tips for using work orders 
E-mail a document 
Customer order reports 

Tips for Using Work Orders 
Customer Order Overview | Order Field Descriptions 

Pro 
The basic procedures used to create, take deposits, edit, or fill work orders are the same as for all types of 
customer orders. 
This topic contains specific ideas for using those procedures to best advantage in tracking work orders. Select a 
link from the following list for more information. 
Use service items 
Track warranty work 
Describe the problem or work to be performed 
Assign work orders to employees 
Track work orders by status 
Track work order dates 
Print work order messages 
  
Overview 
Whereas layaways and sales orders usually involve merchandise orders, work orders generally are for service-only 
jobs, such as alterations, repairs, or warranty service. Merchandise recorded on a work order is typically consumed 
in the service, such as repair parts. Work orders typically do not include the sale of the item being serviced. Work 
orders usually include a labor component, identified as a service item in inventory. 
Work orders can be assigned to the employee who is to perform the service, a due date can be specified, and the 
completion status can be tracked and reported. 
  

Customer orders not available to you? This could be due to your security level or customer orders may be disabled in your 
Features to Use company preference settings. 

  
Related Topics 
Create a work order 
Take a deposit 
Handle special orders 
Preferences for Customer Orders 
Tips for using sales orders 

Delete a Customer Order 
Locate an Order | Refund a Deposit | Edit an Order 

Pro 
Customer orders can be safely deleted at any time as long as no deposit balance exists, . 
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To delete a customer order: 
1. Select or display the customer order(s) you want to delete. How do I select multiple orders?   
2. Select Delete from the I Want To Menu. 

If the customer order has a remaining deposit balance, it cannot be deleted until you refund the deposit. Point 
of Sale will alert you if this is the case. 

  

Notes: 
• Typically, a customer order is deleted after all the ordered items have been sold (Qty Due = 0) and the 
order closed. The sales receipt provides a permanent record of the transaction. 

• Deleting a customer order removes it from the corresponding customer order list and from the customer's 
history (although the sales receipt remains). 

• You are not required to delete customer orders after they have been filled, but if there is little chance you’ll 
ever want to view or copy it in the future, you may want to delete it just to keep your order list compact. Once 
deleted, a customer order cannot be recovered. 

Related Topics 
Fill an order (selling items) 
Customer order overview 

Customer Order Fields 
Customer Order Overview | Program Capacities 

Pro 
Refer to the table below for descriptions of each customer order field. Fields shown in brackets, e.g. [field name], 
are suggested  or read-only  fields auto-filled by Point of Sale. 
If, when viewing a record list, columns (fields) shown below are not visible, you can use the customize columns 
feature to add them. 
See also item fields for a description of common item fields that may appear on documents. 
  

Field Usage 

[Address] Contains the company name (if any), the address, 
and phone number for the customer listed on the 
order. Taken from the customer’s record. To edit a 
customer’s information, click the Edit button next 
to this field to open the appropriate record for 
editing. 

[Amount] On the Payment History screen. The amount of a 
particular deposit. 

Assigned Work order only. Select the employee to whom the 
service job is to assigned. Suggested as the 
logged in employee. As the work progresses, this 
field can be edited as necessary. The Assigned 
field can be used to filter the work order list and 
reports. 

[Associate] Header and item list. Suggested as the logged in 
employee, but can be edited for the entire 
document (header field) or item-by-item (in the 
item list) for the purpose of tracking sales 
commissions. 

[Balance Due] The balance remaining on the customer order. 
(Total – Deposit Balance) 

[Cashier] Auto-filled with the logged in employees name and 
cannot be changed if logins are required. 
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[Commission %] Item list. The commission rate assigned to the 
specified Associate, if item eligible for 
commissions. 

[Commission 
Amount] 

Item list. The commission amount for the item, 
based on the item price and the Associates 
commission percentage, if item eligible for 
commissions. 

Customer Required. The customer’s name with title, or 
company name, from the customer record. This 
field is also used as a customer lookup/search 
field. Enter a customer’s first or last name, 
company name, phone number, or a search 
keyword and press <Enter> or click the Find 
Customer button. 

Customer PO # On orders for customers being tracked as 
businesses, this field is added to the Customer 
Info section of the order. Use to record the 
customer's purchase order number. 

[Deposit Balance] The sum of all deposits received, less any 
deposits already applied toward sale. 

[Dep Receipt #] Payment History screen. Deposit receipt number; 
sequential number assigned to the receipt used to 
record the deposit. 

Description of 
problem 

Work orders only. Use to record the service to be 
performed and any special instructions. Select the 
Edit Instructions icon in this field if more space is 
needed. 

Discount Fields 
  
   Discount 

Enter any discount amount or percent and Point of 
Sale calculates the others. 
Totals area: Global discount amount for the 
customer order. 

   Discount % Item list: A percentage discount applied to the 
specific item price. 
Totals area: A global percentage discount applied 
to the entire document (subtotal). 

   Unit Discount Item list: A discount amount applied to the specific 
item price. 

   Ext Discount Item list: Extended item discount. (Order Qty x 
Unit Discount) 

   Disc Type Item list. Allows you to specify the reason for an 
item discount. Discount types can be customized 
in company preferences and used to filter reports. 

[<Document> #] Examples: Layaway #, Sales Order #, or Work 
Order #. Sequential number assigned by Point of 
Sale using a separate sequence for each order 
type. The numbering format can be customized for 
each order type in company preferences. 

Due Date Used on work orders to record the expected 
completion date. 

[Ext. Price] Item list. The extended price of a customer order 
item (Price X Qty) 

Instructions Layaways/Sales Orders. Optional instructions 
field. Click the edit instructions field for more room 
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to record notes. 

[Order Date] The date the customer order was created. Default: 
the current date. 

Ordered Item list: The quantity of an item being ordered. 
Suggested as one (1) or the Doc Qty  transferred 
from inventory. Editable. 

[Payment] Payment History screen. The payment type (cash, 
credit card, check, etc.) used to make the deposit. 

Price Item list. The price of the item for this particular 
customer order. Suggested is the inventory price 
for the current price level. Enter new price if 
necessary; entries here do not affect inventory 
prices. 

Price Level The price level applied to the order. Select a new 
price level from the drop-down list to change. 

Promo Code Optional field used to record a miscellaneous note 
on a customer order, such as a note identifying a 
special sale. An entry in this field can be required 
in by a company preference and used to filter 
reports. 

[Qty Due] Item list. The item quantity remaining to be 
received by the customer.  (Qty Due =Ordered – 
Sold) 

[Reverse] Payment History screen. If a receipt used to take a 
deposit has been reversed, Reversed is displayed 
in this field. Receipts that reverse a deposit receipt 
show Reversing in this field. 

Shipping Enter an optional amount for shipping charges. On 
sales orders, you can select Shipping 
Information from the I Want To menu to specify 
provider and shipping address. 

[Sold] Item list. The item quantity already sold to the 
customer. 

Status Current status of the order: Open, Closed, 
Pending or a custom status you have defined. 
Used to track and filter the progression of orders 
for viewing and reporting. Learn more. 

Subtotal The total amount due for the customer order 
before adding discounts, taxes or shipping costs. 

Tax The total tax being charged for the customer 
order. 

Total The total amount for the customer order, including 
all taxes, charges and discounts. 

Unfilled % Order Lists: Percentage of the order not yet sold 
to the customer, based on total order quantities. 

[Unit of Measure] Used to change the unit (size) of the item being 
sold when using the multiple units of measure 
feature. Defaults to your default sell-by unit. 

Return to Top 
Creating a customer order 
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Multiple Stores (Pro) 

Multi-Store Overview 
How do I?  | Store Exchange Overview 

Manage a multi-store inventory 
View item quantities at other stores 
Transfer merchandise between stores 
Purchase and receive for multiple stores 
Track customers with multiple stores 
Run multi-store reports 
Track profit/loss by store 
Exchange information among stores 
Troubleshoot Store Exchanges 
Use the QuickBooks POS Merchant or Gift Card 
Services at multiple stores 

  

Pro - Multiple Stores 
Point of Sale Pro can be configured to manage up to ten stores, each with one to ten workstations running the 
software. Program includes features like centralized purchasing and inventory control, inter-store transfers, 
exchange of information between stores, company-wide reporting, and the ability at any store to view the on-hand 
quantity of an item at any other store. 
One store is designated as the Headquarters store (Store 1). Headquarters maintains central control over 
inventory, purchases merchandise, runs company-wide reports, and handles data exchange with QuickBooks 
financial software. Headquarters also has all the capabilities of a remote store, plus can create documents for any 
store. 
Stores 2-10, called remote stores, receive and sell merchandise, capture customer information, transfer items to 
other stores when necessary, and run local store reports. Each store authorizes and settles its own credit, 
debit/ATM, and gift card transactions, runs the End of Day procedure, and defines its own employees and security 
settings. 
Headquarters and remote stores communicate through a process called Store Exchange. Store Exchange typically 
is done at the end of each business day, so that Headquarters, all stores, and your financial software all have 
current information for the start of the next business day. 
  
Related Topics 
Allowed activities by store type 
Point of Sale basics 

Store Exchange Center 
How do I?  | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Configure Store Exchange 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 

  

Pro - Multiple Stores 
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The Store Exchange Center is a central place to initiate all tasks related to exchanging data between your stores 
and to see the current status of exchange with each store. 

To access the Store Exchange Center: 

• From the Stores menu or the Navigator, select Store Exchange Center. 

 
  

The Store Exchange Center is made up of three panels: 

 Actions: Use these buttons to send or receive Store Exchange mailbags, prepare and send item pictures, 
configure exchanges, and view the activity log to troubleshoot any problems encountered. 

 FAQs: Provides answers to frequently asked questions about Store Exchange. 

 Status: Provides the exchange status with each of your other stores. At a glance you can view the last 
successful exchange dates and times and color coding provides an alert when an issue needs your attention 
(Green - OK, Yellow - Minor issue. Red - an issue that needs your attention). Use the buttons and I Want To 
menu for each store to perform routine tasks or correct problems. 

Notes: 
• You can set a preference to be alerted in the Status panel when an exchange with a store doesn't occur in 
a specified number of days. 

• You can also add the Store Exchange Status report to your Point of Sale Dashboard. With the Dashboard 
displayed, select Customize Dashboard and then add the report from the "Other" content area. 

Related Topics 
Schedule Store Exchanges 
Send item pictures to remote stores 
What if a mailbag is lost or damaged? 

Configure Store Exchange 
How do I?  | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 

  

Pro - Multiple Stores 

Which type of store are you configuring? 
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Headquarters 
Remote store 
  
Configuring Store Exchange includes specifying or confirming: 

• Whether you are a Headquarters or remote store 

• The number of stores you have and assigning store codes to each (Headquarters only) 

• The Store Exchange method you will use to communicate with other stores 

• The license number for the Server Workstation at the other store(s) in your company 

• The e-mail address, file transfer path, or drive that will be used to send files to other stores 

• Protecting Store Exchange files with a security password (required: Learn more) 
Important: Before beginning, be sure you have the license numbers from the Server Workstation at the other 
store(s). Until you have entered the license number from the other store(s) in your Store Exchange preferences, 
you will not be able to receive and process files from the store(s). 
License numbers can be found on the Point of Sale CD holder, in the e-mail you received if downloading the 
program, or by selecting About Point of Sale from the Help menu at the Server Workstation in each store after 
installing. 
  

Upgrader Note:  Each store may have a new license number when upgrading from a previous version. Store Exchange will fail 
with a "License numbers do not match" error until your Store Exchange preferences have been updated with the new license 
numbers. 

Allowed Activities by Store Type 
How do I? | Multi-Store Overview | Store Exchange Overview 

Manage a multi-store inventory 
View item quantities at other stores 
Transfer merchandise between stores 
Purchase and receive for multiple stores 
Track customers with multiple stores 
Run multi-store reports 
Track profit/loss by store 
Exchange information among stores 
Troubleshoot Store Exchanges 
Use the QuickBooks POS Merchant or Gift Card Services at multiple stores 

  

Pro - Multiple Stores 
HQ = Headquarters. See footnotes for numbered marks at end of table. 

Area/Function HQ Remote 

Managing Inventory     

View item quantity and info X X 

Add/edit/delete/merge Items and styles X   

Create special order items X X 

Convert special order items to regular X   
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Enter/edit costs, prices, tax codes X   

Define assembly items X   

Build/break/sell assemblies X X 

Define group items X   

Sell group items X X 

Inventory reminders: new items, price 
changes 

X X 

Inventory reminders: reorder items, 
duplicate items 

X   

View item history (all stores) X   

View department information X X 

Add/edit/delete departments X   

View vendor information X X 

Add/edit/delete vendors X   

Define multi-vendors for items X   

Merge vendors X   

Physical Inventory for local store X X 

Physical Inventory for other stores X   

Print tags X X 

Print tags for other stores X   

Use Price Manager X   

Create quantity adjustments X X 

Create cost adjustments X   

Put adjustment memo on hold X X 

View/copy/reverse memos X X6 

Create transfer slips X X 

Create transfer slips for other stores X   

Put slips on hold X X 

View/copy/reverse slips X X6 

Return to top     

Area/Function HQ Remote 
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Purchasing and Receiving     

Add/edit/delete/merge vendors X   

Create POs (for all stores) X   

Create special order PO X X 

View POs for local store X X 

View POs for other stores X   

E-mail POs to vendors X X7 

Delete filled POs X X7 

Create voucher for local store X X 

Create voucher to receive PO items X X 

Create voucher for other stores X   

Put vouchers on hold X X 

View/copy/reverse vouchers X X6 

Return to top     

Sales and Customer Orders     

Create receipts for local store X X 

Create receipts for other stores X   

Accept all payment methods X X 

Authorize/settle credit card payments X X 

Authorize/settle debit/ATM payments X X 

Sell/redeem gift cards X X 

Put receipts on hold X X 

View/copy/reverse receipts X X6 

Print gift receipts X X 

Print store logo on sales documents X X 

Create customer orders X X 

Create special order items from orders X X 

Define initial deposit requirements X   

Sell customer order items for local store X X 

Delete filled customer orders X X 
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Track employee sales commission X X 

Define sales tax locations/codes X   

Select local default tax location X X 

Select local default price level X X 

Return to top     

Area/Function HQ Remote 

Customers     

Add/edit/delete customers X X 

Merge customers X   

View customer history (local sales) X X 

View customer history (all stores) X   

Offer customer charge accounts X X 

Define/change reward program X   

Enter/track shipping information X X 

Company Preferences (Define)     

General X X 

Select features to use X X 

Financial X   

Merchant & Gift Services X X 

Multi-Store: Change Store Type X X 

Multi-Store: Store Codes/Classes X   

Multi-Store: Store Exchange X X1 

Multi-Store: Store Headings X X1 

Inventory X   

Pricing X X2 

Purchasing X   

Receiving X   

Sales X X3 

Customers X   

Customer Orders X X4 
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Sales Tax X X5 

E-mail Documents X X 

Return to top     

Area/Function HQ Remote 

Workstation Preferences (Define)     

All Local W/S Settings (Hardware, Printing) X X 

Software Updates X X 

      

Miscellaneous     

Serial number tracking X X 

Add employees and assign Security Groups 
and Rights (for Local Store) 

X X 

Use Employee Time Clock X X 

Customize list columns X X 

Run store reports X X 

Run company reports X   

View/print/export Z-Out Drawer Count 
reports for all Stores 

X   

Get program updates X X 

Cash drawer payouts X X 

Clean up company data X X8 

  
Footnotes for remote stores: 1. Local settings must match those at HQ.  2. Limited to selection of local default 
price level.  3. Limited to certain local default sales preferences.  4. Limited to layaway/sales order printed 
messages.  5. Limited to selection of default tax location.  6. Remote stores can reverse documents only until they 
have been sent to Headquarters, after which the document can only be reversed at Headquarters.  7. Remote 
stores can delete or e-mail special order POs created at the local store only.  8. Cannot remove HQ-only records. 
Return to top 

Configure and Run Store Exchange 

Configure Store Exchange at Headquarters 
How do I?  | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 
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Pro - Multiple Stores 
The exchange of information between your stores is referred to as Store Exchange. These instructions are for 
configuring Store Exchange from the Store Exchange Center, accessed from the Stores menu. 

1. If you haven't already, install Point of Sale on the Server Workstation, following the instructions for 
a Headquarters store in the User Guide. 

Upon starting Point of Sale the first time, you are prompted to create your company data file. Be sure to specify 
Headquarters as your store type and give your data file a unique name. 

2. Complete the Setup Interview at the Server Workstation (launched automatically or select from 
File menu ) to set up basic Point of Sale options. 
3. When done with the Setup Interview, select Store Exchange Center from the Stores menu. 

The Store Exchange Center lists all possible stores on the right side of the window. 
2. Click Set Up Store for Store # 2. 
3. Enter a 1-3 character Store Code, Store Name, and communication method and select Next. 
4. Enter the License Number from the Server Workstation at the remote store and the e-mail 
address or location to which Store Exchange files are to be sent: 

Desktop e-mail: Enter the e-mail address for the remote store. 
Web-based e-mail: Specify a folder to which the Store Exchange mailbag is copied. When creating your e-
mail, browse to this folder to attach the file. 
Removable Media: Enter or browse to the applicable drive or port. 
Network file transfer: Enter or browse to the in folder of the Point of Sale installation on the Server 
Workstation at the remote store. You must have drives mapped or a UNC path to this folder. Note: If the 
remote hasn’t installed yet, type in the path to the in folder that will be used. You may get an "invalid location" 
message, but can ignore it. Once the remote has installed and specified the same folder as it’s "in" folder, 
Store Exchange will function. 
Intuit Service: After selecting this option, call the phone number displayed to activate the service. An 
additional fee may apply. Once activated, Point of Sale will automatically connect to the QuickBase site and 
log in to send/receive files. 

6. Select Finish. 
7. Repeat for other remote stores. 
8. Click Set Password on the left side of the Store Exchange Center.  Enter a password to secure 
store exchange files. This same password must be entered at each remote store in order for them to 
receive files from you. Note that passwords are case-sensitive.  Tips for passwords  
9. Click Preferences to configure other Store Exchange options. 

Example: the Track Multiple Stores in QuickBooks Using Classes checkbox if you want to run Profit/Loss 
reports by store in your QuickBooks Financial software. This option is only available on this page in you have 
already established a connection with QuickBooks, but can be configured later, if desired. Learn more. 

6. Click Close to leave the Store Exchange Center. 
  

Next Actions to Take at Headquarters 
1. Complete your setup of Point of Sale, including installing Client Workstations, setting advanced 
options, and entering or importing inventory and other data. 

Add items, vendors, customers, etc. 
2. After remote stores have installed, run Store Exchange > Send Files to send an initialization file to 
each remote store. (Remote stores should have installed and configured before sending this file.) 

Back to top 
  
Related Topics 
Configure Store Exchange at remote stores 
Schedule Store Exchanges 
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Configure Store Exchange at Remote Stores 
How do I?  | Multi-Store Overview | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 

  

Pro - Multiple Stores 
These instructions are for initial installation/configuration of a new POS company data file at a remote store from 
the Store Exchange Center.  These same options are available in company preferences. 
  

Important Note: If you have been previously using Point of Sale at multiple stores independently of each other, and now want to 
convert a store (or stores) to a remote in a multi-Store configuration, there are limitations in the data at the remote that can be 
retained in the new configuration. Contact Intuit Technical Support for help with this conversion. 

  

Information Needed 
Collect the following information from Headquarters before beginning: 1) the License Number from the Server 
Workstation at Headquarters, 2) the e-mail address, removable media information, or in-folder path (mapped drive 
or UNC) to the Server Workstation at Headquarters, and 3) the Store Exchange password entered at 
Headquarters. 

To configure a remote store: 
1. Install Point of Sale on the Server Workstation, following the instructions for a remote store in the 
User Guide. 
2. Create a new POS company data file with a unique name when prompted, specifying Remote 
Store as the Store Type. You can also specify a store number, but if Headquarters assigns you a different 
number, your selection will be overwritten when you receive your first Store Exchange file from 
Headquarters. 
3. Run the Setup Interview when it is launched to configure basic Point of Sale settings. 
4. When done with the Setup Interview, select Store Exchange Center from the Stores menu and 
configure to exchange with Headquarters by entering: 

• The License Number for the Server Workstation at Headquarters (from the CD jacket or the Help 
 About Point of Sale screen at Headquarters) 

• A communication method and the e-mail address or location to send files, as applicable, for 
Headquarters 
Desktop e-mail: Enter the e-mail address for Headquarters. 
Web-based e-mail: Specify a folder to which the Store Exchange mailbag is copied. When creating your 
e-mail, browse to this folder to attach the file. 
Removable Media: Enter or browse to the drive or port to be used. 
Network file transfer: Enter or browse to the in folder of the Point of Sale installation on the Server 
Workstation at Headquarters. You must have drives mapped or a UNC path to this folder. 
Intuit Service: After selecting this option, call the phone number displayed to activate the service. An 
additional fee may apply. Once activated, Point of Sale will automatically connect to the QuickBase site 
and log in to send/receive files. 

• The same store exchange password entered at Headquarters (required). Learn more. 
5. Click Close to leave the Store Exchange Center. 
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Next Actions to Take at Remote Stores 
1. Complete your Point of Sale setup, including installing Client Workstations, defining local 
employees and security, adding customers, etc. 
2. Receive and process in a Store Exchange mailbag from Headquarters. This file will initialize your 
system with inventory items, departments, vendors, company preferences, and related settings. 
3. After initialization, you may want to review your Point of Sale company preferences for the 
following store-specific settings: 

• Default tax location 

• Default price for sales 
You are now ready to begin using Point of Sale! 

Upgrader Note: If you converted data from a previous version, you can create documents and carry on other POS activities while 
waiting for the initialization file from Headquarters, but you cannot send a Store Exchange file until you have received one from 
Headquarters. 

  
Back to top   

Store Exchange Passwords 
How do I?  | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Configure Store Exchange 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 

  

Pro - Multiple Stores 
Store Exchange files must be secured by a password. Password encryption helps protect your data from being 
read if intercepted by unintended recipients. 
Important: The same password must be entered at each store. If the password encrypting a Store Exchange file 
you receive does not match the password you have entered, you will not be able to process the file. 

To define your Store Exchange password: 
1. From the Stores menu, select Configure Store Exchange. 
2. Select Store Exchange from the menu on the left of the company preferences window. 
3. Select the Options tab on the displayed page. 
4. Select Change Password. 
5. Enter your password. 

Rules and tips for passwords  
6. Select Save. 

  

Notes: 
• You can also set your password from the Store Exchange Center. From the Stores menu, select Store 
Exchange Center and then select Set Password. 

• If you use Point of Sale for more than one company file, be sure you enter a different password for each 
company file. Otherwise, the receiving store could process a file into the wrong company file. 

Related Topics 
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Store Exchange Methods 
Send Files - Headquarters 
Send Files - Remote 
Receive Files 

Initialize Remote Stores 
How do I?  | Multi-Store Overview | Store Exchange Overview 

Manage a multi-store inventory 
View item quantities at other stores 
Transfer merchandise between stores 
Purchase and receive for multiple stores 
Track customers with multiple stores 
Run multi-store reports 
Track profit/loss by store 
Exchange information among stores 
Troubleshoot Store Exchanges 
Use the QuickBooks POS Merchant or Gift Card Services at multiple stores 

  

Pro - Multiple Stores 
Once Headquarters has completed the setup of inventory, departments, vendors, and company preferences, and 
remote stores have installed and configured Point of Sale, Headquarters sends a Store Exchange mailbag to the 
remote stores to initialize them with the information entered at Headquarters. Remote stores must receive and 
process this mailbag before they can create documents in Point of Sale. 
To initialize remote stores, Headquarters must send a Store Exchange file to all remote stores. Remote stores 
receive and process the file from Headquarters. Once this initial Store Exchange cycle is completed, all stores have 
access to inventory and are ready to begin normal Point of Sale activities. 
The activities that can be performed at the remote store prior to receiving their initialization file from Headquarters 
are limited to certain store-specific tasks, such as adding customers, adding employees and defining security, and 
defining store preferences. Documents generally cannot be made, as the remote store cannot list items until the 
inventory file is received from Headquarters. 
  

Notes: 
• Not all of the new settings sent from Headquarters take effect until all workstations at a remote store have 
exited and restarted Point of Sale. 

• If you converted data from a previous version of Point of Sale at a remote store, you can carry on normal 
POS activities, including sales, while waiting for an initialization file from Headquarters. However, you cannot 
send a Store Exchange file until you have received and processed one in from Headquarters. 

Store Exchange Methods 
How do I?   | Multi-Store Overview | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Configure Store Exchange 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 

  

Pro - Multiple Stores 
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Information can be exchanged between Headquarters and remote stores by any of five methods. Not every store 
has to use the same method; Headquarters can exchange with each remote store by a different method. 
Each method has advantages and limitations. Click a link for more information about a specific method. 
Desktop e-mail client uses file attachments to e-mails sent by your default Windows e-mail client. 
Web-based e-mail uses file attachments to e-mails sent by an e-mail service you access on the Web.. 
Intuit Service uses a secure Internet database, where your stores can send and retrieve files. Phone activation 
required. Additional fee may apply. 
Network file transfer is a direct transfer of files between stores using your VPN, LAN, or WAN network. 
Removable media uses Floppy disks, USB memory sticks, Zip drives, CDs, etc., that you physically transport 
between stores. 
  
Related Topics 
Configure Store Exchange 

Schedule Store Exchanges 
Recommended sequence at: Headquarters | Remote Stores 

Pro - Multiple Stores 
Scheduling allows you to have Point of Sale automatically run Store Exchanges at the same time each day without 
manual action. This allows you, for example, to run Store Exchanges overnight when network or Internet traffic is 
reduced or access fees lower. And it means you don't have to train employees at each store to manually run Store 
Exchanges. 
Scheduling is available only if using the Network File Transfer or Intuit Service methods of Store Exchange. 
  

Headquarters 
At the scheduled time, Point of Sale checks for, retrieves, and processes in all files received from remote stores. 
 The Headquarters data file is updated with the remote transactions, and then the updated information is sent back 
out to the remote stores. Typically, you would schedule your exchanges to occur after all remote stores have sent 
their files to you. 
  

Remote Stores 
You can schedule separate receive and send times. For example, you might schedule to receive files each day at 6 
AM (before opening for the day) and send at 10:00 PM (after close, but before Headquarters has scheduled its 
Store Exchange). 
  

Scheduling and Running 

To schedule Store Exchanges: 
1. Make sure you are configured to exchange via Network File Transfer or Intuit Service. 
2. From the Store Exchange Center, select Schedule on the left side. 
3. Enter the time of day you wish Store Exchanges to run. 
4. Select OK. 

  

Important Note: Point of Sale must be running on the Server Workstation at the scheduled time and, if logins are required, a user 
with adequate rights must be logged in. We strongly recommend you lock  your computer if it will be unattended at the 
scheduled time and disable automatic logouts preferences if set. 

  
When the scheduled time arrives, Point of Sale will display a confirmation dialog with a 60-second countdown. This 
gives you an opportunity to skip the exchange or delay it if necessary to complete other tasks. 
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Notes: 
• You can also schedule Store Exchanges from the Store Exchange page of company preferences. 

• All open windows must be closed when receiving files. Point of Sale will close all windows if necessary, but 
a better practice is to check and close all open windows yourself before the scheduled time to ensure not 
losing any unsaved information. 

• If a scheduled exchange does not occur, Point of Sale will alert you. 

• While convenient, scheduling doesn't allow for doing a Financial Exchange with QuickBooks between 
receiving and sending files at Headquarters and may not be a good solution if you offer customer charge 
accounts and want updated account balances at each store every day. 

Related Topics 
Store Exchange Overview 
Store Exchange Center 
What if an file is lost or damaged? 

What Information is Exchanged between Stores? 
Store Exchange Overview | Methods of Store Exchange | Exchange Log 

Pro - Multiple Stores 

Sent from Headquarters to Remote Stores 
• Inventory; including item, department, and vendor lists, and all item quantities, costs, and prices 

• Price Manager price change and discount records 

• Active purchase orders; designated by store 

• Customers 

• Shared company preferences; includes store codes and headings, price levels, sales tax instructions, 
customer order deposit requirements, etc. 

• (Optional) If using item pictures, you can send these to remote stores in a separate Store Exchange file 
Not sent to remote stores: transactional documents made at Headquarters, employees and security settings, store-
specific and workstation preferences. 
Store Exchange files (mailbags) sent from Headquarters to remotes are in the format hq00001.qbt where 00001 is 
the sequential mailbag number sent from Headquarters. 
  

Sent from Remote Stores to Headquarters 
• Transactional documents; receipts, vouchers, adjustment memos, and transfer slips 

• Customer orders (for quantities only; documents cannot be viewed, edited or filled at Headquarters) 

• Customer records that have been added, edited, or deleted since last exchange 

• Time Clock records 

• Z-Out Drawer Count Reports 
Not sent to Headquarters: inventory and related files, employee records (except time clock records), security 
settings, store-specific and workstation preferences. 
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Store exchange files (mailbags) sent from remotes to Headquarters are in the format snn00001.qbt where snn = 
Store number, e.g. s02 = Store 2, and 00001 is the sequential mailbag number sent from this remote. 

Recommended Store Exchange Sequence at Headquarters 
Store Exchange Overview | Troubleshoot Store Exchange 

Pro - Multiple Stores 
Headquarters has two distinct End of Day responsibilities: Store Activities and Headquarters Activities, and you 
may find it helpful to keep the activities related to each separate. See notes below. 

Store activities include: 
1. Run a Z-Out Drawer Count report at each workstation. 
2. Run a Z-Out Store Close report on the Server Workstation. 
3. Settle credit card transactions with the QuickBooks POS Merchant Service (if applicable). 

Typically, these activities would be done as part of the normal End of Day procedure at Headquarters. 

Headquarters activities are done on the Server Workstation and include: 
1. Receive files to process the mailbags received from each remote store. All other workstations 
must exit Point of Sale before beginning this task. This process updates inventory and related files with the 
day's activities at the remote stores. 
2. Run Financial Exchange with QuickBooks financial software. 
3. Backup the company data. 
4. Send updated files back to remote stores before the beginning of the next business day. 

  

Notes: 
You may find it easier to keep the two components of End of Day separate at Headquarters. Use the automated 
End of Day process to do the routine store close activities for the store. This can be accomplished while you wait 
for the remote stores to get their Store Exchange mailbags sent. Later, process in the remote store mailbags, 
conduct your Financial Exchange with QuickBooks, and then send updated files back to the remote stores. 
There are good reasons to keep the two types of activities separate at Headquarters: 

• It keeps the two processes distinct, making it easier for Associates to understand and follow the correct 
procedure for each. 

• It gives Headquarters one process to carry out while giving remote stores the time to get their stores 
closed and mailbags sent. 

• Receiving remote store mailbags cannot be incorporated into the End of Day procedure due to the many 
variables related to the four supported methods and delivery of the files from remotes. 

• If your goal is to maintain the most accurate information possible at all stores, it is important that 
Headquarters receive and process in a mailbag from each remote store before they in turn update inventory 
and send information back. 

Return to top 
  

Variations on the Recommended Sequence 
Depending on operational requirements and management's need for timely information, the Store Exchange 
process can be run more or less frequently. Some variations include: 

• Remote stores could be required to send mailbags several times a day, instead of once. Headquarters 
could process in and send data back so all store have up-to-the-hour information. With information flowing 
throughout the day, it would less critical that Headquarters have the final day mailbag from each remote 
before they process out to end the day. Transactions not making it at the end of one day would be caught on 
the first exchange the next morning. 

• If your need for updated information is not critical, you could run Store Exchange less frequently; say once 
every few days or once a week. 
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• You can schedule Store Exchanges to happen automatically at a certain time, like overnight. While 
convenient, scheduling doesn't allow for doing a Financial Exchange with QuickBooks between receiving and 
sending files and may not be a good solution if you offer customer charge accounts and want updated 
account balances at each store everyday. 

With experience, you will find the sequencing that works best for your circumstances. It is not required that the 
sequence described here be followed, but by adhering to it you ensure that all stores have the most current 
information for each business day. 
Return to top 
  
Related Topics 
Headquarters Store Exchange sending guidelines 
Configure Store Exchange 

Recommended Store Exchange Sequence at Remotes 
How do I?  | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Configure Store Exchange 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 

  

Pro - Multiple Stores 
At the end of each sales day, each workstation in the store should run a Z-Out Drawer Count report to "close" the 
workstation for the day. Then, the following activities should be performed on the Server Workstation, typically as 
part of the automated End of Day procedure. 

1. Run a Z-Out Store Close report. 
2. Settle credit card transactions with the QuickBooks POS Merchant Service (if applicable). 
3. Perform a backup of your Point of Sale data. 
4. Send the day's transactions to Headquarters. 
5. Prior to opening for business the next business day, receive and process an updated file 
(mailbag) back from Headquarters. 

The mailbag from Headquarters must be processed by the Server Workstation. No other workstation can be 
working in Point of Sale during this procedure, as the process will close all open windows on all workstations if 
necessary to update your files. 
  
Related Topics 
Remote store sending guidelines 
Schedule Store Exchanges 

Store Exchange: Sending Files from Headquarters 
How do I?  | Schedule Store Exchanges 

Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Configure Store Exchange 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 
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Pro - Multiple Stores 
These instructions assume you have already configured Store Exchange with your other stores and specified a 
communication method. 

Which Store Exchange method do you want instructions for? 
Send via desktop e-mail client  

1. If you want the e-mail sent immediately, connect to the Internet before proceeding. 
2. From the Store Exchange Center or the Stores menu, select Send Files or include Store 
Exchange in your End of Day procedure. 
3. In the Store Exchange dialog, select the remote stores to receive the mailbag and make any 
necessary changes in e-mail addresses, and then select Send. (Changes made here affect only this 
occurrence of Store Exchange.) 
4. Your e-mail client is automatically launched and a single e-mail is created, with the mailbag 
file attached and addressed to all stores specified. A default message instructs the remote stores how 
to process the attachment. 

• If you are online when you select Send, the e-mail is automatically sent. 

• If you are not online when you select Send, the e-mail is placed in your e-mail client's outbox, 
ready for you to manually send later. When ready to send, connect to your Internet service provider, 
access your e-mail client, and initiate a Send of the e-mail in your outbox. 

Notes on using desktop e-mail 

  
Send via Web-based e-mail  

1. From the Store Exchange Center or Stores menu, select Send Files or include Store 
Exchange in your End of Day procedure. 
2. In the Store Exchange dialog, select the remote stores to receive the mailbag and make any 
necessary changes in destination folders, and then select Send. (Changes made here affect only this 
occurrence of Store Exchange.) 
3. The mailbag is created and placed in the destination folder specified. A Windows Explorer 
window is opened, showing you this location. 
4. Access your e-mail service on the Internet and follow their instructions to create the e-mail, 
enter the remote e-mail addresses, add a message/instructions to the remote store, browse to and 
attach the mailbag file, and then send the e-mail. 

Notes on using Web-based e-mail 

  
Send via Intuit Service  

1. Establish your Internet connection if necessary. 
2. From the Store Exchange Center or the Stores menu, select Send Files or include Store 
Exchange in your End of Day procedure. 
3. In the Store Exchange dialog, select the remote stores to receive the mailbag and then select 
Send. (Changes made here affect only this occurrence of Store Exchange.) 

Point of Sale creates the mailbag file, connects to the Intuit Service, and leaves the file for remote stores to 
retrieve. 

  
Send via network file transfer  

1. From the Store Exchange Center or the Stores menu, select Send Files or include Store 
Exchange in your End of Day procedure. 
2. In the Store Exchange dialog, select the remote stores to receive the mailbag and make any 
necessary changes in destination folders, and then select Send. (Changes made here affect only this 
occurrence of Store Exchange.) 
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3. The mailbag file is created and then copied to the destination folder specified for the other 
store(s) (e.g., their in folder). 

Notes on using network file transfer 

  
Send via removable media  

1. From the Store Exchange Center or Stores menu, select Send Files or include Store 
Exchange in your End of Day procedure. 
2. In the Store Exchange dialog, select the remote stores to receive the mailbag and make any 
necessary changes in media drives/ports, and then select Send. (Changes made here affect only this 
occurrence of Store Exchange.) 
3. You will be prompted to enter the media (floppy disk, USB device, etc) in the appropriate drive 
or port. Enter the media and select OK. The mailbag file will be copied to the media. 
4. If sending to multiple remote stores, repeat to copy the mailbag to separate media for each 
store. 
5. Transport the media to the other store(s) 

Notes on using removable media 

  
  
Store Exchange guidelines at Headquarters: 

• It is suggested you read and follow the recommended Store Exchange sequence. 

• Only the Server Workstation can run Store Exchange 

• Before you send files, it is a good practice to check for and process in any mailbags that you may have 
received and not yet processed from remote stores 

• There are three ways by which sending a mailbag can be initiated: 

• From the Stores menu or the Store Exchange Center, select  Send Files to prepare and send a 
mailbag to remote stores. 

• Include the Store Exchange option in your End of Day procedure. 

• Schedule your Store Exchanges to happen automatically (available only for Intuit Service and 
Network File Transfer methods) 

• You can revise the Store Exchange settings for particular remote stores and select which are to receive the 
current exchange mailbag in the Store Exchange dialog displayed. Each of your remote stores is listed in this 
dialog. Select the Edit button to the right of a store line to make changes in how the file is sent to a particular 
store. Any changes you make here apply only to the current exchange. 

• Select View Log after an exchange is completed to review or troubleshoot any problems that occur. 

• All exchange mailbag files created at Headquarters are in the format hqxxxxx.qbt, where: 
hq = Headquarters 
xxxxx = sequential number of mailbag, incrementing 00001, 00002, 00003, etc. with each sent mailbag 
.QBT = the file extension used for all Store Exchange mailbags 

  
Related Topics 
Send item pictures to remote stores 
Receive a Store Exchange mailbag 
What information is exchanged? 

Store Exchange: Sending Files from Remote Stores 
How do I?  | Store Exchange Overview | Schedule Store Exchanges 

Send files from Headquarters 
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Receive and process files 
Initialize remote stores with inventory 
Configure Store Exchange 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 

  

Pro - Multiple Stores 
What method of Store Exchange would you like help with? 
These instructions assume you have already configured Store Exchange with your other stores and specified a 
communication method. 
Send via desktop e-mail client  

1. From the Stores menu or Store Exchange Center, select Send Files or include Store 
Exchange in your End of Day procedure. 
2. In the Store Exchange dialog, make any necessary changes in the Headquarters' e-mail 
address, and then select Send. (Changes made here affect only this occurrence of Store Exchange.) 
3. Your e-mail client is automatically launched and the e-mail is created, with the mailbag file 
attached and addressed to Headquarters. A default message instructs Headquarters how to process 
the attachment. 

• If you are online when you select Send, the e-mail is automatically sent. 

• If you are not online when you select Send, the e-mail is placed in your e-mail client's outbox, 
ready for you to manually send later. When ready to send, connect to your Internet service provider, 
access your e-mail client, and initiate a Send of the e-mail in your outbox. 

Notes on using desktop e-mail 

  
Send via Web-based e-mail  

1. From the Stores menu or Store Exchange Center, select Send Files or include Store 
Exchange in your End of Day procedure. 
2. In the Store Exchange dialog, make any necessary changes in the destination folder for the e-
mail attachment, and then select Send. (Changes made here affect only this occurrence of Store 
Exchange.) 
3. The mailbag is created and placed in the destination folder specified. A Windows Explorer 
window is opened, showing you this location. 
4. Access your e-mail service on the Internet and follow their instructions to create the e-mail, 
enter the e-mail addresses, add a message/instructions to Headquarters, browse to and attach the 
mailbag file, and then send the e-mail.  

Notes on using Web-based e-mail 

  
Send via Intuit Service  

1. Establish your Internet connection, if necessary. 
2. From the Store Exchange Center or the Stores menu, select Send Files or include Store 
Exchange in your End of Day procedure. 
3. In the Store Exchange dialog, select Send. 

Point of Sale creates the mailbag file, connects to the Intuit Service, and leaves the file for Headquarters to 
retrieve. 

  
Send via network file transfer  

1. From the Stores menu or Store Exchange Center, select Send Files or include Store 
Exchange in your End of Day procedure. 
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2. In the Store Exchange dialog, make any necessary changes in the destination folder for 
Headquarters, and then select Send. (Changes made here affect only this occurrence of Store 
Exchange.) 
3. The mailbag file is created and then copied to the destination folder specified (e.g. the 
Headquarters in folder). 

Notes on using network file transfer 

  
Send via removable media  

1. From the Stores menu or the Store Exchange Center, select Send Files or include Store 
Exchange in your End of Day procedure. 
2. In the Store Exchange dialog, make any necessary changes in media drives/ports, and then 
select Send. (Changes made here affect only this occurrence of Store Exchange.) 
3. You will be prompted to enter the media (floppy disk, memory stick, etc) in the appropriate 
drive or USB port. Enter the media and select OK. The mailbag file will be copied to the media. 
4. Transport the media to Headquarters. 

Notes on using removable media 

  
  

Store Exchange guidelines at Remote Stores 
• It is suggested you read and follow the recommended Store Exchange sequence. 

• Only the Server Workstation can run Store Exchange. 

• All exchange mailbag files created at remote stores are in the format snnxxxxx.qbt, where: 
snn =Store Number, e.g. s02 = Store 2 
xxxxx = the sequence number for mailbags created at this store. Incremented 00001, 00002, etc. 
.QBT = the file extension used for all Store Exchange mailbags 

• Before you send, it is a good practice to check for and process in any mailbags that you may have 
received from Headquarters and not yet processed. 

• There are three ways by which sending a mailbag can be initiated: 

• To manually send a file, select Send Files from the Stores menu or the Store Exchange Center 

• Include the Store Exchange option in your End of Day procedure 

• Schedule your Store Exchanges to happen automatically (available only for Intuit Service and 
Network File Transfer methods) 

• You can revise the Store Exchange settings for Headquarters in the Store Exchange dialog displayed. Any 
changes you make here apply only to the current exchange. 

• Select View Log after completing a Store Exchange to view results and troubleshoot any problems that 
occur. 

Related Topics 
Receive a Store Exchange mailbag 
What information is exchanged? 

Store Exchange: Receiving and Processing Files 
How do I?  | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Configure Store Exchange 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 
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Pro - Multiple Stores 

By which method are you receiving files? 
Receive via desktop e-mail 
Receive via Web-based e-mail 
Receive via removable media 
Receive via network file transfer 
Receive via Intuit Service 
  

Notes: 
• All open windows must be closed before receiving Store Exchange files. If open windows are detected, you 

will be notified and given a chance to save any pending transactions before continuing. 

• Only the Server Workstation can run Store Exchange. At a remote store, close all open windows before 
processing a file received from Headquarters. 

• There are three general ways in which a mailbag can be received and processed in: 

• Open or double-click a received file or an e-mail attachment with the .qbt extension 

• From the Stores menu or the Store Exchange Center, select Receive Files; this option checks for 
and processes any exchange files found in your default Store Exchange in folder (or from a folder to which 
you have browsed) 

• Schedule your Store Exchanges to happen automatically (available only for Intuit Service and 
Network File Transfer methods) 

• The process of receiving and processing in mailbags will depend on the Store Exchange method used. If 
Store Exchange mailbags are waiting in your "in folder' when Point of Sale is started, you are prompted to 
process them. 

Read Store Exchange sequencing recommendations for: Headquarters  or  Remote Stores 
  
Related Topics 
Store Exchange log 
Store Exchange send - Headquarters 
Store Exchange send – Remote stores 

Store Exchange Activity Log 
How do I?  | Multi-Store Overview | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Configure Store Exchange 
Schedule Store Exchanges 

  

Pro - Multiple Stores 
All activities that occur during Store Exchange are recorded in the Store Exchange log file. A separate log is 
maintained at each store. If an error is encountered, the first step should be to check the log entries for messages, 
error codes, and the mailbag file name that might help identify the problem. 

To access the Store Exchange log: 
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1. Select View Log from the Store Exchange dialog or select View Activity Log from the Stores 
menu. 
2. Select a date/time from the Available Logs: drop-down list. 
3. (Optional) Select the Show Errors Only checkbox to remove routine entries and make 
identification of errors easier. 
4. Use the error code table to review errors and possible solutions. 

To assist in troubleshooting, the log contents can be printed by selecting the Print button. 
With each new exchange, entries older than 30 days are purged from the log. 
See also automatic recovery from lost or damaged data. 
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End of Day 

End of Day Overview 
How do I?   
  
The retail day is over; the doors are locked. It is time to tally up the sales, count the money, exchange information 
with your financial software, and back up your data before you head home. 
When you initiate the End of Day procedure, these tasks are carried out as you specify, prompting you for input as 
needed. 

Note:  In a multi-workstation configuration, the End of Day procedure must be run from the Server Workstation if you wish to 
include a data backup or Financial Exchange. 
Pro Note:  In a multi-workstation configuration, the End of Day procedure must also be run from the Server Workstation if you 
wish to include Store Exchange. 

To run the End of Day procedure: 
1. Select End Of Day Procedure from the Point of Sale menu. 

The End of Day window is displayed. 
2. Select the individual procedures you wish to run by selecting or clearing the checkboxes for each 
and specifying options: 

• Run an End of Day report (drawer count, store close, or status). Select the specific X/Z-Out 
report type, specify a date (default: today), and optionally select the checkbox to print the report 
immediately without previewing. Learn more 

• Back up your company data. Specify the default location or an alternate location. Learn more 

• Send data to other stores. Learn more 

• Settle Merchant Account (send credit and debit card transactions to processor). Learn more 

• Exchange data with QuickBooks financial software. Learn more 
3. Select Start. 
4. Enter additional information as prompted. 

  

Notes: 
• If you have scheduled data backups, you may not want to include another backup in your End of Day 
procedure. 

Cash Drawer Reports (X/Z-Out) 
How do I?  | X/Z-Out Terminology | Reports Overview 
  
The term X/Z-Out is borrowed from cash register systems. These reports can provide up-to-the-minute accounting 
of POS activities for the current sales period, help you reconcile your cash drawer(s), and help you close out the 
day. 
Point of Sale provides four cash drawer reports: 

• The X-Out Status report can be run at any time for a quick check on sales activity or to obtain a 
non-currency media listing up to the time the report is run. The X-Out Status report can be used to report 
sales activity at the end of a shift without doing media counts. 

• The Z-Out Drawer Count reports is often run at the end of a cashier’s shift and/or at the end of 
the day when you want to reconcile the cash drawer. A manual media count can be required on this 
report to improve cash drawer accountability. In a multiple workstation installation, this report is typically 
done at each workstation prior to running the Z-Out Store Close report for the entire store in the End of 
Day procedure. (Pro:  Z-Out Drawer Count Reports ran at remote stores are sent to Headquarters during 
Store Exchanges). 
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• The Z-Out Store Close report is typically run when closing the store for the day and filtered to 
include all workstations in the store. The Store Close report does not include the option to manually count 
out the cash drawer. 

• The Payout Report includes is a summary report of cash paid out of your cash drawer using the 
payout feature. 

All X/Z-Out reports include: 

• All sales activity for the specified period 

• Net sales, cash flow, and discount breakouts 

In addition, a Z-Out report can: 

• Report daily cash flow, including overages and shortages 

• Assist in the recording of media counts and cash drawer reconciliation (Z-Out Drawer Count 
report) 

• Simplify bank deposit preparation by calculating a deposit amount and printing the list of deposit 
items 

Notes: 
• Any of the X/Z-Out reports can be made part of the End of Day procedure. This allows you to use 
the report or reports that best fit your needs and accountability requirements. 

• On X/Z-Out reports, the term "paid out" typically refers to monies given to the customer for any 
reason, such as giving change or refunds on a sale. However, in the list of non-currency media contained 
at the end of X/Z-Out reports, there is a list of payouts, meaning cash removed from the cash drawer 
using the payout feature. It is important to be aware of this distinction. 

• To set printing options for X/Z-Out reports (printer, print template, number of copies, etc.), select 
Preferences  Workstation from the File menu and then select Documents & Printers. 

Related Topics 
How various POS actions are reported 
What is a Z-Out report? 
Z-Out report recommendations 

Settle Merchant Service Transactions 
Merchant Service Overview | FAQs | End of Day Overview 
  
If you have an Intuit Payments Account with the QuickBooks POS Merchant Service, you can include batch 
settlement of your authorized credit and debit card transactions in the End of Day procedure. 
The settlement process is automated. All you need to do is select the Settle Merchant Account option on the End 
of Day window. 
Point of Sale transmits the transactions to the merchant service for settlement. Once the data is transmitted, the 
QuickBooks POS Merchant Service routes the transaction to the bank that issued the card, secures the funds, and 
then transfers the money to your bank account. 
  

Notes: 
• Important: Credit card transaction data must be sent to the processor for settlement within one day of 
authorizing the transaction to avoid paying higher fees. You must settle before reaching 500 transactions or a 
total dollar amount of $999,999.99. Point of Sale will block additional credit or debit card transactions until 
settlement is completed. 

• Typically, a merchant account is settled once per day, during the End of Day procedure. To settle more 
often, run the End of Day procedure, selecting only the Settle Merchant Account option. 

• Only transactions not already sent are included in each batch settlement. 
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• If you are integrated QuickBooks Financial Software 2009, merchant service transactions are sent to 
QuickBooks grouped by settlement batches to assist in reconciliation with your bank deposits. Learn more 

• To check on the status of settlement, visit and set up a free Intuit Payments Account at the Merchant 
Service Center 

Related Topics 
Merchant Service Reports 
Take payment by credit card 
Take payment by debit card 
Troubleshoot 

End of Day Financial Exchange with QuickBooks 
Financial Exchange Overview | FAQs | End of Day Overview 
  
In a multi-workstation configuration, the End of Day procedure must be run on the Server Workstation to include 
Financial Exchange. 
(Pro) The Financial Exchange option is available only at Headquarters. 

To include a Financial Exchange as part of the End of Day procedure: 
1. Make sure QuickBooks is running and your company file is open. 

Tip: To avoid this step set up your integrated applications preferences in QuickBooks to allow Point of Sale to 
automatically login. 

2. In the End of Day window, ensure that the Exchange Data with QuickBooks option is selected 
in the Financial Exchange with QuickBooks section. 
3. Choose other End of Day options. 

4. Select OK. 

Learn more about... 
What information is exchanged? 
What do I if an error occurs during an exchange? 
How is my Point of Sale data posted to QuickBooks?. 
How do I handle bank deposits after running Financial Exchange? 
Can I run Financial Exchange outside of the End of Day procedure? 

Handling Bank Deposits after Running Financial Exchange 
Financial Exchange Overview | FAQs 
  
By default, cash from Point of Sale is placed in the Cash In Drawer account in QuickBooks, while checks and 
credit/debit transaction are placed in the Undeposited Funds account. 
Learn more about using the default or custom account mappings 
To perform a deposit after you have completed the Financial Exchange process with QuickBooks (using the default 
mappings), you will need to transfer the funds you wish to deposit from the Cash in Drawer account in QuickBooks 
to the Undeposited Funds account. 

To make a bank deposit in QuickBooks: 
1. In your QuickBooks financial software, from the Banking menu, select Transfer Funds. 
2. Select the accounts to transfer from and to. 
Normally this would be a transfer from the Cash In Drawer account to the Undeposited Funds account. If 
you have set up custom account mappings between Point of Sale and QuickBooks financial software, you will 
need to specify the custom accounts that you use. 
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This window displays the current balances in each account. 

3. Enter the Transfer Amount (usually the entire balance in the Cash in Drawer account) and save the 
transfer. 

4. Select Make Deposits from the Banking menu. 
5. On the Payments to Deposit window, select the items in the list you wish to deposit. If depositing the entire 

balance from the Undeposited Funds account, click Select All at the bottom of the window. 
6. Select OK. 
7. On the Make Deposits window, select the bank account to which the funds are being deposited and save. 

  
Alternate Method  

1. In QuickBooks financial software, go to the Banking menu and select Make Deposits. 
2. Select the items to deposit and then select OK. The cash that was transferred from Point of 
Sale does not appear on this list. 
3. Add a new line to the deposit list, selecting Cash in Drawer as the From Account and 
entering the amount of cash to be deposited. 
4. Select Save & Close. 

  
  
Related Topics 
Z-Out Store Close reports 

Back up Data at End of Day 
End of Day Overview | Restore from a Backup 
  
The End of Day procedure includes an option to back up your data. 
  

Note: To include a data backup, the End of Day procedure must be run from the Server Workstation. 

To back up data as part of End of Day procedure: 
1. From the Point of Sale menu, select End of Day Procedure. 
2. Select the checkbox to Back up your company data and specify to the default location or to an 
alternate location. 

• If backing up to removable media, place blank formatted media in the appropriate drive. 

• If using an alternate location, enter the path or browse to the alternate location and enter a file 
name. 

• (Pro) Select the checkbox if you want to include inventory item pictures in the backup. Doing so 
may substantially increase backup time or file size. 
3. Specify other End of Day options, as needed. 
4. click OK. 
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Notes: 
• If you have scheduled your backups, the next scheduled time is displayed On the End of Day window for 
reference. 

• Point of Sale only backs up your Point of Sale data. Therefore, it should serve as only one component of a 
comprehensive data protection strategy. You must take separate action to back up other important 
information for your business (QuickBooks financial software records, payroll records, other applications, 
etc.). 

Related Topics 
Backup/restore overview 

Recommended Store Exchange Sequence at Headquarters 
Store Exchange Overview | Troubleshoot Store Exchange 

Pro - Multiple Stores 
Headquarters has two distinct End of Day responsibilities: Store Activities and Headquarters Activities, and you 
may find it helpful to keep the activities related to each separate. See notes below. 

Store activities include: 
1. Run a Z-Out Drawer Count report at each workstation. 
2. Run a Z-Out Store Close report on the Server Workstation. 
3. Settle credit card transactions with the QuickBooks POS Merchant Service (if applicable). 

Typically, these activities would be done as part of the normal End of Day procedure at Headquarters. 

Headquarters activities are done on the Server Workstation and include: 
1. Receive files to process the mailbags received from each remote store. All other workstations 
must exit Point of Sale before beginning this task. This process updates inventory and related files with the 
day's activities at the remote stores. 
2. Run Financial Exchange with QuickBooks financial software. 
3. Backup the company data. 
4. Send updated files back to remote stores before the beginning of the next business day. 

  

Notes: 
You may find it easier to keep the two components of End of Day separate at Headquarters. Use the automated 
End of Day process to do the routine store close activities for the store. This can be accomplished while you wait 
for the remote stores to get their Store Exchange mailbags sent. Later, process in the remote store mailbags, 
conduct your Financial Exchange with QuickBooks, and then send updated files back to the remote stores. 
There are good reasons to keep the two types of activities separate at Headquarters: 

• It keeps the two processes distinct, making it easier for Associates to understand and follow the correct 
procedure for each. 

• It gives Headquarters one process to carry out while giving remote stores the time to get their stores 
closed and mailbags sent. 

• Receiving remote store mailbags cannot be incorporated into the End of Day procedure due to the many 
variables related to the four supported methods and delivery of the files from remotes. 

• If your goal is to maintain the most accurate information possible at all stores, it is important that 
Headquarters receive and process in a mailbag from each remote store before they in turn update inventory 
and send information back. 

Return to top 
  

Variations on the Recommended Sequence 
Depending on operational requirements and management's need for timely information, the Store Exchange 
process can be run more or less frequently. Some variations include: 
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• Remote stores could be required to send mailbags several times a day, instead of once. Headquarters 
could process in and send data back so all store have up-to-the-hour information. With information flowing 
throughout the day, it would less critical that Headquarters have the final day mailbag from each remote 
before they process out to end the day. Transactions not making it at the end of one day would be caught on 
the first exchange the next morning. 

• If your need for updated information is not critical, you could run Store Exchange less frequently; say once 
every few days or once a week. 

• You can schedule Store Exchanges to happen automatically at a certain time, like overnight. While 
convenient, scheduling doesn't allow for doing a Financial Exchange with QuickBooks between receiving and 
sending files and may not be a good solution if you offer customer charge accounts and want updated 
account balances at each store everyday. 

With experience, you will find the sequencing that works best for your circumstances. It is not required that the 
sequence described here be followed, but by adhering to it you ensure that all stores have the most current 
information for each business day. 
Return to top 
  
Related Topics 
Headquarters Store Exchange sending guidelines 
Configure Store Exchange 

Recommended Store Exchange Sequence at Remotes 
How do I?  | Store Exchange Overview 

Send files from Headquarters 
Send files from remote stores 
Receive and process files 
Initialize remote stores with inventory 
Configure Store Exchange 
Schedule Store Exchanges 
Troubleshoot Store Exchanges 

  

Pro - Multiple Stores 
At the end of each sales day, each workstation in the store should run a Z-Out Drawer Count report to "close" the 
workstation for the day. Then, the following activities should be performed on the Server Workstation, typically as 
part of the automated End of Day procedure. 

1. Run a Z-Out Store Close report. 
2. Settle credit card transactions with the QuickBooks POS Merchant Service (if applicable). 
3. Perform a backup of your Point of Sale data. 
4. Send the day's transactions to Headquarters. 
5. Prior to opening for business the next business day, receive and process an updated file 
(mailbag) back from Headquarters. 

The mailbag from Headquarters must be processed by the Server Workstation. No other workstation can be 
working in Point of Sale during this procedure, as the process will close all open windows on all workstations if 
necessary to update your files. 
  
Related Topics 
Remote store sending guidelines 
Schedule Store Exchanges 
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Reports & Sales Charts 

Reports Overview 
How do I?  | Report Categories (All Reports) 

Run a report 
Modify a report 
Drill down to report detail 
Memorize a report 
Manage my reports 
Export a report to Excel 
Use security access levels 

Run cash drawer reports 
Run Merchant Service reports 
Use the report Dashboard 
Refresh report data 
View a chart or graph 
Run multiple reports 

  
  
Point of Sale reports provide detailed information in a wide variety of formats to help you manage inventory, 
analyze your sales, evaluate employee performance, make informed purchase decisions, and much more. 
There are several ways to choose the correct report for your needs or to access previously memorized reports. 

• The Report Center (shown below) allows you to choose and modify specific reports from a variety of 
categories, use the Create a Report wizard, and manage your previously saved reports. Select Report 
Center from the Reports menu. 

• The I Want To menu in most lists provides access to common reports for the current area. 

• The Report Dashboard, available as a tab on the Point of Sale Home page, allows you to create and 
customize a multi-column and multi-page display of mini-reports to see at a glance how your business is 
doing. You can even add various Point of Sale web pages, such as the user forums, directly to the 
Dashboard for immediate access (Internet connection required). 

• The embedded Home Page Navigator provides an instant view of one selected report and access to your 
top memorized reports. 

 
  



Printed Documentation 

412 

Report filters and options allow you to customize reports to include or exclude information (items, departments, 
customers, vendors, date ranges, etc.) and change display options. Once displayed, many reports offer the ability 
to QuickZoom, or drill down, to see additional detail or view related reports and documents. 
If you tend to run several reports together, you can easily run the group of reports at once from the Run Multiple 
Reports window, available from the Reports menu. 
Access to reports can be controlled with security rights, protecting your sensitive data. 
  

Multi-Store Notes 
• Several unique reports are available for multi-store operations, including merchandise transfers, month-to-
date sales and on-hand merchandise information for all stores. In addition, if you use QuickBooks financial 
software, you can run Profit/Loss reports by store by using the class tracking feature. 

• Headquarters can run reports for any store, a selected group of stores, or all stores, while remote stores 
can run reports only for their own store. 

• Z-Out Drawer Count Reports are the only reports sent from remote stores to Headquarters. All other 
company reports ran at Headquarters draw their information from inventory and the transactional document 
history files maintained at Headquarters. 

• Learn more about multi-store reporting 
  
Related Topics 
Security rights for reports 

All Report Categories and Types 
Reports Overview | Memorize Reports | Report Dashboard 
  
On the All Reports page of the Report Center, you can select a report category, type, and then a specific report. A 
brief description of the information contained in the report is displayed to help you choose. 
  

 
• Once you've located the report you need, click Display to run it. 

• If you selected Prompt to modify report options.., the modify report wizard is displayed. Follow 
the on-screen prompts, selecting Help on each page for additional assistance. 
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• See work with a displayed report for options available once the report is displayed. 

Report Categories 
There are many report categories in Point of Sale. Each category includes various specific reports, offering several 
ways to analyze your accumulated data: 
Sales – View summarized or detailed sales information, such as best and worst selling items; sales by department, 
by vendor, by associate, or by store; discounts given; and sales taxes collected. 
Cash Drawer – Run X/Z-Out Reports, including register status, drawer count and closing reports, as well as a 
listing of cash drawer payouts. 
Payments – View summarized or detailed reports of sales payments by type. 
Customers – Print or export customer lists and analyze sales by demographics, customer type, or promotional 
codes. Pro users can also view summarized or detailed reports of merchandise on order, status of service jobs, 
and deposits taken on layaways, sales orders, and work orders. 
Items – Track inventory item, quantities, and costs, including merchandise on hand or on order, reorder points, and 
adjustments, and, in a multi-store configuration, transfers and inventory by store. 
Purchasing – View summarized or detailed listings of merchandise ordered and received, projected cash 
requirements, and vendor lists. 
Employees – View employee lists, sales performance,  and tips collected. Pro users can also view hours worked, 
and commissions earned. 
Memorized Reports – View and access all reports you have created and memorized. This category does not 
display until you have memorized at least one report. 
  
The information for each report is drawn from the related data sources (documents, inventory, customer records, 
etc). For example, most sales information is derived from receipts; purchasing information is drawn from purchase 
orders and receiving vouchers, and so on. 

Run a Report 
How do I?  | Memorize a Report | Report Dashboard 

Modify a report 
Drill down to report detail 
Memorize a report 
Manage my reports 
Export a report to Excel 
Use security access levels 

Run cash drawer reports 
Run Merchant Service reports 
Use the report Dashboard 
Refresh report data 
View a chart or graph 
Run multiple reports 

  
  
These are the basic instructions for running a report from the Report Center. Use the links below or read the Report 
Overview to learn about additional options and access points for reports. In addition to reports listed below, there 
are now Mobile reports to select as well.  

To run a report: 
1. Select Report Center from the Reports menu. 
2. On the Report Center window, select the Overview tab. 
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3. Select one of the following: 

• A report link on the left – These are the most common reports in each category. After selecting 
a report, you will have the opportunity to specify certain options, such as the date range, appearance, and 
data to include (choices which vary by report). 

• A memorized report – When a memorized report is selected, it is immediately ran using the 
saved settings. Steps 4-5 below do not apply. You can further modify the report after it is displayed if 
necessary. 

• Create a Report – Launches the report wizard that will help you build the report you need. 

• All Reports – To view all available report categories and individual reports.  Learn more about 
this option. 
4. Follow the on-screen prompts to modify various report options. Select Help on each options page 
for more information. 
5. Select Run. The report is displayed. 

You can further modify the report and drill down to view additional detail and related records with the report 
displayed. Learn more. 

6. From the top toolbar, choose how you want to output the report: 

• Select Print to send the report to your printer. Note: Printing large reports  

• Select Excel to export the report as a spreadsheet (you must have Microsoft Excel installed for 
this option). 

Or, from the I Want To menu: 

• Select Add this Report to Dashboard. Learn more. 

• Select Memorize this Report and give it a name to add the report to your memorized reports list 

Notes: 
• The printer used for your reports is specified on the Documents & Printers page of workstation 
preferences. 
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• Specific information about running cash drawer reports (X/Z-Out) is available here. 

• (Pro) Headquarters can run reports for any store, a selected group of stores, or all stores, while remote stores 
can run reports only for their own store. When running reports at Headquarters, use the Modify Report > 
Filters option to specify the stores to be included in the report. 

Modify a Report 
How do I?    

Run a report 
Drill down to report detail 
Memorize a report 
Manage my reports 
Export a report to Excel 
Use security access levels 

Run multiple reports 
Run cash drawer reports 
Run Merchant Service reports 
Use the report Dashboard 
Refresh report data 
View a chart or graph 

  
  
Report options are user-definable instructions that affect the report output. The ability to modify report options is 
controlled by the security rights of the logged-in user. Once customized, a report can be memorized with specific 
settings and then run directly from your memorized report list, accessed from various places in the program. 
The options available vary by report and options shown below may not be available on all report types. The Modify 
a Report window can also be used to revert the report to default settings. 

To modify a report: 
1. Open the Modify a Report window by: 
 Using the Create a Report wizard to run a new report, or 
 Selecting the Prompt to modify report before running checkbox on the All Reports page, or 
 Selecting Modify from the report toolbar of a displayed report 
2. Enter a date or date range, if applicable.  Learn more 
3. Select from the additional options available. Select a link below for more information about each 
option category. 

Add or Remove Columns to add/remove, set order, and specify sort options for data in columns 
Filter Data to include/exclude data based on filter criteria 
Change Report Appearance to change report orientation, header and footer information, page numbering, and 
fonts. 
Report Access Level to restrict access to the report based on security groups. 
Revert – Select to reset all report options to their default values. 

4. Select Save on each options page and then Run to display the report with your selected options. 
  
Related Topics 
Work with a displayed report 

Work with a Displayed Report 
How do I?  | Memorize a Report | Refresh Report Data 

Run a report 
Modify a report 
Memorize a report 
Manage my reports 
Export a report to Excel 
Use security access levels 

Run multiple reports 
Run cash drawer reports 
Run Merchant Service reports 
Use the report Dashboard 
Refresh report data 
View a chart or graph 
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Note: Not all options described here are available on every report type or for Point of Sale Free users. For example, several of 
these options are not available when viewing customer, vendor, or item history reports. 

  
You have several options when working with a displayed report. 

• To run the report for different dates, specify a new date range at the top of the report and then select 
Apply Date Range. 

• To change the data included or change other display options, select Modify from the window toolbar. 
Learn more. 

• With the report displayed, you can change the column order/widths, sort the report values, search the 
report by keyword, and, when available, use QuickZoom to view additional detail or view associated 
documents or records. 

• Print, export, memorize, or add the report to the report Dashboard. 

Customizing Report Columns and Sort 
• To rearrange the order of columns in a report, drag-and-drop the column headers to a new position. 

• To change a column’s width, drag the separators (small diamond symbols) left or right or to adjust all 
columns to the width of their largest entry, right-click the header and choose Adjust Column Widths. 

• To sort the report by the values in a column, click the column header. Click the header again to sort in the 
opposite order (ascending or descending). 

Using QuickZoom to View Additional Report Detail 
QuickZoom allows you to view additional detail in sub-reports or in the associated documents and records. 
QuickZoom refers to the "magnifying glass" icon that appears on reports and graphs. 
With the QuickZoom icon displayed, double-click a line or value in the report to bring up the additional detail that is 
available. 
Examples: 

• If you are viewing the Customer Sales report, double-click a customer name to see a sub-report 
listing all items sold to that customer. Double-click an item line on the second report, and a report of all 
sales for the item is displayed. 

• If the report includes a document list (e.g. sales detail report or customer/vendor/item history) 
double-click on a listed document to view it. 

Doing a Text Search on a Report 

To search a report for a text string: 
1. With a report displayed, enter the text string you are looking for in the Find field at the top of the 
report. 

 
2. Select the magnifying glass icon to the right of the Find field. 
3. Continue selecting the find icon to locate additional occurrences of the text. 

  

Export Reports to Excel® 
Reports Overview | Run a Report | Export List Data 
  
You can export report data to Microsoft Excel, allowing you to further manipulate the data in that program. 

Note: For this option to be available, a full licensed version of Excel must be installed on the workstation running the report. 

To export a report: 
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1. Run the report normally, using the modify report option to select the columns and filter the data to 
be included in the export. 
2. With the report displayed, select Excel from the top toolbar. 
 
Once the report is in Excel, you can utilize the many Excel features to manipulate and customize your 
data. Refer to the Excel help system for instructions to: 

• Take advantage of extensive filtering capabilities 

• Combine information from multiple reports 

• Change the order of report columns 

• Add comments 

Memorize a Report 
Reports Overview | Run a Report | Modify a Report 
  
Once a particular report format has been defined, you can memorize it and then immediately run the report at 
anytime with a single click from the Reports menu. Note that you are memorizing the report format (display options, 
filtering, date range, etc.) and not the specific report data. This allows you to memorize and run dynamic reports 
(sales month-to-date, etc.) whenever you want, with the format always the same but the data updated to the current 
time. 
Once memorized, your reports are added to the Report menu and the Report Center under the category 
Memorized Reports. Optionally, you can define new report types, which allow you to sub-categorize your 
memorized reports. 

To memorize a report: 
1. Run the report in the normal manner, modifying it to include the data and display options you 
want. 
2. Select Memorize this report from the I Want To menu. 

The Memorize Report dialog is displayed. 
5. Give your memorized report a unique name and assign it to a report type. 

Select Manage My Reports to add a new report type or to manage your existing types. 
6. Select OK. 

  
Related Topics 
Work with a displayed report 

Manage my Reports 
How do I?   

Run a report 
Modify a report 
Drill down to report detail 
Memorize a report 
Export a report to Excel 
Use security access levels 

Run multiple reports 
Run cash drawer reports 
Run Merchant Service reports 
Use the report Dashboard 
Refresh report data 
View a chart or graph 

  
  
You can use the Manage My Reports window to add, remove, rearrange, or rename your report types and 
memorized reports. 

To access the Manage My Reports window: 

• Select Manage My Reports from either the Report Center I Want To menu or from the Memorize Report 
dialog. 
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Options available on this window: 
Move reports – Drag and drop report types and individual reports or use the move up/down buttons to arrange 
them in the order you prefer. Reports can be moved from one report type to another. This will affect the order in 
which your memorized reports are displayed on the Reports menu and in the Memorized Reports section of the 
Navigator. 
Add new report type – Select to add another report type, allowing you to sub-categorize your reports the way you 
prefer. 
Rename reports or report types – Your memorized reports or types can be renamed at anytime. 
Copy a report – Use to create a new memorized report the same as, or very similar to, an existing memorized 
report. Modify the copy if changes are required. 
Delete report or report type – Your memorized reports or types can be deleted at anytime. Deleting a report type 
deletes all reports contained therein. If you want to save the reports, move them to another type before deleting the 
type. 

Report Dashboard 
Home Page Dashboard | Run a Report 
  
The Dashboard displays your choice of Point of Sale reports, list statistics, financial information, and even links to 
the Point of Sale online community or your favorite web pages. The Dashboard is highly customizable to more 
precisely fit your particular needs and give you an at-a-glance picture of your business. You can add, rearrange, 
and customize individual components, add additional pages, and drill down into report detail or launch the full 
version of a selected report. 

To access the Dashboard: 

• From the home page (Navigator), select Dashboard from the Reports menu. 
OR 

• From the Report Center, select Go to Dashboard from the I Want To menu. 

Customizing the Dashboard 
The default Dashboard page includes several pre-selected reports. Use the following options to customize the 
currently displayed reports on the Dashboard: 

• Click or drag-and-drop report column headers or separators to sort report values, re-order, or resize 
columns 

• Select Show Full Report to open the report in the full report window, where you have all the normal report 
features available 

• Select Edit to edit the time period and/or sorting for a report, or the address for a web page 

• Select Modify Report to edit the report parameters and filters 

• Select Refresh to update the report data at anytime 

To further customize the Dashboard reports and add additional pages: 
1. Select Customize Dashboard in the upper-left corner. 
2. Use any of these options to customize for your needs: 

• Add/Remove Reports: To remove a report, select the X in its title bar. To add a report, click a 
category to expand it and then select Add for a specific report. See the note below about adding reports 
that are not available here. 

• To add a Web page: From the Other category, select Dashboard Web Page. Initially, a default 
Web page is added. After saving, select Edit  in the page title bar to enter the Web page address you wish 
displayed. 

• Rearrange Reports: Click and hold in a report  title bar, then drag-and-drop it  into the desired 
column and position. 
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• Columns: Add or remove columns by changing the Number of Columns counter. If you reduce 
the number of columns, existing reports will auto-arrange to fit the new  space. Drag the column 
separators to make columns wider or narrower. 

• Pages: Add or remove pages by choosing Add Another Page or Remove Page. You can repeat 
content on multiple pages, if desired. Give each page a name to be displayed on its tab. With multiple 
pages added, you can drag and drop the tabs to rearrange their order. 
3. Select Save. 

  

Notes: 
• You can add many other reports to the Dashboard when running them in the Report Center. Run a report 
and then choose Add This Report To Dashboard from the report I Want To menu. Specify a name and, if 
you have multiple Dashboard pages, to which page the report should be added. 

• The Home Page Dashboard, displayed right on the home page main window is a mini-version of your 
Dashboard, displaying any one of several of the most used reports and providing quick access to your own 
list of saved reports. 

Inventory Reports 
Inventory Overview | Reports Overview | Item Ratings & Trends 
  
Point of Sale provides many reports to help you track your inventory investment and maximize your turn and profit. 
These reports can all be customized to include the data you want to see. Reports vary by license level (Free, Basic, 
Pro). 
Here is an example of some of the more frequently used inventory reports: 

• Inventory Summary – Summarizes your current on-hand inventory. 

• Item List – More detailed view of your current on-hand inventory. 

• Inventory Summary with Activity – A summary of current inventory that also can include sales, 
receiving, and purchasing activity. 

• Inventory Valuation – Report of the value of your inventory, currently or for any day in the past. 

• Inventory by Store –  Your current company inventory broken down by stores. 
To run these reports or to see other available inventory reports, select the Items category from the All Reports 
page of the Report Center. 

Multi-Store Reports 
Reports Overview | Multi-Store Overview 

Pro - Multiple Stores 
Assuming you use Store Exchanges to share information between stores, Headquarters can run reports for any 
one store, a selected group of stores, or all stores, while remote stores can only run reports for the activities at their 
own store. When running reports at Headquarters, use the Modify  Filters option to specify the store(s) to be 
included in the report. 
Z-Out Drawer Count Reports are the only reports sent from remote stores to Headquarters. All other company 
reports ran at Headquarters draw their information from inventory and the transactional history documents 
maintained at Headquarters. 
When Headquarters creates transactional documents for another store, that document is not sent to the other 
store. Inventory for the remote store is updated but the document is not added to the history file at the remote. 
These transaction(s) will be included in reports ran at Headquarters, but not in reports ran at the remote store that 
are based on history documents. 
  
Reports Unique to Multi-Store Operations 

• Transfer Reports – which detail the movement of merchandise between stores. Available at both 
Headquarters and remote stores under the Items report category. 
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• Store Inventory Summary –- located under the Items category, this report provides on-hand 
merchandise information for all stores. Available at all stores. 

• Store Sales Reports – located under the Sales report category, these reports can include summary or 
item sales information for all stores, and provide store comparisons. These multi-store reports are available 
only at Headquarters (remote stores have access to all other sales reports for their store). 

• Z-Out Drawer Count Reports – Z-Out Drawer Count Reports are included in the mailbag sent from 
remote stores to Headquarters. Headquarters can view these reports by selecting view drawer count 
History from the Reports menu. The reports can be printed or exported to Excel. 

• Profit & Loss (P/L) Reports by Class in QuickBooks – If you also use QuickBooks financial software, 
you can run P/L reports for each store as well as the entire company in QuickBooks, by assigning a 
QuickBooks class to each store. Available at Headquarters only. Learn more. 

Store Tracking and Profit/Loss Reports in QuickBooks 
Multi-Store Overview | Multi-store Reports in Point of Sale 

Pro - Multiple Stores 
If you are integrated with QuickBooks financial software, you can run Profit/Loss (P/L) reports for each store as well 
as the entire company in your financial software, by assigning a QuickBooks class to each store. 
To generate this report type, you must enable the class tracking preference in both Point of Sale and in 
QuickBooks financial software and assign a unique class to each store in your Point of Sale company preferences 
at Headquarters. 
Click here for instructions to configure Headquarters preferences in Point of Sale. 

To enable tracking by class in your QuickBooks financial software: 
1. Select Preferences from the Edit menu. 
2. Select Accounting, and then Company in the Preferences window. 
3. Select the checkbox for Use Class Tracking. 
4. Select OK. 

  

Notes: 
• During the next Financial Exchange, the classes you assigned to stores in Point of Sale are added to your 
class list in QuickBooks financial software. As transactions are posted to QuickBooks at Headquarters, 
QuickBooks categorizes them according to the assigned store classes. 

• You can run a report by class to see the P/L for any store. To see the P/L for all stores run an unclassified 
report. Refer to your QuickBooks documentation or in-product help for more information about using classes. 

Related Topics 
Financial Exchange Overview 

Merchant Service Reports 
Merchant Service Overview | Merchant Service Center 
  
Users of the QuickBooks POS Merchant Service can run reports summarizing or detailing their credit and debit 
card transactions for any specified time period. These reports subtotal your transactions by settlement batch and, in 
a multi-store configuration, by merchant number. 

To run a Merchant Service report: 
1. In the Report Center, select Payments as the report category and then Merchant Service as the 
report type. 
2. Select one of the specific Merchant Service reports available. 

• Unsettled Summary: Provides a listing of unsettled transactions by card type. 

• Unsettled Details: Provides details of all unsettled transactions. 
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• Activity Summary: Provides a summary of all transactions (credit and debit), settled and 
unsettled. 

• Activity Details: Provides details of all transactions (credit and debit), settled and unsettled. 
The selected report is displayed using default or your last-run settings. 

3. Change the report date range or select Modify to change other report options and filters as 
needed. 

Many report filtering options are available, including filtering by Batch #, Transaction Type (sales, refund), 
Status (voided, authorized), Card Name, Card Present (yes, no), Workstation, etc. The options available vary 
by specific report. 

4. Select OK to display the reports with your specified options. 
Optional: Memorize the report with your specified options for future use, when prompted. 

5. Select Print or Excel depending on your output needs. 
  

Notes: 
• You can also view lists of credit and debit payments in Point of Sale in the Payments > Credit Card List 
and Debit Card List reports. 

Related Topics 
Work with a displayed report 
Settle card transactions 

Gift Card Reports 
POS Gift Card Service Overview | FAQs 
  
Users of the QuickBooks POS Gift Card Service have three gift card reports available in Point of Sale. If you record 
gift card transactions in Point of Sale but process them through another service, only the Gift Card List report is 
available to you. 

To run a gift card report: 
1. From the Report Center, select Payments as the report category and then one of the specific 
types/reports listed above. 
2. The selected report is generated and displayed. 

• Gift Card Service  Balance Summary – A list of all outstanding gift cards and their balances 

• Gift Card Service  Activity Detail – Details of gift card activity in a specified date range 

• Payment Reconciliation  Gift Card List – A listing of transactions using gift cards for 
payment/refund 

Use the report Modify option if you want to apply report filters or change the appearance of the report. For 
example, you could filter the balance report to include only cards with a balance over $100 or change the date 
range to apply to the activity detail report. 
These reports are based on the transactions recorded in Point of Sale. To verify the current balance of an individual 
card, it is recommended you check the balance from the sales receipt payment screen, which connects to the Gift 
Card service’s online server to check the balance. 
(Pro)  If run at a remote store, gift card reports include only the card activity at that store. If run at Headquarters, the 
reports reflect transactions made at all stores current as of the last completed Store Exchange. 
  
Related Topics 
Modify report options 
Take payment by or sale of a gift card 
Handling returns of gift card purchases 

Customer Order Reports 
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Track Orders by Status | Customer Order Reminders 

Pro 
Several customer order reports are available to help you track, order, and follow-up on the merchandise needed for 
customer orders as well as for seeing the deposits received on these documents. 
  

Order Reports 
Summary and detail reports are available for each customer order type. 
These reports are available in the Customers category in the Report Center. 
Modifying the report data by order status, date, assigned employee (work orders), or due quantities can help you 
track and manage these versatile documents. 
You can also view all non-deleted customer orders and corresponding sales receipts made for a specific customer 
by accessing the customer's history. 
  

Reporting of Order Deposits 
When you take an order deposit, the deposit amount is reflected in the sales activity for the day on your cash 
drawer (X/Z-Out) reports. The amount also is reflected on the Deposit Detail report (available in the Customers > 
Orders area of the Report Center). When the ordered items are sold and the deposit applied to the sale, the total 
sale amount is reflected in the day's sales activity on your X/Z-Out, while the deposit amount is again reflected as 
an adjustment (subtraction) to the day's sales activity. 
  

Sales Reports 
The merchandise/services on a customer order are not included on your general sales reports until the sale is 
recorded on a sales receipt. 
  
Related Topics 
Generate POs from customer orders 
Fill an order (selling items) 
View deposit history 
Customer order overview 
Reports overview 

Financial Exchange Reports 
Overview | Verify the Exchange of Transactions 
  
Several reports are available to help you verify the success of data exchanges with your QuickBooks financial 
software. 
These detailed reports, for receipts, vouchers, customers, vendors, and adjustment memos, provide the 
document/transaction name and number created in your financial software as well as other information. 
In the Report Center, select Financial Exchange as the report category and then choose a specific report. All 
normal report filtering and customization options are available. 
  
Related Topics 
Modify reports 
Work with a displayed report 

Report Options 

Define a Date Range 
Reports Overview | Run a Report | Modify a Report 
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When specifying dates for reports, you have the option of choosing a dynamic date range, such as "today" or 
"yesterday," which changes according to the current date, or a fixed date range with a specific start and end date. 

To define a date range: 
1. Access the report date fields: 

• In the Create a Report wizard as running a new report 

• By selecting Modify on a displayed report to change report options 

• On the top of a displayed report 
2. Select a date filter type from the drop-down list: 

• To specify a fixed date range, enter dates directly in the From and To date fields. 

• Or, select a dynamic date range from the available options. The From and To dates of the range 
are automatically populated for you. 

• See the date fields and time fields topics for more information about defining dates/times. 

• If running a comparison report, enter a date range for each comparison period, such as This 
Year: Year to Date and Last Year: Year to Date. 
3. Select Save (if running or modifying a report) or Apply Date Range (if making changes directly 
on a displayed report). 

  
Related Topics 
View a sales chart or graph 
Work with a displayed report 

Define Filter Criteria - Overview 
Filter Lists | Modify Report Options 
  
Point of Sale provides an extensive set of filtering options, allowing you to work with a subset of a list by entering 
criteria you want to match. 
When you first open a filter dialog, it is blank (unless opening a saved filter, in which case your previous settings 
are shown). 
 With no criteria selected, all data is included in the list or report being generated. Entering filter criteria allows you 
to include or exclude records based on your choices. 
Example filter dialog: 

 

To enter filter criteria: 
1. Click in the field in which you want to enter criteria. 

2. Type your criteria or select the  or  icons to make selections. These icons open selection 
dialogs, calendars, or drop-down lists, depending on the field type. 
3. By default, the filter includes data matching the entered criteria. To exclude matching criteria (i.e. 
show all other data), click in the Include/Exclude column and change the setting to Exclude. 
4. When done, select Apply or Save to filter your list or report data accordingly. 

Other options on the filter dialog may include: 

• Clear All – clear all entered filter criteria from all fields. 
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• Revert – reset all filter criteria to default settings (reports only). 

• Save – in lists, memorizes this filter criteria for later use. 

Learn more about specific filter options: 
General filtering rules and tips – includes information on using spaces, exact matches, include/exclude options, and 
more. 
Free-form text and descriptive fields – used to filter on document comments, descriptions fields, names, 
promotional codes, street names, etc. 
Range fields – used to filter on an alphanumeric range, such as a price or cost range, ZIP code range, Item # 
range, etc. 
Selection lists – used to filter by values restricted to a predefined list, such as when filtering by department or 
vendor code, item type, workstation, etc. 
Date/time fields – used to filter data by dates or date ranges, either fixed or dynamic. 
And/or options – used to create complex filtering rules to include/exclude data based on multiple criteria. 
ZIP Codes – used to filter on customers or vendors residing in a particular ZIP code or range of Zip Codes. 
  
Related Topics 
List overview 
Reports overview 

Add or Remove Report Columns 
Filter Report Data | Change Report Appearance | Modify a Report 
  

This information applies to the Add or Remove Columns window, accessed when running or modifying a report. 

  
Select columns to include in the report and set sorting and other options as follows. Select Save when done. 
  
Columns 

• Select the data columns to include on the report. A checkmark indicates the selected columns. 

• Detail reports include a second tab to select the detail fields included. 

• On the report, columns are displayed in the order (from left to right) in which they appear in report options 
(from top to bottom). Drag and drop column names to place in the order you want. 

• Column order can also be rearranged directly on the displayed report by dragging and dropping the 
column headers. 

• Comparison reports and the Inventory Summary with Activity report have a split 
column selection box. Use the upper box to choose what you want to compare 
(vendors, departments, months, specific items, etc.) and the lower box to choose 
the comparison metrics (typically cost, price, sales amounts, or quantities). 

Sort By 

• Select the value by which you want the report data sorted. The sort determines 
how data is ordered and grouped on the report. For example, to see all data for a 
department grouped together, choose Department as the sort value. The sort 
column must be included in the report in order to sort by it. 

• Select the Create subtotals for this field checkbox to add a subtotal line to the 
report each time the selected sort value changes. 

• Report data can also be re-sorted once the report is ran and displayed by clicking the column headers. 
Sort In 

• Select to sort in Ascending Order (A–Z, 1–10) or Descending Order (Z–A, 10–1). 
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Show 

• Available only on certain Best/Worst, performance, and the Inventory Summary with Activity  reports. 

• On Best/Worst reports, select to view All Records or only the Best/Worst n Records (where n is a user-
defined number). The available option here will depend on the Sort In method selected. This option can also 
be changed on a displayed report by clicking a column header related to the value used to rank the report 
(price, cost, margin, etc.) or by changing the number of records to be shown (on the report window toolbar) 
and then selecting the Refresh icon. 

• On the Inventory Summary with Activity Report, select the checkboxes to include sales, receiving, and/or 
purchase order information. 

Change Report or Graph Appearance 
Run a Report | Modify a Report | Add/Remove Report Columns 
  

This information applies to the Change Report Appearance window, accessed when running or modifying a report or graph. 

  
Use this page to set the page orientation, header and footer information, and fonts. Select Save when done. 
  

Report Orientation: 

• Select   Portrait or   Landscape paper orientation 

Show Header Information 
Select the checkboxes and enter text to be printed at the top and bottom of the report. 

Company Name: By default, your store name as defined in 
company preferences. You can edit the company 
name in the report header. 

Report Title: The name of the report. 

Subtitle: Enter an optional report subtitle. 

Date Prepared: Select the date format. 

Time Prepared: Select to include the time the report was run. 

  

Show Footer Information 
Page Number: Select to include page numbers at the bottom of 

the report. 

  

Fonts 
Select a report area. In the Font window, make your selections and then select OK. 

Report Security: Access Levels 
Reports Overview | Modify a Report | Security Overview 
  
If you require employee logins, the reports an employee can access are determined by the security group to which 
he or she is assigned. Each report is assigned a security access level. The report access levels and security 
groups which can view them are as follows: 
  

Level Description Groups with Access 
1 Maximum Security Owner 

2 High Security Owner, Mgr 
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3 Medium Security Owner, Mgr, Asst Mgr 

4 Low Security All groups 
  
Reports that the currently logged-on user does not have access rights to will not be available for selection. If 
program logins are not required, all employees have access to all reports. The System Administrator  always has 
access to all reports. 
A separate security right, Modify report options, controls the ability to modify a report, including dates. If using the 
pre-defined security groups, all employees have rights to modify the reports to which they have access. 
If the default security levels do not meet your needs, you can change the report access levels or customize your 
security groups to give your employees the rights you wish. The ability to make these changes are themselves also 
subject to security rights (only available to the System Administrator and default Owner group). 

To view or change the access level of a report: 
1. Log on as a user with rights to modify report options. 
2. In the Create a Report wizard, select the Set Report Access Level button. 

Or 
On a displayed report, select Modify and then the Security tab. 

3. Select a security access level from the drop-down list. 
4. Select OK or Run to display the report and save the new access level. 

  
Related Topics 
Run a report 

Cash Drawer (X/Z-Out) Reports 

Cash Drawer Reports (X/Z-Out) 
How do I?  | X/Z-Out Terminology | Reports Overview 
  
The term X/Z-Out is borrowed from cash register systems. These reports can provide up-to-the-minute accounting 
of POS activities for the current sales period, help you reconcile your cash drawer(s), and help you close out the 
day. 
Point of Sale provides four cash drawer reports: 

• The X-Out Status report can be run at any time for a quick check on sales activity or to obtain a 
non-currency media listing up to the time the report is run. The X-Out Status report can be used to report 
sales activity at the end of a shift without doing media counts. 

• The Z-Out Drawer Count reports is often run at the end of a cashier’s shift and/or at the end of 
the day when you want to reconcile the cash drawer. A manual media count can be required on this 
report to improve cash drawer accountability. In a multiple workstation installation, this report is typically 
done at each workstation prior to running the Z-Out Store Close report for the entire store in the End of 
Day procedure. (Pro:  Z-Out Drawer Count Reports ran at remote stores are sent to Headquarters during 
Store Exchanges). 

• The Z-Out Store Close report is typically run when closing the store for the day and filtered to 
include all workstations in the store. The Store Close report does not include the option to manually count 
out the cash drawer. 

• The Payout Report includes is a summary report of cash paid out of your cash drawer using the 
payout feature. 

All X/Z-Out reports include: 

• All sales activity for the specified period 

• Net sales, cash flow, and discount breakouts 

In addition, a Z-Out report can: 
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• Report daily cash flow, including overages and shortages 

• Assist in the recording of media counts and cash drawer reconciliation (Z-Out Drawer Count 
report) 

• Simplify bank deposit preparation by calculating a deposit amount and printing the list of deposit 
items 

Notes: 
• Any of the X/Z-Out reports can be made part of the End of Day procedure. This allows you to use 
the report or reports that best fit your needs and accountability requirements. 

• On X/Z-Out reports, the term "paid out" typically refers to monies given to the customer for any 
reason, such as giving change or refunds on a sale. However, in the list of non-currency media contained 
at the end of X/Z-Out reports, there is a list of payouts, meaning cash removed from the cash drawer 
using the payout feature. It is important to be aware of this distinction. 

• To set printing options for X/Z-Out reports (printer, print template, number of copies, etc.), select 
Preferences  Workstation from the File menu and then select Documents & Printers. 

Related Topics 
How various POS actions are reported 
What is a Z-Out report? 
Z-Out report recommendations 

Basic Steps to Run an X/Z-Out Report 
X/Z-Out Overview | End of Day Overview | Reports Overview 
  
The procedure below assumes you are accessing X-Z/Out Reports from the Report Center. The same reports and 
options, though in slightly different sequence, are available in the End of Day procedure. 

1. Select Cash Drawer as the report category and then select X-Out Status Report, Z-Out Drawer 
Count, or Z-Out Store Close as the specific report type. 

The selected report is ran and displayed, using default settings. 
2. Specify a date/time range for the report. The report will only include information from receipts in 
this date range. Learn more. 
3. If it is necessary to modify other report settings, such as filter criteria or display options, select 
Modify and make changes. 
4. Select OK. 

• Z-Out Drawer Count – The Media Totals window is displayed for you to enter/count the cash 
drawer amounts. Learn more about completing a Drawer Count report. 

• X-Out, Z-Out Store Close – The report is displayed on-screen. 
5. (Optional) With the report displayed, select Memorize to save the report options. Enter a report 
name and select OK. The report will be added to your memorized reports list. 
6. Select Print, Print Preview or Excel to output the report. 

  

Notes: 
• The printer and print template used for your X/Z-Out reports are specified on the Documents & Printers 
page of workstation preferences. 

Related Topics 
Z-Out Store Close report 
How various POS actions are reported 
X/Z-Out overview 

Define X/Z-Out Report Options and Filter Criteria 
X/Z-Out Overview | End of Day Overview | Reports Overview 
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The report options and filter criteria for X/Z-Out reports allow the definition of any combination of workstations, 
cashiers, date/time range, and other display options. 
(Pro)  If ran at Headquarters, the filter criteria also includes the ability to specify the stores included (report will only 
include information through the last completed Store Exchange with remote stores.) 

To define X/Z-Out options and filter criteria: 
1. Follow the basic procedure to select and run an X/Z-Out report. 
2. With the report displayed, select Modify (<Alt+M>). 
3. On the Display page, select a date/time range for the report and the orientation. 
4. On the Filters page, enter filter criteria for the available fields: 

• Store: (Pro, Headquarters only) Select  (<F4>) to access and select from the list of your stores. 
If left blank, all stores are included. 

• Workstation: Select  (<F4>) to access and select from the list of your workstations. If left 
blank, all workstations are included. 

• Cashier: Enter an individual associate’s name or all associates. If left blank, all associates are 
included. 

• While editing filter criteria, you can select Revert to erase your changes and return to the default 
values. 
5. If you want to save your report options, select Memorize Report. Enter a report name and select 
OK. 
6. Select OK again to close the Modify Report window and run the report. 

  

Notes: 
• The printer and print template used for your X/Z-Out reports are specified on the Documents & Printers 
page of workstation preferences. 

Related Topics 
Z-Out reports 
General filter criteria instructions 
X/Z-Out Overview 

View POS Actions on X/Z-Out Reports 
X/Z-Out Overview | End of Day Overview | Reports Overview 
  
Sales and Returns 

• Sales recorded on sales receipts are reported in the Sales column in the first section of the report 

• Sales of gift cards, gift certificates, or payments on charge accounts are broken out separately in the Sales 
column 

• Amounts recorded as returns from customers are shown in the Returns column 

• Refunds for returned merchandise are recorded as paid out amounts for the type of payment used 

• Payments by gift card, gift certificate, customer order deposits used, and charges on account, none of 
which bring cash into the drawer, are subtracted from the net sales to arrive at the deposit amount for the 
period 
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Note: On X/Z-Out reports, the term "Paidout" typically refers to money or other payment given to the customer for any reason, 
such as giving change for a normal sales receipt or paying a customer for returned items. However, in the list of non-currency 
media contained at the end of X/Z-Out reports, there is a list of Payouts, meaning cash removed from the cash drawer using the 
Payout feature as described here. It is important to be aware of the distinction. 

  
Accepting More Than One Payment Method 
When the customer pays for a transaction using more than one payment method, amounts are credited to the 
individual payment methods. If a sale were paid for with $50 cash and $75 on a credit card, the report would show 
a $50 cash paid-in amount and a $75 credit card paid-in amount. 
  
Discounts 

• The sales figures in the first section of the report are calculated from the receipt totals after any discount. 
Discount dollars or types are not identified here. 

• The discount breakout section reports all discounts identified by type. 

• User-defined discount types from preference settings are used to identify manual item discounts given at 
point of sale. 

• GLOBAL is assigned if you discounted the receipt sub-total. 

• Note that the use of price levels to give a lower price than normal is not considered or reported as a 
discount. 

Non-Currency Media 
X/Z-Out reports include itemized listings of the individual amounts paid for by non-currency media, such as check, 
ATM/debit, or credit card, and gift card/certificate. 
  
Related Topics 
X/Z-Out basic steps 
X/Z-Out overview 

Z-Out Reports 
X/Z-Out Overview | End of Day Overview | Reports Overview 
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Z-Out or "zero-out" reports are used to close out a workstation and cash drawer for a shift or day and when closing 
the entire store for the day. Z-Out reports contain all the information included in an X-Out report, with additional 
functions as described below. 
There are two types of Z-Out report: 

• Z-Out Drawer Count: The Z-Out Drawer Count report is typically run at the end of an associate’s shift, or 
at the end of day, to summarize sales activity and reconcile a cash drawer for the period. Typically, a Z-Out 
Drawer Count report is run at each workstation independently. 

Z-Out Drawer Count reports can be filtered by date/time range, workstation, store (Pro, Headquarters only), 
and/or associate. In addition, manual media counts can be required to ensure cash drawer accountability. 

  

Note: To require manual media counts as part of drawer count report, select Preferences  Company from the File menu. 
Then select the Sales page from the preferences tree on the left. Select the Require a Manual Media Count for X/Z-Out 
option and save. 

• Z-Out Store Close: The Z-Out Store Close report is typically run at the end of the day when closing the 
store. It is particularly well-suited for retailers with multiple workstations, where each workstation runs their 
own Drawer Count report and then a Store Close report is run to include the activities from all workstations. 
By default; all workstations and associates are automatically included in the report, though it can be filtered to 
narrow the results if desired. Unlike the Z-Out Drawer Count report, manual media counts are not available 
for the Z-Out Store Close report.  

Which Z-Out report should I use? 
  
Related Topics 
How various transactions are reported 
End of Day procedure 
X/Z-Out overview 

Z-Out Report Recommendations 
X/Z-Out Overview | End of Day Overview | Reports Overview 
  
Following are some general suggestions for determining which Z-Out report to use and when. Use the report types 
and frequency that best meets the needs of your business and policies. 
  
If you have a single workstation: 

• For maximum control, do a Z-Out Drawer Count at the end of each shift and as part of your End of Day 
procedure, requiring manual media counts. With a single workstation, it isn’t necessary to run a separate 
Store Close report. 

If you have multiple workstations: 

• For maximum control, do a Z-Out Drawer Count report at each workstation at the end of each shift, 
including the shift that ends the day, and requiring a manual media count. Filter by workstation number, time 
period, and cashier, as appropriate at each workstation. 

• After the individual workstations have completed their final drawer count for the day, run a Z-Out Store 
Close report as part of the End of Day procedure, filtered to include the activity from all workstations/cashiers 
for the entire day. 

Z-Out Drawer Count Report 
X/Z-Out Overview | End of Day Overview | Reports Overview 
  
Follow the basic steps to run an X/Z-Out report, selecting Z-Out Drawer Count as the report type, and then 
continue with this procedure, when prompted to enter media counts on the Media Totals window. 

To enter media totals: 
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1. Enter the amount of currency that was in the drawer at the beginning of the period in the Begin 
field. 

By default, Point of Sale suggests the amount that was entered in the Leave field the last time a Z-Out Drawer 
Count report was run. 

2. If a manual media count is required, select  (<F4>) in the Count field to open the Media Count 
window for each media type. Complete and enter the counts for each currency. The total of each counted 
media type is carried from the Media Count window to the Media Totals window when you select OK. 

If not performing a manual media count, just enter the total drawer currency count in the Count field. 
The total amount of non-currency media accepted during the period is displayed on the Media Totals window 
as well and cannot be edited. 

3. In the Leave field, enter the amount of currency that is to be left in the drawer to begin the next 
period. (Point of Sale suggests the same amount entered the last time a Z-Out Drawer Count report was 
run). 

The Deposit field is calculated by Point of Sale based on your currency counts and the values entered for the 
Begin and Leave fields. 

4. Select OK. 
5. If a discrepancy exists between what was counted and what Point of Sale has recorded, a 
discrepancy notice is displayed. Select Yes to continue or No to recount. If the discrepancy cannot be 
corrected with a recount, enter a reason for the difference or comments in the Remarks field. Remarks are 
printed at the end of the Z-Out Drawer Count report. 

• The Drawer Count report is displayed. 
6. Select Modify if you want to change report options, such as date, store, cashier, or workstations. 
Changing these options causes the report to run again. 

  

Notes: 
• If you want to conduct manual media counts for each drawer at the end of the day and still want to run a Z-
Out Store Close report, manually run a Z-Out Drawer Count report for each workstation, then run a Z-Out 
Store Close report as part of your End of Day procedure that includes all workstations. 

• Drawer Count reports are saved and can be viewed by selecting View Drawer Count History from the 
Reports menu. 

• (Pro) Z-Out Drawer Count Reports ran at remote stores are sent to Headquarters during Store Exchanges. 
Related Topics 
Z-Out reports 
X/Z-Out overview 

View Drawer Count History 
X/Z-Out Overview | End of Day Overview | Reports Overview 
  
Z-Out Drawer Count reports are stored by Point of Sale, and can be viewed at anytime by selecting View Drawer 
Count History from the Reports menu. 
(Pro) Remote stores send their drawer count reports to Headquarters with each Store Exchange. At Headquarters, 
the list of Z-Out Drawer Count Reports includes all stores. The listed reports can be grouped in the list by store, 
date, workstation, etc., using standard list sorting procedures. 
  
Related Topics 
Z-Out reports 
X/Z-Out basic steps 
X/Z-Out overview 

Z-Out Store Close Report: End of Day 
X/Z-Out Overview | End of Day Overview | Reports Overview 
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A Z-Out ("zero" out) Store Close report provides a summary of your workstations’ sales activities for the day and 
helps prepare a bank deposit. 

To run an Z-Out Store Close report as part of the End of Day procedure: 
1. Select End of Day Procedure from the Point of Sale menu. 
2. In the End of Day Reports section, select the checkbox to run a End of Day report and then select 
Z-Out Store Close as the report type. 
3. Select the date period for the report from the drop-down list. For a Z-Out Store Close report, this 
is usually the dynamic date Today. To define a fixed date range, select Custom. 
4. Select other End of Day options, as needed. 
5. Select OK and follow the on-screen prompts. 

  
Notes: 

• The Z-Out Store Close report automatically includes sales activity for every workstation and cashier for the 
date range defined for the report. However, you can filter the report to include only designated workstations or 
cashiers. In a multi-store configuration, you can also filter by stores (only at Headquarters). 

• This report is generally run as part of the End of Day procedure as described below, but can also be run 
manually. 

• The Z-Out Store Close Report does not include reconciling the cash drawer. If you want to reconcile the 
cash drawer, use the Z-Out Drawer Count report instead of, or in addition to, the Store Close Report. 

Related Topics 
Which Z-Out report should I use? 
Z-Out reports 

Sales Charts & Graphs 

Charts and Graphs Overview 
How do I?  | Print Sales Charts/Graphs 

Run a report 
Modify a report 
Drill down to report detail 
Memorize a report 
Manage my reports 
Export a report to Excel 
Use security access levels 

Run cash drawer reports 
Run Merchant Service reports 
Use the report Dashboard 
Refresh report data  
View a chart or graph 
Run multiple reports 

  
  
Point of Sale provides several chart and graph options to let you analyze your business in a visual format. 
A chart/graph can display a summary of sales, profit, or current inventory by investment department, vendor, 
employee, hours or days of the week, or store. The information can be viewed in bar, line, or pie chart formats. 
  



Reports & Sales Charts 

433 

 
  
Graphical formats are useful for making quick comparisons, visualizing trends, and instantly communicating data to 
others. Each type of graph is best suited for a particular purpose. 
Bar graph: Bar graphs are particularly effective when making comparisons among members of a group. 
Pie chart: Pie charts enable you to visualize the proportion of total sales contributed by each vendor, department, 
clerk, etc. 
Line graph: Line graphs display your results over a period of time. In this way, you can monitor trends. 
  
Related Topics 
Security Rights for Sales Charts/Graphs 

Charts and Graphs Overview 
How do I?  | Print Sales Charts/Graphs 

Run a report 
Modify a report 
Drill down to report detail 
Memorize a report 
Manage my reports 
Export a report to Excel 
Use security access levels 

Run cash drawer reports 
Run Merchant Service reports 
Use the report Dashboard 
Refresh report data  
View a chart or graph 
Run multiple reports 

  
  
Point of Sale provides several chart and graph options to let you analyze your business in a visual format. 
A chart/graph can display a summary of sales, profit, or current inventory by investment department, vendor, 
employee, hours or days of the week, or store. The information can be viewed in bar, line, or pie chart formats. 
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Graphical formats are useful for making quick comparisons, visualizing trends, and instantly communicating data to 
others. Each type of graph is best suited for a particular purpose. 
Bar graph: Bar graphs are particularly effective when making comparisons among members of a group. 
Pie chart: Pie charts enable you to visualize the proportion of total sales contributed by each vendor, department, 
clerk, etc. 
Line graph: Line graphs display your results over a period of time. In this way, you can monitor trends. 
  
Related Topics 
Security Rights for Sales Charts/Graphs 

Print Charts and Graphs 
Charts and Graphs Overview | Run a Report | Modify a Report 
  

1. With the chart displayed, select Print from the bottom toolbar. 
2. To modify the printing instructions, select Preview and use any of the following options: 

• Orientation: Specify Portrait or Landscape Mode. 

• Margins (%): Adjust the width of any margin. The chart size expands or shrinks automatically to 
match the new margins. Margins can also be changed by dragging and dropping the preview margin 
indicator lines with your mouse. 

• Reset Margins: Click to restore the last saved margin settings. 

• View Margins: Select to display the margin indicators on the screen. 

• Detail: Set Detail to More to print the chart at the maximum size possible with the specified 
margins. When set to Normal, the chart is reduced slightly and the text labels identifying the chart data 
are enlarged. 

• Proportional: Select to return the chart to its original relative height and width proportions. 
3. Select Print. 

  
Related Topics 
View a chart or graph 
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Employees & Security 

Employees & Security Overview 
How do I? | Add an Employee | Security Rights 

Working with Employees 
Add an employee 
View/edit an employee record 
Delete an employee record 
Print or export my employee list 
Track employee hours worked 
Track sales commissions 

Working with Security 
Turn security on/off (require logins) 
Log In or out 
Change my password 
Track employees without requiring logins 
View or edit a security group 
Create a new security group 
Delete a security group 

  
  
In the working environment of a small retailer, it is not uncommon for the owner or manager to use the same 
register as a sales associate. You may want to give different security rights to different employees to limit access to 
certain features or to ensure confidentiality regarding sensitive financial information. 
Adding employees in Point of Sale and requiring password logins allows you to: 

• Restrict access to program features and sensitive data 

• Automatically add employee names to documents for accountability 

• Track employee sales to evaluate performance 

• (Pro) Pay commissions 

• (Pro) Use employee Time Clock to track hourly employees and assist in your preparing your payroll 
In addition to login names, passwords, and security group assignments, employee records can store addresses, 
contact information, and related notes. 
The use of the security features are optional, but strongly recommended. Besides providing the benefits outlined 
above, requiring user names and passwords to access the program helps protect your valuable data against 
unauthorized access across a network or the Internet. Using Point of Sale’s security features should be one 
component of a comprehensive data protection strategy. 
  

Multi-Store Note: Employees and security rights are defined at each store independently and are not exchanged between stores 
although Time Clock records are sent from remote stores to Headquarters. When a new employee is added to Point of Sale at a 
remote store, the remote may want to contact Headquarters outside of QuickBooks Point of Sale to have the employee added to 
the central database for payroll or other purposes. Each store has their own System Administrator. 

  

Turning Security On 
The security features are enabled by selecting the company preference checkbox to Require users to log in. You 
are immediately prompted to enter a System Administrator  password and then to log in. 
Once security is enabled in this way, only the Security Administrator can change this setting, add or delete 
employees, and perform other security-related tasks. 
  

About Security Groups 
You control access by assigning your employees to security groups; each group having a different set of access 
rights. Point of Sale comes with four predefined security groups that you can assign. If the default rights in the four 
predefined groups don't meet your needs, you can easily change them or set up new groups with access rights of 
your choosing. 
  
Why else might a Point of Sale feature not be available to me? 
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Add an Employee 
Edit an Employee Record | Delete an Employee Record   
  
Use this procedure to add employees in Point of Sale and optionally assign security group rights. The rights of the 
assigned security group determine the employee’s access to Point of Sale features. 
If requiring logins, only the System Administrator  can add employees. 
  

If you have accessed this topic after copying another employee record, start with Step 4. Edit the information brought from the 
copied record as needed. 

To add a new employee: 
1. If requiring logins, log in to Point of Sale as the System Administrator. 
2. From the Employees menu, select Employee List. 

Your employee list is displayed. 
3. Select New Employee. 
4. Enter employee name, contact information, and other information in the appropriate fields: 

• The optional Notes field on the Custom tab can be used to show schedules, vacations, etc. 

• (Pro) If applicable, enter a commission percentage if you will pay the employee a commission on 
eligible sales. 

• (Pro) If using Time Clock to track hours worked for the employee, select the Hourly checkbox. 
The employee will be prompted to clock in/out for purposes of tracking hours worked. 

• (Pro) Custom fields on the Custom tab can be used to record additional employee information. 
5. If requiring logins to use the program, also complete the following: 

• Login Name: Assign an alphanumeric login name. Login names must be unique and be made up 
of letters or numbers and the dash, underscore, and dot/period characters. Login names cannot include 
spaces or other special characters. Once assigned, login names cannot be changed. 

• Security Group: Displays the list of security groups that can be assigned to the employee. Select 
security group from the drop-down list of your available groups (the four predefined groups and your 
custom groups). 

• Password: Select Create Password. Enter a password and enter it again to confirm. Tips for 
passwords  
6. Select Save or Save and New if adding another employee. 

  

Notes: 
• The currently logged in employee must log out and then log in again for changes to take effect in Point of 
Sale. 

• (Pro) Employees and security rights are defined at each store independently and are not exchanged 
between stores. However, if using Time Clock, the time records of hourly employees are sent from remote 
stores to Headquarters. When a new employee is added to Point of Sale at a remote store, the remote may 
want to contact Headquarters outside of QuickBooks Point of Sale to have the employee added to the 
employee list at Headquarters for payroll or other purposes. 

Return to top 
  
Related Topics 
Copying an employee record 
Tracking employees without requiring logins 

Copy an Employee Record 
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Add an Employee | Edit an Employee | Delete an Employee 
  
Copying an existing employee record is a quick way to add a new employee with similar information. When you 
copy an employee record, all of the information except login name and password is carried to the new employee 
record. You can then edit the new record to make it unique, as necessary. You cannot copy the System 
Administrator  record. 
If requiring logins, only the System Administrator can copy an employee record. 

To copy an employee record to create a new one: 
1. From the Employees menu, select Employee List. 
2. Select or display the employee record to be copied. 
3. Select Copy Employee from the window tool bar. 

All information except the login name and password is copied to the new employee record. 
3. Enter a Login name and create a password for the new employee, make any other changes that 
are necessary, and assign a security group. 
4. Click Save. 

  
Related Topics 
Employees & security overview 

View or Edit an Employee Record 
How do I? | Add an Employee | Copy a Record 

Working with Employees 
Add an employee 
Delete an employee record 
Print or export my employee list 
Track employee hours worked 
Track sales commissions 

Working with Security 
Turn security on/off (require logins) 
Log In or out 
Change my password 
Track employees without requiring logins 
View or edit a security group 
Create a new security group 
Delete a security group 

  
  
Only the System Administrator  can edit employee passwords. Other users, with adequate rights, can edit other 
employee information or change the security group assignment. An employee's Login Name can never be edited. 

To view or edit employee records: 
1. From the Employees menu, select Employee List. 
2. Highlight the employee’s record in your employee list. 
3. Select Edit Employee. The employee’s record is displayed. 
4. Make changes as needed. 
4. Select Save. 

  
Tip: Use List Edit mode to edit many records quickly. In the employee list, list edit mode is a quick way to change 
the security group assignments for several employees, or to update ZIP codes or phone area codes when changes 
occur. 
  
Related Topics 
Delete an employee record 
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Track employee commissions 
Track employee hours worked 
Employees & security overview 

Delete an Employee Record 
Add an Employee | View or Edit an Employee 
  
Only the System Administrator  can delete employees. You cannot delete the System Administrator. 

To delete employees: 
1. Select the employee record(s) to be deleted from your employee list. How do I select multiple 
employees?   
2. Select Delete Employees from the I Want To menu. 

(Pro) You will be alerted if any of the selected employee(s) are currently clocked in. 
3. If the confirmation window is displayed, select Delete to complete the action. 

  
Related Topics 
Employees & security overview 

GoPayment:  Frequently Asked Questions 
Basic  

What if I experience a low signal while processing a payment? 
 
If there's no response due to a low signal, keep GoPayment open and try moving to a better spot. If you lose your 
connection during a payment, try to continue where you left off.  If you close GoPayment before getting a 
connection, you will need to re-enter all payment information.  
  

Why can't I void a payment? 
 
If the transaction has been submitted to the bank (batched), it cannot be voided.  
At that point, you or your account administrator can process a refund online using the Merchant Service Center 
site.  
  

How do I use GoPayment to store a list products or services?  
 
Use the  Items feature  to store a priced list of products or services.  
With Items on, you can start transactions by selecting item(s) that comprise the purchase.  
GoPayment uses item prices to tally the charge amount. Customers can see what they bought and you can track 
inventory and services. 
  
To turn on Items: 

•  In Settings, turn Items on.  

• Tap Get Paid.  The Items list displays.  
To add an item: 

• From the  top right of the screen tap +.  

• Then complete the Item form. 
  
To edit an item: 

• Tap the > next to the item you want to edit.  Or, from  Settings, tap Edit Items. 
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To charge for an item: 

• Tap the > next to the item you want to add to the order.  
  

How do I locate past charges? 
 
To view past charges: 

• Tap History.   
You will see the last 25 transactions. (Payments appear in black. Voids display in red).  

  
To open a transaction: 

• Tap the transaction line.  
You can view transaction details, send a receipt, or void the charge. 

.  
  

How do I set the sales tax? 
  
To set the sales tax: 

• At the bottom of the GoPayment screen, tap Settings.  

• In the Sales Tax field, enter the desired tax rate.  
Or, to have GoPayment automatically calculate sales tax based on your location,click the Location-based tax rate 
checkbox.  When sales tax should be applied to an item, open the item and tap its Sales Tax On button.  (The 
sales tax you enter applies only to items).  For charges that do not feature items, you'll need to calculate the tax 
yourself and include it in the total amount charged.  
  

Is a customer signature required? 
 
Getting a signature is optional.  However, Intuit GoPayment lets customers sign for charges on your iPhone screen 
using their finger.  
The charge has already been processed. But in the case of a later chargeback, a signature can help verify that the 
customer was present and approved the charge.  
  

When does a merchant get paid? 
 
Your GoPayment transactions are totaled each day at 3:00pm PST, and that amount normally appears in your 
account within 2-3 business days.  
However, the waiting period, known as “time to funding,” varies depending on a number of variables: 

• Time of day the transaction was processed; 

• The bank account  in which funds were deposited; 

• The length of time it takes your bank to verify and process electronic deposits. 
To update your deposit account information, sign in with your GoPayment User ID and Password here.   
From the web page, choose Account > Account Profile.  
Note:  This site is not optimized for mobile browsers, so you may wish to use your computer's browser.  
  
  

How do customers leave a tip? 

https://merchantcenter.intuit.com/
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To activate the Tips feature: 

• At the bottom of the GoPayment screen, tap Settings.  

• Turn on Tips.  
For a customer to leave a tip: 

• Once Tips is turned on, go to the Signature screen. 

• Tap Add Tip. 

• Tap a percentage amount (automatically calculates) or type a dollar amount directly in the Tip field.  

• Tap Apply Tip.   

• To make a change prior to leaving the Signature screen, tap Change Tip.  
  

How do I match a GoPayment charge in QuickBooks? 
 
You can apply a payment to an existing invoice in QuickBooks, create an invoice for the charge, or just credit a 
customer. 
  
To match a charge in QuickBooks: 

• In QuickBooks, choose Customers > Credit Card Processing Activities > Get Online Payments. 

• Select Mobile Transactions. 

What are the requirements for my wireless network? 
 
If wireless is used or implemented in the payment environment or application, the wireless environment must be 
configured per PCI DSS version 1.2 requirements 1.2.3, 2.1.1, and 4.1.1.  
Wireless technology must be securely implemented and transmissions of cardholder data over wireless networks 
must be secure. 
To be PCI-compliant, wireless network administrators must: 

• Install and configure perimeter firewalls between wireless networks and systems that store credit card 
data, per PCI DSS version 1.2, 1.2.3. 

• Modify default wireless settings, as follows, per PCI DSS 2.1.1: 
o Change default encryption keys upon installation and when anyone who knows the keys leaves or 

changes positions. 
o Change default service set identifier (SSID). 
o Change default passwords or passphrases on access points. 
o Change default SNMP community strings. 
o Enable WiFi protected access (WPA and WPA2) technology for encryption and authentication. 
o Update firmware on wireless access points to support strong encryption and authentication (WPA/WPA2). 
o Other security related wireless vendor defaults. 
o For wireless networks transmitting cardholder data or connected to the cardholder data environment, 

implement industry best practices for strong encryption of data transmission and authentication (e.g.,IEEE 
802.11i).  

o All newly implemented wireless networks are prohibited from using WEP as of March 31st, 2009.  
o For current wireless implementations, it is prohibited to use WEP after June 30, 2010. 

Learn more 

Print or Export Your Employee List 
Printing Basics | Export Data | Reports Overview 

http://www.youtube.com/user/IntuitQuickBooksPOS/videos
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A list of your employees can be printed or exported to Excel for reference. Other employee reports, such as 
Employee Sales in various formats are available in the reports area. 
(Pro) You also have access to Employee Commissions and Time Clock reports.   

To print or export from the Employee List: 
1. Display your employee list and select the records you wish to print or export. How do I select 
multiple records in a list?   

If printing or exporting a group of related records, you may find it helpful to filter the list first. To print or export 
the entire list, make sure the list filter is set to display all records. 

2. From the window toolbar, select Print. 
OR 
From the I Want To menu, select Export to Excel. 

3. Follow the on-screen instructions to print/export the selected records, displayed records, or all 
records. 

To print or export your employee list as a report: 
Printing or exporting your list as a report gives you additional flexibility in formatting and filtering. 

1. From the Reports menu at the home page, select Report Center. 
2. Select Employees  Employee List as the report type. 

The employee list report is displayed with default settings. 
3. Select Modify to change report columns, filters, display options, etc 
4. Select OK. The report is re-generated and displayed on the screen. 
5. Select Print or Excel to output the report as desired. 

  
Related Topics 
Employees & security overview 

Turn Security On/Off 
Log In/Out | Add Employees | Security Rights 
  
Requiring employees to log in with a login name and password activates the security features of Point of Sale. 

To activate security: 
1. At the home page, select Preferences  Company from the File menu. 
2. Select General from the left-side preferences list. 
3. Select the Require users to log in checkbox. 
5. Enter a password for the System Administrator  when prompted. 
6. Select Save. 
7. Log in as the System Administrator using the password defined in Step 5 or as another employee 
previously set up. 

  
After activating security in this manner, add or edit employee records, assigning user names, passwords, and 
security rights as needed. 
Only the System Administrator can change this setting in the future. To deactivate security, come to the same 
preference page and clear the checkbox. 
  
Related Topics 
Track employee transactions without requiring logins 
Employees & security overview 
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Log In/Out 
Employee & Security Overview | Log In/Out Preferences 
  
Employees can be required to log in/out of Point of Sale to provide both security and accountability. Login names 
and passwords are initially defined by the System Administrator , as are the security rights assigned to each 
employee. 

To access the Log In/Out dialog: 
You can access the Log In/Out dialog in any of these ways: 

• Upon program startup, if requiring user logins, the Log In dialog is automatically displayed 

• Click the small arrow adjacent to the logged-in employee's name, and then 
click Log In/Log Out from the drop-down menu 

To log in: 
1. Select your user name from the drop-down list. 
2. Enter your password in the Password field. (Passwords are case-sensitive.) 
3. click Log In. 

The name of the logged-in user is displayed at the top of most Point of Sale screens and is auto-filled into the 
Associate and Cashier fields on documents. 

To log out: 
1. Access the Log In/Out dialog as described above. 
2. click Log Out. 

  

Notes: 
• To log in/out, the Require users to sign in preference must be enabled by the System Administrator.   

• Optionally, you can enable automatic security logouts. 

• A logged-in employee does not have to log out before a second employee logs in. The second employee’s 
login will automatically log out the first employee. This feature saves time if it is necessary for an employee 
with higher security rights to log in to complete an action that the first employee cannot. 

• The Manager Override login dialog may be automatically displayed if the current user does not have 
security rights to complete a selected action. 

Return to top 
  
Related Topics 
Add employees & define security 

Automatic Security Logouts 
Employees & Security Overview | Log In/Out | Clocking In/Out 
  
Your Point of Sale preferences can be set such that employees are automatically logged out under the following 
two circumstances. 
Select a link to view preference setting information for these options. 
Log out after a period of inactivity 
Log out after each sales transaction 
  

Important: Don't use the automatic logout after a period of inactivity if scheduling backups or Store Exchanges to occur when the 
computer is unattended. 
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Change your Login Password 
Employees & Security Overview | Log In/Out 
  
You can change your own login password using the procedure below. No access to the full employee record is 
provided with this procedure. It is recommended that you change your password every 90 days. 

To change your own password: 
1. Log in using your current password. 
2. From the Employees menu, select Change Employee Password. 

The Change Password window is displayed. 
Tips for passwords  

3. Enter your current (old) password. 
4. Enter a new password. Confirm the new password by entering it again. 
5. Click OK. 

  

Note: 
• Only the System Administrator  can change passwords for other employees. 

Security: Manager Override 
Security Overview | Log In/Out | Default Rights 
  
Many actions can be completed only by users with sufficient security rights to perform them. The Manager Override 
function provides an option for those times when it may be necessary for a manager to accomplish a sales task for 
which the current logged-in user does not have sufficient rights. 
When a sales task is attempted for which the current user does not have rights, the Manager Override alert is 
displayed, which allows a manger to temporarily sign in and complete the action. The manager login is good only 
for the current task, security immediately reverts to the previous user. 
  

 

To override a security limitation: 
1. When the Manager Override dialog is displayed and you wish to override the limitation on the 
current user, sign in with your user name and password. 
2. Complete the task and save. 
3. Security automatically reverts to the previous user. 

  
Only certain point-of-sale tasks  trigger the Manager Override alert: 

• Attempting to give a discount on a receipt without the right to do so 
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• Attempting to sell item with a zero price or changing the price 

• Attempting to entering a negative quantity on a regular sales receipt 

• Attempting to accept a check when the customer record is flagged "Do not accept checks" 

• Attempting to charge a new sale to a customer account when the charge would exceed the customer's 
account limit or a past due amount is indicated 

• Attempting certain other edits at the time of sale 

Notes: 
• The Cashier and Associate fields retain the original entries; they do not change to reflect the override user. 

• Other windows opened while in Manager Override will have the elevated rights of the manager, but once 
the original task is completed these windows will be downgraded to the original user's rights or automatically 
closed if the original user has no rights to them. 

Security Rights for Predefined Groups 
Create a New Security Group | Security Overview 
  
Security groups control access to specific features or data. Four predefined security groups are included in Point of 
Sale:  Owner, Manager, Assistant Manager, and Associate. Rights to specific features of the program decrease as 
you move from the Owner group to the Associate group. You can assign these groups to your employees, change 
the rights for each group, and, if necessary, create new groups with the rights you prefer. 
We recommend that you initially assign each employee to one of the four predefined groups. Later, you can 
reassign groups, customize group rights, or create additional groups as necessary to meet your needs. 
The Security Rights by Group table below lists the default rights granted to each of the predefined groups. 
You can give or take away a right by selecting or clearing the checkbox for that group on the Security window. You 
can reset the rights of the four predefined groups by selecting the Revert Default Groups button at the bottom of 
the window. 
Select a link to jump to that section of the table or scroll down to view the entire table. 
  

All levels:   

General Inventory 

Tools Departments 

Financial Vendors 

Receipts Reports 

Sales History POS (sale related) 

Basic:   

Customers Inventory Adjustments (Memos) 

Vouchers Adjustment History 

Receiving History Purchase Orders 

 Pro:   

Customer Rewards 
Sales Orders and Layaways 

Time Tracking 
Work Orders 

Transfer Slips 
Transfer History 

Stores 
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Related Topics 
View or edit a security group 
Add a security group 
  
  
Security Rights by Group 

Area/right Owner Manager AsstMgr Associate 

General         

Access Company 
Preferences 

X X     

Access 
Workstation 
Preferences 

X X X   

Access the Setup 
Interview 

X X     

Access Hardware 
Setup Wizard 

X X X   

Access Hardware 
Troubleshooter 

X X X   

Write letters X X X   

Create E-mail 
Campaign List 

X X X   

Access Manage 
my License 

X X     

Exit Point of Sale X X X X 

Import/Export Data X X     

Open company 
data file 

X X     

Close company 
data file 

X X     

Create new 
company data file 

X       

Rename company 
data file 

X       

Return to top         

Area/right Owner Manager AsstMgr Associate 

General (cont.)         

Backup data X X X X 

Restore data X X     

Convert from 
previous version 

X       

Clean up company 
data 

X X     

Customize 
program interface 

X X     

Access Employees X X     
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and Security 

Edit employee 
information 

X X     

Modify security 
rights or groups 

X       

View cost fields X X     

Download program 
updates 

X X     

Install downloaded 
updates 

X X     

E-mail documents X X X   

Print held 
documents 

X X X   

Login from an 
integrated 
application 

X X X X 

Access Dashboard X X     

Customize 
Dashboard 

X X     

Access Dashboard 
Web Page 

X X     

View list statistics 
View/edit 
commission 
information (Pro) 

X 
  
X 

X 
  
X 

X   

Return to top         

Area/right Owner Manager AsstMgr Associate 

Tools (Pro)         

Access Print 
Designer 

X X     

Return to top         

Area/right Owner Manager AsstMgr Associate 

Financial 
Exchange 

        

Update 
QuickBooks 

X X X   

Recover 
QuickBooks 

X X     

Access Activity 
Log 

X X X   

Open linked QB 
transactions 

X X     

Return to top         

Area/right Owner Manager AsstMgr Associate 

Reports         

Modify report X X X X 
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options 

Run All Reports X       

Run Level 2-4 
Reports 

X X     

Run Level 3-4 
reports 

X X X   

Run Level 4 
reports 

X X X X 

View Drawer 
Count History (Z-
Out) 

X X X   

View amount of 
cash drawer 
mismatch 

X X X X 

View tip amounts 
on End of Day 
reports 

X X     

Return to top         

Area/right Owner Manager AsstMgr Associate 

Point of Sale         

Run End of Day X X X   

Open cash drawer X X X   

Create Payout 
receipts 

X X X   

Apply global 
discount 

X X X X 

Change price level X X X X 

Edit shipping 
amount (Pro) 

X X X X 

Return to top         

Area/right Owner Manager AsstMgr Associate 

Receipts         

Override "Accept 
Check" setting 
(Basic) 

X X X   

Override Credit 
Limit (Basic) 

X X X   

Override Past Due 
Charge Blocking 
(Basic) 
Create receipts for 
other stores (Pro) 

X 
  
X 

X 
  
X 

X 
  
  

  

Edit or discount 
sale price 

X X X X 

Edit item 
description 

X X X   

Accept returns and X X X X 
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exchanges 

Edit receipt date X X X X 

Hold receipts X X X X 

Apply coupons 
(Pro) 

X X X X 

Return to top         

Area/right Owner Manager AsstMgr Associate 

Sales History         

Access sales 
history 

X X X X 

Reverse receipts X X X   

Copy receipts X X X   

Edit receipts X X X   

Return to top         

Area/right Owner Manager AsstMgr Associate 

Transfer Slips 
(Pro) 

        

Access transfer 
slip 

X X X   

Create transfer 
slips for other 
stores 

X X X   

Hold transfer slips X X X   

Return to top         

Area/right Owner Manager AsstMgr Associate 

Transfer History 
(Pro) 

        

Access transfer 
history 

X X X   

Reverse transfer 
slips 

X X X   

Copy transfer slips X X X   

Edit transfer slips X X X   

Return to top         

Area/right Owner Manager AsstMgr Associate 

Inventory         

Add/Copy item X X     

Edit item X X     

Delete item X X     

Edit prices X X     

Edit cost X X     

Edit quantity 
(Basic, Pro) 

X X     
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Change item type X X     

Access Physical 
Inventory (Basic) 

X X X X 

Update Physical 
Inventory Basic) 
Access item 
assembly (Pro) 
Access group item 
(Pro) 

X 
  
X 
  
X 

X 
  
X 
  
X 

    

View inventory 
reminders (Pro) 
Modify/Clear 
Reminders (Pro) 

X 
  
X 

X 
  
X 

X 
   

  

  

Price Manager: 
Access 'Change 
Item Prices' 
Price Manager: 
Access 'Discount 
Pricing' (Pro) 

X 
 
  
X 

X 
 
  
X 

    

View inventory 
ratings & trends 
Create special 
order item (Pro) 

X 
  
X 

X 
  
X 

   
  
X 

  

Print item list X       

Print item tags X X X X 

Export item list X       

Return to top         

Area/right Owner Manager AsstMgr Associate 

Departments         

Add/Copy X X     

Edit departments X X     

Delete 
departments 

X X     

Area/right Owner Manager AsstMgr Associate 

Vendors (Basic, 
Pro) 

        

Access Vendors X X X   

Add/Copy vendors X X     

Edit vendors X X     

Delete vendors X X     

Return to top         

Area/right Owner Manager AsstMgr Associate 

Purchase Order 
(Basic) 

        

Access POs X X X   

Add / Copy POs X X     
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Edit POs X X     

Delete POs X X     

Edit item 
description 

X X     

Access item list 
from PO 

X X     

Return to top         

Area/right Owner Manager AsstMgr Associate 

Vouchers (Basic)         

Access vouchers X X X   

Create return 
vouchers 

X X     

Enter cost X X     

Edit item 
descriptions 
Create voucher for 
other stores (Pro) 

X 
  
X 

X 
  
X 

    

Hold Vouchers X X X   

Return to top         

Area/right Owner Manager AsstMgr Associate 

Receiving History 
(Basic) 

        

Access receiving 
history 

X X X   

Reverse voucher X X     

Copy voucher X X     

Edit voucher X X     

Return to top         

Area/right Owner Manager AsstMgr Associate 

Adjustments 
(Basic) 

        

Access memos X X     

Create cost 
memos 

X X     

Hold memos X X     

Create quantity 
memos 
Create memos for 
other stores (Pro) 

X 
  
X 

X 
  
X 

    

Area/right Owner Manager AsstMgr Associate 

Adjustment 
History 

        

Access adjustment 
history 

X X     
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Reverse memo X X     

Copy memo X X     

Edit memo X X     

Return to top         

Area/right Owner Manager AsstMgr Associate 

Customers 
(Basic) 

        

Add customers X X X X 

Edit customers X X X X 

Delete customer X X X   

Edit customer 
discount or price 
level 

X X X   

Change "Use with 
QuickBooks" 
setting 

X X X   

Change "Accept 
Checks" setting 

X X X   

Add customer type X X X   

Change charge 
account settings 

X X X   

View customer 
ratings 

X X X   

View account 
information 

X X X X 

Return to top         

Area/right Owner Manager AsstMgr Associate 

Rewards (Pro)         

Access Reward 
Manager 

X X     

Manually issue or 
remove rewards 

X X X   

View and redeem 
rewards 

X X X X 

Return to top         

Area/right Owner Manager AsstMgr Associate 

Sales Orders and 
Layaways (Pro) 

        

Access X X X X 

Copy orders X X X X 

Delete orders X X X   

Refund deposits X X X   

Edit item prices X X X   

Edit item 
descriptions 

X X X   
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Generate 
purchase order 
from 

X X X   

Apply coupons X X X X 

Return to top         

Area/right Owner Manager AsstMgr Associate 

Work Orders 
(Pro) 

        

Access X X X X 

Copy orders X X X X 

Delete orders X X X   

Edit item 
descriptions 

X X X   

Edit item prices X X X X 

Refund deposits X X X   

Generate PO from X X X   

Apply coupons X X X X 

Return to top         

Area/Right Owner Manager AsstMgr Associate 

Time Tracking 
(Pro) 

        

Manage clocked-in 
employees 

X X     

Access Time 
Clock History 

X X     

Add/Copy Time 
Clock entries 

X X     

Edit Time Clock 
entries 

X X     

Delete Time Clock 
entries 

X X     

Area/right Owner Manager AsstMgr Associate 

Stores (Pro)         

Access Store 
Exchange Center 
Store Exchange, 
receive files 
Store Exchange, 
send files 

X 
  
X 
  
X 

X 
  
X 
  
X 

X 
  
X 
  
X 

  

Return to top         

  
Related Topics 
Turn security on/off 
Add a custom security group 
Employees & security overview 
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Add a New Security Group 
Copy a Security Group | View or Edit Group Rights 
  
You are not limited to the predefined security groups. You can create new security groups with your preferred 
security rights, and then assign them to your employees. 

To add a new security group: 
1. From the Employees menu, select Security. 
2. Select New Group from the window toolbar. 
3. In the New Group dialog, enter a unique name for the group and select OK. 
4. The new group is created and added as a new column to the Security window. The group initially has no 

security rights. 
5. Edit the security rights of the new group, granting rights as needed. 
6. Select Save. 
7. Assign the new group to employees, using the procedures described in the Viewing or Editing an 

Employee Record topic. 
  

Multi-Store Note: Security settings are not shared among stores; each store can create security groups as needed to control 
access on a local level. 

  
Related Topics 
Delete a security group 

View or Edit a Security Group 
How do I? | Add a Security Group | Copy a Security Group 

Working with Employees 
Add an employee 
View/edit an employee record 
Delete an employee record 
Print or export my employee list 
Track employee hours worked 
Track sales commissions 

Working with Security 
Turn security on/off (require logins) 
Log In or out 
Change my password 
Track employees without requiring logins 
Create a new security group 
Delete a security group 

  
  
With adequate security rights to do so, you can view and edit the security rights assigned to any of your security 
groups or add a new group with the rights needed. If employees assigned to a group you are editing are currently 
working in Point of Sale, their revised rights won't go into effect for them until they log out and then back in. 

To view or edit a security group: 
1. From the Employees menu, select Security. (Or, from the Employee list, select View/Edit 
Security Rights from the I Want To menu.) 
2. Select or clear checkboxes for specific rights in the columns for any of your security groups. 

• Use the View drop-down to limit the displayed rights to a single area of the program or choose All 
Security Rights to view them all. 

• Use the Find field at the top of the window to search for a specific right by keyword. To narrow 
your search, select a program area from the View drop-down list first. 

• Select Revert Default Groups at the bottom of the window to reset all rights of the four 
predefined groups back to the default settings. 
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• Select Print to print a report of the assigned security rights by group. 

• Options to rename or delete a group are available from the I Want To menu. 
3. Select Save. 

  

Notes: 
• If you can't find a security right in the program area you are expecting it, try selecting General, POS, or All 
Security Rights from the View drop-down list and then searching for it. 

  
Related Topics 
Default rights for predefined groups 
Employees & security overview 

Delete a Security Group 
Add a Custom Security Group | Employees & Security Overview 
  
You can only delete your custom security groups. 

1. From the Employees menu, select Security. 
2. From the I Want To menu, select Delete Group. 
3. In the Delete Security roup dialog, select the group you wish to delete from the drop-down list. In 
the second drop-down, specify the group to which the employees from the deleted group should be 
assigned. 
4. Click Delete. 
5. If prompted, select Yes to confirm the deletion. 

  
Related Topics 
Security rights for predefined groups 

Employee Time Clock 

Track Employee Hours Worked 
Employee & Security Overview | Clock In/Out 

Pro 
Point of Sale's Time Clock provides a way to track employee hours worked. Employees clock in and out to begin 
and end their work shifts. Associated tools and reports are available for managers to review and edit time clock 
records when needed. If you are integrated with QuickBooks Financial Software 2008 - 2011*, Time Clock entries 
can be sent to your financial software to use in preparing your payroll. 
The Time Clock feature is turned on by selecting I want to track employee hours on the General page of 
company preferences. Time Clock tasks are then available from the Employees menu. 
In a multi-store configuration, time records are sent from remote stores to Headquarters and Headquarters can add 
or edit Time Clock entries for any store. 
  
* If you are on an earlier version of QuickBooks Financial Software, your time entries are not sent. However, the 
Time Clock Weekly Summary report in Point of Sale is formatted the same as the employee Weekly Timesheet 
available in QuickBooks, allowing you to quickly transpose your time worked information for payroll processing. 

Select a topic to learn more: 
Correct a time entry 
Manage clocked-in employees 
Time Clock history 
Time Clock reports 
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Security rights for time tracking 
Send time records to QuickBooks for payroll 

Clock In/Out 
Log In/Out of Point of Sale | Change your Password 

Pro 

Note: The availability of Time Clock is controlled by your Features to Use preference settings and employees must be set up as 
hourly employees. Learn more 

  
Hourly-wage employees should clock in and out to begin and end their work shift. 

To clock in or out: 
1. At the home page, select Clock In/Out from the Employees menu. 
2. Select your user name from the drop-down list. 
3. Enter your password (if required). 
4. Select Clock In or Clock Out, as appropriate. 

  

Notes: 
• If the Hourly checkbox is selected on the employee record, the employee will be prompted to clock in when 

logging in to Point of Sale. Answering Yes clocks you in without having to open the Clock In/Out window. 

• When requiring logins, clocking in/out is independent of logging in/out (other than as covered in Note 1). The 
ability of an employee to clock in/out is not affected by who is currently logged in. 

• An employee stays clocked in until clocked out, even if Point of Sale or the computer is shut down. 
Related Topics 
Add a new time entry 
Manage clocked-in employees 
Employees & security overview 

Add a New Time Entry 
Manage Clocked-in Employees | Time Clock History | Time Clock Reports 
  

Pro 
If you have sufficient security rights, you can add new entries to your Time Clock history. This is handy if an 
employee forgets to clock in for his shift. 

To add a Time Clock entry: 
1. At the Home Page, select New Employee Time Entry from the Employees menu. 

OR 
From your Time Clock History list, select New Entry. 

2. Enter the employee name, Store number (if applicable), and clock in/out dates and times as 
applicable. 

If making an entry in the Elapsed Time field, use the format hh:mm (Example: 04:30 for 4.5 hours) 
3. Select Save. 

  

Notes: 
• You can enter the clock in time and elapsed time and Point of Sale will calculate and enter the clock out 
time accordingly. 
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• If you enter an elapsed time with no entries in the date and time fields, Point of Sale will automatically 
assign clock in/out dates and times starting with the present time. 

Related Topics 
Correct a time entry 
Clock in/out 
Employees & security overview 

Correct a Time Clock Entry 
Add a New Time Entry | Time Clock History | Time Clock Reports 

Pro 
If you have sufficient security rights, you can edit the entries in your Time Clock history until they have been sent to 
your QuickBooks financial software. 
Multi-store Exception: Time clock entries can be edited at a remote store only until they have been sent to 
Headquarters.   

To edit a Time Clock entry: 
1. Display your Time Clock history if necessary (select from the Employees menu). 
2. Use normal list procedures to locate and select the entry that needs correcting. 
3. Select Edit Entry from the window toolbar. 
4. Make changes as necessary and then select Save. 

  

Notes: 
• If you edit date or time fields, the Elapsed time will automatically update. 

• If you edit the elapsed time, the Clock Out date/time will automatically update. 
Related Topics 
Send Time Clock records to QuickBooks for payroll 
Clock in/out 
Employees & security overview 

Manage Clocked-in Employees 
Add New Time Entry | Time Clock History | Time Clock Reports 

Pro 
The Manage Clocked-in Employees window displays the name, clock in time, and elapsed time for each 
employee that is currently clocked in. The  window allows an employee with adequate rights to view and, if 
necessary, clock out and adjust the time worked. This may become necessary if an employee has forgotten to 
clock out when leaving. 

To view employees currently clocked-in: 
1. From the Employees menu, select Manage Clocked-In Employees. 
The window is displayed with clocked-in employees listed. 
2. Select an employee name from the list. 
3. If necessary, select Clock Out. 

You are asked if you want to modify the hours for this employee. Answer Yes or No. If yes, the time entry is 
opened in Time Clock history for editing. 

  
Related Topics 
Correct a time entry 
Clock in/out 
Employees & security overview 
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Time Clock History 
Correct a Time Entry | Time Clock Reports 

Pro 
Your Time Clock history is very similar to other lists in Point of Sale. It displays a listing of Time Clock entries for 
your hourly employees for a specified time period. Each entry in history is comprised of one clock in/clock out 
sequence. 

What's important about Time Clock history? 

• Both "open" and closed entries are displayed. An open entry is one where an employee has clocked in but 
has not yet clocked out; therefore the Clock Out and Elapsed time fields are empty. 

• Open entries are reflected on Time Clock reports, but in a multi-store setup are not sent to Headquarters 
during End of Day exchanges. 

• Time entries can be viewed, edited, copied, or deleted, and new entries can be made (subject to security 
rights). 

• When filtering the list by the default date ranges (Today, Yesterday, etc.), records are displayed based on 
the clock-in date. To see records based on other criteria, set up a custom filter or choose to display all 
entries. 

• With the list collapsed (Select Collapse at the top if necessary), the selected employee's time clock detail 
is displayed on the bottom of the right-side information panel. 

• You can quickly run one of the Time Clock reports by selecting it from the I Want To menu. 

• If sending time records to your QuickBooks financial software, once sent they can no longer be edited in 
Point of Sale. Learn more about sending time records to QuickBooks. 

Related Topics 
Manage clocked-in employees 
Clock in/out 
Employees & security overview 

Time Clock Reports 
Time Clock Overview | Time Clock History | Reports Overview 

Pro 
There are three Time Clock reports available. 

• Time Clock Summary —Summarizes total hours clocked-in by employee for the selected time period. 

• Time Clock Detail—A more detailed listing of employee hours, including clock in/out dates and times. 

• Weekly Time Sheet—Day-by-day employee hours for a full week. Starting day of the week can be 
changed to meet your payroll model. This report is formatted similarly to the Weekly Timesheet in your 
QuickBooks financial software. 

These reports are available from: 
• the Employees category of the Reports menu or Report Center, or 
• From the I Want To menu in your Time Clock History list 

Related Topics 
Manage clocked-in employees 
Send time records to QuickBooks financial software for payroll 
Employees & security overview 
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Import/Export Data 

Office Integration 
  
Point of Sale supports data import/export with Microsoft Excel, letter writing with Microsoft Word, e-mailing of 
documents via your default Windows e-mail client, and creation of targeted customer lists for use in e-mail 
marketing campaigns. 
  
Click a link below for more information on a specific feature. 

You can: 

• Import or export your Point of Sale list data with Excel 

• Export reports to Excel 

• Write letters to customers or vendors with Word using Point of Sale templates and your company file 
information 

• E-mail Point of Sale documents to vendors or customers 

• Create targeted customer lists for use in e-mail marketing campaigns and export them to Excel or send 
them directly to an integrated marketing partner 

The use of Excel and Word features requires that you have a supported version of Excel and/or Word installed on 
the workstation performing the task. Refer to the system requirements in the Point of Sale User Guide (launches 
PDF version). 

Import Non-QuickBooks Data 

Data Import Wizard Overview 
Data Import Instructions | Tips | Data Export Wizard 
  

Note: This topic may refer to data types not applicable to your Point of Sale installation. For example, Point of Sale Free users 
cannot import customer, vendor, or item quantity information and Basic users cannot import item pictures. 

  
When you first begin using QuickBooks Point of Sale, you may already have existing customer, vendor, and/or item 
information in another application (other than QuickBooks financial software). Or, you may receive data from an 
outside source that you wish to enter into the program periodically, such as from your vendors. 
The Data Import Wizard is designed to spare you the time-consuming task of having to manually enter large 
amounts of existing data into Point of Sale, such as items, item pictures, customers and vendors, allowing you to 
import this data instead. This tool is particularly useful for: 

• New users of Point of Sale who want to import data from another software application. The other software 
application must be able to export the data into an Excel spreadsheet or comma-delimited text file (.csv). 

• Existing users of Point of Sale who want to import data provided by vendors, such as catalog information 
or new pricing for new or existing inventory items 

You can import data from: 

• An Excel spreadsheet by copying and pasting into a predefined template we have supplied for you 

• A custom Excel spreadsheet in another format (generated by another program, from a vendor, or that you 
have created) 

• A comma-delimited text file (file extension must be .csv) 

• (Pro) A folder of picture files; on your computer or on a CD, DVD or other media. Special considerations 
apply to picture imports; click here to learn more. 

Information from any of the above sources is mapped into the correct data fields in Point of Sale. If the imported 
data affects your inventory value (item cost or quantity), Point of Sale creates adjustment memos with an entry in 
the Source field of Import. 
View the complete instructions for using the wizard to import your data or select Help on each page of the wizard 
for additional information about the choices on that page. 
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Notes: 
(Basic, Pro) The Data Import option can be accessed from the File  Utilities menu on the Server Workstation 
only. 
(Pro) In a multi-store configuration, remote stores can import only customers. 
  

Tips for Using the Data Import Wizard 
Data Import Wizard Overview | Import Instructions 
  

Note: This topic may refer to data types not applicable to your Point of Sale installation. For example, Point of Sale Free users 
cannot import customer, vendor, or item quantity information and Basic users cannot import item pictures. 

  
The following are useful tips, and answers to frequently asked questions, regarding the Data Import Wizard: 

• Check your import template to ensure required fields are filled (denoted on the default template and in the 
custom mappings page of the wizard). 

• Save and close the import template before beginning the import. 

• Do not enter monetary symbols ($) in currency fields or change the format of the fields. These things will 
cause the import to fail. 

• If doing your first or a very large import, you may find it helpful to create a new company data file and 
import to that file to test before importing into your real company file. It is also strongly recommended you 
make a backup of your company data before an import (the wizard will give you the chance to do so). 

• If the template file you are using has been provided by a vendor or outputted from another application, the 
field names (columns) may not match the Point of Sale field names. You will have to do one of these things in 
this case: 

• Rename the fields/columns in your custom template to match those in Point of Sale (look at the 
default template for the data you are importing and match the names exactly). 

• Copy and paste the information from the custom file into the default template provided with Point 
of Sale. 

• Create a custom import mapping, this tells Point of Sale how to match up the field names. If you 
import frequently from the same file format, such as from a vendor catalog, save the mapping file and 
associate it with the vendor for reuse. 

• Refer to the documentation in other applications for directions on how to export data to a file. Choose an 
Excel option or a comma delimited text file (.csv extension). 

• Because different programs often store data differently, review the data before importing to make sure it is 
in the correct format for Point of Sale. For example, your previous software may have stored full customer 
names in one field. Point of Sale stores customers’ first and last names separately in different fields. Edit the 
data as necessary in the import file so that it is in the correct format. If using Point of Sale's default template 
you can get additional information about each field by placing your cursor on the red triangle in the upper-
right corner of the applicable column heading. 

• If an imported item contains the same department, vendor, item name, attribute, and size as an existing 
item in Point of Sale, then the item will be imported with a number appended to the end of the Item Name 
field (e.g. "Hammer" and "Hammer1"). 

• If you use the default template file more than once to import data, make sure to clear any old data before 
entering new data and importing again. Otherwise, you may create duplicate records in Point of Sale. 

• If you need to change a value for a large number of records, consider exporting the records to Excel, doing 
a global find and replace to update the value in Excel, and then re-importing. This procedure can be used to 
change the department name for a large group of items for example. 

• (Pro) If you have enabled the multiple unit of measure feature, individual fields for each unit (UPC, 
alternate lookup, price, etc.) are added to the custom file mappings options. 
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• (Pro) You can enter on-hand quantities for all of your stores on the template at one time, saving time and 
effort. 

Return to top 

Import from a Vendor Catalog 
Data Import Wizard 
  
If a vendor provides a catalog of items, you can use the Data Import Wizard to import or update your inventory 
items with that information. Once your import template mappings are set up for the vendor, they are remembered 
and automatically used for subsequent imports from the same vendor. 

What's important about this capability? 

• The vendor catalog must be provided in Excel format. 

• On the first import you tell Point of Sale how to map the vendor's item field names to the Point of Sale item 
fields, and also the sheet and starting row in the file for the imported data. Point of Sale will then remember 
this information for future imports. 

• You can initiate an import from the vendor's catalog from the I Want To menus in your vendor list or your 
item list. 

To do the initial import from a vendor catalog: 
1. From the File > Utilities menu, select Import Data. 

OR 
From the I Want To menu on the vendor record, select Import items from this vendor's catalog. 

2. In the Data Import Wizard, select Inventory Items as the data type and then Vendor Catalog as 
the file type. If starting in the Wizard, specify the vendor name when prompted. 
3. Browse to the catalog Excel file, and then enter the sheet, starting row, and mappings, how 
you wish duplicates to be handled, and a department name. Use the help links on the Data Import 
Wizard if you need assistance. 
4. Follow the prompts to review and then complete the import. 

  

Notes: 
On subsequent imports from this vendor, assuming the catalog file is in the same format, you simply tell Point of 
Sale the vendor's name and where the file is located. The rest of the import mapping information is assumed to be 
the same as the initial import and happens automatically. 
  

Import or Export Item Pictures 
Use Item Pictures 

Pro 
If you are using item pictures, you can import and associate pictures for multiple items at once instead of assigning 
them one-by-one on item records. Likewise, you may have need to export the item pictures you have in Point of 
Sale for some other use. The Data Import Wizard and Data Export Wizards in Point of Sale make these tasks easy. 
In a multi-store configuration, if you want to send item pictures from Headquarters to remote stores, you can do it in 
a Store Exchange file instead Learn more 

What do you want help with? 
Import Item Pictures 
Export Item Pictures 
  

Importing Item Pictures 
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In the import process, Point of Sales associates pictures to items by matching the file names of the pictures to 
specific item information. The file names of the pictures to be imported must match one of the item information field 
or fields listed below, as well as meeting other formatting requirements. Point of Sale can then automatically 
associate the imported pictures to your existing items. 
Example picture file names  

Imported picture files must be named to match one of the following item information field formats: 

• Item Name_Attribute_Size (if using styles, lets you associate a different picture with each style item) 

• Item Name (if using styles, associates the same picture(s) with all style items) 

• UPC 

• Alternate Lookup 

• Item Number 

Example: To import a picture for this item... 

 

The filename could be any of the following: 
sweatpants_red_sml.jpg 
sweatpants.jpg 
109.jpg 
ad142558s.jpg 
1234567891234.jpg 

This example assumes a JPG file format. Other formats (extensions) that can be imported include BMP, GIF, 
and TIF. 
Filenames for importing are not case-sensitive. Either upper or lower-case filenames can be used. 
If importing both default and alternate pictures at the same time, add _def or _1 and _alt or _2 to each filename, 
like this: 
Default Picture:     sweatpants_red_sml_def.jpg 
Alternate Picture:  sweatpants_red_sml_alt.jpg 
  
If you export item pictures, the exported files will be named in one of the same formats (your choice). 

  
Picture file formats and attributes  

You can assign or import pictures in JPG, GIF, BMP and TIF formats. However, Point of Sale converts and 
stores all pictures in the JPG format. 
The maximum picture size is 500 pixels by 500 pixels. If you attempt to add a picture larger than this, Point of 
Sale will resize it to this dimension. Since these pictures are intended for viewing on your computer monitor, the 
recommended resolution is 72 dpi. Higher resolutions will increase file sizes, which in turn increases disk space 
and loading time. 
Picture file information is preserved when the picture is brought into Point of Sale. Additionally, information for 
the picture name, size, and last edit date is also saved. 
Tip: Many graphics programs will batch process images to the specific sizes, resolution and format required. 
Check the documentation of graphics programs you have available to you to see if they are capable of doing 
his time-saving work. 

  

To import item pictures: 
1. From the File menu, select Utilities > Import and select Item Pictures as the data type. 
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2. Specify the location of the picture files and which item information fields have been used to name 
the picture files (see example filenames above) and then select Next. 
3. Specify if you are importing default item pictures only, alternate pictures only, or both default and 
alternate pictures and select Next. 

• If you are importing both default and alternate pictures at the same time, you must include _def or 
_1 at the end of the filename for the default pictures, and _alt or _2 at the end of the filename for the 
alternate pictures. See example filenames above. 

4. Specify what Point of Sale should do if an item already has a picture associated with it (replace existing, 
keep existing, or prompt you for decision) and select Next. 

• A summary of the pictures found at the specified location is displayed for your review before the 
import is started. If pictures cannot be matched to items, an alert and list of the files is displayed. Review 
the file list and rename the affected picture files in one of the filename formats listed above. 
5. When ready to proceed, select Import. Point of Sale confirms the import was completed. 
6. Select Finish. 

  
Return to top 
  

Exporting Item Pictures 
There are two methods of exporting item pictures from Point of Sale. In both instances, pictures are only exported 
in JPG format. If the location to which you are exporting the picture(s) contains a file with the same name as that 
being exported, Point of Sale will prompt you to overwrite or keep the existing picture file. 

To export individual pictures by dragging-and-dropping: 
1. Arrange your desktop so that you have both the destination location (Windows Explorer window) 
and the Item Pictures section of the item record (or the Inventory Picture Album) visible on your screen 
side-by-side. 
2. Click the picture in Point of Sale with your left mouse button and hold down the button. 
3. Drag your mouse pointer to the location you wish the to export the file and release the mouse 
button. 

A copy of the picture is created in the destination folder. 

To export multiple pictures: 
You can export a number of pictures at once using the Data Export Wizard. Exporting item pictures differs from 
other data exports in that a separate file is created for each item picture being exported in a folder or location you 
specify. 

1. From the Point of Sale File menu, select Utilities > Export (this option is best to export all item 
pictures, or to export by department, vendor, or style). The Data Export Wizard opens. 

Or 
From your item list or Picture Album, select the items whose pictures you wish to export, and then from the I 
Want To menu, choose Export > Export Item Pictures for Selected Items. (Skip to Step 4.) 

2. Select Item Pictures as the type of data to export, and then follow the on-screen instructions to 
specify for which items pictures will be exported. 
3. Indicate the destination folder for the exported pictures, how you wish the exported files to be 
named (see examples under import above), and whether you wish to export the default, alternate or 
thumbnail picture, or all three, for the items. 
4. Select Export to copy the pictures to the destination location. 
5. Select Open if you wish to view the contents of the destination folder, or select Finish to exit. 

Back to top 
  

Notes: 
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• It is assumed you are using the default item label of Item Name; if not adjust the above to reflect your 
custom item label. Note: For upgraders from a previous version, this label may be Description 1. 

• If using item name, or name with size and attribute, to create filenames, any slashes (/) included in these 
fields (such as a size of "1/2") are converted to the tilde character (~) upon export and then converted back to 
slashes when imported at the destination. This is because the slash cannot be used in a filename. 

Related Topics 
Data Import Wizard 
Data Export Wizard 

Importing Print Templates 
Specifying Templates in Preferences 
From time to time it may be necessary to get updated print templates to meet legal requirements for printed 
documents in your area or to more effectively reflect your business practices. Only Pro-level users of Point of Sale 
can create their own custom templates, but all users may at times have access to updated templates through 
QuickBooks Point of Sale Pro Advisors, Retail Service Providers, or Intuit technical support. This option allows you 
to import those templates into Point of Sale. 

To import print templates: 
1. Obtain and save the print template file to your computer. Print template files end in the .xml file 
extension. 
2. From the File menu, select Utilities > Import Print Templates. 
3. Select Import on the message displayed. 
4. Browse to the template file in the Import Document Templates window and select Open. 
5. Select the new template(s) in your workstation Documents & Printers preferences. 

  
Related Topics 
Printing Overview 

Data Import Log 
Data Import Wizard Overview | Tips 
  
The Data Import Log provides a way for you to review the results of an import operation and to identify errors and 
records that were not imported. 

To use the log: 
1. Select Utilities  View Data Import Log from the File menu (also available from the Complete 
screen of the Data Import Wizard). 
2. Select a date, and optionally time, from the Available Logs column on the left. You have the 
following options in the log: 

• The information for the selected import is shown in the window. Select Show Errors Only at the 
top of the window to make it easier to identify where errors occurred. 

• Click a hyperlink in an entry, if available, to take you to the corresponding program area where 
you can review the record in question. 

• Select Print from the bottom of the window to print the log. 
3. When done, select Close. 

  
If you used the default template, it is recommended that you also review the template (Filename: QB POS vn 
Import Template.xls in your C:\Documents and Settings\All Users\Documents\Intuit\QuickBooks Point of Sale n.0 
folder, where n = version number) to ensure that data was imported correctly. You may see the following flags on 
the inventory sheet of the template file, depending on the item import option you chose prior to importing: 
  

XL Dup column If the item is duplicated within 
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  the QB POS vn Import 
Template.xls file itself, the row 
number of the duplicate item is 
written in this column. 
  

In QBPOS column If the item is a duplicate of an 
item already in Point of Sale, 
then QBPOS is written in this 
column. 

Import from QuickBooks Financial Software 

Import QuickBooks Items 
Overview | Customize Financial Exchange | FAQs 
  
(Pro) This option is available at Headquarters only. 
You may have existing items in QuickBooks that you now want to track in Point of Sale. You can easily import 
these items to Point of Sale at any time, making them available to list on Point of Sale documents. Importing your 
QuickBooks items is optional. After importing, inventory items are not routinely exchanged between the two 
programs. The imported items should be tracked only in Point of Sale after import. 
After the two programs are integrated, you will be prompted to import your QuickBooks items each time you open 
your item list in Point of Sale until you elect to import or indicate that you do not want to import. Choose Ask Me 
again Later if you plan to import, but are not ready to do at this time. 

To manually initiate an import of your QuickBooks items: 
1. Make sure your QuickBooks financial software is running and in single-user mode. 
2. Select Import QuickBooks Items from the Financial menu or from the Advanced Options page 
of the Financial Center. 

  

More Information about Importing QuickBooks Items 
What are the benefits of importing my QuickBooks Items? 
Are there reasons I may not want to import my QuickBooks Items? 
Can I import QuickBooks items later? 
Can I import some items and not others? 
Can I control how my imported inventory items are described in Point of Sale? 
  

Notes: 
• Importing of items from QuickBooks can be done multiple times. This can be helpful if you import only 
selected items the first time and later want to import the others, want to import from multiple QuickBooks 
company files, or have added new items to QuickBooks after the initial import. Be careful not to import the 
same items a second time or duplicate item records will be created in Point of Sale. 

• Once imported, the imported items should no longer be tracked in QuickBooks. It is strongly recommended 
that all purchasing, receiving, and selling of these items be done in Point of Sale only. 

• The on-hand quantity of imported items is set to zero (0) in QuickBooks and a compensating General 
Journal transaction is created to debit the Inventory Asset account. On the Point of Sale side, inventory 
adjustment memos are created to record the addition of the items to inventory. The memos are sent to 
QuickBooks, balancing against the General Journal transaction so that no net change in inventory value 
occurs. 

• Imported items should be reviewed and edited to take advantage of the inventory tracking and control 
features in Point of Sale. 

• If you have existing items (and customers and vendors) in an application other than QuickBooks financial 
software, you may be able to import this data using the Data Import Wizard. 



Printed Documentation 

466 

Related Topics 
Financial Exchange overview 
Troubleshoot Financial Exchange 

Can I control how my imported items are described in Point of Sale? 
Financial Exchange Overview | Customizing Exchanges | FAQs 
  
During the import process, you can specify how the QuickBooks item descriptive fields are populated to the Point of 
Sale item descriptive fields. 
  

QuickBooks item 
descriptive fields 

Can be populated to one of these Point 
of Sale fields… 

Sales Description Item Name (printed on sales receipts) or 
Description 2 

Purchase Description Item Name or Item Description 

Item Name/Number Alternate Lookup 

  

Note: In Point of Sale, the names of the Item Name and Item Description fields can be renamed to better meet your needs, Pro-
level users can also  customize printed documents to include the fields you wish. 

Benefits of Importing QuickBooks Items 
Financial Exchange Overview | Customizing Exchanges | FAQs 

Benefits of Importing your QuickBooks Items 

• Saves time: There is no need for you to manually re-enter your QuickBooks financial software item 
information in Point of Sale. Your imported items are immediately available for use in Point of Sale. 

• Efficiency: Consolidating items in Point of Sale program results in more efficient purchasing and inventory 
control and more meaningful reporting. 

• Fewer data-entry errors: Less manual data entry means a lower likelihood of data entry errors. 

Select Items to Import from QuickBooks 
Financial Exchange Overview | Customize Financial Exchange | FAQs   
  
You can import all or just selected items from your QuickBooks financial software. 
Why would I import only selected items? 

To select specific items to import: 
1. Answer Yes when asked if you want to import selected items. 
2. In the Select Items to Import dialog, make sure the checkbox in the Import column is selected for all items 

you want to import and cleared (not checked) for all items you do not want to import. 

• By default, all items are selected. You can use the Select All or Clear All buttons to select or 
clear all checkboxes at once. 

• An easy way to select/clear checkboxes is to place the focus in the Import column, then arrow up 
or down through the list, pressing <Spacebar> to select/clear the checkboxes. 

• To locate a particular item, sort by the column containing the information by which you want to 
search. Do this by clicking the  icon in the column header. Then type in the Search field to automatically 
be taken to matching records. For example, to locate an item with a sales description of "Cabinet Fixture," 
sort by the Sales Description column and type "cabinet" in the Search field. 

• To view a group of items that share common information, select Filter View. For example, if you 
wish to view all of your service items, you could filter by the Item Type of Service. 
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• Filtering or sorting may reduce the number of items displayed in the Select Items to Import dialog. 
However, all items that have the Import checkbox selected will be imported, whether or not they are 
currently displayed on screen. Cancel the filtered view or sort by a column with an entry for all items to 
display all of your items again. 

3. Select OK when finished to begin item import. 
  
Related Topics 
Import QuickBooks items 
Review imported records 

Financial Exchange: Review Imported Items 
Exchange Overview | Customize Exchanges | FAQs 
  
QuickBooks items of the following types can be imported and are assigned the Point of Sale item types shown 
below. 
  

QuickBooks Item Type Point of Sale Item Type 

Inventory Part Inventory 

Non-Inventory Part Non-Inventory 

Other Charge Non-Inventory 

Service Service 

Assembly Assembly  (Pro) 

Group Group (Pro) 

Imported items should be reviewed and edited as needed to take advantage of Point of Sale inventory features. 
Pay particular attention to reviewing the following fields in the imported item records: 
  

QBPOS Field Description 

Item Type Review item types to ensure your items 
are properly categorized. 

Department All imported items are assigned to the 
default department QuickBooks Financial 
Software. See the discussion about 
departments and edit them as needed to 
improve reporting by department. 

Attribute Use this field to describe your items by 
color, a second size, a pattern, or any 
other product trait. This field name can be 
customized. 

Size Use this field to enter item size to facilitate 
purchasing and reporting. This field name 
can be customized and used for product 
attributes other than size. 

Price Levels The item price from QuickBooks is placed 
in the Regular Price field for imported 
items. Prices at other price levels, if used, 
are not calculated for imported items. 
Manually assign prices or markdown 
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percentages for each price level on the 
item record, as desired. 

UPC Codes Scan or enter UPC codes, as applicable, if 
you want to list items on receipts by 
scanning vendor-printed tags. 

QuickBooks 
Information 

Review and edit the QuickBooks item 
accounts (COGS, Income, and Inventory 
Asset) used when posting item sales to 
QuickBooks. 

Custom Fields 
(Pro) 
 
 
Style Definitions 
(Pro) 

Data from custom fields is exchanged, 
providing the fields are named exactly the 
same in both programs. 
To use the style features, inventory items 
grouped into a style must be modified so 
that all members of a particular style have 
identical Department and Item Name 
fields. 

Other Item Fields Review and edit other Point of Sale item 
fields to take advantage of features 
important to your business. 

Return to top 
  
Related Topics 
Inventory overview 
Review your Point of Sale setup for Financial Exchange 

Financial Exchange: Review Imported Customers 
Exchange Overview | Customers Overview 

Basic  

The Use with QuickBooks checkbox determines whether information for a particular customer is shared with 
QuickBooks during daily updates. Select or clear this checkbox as appropriate for your imported customers. 
In addition, when you add a new customer in Point of Sale and want this customer's;s information sent to 
QuickBooks financial software, make sure the checkbox is selected. 
It is recommended that you review and edit customer records that have been imported from QuickBooks to take 
advantage of additional Point of Sale customer features. 

• Custom Fields – (Pro) Data from custom fields is exchanged, providing the fields are named exactly the 
same in both programs. 

  

Note: You can specify to have the Use with QuickBooks checkbox selected or cleared by default for all new customers in 
company preferences. If you’d like to ensure that all new customers are shared with QuickBooks financial software, make sure 
the preference option is set to Yes. 

  
Related Topics 
Review your Point of Sale setup for Financial Exchange 
How QuickBooks financial software handles POS data 
Send detailed item and customer information to QuickBooks 

Financial Exchange: Review Imported Vendors 
Exchange Overview | Customize Exchanges | FAQs 

Basic  
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Non-merchandise vendors, such as utility companies and the agencies to which you pay sales tax, are stored in the 
vendor list in QuickBooks. As such, these agencies may have been imported to Point of Sale as vendors. 
Do not delete these vendors in Point of Sale. If you prefer not to see these vendors in your vendor list, select the 
Inactive checkbox on the vendor records and filter the vendor list to show only active vendors. You may also want 
to enter or edit other imported vendor information: 

• Vendor Website addresses for one-click access (requires Internet connection) 

• Ensure the vendor account number and payment terms are what you want applied to purchase 
orders and receiving vouchers created in Point of Sale 

• (Pro) Data from custom fields is shared, providing the custom fields are named exactly the same 
in both programs. 

Related Topics 
Vendor overview 
Review your Point of Sale setup for Financial Exchange 
How QuickBooks financial software handles POS data 

Financial Exchange: Review Purchase Orders 
Exchange Overview | Customize Exchanges | FAQs 

Basic  

Purchase orders are not imported from QuickBooks. If you wish, you can manually enter existing QuickBooks 
purchase orders into Point of Sale. Doing so will allow coordinated tracking of purchases, better reporting 
capabilities, and the ability to create receiving vouchers from these POs when the merchandise arrives. 
If you recreate QuickBooks purchase orders in Point of Sale, they should be canceled or deleted from QuickBooks 
as they are now tracked in Point of Sale. 
Note: If you have items you did not import and do not plan to use in Point of Sale, you should perform all activities 
regarding these items—purchasing, receiving, reporting—in QuickBooks financial software. 
  
Related Topics 
Purchasing overview 
Review your Point of Sale setup for Financial Exchange 

Export Data 

Export Reports to Excel® 
Reports Overview | Run a Report | Export List Data 
  
You can export report data to Microsoft Excel, allowing you to further manipulate the data in that program. 

Note: For this option to be available, a full licensed version of Excel must be installed on the workstation running the report. 

To export a report: 
1. Run the report normally, using the modify report option to select the columns and filter the data to 
be included in the export. 
2. With the report displayed, select Excel from the top toolbar. 
 
Once the report is in Excel, you can utilize the many Excel features to manipulate and customize your 
data. Refer to the Excel help system for instructions to: 

• Take advantage of extensive filtering capabilities 

• Combine information from multiple reports 

• Change the order of report columns 

• Add comments 

Export Point of Sale List Data 
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Office Integration Overview | Import Data | Export Reports 
  

Note: This topic may refer to data types not applicable to your Point of Sale installation. For example, Point of Sale Free users 
cannot export customer, vendor, or item quantity/cost information and Basic users cannot export item pictures. 
 
Note: Excel must be installed on the workstation using this option. 

  
The Data Export Wizard walks you through exporting list data to an Excel spreadsheet, where you can then utilize 
Excel's features to further manipulate the data. You can choose to export all records in a list, all records currently 
displayed in a filtered list, or only selected records. 
Export templates determine the data fields included in the export and how that data appears in columns in Excel. A 
default template is provided for each record type. You can customize the default templates or create and save new 
ones to meet your needs. 

What would you like help with? 
Export records directly from a list (customers, vendors, items, departments, employees)  

1. Display the list you wish to export and filter, sort, or select the records you wish to export. 
2. From the I Want To menu, select Export to Excel. The Export Data Wizard is opened. 
3. Specify the records you want to export (selected, entire list, etc.) and select Next. 
4. Select a destination Excel file (.xls format) for the exported data: 

View example screen  

 
Sample Customer Export Screen 

  

  

• Accept the default location and file name, or 

• Enter a location and file name to create a new file, or 

• Browse to an existing custom file that will receive the exported information 
5. Select the worksheet and starting row number in the spreadsheet file that you want to receive 
the data. The column headers will begin on the row you specify. 
6. Select the export template that you wish to use. The default template for the record type is 
suggested. Select Manage Templates to review, edit or create export templates. 
7. Select Next. 
8. Continue following the on-screen prompts to complete the export. 
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Export customers from the Customer Center  (provides additional options for filtering by customer sales history) 

1. On the home page Navigator, click Customer Center. The Customer Center is opened. 
2. In the Reach Out to Your Customers section, click Export list to a file. The Export Wizard is 
opened. Make entries as needed on the following wizard pages. Click Next on each when ready to 
move to the next page. 
3. Select Customers: Select one of the choices on which to filter your customer list. View 
example screen  

 

4.   

• Recent Purchase—Include only customers that have made a purchase in the last x number 
of days (enter x). 

• No Activity—Contact only customers that haven't made a purchase in x number of days 
(enter x). Optionally, you can also elect to include only those customers that have made at least one 
purchase from you anytime. 

• Merchandise Interest—Contact only customers that have made a purchase from a particular 
department or vendor. Click the Select Department/Vendor button to specify which 
department/vendor. Optionally, you may limit the sales period to the last x number of days. 

• Custom—Create list based on filter criteria you enter. 
4. Custom Filter Pages: Displayed only if you selected Custom above. Learn more about using 
filters 

• On the first page,enter filter criteria for information stored in your customer records (city, ZIP 
Code, customer type, reward program members, charge account customers, etc.). 

• On the second page, enter criteria to filter for information contained in your customer sales 
history. 
5. Review Customer List: This page displays the list of customers resulting from your previous 
entries and provides an opportunity to remove customers.  By default, all customers in this proposed 
list are selected for inclusion in the final list ( = selected). Remove customers by clearing their 
checkboxes. Clear/select checkboxes by clicking on them or by using the button options on the right. 
6. Destination File and Export Template: View example screen  
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Sample Customer Export Screen 

  

7.   

• Select a destination Excel file (.xls format) for the exported data: 
 Accept the default location and file name, or 
 Enter a location and file name to create a new file, or 
 Browse to an existing custom file that will receive the exported information 

• Select the worksheet and starting row number in the spreadsheet file that you want to receive 
the data. The column headers will begin on the row you specify. 
 Select the export template that you wish to use. The default template for the record type is 
suggested. Select Manage Templates to review, edit or create export templates. 
7. Select Next and continue following the on-screen prompts to complete the export. 

  

  
Export item pictures 
  

Notes: 
• You can also select Utilities  Export from the File menu without displaying a list first. You can choose to 
export any of your lists or your item pictures.    However, the entire list is always exported with this selection. 

• Excel Worksheet Display Limit  
Related Topics 
Customer Center 
E-mail Marketing from Point of Sale 
Write Letters from Point of Sale 

Import or Export Item Pictures 
Use Item Pictures 

Pro 
If you are using item pictures, you can import and associate pictures for multiple items at once instead of assigning 
them one-by-one on item records. Likewise, you may have need to export the item pictures you have in Point of 
Sale for some other use. The Data Import Wizard and Data Export Wizards in Point of Sale make these tasks easy. 
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In a multi-store configuration, if you want to send item pictures from Headquarters to remote stores, you can do it in 
a Store Exchange file instead Learn more 

What do you want help with? 
Import Item Pictures 
Export Item Pictures 
  

Importing Item Pictures 
In the import process, Point of Sales associates pictures to items by matching the file names of the pictures to 
specific item information. The file names of the pictures to be imported must match one of the item information field 
or fields listed below, as well as meeting other formatting requirements. Point of Sale can then automatically 
associate the imported pictures to your existing items. 
Example picture file names  

Imported picture files must be named to match one of the following item information field formats: 

• Item Name_Attribute_Size (if using styles, lets you associate a different picture with each style item) 

• Item Name (if using styles, associates the same picture(s) with all style items) 

• UPC 

• Alternate Lookup 

• Item Number 

Example: To import a picture for this item... 

 

The filename could be any of the following: 
sweatpants_red_sml.jpg 
sweatpants.jpg 
109.jpg 
ad142558s.jpg 
1234567891234.jpg 

This example assumes a JPG file format. Other formats (extensions) that can be imported include BMP, GIF, 
and TIF. 
Filenames for importing are not case-sensitive. Either upper or lower-case filenames can be used. 
If importing both default and alternate pictures at the same time, add _def or _1 and _alt or _2 to each filename, 
like this: 
Default Picture:     sweatpants_red_sml_def.jpg 
Alternate Picture:  sweatpants_red_sml_alt.jpg 
  
If you export item pictures, the exported files will be named in one of the same formats (your choice). 

  
Picture file formats and attributes  

You can assign or import pictures in JPG, GIF, BMP and TIF formats. However, Point of Sale converts and 
stores all pictures in the JPG format. 
The maximum picture size is 500 pixels by 500 pixels. If you attempt to add a picture larger than this, Point of 
Sale will resize it to this dimension. Since these pictures are intended for viewing on your computer monitor, the 
recommended resolution is 72 dpi. Higher resolutions will increase file sizes, which in turn increases disk space 
and loading time. 
Picture file information is preserved when the picture is brought into Point of Sale. Additionally, information for 
the picture name, size, and last edit date is also saved. 
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Tip: Many graphics programs will batch process images to the specific sizes, resolution and format required. 
Check the documentation of graphics programs you have available to you to see if they are capable of doing 
his time-saving work. 

  

To import item pictures: 
1. From the File menu, select Utilities > Import and select Item Pictures as the data type. 
2. Specify the location of the picture files and which item information fields have been used to name 
the picture files (see example filenames above) and then select Next. 
3. Specify if you are importing default item pictures only, alternate pictures only, or both default and 
alternate pictures and select Next. 

• If you are importing both default and alternate pictures at the same time, you must include _def or 
_1 at the end of the filename for the default pictures, and _alt or _2 at the end of the filename for the 
alternate pictures. See example filenames above. 

4. Specify what Point of Sale should do if an item already has a picture associated with it (replace existing, 
keep existing, or prompt you for decision) and select Next. 

• A summary of the pictures found at the specified location is displayed for your review before the 
import is started. If pictures cannot be matched to items, an alert and list of the files is displayed. Review 
the file list and rename the affected picture files in one of the filename formats listed above. 
5. When ready to proceed, select Import. Point of Sale confirms the import was completed. 
6. Select Finish. 

  
Return to top 
  

Exporting Item Pictures 
There are two methods of exporting item pictures from Point of Sale. In both instances, pictures are only exported 
in JPG format. If the location to which you are exporting the picture(s) contains a file with the same name as that 
being exported, Point of Sale will prompt you to overwrite or keep the existing picture file. 

To export individual pictures by dragging-and-dropping: 
1. Arrange your desktop so that you have both the destination location (Windows Explorer window) 
and the Item Pictures section of the item record (or the Inventory Picture Album) visible on your screen 
side-by-side. 
2. Click the picture in Point of Sale with your left mouse button and hold down the button. 
3. Drag your mouse pointer to the location you wish the to export the file and release the mouse 
button. 

A copy of the picture is created in the destination folder. 

To export multiple pictures: 
You can export a number of pictures at once using the Data Export Wizard. Exporting item pictures differs from 
other data exports in that a separate file is created for each item picture being exported in a folder or location you 
specify. 

1. From the Point of Sale File menu, select Utilities > Export (this option is best to export all item 
pictures, or to export by department, vendor, or style). The Data Export Wizard opens. 

Or 
From your item list or Picture Album, select the items whose pictures you wish to export, and then from the I 
Want To menu, choose Export > Export Item Pictures for Selected Items. (Skip to Step 4.) 

2. Select Item Pictures as the type of data to export, and then follow the on-screen instructions to 
specify for which items pictures will be exported. 
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3. Indicate the destination folder for the exported pictures, how you wish the exported files to be 
named (see examples under import above), and whether you wish to export the default, alternate or 
thumbnail picture, or all three, for the items. 
4. Select Export to copy the pictures to the destination location. 
5. Select Open if you wish to view the contents of the destination folder, or select Finish to exit. 

Back to top 
  

Notes: 
• It is assumed you are using the default item label of Item Name; if not adjust the above to reflect your 
custom item label. Note: For upgraders from a previous version, this label may be Description 1. 

• If using item name, or name with size and attribute, to create filenames, any slashes (/) included in these 
fields (such as a size of "1/2") are converted to the tilde character (~) upon export and then converted back to 
slashes when imported at the destination. This is because the slash cannot be used in a filename. 

Related Topics 
Data Import Wizard 
Data Export Wizard 

Write Letters from Point of Sale 
Manage Letter Templates | Office Integration Overview | FAQs 
  
Point of Sale provides Microsoft Word integration for writing letters to customers and vendors. The letters can 
include data from the customer and vendor records as well as from documents made for the customer or vendor. A 
variety of letter templates is provided for your use. You can customize the provided templates and create more of 
your own. 
Letters can be initiated from the I Want To menu in your customer or vendor list or from your document lists. If you 
want a letter to include data from a document, such as specific item information, the letter must be initiated from 
that document. 
You can create a letter for a single recipient or send letters to a group of selected or filtered recipients. 

To write letters: 
1. Select the record or documents for which you wish to print letters. 

If sending letters to a filtered list, you do not need to select specific records in this step. 
2. From the I Want To menu, select Write Letters  and then choose to Currently Selected or to 
Filtered List. 

If using the filtered list option, follow the prompts to enter filter criteria to include/exclude customers or vendors. 
Learn more. 

3. Select the template you wish to use for the current printing and select Next. 
4. Enter the name and title of the person that the letter will be from and select Next. 

The letter(s) are opened in Word. If you are printing multiple letters they are all in a single Word document with 
each letter starting on a new page. 

5. Review and modify in Word if necessary and then print the letter(s). 
  

Notes: 
• You can select  Modify Template when selecting a template if necessary to customize the template before 
creating the letters. Learn more about modifying templates. 

• If the selected template includes data fields for which no data exists in your Point of Sale records or 
documents, the fields will be auto-filled with **MISSING <data field>**. Review your letter(s) and edit or 
remove these fields to complete the current letter. You can remove the fields from the template if you never 
want them included in future letters. 

• You may save the Microsoft Word document if you wish; doing so will not affect the template. 
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Related Topics 
E-mail Marketing from Point of Sale 

E-mail Marketing with Point of Sale 
E-mail a Document | E-mail FAQs | Office Integration 

Basic  

Unlock the hidden value in your retail data with e-mail marketing to get customers into your store more often and 
getting them to spend more when they do visit. Point of Sale makes it easy to create targeted customer lists to use 
in e-mail marketing campaigns.* 
Highlights of this feature include: 

• Targeted customer lists can be created based on previous sales data and/or on information stored in your 
customer records. The Create an E-mail Campaign wizard walks you through the steps to create the 
customer lists. 

• You can set up an account with the Point of Sale e-mail marketing partner , in which case your customer 
lists are sent automatically from Point of Sale to the partner. 

• If you prefer, you can export the customer list to Microsoft Excel. The Excel file can then be manually 
uploaded to an alternative e-mail marketing provider of your choice. 

• You create, send, and track the actual marketing campaign e-mails through the service provider you have 
selected. 

• Optionally, you can set Point of Sale to prompt your cashiers to e-mail a copy of sales receipts to your 
customers. This is a great way to collect customer e-mail addresses for future use in your e-mail marketing. 
Enable this prompt in workstation preferences. 

• Your customers can "opt out" of receiving marketing e-mails, in which case they will never be included in 
the customer lists you create for marketing. 

*This feature requires an account with a third-party e-mail marketing provider. Terms and conditions, pricing, and 
service options are set by the e-mail marketing provider you choose. 
  
Related Topics 
Customer Center 
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Hardware 

Compatible Hardware 
How do I?  | Hardware Setup Wizard | Troubleshooting 
  
QuickBooks Point of Sale has been designed to work with select industry-leading retail hardware. Although Point of 
Sale may operate with various other hardware peripherals, Intuit does not provide hardware support for hardware 
not sold by Intuit. 
Supported Hardware: Hardware models listed in bold type in the compatible hardware lists are available for 
purchase from Intuit and are supported by Intuit if purchased directly from Intuit. Supported hardware is pre-
configured to work with Point of Sale. The same models purchased from other sources may not be compatible with 
Point of Sale. Intuit does not provide support for hardware not purchased from Intuit.  
Other hardware in the compatible hardware lists is not sold or supported by Intuit. These hardware models have 
been tested and found to be compatible with Point of Sale at the time of testing. Setup information for this hardware 
is provided as a convenience to Point of Sale users, but is not guaranteed or supported. For assistance with 
hardware purchased from other sources, contact the hardware manufacturer or vendor. 

To purchase supported hardware directly from Intuit, call 1-800-926-6066 or visit us online. 
For the most current QuickBooks Point of Sale 2013 hardware drivers and installation instructions, click here.  
  

Important Note: Intuit works closely with the manufacturers of hardware sold by Intuit for use with Point of Sale to ensure these 
devices work together and with the Point of Sale software. Hardware, such as PIN Pads and Physical Inventory Scanners, 
purchased from other sources may not contain the required programming to work with Point of Sale software and/or the 
QuickBooks POS Merchant Service. Intuit does not provide hardware programming, and does not guarantee that devices 
purchased from other third party sources will work with Intuit software. 

View the compatible hardware list for: 
Cash drawers 
Receipt printers 
Tag and label printers 
Card readers 
PIN pads 
Bar code scanners 
Pole (shopper) displays 
Physical inventory scanners 
Touchscreens 
Electronic Scale for Shipping Manager 
  
About connection ports 

Set Up Hardware 
Preference Instructions | Compatible Hardware List 
  
It is strongly recommended that you use the Hardware Setup Wizard to configure your Point of Sale hardware. You 
can access the setup wizard from the File menu and from individual hardware preferences pages. 
  
For the most current QuickBooks Point of Sale 2013 hardware drivers and installation instructions, click here.  

What type of hardware are you setting up? 
Cash drawer 
Modem 
Bar Code Scanner 

http://pointofsale.intuit.com/barcode-inventory-software?lid=left_nav
http://support.quickbooks.intuit.com/support/Articles/HOW12055
http://support.quickbooks.intuit.com/support/Articles/HOW12055
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Card reader (MSR) 
Customer pole display 
Touchscreen monitor 
Physical inventory scanner 
PIN pad 
Printers 
  
Related Topics 
Troubleshoot hardware 
Workstation preferences overview 
Install supported hardware 

Hardware Setup Wizard 
Hardware Drivers  | Compatible Hardware | Troubleshooting 
  
The Hardware Setup Wizard is launched automatically when you configure hardware in the Setup Interview to 
guide you through connecting and configuring hardware to work with Point of Sale. If you add hardware in the 
future, you can manually access the setup wizard from the File menu or from the hardware configuration pages in 
workstation preferences. 
Important: Do not connect hardware to your computer until instructed to do so by the wizard. 

To use the Hardware Setup Wizard: 
1. If installing hardware purchased from Intuit, put the Point of Sale CD in your CD-ROM drive 
(cancel the installation wizard if it launches). 
2. Click Next after reading the welcome page. 
3. Select the type of hardware you are installing. 
4. Select Next and follow the on-screen instructions to connect, set up, and test each piece of 
hardware. 

  

Notes: 
• If installing non-Intuit hardware, you may be prompted to use the manufacturer’s CD or instructions to 
install the device. When done return to the setup wizard and continue. 

• Since Windows, Software and Hardware are constantly changing, the driver you need may not be on the 
CD.  To find the most current driver, go to www.quickbooks.com/support and search for Hardware 
Drivers.  You should see a link for the tested drivers as well as instructions for installation. 

Related Topics 
About connection ports 

Install Supported POS Hardware 
Hardware Setup Wizard | Compatible Hardware | Troubleshooting 
  
It is strongly recommended that you use the Hardware Setup Wizard to configure your Point of Sale hardware. You 
can access the setup wizard from the File menu and from individual hardware workstation preferences pages. 
Select from the list below to view installation and setup information for Intuit-sold and supported POS hardware. 
If you have purchased compatible hardware from another source, follow the installation instructions provided with 
the hardware. 
For the most current QuickBooks Point of Sale 2013 hardware drivers and installation instructions, click here.  

Which piece of hardware are you installing? 
CipherLab 8000 physical inventory scanner 

http://www.quickbooks.com/support
http://support.quickbooks.intuit.com/support/Articles/HOW12055
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Citizen CT-S300 Receipt Printer (USB) 
ID Innovations MSR card reader (PS/2) 
ID Innovations MSR card reader (USB) 
Ingenico 2100/3010/3070 PIN pads 
Logic Controls LD9900 pole display (USB) 
Magtek 21040110 MSR card reader (USB) 
Metrologic SP5500 Optimus S Physical Inventory Scanner (USB) 
VMMF VAL-u Line Cash Drawer 
M-S CF-Media cash drawer 
Partner Tech CD7220 pole display (serial) 
Star TSP100 or TSP600 receipt printer (USB) 
Star TSP600 receipt printer (parallel) 
Welch Allyn IT3220 or HHP Imageteam 3800 handheld bar code scanner 
Zebra LP2824P tag printer (parallel) 
Zebra LP2824P tag printer (USB) 
  
Related Topics 
Drivers for Hardware  

Troubleshoot Your Cash Drawer 
Compatible Cash Drawers | Help & Support Overview 

My cash drawer will not open. What could cause this? 
Use the procedure below to troubleshoot your cash drawer, or use the Hardware Troubleshooter wizard , available 
from the Help menu. 
To function in Point of sale, a cash drawer must be connected through a working 40-column receipt printer. 

1. Are both your cash drawer and receipt printer on the Point of Sale compatible hardware list? 

Note:The M-S Cash Drawer formerly sold by Intuit works only with compatible Star receipt printers. Learn more  

• If YES, continue with the following steps. 

• If NO, has your cash drawer/printer worked with Point of Sale in the past? If it has, try the 
following steps to restore operation. If not, obtain and install compatible hardware. 
2. Are the cash drawer and printer cables connected  tightly? 

Note: Use only the manufacturer's cable included with the cash drawer for this connection. Using any other cable, including 
phone cords, may result in irreparable damage to your receipt printer. 

• If YES, continue with the following steps. 

• If NO, correct the connections and then test the cash drawer again. 
3. Is the receipt printer printing normally? Try re-printing a saved receipt from your sales history to 
test. 

• If YES, continue with the next step. 

• If NO, troubleshoot the printer first. Fixing the printer operation will most likely correct the cash 
drawer issue as well. 
4. Does the receipt printer specified in your cash drawer setup exactly match the receipt printer 
specified for printing receipts in workstation preferences? 

  
Edit  Preferences  Workstation  Cash Drawer: Make sure the receipt printer specified here matches 
the one specified on your Documents & Printers page for printing sales receipts. 



Printed Documentation 

480 

 
Edit  Preferences  Workstation  Documents & Printers 

 
• If YES, continue with the next step. 

• If NO, change your selections to match your receipt printer, and then select the Open Cash 
Drawer button to test the operation. Continue with the following steps if necessary. 
5. Are your company sales preferences set to open the cash drawer for the payment type you are 
taking? 

  

 
  

6. Is the cash drawer locked? Use your key to open it, if necessary. 
7. Is something inside the cash drawer preventing it from opening? Try gently shaking the cash 
drawer to dislodge the obstruction. 

  
Related Topics 
Install the VAL-u Line cash drawer 
Install the M-S cash drawer 

Troubleshoot Your Receipt Printer 
Print FAQs | Help & Support Overview 
  
Use the procedure below to troubleshoot your receipt printer or use the Hardware Troubleshooter, available from 
the Help menu. 

My 40-column receipt printer is not working. What could cause this? 
1. Is your receipt printer on the Point of Sale compatible hardware list? 

• If YES, continue with the following steps. 

• If NO, has your printer worked with Point of Sale in the past? If it has, try the following steps to 
restore operation. If not, obtain and install a compatible printer. 
2. Check the following printer conditions: 
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• Is the printer plugged in and powered on? 

• Is the printer out of paper? 

• Is the printer cover open? 

• Are there error lights illuminated on the printer? Information and solutions for error light conditions 
are available for these printers: Star TSP 100, Star TSP 600, Epson TM-T88III, Epson TM-T88IV, Citizen 
CT-S300. 

If your printer isn't listed, consult the printer's user guide or contact the vendor for more information. 
3. Is the receipt printer correctly installed and specified in workstation preferences? 

• Is your printer model on the Available Printers list? If not, choose Add Printer and install it now. 

 
• Is your printer model selected on the Documents & Printers page for printing receipts? 

 
If not, change your selections to match your printer, and then select Print Test Page. Continue with the 
following steps if this doesn't fix the problem. 
  

4. If using a USB printer, did you recently change the USB port into which you have it attached to 
your computer? 

Changing the USB port for your printer causes Windows to install the printer a second time. Each installation of 
the printer is unique to the USB port into which it is attached. If this has happened, your Available Printers list 
will have a second instance of your printer named Copy of <model>. 
You can either plug the printer back into the original port or, if leaving it in the new port, return to the 
Documents & Printers page of workstation preferences and select Copy of <model> as your receipt printer. 
If using a cash drawer with the receipt printer, also change your cash drawer setup to reflect the Copy of 
<model> receipt printer selection. 
In general, it is recommended you always plug the receipt printer into the same USB port and delete the other 
instance of the printer from your Windows printer list. 

If the steps above do not correct the problem, uninstall and reinstall the printer. 
1. Open your Windows Printers and Faxes folder from the Windows Start menu or Control Panel. 
2. Ensure there are no documents waiting to be printed by double-clicking your receipt printer name. 
If documents are pending, select Cancel All Documents from the Printer menu and then close the 
documents window. 

If there are multiple copies of your receipt printer listed, do this for each. 
3. Delete each occurrence of your printer by highlighting it and then selecting Delete from the File 
menu. 
4. Reinstall your printer, following the instructions provided with it. Click here for instructions to 
install supported hardware you have purchased from Intuit. 
5. Return to workstation preferences and select the new installation of your printer for sales receipts 
and, if applicable, for your cash drawer connection. 

  
Related Topics 
Print FAQs 
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Troubleshoot a cash drawer 
Troubleshooting Overview 

Hardware Troubleshooter 
Hardware Drivers  | Compatible Hardware List | Hardware Setup Wizard 
  
The Hardware Troubleshooter can help you identify and correct problems with your Point of Sale hardware. 

To use the Hardware Troubleshooter: 
1. From the Point of Sale Help menu, select Hardware Troubleshooter. 
2. Select the type of hardware with which you are having trouble. 
3. Follow the on-screen prompts to narrow down the possible causes, try the suggested solutions, 
and then use the test option to verify the issue has been resolved. 

  

Notes: 
• If you have non-Intuit hardware, you may be prompted to use the manufacturer’s CD or instructions to 
troubleshoot the device. When done return to the troubleshooter and continue. 

Related Topics 
Troubleshoot a receipt printer 
Troubleshoot a cash drawer 
Troubleshooting overview 
Help and support overview 

Bar Code Scanner FAQs 
Help & Support Overview | Support Resources 

How do I configure my bar code scanner to automatically insert a carriage return after each scan? 
Bar code scanners can be configured to insert a carriage return after each scan by scanning a bar code included in 
the documentation that you received with your scanner. Check the documentation for specific instructions. 
Bar code scanners purchased from Intuit should be preconfigured to insert the carriage return automatically, but if 
this setting is somehow lost, it can be reprogrammed by following the directions that came with the scanner. 
  

How do I reset the HHP® IT3800LR model bar code scanner? 
1. Locate the Resetting the Factory Settings section in your HHP IT3800 User manual. 
2. Scan the bar code labeled Factory Default Settings with the scanner. This will reset the 
scanner. 

  
Related Topics 
List of compatible bar code scanners 
Using bar codes and scanners in Point of Sale 

Pole (Shopper) Display FAQs 
Compatible Pole Displays | Configure your Pole Display 

Nothing displays on my pole display. What could be wrong? 
Check the following, seeking the help of a qualified computer consultant if necessary: 

• Be sure the display has power. Some older units have a power switch located under the display unit; be 
sure this is turned on. When the unit is first powered on, the display will show the power up information for 
several seconds. If you do not see this then it is either not getting power or the unit is defective. 

• Ensure that the port selected in workstation preferences matches the physical port on the computer. 
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• Serial pole displays may conflict with other serial devices, such as modems or printers, even if the other 
device is not connected or powered on. It may be necessary to reassign other serial devices to different ports. 

• If using a Logic Controls pole display, unplug the unit for a few minutes an then plug back in; this will 
reset the display 

Related Topics 
Install the Partner Tech CD7220 pole display 
Troubleshooting overview 
Help and support overview 

Drivers for Compatible Hardware 
in-help popup topic. 
Software drivers for compatible hardware are included on the Point of Sale installation CD in the Drivers folder. 
You can browse to this folder as necessary from the Point of Sale Hardware Setup Wizard or the Windows Add 
Hardware Wizard to select a needed driver. 
Look for sub-folders with the hardware name to locate the driver you need. 
Important: You should complete the Point of Sale software installation before connecting any hardware. Hardware 
drivers are installed during Point of Sale installation. Connecting the hardware prior to installation may result in 
Windows installing drivers that cause your hardware to malfunction or not function at all. 
If you are having difficulty getting printers or other hardware to work, make sure you have installed all pending 
Windows updates:  Click Start and select Control Panel > Windows Updates.   

To check for newer versions of drivers for Intuit-sold hardware visit www.quickbooks.com/support/pos/hardware. 
  

Drivers for Compatible Hardware from Other Suppliers 
The drivers included for compatible hardware were current as of the compatibility testing date. Updated drivers may 
be available from your hardware vendor, however, these drivers have not been tested for compatibility. 

http://www.quickbooks.com/support/pos/hardware
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POS Merchant & Gift Card Services 

Merchant Service - Credit/Debit Cards 

Sign Up and Configure Merchant Service 

Sign Up for an Intuit Payments Account 
Merchant Service Overview 
  
Most retailers will want to sign up for a merchant account with Intuit to perform credit and debit/ATM card 
transactions. An Intuit Payment Account offers an integrated processing solution that allows you to authorize, 
settle, and record all your credit/debit card sales from within QuickBooks Point of Sale. 

Getting set up is easy!   Learn more 
  

To sign up for an Intuit Payments Account: 
1. From the Point of Sale File menu, select Setup Interview. 
2. Select the Payments tab. 
3. Click Yes to accept credit and debit cards.  
4. Click Sign In.  
5. Be sure to sign in using the User ID (email) and password that you had previously created. 
6. If there is more than one account, you will be prompted to select the right account.  

  
Note:  You will also need your Intuit Payments Account to take advantage of the available  mobile features.  
  
Learn More 
  
Related Topics 
Merchant Service reports 
Protecting your customer's payment card data 

Configure Your System for a Merchant Account 
Merchant Service Overview | Merchant Service Hardware 
  
Use this procedure to configure your system to work with the QuickBooks POS Merchant Service. 

1. Sign up for an Intuit Payments Account and receive your Merchant Number. 
Continue with the following steps after receiving your Merchant Number. 

2. Select Preferences  Company from the File menu and then select the Merchant & Gift 
Services page from the preferences menu on the left. 
3. Enter the Merchant Number provided to you and specify other options: 

• Do not allow manual transactions that fail address verification. When credit card information 
is manually entered, an address verification is performed to compare the entered ZIP code, and optionally 
the street address, against bank records. If this option is selected, the transaction is not allowed if a 
mismatch occurs. Learn more. 

• Do not allow manual transactions that fail card verification. When credit card information is 
manually entered, an optional card verification can be performed using the verification code printed on the 
card. If this option is selected, the transaction is not allowed if the code entered does not match issuer 
records. Learn more 

• Accept debit/ATM card payments. Select if you want to accept payment by debit/ATM cards. A 
PIN pad device is required to process PIN debit transactions; which must be configured in workstation 
preferences. 

• Allow cash back up to. If processing PIN debit sales, select this option if you also want to allow 
cash back to the customer. Enter the maximum cash back amount (limit of $200). 

http://www.youtube.com/user/IntuitQuickBooksPOS?feature=mhee
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• Automatically print and save receipt upon card approval. This option (at the bottom of the 
window) lets you return to assisting the customer while the authorization completes and the receipt is 
automatically printed. 
4. Select the Communication Setup sub page, and specify how you will communicate with the 
service, via Internet connection or dial-up (modem). Click the Internet Connection Setup button if you 
need help configuring an Internet connection. 
5. Return to the Merchant & Gift Services page and select Verify next to your Merchant Number. 
Point of Sale will do a test connection and confirm that your account is active and ready to use. If errors 
are encountered, a message is displayed with information about resolving the situation. 
6. Select Save. 

  
(Pro) Read additional information about configuring for multiple locations. 
Back to top 
  
Related Topics 
Protect customer's payment card data 
Take payment by credit card 
Take payment by debit card 
Frequently Asked Questions (FAQs) 

Communication Setup for Merchant and Gift Card Services 
Merchant Service Overview | Gift Service Overview 
  
You specify communication options for the QuickBooks POS Merchant and/or Gift Card Services on the Merchant 
and Gift Card Service  Communication Setup page in company preferences. You must have security rights to 
edit preferences to change this setting. 
Select a connection option: 

• Secure Internet Connection - provides an IP-based connection through your Internet Service 
Provider. This option requires a persistent (always on) Internet connection, such as DSL, cable, or T1. 
Click the Internet Connection Setup button if you need assistance setting up your Internet connection. 

• Direct-Dial - this modem option supports high-speed and advanced modem technologies, 
typically using the modem's default settings. A dedicated phone line is required. 

If you select the direct-dial option, also read about modem setup. 
If you haven't already, return to the main Merchant & Gift Services page and select Verify to test your connection. 

Credit, Debit, and Gift Card Hardware 
Take Payments | Compatible Card Readers | Compatible PIN pads 
  

This topic applies to users of the QuickBooks POS Merchant and/or Gift Card Services. If you use a different service, refer to that 
service's hardware requirements. 

  
Point of Sale supports card readers and PIN pads for processing of credit, debit/ATM, and gift card transactions 
through the QuickBooks POS Merchant and Gift Card Services. 
Credit card and gift card transactions do not require the use of a card reader, but the use of one is highly 
recommended. Swiping a card though a card reader speeds entry, helps avoid errors of hand-keying, and qualifies 
you for lower fees on credit card transactions. PIN debit transactions require the use of a PIN pad. 
The procedure for accepting payment varies depending on your hardware configuration. 
Card Reader (MSR) – Ideal for retailers who accept credit and gift card payments but not PIN debit payments, or 
who will use the card reader in conjunction with the Ingenico 3010 (see below) for processing all card transactions. 
Ingenico Telium iPP3xx and Ingenico eNcrypt 2100 PIN pad – These PIN pads have an integrated card reader 
which can be used to process credit, debit/ATM, and gift card transactions. An added benefit with these device is 
their ability to store authorization information, allowing the customer to swipe their card, enter their PIN, and select 
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cash back (if you allow it), all while your cashier is still completing the receipt. When the cashier goes to the 
Payment window, the PIN pad device will send the approved amounts to the correct payment and change fields. 
Ingenico 3010 PIN pad – This PIN pad has no integrated card reader and requires that a card reader also be 
installed on the system. Typically, the customer hands their card to the cashier who swipes it through their existing 
card reader. The customer uses the PIN pad to enter their PIN, optionally request cash back, and approve the total 
amount. 
  
For the most current hardware information, click here.  
  

Important Note: Intuit works closely with the manufacturers of hardware sold by Intuit for use with Point of Sale to ensure these 
devices work together and with the Point of Sale software. Hardware, such as PIN Pads and Physical Inventory Scanners, 
purchased from other sources may not contain the required programming to work with Point of Sale software and/or the 
QuickBooks POS Merchant Service. Intuit does not provide hardware programming, and does not guarantee that devices 
purchased from other third party sources will work with Intuit software. 

  
Related Topics 
Configure merchant and gift card services 
Install an Ingenico PIN pad 

Multiple Locations Using Merchant/Gift Card Service 
Merchant Service Overview | Gift Card Overview | Customer Support 

Pro - Multiple Stores 
For QuickBooks POS Merchant and/or Gift Services customers with multiple physical locations under the same 
ownership, each location must have a separate account with these services, but those accounts can be linked so 
that you receive consolidated reporting and statements. Each location would process authorizations and 
settlements independently. 
For more information, contact the QuickBooks POS Merchant and/or Gift Card Services. 

General Credit Card Guidelines 
Merchant Service Overview | Credit Card Payments 
  

This topic applies to users of the QuickBooks POS Merchant Service. What if I use another Service? 

  

Accepted Card Types 
Allowed credit card types are Visa, MasterCard, American Express, Discover, Diner’s Club, and JCB. Up to three 
credit card payments can be accepted on a single transaction. You can specify the specific card you accept in 
company preferences. 
  

Using a Credit Card Reader 
The QuickBooks POS Merchant Service does not require a card reader to process credit card transactions. 
However, you may get a lower "swipe" rate when using a card reader to authorize these transactions (see below). 
The credit card payment procedures refer to card readers and PIN pads for use with credit card transactions. See 
Credit, Debit, and Gift Card Hardware for more information on supported card readers. 
  

Card Not Present 
The QuickBooks POS Merchant Service does not require that the credit card be present to authorize a transaction; 
however, you do need to have the customer’s name, ZIP code, card number, and expiration date. "Card not 
present" fees apply. Refer to your QuickBooks POS Merchant Service agreement for more information. 
  

Address Verification Service 

http://pointofsale.intuit.com/barcode-inventory-software?lid=left_nav
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Point of Sale performs an address verification on all credit card transactions that are entered manually (not 
swiped). The service checks if the customer’s ZIP Code, and optionally street address, matches the address 
currently on file at the cardholder’s bank and alerts you if there is a mismatch. Learn more. 
  

Card Verification 
Optionally, Point of Sale can also perform a check of the card verification code when manually entering card 
information. This verification helps to confirm that the customer actually has the card in his/her possession at the 
time of the sale. You are alerted in the event of a mismatch with the card issuer records. Learn More. 
  

Credit Card Settlement 
Although credit card transactions are authorized immediately, funds are not transferred to your bank account until 
the transactions are settled by running the End of Day procedure. It is important that you settle transactions daily to 
avoid paying higher fees on your credit card transactions. 
  
Related Topics 
Protect your customers' card data 
Take payment by credit card 
Credit card returns 

Take Payment by Credit Card 
Payment Overview | Credit Card Refunds 
  

This topic applies to users of the QuickBooks POS Merchant Service. What if I use another Service? 

To take full payment by one credit card: (modifications for splitting payment are covered here) 
Note for users of the Ingenico eNcrypt 2100 or 3070 PIN pad  

1. Click the Credit payment button. 
The Credit payment dialog is opened, with default options: 

 
• Charge card as the transaction type 

• Swipe as the transaction method 

• The total sales amount pre-filled in the Amount field 
2. Swipe the credit card. (recommended) 

Or 
Select Manual Entry, enter the card information and ZIP code, and optionally the fraud prevention information, 
and then select Authorize Now. At the prompt, specify whether the card is present or not. 
Or 
Select Voice to complete a voice authorization. This is recommended only if  your connection to the processor 
is down or you are requested to do so. 

4. Point of Sale connects to the Merchant Service to obtain authorization. 
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If all of the following are true, Point of Sale will process the transaction and print the receipt without further 
action on your part. This allows you to return to servicing the customer. 

• The card was swiped (rather than manually entering card information) 

• The transaction is authorized 

• You are configured to automatically save/print upon authorization 
If any of these are not true, continue with the following steps. 

5. You will see one of the following messages: 
Authorized: The charge has been approved. Select OK to close the window. 
Declined: The charge was not approved. Select Cancel to return to the payment screen. Ask the customer to 
provide a different form of payment, or select Authorize to try again. 
Referral: Voice authorization is required. Call the number listed on-screen and give the operator your 
Merchant Number. Enter the authorization number the operator gives you in the Voice Auth Number field 
 and click Authorize Now. 
Failed address or card verification check: The address or card verification code entered does not match 
the issuer’s records. Depending on your merchant service preferences, you may be allowed to continue or the 
transaction may be automatically voided. 

View the Address and Card Verification Results Guide  
6. Wait for the receipt to print, if configured to print automatically 

Or 
Select Save & Print to record and print the receipt. 

7. Have the customer sign the merchant copy of the receipt. 
  
Return to top 

Notes: 
• By default, the program is configured to print two copies of credit card receipts —one for the customer and 
one for the merchant (signature copy). If you are using double-ply paper, you may want to turn off this 
preference. Point of Sale is also set by default to pause between printouts so you have time to tear off the 
receipts. 

• Although credit card transactions are authorized immediately, funds are not transferred from the 
cardholder’s account to yours until transactions are settled by running the End of Day procedure. 

Related Topics 
Specify the credit cards you accept 
Cancel or reverse credit card charges 
Credit card fraud prevention tips 
Hardware requirements for Merchant & Gift Card Services 
General credit card guidelines 
Merchant Service FAQs 

Referral/Voice Authorization 
Take Credit Card Payments | Merchant Service Overview 
  

Manual Voice Authorizations 
Sometimes it may be necessary to force a manual voice authorization. This may because your regular connection 
to the processor is down and you need to manually process the sale or you need to enter sales made earlier (such 
as at a remote location). 

To force a manual voice authorization: 
1. Select Credit as the payment type on the receipt form. 
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2. When the credit card payment dialog opens, select Voice. 
3. Enter the credit card number, expiration date, ZIP Code, and optionally the street address and 
card verification code.  Learn about fraud prevention. 

Voice instructions and a number for the voice authorization are displayed. 
3. Call the number displayed. You will be asked for your Merchant Number, which is displayed 
onscreen for your convenience. 
4. Listen to the authorization menu choices carefully, you can choose to authorize with or without an 
address verification. Follow the phone prompts to enter necessary information. The operator will give you 
an authorization code when complete. 
5. Enter the authorization code you are given in the Voice Auth Number field. 
6. Click  Authorize Now. 

  
The credit card payment information is added to the receipt total section. 
  

Referral Response 
The referral response typically occurs after three failed attempts to connect with the Merchant Service. This might 
occur if there is a problem with your modem or Internet connection, for example. 
When the Referral response is returned, voice authorization is necessary. Follow the procedure above to obtain 
authorization for the transaction. 
  
Related Topics 
Take payment by credit card 
Merchant Service overview 

Credit Card Returns 
Sales Returns | Fraud Prevention Tips 
  
If the transaction has already been settled with the bank, you should issue a credit refund to the customer by 
making a return receipt. 

To make a return credit card receipt: 
1. Create a new receipt, listing the return items as negative quantities (click Return Item after 
adding to the receipt). 
2. If necessary, edit the returned item prices and quantities to be the same as the original purchase 
and then click Credit as the payment type. 
3. In the Credit dialog, ensure that Refund Card is selected. 
4. Swipe the customer's card (recommended). 

Or 
Click Manual and type the credit card number, expiration date and cardholder’s ZIP Code and then click 
Authorize Now. 

5. Save and print the receipt. Have the customer sign the merchant copy. 
  
Tip: If the customer is returning all of the merchandise on the original receipt , you can also reverse the original 
receipt. Reversing the receipt is typically done when the customer is not present to swipe their card. (Pro: This 
option is not available at a remote store after a receipt has been sent to Headquarters.) 
  
Related Topics 
Cancel and reverse credit card payments 
Take payment by credit card 
Merchant Service reports 
Merchant Service overview 
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Address Verification Service (AVS) 
Card Verification | Fraud Prevention Tips 
  
When you manually enter credit card information, the QuickBooks POS Merchant Service verifies the cardholder's 
address by comparing the ZIP Code, and optionally the street address, you enter with the customer's credit card 
bank records. 
This check is carried out using the Address Verification Service (AVS). Address verification helps merchants avoid 
credit card fraud and chargebacks for transactions in which the credit card information is manually entered or not 
physically present at the point of sale. 
  

ZIP Code and Street Address 
Only the customer’s ZIP Code is required to complete the address verification check, but you can include street 
address for extra protection. Only the number portion of the street address is used in the verification check, but the 
credit card dialog allows you to enter the street name as well. 
  

Handling the AVS Results 
The processor returns a message indicating whether the entered information matches that on file at the 
cardholder’s bank. The results of the AVS check are for your information only. You can choose to process the 
credit card payment even if the AVS check indicates a mismatch between the ZIP Code or street address you 
entered and the cardholder's bank address information. 
Address Verification Results Guide  
  
You specify how you wish to handle AVS mismatches on the Merchant & Gift Services page in company 
preferences: 

•  Do not allow manual transactions that fail address verification — Selecting this option provides a 
degree of protection against fraud and chargebacks but may also block legitimate transactions. You will not 
be able to complete a credit card transaction if an AVS mismatch occurs. If you clear this checkbox, the AVS 
check results are displayed, but you can still process the transaction at your discretion. 

Related Topics 
Take payment by credit card 
Configure your system for a merchant account 

Credit Card Verification 
Address Verification | Fraud Prevention Tips 
  
A credit card verification is an important security check for manually entered (non-swiped) credit card transactions. 
The code helps verify that the customer, presumably the legitimate cardholder, has the actual card in their 
possession. The use of this feature is optional, but highly recommended, as one component of a fraud prevention 
strategy. 
Note: Depending on the card issuer, the card verification feature may be referred to as a card verification code 
(CVC), card verification value (CVV), card identification number (CID), or cardmember ID. All of these terms are 
synonymous and mean the same thing. 
When you enter the card verification code on a credit card transaction, the processor verifies that the code matches 
issuer records. A mismatch can be one potential indicator of fraudulent use of the card. 
Card Verification Code Results Guide 
  

Where is the card verification code located? 
The card verification code will have 3 or 4 digits and will be in different locations depending on the card type, as 
shown in the examples below. 
When manually entering credit card information, enter the code in the Card Verification Code field on the credit 
card dialog before selecting the authorize button. 



Printed Documentation 

492 

 
  

What happens if a mismatch occurs? 
How a card verification code mismatch affects your credit card transaction depends on: 

• The card issuer’s regulations – Some card issuers automatically decline charges when the verification 
code entered does not match their records. In this case the charge cannot be completed. Ask the customer 
for another method of payment. 

• Your Point of Sale Merchant Services preferences – If the card issuer does not decline the transaction, 
then you can proceed with the charge at your discretion. If you wish to block all transactions that fail card 
verification, select the checkbox for Do not allow manual transactions that fail card verification in your 
Merchant Service company preferences. 

Related Topics 
Take payment by credit card 
Configure your system for a merchant account 

Credit Card Fraud Prevention Tips 
Address Verification | Card Verification 
  
While the warning signs and suggestions below taken alone are not a sure method for protecting yourself against 
credit card fraud, you should be aware of them and use them to make better decisions in the fight against card 
fraud and chargebacks. 
  
Verify the cardholder’s identity. Use the customer’s driver’s license or ID card to verify the name, address, and 
compare signature’s with that on the sales slip. If in doubt, don’t hesitate to turn down the transaction or call the 
number on the back of the card, if present, to verify the cardholder information. 
Get the customer signature on sales slips. If the customer refuses to sign the slip after you have processed the 
authorization, void the transaction. Do not process the sale if the cardholder refuses to sign the sales slip. 
Observe the Address Verification Service (AVS) results. You have the option in Point of Sale of disallowing 
manually entered transactions that fail the address verification check. This preference may provide a degree of 
protection, but may also block some legitimate transactions. Some merchants choose to not accept transactions or 
ship merchandise to addresses other than the billing address for the account. Be especially wary if the customer 
requests a shipment to a PO Box or an international address. 
Observe the card verification results. You also have the option in Point of Sale of disallowing manually entered 
transactions where the entered card verification code does not match the card issuer’s records. This check helps 
ensure that the customer actually has the card in their possession at the time of the sale. Some issuers 
automatically decline the transaction when a mismatch occurs, others allow you to use your discretion in accepting 
such transactions. 
Be aware of card security features. All major card issuers have unique features to help identify against fraudulent 
cards. Visit the card issuer Web sites (Visa, MasterCard, American Express, Discover, etc.) periodically to keep up 
with the latest technologies and features. 
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Don’t refund credit card transactions with cash. Asking for a cash refund on a credit card transaction is a strong 
indicator of credit card fraud. In some cases, the cardholder will also file a dispute for the transaction after receiving 
cash, resulting in a possible chargeback to you as well. Refund credit card transactions only as a credit back to the 
same card. 
Report fraud immediately. If possible, notify your manager while holding the card. Alternatively, initiate a voice 
authorization and request a Code 10 authorization. The operator will ask you a series of yes or no questions and 
guide you through the necessary steps. 
Safety Comes First. If you feel you are in danger, decline the transaction and return the card. Call the 
authorization number after the customer has left to report the fraud. 
  
Related Topics 
Protect your customer's credit card data 
Take payment by credit card 
Configure your system for a merchant account 

General Debit/ATM Card Guidelines 
Take Payment by Debit/ATM Card | Merchant Service Overview 
  

This topic applies to users of the QuickBooks POS Merchant Service. What if I use another Service? 

  

Transaction Fees 
The QuickBooks POS Merchant Service does not support the collection of transaction fees on debit/ATM 
payments. 
  

What is a PIN Debit Transaction? 
There are two ways a customer’s debit/ATM card can be accepted for payment: 

• PIN Debit transactions, which require the use of a PIN pad, take payment directly from the cardholder’s 
associated bank account and allow cash back. The help topics for taking payment by debit/ATM apply to this 
type of transaction. 

• Processing the customer’s debit/ATM card like a credit card, which does not require the use of a PIN pad 
and does not allow cash back. Typically, the card must display a credit card logo (e.g. Visa, MasterCard) to 
be used this way. Process these transactions using the credit card procedure. 

Canceling or Reversing PIN Debit Payments 
PIN debit payments, if already authorized, cannot be deleted from the receipt, nor can the receipt be canceled or 
voided. The money has already been debited from the cardholder's bank account. 
If the receipt has not yet been saved, the cashier can manually enter an equal amount by another payment method 
and refund the debit amount to the customer as change (cash suggested). 
If the receipt has been saved, it can only be reversed or a return receipt made. Reversing a debit receipt does not 
create a credit back to the customer’s bank account. When you reverse a debit receipt, the change is automatically 
assigned to cash. If you want to refund the money to the customer by another method, create a return receipt 
instead and select any other change type. 
  

Debit Card Batch Settlement 
Although debit card transactions are authorized and the cardholder’s bank account debited immediately, funds are 
not transferred to your bank account until the transactions are sent to the processor by running the End of Day 
procedure and settled. 
  
Related Topics 
Protect your customers' payment card data 
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Take Payment by Debit/ATM Card 
Payment Overview | Void a Debit Card Payment 
  

This topic applies to users of the QuickBooks POS Merchant Service. What if I use another Service? 

To take full payment with one debit card: (modifications for splitting payment are covered here) 
Note for users of the Ingenico eNcrypt 2100 or 3070 PIN pad  

1. Click Debit as the payment type. 
The Debit Card dialog is opened with the full sale amount pre-filled in the Amount field. 

3. Swipe or have customer swipe the debit card and, if allowed, select a cash back amount. 
4. Click Authorize. 
5. Have customer enter their PIN and select OK on the PIN pad. 
6. Have customer approve the total transaction amount by selecting OK. 

Point of Sale connects to the Merchant Service to obtain authorization. 
If both of the following are true, Point of Sale will process the transaction and print the receipt without further 
action on your part. This allows you to return to servicing the customer. 

• The transaction is authorized 

• You are configured to automatically save/print upon authorization 
If either of these are not true, continue with the following steps. 

6. You will see one of the following messages: 
Authorized: The debit has been approved. Select OK to close the card dialog. 
Declined: The debit was not approved. Select Cancel to close the Debit window and return to the payment 
screen. Ask the customer to provide a different form of payment. 

7. Wait for the receipt to print, if configured to print automatically 
Or 
Select Save & Print to complete and print the receipt. 

8. If applicable, the change window displays the cash back amount to give the customer. Select OK to close 
the window. 

Return to top 
  
Related Topics 
Connection failed messages 
General debit/ATM card guidelines 
Hardware requirements for Merchant & Gift Card Services 
Configure debit preferences 
Merchant Service reports 
Merchant Service FAQs 

Settle Merchant Service Transactions 
Merchant Service Overview | FAQs | End of Day Overview 
  
If you have an Intuit Payments Account with the QuickBooks POS Merchant Service, you can include batch 
settlement of your authorized credit and debit card transactions in the End of Day procedure. 
The settlement process is automated. All you need to do is select the Settle Merchant Account option on the End 
of Day window. 
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Point of Sale transmits the transactions to the merchant service for settlement. Once the data is transmitted, the 
QuickBooks POS Merchant Service routes the transaction to the bank that issued the card, secures the funds, and 
then transfers the money to your bank account. 
  

Notes: 
• Important: Credit card transaction data must be sent to the processor for settlement within one day of 
authorizing the transaction to avoid paying higher fees. You must settle before reaching 500 transactions or a 
total dollar amount of $999,999.99. Point of Sale will block additional credit or debit card transactions until 
settlement is completed. 

• Typically, a merchant account is settled once per day, during the End of Day procedure. To settle more 
often, run the End of Day procedure, selecting only the Settle Merchant Account option. 

• Only transactions not already sent are included in each batch settlement. 

• If you are integrated QuickBooks Financial Software 2009, merchant service transactions are sent to 
QuickBooks grouped by settlement batches to assist in reconciliation with your bank deposits. Learn more 

• To check on the status of settlement, visit and set up a free Intuit Payments Account at the Merchant 
Service Center 

Related Topics 
Merchant Service Reports 
Take payment by credit card 
Take payment by debit card 
Troubleshoot 

Merchant Service Reports 
Merchant Service Overview | Merchant Service Center 
  
Users of the QuickBooks POS Merchant Service can run reports summarizing or detailing their credit and debit 
card transactions for any specified time period. These reports subtotal your transactions by settlement batch and, in 
a multi-store configuration, by merchant number. 

To run a Merchant Service report: 
1. In the Report Center, select Payments as the report category and then Merchant Service as the 
report type. 
2. Select one of the specific Merchant Service reports available. 

• Unsettled Summary: Provides a listing of unsettled transactions by card type. 

• Unsettled Details: Provides details of all unsettled transactions. 

• Activity Summary: Provides a summary of all transactions (credit and debit), settled and 
unsettled. 

• Activity Details: Provides details of all transactions (credit and debit), settled and unsettled. 
The selected report is displayed using default or your last-run settings. 

3. Change the report date range or select Modify to change other report options and filters as 
needed. 

Many report filtering options are available, including filtering by Batch #, Transaction Type (sales, refund), 
Status (voided, authorized), Card Name, Card Present (yes, no), Workstation, etc. The options available vary 
by specific report. 

4. Select OK to display the reports with your specified options. 
Optional: Memorize the report with your specified options for future use, when prompted. 

5. Select Print or Excel depending on your output needs. 
  

Notes: 
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• You can also view lists of credit and debit payments in Point of Sale in the Payments > Credit Card List 
and Debit Card List reports. 

Related Topics 
Work with a displayed report 
Settle card transactions 

Merchant Service Center 
Merchant Service Overview | Merchant Service Reports 
  
Users of the QuickBooks POS Merchant Service can visit our online Merchant Service Center to: 

• Check on account activation 

• View processing and funding status 

• Perform basic account management tasks 

 To visit the Merchant Service Center: 
1. From the Report menu, select Merchant Service Center. 

The Merchant Service Center Sign In page is opened in a Web browser window. 
2. On first visit, select Create an Account, and follow the on-screen instructions to set up your 
access account. 

OR 
If returning, sign in with your user name and password. 

  

Notes: 
• Transactions show up in the Merchant Service Center one day after processing 

• From outside of Point of Sale, visit https://merchantcenter.intuit.com/posms   

Merchant Service Reconciliation 
Merchant Service Reports | Merchant Service Center 
  

Note: This feature requires integration with QuickBooks Financial Software 2009. 

  
Merchant Service reconciliation makes it easy to match credit and debit card payments taken in Point of Sale to the 
bank deposits you make from your QuickBooks financial software and identify discrepancies and fees. 
When credit and debit card transactions are sent from Point of Sale to QuickBooks, they are added to the 
Payments to Deposit window (by store/merchant number in a multi-store configuration) and settlement batch, 
helping you to match the transactions with your deposits and more easily identify and account for discrepancies 
and fees. 

Requirements for the reconciliation feature: 

• Using the QuickBooks POS Merchant Service to process card payments 

• Integrated with QuickBooks Financial Software 2008 or later 

• You have not changed the default payment types. These specific payment type mappings are required for 
the reconciliation feature. 

To send transactions with reconciliation information to QuickBooks: 
No action is necessary in Point of Sale to send reconciliation information to QuickBooks. If you meet the 
requirements listed above and conduct routine Financial Exchanges your transactions will show up on the 
Payments to Deposit screen in QuickBooks grouped by store/merchant number and batch. 

https://merchantcenter.intuit.com/posms
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Making deposits in QuickBooks: 
This procedure is completed in QuickBooks financial software, and is summarized here. More specific instructions 
can be accessed from the Payments to Deposit window in QuickBooks by selecting Help. 

1. Complete Financial Exchange with QuickBooks as part of your End of Day procedure. 
Your payment card transactions update the Undeposited Funds balance in QuickBooks. 

2. In QuickBooks, select Make Deposits from the Banking menu. 
3. Select the payments to include in the deposit. 

To facilitate reconciliation later, make your deposits by the transaction groupings. The transactions from Point 
of Sale are grouped by store/merchant number and batch for convenience. 

  

Notes: 
• After a transaction has been sent to QuickBooks (or from remote store to HQ), voiding of the transaction is not 

allowed. Point of Sale automatically  reverses the transaction in this case. 

• Point of Sale Merchant Service reports are also split out by batch and, if applicable, store/merchant number. 

• To help keep your settlement batches synchronized with other End of Day postings to QuickBooks, it is 
recommended you settle once per day before exchanging data with QuickBooks. In a multi-store 
configuration, settle at each remote store before Store Exchanges with HQ. 

Credit, Debit, and Gift Card Printed Receipt Options 
Merchant Service Overview | Gift Card Service Overview 
  
Three preference options are available for printing of credit, debit, and gift card receipts. 
  

Automatically Save/Print Credit, Debit and Gift Card Receipts Upon Approval 
With this option selected (default) credit, debit, and gift card receipts are automatically saved and printed as soon 
as the transaction has been authorized when using the QuickBooks POS Merchant or Gift Card Services. This 
allows the cashier to swipe a card and immediately return to servicing the customer while the approval is in process 
and the receipt printing. This option can be disabled, if necessary, on the Merchant and Gift Service page of 
company preferences. 
  

Printing Two Copies of Credit Card Receipts 
When a customer pays for a purchase with a credit card, two copies of the receipt can be printed: a signature copy 
for you and the customer’s copy. 
By default, Point of Sale is configured to print two copies. However, if you use a two-ply receipt paper that prints 
both copies at the same time you should turn off this option, or you will end up with four copies of credit card 
receipts. Set this option independently for each workstation on the print options page of workstation preferences. 
  

Pause Between Printing to Allow Tearing Off Printed Receipts 
By default, Point of Sale is configured to pause briefly after the first copy of a credit card receipt prints so you have 
time to tear it off before the second copy starts printing. If your receipt printer auto-cuts receipts, you can turn off 
this option independently for each workstation on the print options page of workstation preferences. 
  
Related Topics 
Specify the credit cards you accept 
Take payment by credit card 
Take payment by debit/ATM card 
Take payment by gift card 

Notes on Reversing Receipts of Specific Payment Methods 
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Reverse a Receipt | Find a Receipt 
  
When you reverse a sales receipt, the reversing receipt created is a return receipt. The amounts taken in payment 
on the original receipt are returned as change (on paper) to the customer as credits on the return receipt. In this 
way, the accounting is automatically corrected along with the other changes you make on the receipt. The following 
are brief descriptions of how reversing a sales receipt of specific payment methods, and then creating a new 
corrected receipt are handled. Reversing a return receipt works the same way but the payment and change (credit) 
amounts are the opposite. 
  
Cash: The reversing receipt (return) shows the original payment returned to the customer as cash change. Record 
payment on the new corrected sales receipt as cash as well. If there is a difference between the amounts on the 
two receipts, you will need to handle collecting or refunding from/to the customer according to your store policy. 
Check: The reversing receipt (return) shows the original payment returned to the customer as change by check. 
Record payment on the new corrected sales receipt by check as well. If there is a difference between the amounts 
on the two receipts, you will need to handle collecting or refunding from/to the customer, changing the amount of 
the check, or getting a new check according to your store policy and legal requirements in your area. 
Credit Card: The reversing receipt (return) shows the original payment returned to the customer as change by 
credit card. If you use the QuickBooks POS Merchant Service, this receipt will automatically be sent to the card 
processor as part of the next settlement batch. This will result in a credit on the cardholder's account. Record 
payment on the new corrected sales receipt by the same credit card, authorizing and updating the charge by 
manually entering the card information, if necessary. This new receipt will also be sent with the next settlement 
batch, resulting in a new charge on the cardholder's account. If you do not use the QuickBooks POS Merchant 
Service, follow the same procedure but use the third-party processor's instructions for handling the card credit and 
new authorization. For more information, read canceling and reversing credit card payments. Reversing credit card 
receipts processed through Point of Sale is limited to 60 days after the sale. 
Debit/ATM: Reversing a debit receipt does not create a credit back into the customer’s bank account. When you 
reverse a debit receipt, the change is automatically assigned to cash. If you want to return the money to the 
customer by another method, create a return receipt instead and choose the payment method. Then create a new, 
corrected receipt. 
Gift Card: If you use the QuickBooks POS Gift Card Service and reverse a sale paid by gift card, Point of Sale 
automatically connects to the Gift Card Service servers and adds the original payment amount back to the card 
balance. The refund amount is placed in the Gift Card Purchase field on the payment screen. If you reverse a 
receipt which originally sold (added value) to the gift card, reversing it deducts the reversed amount from the stored 
value of the card. If not using the QuickBooks POS Gift Card Service, the reversing process is the same, but you’ll 
have to use the procedure outlined by your service to add/deduct the value back to the customer’s card. 
Gift Certificate: The reversing receipt (return) shows the original payment returned to the customer as change by 
gift certificate. Record payment on the new corrected sales receipt by gift certificate as well. If you track gift 
certificates by number, enter the same number as the original certificate. If there is a difference between the 
amounts on the two receipts, you will need to handle collecting or refunding from/to the customer according to your 
store policy and legal requirements in your area. 
Account Charge: The reversing receipt (return) shows the original payment returned to the customer as an 
account credit. Record payment on the new corrected sales receipt by account charge. Both receipts are sent to 
your QuickBooks financial software, and any difference between the receipt amounts is reflected in the customer’s 
new account balance after credits are applied to invoices in QuickBooks. 
   
QuickBooks Financial Software Users: In all cases, both the reversing (return) receipt and the new corrected 
receipt will be sent to QuickBooks as part of the next Financial Exchange, thus automatically updating your 
accounting records accurately. 
  
Return to top 
  
Related Topics 
Copy and correct a reversed receipt 
Sales overview 

Protect Your Customer's Payment Card Data 
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QuickBooks POS Merchant Service | Data Protection Strategy 
  
When you, as a retailer, start accepting credit and/or debit cards for payment using the QuickBooks POS Merchant 
Service, you have a responsibility to comply with the requirements of the Payment Card Industry Data Security 
Standard (PCI DSS). 
This standard includes requirements for the configuration, operation, and security of payment card transactions in 
your business, and extends beyond your use of Point of Sale. It includes requirements for restricting user access, 
as well as for protecting your computers, operating system, and network, and for communications with other 
computers and the Internet. 
  

Note: If you use another merchant service for card payments, the cardholder data is not processed, stored, or transmitted by 
Point of Sale and this topic is not directly applicable to your use of Point of Sale. You should refer to the information provided by 
your service provider for compliance requirements. 

  
Point of Sale has been engineered to help you comply with these requirements in your use of Point of Sale, but it is 
your responsibility to ensure your entire system is in compliance. 
How does Point of Sale assist me in complying with the PCI DSS?  

Point of Sale assists with PCI DSS compliance with the following features: 

• Encrypts the cardholder data stored in your company data, using an industry-standard, strong 
encryption process. 

• Automatically regenerates the keys used to encrypt card data once per year. 

• Provides you a tool to manually generate new encryption keys if you suspect a security breach has 
occurred. 

• Deletes old encryption keys anytime new keys are generated. 

• Automatically strips card information from stored transactions at sixty days of age; so that cardholder 
data is not retained any longer than necessary. 

• Logs all activities related to data access, payment card transactions, and changes to card encryption 
keys in an Audit Log and all failed attempts to log in to Point of Sale are logged in the Windows Event 
Log. 

• Provides a PCI DSS Implementation Guide detailing these features as well as requirements applying 
to the non-POS components of your system. 

  
What happens if I don't comply with the PCI DSS?  

As a merchant, you are required to maintain certain security standards within Point of Sale as well as within 
your Windows operating system, your network, and your connections to the Internet or other computers. 
Adherence to the standards not only is good for your business, as it assures your customers that their 
transactions are being handled in a secure manner, but also is fiscally important as your business could be held 
liable for fines or other damages if your customer's card information is ever stolen or compromised. 
Refer to the PCI DSS Implementation Guide for complete details. 

  
  

PCI DSS Implementation Guide 
Intuit has prepared an electronic Implementation Guide to help you learn about and comply with these 
requirements. You can access this guide via the link below or at anytime by selecting User Manuals from the Help 
menu (Adobe Acrobat Reader required ). 
Open the Implementation Guide now 
  

Where can I learn more about the Payment Card Industry standards? 
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You can learn more about and get a copy of the PCI DSS standard at the PCI Security Standards Council™ site: 
https://www.pcisecuritystandards.org 

  
Related Topics 
Credit card fraud prevention tips 
Generate new credit card keys 
Payment card activity Audit Log 
If you suspect a security breach 

Merchant & Gift Card Services: FAQs 
Merchant Service Overview | Gift Card Service Overview 
  
If you have trouble connecting to or processing transactions through the QuickBooks POS Merchant or Gift Card 
Services, please review this list of common questions and answers. If you cannot resolve your issue here, call our 
customer support at (800) 558-9558. 

How do I fix "Socket Error # xxxx" messages?  

Several possible conditions may cause this problem. Click the link in the error message you receive to start the 
EFT troubleshooter: 

 
  
Or, on the workstation handling communication with the service, right-click the POS Merchant & Gift Service 
icon in the system tray and select Troubleshoot. Select the specific socket error message received and then 
follow the directions provided. 

 
If this icon isn't present in the system tray, restart the workstation and Point of Sale. After the icon is displayed, 
you can close Point of Sale but leave the computer running. 

  

I configured my account and selected the Verify button in the company setup (or company preferences) but got an 
error message. What could be wrong?  

Make a note of the error message you receive. It should help you identify which of the following issues might be 
the problem. Select Preferences > Company from the Edit menu, and then Merchant & Gift Services and 
confirm the following settings: 

 Is the Merchant or Gift Card Account Number entered exactly as provided? 
 Is your account confirmed as active when you select Verify? 

 If the error is for the Gift Card Service, have you received your gift cards yet? Your account may not be 
activated yet if your gift cards have not been sent to you. Try again after receiving your cards. 
 Is your modem or Internet connection set up and working? Select the Communication Setup page in 
preferences and make sure the correct connection type is set correctly to Secure Internet Connection or 
Direct-dial (modem). If necessary, click the Internet Connection Setup button for assistance with an 
Internet connection. 
 If your modem or Internet connection doesn't seem to be working, check it in another program or Web 
page. If you can't connect from other programs either, use Windows help or contact your Internet Service 
Provider for troubleshooting assistance. 

https://www.pcisecuritystandards.org/
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 If connections are going through another computer on your network, is that computer turned on? 
 Depending on your network configuration and hardware, the computer through which connections are 
routed may have to be running. Learn more. 
 Is your modem in use on another connection? 

  

Why do I get "timed out" or firewall and port error messages when trying to authorize or settle credit, debit, or gift 
card transactions?  

Review the configuring firewalls topic for information about opening the correct ports to allow communications 
for merchant and gift card services. In many cases, updating your firewall program to the latest available 
version will automatically correct these issues. 

  

Why am I not able to authorize card transactions on my networked workstations?  
On a network, all communication to the Merchant and Gift Card Services goes through one workstation 
specified in your Point of Sale company preferences. If this workstation has been shut down or if the Merchant 
& Gift Card communication service has been terminated, other workstations will not be able to connect to 
authorize transactions. 
Check your communication setup in company preferences and start (or restart) Point of Sale on the designated 
communication workstation. You can then close Point of Sale on this workstation if desired, but the computer 
must remain running. You should see the Merchant & Gift Card Services icon in the Windows system tray of 
this computer. 

  

Why do I get a "Connection Failed" message when trying to authorize transactions?  

If you get connection failure messages when attempting to connect for credit, debit, or gift card authorizations, 
check your phone line or Internet connection and communication setup to be sure they are configured and 
working. 
If using a dial-up phone connection, ensure that some other program is not accessing your modem. Your 
system is configured with two numbers that can be dialed for electronic funds transactions. If dialing the first 
number fails for any reason, you will briefly see a "Dial Failed" message and then the system will attempt to dial 
the alternate number. It is not necessary for you to take any action when the Dial Failed message is displayed 
in this case; it will be cleared automatically if the second number is successful. 
In the case of a credit card, you prompted to do a manual voice authorization or you can choose to force a 
voice authorization without waiting for the failed connection attempts. 

  

Why do I get an "INVALID_MRCH_#_" message when trying to process a card transaction?  

This message is returned by the processor when the card you are attempting to accept is not a card type 
allowed by your Service agreement. This message does not mean your Merchant/Gift Account Number is 
invalid. Ask the customer for a different form of payment. 

  

Are there steps I can take to minimize the potential of credit card fraud and chargebacks?  

Yes, there are several warning signs and Point of Sale features that can help you recognize and prevent 
fraudulent credit card charges. Review the credit card fraud prevention tips for more information. 

  

A customer lost a gift card and is asking for a replacement. How do I handle this?  

If it conforms with your store policy and you can identify the original gift card number, you can cancel the 
original gift card and issue a new one with the same balance. Click here for more information. 
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What is the Payment Card Industry Data Security Standard (PCI DSS) and how do I comply?  

The Payment Card Industry (PCI) Data Security Standard (DSS) outlines requirements that retailers must 
take to protect their customer's credit and debit card information. The requirements apply not only to how you 
use Point of Sale to authorize, settle, store, and transmit information from card payments, but also to measures 
necessary to protect your operating system, network, and Internet connection. 
Learn more 

  
  
Related Topics 
Configure Point of Sale for a merchant account 
Configure Point of Sale for gift card services 
Help and support overview 

QuickBooks POS Merchant Service Overview 
How do I?   | Merchant Service Hardware | Reports 
  

Learn more about the QuickBooks POS Merchant Service 
  
Overview 
Most retailers will want to sign up for an account with the QuickBooks POS Merchant Service, provided by 
Innovative Merchant Solutions (IMS), an Intuit company, to accept and process credit and debit/ATM card 
transactions. 
Key benefits of the service include: 

• No duplicate data entry. All your credit and debit/ATM card sales are authorized, settled, and 
recorded directly in QuickBooks Point of Sale. 

• Integrated batch settlement reporting within QuickBooks Point of Sale. 

• Choice of modem or secure Internet connection to communicate with the service. 

• Optional cash back option for PIN debit transactions 
You can apply for an account with the QuickBooks POS Merchant Service during the Setup Interview. The 
application takes just minutes to complete, and you’ll receive an approval decision and your Merchant Service 
number promptly. Once received, you enter your Merchant Number in company preferences to enable payments by 
credit and/or debit/ATM card. 
A card reader is recommended, but not required to process credit card transactions (higher fees apply on non-
swipe transactions). A PIN pad is required to process PIN debit transactions. A modem or persistent (always on) 
Internet connection is necessary for transmitting data to and from at least one of your Point of Sale workstations. 
(Hardware sold separately.) 
With QuickBooks POS Merchant Service, each time a customer presents a credit or debit/ATM card as payment, 
the card is swiped through the card reader or PIN pad device. Point of Sale then submits the card information to the 
processor for authorization. Credit card information can also be manually entered. Within seconds, the status of the 
transaction is relayed back to the merchant’s computer. 
Credit and debit card transactions are settled when a merchant runs the End of Day procedure. Settlement initiates 
the actual transfer of funds from the card-issuing bank to the merchant’s bank account. 
Point of Sale records the transaction information on your computer so you can generate reports or access the 
details of a transaction later. You can run Merchant Service reports from the reports area of Point of Sale. 
  

Important Notes: 

• Users of the QuickBooks POS Merchant Service must take steps to comply with the Payment Card 
Industry Data Security Standard (PCI DSS) requirements for the secure processing, storage, and 
transmittal of credit and debit card transactions. 

• Credit card transaction data must be sent to the processor for settlement within one day of authorizing 
the transaction to avoid paying higher fees. 
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Related Topics 
Multiple-location configuration 
What if I use another Service? 

Gift Card Service 

Sign Up and Configure Gift Card Service 

Sign up for the QuickBooks POS Gift Card Service 
How do I?   | QuickBooks POS Gift Card Service Overview 
  
The QuickBooks POS Gift Card Service, provided by Innovative Merchant Solutions, LLC (IMS), an Intuit company, 
allows you to sell, redeem, and track the balance of gift cards from within Point of Sale. An Intuit Payments Account 
is required.  
  

Getting set up is easy!  Learn more 
  
You can sign up from within QuickBooks Point of Sale 2013: 

To sign up for an account with QuickBooks POS Gift Card Service: 
1. From the Point of Sale File menu, select Setup Interview. 
2. Select the Gift Cards tab.  
3. Click Yes.  
4. Type in your Gift Card account number in the field provided. 
5. Click Verify.  

Once your account is approved and you have received your Gift Card Account Number (typically in 2-3 business 
days), configure Point of Sale to work with the Gift Card Service. 
  
Related Topics 
Gift Card Service overview 
Sell or redeem gift cards 
Order custom gift cards 

Configure your System for a Gift Card Account 
How do I?   | QuickBooks POS Gift Card Service Overview 
  

This topic applies to users of the QuickBooks POS Gift Card Service.  What if I use another Service? 

  
Once your account is approved and you have received your Gift Card Account Number (typically in 2-3 business 
days), enter the account number in Point of Sale company preferences and specify how you will communicate with 
the service. Once you have received your cards, you will be ready to start processing gift card transactions. 

To enter your gift card account number: 
1. From the File menu, select Preferences  Company, and then Merchant & Gift Card Services 
from the left-side preferences list. 
2. Enter the account number provided to you in the Gift Card Service area on the page. 
3. Select Communication Setup from the left-side preferences list, and specify how you will 
communicate with the service, either Secure Internet Connection or Direct-dial (modem). Click Internet 
Connection Setup if you need help configuring your Internet connection (this step is not necessary if you 
have already set up communication for the QuickBooks POS Merchant Service): 

http://payments.intuit.com/products/quickbooks-payment-solutions/custom-gift-card-program.jsp


Printed Documentation 

504 

4. Return to the Merchant & Gift Services page and select Verify next to your Gift Card Account 
Number. Point of Sale will do a test connection and confirm that your account is active and ready to use. If 
errors are encountered, a message is displayed with information about resolving the situation. 
5. Select Save. 

  
Related Topics 
Gift Card Service overview 
Sell a gift card 
Redeem a gift card 
Order custom gift cards 

Communication Setup for Merchant and Gift Card Services 
Merchant Service Overview | Gift Service Overview 
  
You specify communication options for the QuickBooks POS Merchant and/or Gift Card Services on the Merchant 
and Gift Card Service  Communication Setup page in company preferences. You must have security rights to 
edit preferences to change this setting. 
Select a connection option: 

• Secure Internet Connection - provides an IP-based connection through your Internet Service 
Provider. This option requires a persistent (always on) Internet connection, such as DSL, cable, or T1. 
Click the Internet Connection Setup button if you need assistance setting up your Internet connection. 

• Direct-Dial - this modem option supports high-speed and advanced modem technologies, 
typically using the modem's default settings. A dedicated phone line is required. 

If you select the direct-dial option, also read about modem setup. 
If you haven't already, return to the main Merchant & Gift Services page and select Verify to test your connection. 

Credit, Debit, and Gift Card Hardware 
Take Payments | Compatible Card Readers | Compatible PIN pads 
  

This topic applies to users of the QuickBooks POS Merchant and/or Gift Card Services. If you use a different service, refer to that 
service's hardware requirements. 

  
Point of Sale supports card readers and PIN pads for processing of credit, debit/ATM, and gift card transactions 
through the QuickBooks POS Merchant and Gift Card Services. 
Credit card and gift card transactions do not require the use of a card reader, but the use of one is highly 
recommended. Swiping a card though a card reader speeds entry, helps avoid errors of hand-keying, and qualifies 
you for lower fees on credit card transactions. PIN debit transactions require the use of a PIN pad. 
The procedure for accepting payment varies depending on your hardware configuration. 
Card Reader (MSR) – Ideal for retailers who accept credit and gift card payments but not PIN debit payments, or 
who will use the card reader in conjunction with the Ingenico 3010 (see below) for processing all card transactions. 
Ingenico Telium iPP3xx and Ingenico eNcrypt 2100 PIN pad – These PIN pads have an integrated card reader 
which can be used to process credit, debit/ATM, and gift card transactions. An added benefit with these device is 
their ability to store authorization information, allowing the customer to swipe their card, enter their PIN, and select 
cash back (if you allow it), all while your cashier is still completing the receipt. When the cashier goes to the 
Payment window, the PIN pad device will send the approved amounts to the correct payment and change fields. 
Ingenico 3010 PIN pad – This PIN pad has no integrated card reader and requires that a card reader also be 
installed on the system. Typically, the customer hands their card to the cashier who swipes it through their existing 
card reader. The customer uses the PIN pad to enter their PIN, optionally request cash back, and approve the total 
amount. 
  
For the most current hardware information, click here.  
  

http://pointofsale.intuit.com/barcode-inventory-software?lid=left_nav
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Important Note: Intuit works closely with the manufacturers of hardware sold by Intuit for use with Point of Sale to ensure these 
devices work together and with the Point of Sale software. Hardware, such as PIN Pads and Physical Inventory Scanners, 
purchased from other sources may not contain the required programming to work with Point of Sale software and/or the 
QuickBooks POS Merchant Service. Intuit does not provide hardware programming, and does not guarantee that devices 
purchased from other third party sources will work with Intuit software. 

  
Related Topics 
Configure merchant and gift card services 
Install an Ingenico PIN pad 

Multiple Locations Using Merchant/Gift Card Service 
Merchant Service Overview | Gift Card Overview | Customer Support 

Pro - Multiple Stores 
For QuickBooks POS Merchant and/or Gift Services customers with multiple physical locations under the same 
ownership, each location must have a separate account with these services, but those accounts can be linked so 
that you receive consolidated reporting and statements. Each location would process authorizations and 
settlements independently. 
For more information, contact the QuickBooks POS Merchant and/or Gift Card Services. 

QuickBooks POS Gift Card Service Overview 
How do I?   | Configuring Point of Sale for Gift Cards 
  
An account with the QuickBooks POS Gift Card Service* provides an integrated gift card processing solution that 
allows you to sell and redeem stored-value gift cards from within your Point of Sale software. 

Key benefits of the service include: 

• No duplicate data entry. All communication with the service and recording ot gift card transactions is done 
directly in your Point of Sale software. 

• Transactions can be automatically posted to your QuickBooks financial software. 

• Card value is tracked on the service’s online servers rather than on the card itself, giving you the flexibility 
to sell in whatever denominations your customers want and to add additional value to a gift card by "re-
charging" the card. 

• Check the outstanding balance of a gift card from the receipt payment screen. 

• Choose from standard or custom cards. Custom cards allow you to add your own store logo and/or artwork 
to your gift cards. 

• Integrated gift card balance and activity reporting within Point of Sale. 
You can apply for an account with the QuickBooks POS Gift Card Service while completing the Setup Interview. 
The application takes just minutes to complete, and you’ll receive an approval decision and your Gift Card Service 
account number promptly. Once received, you enter the account number in company preferences to begin using 
the gift card service. 
A card reader (sold separately) is recommended, but not required to use the Gift Card service. Using a card reader 
is faster and more convenient, but you can just type the number printed on the card to process a transaction. A 
modem and phone line or Internet connection is necessary on at least one of your Point of Sale workstations for 
transmitting data to and from the service. 
  
*Service is optional. Application approval, fees and additional terms and conditions apply. Requires an account 
through QuickBooks POS Gift Card Service, provided by Innovative Merchant Solutions, LLC (IMS), an Intuit 
company, Internet connection or modem and phone line, and gift cards, sold separately. Details available on our 

Website. Terms, conditions, pricing, features and service options subject to change without notice. 
  
Related Topics 
QuickBooks POS Merchant Service for accepting credit and debit cards 
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Sell or Recharge a Gift Card 
Redeem a Gift Card | General Payment Procedure 
  
Gift cards are sold or recharged on sales receipts. Up to three gift cards can be sold on a single receipt. The gift 
card item and sales amount are printed on the customer receipt. 
  

This topic applies to users of the QuickBooks POS Gift Card Service. What if I use another Service?  
 
Note: If you use the Ingenico 2100 or 3070 PIN pads to swipe cards, you must use the alternate procedure for selling gift cards, 
or set up a separate card reader for gift card sales. 

To sell or recharge a gift card: 
1. Start a new receipt with or without other items listed. 
2. Swipe the gift card while in the Enter Items field on the receipt. Alternatively, type Gift Card and then 

press <Enter> to add a gift card to the receipt item list. 
3. In the window displayed, enter the gift card sale amount and swipe the gift card (or manually enter the 

card number) and then select OK. 
4. Repeat for additional gift cards, up to three on the receipt. 
5. Use general payment procedures to accept the amount due or give change until the Payment Complete 

message is displayed. 
Point of Sale connects to the Gift Card Service and updates the balance for the card(s). Progress and 
confirmation messages are displayed. 

6. Save/print the receipt. 
  

Notes: 
• Price (sale amount) is the only editable field when listing a gift card on a receipt as an item. To sell multiple 
cards, enter each as a separate item. 

• If authorization of the gift card fails for some reason, the card is removed from the receipt. 
Related Topics 
Check a gift card balance 
Replace a lost gift card 
Correct or clear payments 
Gift Card Service overview 

Check a Gift Card Balance 
Gift Card Service Overview | Sell or Recharge a Gift Card 
  

This topic applies to users of the QuickBooks POS Gift Card Service.  What if I use another Service? 

To check the balance of a gift card from a sales receipt: 
1. Start a new sales receipt with or without items listed. 
2. From the I Want To menu, select Check Gift Card Balance. 

The Gift Card Balance Inquiry window is displayed. 
4. Swipe the gift card or type  the card number and then click Check Balance. 

Point of Sale connects to the service and displays the card balance. 
  
To view the balances of all outstanding gift cards run the Gift Card Balance Summary report. 
  
Related Topics 
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Collect tips on gift card sales 
Handling returns of purchases made by gift card 
Replace a lost gift card 

Handling Gift Card Returns 
Gift Card Service Overview 
  
Use this procedure to refund amounts for returned merchandise to a gift card. Enter the return on either a sales or 
return receipt and then enter the refund amount in the Gift Card Sell column on the payment window. Entering the 
refund amount as a sale adds the refund amount back to the gift card balance (if using the QuickBooks POS Gift 
Card Service). 

To make a return gift card receipt: 
1. Add the items to a receipt as return items using the same prices at which the merchandise was 
purchased, using normal return methods. 
2. Click Gift Payment Method. 
3. Be sure purchase/recharge card is selected and then swipe the gift card. 
4. Click Save.  
5. Print the receipt.  

  

Notes: 
• At your discretion or according to your store policy, you can also return the refund amount by another 
payment method, such as cash. 

• If the customer wants to return the gift card itself for a refund, and your store policy allows it, use a sales 
receipt with no items listed. Go to the payment window and check the balance of the card. Then enter the 
balance in the Gift Card Redeem field and authorize. A refund of the amount will be suggested as cash 
(change it to a different change method if necessary). 

Related Topics 
Reverse a gift card transaction 
Sell or redeem a gift card 
Replace a lost gift card 
Gift Card Service reports 

Notes on Reversing Receipts of Specific Payment Methods 
Reverse a Receipt | Find a Receipt 
  
When you reverse a sales receipt, the reversing receipt created is a return receipt. The amounts taken in payment 
on the original receipt are returned as change (on paper) to the customer as credits on the return receipt. In this 
way, the accounting is automatically corrected along with the other changes you make on the receipt. The following 
are brief descriptions of how reversing a sales receipt of specific payment methods, and then creating a new 
corrected receipt are handled. Reversing a return receipt works the same way but the payment and change (credit) 
amounts are the opposite. 
  
Cash: The reversing receipt (return) shows the original payment returned to the customer as cash change. Record 
payment on the new corrected sales receipt as cash as well. If there is a difference between the amounts on the 
two receipts, you will need to handle collecting or refunding from/to the customer according to your store policy. 
Check: The reversing receipt (return) shows the original payment returned to the customer as change by check. 
Record payment on the new corrected sales receipt by check as well. If there is a difference between the amounts 
on the two receipts, you will need to handle collecting or refunding from/to the customer, changing the amount of 
the check, or getting a new check according to your store policy and legal requirements in your area. 
Credit Card: The reversing receipt (return) shows the original payment returned to the customer as change by 
credit card. If you use the QuickBooks POS Merchant Service, this receipt will automatically be sent to the card 
processor as part of the next settlement batch. This will result in a credit on the cardholder's account. Record 
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payment on the new corrected sales receipt by the same credit card, authorizing and updating the charge by 
manually entering the card information, if necessary. This new receipt will also be sent with the next settlement 
batch, resulting in a new charge on the cardholder's account. If you do not use the QuickBooks POS Merchant 
Service, follow the same procedure but use the third-party processor's instructions for handling the card credit and 
new authorization. For more information, read canceling and reversing credit card payments. Reversing credit card 
receipts processed through Point of Sale is limited to 60 days after the sale. 
Debit/ATM: Reversing a debit receipt does not create a credit back into the customer’s bank account. When you 
reverse a debit receipt, the change is automatically assigned to cash. If you want to return the money to the 
customer by another method, create a return receipt instead and choose the payment method. Then create a new, 
corrected receipt. 
Gift Card: If you use the QuickBooks POS Gift Card Service and reverse a sale paid by gift card, Point of Sale 
automatically connects to the Gift Card Service servers and adds the original payment amount back to the card 
balance. The refund amount is placed in the Gift Card Purchase field on the payment screen. If you reverse a 
receipt which originally sold (added value) to the gift card, reversing it deducts the reversed amount from the stored 
value of the card. If not using the QuickBooks POS Gift Card Service, the reversing process is the same, but you’ll 
have to use the procedure outlined by your service to add/deduct the value back to the customer’s card. 
Gift Certificate: The reversing receipt (return) shows the original payment returned to the customer as change by 
gift certificate. Record payment on the new corrected sales receipt by gift certificate as well. If you track gift 
certificates by number, enter the same number as the original certificate. If there is a difference between the 
amounts on the two receipts, you will need to handle collecting or refunding from/to the customer according to your 
store policy and legal requirements in your area. 
Account Charge: The reversing receipt (return) shows the original payment returned to the customer as an 
account credit. Record payment on the new corrected sales receipt by account charge. Both receipts are sent to 
your QuickBooks financial software, and any difference between the receipt amounts is reflected in the customer’s 
new account balance after credits are applied to invoices in QuickBooks. 
   
QuickBooks Financial Software Users: In all cases, both the reversing (return) receipt and the new corrected 
receipt will be sent to QuickBooks as part of the next Financial Exchange, thus automatically updating your 
accounting records accurately. 
  
Return to top 
  
Related Topics 
Copy and correct a reversed receipt 
Sales overview 

Gift Card Reports 
POS Gift Card Service Overview | FAQs 
  
Users of the QuickBooks POS Gift Card Service have three gift card reports available in Point of Sale. If you record 
gift card transactions in Point of Sale but process them through another service, only the Gift Card List report is 
available to you. 

To run a gift card report: 
1. From the Report Center, select Payments as the report category and then one of the specific 
types/reports listed above. 
2. The selected report is generated and displayed. 

• Gift Card Service  Balance Summary – A list of all outstanding gift cards and their balances 

• Gift Card Service  Activity Detail – Details of gift card activity in a specified date range 

• Payment Reconciliation  Gift Card List – A listing of transactions using gift cards for 
payment/refund 

Use the report Modify option if you want to apply report filters or change the appearance of the report. For 
example, you could filter the balance report to include only cards with a balance over $100 or change the date 
range to apply to the activity detail report. 
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These reports are based on the transactions recorded in Point of Sale. To verify the current balance of an individual 
card, it is recommended you check the balance from the sales receipt payment screen, which connects to the Gift 
Card service’s online server to check the balance. 
(Pro)  If run at a remote store, gift card reports include only the card activity at that store. If run at Headquarters, the 
reports reflect transactions made at all stores current as of the last completed Store Exchange. 
  
Related Topics 
Modify report options 
Take payment by or sale of a gift card 
Handling returns of gift card purchases 

Credit, Debit, and Gift Card Printed Receipt Options 
Merchant Service Overview | Gift Card Service Overview 
  
Three preference options are available for printing of credit, debit, and gift card receipts. 
  

Automatically Save/Print Credit, Debit and Gift Card Receipts Upon Approval 
With this option selected (default) credit, debit, and gift card receipts are automatically saved and printed as soon 
as the transaction has been authorized when using the QuickBooks POS Merchant or Gift Card Services. This 
allows the cashier to swipe a card and immediately return to servicing the customer while the approval is in process 
and the receipt printing. This option can be disabled, if necessary, on the Merchant and Gift Service page of 
company preferences. 
  

Printing Two Copies of Credit Card Receipts 
When a customer pays for a purchase with a credit card, two copies of the receipt can be printed: a signature copy 
for you and the customer’s copy. 
By default, Point of Sale is configured to print two copies. However, if you use a two-ply receipt paper that prints 
both copies at the same time you should turn off this option, or you will end up with four copies of credit card 
receipts. Set this option independently for each workstation on the print options page of workstation preferences. 
  

Pause Between Printing to Allow Tearing Off Printed Receipts 
By default, Point of Sale is configured to pause briefly after the first copy of a credit card receipt prints so you have 
time to tear it off before the second copy starts printing. If your receipt printer auto-cuts receipts, you can turn off 
this option independently for each workstation on the print options page of workstation preferences. 
  
Related Topics 
Specify the credit cards you accept 
Take payment by credit card 
Take payment by debit/ATM card 
Take payment by gift card 

Merchant & Gift Card Services: FAQs 
Merchant Service Overview | Gift Card Service Overview 
  
If you have trouble connecting to or processing transactions through the QuickBooks POS Merchant or Gift Card 
Services, please review this list of common questions and answers. If you cannot resolve your issue here, call our 
customer support at (800) 558-9558. 

How do I fix "Socket Error # xxxx" messages?  

Several possible conditions may cause this problem. Click the link in the error message you receive to start the 
EFT troubleshooter: 
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Or, on the workstation handling communication with the service, right-click the POS Merchant & Gift Service 
icon in the system tray and select Troubleshoot. Select the specific socket error message received and then 
follow the directions provided. 

 
If this icon isn't present in the system tray, restart the workstation and Point of Sale. After the icon is displayed, 
you can close Point of Sale but leave the computer running. 

  

I configured my account and selected the Verify button in the company setup (or company preferences) but got an 
error message. What could be wrong?  

Make a note of the error message you receive. It should help you identify which of the following issues might be 
the problem. Select Preferences > Company from the Edit menu, and then Merchant & Gift Services and 
confirm the following settings: 

 Is the Merchant or Gift Card Account Number entered exactly as provided? 
 Is your account confirmed as active when you select Verify? 

 If the error is for the Gift Card Service, have you received your gift cards yet? Your account may not be 
activated yet if your gift cards have not been sent to you. Try again after receiving your cards. 
 Is your modem or Internet connection set up and working? Select the Communication Setup page in 
preferences and make sure the correct connection type is set correctly to Secure Internet Connection or 
Direct-dial (modem). If necessary, click the Internet Connection Setup button for assistance with an 
Internet connection. 
 If your modem or Internet connection doesn't seem to be working, check it in another program or Web 
page. If you can't connect from other programs either, use Windows help or contact your Internet Service 
Provider for troubleshooting assistance. 
 If connections are going through another computer on your network, is that computer turned on? 
 Depending on your network configuration and hardware, the computer through which connections are 
routed may have to be running. Learn more. 
 Is your modem in use on another connection? 

  

Why do I get "timed out" or firewall and port error messages when trying to authorize or settle credit, debit, or gift 
card transactions?  

Review the configuring firewalls topic for information about opening the correct ports to allow communications 
for merchant and gift card services. In many cases, updating your firewall program to the latest available 
version will automatically correct these issues. 

  

Why am I not able to authorize card transactions on my networked workstations?  
On a network, all communication to the Merchant and Gift Card Services goes through one workstation 
specified in your Point of Sale company preferences. If this workstation has been shut down or if the Merchant 
& Gift Card communication service has been terminated, other workstations will not be able to connect to 
authorize transactions. 
Check your communication setup in company preferences and start (or restart) Point of Sale on the designated 
communication workstation. You can then close Point of Sale on this workstation if desired, but the computer 
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must remain running. You should see the Merchant & Gift Card Services icon in the Windows system tray of 
this computer. 

  

Why do I get a "Connection Failed" message when trying to authorize transactions?  

If you get connection failure messages when attempting to connect for credit, debit, or gift card authorizations, 
check your phone line or Internet connection and communication setup to be sure they are configured and 
working. 
If using a dial-up phone connection, ensure that some other program is not accessing your modem. Your 
system is configured with two numbers that can be dialed for electronic funds transactions. If dialing the first 
number fails for any reason, you will briefly see a "Dial Failed" message and then the system will attempt to dial 
the alternate number. It is not necessary for you to take any action when the Dial Failed message is displayed 
in this case; it will be cleared automatically if the second number is successful. 
In the case of a credit card, you prompted to do a manual voice authorization or you can choose to force a 
voice authorization without waiting for the failed connection attempts. 

  

Why do I get an "INVALID_MRCH_#_" message when trying to process a card transaction?  

This message is returned by the processor when the card you are attempting to accept is not a card type 
allowed by your Service agreement. This message does not mean your Merchant/Gift Account Number is 
invalid. Ask the customer for a different form of payment. 

  

Are there steps I can take to minimize the potential of credit card fraud and chargebacks?  

Yes, there are several warning signs and Point of Sale features that can help you recognize and prevent 
fraudulent credit card charges. Review the credit card fraud prevention tips for more information. 

  

A customer lost a gift card and is asking for a replacement. How do I handle this?  

If it conforms with your store policy and you can identify the original gift card number, you can cancel the 
original gift card and issue a new one with the same balance. Click here for more information. 

  

What is the Payment Card Industry Data Security Standard (PCI DSS) and how do I comply?  

The Payment Card Industry (PCI) Data Security Standard (DSS) outlines requirements that retailers must 
take to protect their customer's credit and debit card information. The requirements apply not only to how you 
use Point of Sale to authorize, settle, store, and transmit information from card payments, but also to measures 
necessary to protect your operating system, network, and Internet connection. 
Learn more 

  
  
Related Topics 
Configure Point of Sale for a merchant account 
Configure Point of Sale for gift card services 
Help and support overview 

Using Another Merchant Service 
Payment Overview | Sign Up for a Merchant Account 
  
If you do not have an account with the QuickBooks POS Merchant Service, you can still record credit card 
payments and refunds, and debit/ATM card payments in Point of Sale. 
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1. Add items and customer to the receipt and then click the Credit or Debit payment button, as 
appropriate. 
2. Enter the payment amount in the Credit Card or Debit/ATM Card field and accept it. 

• Credit card payments: Select Charge or Refund, edit the amount if necessary, and click the card 
type from the displayed list (from your preference settings). 

 
• Debit/ATM payment: Edit the amount, if necessary, and enter optional cash back, then click 
Save. 

 
3. Follow your service’s instructions for authorizing the payment. 
4. Save/print the receipt. Follow your service's instructions for having the customer sign the 
merchant copy. 

When using another merchant service for these transactions: 

• You cannot authorize or settle the transactions from within Point of Sale and reports regarding settlement 
are not available. 

• You can view lists of your credit and debit payments in the Payments  Payment Reconciliation  
Credit Card List and Debit Card list reports. 

• Cash Drawer reports (X/Z-Out) will reflect these transactions. 

• If integrated with QuickBooks Financial Software, the transactions will be sent to QuickBooks and be 
posted to the appropriate accounts. 

• Not all Merchant Service preferences related to credit and debit card transactions apply to you (applicable 
preferences marked with an * in help). 

• You can specify the credit card types accepted in your receipt tendering preferences. 
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Financial Exchange with QuickBooks 

Configure for Financial Exchange 

Requirements of QuickBooks Integration 
Financial Exchange Overview | QuickBooks Connection Wizard | FAQs 
  
Before you can connect Point of Sale to your QuickBooks financial software and share data, the following 
requirements must be met: 

• You must be using QuickBooks financial software, Pro or Premier Editions (2007 - 2011), or 
Enterprise Solutions (7.0 - 11.0) 

• If connecting across a network, a properly installed and configured network with mapped drives as 
appropriate for your installation choice   

Networking issues and FAQs 

• You must have installed QuickBooks and set up the company file you will use with Point of Sale 
QuickBooks installation options 
How do I set up my QuickBooks company file? 

• To initially establish the connection between the programs, your QuickBooks financial software 
must be running and your company file open 

If you meet all of these requirements, you are ready to use the connection wizard to connect to QuickBooks. 
  
I am still having trouble connecting. What could be wrong?   

Prepare QuickBooks for Financial Exchange 
Financial Exchange Overview | Connect to QuickBooks 
  
Before you can share data, you should prepare your QuickBooks financial software by doing the following: 

• Make a backup copy of both your Point of Sale and QuickBooks files.  (Create a unique name for the 
backup. For example: "POS backup before QB"). 

• Install QuickBooks on the same computer as QuickBooks Point of Sale 2013 for sharing.  

• Turn on the collection of sales tax, if applicable.  

• Turn on Inventory, if applicable. 

• Clean up QuickBooks lists (optional, if you plan to import data) 
Related Topics 
Set QuickBooks preferences to allow access 
Turn on the collection of sales tax 
Clean up QuickBooks lists  
  
Related Topics 
Troubleshoot Financial Exchange 

QuickBooks Financial Software Installation Options 
Requirements of Integration | Financial Exchange Overview 
  
If you are integrating Point of Sale with QuickBooks financial software, there are three options for how the two 
programs can be installed relative to one another to share data. 
The three options are summarized here. Use the links provided on this page to get more information. 
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Installation Option 1:  QuickBooks financial software installed on the Point of Sale Server 
Workstation 

• This is the simplest and most commonly used configuration. 

• This is the only choice if you have only one computer. 

• On a network, the Point of Sale Server Workstation and QuickBooks would typically be installed in the 
office, with additional Point of Sale client workstations as the front "registers." 

• If you are new to QuickBooks financial, create a file there first. Then use the Connection Wizard from 
within Point of Sale to establish the connection between the programs. 

  

Installation Option 2:  QuickBooks financial software installed on both the Point of Sale Server 
Workstation and another Network Computer 

• This option can be used if you have only one Point of Sale workstation, which you need to have at the front 
register but you prefer to use your financial software at another computer (such as in the back office). 

• This configuration requires a peer-to-peer network with mapped network drives. 

• You can install this way even with a single license of your QuickBooks financial software. 

• Once configured, the copy of QuickBooks financial software on the Point of Sale Server workstation can be 
"silent", i.e., it does not ever have to be opened, but it cannot be uninstalled. 

• Additional Point of Sale or QuickBooks workstations could be added to the network with proper licensing. 
Learn more about this option, including how to set it up. 

  
  

Installation Option 3:   QuickBooks financial software installed only on another Network 
Computer 

• This option, called Remote Data Sharing (or RDS), is the most complex to set up and use, but offers an 
alternative way to share data across your network. 

• Uses RDS Server and Client applications which must be installed in addition to Point of Sale and 
QuickBooks financial software. These applications are available for download from our support site. 

• Both your Point of Sale and QuickBooks company files must be open during Financial Exchanges. 
Learn more about RDS, including how to get the server/client applications you need to set up this option. 

  
  
Related Topics 
Prepare QuickBooks for Financial Exchange 
QuickBooks Connection Wizard Overview 
Customize Financial Exchange 

Set QuickBooks Preferences to Allow Access 
Overview | Customize Exchanges | FAQs 
  
Access preferences must be set in your QuickBooks financial software to allow Point of Sale to send/receive 
information from your financial company file. Typically, this access is granted when you run the connection wizard. 
However, this option may vary slightly between versions of QuickBooks and you may have to set this preference 
manually as described below. 

To make sure QuickBooks allows access to Point of Sale: 
1. From the Edit menu in your QuickBooks financial software, select Preferences and then select 
Integrated Applications. 
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2. Select the Company Preferences tab and make sure the following checkbox is NOT selected: 

• "Don’t allow any applications to access this company file" 
3. Select OK to save your changes. 

 
  

Allowing Access even when QuickBooks financial software is not Running 
While QuickBooks must be running and your company file open to initially establish the connection, you can set 
your QuickBooks preferences to allow Point of Sale to log in automatically, even when QuickBooks is not running, 
for future exchanges. 
Note: This setting is only available after the initial connection is made. This setting is not applicable if you are using 
the remote data sharing connection option. 

1. Go to your Integrated Applications preferences in QuickBooks, as described above. 
2. Select the application QuickBooks Point of Sale and then select properties. 
3. Make sure the option checkboxes on the Access Rights tab are set as follows: 

Selected: 

• "Allow this application to access this company file" 

• "Allow this application to log in automatically" 
Not selected: 

• "Prompt before allowing access" 
4. Select or create a user that Point of Sale will use to log in. We recommend that you select 
"Admin" as the user, but you can create a new one if desired. The specified user must have rights to 
access all data areas of the company file. 

For example, if you create a user named "QB POS" and select this as your login choice, Point of Sale will log 
in with this identity (and corresponding access settings). Make sure the "QBPOS" user has full access rights. 

5. Select OK to save these settings in QuickBooks. 
  
Related Topics 
Troubleshoot Financial Exchange 

Set Up QuickBooks Sales Tax 
Sales Tax Overview | Sales Tax Integration 
  
If you collect sales tax, you must have sales tax turned on in your QuickBooks financial software, so that Point of 
Sale can send sales tax information. 

To turn on the collection of sales tax in QuickBooks financial software: 
1. Start your QuickBooks financial software and open the company file which you are going to 
integrate with Point of Sale. 
2. From the QuickBooks Edit menu, select Preferences. 
3. Select Sales Tax from the left-side preferences menu. 
4. Select the Company Preferences tab. 
5. If you collect sales tax, make sure the response for "Do you charge sales tax?" is Yes. 

If you do not charge sales tax, answer No. 
6. Select OK. 
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With this setting turned on, Point of Sale will automatically create sales tax items and tax codes, as necessary, in 
QuickBooks when sending sales tax information. Learn more. 
  

Custom Mapping of Sales Taxes to QuickBooks 
If you prefer to set up your own QuickBooks sales tax items, or if you wish to use sales tax groups in QuickBooks to 
pay taxes to multiple agencies, define them in QuickBooks first. Then, when setting up sales tax codes in Point of 
Sale, link them to the applicable tax items/groups you have set up in QuickBooks. Refer to your QuickBooks 
documentation and help files for more information about defining tax items and groups. 

Remote Data Sharing (RDS) 
QuickBooks Installation Options | Financial Exchange Overview 
  
Remote Data Sharing (RDS) is an alternative method for integrating Point of Sale with QuickBooks financial 
software over a local area network (LAN) using server/client applications. View Illustration 
  

Note: VPN's and wireless networks tend to be low bandwidth (slow) and therefore are not recommended for use with RDS. These 
network configurations may be unreliable for this purpose. 

  

Advantages of RDS 
• Doesn't require that QuickBooks financial software be installed on your Point of Sale Server Workstation, 
which may be accessible to employees. 

Disadvantages of RDS 
• More complex to set up and use than other integration methods 

• Terminology can be confusing: the "server" and "client" for RDS purposes do not correlate with the Point of 
Sale "Server" and "Client" Workstations 

• During data exchanges, your QuickBooks financial software and the RDS server application must be 
running, and your financial company file open on the computer that has QuickBooks 

Get the RDS Files and Documentation 
You can download the RDS application files and the most recent documentation for RDS from the following web 
site. This is a free download. 

 http://support.quickbooks.intuit.com/support/Articles/INF12336 
  
Related Topics 
Troubleshoot Financial Exchange 
Prepare QuickBooks for Financial Exchange 
QuickBooks Connection Wizard Overview 
Customize Financial Exchange 

Customize Financial Exchange 

Customize Financial Exchange 
Overview | Troubleshoot Financial Exchange 
  
Point of Sale offers several options for customizing the way information is sent to QuickBooks and, if you imported 
existing QuickBooks customers, vendors, and inventory items to Point of Sale, you should review and edit the 
imported records to take full advantage of Point of Sale features. 
  

Customizing Financial Exchanges 

http://support.quickbooks.intuit.com/support/Articles/INF12336
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Customize account and payment type mappings 
Customize item account and sub-account mappings 
Send summarized vs. detailed sales & receiving information 
Send original and discounted item sales values 
Change where vendor billing information is entered 
Change the customer name order for Financial Exchanges 
  

Reviewing Data Imported from QuickBooks 
Imported vendors 
Imported items 
Departments for imported items 
Imported customers 
Purchase orders in QuickBooks 
  

Warning: Inventory items are not exchanged during routine Financial Exchanges. However, customers and vendors are. 
Any data imported from QuickBooks financial software during daily exchanges should be subjected to the same review as 
outlined in the topics above. To avoid data discrepancies and save data review time, it is advised that you add or edit items, 
customers, and vendors only in Point of Sale after the two programs are sharing data. 

Summarized vs. Detailed Item Information 
Exchange Overview | Customize Exchanges | FAQs 
  
In your Point of Sale company preferences, you can choose whether to send summarized or detailed item 
information to QuickBooks on receipts and vouchers. The choice depends on the level of detail you want in your 
financial software regarding your Point of Sale activities. 
We recommend you read this entire topic carefully before making a change in this setting. 

To specify detailed or summarized information for Financial Exchange: 
1. From the File menu, select Preferences  Company. 
2. On the Financial page, select from one of the three options for sending receipts and vouchers: 

• With Detailed item descriptions 

• With Detailed item descriptions for customer charge account transactions only 

• With Summarized item totals (no item detail: default) 
3. Select Save. 

You change will go into effect with the next Financial Exchange. 
  

About This Choice 
By default, these documents are sent to QuickBooks in the summarized format. This streamlines Financial 
Exchange and presents data in a concise format in QuickBooks. In most cases, sending summarized data is the 
most efficient way to transfer data. However, you may wish to send detailed documents to your financial software if 
you need or want: 

• The ability to print reports or statements in QuickBooks showing item descriptions for sales and receiving 
documents (e.g. the specific items sold or received). 

• The ability to see individual sales documents in QuickBooks, rather than consolidated documents. 

• The ability to run reports or do customer mailings with customer information from receipts. 
Detailed document posting DOES NOT mean that inventory information (items, quantities, costs, etc.) are sent to 
QuickBooks 
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Here’s how the different formats handle sending data to QuickBooks: 
  
Summarized item totals: (Default) 

• Certain documents are consolidated by day. For example, all receipts paid by cash, credit card, debit card, 
and gift card/certificate for a particular day are consolidated and sent to QuickBooks as a single receipt for 
the total amount of sales. 

• Sales documents do not list individual items. Instead, items are consolidated by tax code. For example, if 
you have a tax code called "Tax," the total amount of all items sold on a document that belong to that tax 
code are listed under an item called "POS Tax Sales." 

• Documents created from vouchers (bills, credits, or item receipts) do not list individual items. 

• Customer information is not included on consolidated receipts (but is included if the sale was paid by 
account charge). 

Detailed item descriptions: 

• Receipts are never consolidated and include item detail and the customer name (if the Use With 
QuickBooks flag is selected in the customer record). 

• Receipts and documents created from vouchers list individual items, including serial numbers, if recorded. 

• Journal entries for Cost of Goods Sold (COGS) list the Point of Sale receipt numbers. 

• (Pro) If tracking customers by company name and including customer's PO # on POS sales receipts, the 
PO # is included on receipts and invoices created in QuickBooks. 

Note: Detailed item information applies only to sales receipts and to documents created from vouchers. If you select to send 
detailed data to QuickBooks, documents such as adjustment memos will still be sent in a consolidated format. Likewise, 
General Journal transactions for vouchers will not show individual items. 

  
Detailed item descriptions for customer charge account transactions only: 

• Receipts for sales that are charged to a customer's account are sent with item descriptions and customer 
information so you can send itemized statements. 

• All other receipts and vouchers are sent in summarized format with no item detail. 
Return to top 
  

Inactive Items Created in QuickBooks for Detailed Exchanges 
When using detailed item posting, Point of Sale creates an inactive, non-inventory item in QuickBooks for each 
item sold or received on Point of Sale documents sent to QuickBooks. It is these inactive items that are listed on 
the QuickBooks documents created during Financial Exchanges. 
An item is only created once. Subsequent appearances of the item on sent documents will not create another 
inactive QuickBooks item. These items are made inactive, non-inventory items so that they don’t show up in your 
default QuickBooks item list view. This is because they are tracked in Point of Sale, not in QuickBooks, and you 
should not use them in QuickBooks for other purposes or edit them. These items are meant to be used solely for 
the purpose of detailed Financial Exchanges. 
  

Note: Item List Limit in QuickBooks. If you have a large inventory, these inactive items may cause you to reach the maximum 
number of items allowed in QuickBooks. See the Item List Limit in QuickBooks topic for more information. 

  
Return to top 
  
Related Topics 
Troubleshoot Financial Exchange 

Default Chart of Accounts and Mappings 
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Overview | Customize Financial Exchange | FAQs 
  
These tables display the default accounts and payment type mappings used by Point of Sale to transfer data to 
your QuickBooks financial software. 
Learn how to use custom accounts or mappings 
  

Default Account Mappings 
Point of Sale QuickBooks Account Account Type 

Cash In Drawer Cash In Drawer  Note  Bank 

Check Undeposited Funds Other Current Asset 

Credit Card Undeposited Funds Other Current Asset 

Debit Card Undeposited Funds Other Current Asset 

Gift Certificates Gift Certificates 
Outstanding 

Other Current Liability 

Gift Card Gift Cards Outstanding Other Current Liability 

Accounts Receivable Accounts Receivable Accounts Receivable 

Sales Tax Sales Tax Payable Other Current Liability 

Customer Order 
Deposit Taken 

Customer Deposits Other Current Liability 

Purchase Clearing Unbilled Purchases Other Current Liability 

Voucher Adjustment Purchase Discounts Cost of Goods Sold 

Freight In Freight & Shipping Costs Expense 

Voucher Fee Freight & Shipping Costs Expense 

Accounts Payable Accounts Payable Accounts Payable 

Document Offset POS Inventory 
Adjustments 

Cost of Goods Sold 

Shipping Shipping and Delivery 
Income 

Income 

Pay out Expense Cash Drawer Payouts Expense 

Tips Employee Tips Payable Other Current Liability 

POS Balancing 
Adjustments 

Balancing Adjustments Other Expense 

Return to top 
  

Default Payment Type Mappings 
Point of Sale Payment QuickBooks Payment Method QuickBooks Payment Type 

Cash Cash Cash 

Check Check Check 

Debit Card Debit Card Debit Card 

Credit Card: American Express American Express American Express 

Credit Card: MasterCard MasterCard MasterCard 

Credit Card: Visa Visa Visa 

Credit Card: Discover Discover Discover 
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Credit Card: Diners Club Diners Club Other Credit Card 

Credit Card: JCB JCB Other Credit Card 

Return to top 
  

Default Item Account Mappings 
POS Item 
Type 

Income 
Account 

COGS Account Asset Account 

Inventory Merchandise 
Sales 

Cost of Goods Sold Inventory Asset 

Non-inventory Merchandise 
Sales 

Purchases - Resale 
Items 

Purchases - 
Resale Items 

Service Service Sales Subcontracted 
Services 

Subcontracted 
Services 

Assembly Merchandise 
Sales 

Cost of Goods Sold Inventory Asset 

Special Order Merchandise 
Sales 

Cost of Goods Sold Inventory Asset 

Group n/a n/a n/a 

Return to top 
  
Related Topics 
Customize account mappings 
Troubleshoot Financial Exchange 

Custom Mapping of Financial Exchange Accounts 
Overview | Customize Financial Exchange | FAQs 
  
Mapping accounts and payment types creates a link between Point of Sale and QuickBooks, so that your point-of-
sale information is sent to QuickBooks in the manner you prefer. 
  

Using the Default Account Mappings 
A default Chart of Accounts is used by Point of Sale to send information to QuickBooks. When using the default 
account mappings: 

• If the default accounts don’t already exist in your QuickBooks financial software chart of accounts, Point of 
Sale automatically creates most of them for you. 

• Certain default accounts, including Undeposited Funds, Accounts Payable, Accounts Receivable, Sales 
Tax Payable, Cost of Goods Sold, and Inventory Asset are by Point of Sale in your financial software. 

What if I already have the same account types with custom names in QuickBooks?   
  

Warning: If you are using the QuickBooks POS Merchant Service reconciliation feature, the default account and payment type 
mappings for credit and debit cards are required. If you change these mappings, the reconciliation feature will not work. 

  

Customizing the Account Mappings 
The default accounts are necessary to establish the initial connection with QuickBooks. However, once the 
connection is established, you can customize the mappings to QuickBooks accounts. 
How to map custom accounts  
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1. Create the custom accounts in your QuickBooks financial software and save. 
This makes the accounts available for selection in Point of Sale company preferences. 

2. In Point of Sale, close all open windows. 
3. From the File menu, select Preferences  Company. 
4. Select Financial  Accounts from the preferences menu on the left of the window. 
5. On the Basics tab, specify an Income, Cost of Goods Sold, and Asset account for each 
item type (not all item types use all accounts). 

• With few exceptions, all of your QuickBooks accounts are available for selection from the 
drop-down list in each field. The accounts specified here are suggested by Point of Sale for all new 
items added to inventory, but you can change the accounts item-by-item in inventory as needed. 

• You can also create sub-accounts based on your departments and/or stores. Learn more. 
6. Optionally, select Apply Accounts to Existing Items to apply your changes to all current 
inventory items. 

Warning: Selecting this option overwrites any previous item-level account mapping. 
7. On the Advanced tab, for each Point of Sale field on the left, select an account from the list in 
the QB Account column. Scroll through the drop-down list in each field to view all of the mapping 
choices. 

You can reset your account mappings to the default accounts by selecting Reset to Defaults on this tab. 
8. Select Save. 

The account mappings you have defined will go into effect with the next Financial Exchange with QuickBooks. 
  

  
Important Note about the Cash in Drawer Mapping  
  

Payment Type Mappings 
Payment type mappings cannot be changed in Point of Sale. Point of Sale will always map to the payment methods 
specified in the default mappings table. To change these mappings requires that you change the payment types 
associated with these payment methods in your QuickBooks financial software. 
Important: If using the QuickBooks POS Merchant Service and QuickBooks 2009 financial software, changing the 
payment type mappings will cause the merchant service reconciliation feature to stop functioning. 
  
Related Topics 
Review your Point of Sale setup for Financial Exchange 
How QuickBooks financial software handles POS data 
Troubleshoot Financial Exchange 

Mapping Item Accounts 
Financial Exchange Overview | Customize Exchanges | FAQs 
  
The default item Cost of Goods Sold (COGS), Income, and Asset accounts, used to post item sales to your 
QuickBooks financial software, are defined in Point of Sale company preferences. The default accounts are 
assigned to all items in inventory. 
You can also have Point of Sale create item sub-accounts by appending the name of the department (and/or store 
name) to the end of the default account name. Learn more about sub-accounts. 
There may be circumstances under which you want individual item sales or costs to post to accounts other than the 
defaults. You can change the default accounts, so they are suggested for all new items, or use the following 
procedure to assign different accounts on an item-by-item basis. 

To assign QuickBooks accounts to an individual item: 
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1. Make sure the accounts you want to use are set up in your QuickBooks financial software. 
This makes them available for selection on the item record. 

2. Display the Point of Sale item form, then select the Additional Info tab. 
3. Make new selections from the drop-down lists for COGS, Income, and/or Item Asset accounts. 
4. Edit information in other item fields as applicable. 
5. Select Save. 

Your new account mappings will go into effect on the next Financial Exchange with QuickBooks. 
  

Note: 
• With a few exceptions  for item Income accounts, Point of Sale does not place limitations on the 
QuickBooks account types you can map for items. All of your QuickBooks accounts are available for 
selection. This mapping freedom allows, for example, you to map a service or non-inventory item’s cost to a 
QuickBooks financial expense account. 

• Mapping to account types other than COGS, income/other income, or asset accounts in QuickBooks may 
produce unusual results. 

• Item account columns are available to add to your item list and selected inventory reports. 
Related Topics 
Review your Point of Sale setup for Financial Exchange 
Troubleshoot Financial Exchange 
Customize List Columns 
Modify Reports 

Customer Name Order for Financial Exchanges 
Overview | Customize Financial Exchange | FAQs 

Basic  

Point of Sale and QuickBooks both have First and Last name fields for customers. QuickBooks also has a full 
Customer Name field, which is populated with some combination of first and last, or company names when Point of 
Sale sends new customer records to QuickBooks. 
(Pro) For business customers (Track as Company checkbox selected on customer record), Point of Sale will 
always send the customer's company name to the full Customer Name field in QuickBooks. 
For individual customers, use this setting to control the order of the customer name sent by Point of Sale to the Full 
Name field in QuickBooks. 

To change the customer name order: 
1. From the Point of Sale Edit menu, select Preferences  Company. 
2. On the Financial preferences page, select one of the three name order options: 

<last>,<first> 
<first><last> 
<title><first><last> 

3. Select Save. 
  
Related Topics 
Review your Point of Sale setup for Financial Exchange 
How QuickBooks financial software handles POS data 
Troubleshoot Financial Exchange 

Customize Financial Exchange 
Overview | Troubleshoot Financial Exchange 
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Point of Sale offers several options for customizing the way information is sent to QuickBooks and, if you imported 
existing QuickBooks customers, vendors, and inventory items to Point of Sale, you should review and edit the 
imported records to take full advantage of Point of Sale features. 
  

Customizing Financial Exchanges 
Customize account and payment type mappings 
Customize item account and sub-account mappings 
Send summarized vs. detailed sales & receiving information 
Send original and discounted item sales values 
Change where vendor billing information is entered 
Change the customer name order for Financial Exchanges 
  

Reviewing Data Imported from QuickBooks 
Imported vendors 
Imported items 
Departments for imported items 
Imported customers 
Purchase orders in QuickBooks 
  

Warning: Inventory items are not exchanged during routine Financial Exchanges. However, customers and vendors are. 
Any data imported from QuickBooks financial software during daily exchanges should be subjected to the same review as 
outlined in the topics above. To avoid data discrepancies and save data review time, it is advised that you add or edit items, 
customers, and vendors only in Point of Sale after the two programs are sharing data. 

Financial Exchange Overview 
How do I?   | Customize Exchanges | Reports | FAQs 
  
This version of Point of Sale can be integrated with the following versions of QuickBooks financial software: 

• Pro or Premier Editions (2007 - 2010) 

• Enterprise Solutions (7.0 - 10.0) 
Integration and exchange of data with QuickBooks, while providing many benefits, is not required. 
Point of Sale tracks your daily point-of-sale business: purchasing, receiving, and selling merchandise, and tracking 
inventory and customers. QuickBooks financial software helps you pay bills, manage cash flow, invoice customers, 
and run financial reports. 
Exchanging information between the two programs, called Financial Exchange, can be done at any time (typically 
as part of your End of Day procedure) and can significantly reduce your workload because you can conduct your 
inventory and sales activities in Point of Sale, then transfer the resulting data directly to your financial software. 
There’s no need to enter information twice! 
Several options are available for you to customize how your Point of Sale data is transferred to QuickBooks so that 
it works for your business model and how you like to have your retail activities reported. 
Financial Exchange allows you to get the most from the specialized features of each program by splitting key 
business activities between them as shown below (this is not an all-inclusive list of the features in either program): 
  

Activity POS QBFS 

Add/track inventory X   

Order and receive merchandise X   
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Make sales and collect sales tax X   

Run sales and merchandise reports X   

Add customers or vendors* X X 

Enter vendor billing info (invoices)** X X 

Track cost of goods and expenses   X 

Pay bills and sales taxes   X 

Invoice customers   X 

Process payroll   X 

Run financial reports   X 

Banking activities   X 

POS = Point of Sale QBFS = QuickBooks financial software 
*  Recommend doing in Point of Sale 
** Preference option; controls how receiving information is shared 
  
Related Topics 
What data is shared? 
Requirements of Financial Exchange 
How QuickBooks handles POS data 
Default chart of accounts & mappings 
Security rights for Financial Exchange 

What information is exchanged with QuickBooks? 
How do I?   | Overview | Exchange Reports 
  
All transactions and data of the following types that has not previously exchanged is sent each time Financial 
Exchange is initiated. Your Financial Exchange settings may affect what and how data is sent. 
  

Point of Sale to QuickBooks QuickBooks to Point of Sale 

• New customers and 
updated customer 
information (except account 
balances) 

• New vendors and 
updated vendor information 
(active) 

• New vendor payment 
terms 

• Sales information 
(receipts, deposits, sales 
tax, shipping) 

• Payments on account 

• Cash drawer payouts 

• Receiving information 
(vouchers) 

• Vendor billing 
information (optional) 

• New customers and 
updated customer 
information, including 
account limit, balance, 
aging status, and any 
past due amount 

• New vendors and 
updated vendor 
information (active) 

• New vendor payment 
terms 

• Inventory items (not 
routinely; must manually 
import) 
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• Inventory adjustments 
(memos, aggregated) 

• Employee time records* 

• Multi-store transfer 
information 

* Requires QuickBooks 2009 

The Financial Center 
Overview | Customize Financial Exchange | FAQs 
  
The Financial Center provides a single access point to all activities related to exchanging data with QuickBooks 
financial software.  

To access the Financial Center: 

• From the Financial menu, select FINANCIAL CENTER. 
Or 

• Select FINANCIAL CENTER from the Navigator. 

 

From the Financial Center, you can: 

• Confirm the connection and last exchange status, and the names of the company files for both programs 

• Manually initiate a Financial Exchange (select Update QuickBooks Now) 

• View the activity log to see results of previous exchanges 
The following options are available after selecting Show Advanced Options from the Overview page: 

• Set up or modify your connection to QuickBooks with the connection wizard 

• Import items from QuickBooks 

• Recover data (resend for a specified date range) to your QuickBooks company file in the event of a data 
loss in QuickBooks 

Related Topics 
Troubleshoot Financial Exchange 

QuickBooks Connection Wizard Overview 
Financial Exchange Overview | Troubleshooting 
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The QuickBooks Connection Wizard can assist you in establishing the connection between Point of Sale and your 
QuickBooks financial software. 
If you haven’t already, you may want to read the following topics: 
Requirements for QuickBooks integration 
Prepare QuickBooks for Financial Exchange 
  
The wizard will help you select the QuickBooks company file with which you will share Point of Sale data and will 
configure Point of Sale so that it will reconnect to the same QuickBooks company file automatically in the future. 
The wizard will also alert you if a condition exists that prevents the connection and help you rectify the problem so 
you can continue. 
The wizard will start automatically when a connection is needed or you can start it manually at anytime in Point of 
Sale by selecting Set Up QuickBooks Connection Now from: 

• The Financial Center (select Financial Center from the Financial menu or from the Navigator), or 

• The Financial page of company preferences 
If this is your first time connecting the programs, launch QuickBooks and open your financial company file before 
selecting Next on the connection wizard page. 

Import QuickBooks Items 
Overview | Customize Financial Exchange | FAQs 
  
(Pro) This option is available at Headquarters only. 
You may have existing items in QuickBooks that you now want to track in Point of Sale. You can easily import 
these items to Point of Sale at any time, making them available to list on Point of Sale documents. Importing your 
QuickBooks items is optional. After importing, inventory items are not routinely exchanged between the two 
programs. The imported items should be tracked only in Point of Sale after import. 
After the two programs are integrated, you will be prompted to import your QuickBooks items each time you open 
your item list in Point of Sale until you elect to import or indicate that you do not want to import. Choose Ask Me 
again Later if you plan to import, but are not ready to do at this time. 

To manually initiate an import of your QuickBooks items: 
1. Make sure your QuickBooks financial software is running and in single-user mode. 
2. Select Import QuickBooks Items from the Financial menu or from the Advanced Options page 
of the Financial Center. 

  

More Information about Importing QuickBooks Items 
What are the benefits of importing my QuickBooks Items? 
Are there reasons I may not want to import my QuickBooks Items? 
Can I import QuickBooks items later? 
Can I import some items and not others? 
Can I control how my imported inventory items are described in Point of Sale? 
  

Notes: 
• Importing of items from QuickBooks can be done multiple times. This can be helpful if you import only 
selected items the first time and later want to import the others, want to import from multiple QuickBooks 
company files, or have added new items to QuickBooks after the initial import. Be careful not to import the 
same items a second time or duplicate item records will be created in Point of Sale. 

• Once imported, the imported items should no longer be tracked in QuickBooks. It is strongly recommended 
that all purchasing, receiving, and selling of these items be done in Point of Sale only. 

• The on-hand quantity of imported items is set to zero (0) in QuickBooks and a compensating General 
Journal transaction is created to debit the Inventory Asset account. On the Point of Sale side, inventory 
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adjustment memos are created to record the addition of the items to inventory. The memos are sent to 
QuickBooks, balancing against the General Journal transaction so that no net change in inventory value 
occurs. 

• Imported items should be reviewed and edited to take advantage of the inventory tracking and control 
features in Point of Sale. 

• If you have existing items (and customers and vendors) in an application other than QuickBooks financial 
software, you may be able to import this data using the Data Import Wizard. 

Related Topics 
Financial Exchange overview 
Troubleshoot Financial Exchange 

Initiate a Financial Exchange with QuickBooks 
Overview | Customize Financial Exchange | FAQs 
  
There are two ways to initiate a Financial Exchange between Point of Sale and QuickBooks financial software. 
Financial exchanges can only be done from the Server Workstation. 
(Pro) This option is available at Headquarters only. 

To include Financial Exchange in your End of Day procedure: 
1. On the Point of Sale Server Workstation, select End of Day Procedure from the Point of Sale 
menu. 
2. On the End of Day window, ensure that the Transfer your day’s transactions… checkbox is 
selected in the Financial Exchange with QuickBooks section. 
3. Choose other End of Day options, as desired. 
4. Select OK. 

To run a manual exchange: 

• Select Update QuickBooks from the Financial menu or from the Financial Center. 
You might manually run an exchange, for example, if you want to do mid-day billings from QuickBooks and want to 
be sure that you have up-to-the-minute Point of Sale sales data. 
  

Notes: 
• Your QuickBooks financial software company file must be open or you must have your financial software 
preferences set to allow automatic access during exchanges. 

• If you use remote data sharing, you may need to have your QuickBooks company file open and the server 
application running during all financial exchanges depending on how you have configured the program. 

• When the exchange is completed, a summary window displays the number of records exchanged and 
whether any errors occurred. Select View Activity Log from this window for help in troubleshooting any 
errors that are listed. 

Related Topics 
What data is shared? 
How QuickBooks handles POS data 
Troubleshoot Financial Exchange 
Financial Exchange Reports 

End of Day Financial Exchange with QuickBooks 
Financial Exchange Overview | FAQs | End of Day Overview 
  
In a multi-workstation configuration, the End of Day procedure must be run on the Server Workstation to include 
Financial Exchange. 
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(Pro) The Financial Exchange option is available only at Headquarters. 

To include a Financial Exchange as part of the End of Day procedure: 
1. Make sure QuickBooks is running and your company file is open. 

Tip: To avoid this step set up your integrated applications preferences in QuickBooks to allow Point of Sale to 
automatically login. 

2. In the End of Day window, ensure that the Exchange Data with QuickBooks option is selected 
in the Financial Exchange with QuickBooks section. 
3. Choose other End of Day options. 

4. Select OK. 

Learn more about... 
What information is exchanged? 
What do I if an error occurs during an exchange? 
How is my Point of Sale data posted to QuickBooks?. 
How do I handle bank deposits after running Financial Exchange? 
Can I run Financial Exchange outside of the End of Day procedure? 

How QuickBooks Handles Point of Sale Data 
Exchange Overview | Customize Exchanges | FAQs 
  
What's Important to Know About the Exchange of Data? 

• There is not necessarily a one-to-one correspondence of documents in Point of Sale and QuickBooks 
Transactions can be posted differently to QuickBooks depending on whether you send summarized or 
detailed information and if you have customized the account mappings between the programs. 

• You can verify the exchange status of individual transactions or view linked QuickBooks 
documents/records from your Point of Sale lists. 

• Financial exchange reports provide listings of transactions and records exchanged and are another means 
of verifying successful exchange. 

• Some transactions/documents created in QuickBooks are governed by QuickBooks rules. For example, 
the "To be printed" flag is set on a document created from Point of Sale if it was set on the last document of 
the same type. And customer payments on account are automatically applied to open invoices (or not) 
according to your Receive Payments preferences in QuickBooks. 

Select a data type from the list below to see a brief description of how that Point of Sale data is recorded in 
QuickBooks. 

Sales receipts Cash drawer payouts 

Customers Customer account information 

Vendors Receiving vouchers 

Vendor Payment Terms Return vouchers 

Adjustment memos Sales tax 

Employee hours worked 
Transfer slips 

Customer orders 

  

Verify the Exchange of Individual Transactions 
Overview | Customizing Financial Exchange | FAQs 
  
If you have Point of Sale integrated with QuickBooks financial software, there are several ways for you to check the 
Financial Exchange status of individual transactions with QuickBooks: 
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• Financial exchange reports which provide a detailed listing of all documents and records exchanged 

• The ability to view the transactions created in QuickBooks via links from your Point of Sale documents and 
records (available from Server Workstation only) 

• The activity log which is especially useful for troubleshooting exchange errors 

• The QB Status field in Point of Sale lists (explained below) 

The QuickBooks Status Field in Point of Sale List 
The QB Status field is available to add to your Point of Sale lists for each data type sent to QuickBooks 
(customers, vendors, sales history, receiving history, etc.). This field shows the exchange status of a document or 
record: 

• Not Posted - not yet sent to QuickBooks. This transaction will be sent with the next Financial Exchange. 

• Completed - successfully sent to QuickBooks. 

• Error - attempting to send the transaction to QuickBooks resulted in an error. Check the activity log for 
clues to resolve the error. 

• Unbilled purchases - (vouchers only) merchandise has been received on a voucher but has yet to be 
billed; document has been sent to unbilled purchases in QuickBooks. Displayed only if you have selected to 
enter vendor billing information in Point of Sale. 

  
Related Topics 
Data recovery in QuickBooks 
How QuickBooks handles POS data 

View Point of Sale Transactions in QuickBooks 
Financial Exchange Overview | Financial Exchange Reports 
  

Note: This feature is available from the Server Workstation only and requires that your QuickBooks financial software be running, 
even if you have set your preferences to allow routine exchanges when not running. Point of Sale will automatically launch 
QuickBooks, if not already running, when you select this option. 

  
Point of sale customer, vendor, and history document lists have active links to the corresponding record(s) and or 
document(s) created in QuickBooks financial software. This link helps confirm that a record/document was 
successfully exchanged and allows you to open the QuickBooks record/document for viewing. 
Shown is an example from sales history. 
  

 

To confirm/view a corresponding QuickBooks record/transaction: 
1. In the Point of Sale list, highlight the record or document of interest. 
2. From the I Want To menu, select Show Financial Details. 
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The Financial History window is displayed, showing the exchange status and containing a link to view the 
document (if successfully sent). 

 
This window will show one of the following, as applicable: 
Documents: 

• Sent to QuickBooks Successfully – The document has been sent to QuickBooks. 

• Not sent – The document has not been sent yet. 

• Problem sending to QuickBooks – The document had an error when trying to send it. 
Customer and Vendors: (Basic) 

• Synchronized with QuickBooks - Record has been synchronized and no changes have been 
made on the Point of Sale side. 

• Pending Synchronization – Record has data to be shared with QuickBooks (or it hasn’t been 
shared yet but is flagged to do so). 

• Not shared with QuickBooks – Customer or vendor is not flagged to be shared with 
QuickBooks. 

• Problem Synchronizing with QuickBooks – The customer or vendor had a problem 
exchanging. 
4. Select Open in QuickBooks to view the listed document/records. (QuickBooks will be launched). 

  
Other Options on this window include (only one available depending on current status): 
Resend this record during the next exchange – Select this check box to resend the document during the next 
Financial Exchange. You might do this if you had to restore an older QuickBooks backup and this document is now 
missing in QuickBooks. Note: This may result in the document being listed twice in the financial history window, but 
the link to the original document will no longer work. 
Mark this document as successfully sent – Select this check box if you do not want this document sent to 
QuickBooks during the next Financial Exchange. You might make this choice if you restore a Point of Sale backup 
that was created before the document was sent to QuickBooks. Sending it again in this case would result in 
duplicates in QuickBooks. 
  
Related Topics 
Troubleshoot Financial Exchange 
Data recovery in QuickBooks 
How QuickBooks handles POS data 

Sales Tax Integration with QuickBooks 
Tax FAQs | Tax Reports | Tax Overview 
  
Sales tax amounts collected in Point of Sale are sent to QuickBooks financial software according to the sale tax 
mappings specified for each Point of Sale tax code used. Tax codes and the QuickBooks tax mappings used by 
Point of Sale are defined on the sales tax page of company preferences. 
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When configuring your Point of Sale sales taxes, you can leave the QuickBooks tax mappings blank and Point of 
Sale will automatically create matching tax items and codes in your QuickBooks financial software. 
  
View example  
  
If you set up a Point of Sale multi-rate tax code, one tax item is created in QuickBooks for each component rate 
included in the code. 
  
Custom Mapping of Sales Tax to QuickBooks 
If you prefer, and you have already set up sales tax items/codes in QuickBooks, you can manually map your Point 
of Sale tax codes to those when setting up your tax codes in Point of Sale. 
If you are required to collect and pay sales taxes to multiple agencies (city, county, and state, for example) you 
should set up a sales tax group in QuickBooks and then map your Point of Sale tax code(s) to the group. Learn 
more. 
  
Related Topics 
Setting up sales tax in QuickBooks 
Setting up sales tax codes in Point of Sale 
Using sales tax codes 
Using sales tax locations 
Assigning tax codes to items 
  

Handling Bank Deposits after Running Financial Exchange 
Financial Exchange Overview | FAQs 
  
By default, cash from Point of Sale is placed in the Cash In Drawer account in QuickBooks, while checks and 
credit/debit transaction are placed in the Undeposited Funds account. 
Learn more about using the default or custom account mappings 
To perform a deposit after you have completed the Financial Exchange process with QuickBooks (using the default 
mappings), you will need to transfer the funds you wish to deposit from the Cash in Drawer account in QuickBooks 
to the Undeposited Funds account. 

To make a bank deposit in QuickBooks: 
1. In your QuickBooks financial software, from the Banking menu, select Transfer Funds. 
2. Select the accounts to transfer from and to. 
Normally this would be a transfer from the Cash In Drawer account to the Undeposited Funds account. If 
you have set up custom account mappings between Point of Sale and QuickBooks financial software, you will 
need to specify the custom accounts that you use. 

 
This window displays the current balances in each account. 

3. Enter the Transfer Amount (usually the entire balance in the Cash in Drawer account) and save the 
transfer. 

4. Select Make Deposits from the Banking menu. 



Printed Documentation 

532 

5. On the Payments to Deposit window, select the items in the list you wish to deposit. If depositing the entire 
balance from the Undeposited Funds account, click Select All at the bottom of the window. 

6. Select OK. 
7. On the Make Deposits window, select the bank account to which the funds are being deposited and save. 

  
Alternate Method  

1. In QuickBooks financial software, go to the Banking menu and select Make Deposits. 
2. Select the items to deposit and then select OK. The cash that was transferred from Point of 
Sale does not appear on this list. 
3. Add a new line to the deposit list, selecting Cash in Drawer as the From Account and 
entering the amount of cash to be deposited. 
4. Select Save & Close. 

  
  
Related Topics 
Z-Out Store Close reports 

Financial Exchange Reports 
Overview | Verify the Exchange of Transactions 
  
Several reports are available to help you verify the success of data exchanges with your QuickBooks financial 
software. 
These detailed reports, for receipts, vouchers, customers, vendors, and adjustment memos, provide the 
document/transaction name and number created in your financial software as well as other information. 
In the Report Center, select Financial Exchange as the report category and then choose a specific report. All 
normal report filtering and customization options are available. 
  
Related Topics 
Modify reports 
Work with a displayed report 

Financial Exchange Activity Log 
Overview | Financial Exchange Reports | Troubleshooting 
  
The Financial Exchange activity log allows you to review the details of the data shared between Point of Sale and 
QuickBooks. It summarizes the data that has been imported, added, and updated between the two programs. 
The activity log is a useful tool for troubleshooting problems that arise during Financial Exchange and can help you 
locate problematic data. 
If an error occurs, you will see a problem message in the Financial Exchange summary window. 

To view the Activity Log: 
1. Select View Activity Log from the Financial Exchange summary window or at anytime from the 
Financial menu. 

The Activity Log dialog is displayed, showing the log for the current date. 
2. To view the log for a different date, select a date from the left side of the window, and a time of 
day to narrow the entries even further. 

• To see only the errors in the displayed log, select Show Errors Only. 

• Click on a blue hyperlink, if available, to view the corresponding record or transaction in Point of 
Sale. 

• To print the log, select Print. 
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3. When finished reviewing logs, select Close to exit the dialog. 
  

Notes: 
• Logs for individual exchanges can be viewed one at a time. If data is shared multiple times a day, a 
separate time-stamped entry is made for each exchange. 

• With each new exchange, entries older than 30 days are purged from the log. 
Related Topics 
Financial Exchange at End of Day 
Data recovery in QuickBooks 

Recover Point of Sale Data in QuickBooks 
Financial Exchange Overview | FAQs  
  
You can use this procedure to resend Point of Sale data to QuickBooks if your financial software company file is 
damaged or lost. 
You should try to restore from a QuickBooks backup before using the recover feature. However, if your QuickBooks 
backup is not current, you could lose the sales data that you have been regularly sending from Point of Sale since 
the last backup date. The Recover QuickBooks option allows you to resend your Point of Sale data to QuickBooks 
for s specified date range. 

This procedure should be used in only two situations: 

• Your QuickBooks financial software company file is corrupted and you have no backup or the backup is 
old. 

• You have started a new QuickBooks financial software company file, and want to populate it with Point of 
Sale data. 

This procedure sends all Point of Sale data for the specified date range to QuickBooks, whether or not it has been 
previously sent. If you use this feature for any purpose other than specified above, you may overwrite important 
information or create duplicate entries in your QuickBooks company file. 
It is suggested that you read the Financial Exchange FAQs for other possible issues and corrections before using 
this option. 
  

 Warning: Depending on the size of your Point of Sale data, the date range you specify, and your computer speed, data 
recovery may take a considerable amount of time to complete. Once started, the process must be allowed to finish. Errors may 
result in duplication or missed records if you attempt to stop and restart this process. 

  

Notes: 
• If your attempt to restore your QuickBooks financial software data is unsuccessful, you can contact Intuit 
Technical Support for assistance in recovering your QuickBooks data. There may be a fee for this service. 

• After recovering, the Financial History window in Point of Sale will show two entries for each resent record 
and document. The first link will no longer be functional. 

To recover from a total QuickBooks financial software data loss (no backup): 
Use the steps below if you have been unable to restore your financial software data and/or have started a new 
QuickBooks company file. All vendors, customers, and transactional data within the specified date range will be 
sent. 

1. Follow the Prepare QuickBooks for Financial Exchange topic to prepare the new company for 
Financial Exchange before selecting Recover QuickBooks. 
2. Select Financial Center from the Financial menu. 
3. In the Financial Center select Show Advanced Options and then click Recover Data Now. 
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4. Read the recovery warning, and then select Continue. 
5. Specify a date range. Typically, the date range in this case will be from the date you first started 
using Point of Sale to the current date. 
6. Type Yes to confirm the recovery. 
7. Select Continue to start the exchange. 

To recover if your QuickBooks backup is out of date: 
Use the procedure below if you have an intact QuickBooks company file but your recent sales activity has been lost 
due to restoring an outdated QuickBooks backup. Adjusts the dates in the example below to match your 
circumstances. 
Example: It is March 1. Your QuickBooks company file is damaged, and the most recent backup you have is from 
February 27: 

1. Restore QuickBooks from your most recent backup (February 27). 
2. Refer to the QuickBooks help for specific instructions on this step. 
3. In Point of Sale, select Recover Data Now from the Financial Center as explained in the 
procedure above. 
4. Read the Recovery warning, and then select Continue. 
5. Specify the beginning and ending date for the data to be resent; in this example specify a 
beginning date of February 28 and an ending date of March 1. 

This date range assumes that your February 27 QuickBooks backup already has the Point of Sale data from 
that day, so we are resending data starting on the next day. 

6. Type Yes to confirm the recovery. 
7. Select Continue to send the Point of Sale data to QuickBooks. 
8. Resume routine Financial Exchanges. 

  
Return to top 

Troubleshoot Financial Exchange  
Exchange Overview | Reports | Customize Exchanges 
  
The following lists include frequently asked questions and solutions to Financial Exchange issues. Click on a 
question to view the answer. 
  
Configuring for QuickBooks Integration 
What versions of QuickBooks financial software can I use with Point of Sale? 
Why must a company file be set up in QuickBooks financial software before data can be shared with Point of Sale? 
I cannot find my QuickBooks financial software company file. Where is it? 
I cannot get the two programs to communicate across my network and am not able to share data. What could be 
wrong? 
Do I have to import QuickBooks items when prompted to do so? 
Why can't I see my item quantities in QuickBooks after integrating the two programs? 
Can Point of Sale exchange data with QuickBooks Online Edition? 
  
Running Routine Financial Exchanges 
Why are there fewer receipts in QuickBooks financial software than in Point of Sale? 
Does QuickBooks financial software have to be running to exchange data? 
I made a receiving voucher in Point of Sale and ran a Financial Exchange, but there was no matching bill created in 
QuickBooks. Why? 
How do I make a bank deposit in QuickBooks after doing my End of Day Financial Exchange? 
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Why do some of my customers' names look different after importing into Point of Sale? 
Why does an item named "POS Tax Sales" appear on my receipts sent to QuickBooks financial software? 
Point of Sale says my document was sent to QuickBooks, but I can't find it in my financial software. Where did it 
go? 
What can I do if one of my associates incorrectly entered a receipt payment? 
Can I change the accounts and payment types used by Point of Sale to transfer my routine point-of-sale data to 
QuickBooks financial software? 
  
Errors During Financial Exchange 
When I try to conduct a Financial Exchange, why do I get an error message about my QuickBooks financial 
software company file? 
Why do I get an error about insufficient rights? 
I receive an error about a customer's credit limit being exceeded. How do I fix this? 
Why do I receive an error message that Point of Sale does not have permission to access my financial software 
company file? 
The Activity Log says, "Error occurred while sending receipts. POS STX tax item must be 0%." How do I resolve 
this error? 
  

What versions of QuickBooks financial software can I use with Point of Sale? 
This version of Point of Sale can be integrated with QuickBooks Pro or Premier Editions (2007 – 2010) or 
Enterprise Solutions (Versions 7.0 – 10.0). 
Return to question List 
  

Why must a company file be set up in QuickBooks financial software before data can be shared with Point 
of Sale? 
Point of Sale must know the name and location of the company file you use in QuickBooks financial software, in 
order to send your sales data to the correct accounts, report sales tax properly, and handle other aspects of 
integration. 
Your company file must be set up in QuickBooks financial software before the two programs can be connected. 
Refer here, and to the documentation provided with your QuickBooks financial software, for more information about 
setting up a financial company file. 
Return to question List 
  

I cannot find my QuickBooks financial software company file. Where is it? 
If you have QuickBooks running and The QuickBooks Connection Wizard in Point of Sale can help you locate your 
QuickBooks company file. The Wizard will display the company files it finds in your QuickBooks financial software 
folder. If the wizard is unable to locate your file, it could be because: 

• QuickBooks isn’t running and/or your company file isn’t open. 

• You don’t have a supported version of QuickBooks 

• Your company file has been moved or renamed. Start QuickBooks and open the company file 
then try connecting again. 

• Your network connections have been interrupted. Network troubleshooting. 

• Your QuickBooks Integrated Applications preferences are configured to not allow access. 

Note: To verify the location of your company file, switch to QuickBooks financial software and select Backup from the file menu. 
Your company file and location are displayed in the Current Company section. Cancel the backup operation. 

  
Return to question List 
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I cannot get the two programs to communicate across my network and am not able to exchange data. What 
could be wrong? 
In order to exchange data between Point of Sale and QuickBooks, several conditions must be met. Check your 
network configuration, program installation, and preferences to be sure all of the following are true: 

• You are on a XP/Vista peer-to-peer network, or Windows® 2003/2008 Server or Novell® Netware 
Network. 

• You have set your QuickBooks integrated applications preferences to allow access to Point of 
Sale. How do I? 

• QuickBooks is running and your financial company file is open OR you have set your QuickBooks 
Integrated Applications preferences to allow automatic login even when QuickBooks is not running. How 
do I? 

• If QuickBooks and your company file is open, the Preferences window is closed. 

• You have followed the installation instructions in the User Guide to install and configure 
QuickBooks 

• If you use Remote Data Sharing, QuickBooks financial software is running, your company file is 
open and the RDS server application is running on the computer with QuickBooks 

Return to question List 
  

Do I have to import QuickBooks items when prompted to do so? 
No, and you do not ever have to import them if you wish not to. If you elect not to import your QuickBooks items 
when prompted, but want to later, you can do so by selecting Import QuickBooks Items from the Financial menu 
or from the Financial Center in Point of Sale. 
Return to question List 
  

Why can’t I see my item quantities in QuickBooks after integrating the two programs? 
Individual item information (quantities, prices, etc.) is not shared between the two programs. If you purchase, 
receive and sell an item in Point of Sale, you can view information about the item in the Point of Sale inventory 
screen and on Point of Sale reports. 
Return to question List 
  

Can Point of Sale exchange data with QuickBooks Online Edition? 
No, the online edition of QuickBooks is not supported at this time. 
Return to question List 
  

Why are there fewer receipts in QuickBooks financial software than in Point of Sale? 
By default, information is sent to QuickBooks in summarized format, meaning that many documents are 
consolidated. For example, the total amount for all receipts paid by cash in Point of Sale on a given day is reflected 
on a single receipt and a single general journal transaction in QuickBooks financial software. 
If you would like each individual receipt in Point of Sale to be sent to your financial software as an individual 
document, select the Detailed Item Descriptions option in company preferences. (See the Summarized vs. 
Detailed Item Information topic for further information.) Note that even with this option there is not one document 
created in QuickBooks for every document created in Point of Sale (Other than receipts and vouchers). 
You can always view the documents or records created in QuickBooks for a Point of Sale transaction by selecting 
the Financial button in the corresponding Point of Sale list. Learn more. 
Return to question List 
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Does QuickBooks financial software have to be running to exchange data? 
Not if you have set your QuickBooks Integrated Application preferences to allow Point of Sale to login 
automatically. How do I? 
Exception: If you are using the Remote Data Sharing (RDS) option, QuickBooks must be running with your 
company file open to exchange data. 
Return to question List 
  

I made a receiving voucher in Point of Sale and ran a Financial Exchange, but there was no matching bill 
created in QuickBooks. Why? 
Receiving vouchers may be sent to QuickBooks in different ways, depending on where you have selected to enter 
vendor billing information and, if entering billing information in Point of Sale, whether an invoice number has been 
entered. Learn more. 
To view the corresponding document(s) and/or transactions created in QuickBooks for a Point of Sale voucher, first 
locate and select the voucher in your Point of Sale receiving history, then select View Financial History from the I 
Want To menu. The dialog displayed lists the document(s) or transactions created in QuickBooks. To view the 
QuickBooks document, select Open in QuickBooks next to a listed document. 
Return to question List 
  

How do I make a bank deposit in QuickBooks after doing my End of Day Financial Exchange? 
By default, cash from Point of Sale is placed in the QuickBooks Cash In Drawer account, while checks and 
credit/debit transaction are placed in the Undeposited Funds account. 
Learn more about using the default or custom account mappings 
To perform a deposit once you have completed the Financial Exchange process with QuickBooks financial 
software, you will need to first transfer the funds you wish to deposit from the Cash in Drawer account in 
QuickBooks to the Undeposited Funds account. How do I? 
Return to question List 
  

Why do some of my customers’ names look different after importing into Point of Sale? 
Names in the First Name and M.I. fields from QuickBooks financial software are combined in Point of Sale. Also, if 
a name in your financial software is a duplicate of a customer that already exists in Point of Sale, a number will be 
appended to the end of the name upon import to ensure that it is unique. 
Return to question List 
  

Why does an item named "POS Tax Sales" appear on my receipts sent to QuickBooks financial software? 
If you send data to QuickBooks financial software in summarized format, individual items are not listed on receipts. 
Instead, items are consolidated by tax code. For example, if you sell $250 worth of items belonging to the "Tax" 
code, a $250 item called POS Tax Sales appears on the receipt in your financial software. 
Return to question List 
  

I can’t find the document(s) created in QuickBooks for a document made in Point of Sale even after 
successfully running Financial Exchange. Where did it go? 
To view the corresponding document(s) created in QuickBooks for a Point of Sale document, first locate and select 
the document in your Point of Sale history list, then select View Financial History from the I Want To menu. The 
dialog displayed lists the document(s) or journal entries, as applicable, created in QuickBooks. To view the 
QuickBooks document, select Open in QuickBooks next to an entry. 
Return to question List 
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What can I do if one of my associates incorrectly entered a payment? 
Reverse the receipt in Point of Sale and create a new, corrected one. Reversing the receipt does the following: 1) 
creates a new reversing receipt with the opposite effect of the original to "cancel" it out (it does not change the 
original), and 2) the new, corrected receipt posts the correct payment information to QuickBooks. For example, if 
the original was a sales receipt, selecting reverse creates a return receipt with the same items and prices, adding 
the quantity back to inventory. Once transferred, the new corrected receipt will correct your records in QuickBooks. 
Return to question List 
  

Can I change the account s and payment types used by Point of Sale to transfer my point-of-sale data to 
QuickBooks? 
Yes, you can change the account mappings on the Financial  Accounts page of Point of Sale company 
preferences. Payment type mappings can only be changed by editing your payment methods or types in your 
QuickBooks software. Note: If you use the QuickBooks POS Merchant Service reconciliation feature, some of the 
default mappings are required. 
You can also change income, COGs, and inventory asset item account mappings on an individual item basis. Your 
changes will take effect on the next Financial Exchange. 
Return to question List 
  

When I try to conduct a Financial Exchange, why do I get an error message about my QuickBooks financial 
software company file? 
QuickBooks and your QuickBooks company file must currently be open. If no company file is open, or if a different 
company file is open, or if a dialog in QuickBooks is open, you will receive an error message. 
Optional: You can set your Integrated Applications preferences in QuickBooks financial software to allow access 
even if the program is not running. How do I? 
Return to question List 
  
Why do I get an error about insufficient rights? 
The user currently logged into QuickBooks does not have the rights to perform the actions needed to share data. 
Login as a user with sufficient rights to create items and transactions. It is recommended you login as the Admin 
user. If you have set your Integrated Applications data in QuickBooks financial software for automatic login, make 
sure the user specified there has sufficient rights to perform the actions necessary to share data. Again, it is 
recommended that this user be the Admin user. 
Return to question List 
  

I receive an error about a customer’s credit limit being exceeded. How do I fix this? 
If multiple charges to account are made at different stores between Store and Financial Exchanges or the 
customer's credit limit is overridden at the time of sale to allow a charge exceeding the credit limit, you may get an 
error during Financial Exchange. Some versions of QuickBooks financial software will not accept a charge receipt if 
the limit would be exceeded. To resolve this issue, temporarily (or permanently) increase the customer's credit limit 
so and run Financial Exchange to get the receipt posted. Then change the credit limit back. No additional charges 
will be allowed in Point of Sale until a payment reduces the balance below the limit. 
A second possible cause of this error is that previous customer payments/credits have not been applied to the 
customer’s open invoices in your QuickBooks financial software, thus the account balance has not yet been 
reduced by these amounts. Applying the payments to invoices in QuickBooks and then exchanging data again 
should resolve this issue. Learn more. 
Return to question List 
  
Why do I receive an error message that Point of Sale does not have permission to access my financial 
software company file? 
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QuickBooks financial software is not running or Point of Sale does not have permission to access it automatically. 
Make sure your financial software is running before trying to run Financial Exchange again. (You can set your 
financial software preferences so that Point of Sale can access the program even if it is not currently running. How 
do I? ) 
Return to question List 
  

The Activity Log says, "Error occurred while sending receipts. POS STX tax item must be 0%." How do I 
resolve this error? 
POS STX is the inactive tax item created in QuickBooks financial software and used in the Tax field on documents 
created in your financial software. The tax rate of this item is 0.0%. (The actual tax charged on receipts sent to your 
financial software appears as line items.) If you edit the POS STX item in QuickBooks financial software so that the 
rate is other than 0%, you will receive this error. Make sure the POS STX item has a tax rate of 0%, then send data 
to QuickBooks financial software again. 
Return to question List 
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Customizing Point of Sale 

Customize the Navigation Toolbar Buttons 
Use this procedure to add or remove buttons on the navigation toolbar on the left of the Home Page, receipts, and 
vouchers. 

To add or remove navigation buttons: 
1. Right-click the button toolbar. 
2. Click Customize. 
3. Select the field for the button you'd like to add and click the right-arrow to move it to the selected 
fields column. 
4. When done, click Finish.  

  
Related Topics 
Mouse & Touchscreen Navigation 
Keyboard Navigation 

Customize List Columns 
How Do I?  

Note: Not all tasks apply to all list types. 

Sort and scroll in a list 

Filter a list 

Customize a collapsed list information panel 

Export a list 

Print a list 

Complete other list tasks 

Customize my printed documents 

  
  
Use these procedures to add, remove, or rearrange the columns in a Point of Sale list. The procedure varies 
slightly depending on your list. Select the list type you are working with for specific instructions: 
Item, Customer, Sales History, or Receiving History lists    

This information applies to item, customer, sales history, and receiving history lists. 

To customize list columns: 
1. Right-click on any list column header. 

A list of available columns is displayed. The columns already shown in the list are at the top of the list with 
checkmarks. The remainder of the list is the available columns in alphabetical order. 

2. Scroll through the list and click the columns you wish to add (or click an existing column to 
remove it). 
3. When done, click anywhere outside the list to close it. 
4. In the list, drag column headers to put them in to the position you prefer and/or drag header 
divider lines to re-size the column width. 

  
All other lists   

This information applies to department, vendor, employee, customer order, purchase order, transfer history, and adjustment 
history lists. 
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To customize list columns: 
1. Right-click on any list column header. 
2. From the popup menu, select either: 

• Adjust Column Widths to adjust the width of all columns to the width of the largest entry in 
the column. 

• Customize Columns to add, remove, or rearrange columns (see below). 

To add or remove columns, or to rearrange their order: 
1. Select Customize Columns as described above. 
2. Perform the appropriate actions: 

• To add a column: Select a column name in the Available Columns list on the left, then select 
Add. The selected column is added to the Chosen Columns list on the right. 

• To remove a column: Select a column name in the Chosen Columns list on the right, then 
select Remove. The selected column is added back to the Available Columns list on the left. 

• To rearrange column order: Select a column name in the Chosen Columns list on the right, 
then select Move Up or Move Down until it is in the desired position. 

• To reset columns to the default settings: Select Default. All columns are returned to the 
same state as when you first installed Point of Sale. 
3. Select Save. 

  

  
  

Notes: 
• You can rearrange column order or column widths directly in the list: 

• To move a column, click and hold on the column header and drag it to the desired position. 

• To adjust a column’s width, click and hold on the separator (the small vertical line) between 
column headers and drag the separator until the column is the desired width. 

• Some columns (fields) in your item list can be renamed to better suit your business needs. Read the 
customizing field labels topic for more information. 

• Customizing the columns in a list does not affect how columns appear in reports or on printed documents. 
Read modifying report options for more information on customizing reports.  Read the Print Designer 
overview  fro information on customizing printed documents. 

Related Topics 
Locate a record or document 
Use custom fields 

Customize List Information Panels 
How Do I?   

Note: Not all tasks apply to all list types. 

Sort and scroll in a list 

Filter a list 

Customize list columns 

Export a list 

Print a list 

Complete other list tasks 
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Customize my printed documents 

  
  

This topic applies to department, vendor, employee, customer order, purchase order, transfer history, and adjustment history lists. 

  
When a Point of Sale list is in collapsed format, the right side of the window is called the information panel. The 
information displayed is for the selected record in the collapsed list to the left and varies depending on the record 
type. 

• The bottom half of the information panel typically includes a history for the selected record or, in the case 
of a document, the list of items that were included in the transaction. Other information may appear for some 
record types. This information is often presented in report format and some report viewing options are 
available. 

• The top portion of the information panel, shown below, contains specific information fields from the 
selected record and task buttons that can be customized by adding, removing, or rearranging the fields to 
best suit your information needs. 

 

To customize a list information panel: 
1. Select the Customize this window link at the bottom-right of the panel. 
2. In the window displayed: 

• Drag and drop fields and task buttons to position them where you want. 

• To add a field or button, drag it from the Available Fields area to the panel at the top. To remove 
a field, drag it down to the Available Fields area or press <Delete> on your keyboard. 

• Each panel column is split into two sub-columns. When placing data fields in a column, the field 
label is on the left and the actual data on the left. You can drag the separator (dotted line) between right 
and left sub-columns to change their relative widths. Right-clicking in a cell brings up a menu with other 
options, such as text alignment. 
3. Select Apply to implement your changes. 

  

Related Topics 
Work with Forms 

Company Preferences: General 
Preference Instructions | Employee & Security Overview 
  
The General Page contains preference settings affecting general program usage, rather than a specific area, 
including the ability to remove features you do not wish to use. 

Preference Function 

General Options   
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Require users to sign 
in 

 = Require users to login to Point of Sale 
using the login names and passwords you 
have assigned. 
Only the System Administrator  can 
change this setting after it has been 
turned on. 
Changing this setting requires that a 
System Administrator password be 
entered and that all open windows be 
closed before saving. 

Automatically log out 
users after each sale 

 = Automatically logs out the current 
user upon saving a receipt (if users are 
required to log in). 

Warn when editing 
documents, items, or 
customers 

 = Confirm edits to documents, items, or 
customers before carrying out the action. 

Warn when deleting 
documents, items, or 
customers 

 = Confirm deletions of documents, 
items, or customers before carrying out 
the action. 

Bring back all one 
time messages 

Selecting DO NOT SHOW ME AGAIN 
from a Point of Sale message prevents 
that particular message from being 
displayed. Selecting this preference brings 
back all such messages. This option is 
then cleared. You may have to close and 
re-open currently open windows for the 
messages to show up. 

Select features to use  = Select the checkboxes for features 
you use in Point of Sale. Clear the 
checkboxes to remove a feature. Related 
icons, menu options, and information 
fields are removed from Point of Sale 
screens. Return here at anytime to 
change your choices. 
Changing these settings may require you 
to close any open windows in related 
areas before saving. 
(Pro) Some choices are interdependent, 
e.g., if you choose to use customer 
orders, then customer tracking is a 
required feature. 

Data Safeguard  = By default, a backup is made of 
your company file once per day when 
you exit Point of Sale on the Server 
Workstation. Change this selection to 
create a backup at a scheduled time 
instead. Read the information in the help 
sidebar about requirements for scheduled 
backups. Learn more. 
(Pro) Include item images... Select the 
checkbox to include item images in your 
backup file. This option may greatly 
increase the time to create and size of 
your backup file. 

Store Info   
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Headings Store headings are printed across the top 
of documents. 
Enter information in the following fields: 
Store Name, Street, City, State, ZIP, and 
Miscellaneous 1-3. 

Logo  = Select the checkbox and then click 
Specify to add one or more logos. Select 
one of the added logos to print on sales 
documents. Adding multiple logos lets you 
switch between them quickly. 
(Pro) You can use Print Designer to print 
different logos on different documents. 
Learn more about logos and file 
requirements. 

My Field Labels   

Field Labels You can define the field labels for the four 
item description fields. The field labels you 
specify are displayed throughout the 
program, on printed documents, and on 
reports. 
Choose Restore to Defaults at the 
bottom of the page to return all labels to 
the program default values. 
(Pro) You can also define labels for the 
custom fields available on customer, 
vendor, item, and employee records. If 
integrated with QuickBooks financial 
software, the information in customer and 
vendor custom fields is shared, provided 
they are named exactly the same in both 
programs. 
  

Return to top 
Company preferences overview 

Company Preferences: Sales 
Preference Instructions | Sales Overview 
  
Sales preferences allow you to define various options related to sales transactions.   
The Sales page covers the general sales preferences. Other sales preferences are discussed on sub-pages (select 
a link for instructions). 
Discounts – define and optionally require manual item discount reasons 
Receipt message – printed on every sales receipt 
Shipping – list of shipping providers 
Receipt tendering – payment options 
  
Sales – General 
Preference Function 

Order to display full 
name field 

Choose the order in which to display/print 
customer names on receipts. 
Example: A record has Sara in the First 
field, Edward in the Last field, and Ms. in 
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the Title field. If you choose to display 
the name as last, title, first, Point of Sale 
will print the name as Edwards, Ms. 
Sara. 

Require a 
promotional code 
entry 

 = Requires an entry in the Promo 
Code field on a receipt before payment 
can be accepted and the document 
saved. This field facilitates filtering for 
viewing or reporting purposes. 
(Pro) This also applies to customer 
orders. 

Require a manual 
media count for X/Z-
Out 

 = If selected, associates are required 
to manually count each denomination of 
currency when running a Z-Out Drawer 
Count report. 

When printing group 
item on receipt or 
customer order (Pro) 

Select to print the group item price only, 
the individual component item prices 
only, or both. Default is to print individual 
item prices only. 

Open Cash Drawer  = Select the payment types that will 
open an attached, compatible cash 
drawer. Defaults: Cash, Check. 

Return to top 
  
Related Topics 
Customizing receipt item list columns 
Customizing printed receipts and other documents 
Company preference: removing unused features 
Company preferences overview 

Customize Field Labels 
Data Field Overview | Define Inventory | Program Capacities 
  
You can specify custom field labels for the four item description fields in inventory (Inventory Name, Inventory 
Description, Size, and Attribute). The field labels you specify are displayed throughout the program, on printed 
documents, and on reports. 

Default Labels: The default labels for new users are Item Name, Item Description, Size, and Attribute. Upgraders from earlier 
versions may have labels of Description 1 and Description 2 for the name and description fields. Click Restore To Defaults at the 
bottom of the screen to return to the default field labels. 

(Pro) You can also create and use custom fields on customer, vendor, item, and employee records. And, if you use 
Print Designer to customize your print templates, you can specify different labels for printed documents as well. 

To customize field labels: 
1. From the POS Home Page,  select Preferences  Company from the File menu. 
2. In the left pane, choose General  My Field Labels. 
3. Scroll down to locate the field labels you wish to customize and enter new label text in the My 
Label column. 
4. Select Save. 

  
Related Topics 
Customize List Columns 
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Custom Fields 
Data Field Overview | Program Capacities 

Pro 
Point of Sale provides you the ability to create and use custom fields. Once defined, the custom fields can be 
displayed and used to filter lists and reports, and can be added to your printed documents using Print Designer. 
For example, on your customer records you may wish to add fields for birthday and spouse's name. In inventory, 
you may wish to track the vendor’s catalog number, or you may need to record and print an item part number on 
your purchase orders. 
You can define and use custom fields in the following records: 

• Customers 

• Vendors 

• Items 

• Employees 

Defining Custom Field Labels 
Custom fields are enabled and labeled on the My Field Labels page of company preferences. The My Field Labels 
preferences page allows you to add and define all custom fields in Point of Sale in one place. How Do I? 
  
How do I add my custom fields to lists? 
How do I add custom fields to my printed documents? 
  
Related Topics 
Filter lists 
Modify and filter reports 

Adding your Logo to Sales Documents 
Printing Overview | Print Designer | FAQs 
  
You can easily add your store logo to printed sales receipts,  gift receipts, customer orders, and other documents. 
You can even add several logos to Point of Sale and then switch between them for seasonal or holiday purposes. 
Pro users can add different logos to different documents using Print Designer. 

To add your logo to printed sales documents: 
1. From the File menu, select Preferences  Company. 
2. Select the General  Store Info page from the left-side menu. 
3. Select the checkbox for Use Image as Default Logo. 
4. Select Specify. 
5. In the Images Collection window, select Add and browse for a graphic file. See notes below for 
file requirements. 
6. Repeat to add additional logos. Choose the one logo you want printed on documents and choose 
Select. 
7. Select Save on the preference page. 

  
Notes: 

• Standard .BMP, .JPG, and .GIF file formats are supported. Note that some files with these extensions, 
such as those from some digital cameras, may contain extra file information that will prevent them from 
working in Point of Sale. If this occurs, use a graphics, paint, or photo application to open and re-save the file 
with a standard format. Tip: Test the file to see if it opens in Internet Explorer. If it does, it should work in Point 
of Sale. 
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• Logo colors must be RGB (not CMYK) and maximum 24-bit resolution. 

• Logo file size should not exceed 100 KB. Larger file sizes may slow printing. We recommend reducing 
color resolution or logo dimensions to reduce file size, if necessary. 

• Point of Sale will scale the graphic, if necessary, to fit in the allotted space on a document. Some loss in 
graphic quality may result when scaling. For best results, use a graphics application to size your logo to the 
recommended sizes: 

• 40-column documents: 248 pixel maximum width 

• Letter-size documents: 381 pixel maximum width 

• The specified default logo is automatically added to your printed sales documents. Simply return here and 
change the default logo to print a different logo. 

• (Pro) If you use Print Designer to customize your printed document templates, you can change the size 
and position of the logo, use different logos for different documents, and add logos to other document types. 

• (Pro with multiple stores) Each store can define their own logos. 

Add a New Security Group 
Copy a Security Group | View or Edit Group Rights 
  
You are not limited to the predefined security groups. You can create new security groups with your preferred 
security rights, and then assign them to your employees. 

To add a new security group: 
1. From the Employees menu, select Security. 
2. Select New Group from the window toolbar. 
3. In the New Group dialog, enter a unique name for the group and select OK. 
4. The new group is created and added as a new column to the Security window. The group initially has no 

security rights. 
5. Edit the security rights of the new group, granting rights as needed. 
6. Select Save. 
7. Assign the new group to employees, using the procedures described in the Viewing or Editing an 

Employee Record topic. 
  

Multi-Store Note: Security settings are not shared among stores; each store can create security groups as needed to control 
access on a local level. 

  
Related Topics 
Delete a security group 

Why is a Point of Sale feature not available to me? 
Help and Support Overview | Unlock to Higher Level 
  
If a Point of Sale feature is not available to you, it may be due to one of the following reasons. Features not 
available may be grayed out or not displayed on your screen at all, depending on the specific reason. Select a link 
for more information on a particular setting or feature. 

• The level of Point of Sale (Free, Basic, or Pro) you have licensed doesn't include that feature 

• You don't have security rights to access that feature 

• You are on a Client Workstation, but the feature is available only on the Server Workstation 

• The feature has been turned off in company preferences 

• A related feature, required for the feature you are trying to use, is not available, has been turned off or not 
set up (e.g. to track charge accounts requires that you track customers, to require employees to log in and 



Customizing Point of Sale 

549 

restrict their access requires a company preference setting to that effect, and to use customer orders requires 
you also have tracking customers turned on, etc.) 

• You are trying to use a Financial Exchange feature but your connection with QuickBooks has not been set 
up 

• You are at a remote store in a multi-store configuration and the feature is not available to remote stores 
Important Note: New information fields, list columns, and report options may be added in support of new and 
enhanced features in Point of Sale upgrades and updates. In most cases, these new fields and options are 
automatically available to you. However, if you have customized your Point of Sale lists,  reports, or printed 
documents and tags, the new installation does not overwrite your customized layouts to add the new fields. If you 
plan to use a new feature, and the fields or options are not visible to you, you may need to further customize your 
layouts to add them or, in the case of reports, use the Revert option to reset to the default options and then re-
memorize. 
  
Related Topics 
Help & Support Resources 

Install Additional Workstations 
Network Issues | Company Data Connection Issues 

Basic  

QuickBooks Point of Sale can be networked to allow up to ten workstations simultaneous access to the program 
across a network within a store; one Server Workstation and up to nine client workstations. About Server and Client 
Workstations. 
  

Note: Virtual Private Networks (VPN) and wireless networks tend to be low bandwidth (slow) and therefore are not recommended 
for use with Point of Sale. These network configurations may be unreliable. 

  
Use this procedure to install additional Client workstations to an existing Point of Sale server installation. If multiple 
workstations are to concurrently access the Point of Sale company data, each must have a separately purchased 
user license and all computers on the network must have the same version (e.g. 10.0) and level (e.g. Pro) of Point 
of Sale installed. About Point of Sale licensing. 
For additional information or if you need to install the Server Workstation, read the Point of Sale User Guide 
(launches electronic version in a separate window) 

To install an additional client workstation: 
1. If necessary, network your computers, following the instructions for your networking hardware and 
software. 
2. Close all running programs, except Windows, on the computer that you are installing as a Client. 
3. Put the QuickBooks Point of Sale CD into your CD-ROM drive (if installing from a downloaded 
file, follow the instructions provided). 

The install Wizard will launch automatically. If it doesn’t, browse to the Setup.exe file on the CD and double-
click it to start the installation. 

4. Follow the on-screen prompts to install the program files to the client workstation: 

• Enter License and Product numbers from the CD holder purchased for the workstation or enter 
the same numbers used on the Server Workstation (with the latter choice, the Client will be able to run 
Point of Sale only if the Server Workstation closes the program) 

• Read and accept the license agreement. 

• Select Client Workstation as the installation type. 

• Accept the default installation folder (recommended) or browse and enter an alternate folder 
name on this workstation. Do not browse to the server’s installation folder over the network! Each 
workstation must have the program files installed locally. 
5. Follow the on-screen prompts to complete the installation. 
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6. With the Server Workstation running (Point of Sale does not have to be open), launch Point of 
Sale on the Client workstation.. 
7. Connect to the company data on the Server workstation. 

If only one company data file exists on the network, you are automatically connected. If multiple files exist, a 
list is displayed and you can select a file. 

8. When prompted, select a workstation number for this computer. If using passwords, log in using 
the user name and password assigned to you when prompted. 
9. When the Hardware Setup Wizard appears, follow the on-screed directions to connect and 
configure any Point of Sale hardware you have purchased. 
10. Merge the Client license with the Server license if prompted. 

  

Notes: 
• The Server Workstation has all program, company data, and the database application files installed. Client 
workstations install the program files, but access the company data file across the network to carry out 
program activities. 

• The following activities cannot be done on a client workstation: 

• Creation of a Point of Sale company data file 

• Exchanging data with QuickBooks financial software 

• Accessing Intuit servers online to manage program license information 

• Importing data with the Data Import Tool 

• (Pro) Store Exchange with other stores 

• It is recommended that you check for and install available program updates immediately after adding a 
workstation. If installing updates, make sure you update all workstation on your network. 

Related Topics 
Help and support overview 
Work with your POS company data 
Install supported hardware 

Customize Printed Documents 

Print Designer Overview 
How do I?   | Print Designer FAQs 

Pro 
Using Print Designer, you can customize your printed documents, labels, packing slips, and tags. The following 
actions are available to you in Print Designer: 

• Add, remove, size, and position data fields, static text, bar codes, and logos 

• Add borders and graphic lines 

• Change the printed labels on fields 

• Change the fonts used for printing 

• Control certain printing characteristics, such as the behavior of headers and footers 
Note that not all options are available on every template. 
Point of Sale comes with default templates for each document, tag, and label type. You can directly edit the default 
templates or copy them and then modify the copy to create and save new templates. Once modified, templates can 
be exported and imported to share them with other workstations or stores. 
Print Designer is not a "WYSIWYG" ("what you see is what you get") editor. As you position data fields on a design 
page, keep in mind that you are defining relative position, not absolute position, especially as it relates to vertical 
positioning. Every field that is placed on a template is not necessarily filled with data with each transaction. Many 
unused fields are removed from the template at the time of printing, so that the printed document does not have 
blank, wasted spaces. A good example of this behavior is the payment type fields included on sales receipt 
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templates. While all of the possible payment types are included in the design, most sales only utilize one payment 
type, thus it is the only one actually printed. 
Most document templates are separated into sections. There can be up to five different sections on a template, 
each with a unique printing behavior. These sections control how the printed output looks. For example, the 
information included in the Repeating Header section prints at the top of each page of a multi-page document, 
while the information in the Body Header section prints only once, near the top of the first page. Learn more about 
template sections and spacing. 
  
Related Topics 
Recommended sequence and tips for modifying templates 
Print Designer preferences 

Access the Print Designer 
Print Designer Overview | Print Designer FAQs 

Pro 

To access the Print Designer: 

• From the File menu, select Utilities > Print Designer. 

Recommended Sequence and Tips 
Print Designer Overview | Print Designer FAQs 

Pro 

Recommended Design Sequence and Tips 
There are no hard and fast rules for the order in which you must modify document templates, but you may find this 
recommended sequence and associated tips helpful in achieving the desired outcome in the most efficient manner. 

1. Select a template to modify. 
2. Click anywhere in the section in which you want to work to make it active. This step is 
unnecessary on tag and label templates as they have only a single section. 
3. Remove the elements that you do not wish included on the printed document. 

• This helps create space for adding other fields or moving fields around 

• Use the Zoom In/Out controls from the toolbar to make selecting and working with individual 
elements easier 

• If additional space is needed while working in a section, drag the bottom section border 
downward 
4. Add data fields and other new elements as needed, positioning them in their approximate location 
by dragging-and-dropping. 
5. Resize elements and make any necessary changes to element properties. 

• Select Preview from the toolbar to see how your changes will look as you progress. The 
previewer allows you to view, save, or print your template. 

• We recommend saving your work if you are satisfied with the preview (select Save As if you want 
to give your modified template a different name, thus preserving the original template). 

• Make a mistake? Select Undo from the toolbar. You can undo the last several actions taken since 
your last save. Each save clears the Undo memory. 
6. Use the alignment tools to precisely place elements in their final position, working from the top of 
a section downward. 

• Select multiple elements by holding down <Ctrl> or <Shift> and clicking each, or by dragging the 
mouse pointer to encompass all elements to be selected 

• Use your keyboard arrow keys to move an element in small increments, or <Ctrl + arrow keys> 
to move at 10X the increment 
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6. Remove any extra white space at the bottom of the section by dragging the bottom border 
upward. 
7. Do a final preview, test print, and then save your template. 
8. If you created a new template, answer Yes when asked if you want the new template to be the 
default for that document type. You can also change templates at anytime in your print option preferences. 

• Use the import-export feature to share the new template with other stores or to move the template 
to another company data file. 

Related Topics 
Note on bar codes  

About Template Sections and Spacing 
Print Designer Overview | Print Designer FAQs 

Pro 
Most document design templates are divided into logical sections, each with a unique printing behavior. The 
number of sections and the specific fields located in each section vary depending on the document type. For 
example, price tag, label, and 40-column templates will not include all of the section types listed below. The 
following descriptions will provide a general understanding of how the template sections are used and how these 
sections behave. Template sections cannot be re-positioned, though they typically can be vertically resized to add 
or remove white space in a design. 
The five section types are as follows: 
Repeating Header – The elements included in this section are printed at the top of each page of the document. 
This section typically includes such things as the document date, print date, page number, document/transaction 
number and the logged-in user’s name. 
Body Header – The elements included in this section are printed only on the first page of a document. This section 
typically includes such things as store name and address information, as well as billing and shipping address 
information. 
Body – This section typically contain the actual content of the document. For example, on most transactional 
documents this would be the list of the items processed and the descriptions and/or attributes of those items. When 
printing a document, the body section expands to accommodate the number of items listed and can span multiple 
pages. 
Body Footer – The elements included in this section are printed only at the end of the document, or on the last 
page of a multi-page document. This section typically includes such things as totals, balances, savings, payment 
type, messages and comments. 
Repeating Footer – The elements included in this section are printed at the bottom of each page. The same type 
of information can be placed in this section as in the Repeating Header section, depending on whether you wish 
this information to be displayed at the top or bottom of each page. 
Click on a section name on the left side of the template to make it active. In the example shown, the Body section is 
active. 
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Template Spacing 
The Print Designer allows you to add or remove "white space" at the top and bottom of each section by dragging 
and dropping the section dividers. This is useful for gaining additional space to add design elements or to remove 
space that would otherwise waste paper when printing. 
The Print Designer template display is not always an accurate representation of how the printed document will 
appear. Templates typically contain many fields that may or may not be populated with data from a particular Point 
of Sale transaction. For example: if your sales receipt template includes customer address fields, but you do not 
always record the customer on the receipt when a sale is made, then those fields and the vertical space they 
normally occupy will be omitted from the printed document and everything below the address fields will be moved 
up. 
Use the vertical ruler as a general guide for relative positioning of elements. The actual height of sections and their 
contents will vary depending upon what data is actually available to be printed. It is recommended that you test 
your modified templates before implementing them for general use. 
  

The End of the Document or Section 
Sections in the template and particularly at the end of the document will vary depending upon the particular type of 
document and the printer being used. It is recommended that you build each section from the top down and then 
set the placement for the end of each section and the end of the document according to the lowest field placed in 
that section. 
The image to the right shows the divider at the end of the document moved to just below the end of the last field. 
This ensures that no wasted space is added to the printed documents. If more space is needed, the divider can be 
moved down. 
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Moving Elements between Sections 
You cannot move an element directly from one template section to another. If you need to move an element to 
another section, first remove it from one section and then add it to the other. 
  
Back to top 
  
Related Topics 
Recommended sequence and tips for modifying templates 

Select a Template to Modify 
Print Designer Overview | Print Designer FAQs 

Pro 
Point of Sale ships with default templates for each document, tag, and label type. You can directly modify one of 
the default templates or make a copy of a default template to use as a starting point to create a new template. 

To select a document template to modify or copy: 
1. From the Tools menu, select Print Designer. 
2. Select the document category you wish to modify from the Select a Document Type drop-down 
list. 
3. Select the specific template you wish to work with from the Available Documents list. 
4. Select the desired option: 

• To create a new template, choose Copy Selected from the Options menu. When done, save the 
template with a new name and answer Yes when asked if you want to make it the default template when 
printing that document type. 

• To modify the default template, select Modify at the bottom of the window. 
The selected template is displayed in the Print Designer, ready for you to modify. 

Other options from this window include: 

• Revert Design to Default – available from the Options menu, this selection resets a modified template 
back to its original design. 
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• Delete Selected Design – available from the Options menu, removes the selected design. Note that 
default templates can not be deleted. 

• Import & Export – provides a way to move modified templates to another company data file or to remote 
stores. Learn more. 

Related Topics 
Print Designer preferences 
Recommended sequence and tips for modifying templates 

Add Data Fields or Groups of Fields 
Print Designer Overview | Print Designer FAQs 

Pro 
Data fields are populated from information in your company data file. This could be store information, customer 
information, item information, sales information, and so forth. 
A data field represents one piece of information from the record, such as the city for the billing address. 
A group of fields represents a set of data fields that are added to a template as a group. For example, a "Ship To" 
group would have available all individual fields pertinent to the shipping address. In most cases, the pre-defined 
groups should meet your needs. However, should you need a more specific design, you can add or remove 
individual data fields from a group. 
In most cases, you will not be able to place the same data field or group of fields in multiple locations on a 
template. 

To add a data field or group of fields to a template: 
1. If applicable, select the section of the template to which you wish to add the date field or group. 

If necessary, create more room in the section by dragging its lower separator bar downwards. 
2. From the tool bar, select Add  Data Field or Group of Fields from the tool bar. 

The Add Data Field window is displayed. 
3. Select the individual data field or group you wish to add. 

A short description of each field or group is displayed in the window as they are selected. 
Notes on changing bar code fields  

4. Select OK. 
The selected field/group is added to the selected section of the template. 

5. Position, resize, or set other element properties as needed. 
  
Related Topics 
How do I remove a data field or group? 
About template sections and spacing 
Recommended sequence and tips for modifying templates 

Add a Logo 
Print Designer Overview | Print Designer FAQs 

Pro 
The default sales document templates include the logo field at a predefined size and position. The actual logo to be 
used is specified in company preferences. Learn more 
You can use Print Designer to change the position and size of your logo on these printed documents and add your 
logo to other documents if desired. 

To add your logo to a template: 
1. If applicable, select the section of the template to which you wish to add the logo. 

If necessary, create more room in the section by dragging its lower separator bar downwards. 
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2. From the tool bar, select Add  Store Logo from the tool bar. 
The logo specified in company preferences is added to the template. 

3. Position, resize, or add a border to the logo as appropriate. 
  

To add an alternate logo to a template: 
You must have specified more than one image in company preferences to use for logos before this option is 
available. 

1. Add the logo to the template as described above. 
2. With the image selected, click the properties icon on the toolbar. 
3. Select alternate image and specify. 
4. Choose from the available images (or add another image if needed) and choose select. 
5. Select ok. 

  

Notes: 
• When resizing a logo, only the horizontal sizing affects the printed logo size. Vertical sizing is automatically 
adjusted to maintain the aspect ratio of the logo. 

• Scaling of the logo to the size specified occurs when previewing or printing. The display of the logo in the 
designer window is not an accurate representation of the printed image. 

• We recommend you use the preview option to see how the logo will look when printed. 
Related Topics 
Recommended sequence and tips for modifying templates 

Add Text Labels 
Print Designer Overview | Print Designer FAQs 

Pro 
Text labels are static text (unchanging) that you can add to a template. You might use a text label to print a 
message regarding your store return policy, warranty information, or any other information you want added to every 
printout of the selected document. 

To add a text label: 
1. If applicable, select the section of the template to which you wish to add the text label. 

If necessary, create more room in the section by dragging its lower separator downwards. 
2. Select Add Text Label from the tool bar. 
3. In the Properties window displayed, type the text to be printed. 
4. Specify text justification (left, center or right), change font characteristics, or add a border to the 
label as desired. 
5. Select OK. 

The text label is added to the selected template section. 
6. Position and resize the text label within the section as needed. 

  
Related Topics 
How do I remove a text label? 
About template sections and spacing 
Recommended sequence and tips for modifying templates 

Set Element Properties 
Print Designer Overview | Print Designer FAQs 
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Pro 
You can set the following properties for elements (not all settings are available for all elements): 

• Define Field Labels – Adjust width, position and justification of field labels; change label text. 

• Define Group Fields – Add, remove, rearrange, and align the individual fields within a group. 
Working with an item list field is slightly different than other field groups. Learn more. 

• Define Group Labels – Same options as field labels, only applied to the label for the group. 

• Change Font Characteristics – Change text font size, color, and style. All Windows fonts installed on 
your computer are available. 

• Add Borders – Add a border to the top, bottom, left, or right of any element, or an entire template section. 

• Bar Code Type – Select between two bar code formats. The Code2OF5IL format is generally 
recommended for smaller tag sizes as it increases the space between line. Note on bar codes  

To set the properties of an element: 
1. Select the element you wish to modify. 
2. From the tool bar, select Properties 

Or 
Double-click the element. 

3. Make changes to the available properties. 
4. Select OK. 

  

Notes: 
• Take into consideration the printed document size and your printer’s capabilities when changing font sizes, 
styles, and colors. For example, tags and 40-column documents have very limited space for using a larger 
font. Preview and test your new design before going live with it in your store. 

• If you do increase font sizes, you may have to resize fields to accommodate the larger printed text. 

• The following example is the Properties window for a group of fields. The preview at the bottom of the 
window allows you to immediately see the effect your changes have on the printed document. 

• Click here for more information about customizing the item list included on documents. 
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Related Topics 
Recommended sequence and tips for modifying templates 

Customize a Document Item List 
Print Designer Overview | Print Designer FAQs 

Pro 
The group of fields making up the item list on printed documents is slightly different from other field groups. As 
shown in the following images, there is a heading line and three lines for item data that can be displayed/printed for 
each item listed on the document. Multiple lines can be helpful, especially if you are using a 40-column printer. 

 
Sample letter-size sales receipt item list: 
  

 
Sample 40-column sales receipt item list: 
  
You can add, remove, or rearrange the order of fields on each line, change fonts, and customize the printed 
headings and field labels. 

To customize the item list: 
1. Select the line you want to customize (blue highlighting indicates the selected line). 

• The list of available fields for the selected line is displayed. If a field is already displayed on one 
line, it is not available to add to another. To make it available, remove it from its current line. 
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• Note that selecting Line 1 also highlights the heading line. The headings are based on the fields 
added to Line 1. 
2. Select/clear the checkboxes of available fields to include/exclude from the line respectively. 

• The selected fields are added to the line at their default size (shown with the field description on 
the right of the window). 

• If you add more fields than will fit in the width of the printed page, the fields will auto-adjust to fit. 
Be aware that this means the printed text will be truncated to fit the smaller fields. 

• Use the "Empty Space" fields to add space so printed text doesn’t run together. 
3. Use the Up and Down buttons to arrange the fields in the order you want to appear on the line. 
(up = left, down = right). 
4. Resize the width of the fields on a line by dragging their separator lines. If the line is already full, 
increasing the width of one field means another field has to get smaller. 
5. Change the Headings (Line 1 fields) or labels (Lines 2-3 fields) desired for each field used. Your 
choices are to use the labels defined in Point of Sale, enter a different label for printing (maybe a shorter 
one?), or to not print labels at all. Field labels for data on Lines 2-3 are printed right in the field, so if space 
is limited you may want to turn off printing of the labels. 
6. Change font properties for the heading line or the data field lines. 
7. Select OK to close the Properties window. 

  

To use a style grid for listing items: 
Using a style grid instead of a standard item list can be a great space saver on documents. 

1. Select the item list in the template. 
2. Select Properties from the tool bar. 
3. Select Style Grid from the drop-down list at the top of the Properties window. 

Fields are selected for the style grid in the same manner as for the item list. To change the axis for the grid, 
select the Style Grid Details tab. 

 
  

Related Topics 
Recommended sequence and tips for modifying templates 

Resize Elements 
Print Designer Overview | Print Designer FAQs 

Pro 
There are two ways to resize an element: 
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• Drag and drop the grab handles around the perimeter of the selected element, as shown below, with your 
mouse. 

• Use the tool bar alignment options to quickly make the width of the selected element(s) the same as 
another element or the section containing it. 

  
Horizontal grab handle 

 
Vertical grab handle 

  

Notes: 
• Most elements can only be resized in the horizontal direction. Vertical sizing is controlled by the content of 
the element. If you drag the vertical grab handles on the top or bottom of the element, the vertical size 
"snaps" back to its original size when you let go. 

• In the case of a logo, you can change the vertical sizing. However, when printing, the vertical size is 
automatically scaled to maintain the aspect ratio of your graphic based on the horizontal size. This helps 
prevent distortion of your printed logo. 

• Take into consideration the size of the data that will populate a field when printing. If a data field size is too 
small, the printed data will be truncated to fit. Note on bar code fields  

• You may find it helpful to use the top and side rulers and status bar coordinates for precise sizing. 
Related Topics 
Recommended sequence and tips for modifying templates   

Position and Align Elements 
Print Designer Overview | Print Designer FAQs 

Pro 
Elements can be positioned on the template by any or a combination of these methods: 

• Drag and drop the element; use this method to approximately place the element in the desired position and 
then use the options below for more precise alignment 

• Use the arrow keys on your keyboard to move the selected element in small incremental steps or <Ctrl + 
arrow keys> to move in 10X larger increments 

• Use the tool bar alignment options (see below) to position elements relative to other fields or relative to the 
section in which it is placed 

• Use the top and side rulers, status bar coordinates, and snap overlapping objects to their edges options 
with any of the above to help with precise placement 

Using the Alignment Options 
The alignment options allow you to align selected elements to another element or to the section in which it is 
placed. When aligning to another element, the first element selected is referred to as the "anchor element." Other 
selected elements will be oriented to the position of the anchor element according to the alignment option selected. 

To apply an alignment option: 
1. Select the element or elements you wish to align. 

To select multiple elements, hold down the <Shift> key and click on each element in turn or by dragging the 
mouse to encompass all elements to be selected. The first element selected is the anchor element when 
aligning elements relative to each other. 

2. From the toolbar, select Align and then select Align Fields to Each Other or Align Fields to 
Section. 
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The align fields to each other option is available only if multiple elements have been selected. 
3. From the drop-down menu displayed, select the specific alignment option: 

You can also select Show Align Toolbar from the Align menu to add the alignment tools to the toolbar. 
  

Alignment 
Options: 

Fields to each 
other 

Fields to 
Section 

Align Left Aligns the left edge 
of all selected 
elements with the 
left edge of the 
anchor element 

Aligns left edge of 
selected element(s) 
to the left edge of the 
section 

Align Right Aligns the right 
edge of all selected 
elements with the 
right edge of the 
anchor element 

Aligns the right edge 
of all selected 
element(s) with the 
right edge of the 
section 

Align Bottom Aligns the bottom 
edge of all selected 
elements with the 
bottom edge of the 
anchor element 

Aligns the bottom 
edge of all selected 
element(s) with the 
bottom edge of the 
section 

Align Vertical 
Center 

Aligns the vertical 
center of all 
selected elements 
with the vertical 
center of the 
anchor element 

Vertically centers the 
selected element(s) 
within the section 

Align 
Horizontal 
Center 

Aligns the 
horizontal center of 
the selected 
elements with the 
horizontal center of 
the anchor element 

Horizontally centers 
the selected 
element(s) within the 
section 

Make Same 
Width 

Makes the width of 
selected elements 
the same as the 
width of the anchor 
element 

Makes the selected 
element(s) the same 
width as the section 

Equal 
Horizontal 
Space 

Evenly distribute 
the horizontal 
spacing between 
selected elements 

n.a. 

Equal Vertical 
Space 

Evenly distribute 
the vertical space 
between selected 
elements 

n.a. 

  

Moving Elements between Sections 
You cannot move an element directly from one template section to another. If you need to move an element to 
another section, first remove it from one section and then add it to the other. 
  
  
Related Topics 
Resize elements 
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About template sections and spacing 
Recommended sequence and tips for modifying templates 

Remove an Element 
Print Designer overview | Print Designer FAQs 

Pro 

To delete an element from a template: 
1. Select the element to be deleted. 
2. Select Remove from the tool bar. 

Or 
Press <Delete> on your keyboard. 

To delete a data field from a group of fields 
1. Select the group of fields. 
2. Select Properties from the toolbar (or double-click the group element). 
3. In the Properties dialog, select or clear the checkboxes for the available group fields. 

At least one field must be left in the group. To delete all fields, remove the entire group element. 
4. Select OK. 

The vertical size of the group on the template is automatically adjusted to fit the remaining fields. 
  

Notes: 
• Some elements are required in specific templates and cannot be deleted. These elements are displayed in 
a gray color. 

Related Topics 
Recommended sequence and tips for modifying templates 

Import and Export Document Templates 
Print Designer Overview | Print Designer FAQs 

Pro 
Modified document templates are automatically available to other workstations on your network that access the 
same Point of Sale company data. 
If you create a new company data file and want to use your modified templates with that data (or want to share 
modified templates with another store) you can use the import & export feature to accomplish this. The export 
process places copies of all modified templates into a single file that can then be imported and used with another 
company data file. 

To export modified templates: 
1. From the Print Designer selection window, select Import & Export. 
2. Select Export Document Templates and then Next. 
3. Select to Export the Selected Document or Tag or Export All Documents and Tags and 
select Next. 
4. Accept the default filename and location or specify alternates. 

Defaults: (x = Point of Sale version number) 
File name: VxDocumentTemplates.XML 
Folder: C:\Program Files\Intuit\QuickBooks Point of Sale x.0\Design\  (folder will vary if you installed to a 
different location) 
4. Select Save. 
5. Select Close. 
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Your modified templates are exported in an XML file format that can be imported to the other company data file as 
needed. 
(Multi-Store)   The file can be copied to removable media, attached to an e-mail, or directly accessed across a 
network connection to share the templates with other stores. 
  

To import templates: 
1. From the Print Designer selection window , select Import & Export. 
2. Select Import Templates. 
3. Browse to the XML file containing the templates and select it. 
4. Select OK. 
5. Select Import Now. 

If the imported templates are named differently than the default templates, you must modify your template 
selections on the Documents & Printers page of workstation preferences to use them on printed documents. 
  

Notes: 
• You can also import templates from the File menu without opening Print Designer. Select Utilities > 
Import Print Templates. 

  
Related Topics 
Recommended sequence and tips for modifying templates 

Print Designer Preferences 
Print Designer Overview | Print Designer FAQs 

Pro 
Print Designer preferences give you choices for how you want to view and work with templates: 

• Snap Overlapping Objects to their Edges – helps quickly align the vertical edges of adjacent elements. 
With this option selected, you can overlap the top or bottom edges of two elements and they will automatically 
"snap" the edges to align with each other. 

• Show Example Text for Data Fields – With this option selected, data fields display sample text instead of 
the field description. 

• Show Top Ruler – Helps position elements horizontally on the page. 

• Show Side Ruler – Helps position elements vertically on the page. Note that vertical positioning is relative, 
rather than absolute. When the document is printed, fields not populated with data are removed and lower 
fields on the template moved up to fill the blank space. 

To set Print Designer preferences: 
1. With a template displayed, select Preferences from the lower-left of the screen. 
2. Select or clear the checkboxes for the preference options. 
3. Select Save. 

Print Designer FAQs 
Print Designer Overview 

Pro 

Adding and Removing Elements from the Template 
I see something on the screen that I want to remove, how can I do that? 
How do I add a new section? 
Besides my logo, what other images can I add to the template? 
How do I know what information fields are available in the template? 
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Formatting Text and Element Properties 
What options are available for formatting text and lines? 
How do I change the text in a message or comment line? 
  

Positioning and Sizing Elements and Sections 
How do I know where or how something will appear when I print? 
How do I get things to line up the way I want? 
Can I resize column and field widths? 
How do I resize or move a section? 
How do I align elements and groups? 
How do I turn on/off the rulers? 
How do the X/Y coordinates work? 
  

Printing and Viewing 
I see an element in the template, why is it not there when I print? 
Why is my new template not being used when I print? 
How do I know where or how something will appear when I print? 
  

Saving a Template 
How do I save and use my template design? 
How can I export my template so it can be used at another store or in another company data file? 
  
  

Didn’t find an answer to your question? Try these other resources: 

Visit the Point of Sale User Community to ask questions and share ideas, solutions, and advice with other Point 
of Sale users and experts. 

Check out our support website to search our online database of answers to frequently asked questions at 
www.quickbooks.com/support/pos. 
  
  
  
  
I see something on the screen that I want to remove, how can I do that? 
The easiest way to remove an element from a template in Print Designer is to select it and press the enter key on 
your keyboard. You can also use the remove button on the toolbar. 
When a selected element displays a grey background, it is required and cannot be removed. However, a required 
group field may have components you can turn off so that they will not display. 
Sections cannot be removed from a template. If you do not wish section to be printed, just remove the elements in 
that section. 
Learn more about removing elements from a template. 
Print Designer overview 
Return to question list 
  
  
How do I add a new a section? 
Each template has a predefined and unchangeable number of sections. The number of sections in a template will 
vary depending on the template and on whether you are using a 40-column printer. 

http://www.qbinproduct.com/community/help/pos
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Learn more about template sections. 
Print Designer overview 
Return to question list 
  
  
Besides my logo, what other images can I add to the template? 
More than one image can be specified in company preferences. but one must be designated the default logo. 
When you select an image in Print Designer, you can select the image set as the default logo, specify a different 
image than the default, or use more than one image in a document template. 
Learn more about adding a logo. 
Print Designer overview 
Return to question list 
  
  
How do I know what information fields are available in the template? 
Though most information is available to be printed, specific data fields will vary from template to template, and from 
section to section within each template. To determine what fields are available to be added in a section of a 
template, select that section and then select Add and Data field or Group of Fields. A dialog is displayed showing 
unused data fields that are available to be added to that section of the template. Data fields that are already in that 
section of the template will not be included in this list. 
Return to question list 
  
  
How do I change the text in a message or comment line? 
There are several different types of text messages. Some are defined in company preferences. Many documents in 
Point of Sale have comments fields that you can edit directly from the document. 
Some text fields, such as the signature memo on credit card receipts, cannot be edited. This text message can be 
turned off however by accessing the properties of the group element containing the credit card transaction and 
signature line. 
You can also add text to any section of a document template. 
Return to question list 
  
  

Formatting Text and Elements 
In Print Designer, text can be formatted in the same manner as it is formatted in most word processing programs, 
including font, size, bold, italic, underline and color. To change the formatting of text, access the properties of the 
element containing the text. 
Specialized formatting of borders and graphic lines is not supported. 
Learn more about changing font, line and border properties. 
Print Designer overview 
Return to question list 
  
  
How do I know where or how something will appear when I print? 
The exact vertical placement of an element is dynamic based upon the other content in the printed document. More 
content or less content will cause elements to shift up or down the printed document. The template design window 
shows you what elements are assigned in each section, their general horizontal position, the sequence in which 
they will appear, and the space between them. 
The Print Preview screen will provide a much closer approximation to the printed document. However, the preview 
screen does not have an actual transaction to use a basis for the display and therefore is still not a perfect example 
of the printed document. 
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The only way to see exactly how a document will print is to actually print a document from your history. However, 
you should bear in mind that not all fields are used in every document. For example, a receipt for a cash sale will 
not print the credit card signature lines. 
Learn more about positioning elements. 
Learn more about template sections and spacing. 
Return to question list 
  
  
How do I get things to line up the way I want? 
Elements can be aligned through various methods: 

• Drag and drop positioning 

• Using the alignment tools 

• Using the status bar coordinates 
It might also be necessary to resize an element in order to get it aligned in the way you prefer. 
Return to question list 
  
  
Can I re-size Column and field widths? 
Column widths, such as in the item list, can be re-sized. However, if you size the column and it becomes too 
narrow for the information that will appear in the column, the information will be cut off. 
Field and element widths can also be re-sized. Again, it is important to ensure that you do not re-size the field to a 
size too small for the data that will be printed in the field. 
Return to question list 
  
  
How do I resize or move a section? 
Sections in the template and particularly at the end of the document will vary in vertical length depending upon the 
particular type of document and the printer being used. It is recommended that you build each section from the top 
down and then set the placement for the end of each section and the end of the document according to the lowest 
field placed in that section. The sequence of sections is predefined in each template. 
The image below shows the divider at the end of the document moved to just below the end of the last field. This 
ensures that no wasted space is added to the printed documents. If more space is needed, the divider can be 
moved down. 
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Return to question list 
  
  
How do I turn on/off the rulers? 
You can turn the rulers and set other interactive features in Print Designer preferences. These features give you 
choices for how you want to view and work with templates: 

• Snap overlapping objects to their edges – helps quickly align the vertical edges of adjacent elements. 
With this option selected, you can overlap the top or bottom edges of two elements and they will automatically 
"snap" the edges to align with each other. 

• Show example text for data fields – With this option selected, data fields display sample text instead of 
the field description. 

• Show Top Ruler – Helps position elements horizontally on the page. 

• Show Side Ruler – Helps position elements vertically on the page. Note that vertical positioning is relative, 
rather than absolute. When the document is printed, fields not populated with data are removed and lower 
fields on the template moved up to fill the blank space. 

To set Print Designer preferences: 
1. With a template displayed, select Preferences from the lower-left of the screen. 
2. Select or clear the checkboxes for the preference options. 
3. Select Save. 

  
Return to question list 
  
  
How do the X/Y coordinates work? 
The X and Y coordinates are, respectively, the current horizontal and vertical position of the top left corner of the 
selected element. While moving an element, the displayed coordinates show the position changes, allowing you to 
place the element exactly, whether you are using drag and drop, or the arrow keys on the keyboard. 
Learn more about status bar coordinates. 
  
Return to question list 
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I see an element in the template, why is it not there when I print? 
Some elements are conditional and are only printed when applicable. For example, a credit card signature line 
would not appear on a receipt for a transaction being paid with cash. In such cases, the unused element and the 
space it takes are removed from the printed document. Elements that appear below the unused element are moved 
up the document accordingly. 
  
Return to question list 
  
  
Why is my new template not being used when I print? 
Point of Sale uses whichever template is assigned in workstation preferences. When printing tags, you have the 
ability to change the template and/or printer directly from the print dialog. 
  
Return to question list 
  
  
How do I save and use my template design? 
Templates can be modified and saved with the same name, or they can be modified and using Save As can be 
saved with a different name. Once complete, the modified template will be available for use. 
Point of Sale uses whichever template is assigned in workstation preferences. When printing tags, you have the 
ability to change the template and/or printer directly from the print dialog. 
Learn more about modifying and saving changes to a template. 
Learn more about recommended sequence for editing and saving templates. 
Return to question list 
  
  
How can I export my template so it can be used at another store or in another company data file? 
If you have created templates that you wish to use at another location or in another Point of Sale company file , use 
the import/export feature to export specific or all modified templates to an external file. Once you have copied the 
external file to the destination location, use the import/export feature at that location to bring the templates into that 
system. 
Learn more about importing and exporting templates. 
Return to question list 

Company Preferences 

Company Preferences: Overview 
Preference Instructions | Workstation Preferences 
  
Company preferences are used to configure Point of Sale features to best suit the needs of your business. 
Company preferences define settings and options that are shared by all Point of Sale workstations and all stores. 
From the File menu, select Preferences  Company. 
Company preferences are split into the following categories. Select a category for specific information about the 
options on that page: 

General Purchasing 

Financial Receiving 

Merchant & Gift Services Sales 

Inventory Sales tax 

Price levels Customers 

Ratings & Trends Layaways 
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Sales orders 
E-mail documents 

Work orders 
Multi-store 

  

Notes: 
• Some company preferences are initially configured as you complete the Company Setup but can be 
directly edited at anytime as your needs change. 

• Shared company preferences that affect all stores can be defined at Headquarters only. Store-specific 
company preferences, such as default payment type, allowed credit card types, default tax location used for 
sales, and employees and security, are set at each store independently. Learn more. 

• Use workstation preferences to define workstation-specific settings, such as attached hardware setup and 
printing configuration. 

General Instructions for Editing Company Preferences 
Overview | Workstation Preferences 
  

 Warning: Undo and Reset Options Affect All Preferences 
Two powerful options are available from the Preferences I Want To menu:  Undo Changes to discard all changes since your last 
save, but remain in preferences, and Reset to Default Setting to revert all workstation preferences to their default values. Be 
aware that these choices affect all workstation preferences, not just the page you are currently viewing. 

To edit company preferences: 
1. From the File menu, select Preferences  Company. 
2. In the left pane, choose the page containing the preference you want to change. 

Click the icons (or keys) to expand or collapse the preference menu structure, as necessary. 
3. Edit the preference settings as needed. Help for each page is displayed in the yellow sidebar to 
the right. 
4. Select Save. 

  

Notes: 
• Select Cancel to leave preferences without saving any changes. 

Company Preferences: General 
Preference Instructions | Employee & Security Overview 
  
The General Page contains preference settings affecting general program usage, rather than a specific area, 
including the ability to remove features you do not wish to use. 

Preference Function 

General Options   

Require users to sign 
in 

 = Require users to login to Point of Sale 
using the login names and passwords you 
have assigned. 
Only the System Administrator  can 
change this setting after it has been 
turned on. 
Changing this setting requires that a 
System Administrator password be 
entered and that all open windows be 
closed before saving. 

Automatically log out  = Automatically logs out the current 
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users after each sale user upon saving a receipt (if users are 
required to log in). 

Warn when editing 
documents, items, or 
customers 

 = Confirm edits to documents, items, or 
customers before carrying out the action. 

Warn when deleting 
documents, items, or 
customers 

 = Confirm deletions of documents, 
items, or customers before carrying out 
the action. 

Bring back all one 
time messages 

Selecting DO NOT SHOW ME AGAIN 
from a Point of Sale message prevents 
that particular message from being 
displayed. Selecting this preference brings 
back all such messages. This option is 
then cleared. You may have to close and 
re-open currently open windows for the 
messages to show up. 

Select features to use  = Select the checkboxes for features 
you use in Point of Sale. Clear the 
checkboxes to remove a feature. Related 
icons, menu options, and information 
fields are removed from Point of Sale 
screens. Return here at anytime to 
change your choices. 
Changing these settings may require you 
to close any open windows in related 
areas before saving. 
(Pro) Some choices are interdependent, 
e.g., if you choose to use customer 
orders, then customer tracking is a 
required feature. 

Data Safeguard  = By default, a backup is made of 
your company file once per day when 
you exit Point of Sale on the Server 
Workstation. Change this selection to 
create a backup at a scheduled time 
instead. Read the information in the help 
sidebar about requirements for scheduled 
backups. Learn more. 
(Pro) Include item images... Select the 
checkbox to include item images in your 
backup file. This option may greatly 
increase the time to create and size of 
your backup file. 

Store Info   

Headings Store headings are printed across the top 
of documents. 
Enter information in the following fields: 
Store Name, Street, City, State, ZIP, and 
Miscellaneous 1-3. 

Logo  = Select the checkbox and then click 
Specify to add one or more logos. Select 
one of the added logos to print on sales 
documents. Adding multiple logos lets you 
switch between them quickly. 
(Pro) You can use Print Designer to print 
different logos on different documents. 
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Learn more about logos and file 
requirements. 

My Field Labels   

Field Labels You can define the field labels for the four 
item description fields. The field labels you 
specify are displayed throughout the 
program, on printed documents, and on 
reports. 
Choose Restore to Defaults at the 
bottom of the page to return all labels to 
the program default values. 
(Pro) You can also define labels for the 
custom fields available on customer, 
vendor, item, and employee records. If 
integrated with QuickBooks financial 
software, the information in customer and 
vendor custom fields is shared, provided 
they are named exactly the same in both 
programs. 
  

Return to top 
Company preferences overview 

Company Preferences: Financial 
Preference Instructions | Financial Exchange Overview 
  
Set financial preferences in order to exchange data with your QuickBooks financial software. Note that there may 
be a short delay accessing these preferences as Point of Sale connects with your QuickBooks software and reads 
existing account lists and other preferences to make them available for selection here. 
  

Preference Function 

Financial   

Use with 
QuickBooks 
financial 
software 

 = Select to allow the exchange of data between Point of Sale and QuickBooks financial 
software. 
QuickBooks must be running and the financial company file you intend to share data with 
open to establish the initial connection. Learn more 
Note: This option must be selected in order for all other financial preferences to be 
available. 

QuickBooks 
Company file 
Where is my 
QuickBooks 
financial 
company file? 

Once connected, your company name and file location are displayed. 
To connect to your QuickBooks company file, launch QuickBooks and open your company 
file, then select Set Up QuickBooks Connection Now and follow the on-screen prompts. 
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Send receipts 
and vouchers 
with.. 
Learn more 

Select an option: 

• Detailed item descriptions 

• Detailed item descriptions for customer charge account transactions only 

• Summarized item totals (no item detail: default) 

Order to send 
customer 
name to 
QuickBooks 
(Basic) 
Learn more 

Select the order in which you want customer names sent to QuickBooks: <Last>, <First> 
default 
<First Last> 
<Title First Last> 

Send 
discounted 
items with 
Learn more 

Select an option: 

• Net value (discounts not reported separately) 

• Separate original and discounted values 

Employee 
Hours (Pro) 
  
Learn More 
  
Return to top 

 = Send employee time records from Time Clock to QuickBooks. Select the hourly 
payroll item to be used for the time entries created in QuickBooks. Requires integration 
with QuickBooks Financial Software 2009. 

Financial Accounts: Basic 

Default item 
accounts 
  
View default 
accounts 

Specify a default Income, Cost of Goods Sold , and Asset account for each item type 
(not all item types use all three accounts). 
With a few exceptions  related to item Income accounts, all of your QuickBooks accounts 
are available for selection from the drop-down list in each field. The default accounts 
specified are assigned to all items in inventory, but you can change the accounts item-by-
item in inventory as needed. 

Automatically 
create sub-
accounts 
based on: 

 = Select and then specify how sub-accounts should be created and for which item 
accounts. Learn more. 

Apply 
accounts to 
existing 
items 

Select to apply the accounts specified above to all existing items in your Point of Sale 
inventory. The reassigned accounts will take effect with the next Financial Exchange. 
Important: This overwrites any previous item accounts you have specified. 
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Financial 
Accounts: 
Advanced 

Map custom accounts (except item, see above) for Financial Exchange. Choose Reset to 
defaults at the bottom of this page to return to the default set of account mappings. 

Account 
mapping 
  
View default 
accounts 

Each account/field in Point of Sale must be "linked" (mapped) to a QuickBooks financial 
software account to which data will be transferred. You can accept the default account 
mappings or define your own mapping structure by choosing from the drop-down list in the 
QB Account column. 
Only accounts previously defined in QuickBooks are available for selection. Learn more. 

  
For frequently asked questions about Financial Exchanges, see Troubleshooting Financial Exchange. 
  
Return to top 
Company preferences overview 

Company Preferences: Merchant & Gift Services 
Preference Instructions | Merchant Overview | Gift Card Overview 
  
This topic summarizes the company preferences that apply to credit and gift card transactions processed through 
the QuickBooks POS Merchant and Gift Card Services. 
 What if I have multiple store locations? 

Using another service? If you use another merchant or gift card service, only those preferences marked with an * apply to you. 

  

Preference Function 

Merchant Service   

Merchant Number Enter the number provided via e-mail from 
the QuickBooks POS Merchant Service. 
After entry, select Verify to test your 
account setup. 
Note: Select the Communication Setup 
preference page (see below) and confirm 
your connection setup before verifying 
your account. 

Credit card address 
verification 
  
What is address 
verification?   

 Do not allow manual transactions 
that fail address verification — 
Selecting this option provides a degree of 
protection against fraud and chargebacks 
but may also block some legitimate 
transactions. You will not be able to 
complete a credit card transaction if an 
address verification mismatch occurs. If 
you clear this checkbox, you are alerted 
when a mismatch occurs but can continue 
with the transaction at your discretion. 
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Credit card 
verification 
  
What is card 
verification?   

 Do not allow manual transactions 
that fail card verification — Selecting 
this option provides a degree of protection 
against credit card fraud and 
chargebacks, by blocking transactions 
where the card verification code does not 
match card issuer records. If you clear 
this checkbox, you are alerted when a 
mismatch occurs but can continue at your 
discretion (subject to card issuer 
regulations). 

*Debit/ATM setup  = *Accept debit/ATM card payments. 
Select to allow customer payment by 
debit/ATM card. 
 = *Allow cash back up to: Select if 
you wish to allow cash back to the 
customer on PIN debit transactions, and 
specify the maximum cash back allowed 
(up to $200). 
A PIN pad device is required for PIN 
debit/ATM transactions through the 
QBPOS Merchant Service. Configure 
your PIN pad in the Hardware Setup 
Wizard or  workstation preferences. 

*Automatically print 
and save receipt 
upon credit, debit, or 
gift card approval 

 = If selected, the receipt will be 
saved/printed automatically after approval 
for the transaction is received. 

Return to top 
  

  

Gift Card Service   

Gift Card Account 
Number 

Enter the number provided via e-mail from 
the QuickBooks POS Gift Card Service. 
After entry, select Verify to test your 
account setup. 
Note: If using a dial-up connection 
(modem) to communicate with the 
Merchant Service, select the 
Communication Setup preference page 
(see below) and change the setting to 
Direct-dial before verifying your account. 

Communication 
Setup 

Applies to Merchant and Gift Card 
Services 

Use this computer for 
all credit, debit, and 
gift card transactions 

 = All credit, debit, and gift card 
transactions are authorized and settled 
through this workstation (workstation must 
have a modem or Internet connection). 
If the checkbox is checked and grayed 
out, this option has already been selected 
for this workstation. To transfer this 
function to another Point of Sale 
workstation, access this preference from 
that computer and select the checkbox. 
The specified workstation must be 
running and the connection active for 
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other workstations on a network to 
authorize transactions. Learn more. 

Communication 
Options 

Select an option for communicating with 
the QuickBooks POS Merchant and/or 
QuickBooks POS Gift Card Service: 
 = Secure Internet Connection 
provides an IP-based connection through 
your Internet Service Provider (ISP). This 
option requires a persistent Internet 
connection (DSL, Cable, T1, etc.). Click 
the internet connection setup button if 
you need help configuring your 
connection. 
 = Direct-Dial supports high-speed and 
advanced modem technologies, typically 
using your modem's default settings. 
Read modem setup instructions. 

Return to top 
  
Specifying the credit cards accepted 
Company preferences overview 

Company Preferences: Multi-Store 
Preference Instructions | Multi-Store Preferences Overview 

Pro - Multiple Stores 
These settings apply only  to Pro users that have multiple stores. 

Key Topics 
The table below summarizes the multi-store and Store Exchange preference settings. For more information about 
setting up your stores from the Store Exchange Center, use these links: 
Configure Headquarters Store Exchange preferences 
Configure remote Store Exchange preferences 
  
  

Preference Function 

Multi-Store This page summarizes your store type 
information. 
You can use this page to change a store 
from Headquarters to remote. Read the 
information on this page carefully, as 
changing store types at any time other 
than the initial installation requires 
additional steps to protect your data. 
Important information about changing 
store types 

Store Codes / 
Classes 

Note: Changing your number of stores 
requires that all inventory and transactional 
document windows be closed before saving. 

(Headquarters only) Enter your total 
number of stores, and then assign a 
unique alphanumeric code up to three 
characters for each. This code is 
displayed throughout the program and on 
multi-store reports. 
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Optionally, assign a QuickBooks financial 
software class to each store to allow 
Profit/Loss reporting by store in your 
financial software. You must have 
already connected to your financial 
software and have it configured to use 
classes before this option is available in 
Point of Sale. Learn more. 

Store Exchange 
  
For more information, 
read Configuring Store 
Exchange. 

On the Configuration tab: 
Specify a communication method for 
Store Exchanges with your other stores, 
then select Configure to enter the other 
stores’ license number and e-mail 
address, file transfer path, or folder 
location (depending on exchange 
method). 
In the Store Exchange Notification 
area, you can set an alert so that you are 
aware if you have not sent or received a 
file from another store. Enter the number 
of days after which you will be alerted. 
On the Options tab: 
Select Change Password to enter or 
revise a password to encrypt Store 
Exchange files (required). The same 
password must be entered at all stores. 
Note: If you have multiple POS data files, 
enter a different password for each file. 
If you want received files placed in a 
folder other than the default, browse to a 
new Process-In Folder. Select Revert 
to Default Folder to return to using the 
default folder. 
Finally, if desired select Automatically 
exchange store data... and enter a time 
for files to be exchanged each day. Read 
the information provided on the right of 
this screen for important information. 

Store Heading (Headquarters only) Select a store from 
the drop-down list and enter store name, 
address, and miscellaneous information. 
Repeat for each store. This information is 
included on printed sales documents. 

  
Multi-store overview 
Company preferences overview 

Company Preferences: Inventory 
Preference Instructions | Inventory Overview 
  

Preference Function 

I want to associate 
pictures with my 
inventory items (Pro) 
  

Select to make the item picture fields 
available on the item form and a 
thumbnail available in other program 
areas. 
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Reset automatic item 
number sequencing 
when an item number 
is edited 
  
  
Create reorder 
reminders based on 
(Pro) 

  
If selected, editing an item number in 
inventory resets the auto-numbering 
sequence to begin with the next available 
number after the edited number. 
  
Select an available option: 
Available quantity (default): Takes into 
consideration quantities committed to 
open customer orders. 
On-Hand Quantity: Does not take 
customer order quantities into 
consideration. 
With either selection, Point of Sale looks 
at your reorder points and considers 
quantities already on open purchase 
orders before adding items to the reorder 
reminders. Learn more. 

Inventory Quick Pick 
Groups 

Click Add to create a new inventory tag 
for use with the Quick Pick Item feature. 
Once defined, you assign the tags to 
items in inventory and can then use 
Quick Pick to add them to  sales receipts 
and receiving vouchers. 
You can use other action buttons to 
arrange the order or remove item tags. 

Units of Measure 
  
  
  
  
  
  
  
  
Multiple Units of 
Measure (Pro) 

Select Add to define a new unit of 
measure or Remove to delete an 
existing one. 
The Move Up and Move Down buttons 
allow you to arrange the entries into the 
order they will appear on the drop-down 
list on item records. 
Unit of measures defined here are 
available for use with the multiple unit of 
measure feature described below. 
  
I want to set up multiple units of 
measure.. Select to use the multiple unit 
of measure feature to purchase, receive 
and sell items by different units, such as 
by cases and individual units. Learn 
more. 
  
Unit of measure options: 
Print unit of measure information in 
the quantity field on all documents. 
Select to insert the unit in the quantity 
field on printed documents. Learn more. 
  
Displaying Units of Measure: Choose 
whether Point of Sale should add the 
UOM fields to all documents and lists, or 
if you want to add them manually as 
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needed. 

Company preferences overview 

Company Preferences: Pricing 
Preference Instructions | Price Level Overview 
  
Use this page to define a price tag code, price level names and markdowns, and the default price level to use on 
sales. Changing your price level information in preferences does not update item prices of existing items in 
inventory. 

Preference Function 

Default Price From the drop-down list, specify the 
default price to suggest for all sales in 
this store. 
Default: Regular Price 

Price Levels 
  
  
  

Define up to four optional markdown 
price levels. 
Name: Assign a custom name to each 
price level you wish to use. 
Markdown %: Assign a default 
markdown percent for each price level. 
The price at each price level is calculated 
from your regular price by applying the 
markdown. 
These default markdowns are used to 
calculate the prices for new items added 
to inventory. Changes to the default 
markdowns do not update existing item 
prices. Individual prices at each level can 
be manually edited at any time item-by-
item in inventory. 
Tip: For no markdown, enter 0%. To do 
a markup, enter a negative markdown, 
e.g., -10%. 
Learn more 

Price Tag Code 
  

Enter a character to replace each 
number (0-9) when selecting to print cost 
and last received dates in code on price 
tags. 
To use this feature, you must select a tag 
template that includes the cost fields in 
workstation preferences. Templates that 
include the cost fields have "+cost" 
included in the template name. 

Company preferences overview 

Company Preferences: Purchasing 
Preference Instructions | Purchasing Overview 

Basic  

Use the Purchasing preferences to set various options related to the purchasing of merchandise from your vendors. 
  

Note: You must have purchase orders enabled in your Select Features to Use preferences for the following preferences to be 
applicable. 
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Preference Function 

Purchase Order 
Numbering 

By default, purchase orders are 
sequentially numbered, starting with 1. 
If preferred, you can precede the number 
with a text string, such as the vendor 
name, vendor code, or the name of the 
associate making the PO. You can also 
change the starting number. 
Follow the instructions provided on the 
help sidebar on the preference page. 

Purchase Order 
Status 

There are default statuses for use in the 
Status field on purchase orders: 

• Open is automatically assigned to 
every new order. 

• Closed is automatically assigned to 
the order once all listed items have 
been received on a voucher. 

• Pending should be assigned to 
planning orders that haven't been 
given to your vendor.  (Pro) And so 
they are not included when Point of 
Sale calculates available quantities. 

• Suggested is assigned to purchase 
orders generated by the Suggest 
PO feature. (Pro) 

You can change the name of these 
statuses, add new ones, and arrange the 
order they appear in the Status field 
drop-down list on order forms. Learn 
more. 

Purchase Order 
Instructions 

Enter up to two lines of optional 
instructions to print on POs. These 
instructions are not displayed on screen. 

  
Company preferences overview 

Company Preferences: Receiving 
Preference Instructions | Receiving Overview 

Basic  

Use the Receiving preferences to set various options related to receiving of merchandise from your vendors. 

Preference Function 

Warn when receiving 
against PO past its 
Cancel Date 

Alert employee when receiving against a 
PO that has passed the cancel date. If 
this preference is not selected, the 
cancel date is ignored. 

Enter vendor billing 
information in Point 
of Sale 

Select to enter vendor billing information 
on receiving vouchers in Point of Sale. 
By default, the vendor billing information 
fields are not available on Point of Sale 
receiving vouchers, as it is assumed you 
will track vendor billings in QuickBooks 
financial software. 
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Learn more. 

Printed Voucher 
Message 

Enter optional default message to print 
on all vouchers. This message is not 
displayed on screen. 

  
Company preferences overview 

Company Preferences: Sales 
Preference Instructions | Sales Overview 
  
Sales preferences allow you to define various options related to sales transactions.   
The Sales page covers the general sales preferences. Other sales preferences are discussed on sub-pages (select 
a link for instructions). 
Discounts – define and optionally require manual item discount reasons 
Receipt message – printed on every sales receipt 
Shipping – list of shipping providers 
Receipt tendering – payment options 
  
Sales – General 
Preference Function 

Order to display full 
name field 

Choose the order in which to display/print 
customer names on receipts. 
Example: A record has Sara in the First 
field, Edward in the Last field, and Ms. in 
the Title field. If you choose to display 
the name as last, title, first, Point of Sale 
will print the name as Edwards, Ms. 
Sara. 

Require a 
promotional code 
entry 

 = Requires an entry in the Promo 
Code field on a receipt before payment 
can be accepted and the document 
saved. This field facilitates filtering for 
viewing or reporting purposes. 
(Pro) This also applies to customer 
orders. 

Require a manual 
media count for X/Z-
Out 

 = If selected, associates are required 
to manually count each denomination of 
currency when running a Z-Out Drawer 
Count report. 

When printing group 
item on receipt or 
customer order (Pro) 

Select to print the group item price only, 
the individual component item prices 
only, or both. Default is to print individual 
item prices only. 

Open Cash Drawer  = Select the payment types that will 
open an attached, compatible cash 
drawer. Defaults: Cash, Check. 

Return to top 
  
Related Topics 
Customizing receipt item list columns 
Customizing printed receipts and other documents 
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Company preference: removing unused features 
Company preferences overview 

Company Preferences: Discounts 
Preference Instructions | Giving Discounts 
  

Preference Function 

Manual Item Discount 
Reason 

 = Require a discount reason for 
manual discounts. Select to require the 
cashier to specify the reason when giving 
a manual item discount. 
This allows you to track discounts given 
on discount reports. 
You define manual discount reasons in 
Price Manager. The names will then be 
available for the cashier to select from on 
the sales receipt. 

Print Coupons on 
Receipts (Pro) 

 = Print coupons on receipts.  Select 
and then specify options to print your 
store coupons with qualifying sales 
receipts. 
To avoid giving coupons to customers 
who also qualify for your rewards 
program, select the checkbox titled 
Exclude receipts with rewards 
customer assigned. 

  

Other Sales Preferences 
Sales – general sales preferences 
Printed receipt message 
Shipping – list of shipping providers 
Receipt tendering – payment options 
  
Related Topics 
Company preferences overview 
Customizing printed receipts and other documents 

Company Preferences: Printed Receipt Message 
Preference Instructions | Sales Overview 
  

Preference Function 

Printed Receipt 
Message 

Enter text to be printed on all receipts. 
For example, you might want to use this 
preference to print your return/exchange 
policy,  or a thank you message. 
Pro users might include information 
about your rewards program. 

  

Other Sales Preferences 
Sales – general sales preferences 
Discounts – define and optionally require manual item discount reasons 
Shipping – list of shipping providers 
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Receipt tendering – payment options 
  
Related Topics 
Company preferences overview 
Customizing printed receipts and other documents 

Company Preferences: Shipping 
Preference Instructions | Sales Overview 

Pro 
  

Note: You must have shipping enabled in your Select Features to Use preferences for the following preferences to be applicable. 

  

Preference Function 

Shipping Manager 
  
  
  

Use QuickBooks Shipping Manager. 
Select the checkbox to use Shipping 
Manager. 
With the Shipping Manager you can 
connect to UPS shipping services online 
to arrange shipments, print shipping 
labels, and track the shipments from 
within Point of Sale. 
Shipping Manager Requirements  

• You must have an account 
with UPS. Links are provided 
within Shipping Manager to 
sign up for an account, if 
necessary. 

• The workstation(s) on which 
you will use Shipping Manager 
must have Internet access. 

• You must set up Shipping 
Manager on each workstation 
that will use it. You can share 
the same account number on 
all your workstations. 

  
  
I do not charge my customer for 
shipping. With this option, you can use 
Shipping Manager to arrange shipments, 
but the shipping charges will not be 
added to sales receipts. 
Learn more about Shipping Manager 

  

Shipping Providers Select Add or Remove to add or delete 
shipping providers from the list. 
The providers on this list are available in 
the order listed for selection on sales 
receipts and customer orders. Use the 
Move Up/Down buttons to arrange the 
order of providers and the Make Default 
button to designate the provider that is 
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suggested when entering shipping 
information on a document. 
  
Important: If using Shipping Manager, 
ensure you do not include "UPS" in the 
name of a provider you are adding 
manually. This string of characters will 
result in errors when shipping. If adding a 
legitimate UPS service, select it from the 
predefined drop-down list in the Add a 
New Shipping Provider dialog. 
The shipping providers and service levels 
on this list are available (in the order 
listed) for selection on sales receipts and 
customer orders when you are adding 
shipping information or charges. 
Use the Add, Remove, and Move 
Up/Down buttons to add, delete, or 
rearrange the providers to meet your 
needs. 
Important: Do not include "UPS" in the 
name of a provider you are adding 
manually. This string of characters will 
result in errors when shipping via 
Shipping Manager. If you need to add a 
legitimate UPS service, select it from the 
predefined drop-down list in the Add a 
New Shipping Provider dialog. 

  

Other Sales Preferences 
Sales – general sales preferences 
Discounts – define and optionally require manual item discount reasons 
Receipt message – printed on every sales receipt 
Receipt tendering – payment options 
  
Company preferences overview 

Company Preferences: Receipt Tendering 
Preference Instructions | Taking Payments | Sales Overview 
  

Preference Function 

Payment Methods Select the payment methods you accept 
on sales. Only the payment methods 
selected will be available on the receipt 
payment window. Cash cannot be 
removed. 
Default payment method: From the 
drop-down list, select the payment 
method most frequently used on sales. 
This default method will be suggested on 
all new sales. 

Card Types Specify the credit card types allowed 
when taking a payment by credit card. 
Only the selected types will be accepted. 
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Tips Select to be prompted to collect and 
record a tip (gratuity) on credit card, gift 
card, and account charge sales. Learn 
more. 

Past Due Payments Select and enter 30, 60, or 90 days to 
display past due amounts and block 
additional charges to a customer's 
account at that age. Past due amounts 
come from your QuickBooks financial 
software. Learn more. 

  

Other Sales Preferences 
Sales – general sales preferences 
Discounts – define and optionally require manual item discount reasons 
Receipt message – printed on every sales receipt 
Shipping – list of shipping providers 
Company preferences overview 

Company Preferences: Customers 
Preference Instructions | Customer Overview 

Basic  

Customer preferences allow you to specify if you want to share customer information with your QuickBooks 
financial software and if you want to require that a customer be recorded on all sales. Recording customers on 
sales allows you to offer customer-specific discounts, use charge accounts, and to build customer sales history. It 
is not necessary to require that a customer be recorded to use these features. 
  

Note: You must have customer tracking enabled in your general  preferences for the following customer-specific preferences to 
be applicable. 

  

Preference Function 

Use with QuickBooks Choose Yes if you want information for 
all new customers to be shared with 
QuickBooks by default. You can still 
change this setting for individual 
customers on their record. 

Customer tracking 
options 

 Require a customer entry on receipts. 
If selected, a receipt cannot be saved 
until a customer is entered. 
Note that this option is not required to list 
a customer on a sale. 

E-mail Marketing If you have an account with the POS e-
mail marketing partner , enter your login 
name and password here. Targeted 
customer lists you create in Point of Sale 
can then be sent automatically to the 
partner. Learn more. 

Customer Type Create categories of customer types for 
your business. Customer types can then 
be assigned in the customer record and 
used for filtering the customer list and 
reports. 

Company preferences overview 
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Company Preferences: Customer Orders 
Preference Instructions | Customer Order Overview 

Pro 
Layaway, sales order, and work order preferences allow you to define various options related to these customer 
order documents. There is a separate preference page for each customer order type, but all have the same options 
as described here. 

Note: You must have customer orders enabled in your Select Features to Use preferences for the following preferences to be 
applicable. 

  

Preference Function 

Initial Deposit Select how you want to handle the initial 
order deposit. Subsequent deposits can 
be for any amount: 
Do not require or suggest an initial 
deposit:  = If selected, no initial deposit 
is required or suggested when you create 
a new order. 
Suggest an initial deposit:  
 = If selected, an initial deposit amount 
is suggested for each new order. Enter 
the percentage of the total order amount 
that you want suggested as the deposit 
amount. When taking the deposit the 
suggested amount is auto-filled, but can 
be changed or deleted, at your 
discretion. 
Require an initial deposit:  
 = If selected, an initial deposit is 
required for the order. Enter the 
percentage of the order total to be 
required. When taking the deposit the 
required amount is auto-filled. You can 
enter a larger amount, if you wish, but 
you cannot reduce or delete the required 
amount. 

Order Status There are three default statuses for use 
in the Status field on customer orders: 

• Open is automatically assigned to 
every new order. 

• Closed is automatically assigned to 
the order once all listed items have 
been sold on a receipt. 

• Pending should be assigned to 
orders used to give estimates or 
quotes to customers, where the 
items are not yet committed to sell. 
Pending orders are not included 
when Point of Sale calculates 
available quantities. 

You can change the name of these 
statuses, add new statuses, and arrange 
the order they appear in the Status field 
drop-down list on order forms. Learn 
more. 
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Printed Message Enter text to print on the bottom of every 
order. 

Document 
Numbering 

By default, orders are numbered 
sequentially, starting with 1. You can use 
this preference page to specify text or a 
POS field that should precede the 
sequential number or to change the 
starting number. 

  
Taking deposits on orders 
Company preferences overview 

Company Preferences: Customer Orders 
Preference Instructions | Customer Order Overview 

Pro 
Layaway, sales order, and work order preferences allow you to define various options related to these customer 
order documents. There is a separate preference page for each customer order type, but all have the same options 
as described here. 

Note: You must have customer orders enabled in your Select Features to Use preferences for the following preferences to be 
applicable. 

  

Preference Function 

Initial Deposit Select how you want to handle the initial 
order deposit. Subsequent deposits can 
be for any amount: 
Do not require or suggest an initial 
deposit:  = If selected, no initial deposit 
is required or suggested when you create 
a new order. 
Suggest an initial deposit:  
 = If selected, an initial deposit amount 
is suggested for each new order. Enter 
the percentage of the total order amount 
that you want suggested as the deposit 
amount. When taking the deposit the 
suggested amount is auto-filled, but can 
be changed or deleted, at your 
discretion. 
Require an initial deposit:  
 = If selected, an initial deposit is 
required for the order. Enter the 
percentage of the order total to be 
required. When taking the deposit the 
required amount is auto-filled. You can 
enter a larger amount, if you wish, but 
you cannot reduce or delete the required 
amount. 

Order Status There are three default statuses for use 
in the Status field on customer orders: 

• Open is automatically assigned to 
every new order. 

• Closed is automatically assigned to 
the order once all listed items have 
been sold on a receipt. 
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• Pending should be assigned to 
orders used to give estimates or 
quotes to customers, where the 
items are not yet committed to sell. 
Pending orders are not included 
when Point of Sale calculates 
available quantities. 

You can change the name of these 
statuses, add new statuses, and arrange 
the order they appear in the Status field 
drop-down list on order forms. Learn 
more. 

Printed Message Enter text to print on the bottom of every 
order. 

Document 
Numbering 

By default, orders are numbered 
sequentially, starting with 1. You can use 
this preference page to specify text or a 
POS field that should precede the 
sequential number or to change the 
starting number. 

  
Taking deposits on orders 
Company preferences overview 

Company Preferences: Customer Orders 
Preference Instructions | Customer Order Overview 

Pro 
Layaway, sales order, and work order preferences allow you to define various options related to these customer 
order documents. There is a separate preference page for each customer order type, but all have the same options 
as described here. 

Note: You must have customer orders enabled in your Select Features to Use preferences for the following preferences to be 
applicable. 

  

Preference Function 

Initial Deposit Select how you want to handle the initial 
order deposit. Subsequent deposits can 
be for any amount: 
Do not require or suggest an initial 
deposit:  = If selected, no initial deposit 
is required or suggested when you create 
a new order. 
Suggest an initial deposit:  
 = If selected, an initial deposit amount 
is suggested for each new order. Enter 
the percentage of the total order amount 
that you want suggested as the deposit 
amount. When taking the deposit the 
suggested amount is auto-filled, but can 
be changed or deleted, at your 
discretion. 
Require an initial deposit:  
 = If selected, an initial deposit is 
required for the order. Enter the 
percentage of the order total to be 
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required. When taking the deposit the 
required amount is auto-filled. You can 
enter a larger amount, if you wish, but 
you cannot reduce or delete the required 
amount. 

Order Status There are three default statuses for use 
in the Status field on customer orders: 

• Open is automatically assigned to 
every new order. 

• Closed is automatically assigned to 
the order once all listed items have 
been sold on a receipt. 

• Pending should be assigned to 
orders used to give estimates or 
quotes to customers, where the 
items are not yet committed to sell. 
Pending orders are not included 
when Point of Sale calculates 
available quantities. 

You can change the name of these 
statuses, add new statuses, and arrange 
the order they appear in the Status field 
drop-down list on order forms. Learn 
more. 

Printed Message Enter text to print on the bottom of every 
order. 

Document 
Numbering 

By default, orders are numbered 
sequentially, starting with 1. You can use 
this preference page to specify text or a 
POS field that should precede the 
sequential number or to change the 
starting number. 

  
Taking deposits on orders 
Company preferences overview 

Company Preferences: Sales Tax 
Preference Instructions | Tax Overview | Tax FAQs 
  

Pro Note: If you have multiple stores, sales tax must be set up at Headquarters. Remote stores can select the default tax location 
applicable to sales at their store on this page. 

  
Use the procedures below to set up the collection of sales tax in Point of Sale. You can add or edit tax codes or 
locations, and set specific taxing instructions for each. We recommend you set up all of the tax codes you will use 
in the default tax location first, then add additional tax locations and edit the codes for each as necessary. 
From the File menu, select Preferences > Company and then select Sales Tax from the list on the left. 

To specify that you collect sales tax: 

• Select (check) the Collect Sales Tax checkbox. Clear the checkbox if you do not collect sales taxes. 
Adding or editing a tax code  

If you use multiple tax locations, adding or deleting a tax code in one location adds or deletes that code in all 
locations. If the taxing instructions for a code are different in different locations, edit the tax code as appropriate 
for each affected location. Editing a tax code in one location does not affect that tax code in other locations. 
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To add or edit a tax code: 
1. Select Add Tax Code or Edit Tax Code within a tax location. You may have to scroll the 
page to view all of your choices. 

The Add/Edit Tax Code Wizard is displayed. Select Next or Back to move between pages of the Wizard. 
2. Enter or edit the Tax Code (3-character maximum) and Tax Name, specify the tax rate(s), 
and set other tax options for this code as appropriate. Select Help (<F1>)on any page for more 
information about the settings on that page. 
3. When done, select Finish. 
4. Specify the default tax code when creating a new department at the bottom of the preference 
page. 

The taxing instructions of the specified code, as defined for your default tax location (see below), will be 
suggested for new departments and to the items in that department. 

5. Select Save. 

• If a tax code is no longer needed, it can be deleted by selecting Remove to the right of the 
window. 

  
Adding or editing a tax location  

1. Select Add Tax Location or Edit Tax Location, as applicable. You may have to scroll the 
page to view all of your choices. 

The Tax Location Wizard is displayed. 
2. Enter or edit the Tax Location Name. 

(Pro) If shipping charges in this location are taxable, select the checkbox for that option and select a tax 
code to assign to the shipping charges. 

3. Select OK. 
4. Add or edit your tax codes for this location, if necessary (see above). 
5. Select the default tax location for this store at the bottom of the page. 

The taxing instructions of the specified location will be the default for all sales. 
6. Select Save. 

The first tax location in the list, named Local Sales TAXES, cannot be deleted, but it can renamed or edited to 
specify additional taxing instructions. Other tax locations can be deleted by selecting Remove to the right of the 
window. 
  

Basic Note: The tax location Exempt is hard-coded and not displayed in your tax preferences. This location is used for 
customers you have marked as tax-exempt and has an automatic 0% tax rate for all tax codes. You can filter sales reports by 
this hidden tax location. 

  
  
Related Topics 
How do I use tax codes? 
How do I use tax locations? 
Sales tax Integration with QuickBooks financial software 

Company Preferences: E-mail Documents 
Preference Instructions | E-mailing Documents 

Pro 
Specify default settings for e-mailing documents from within Point of Sale. 
  

Preference Function 
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Default Message Text Select a document type from the drop-
down list at the top of the window and 
then complete the following settings to 
apply to that document type. Repeat for 
each document type you wish to e-mail. 
Enter salutation, subject line, and body 
text. Point of Sale writes this information 
to each e-mail it creates, but you can edit 
individual e-mails before sending. 
You can add information fields (shown in 
<brackets> at bottom of window) to your 
subject line or message, in which case 
the information from the matching fields 
on the document being sent is auto-filled 
to the message when it is created. Enter 
the field name and bracket just as 
shown. 

Create attachment as Select one of the e-mail attachment 
formats: 
PDF – recipient must have Adobe 
Acrobat Reader installed to view. 
Excel – recipient must have Microsoft 
Excel 2000 - 2007 installed to view. 
HTML – can be viewed in web browsers. 
Text – plain text format that can be 
viewed in most text editors or Word 
processing software. 

  
See also the workstation preference for being prompted to e-mail each sales receipts. 
  
Company preferences overview 

Company Preferences: Ratings & Trends 
Preference Instructions | Item Ratings | Customer Ratings 
  
Ratings and trends allow you to view graphical indicators of sales performance in your item and customer lists. 
Returns are subtracted from sales to calculate net sales for this feature. Select a link above to learn more about 
this feature in each area. 
Use this page of company preferences to turn on/off the rating and trend feature for each area and specify the 
value and time periods on which rankings are based. 

Note: In a networked, multi-workstation configuration, this preference can be set by the Server Workstation only. 

  

Preference Function 

Show ratings and 
trends for items 

 Select if you want rating and trend 
information calculated for inventory 
items. 
Based on: Choose a value on which 
rankings are based. Choices are Profit, 
Quantity (net sales), or Total Sales (net 
dollars). 
Time: Choose the number of days in 
sales history that should be used for 
calculations. Maximum is 999. 

Show ratings for  Select if you want sales rating 
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customers (Basic) information calculated for customers. 
Based on: Choose a value on which 
rankings are based. Choices are Profit or 
Total Sales (net dollars). 
Time: Choose the number of days in 
sales history that should be used for 
calculations. Maximum is 999. 

  
Company preferences overview 

Company Preferences: Integrated Applications 
Preference Instructions 
  
This page lists third-party applications that have previously been granted access to your Point of Sale company 
data. 

To remove an application (which blocks further access to your data): 
1. Highlight the application in the list. 
2. Select Remove. 
3. Select Yes in the confirmation dialog. 

Learn more about integrated applications 
  

Notes: 
• Integration with QuickBooks financial software does not show up in this list and cannot be removed here. 

• If you require employee logins, you can block an employee's ability to log in to Point of Sale from an 
integrated application. Clear the security right checkbox labeled Log in from an integrated application (in 
the General area) for the employees you wish to block. 

Workstation Preferences 

Workstation Preferences Overview 
Preference Instructions | Company Preferences 
  
Workstation preferences define workstation-specific settings and options, including Point of Sale hardware, printing 
options, and automatic program updates. 
Use company preferences to define settings and options that are shared by all workstations on a network. 

Choose a workstation preference area for more information: 
General: Set automatic logout, appearance, and inventory reminders preferences. 
Software Updates: Set options for automatically updating the Point of Sale program files on this workstation. 
Hardware: Individual pages to configure your Point of Sale hardware. 
Available Printers: View and/or add printers used with Point of Sale. 
Documents & Printers: Specify the printer, template, and number of copies for each printed document type. 
Print Options: Specify general print options. 

Workstation Preference Instructions 
Workstation Preference Overview | Company Preferences 
  
Use workstation preferences to set up hardware, print options, and general program options that apply only to this 
workstation. Each workstation sets their own workstation preferences. 
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Changes in some preference settings require you to close all or related windows before saving. Point of Sale will 
prompt you and give you an opportunity to switch to open windows to save or cancel transactions in progress if 
necessary. 

To configure workstation preferences: 
1. From the File menu at the home page, select Preferences  Workstation. 
2. From the list on the left, select the page of preferences you wish to edit. 
3. Edit preference settings as needed. 
4. Select Save. 

  

Notes: 
• Select Cancel to leave preferences without saving any changes. 

• Two powerful options are available from the I Want To menu:  Undo Changes to discard all changes since 
your last save, but remain in preferences, and Reset to Default Setting to revert all workstation preferences 
to their default values. Be aware that these choices affect all workstation preferences, not just the page you 
are currently viewing. 

Workstation Preferences: General 
Preference Instructions | Company Preferences 
  

Preference Function 

Workstation 
Number 

Enter a workstation number from 1 - 10. Each 
workstation in a store must have a unique 
number. 

Security: 
Automatic 
Logout 

Select  to automatically log out a user after a 
specified period of inactivity. 
Define the amount of time, in minutes, after 
which users will be automatically logged out. 
Default: 15 minutes 
Note: Setting applies only if employee logins 
are required. 

Appearance Select Reset Now to reset Point of Sale 
layouts to the default appearance. Any 
customizations made to column order, size, 
etc., will be lost. 

  
Related Topics 
Employees & security overview 
Workstation preferences overview 

Set Up a Cash Drawer 
Preference Instructions | Compatible Cash Drawers 
  

This information applies to the Cash Drawer page of workstation preferences. 

  
A cash drawer must be connected through a 40-column receipt printer. Your receipt printer must be installed and 
working for the cash drawer to function. If you need to add your receipt printer or cash drawer, select the Hardware 
Setup Wizard button at the bottom of this window and follow the instructions. 

To change your cash drawer setup on this page: 
1. From the first drop-down list, select your receipt printer model. 
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2. In the second drop-down list, select the cash drawer connection that matches your receipt printer. 
3. Select Open Cash Drawer to confirm that your cash drawer opens properly. 
4. Select OK or Save. 

  
Related Topics 
Cash drawer troubleshooting 
Receipt printer troubleshooting 
Installing the VALU-u Line cash drawer 
Installing the M-S dash drawer 
List of compatible cash drawers 

Set Up a Modem 
Preference Instructions | Merchant and Gift Card Service Setup 
  

This information applies to the Modem page of workstation preferences. To access this page, select Preferences > Workstation 
from the File menu and then select Modem on the left-side menu. 

  
Setting up a modem in Point of Sale is necessary if you are connecting via a dial-up connection (phone line) to the 
QuickBooks POS Merchant or Gift Card Service. 

• Select your modem from the drop-down list of installed modems. 

• If your modem is not listed, select Add Modem and follow the Windows prompts to install your modem. 

Dialing a Number to Access an Outside Line 
If you need to dial 9 or another number to access an outside line, you must enter that number in your modem’s 
dialing properties. Instructions are provided below; window names and paths may vary slightly for different versions 
of Windows. 

To change modem dialing properties: 
1. Select the Add Modem button on the Modem Setup window as described above. 

Alternatively, you can access this setting from the Windows Control Panel. 
Windows 2000: Select Start  Settings  Control Panel and then double-click the Phone and Modem 
Options. 
Windows XP: Select Start  Control Panel and then double-click Phone and Modem Properties. (Note: If 
you use Category View in Control Panel, you will have to select Printers and Other Hardware before you can 
select Phone and Modem Properties.) 
Windows Vista: Select Start  Control Panel, switch to regular view, and then double-click Phone and 
Modem Properties. 

2. On the window displayed, enter the number to be dialed for accessing an outside line. Make other 
changes to the dialing properties if needed. 

Note: Depending on your version of Windows you may have to first choose the Dialing Rules tab on the 
window, select your location and then choose Edit to make these changes. 

3. Select OK twice to apply the changes. 
4. Restart your computer. 

The first time you process a card transaction, you may be asked to select an installed modem. Specify your modem 
and select OK. 
  

Notes: 
• After installing a new modem, you must restart your computer before using the modem in Point of Sale. 

• Consult your computer/modem documentation if you need additional information about configuring your 
specific modem. 
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Related Topics 
Communication setup for Merchant or Gift Card Service 
Workstation preferences instructions 
Store Exchange overview (Pro) 

Set Up a Bar Code Scanner 
Preference Instructions | FAQs 
  

This information applies to the Bar Code Scanner page of workstation preferences. 

  
If you have a bar code scanner attached to this workstation, select the checkbox on this preference page. 
Select Test Bar Code Scanner at the bottom of the page to confirm the scanner is working. 
  
Related Topics 
List of compatible bar code scanners 
Install Bar Code Scanner 
  

Set Up a Card Reader (MSR) 
Preference Instructions | Compatible Card Readers 
  

This information applies to the Card Reader (MSR) page of workstation preferences. 

  
It is recommended that you use the Hardware Setup Wizard to configure your Point of Sale hardware. You can 
access the setup wizard from the File menu and from individual hardware preferences pages. 
Select your installed card reader (MSR) from the drop-down list, then select the test button to check its operation. 
  
Related Topics 
Installing the Magtek 21040110 MSR USB card reader 
Installing the ID Innovations MSR USB card reader 
Installing the ID Innovations MSR PS2 card reader 

Set Up a Pole Display 
Preference Instructions | Compatible Pole Displays 
  

This information applies to the Pole Display page of workstation preferences. 

  
It is strongly recommended that you use the Hardware Setup Wizard to configure your Point of Sale hardware. You 
can access the setup wizard from the File menu and from individual hardware preferences pages. 
  

1. Select your pole display model from the drop-down list. 
In the Connected to field, select the port the pole display is connected to (a serial port, which is also called a 
COM port, or a USB port). 

2. In the Message Displayed Between Sales area, enter text in Line 1 and/or Line 2 and select an 
alignment option from the drop-down lists. The display will accommodate up to 20 fixed characters per line 
or 50 scrolling characters if you select Scroll in the Alignment field. 
3. Select an option for the Message Displayed During Sales. Your choice is reflected in the 
Example window. 
4. Use the test button at the bottom of the page to verify the operation of the device. 
5. Select Save. 

http://support.quickbooks.intuit.com/opencms/sites/default/IPH/POS/POSv6_Basic/qbpos_equipment/equipment_install_barcodescanner.htm
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Notes: 
• If you are using a serial connection and the pole display does not display information after this 
procedure, re-enter Workstation preferences and try a different port connection, e.g. if you initially 
selected COM 1, change the setting to COM 2 and test again. Repeat this procedure until the pole display 
functions correctly (or use this procedure to verify the port assigned in Windows Device Manager and 
then select the matching port in workstation preferences). 

• If you are using a serial connection and you have an internal modem, the modem may be 
assigned to one of your serial ports, causing a conflict if the pole display is plugged into the same port. If 
your pole display still does not work, try plugging the pole display into another serial port. Repeat the 
steps above until you have identified the right combination of physical port and serial port setting that 
results in the pole display working. 

Related Topics 
Troubleshooting your pole display 

Set Up a Touchscreen Monitor 
Preference Instructions | Using a Touchscreen | Compatible Touchcreens 
  

This information applies to the Touchscreen Monitor page of workstation preferences. 

  
It is strongly recommended that you use the Hardware Setup Wizard to configure your Point of Sale hardware. You 
can access the setup wizard from the File menu and from individual hardware preferences pages. 
  
 = Select to enable the use of a touchscreen in Point of Sale. 
When this option is selected, the touchscreen navigation toolbar and controls are displayed in the customer-facing 
areas of Point of Sale, such as sales receipts. 
You must have a touchscreen monitor connected to your computer for this feature to work. 

Set Up a Physical Inventory Scanner 
Preference Instructions | Compatible Physical Inventory Scanners 

Basic  

This information applies to the Physical Inventory Scanner page of workstation preferences. 

  
It is strongly recommended that you use the Hardware Setup Wizard to configure your Point of Sale hardware. You 
can access the setup wizard from the File menu and from individual hardware preferences pages. 
This procedure assumes you have followed the instructions to install your physical inventory scanner to this 
workstation and have assigned a Windows COM port. 

1. Select your scanner model from the drop-down list. 
2. Select the COM Port number that matches the COM Port you assigned in Windows when 
installing the scanner. 
3. Use the Test button at the bottom of the page to verify operation of the scanner. 
4. Select Save. 

  
Related Topics 
Using the scanner for a Physical Inventory 
Hardware troubleshooter 

Set Up a PIN Pad 
Preference Instructions | Compatible PIN Pads 
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This information applies to the PIN pads page of workstation preferences. 

  
It is strongly recommended that you use the Hardware Setup Wizard to add and configure your Point of Sale 
hardware. You can access the setup wizard from the File menu and from individual hardware preferences pages. 
  
This procedure assumes you have used the instructions to install your PIN pad to this computer. 

1. Select your PIN pad model from the drop-down list. 
2. Use the test button at the bottom of the window to verify operation of the device. 
3. Select Save. 

  
Related Topics 
Hardware requirements for Merchant Services 
Taking payment by debit/ATM card 
Configuring Merchant Services 

Available Printers/Add Printer 
Preference Instructions | Compatible Printers 
  

This information applies to the Available Printers page of workstation preferences. 

  
This workstation preference page lists the printers currently installed on this workstation. 
Check the list to see if your printer is installed. If not, select the Hardware Setup Wizard button to install it now. 
Follow the wizard prompts to complete the installation. 
If you purchased your printer from Intuit (i.e. a supported printer), follow any instructions included with the printer or 
select from the installation instructions below. 
  

Select a link for more information about installing supported printers: 
Citizen CT-S300 Receipt Printer (USB) 
Star TSP100/TSP600 receipt printer (USB) 
Star TSP600 receipt printer (parallel) 
Zebra LP2824 tag printer (USB) 
Zebra LP2824 tag printer (parallel) 
  
Related Topics 
Print option preferences 
General printing instructions 
Troubleshooting printing 
Setting up an Inkjet or laser printer 

Workstation Preferences: Documents and Printers 
Preference Instructions | Printing FAQs | Company Preferences 
  
Use the Documents & Printers page of workstation preferences to specify the default printer, print template and 
number of copies to print for each document type in Point of Sale. Set these options at each workstation that will 
print from within Point of Sale. 

Printer: Select from the drop-down list of available printers. 
Template: Select from a list of available templates to be used when printing the document type. The template 
determines the print layout of fields for a particular document type and printer. Point of Sale includes several 
template choices for each document type for use with various printers and for various needs. 
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Copies: Enter the number of copies to print each time the document type is printed. 
Highlight a document line and select Preview or Print Test Page to view or test that the printer/template 
combination results in the desired output. If you need to add or configure a printer, select the Hardware Setup 
Wizard button. 
If you also specify to display the Print dialog on the Print Options page, you can change these settings at the time 
of printing. 
  
Shipping Manager Label Printer (Pro) 
If you use Shipping Manager, select Shipping Manager Setup to open this application and set up a printer for your 
shipping labels. 
  
Related Topics 
General printing instructions 
Customizing print templates (Pro) 
Workstation preferences overview 

Workstation Preferences: Print Options 
Preference Instructions | Compatible Printers | Printing FAQs 
  
Additional Printing Preferences 

Preference Function 

Prompt for gift 
receipt with each 
sale 

 =Select to be prompted to print a gift 
receipt for each sale (with the item, price, 
and payment information excluded). 

Prompt to e-mail 
receipt with each 
sale 

 =Select to be prompted to e-mail sales 
receipts to your customers, the prompt 
message also affords an opportunity to 
capture an e-mail address if you don't 
already have it. 

Pause between 
printing to allow 
tearing off of 
printed receipt 

 = The printer will pause briefly before 
printing the second copy of a receipt. This 
pause gives users time to tear off the first 
copy. This option is for users with printers 
that do not automatically cut off each 
receipt. 

Print two copies 
of credit card 
receipts 

 = Automatically print two copies of all 
sales receipts that are paid for by credit 
card. If using two-ply receipt paper, you 
may disable this option. 

Print two copies 
of receipts 
tendered by 
account charge 

 = Automatically print two copies of all 
sales receipts that are paid for by charge to 
customer account. If using two-ply receipt 
paper, you may disable this option. 

Display Print 
Options dialog 
when printing 

Select the documents for which you wish to 
display a dialog allowing you to change 
print settings or to display a preview before 
printing. 
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Help and Learning 

Help and Support Overview 
For assistance with learning and using Point of Sale, select from the following resources: 
  
Getting Started 

User Guide (PDF) 

Setup Interview 

Hardware Setup Wizard 

Point of Sale terminology (glossary) 

  

Getting Help When You Need It 

Use the in-program Help system 

Troubleshooting FAQs 

Support Resources 

Find a local expert 

Purchase Point of Sale supplies 

Starting and growing your business 

  

Point of Sale Licensing, Registration, and Updates 

About Point of Sale licensing 

Register your software 

Merge license numbers 

Manage or buy an additional license 

Keep your software up to date 

Feature comparison by level: (Free, Basic, Pro) 

Important Information about Windows Vista 

Unlock to a higher level of features 

 
Use the Point of Sale Help System 

Free Online Support | Help & Support Resources | Find a Local Expert 

For assistance with your current task, do one of the following: 

• Press <F1> from any Point of Sale window. 

• Select the Help button or a blue text link on a window, dialog, or message. What do the icons by some 
links mean?   

• Select Help on this Window from the Help drop-down menu at the top of the screen. 

• The Help menu at the top of the Point of Sale screen offers access to additional resources:  

•  

o Help Contents – Opens the help window, with a table of contents, index, and search features. 
 Learn more. 

http://www.quickbooks.com/support


Printed Documentation 

600 

o Keyboard Shortcuts - to view a list of shortcuts applicable to your current task or window. 
o Hardware Troubleshooter – To help diagnose and correct problems with your hardware. 
o User Guides – to view electronic versions of the Point of Sale manuals (requires Adobe Acrobat 
Reader). 
o Help & Support – A summary of in-program and online help & support resources. 

o Point of Sale User Community – Connect with other Point of Sale users and experts to ask 
questions and share advice. Go to the User Community now. 
o Manage My License – Sync your license with Intuit or buy additional licenses.  Learn more. 
o About QBPOS – View your current version/release and license information, as well as program 
copyright and trademark information. 

•   
The Point of Sale main help window: 

 

License Level Identification 
When the feature to which a help topic applies is restricted by your licensing level, you will see the license level 
identification in the upper-right corner of the topic: 

Basic - available to Basic and Pro levels. 
Basic Only - Available to Basic level only. Typically this means Pro level users have a more advanced feature 
to accomplish the same task. 
Pro - Available to Pro level only (including Pro with multiple stores). 
Pro Multiple Stores - Available only to Pro users with two or more stores using Point of Sale. 

  
Click here to learn about finding topic within the help system. 
  

Point of Sale User Guides 
Help and Support Overview 
  
Click a link below to view an electronic version of the Point of Sale user guides in PDF format. How do I view PDF 
files?   
  
User Guide - Installation and configuration instructions 
Implementation Guide: Payment Card Industry Data Security Standard - Information about implementing Point of 
Sale as part of an overall system that complies with industry standards to protect the card information of your credit 
and debit card customers 
  

Additional online resources (Internet connection required): 
Point of Sale User Community - Connect with other Point of Sale users and experts to ask questions and share 
advice. 

http://www.qbinproduct.com/community/help/pos
http://www.quickbooksgroup.com/
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Point of Sale Support Web Site - Search our Knowledge Base of frequently asked questions, learn about available 
updates, or research other support options. 
  

Point of Sale User Community 
Help & Support Overview | Help & Support Resources 
  
  

The Point of Sale User Community is an online forum for users to share ideas, ask questions, and provide solutions 
to one another. 
Click the picture above to launch your Web browser and connect to the User Community. 

Who answers the questions posted to the Point of Sale User Community? 

Point of Sale users provide answers to each other's questions. This is a thriving community of novice through 
expert users eager to answer questions, share tips and advice, and act as peer support. Community hosts (also 
referred to as Moderators) monitor the discussions for directional and navigational assistance. 
To visit the QuickBooks Point of Sale community, click here.  

Find a Local QuickBooks Point of Sale Expert 
Help & Support Overview | Help & Support Resources 
  
This topic content provided by the ProAdvisor and RSP teams. Do not edit without review and approval by them. 

Looking for a QuickBooks Point of Sale expert in your area? 
Get on-site assistance from a local expert who can help you set up, customize, and learn your Point of Sale 
software. Choose from Certified QuickBooks Point of Sale ProAdvisors or Retail Solution Providers, both have 
been tested and certified on Point of Sale by Intuit. 

Note: Fees apply and are set by the expert. QuickBooks Point of Sale ProAdvisors have also been certified in QuickBooks 
Financial Software. 

  

Certified QuickBooks Point of Sale ProAdvisors 
Provide accounting advice tailored to your business needs. 

Visit: www.FindAProAdvisor.com 
  

Certified Point of Sale Retail Solution Providers 
Your local retail business and technology experts that can help you with any retail technology questions. 

Visit: www.quickbooksgroup.com/pos_form.html 
  

Order Supplies 
Help and Support Overview | Print Tags 
  
Tags, labels, and receipt paper for Point of Sale can be ordered directly from Intuit. 
Six types of tags/labels are supported with Point of Sale: two that work with standard laser/inkjet printers, and four 
that work with the Zebra LP2824 thermal tag printer. 

Point of Sale tags/labels compatible with laser/inkjet printers: 
Labels 1" x 2-5/8" (30 tags per sheet, 3 across) 
Labels 1/2" x 1-3/4" (80 tags per sheet, 4 across) 

http://www.quickbooks.com/support
http://community.intuit.com/category/quickbooks-point-of-sale
http://www.findaproadvisor.com/POSIPH
http://www.quickbooksgroup.com/pos_form.html
http://www.qbinproduct.com/community/help/pos�
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Point of Sale tags/labels compatible with the Zebra LP2824 or compatible tag printers: 
Hang Tags 2.25" x 1.35" 
Price Labels, roll, adhesive 2.25" x 1.25" 
Small Labels, roll, adhesive 1.2" x 0.85" 
Jewelry Tags with Flaps 
Jewelry Tags without Flaps 
  

Receipt Paper 
Designed to work perfectly with the Intuit-sold and supported Point of Sale receipt printers. Available in 10 or 50 roll 
packs. Each roll measures 3.15 inches wide and 220 feet long. 
  

Ordering 
These tags, labels, and receipt paper are available directly from Intuit. To order, please call 1-800-926-6066 or visit 
our web site. Offerings subject to change without notice. 
  
Related Topics 
Basic printing instructions 
Compatible Tag Printers 

Glossary of Terms 

 

 
Click a letter to jump to that section of the glossary. 
  

A 
Activity tolerance: Some Point of Sale activities are intolerant. This means that the activity cannot be completed if 
you or another workstation are currently accessing the POS data file via another open window or document. For 
example, installing a program update, editing company preferences, or restoring from a backup are all intolerant 
activities. An alert message is displayed if this applies to your activity. The alert message could also be caused by 
an improper shutdown of the program (such as if power is lost). 
Adjustment memo: A transactional document that provides a permanent record of changes to an item’s quantity 
or cost which were not recorded on another type of transactional document. 
Address Verification Service (AVS): Service that verifies a credit card customer's stated Zip Code, and optionally 
street address, matches that on file at the issuing bank. Helps prevent credit card fraud on manually entered and 
"card-not-present" transactions. For use with the QuickBooks POS Merchant Service. 
Alphanumeric: Containing both letters and numbers. 
Alternate Lookup (ALU): A descriptive inventory field used as an additional item identifier when listing items on 
documents. 
Alternate vendor: (Pro) Secondary vendor(s) that can be listed on POs and vouchers when purchasing an item. 
Each alternate vendor can have a unique order cost, UPC, and Alternate Lookup assigned. See also primary 
vendor. 
Assembly: (Pro) Inventory item pre-built, or assembled, from other existing inventory items and sold as a unit. 
Associate: (Pro) An employee whose name is available for selection on transactional documents. 
Attribute: Typically an item’s color or a second size, such as shoe width. 
Automatic update: Automatic process of downloading program updates in the background while you work in Point 
of Sale. 
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Automatic discount: (Pro) Discount defined in Price Manager, with options for eligible items, schedule, and 
purchase requirements, and automatically applied to eligible sales. 
Available quantity: (Pro) Item quantity available for immediate sale. Equal to the on-hand quantity minus any 
quantity already committed on active customer orders. Does not take into consideration quantities on pending 
customer orders or held documents. 
Average unit cost: The average amount paid per unit for the on-hand quantity of an item. Different than order 
cost, which is the current cost at which you order and receive an item. 
AVS: see Address Verification Service. 
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B 
Backordered: In Point of Sale, any item with a negative available quantity (i.e. quantity on active customer orders 
exceeds on-hand quantity) is considered to be on backorder and will show up on your reorder reminders and 
backorder report. 
Backup: A manual or automated procedure that verifies the integrity of Point of Sale data files and makes a 
backup copy. See also restore. 
Bar code: A series of spaced lines forming a code that can be read and interpreted by a bar code scanner for rapid 
data entry. Bar codes typically are encoded item numbers or UPC codes. 
Base unit: (Pro) When using multiple units of measure for an item, that unit you most typically stock and sell by. 
Item quantities, costs, and related information are shown in inventory for your base unit. 

  

C 
Card Verification Code (CVC): A three or four-digit code printed on a credit card used in manually entered credit 
card transactions to help verify that the customer actually has the card in their possession. Can help prevent credit 
card fraud and chargebacks. For use with the QuickBooks POS Merchant Service. 
Case-sensitive: With regard to text entry, the requirement that uppercase letters be distinguished from lowercase 
letters. Login passwords in Point of Sale are case-sensitive. A password must be entered exactly as it is recorded. 
Example: If password stored is "Huckleberry" then entering "huckleberry" does not grant access. 
Card reader: A device that reads the magnetic strip on the back of credit, debit, and gift cards, allowing information 
about the customer and his account to be electronically entered for payment on a sale or refund. 
Cashier: The employee who is logged in during the current sales transaction (receipts and customer orders). 
Cell: (Pro) In a grid (e.g., a style grid), the point where a column and row intersect. Each cell represents a particular 
item size/attribute and corresponds to an item in inventory. See also grid. 
Certificate: A QuickBooks term related to integrated applications and their access to your QuickBooks company 
file. A certificate is a digital signature that verifies the identity of the third-party developer. Refer to your QuickBooks 
financial software documentation for more information. 
Chargebacks: For a credit card transaction, a chargeback is a dispute of the charge by the cardholder. 
Chart of Accounts: In your QuickBooks financial software, the set of accounts and their balances. Some accounts 
are predefined by QuickBooks when a company is set up; others can be added as needed. Point of Sale assumes 
you are using a default set of accounts when transferring your Point of Sale data, but you can define custom 
account mappings if preferred. Search the Point of Sale help index using keyword "Cart of accounts" or refer to 
your QuickBooks financial software documentation for more information. 
Class: A transaction categorizing attribute in QuickBooks that when assigned to stores in a multi-store 
configuration allows you to track and run P/L reports by store in your QuickBooks financial software. 
Clean Up Company Data: Procedure by which you can remove old records and documents from your company 
file to optimize program performance. Access from the File > Utilities menu. 
Client Workstation: Any networked workstation that is not designated as the Server Workstation. Accesses the 
Point of Sale company data on the Server Workstation across the network. You can view your current workstation 
type by selecting About Point of Sale from the Help menu. 
Cloud: Cloud computing is a general term for services that are offered on the Web including social networking, file 
backup, and payment solutions. To use most Cloud services, the only requirement is access to the Internet.  
Commission: (Pro) An amount paid to an employee on sales of specified items. 
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Committed quantities: (Pro) Quantities promised on active customer orders. When the committed quantity for an 
item is subtracted from the current on-hand quantity, the resulting value is your available quantity. 
Company data: The Point of Sale data file that is stored on the Server Workstation. In a multi-workstation setup, 
client workstations access this data across the network. Do not confuse the POS company data with your 
QuickBooks financial company file, which is used for accounting purposes. 
Company preferences: Company preferences define settings and options that are shared by all workstations on a 
network and that configure all Point of Sale modules. 
Compatible hardware: Compatible hardware is hardware that has been tested to work with Point of Sale. 
Supported hardware is compatible hardware that is sold and supported by Intuit. Compatible hardware not sold by 
Intuit is not supported. 
Component items: (Pro) The inventory items that make up an assembly or group item. 
Conflicting items: (Pro) Two or more inventory rows in the same style with the same size and attribute. 
Coupon: (Pro) Store discount document provided to customers who can redeem it to get the specified discount. 
Defined in Price Manager, including eligible items and expiration date, and automatically applied to qualified sales 
when scanned on receipt. 
Cost: See average unit cost or order cost. 
Customer order: (Pro) A sales order, work order, or layaway that records the planned sale of merchandise or 
services. Items ordered on a customer order are later sold on a sales receipt. 
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D 
Database Server applications: Applications that run on the Server Workstation and allow Point of Sale 
workstations to connect to the POS company data. Started automatically when the Server Workstation is turned on. 
If you have used Windows Task Manager to manually stop these applications, they can be restarted by restarting 
Point of Sale on the Server Workstation. 
Debit/ATM transaction (PIN): Transaction using a customer’s debit/ATM card and PIN authorization. 
Department: A manageable category of related merchandise. Categorizing items into departments gives you 
greater flexibility to monitor sales performance, manage inventory, run meaningful reports, and for filtering your 
item list when conducting a physical inventory, changing prices, and printing tags. Departments are assigned a 
name and a code. A department code is a user-assigned code identifying the department, made up of one to three 
alphanumeric characters, and can be used to identify the department on reports and program screens where space 
is limited. 
Descriptive field: Any field that describes an item, such as the default item fields Description1, Description 2, 
Attribute, Size, and Alternate Lookup. 
Device Manager: Applet in Windows Control Panel  System Properties dialog that lists the hardware installed on 
your computer and used to change the settings for that hardware. You can access System Properties by selecting 
System from Control Panel (or press the Windows logo key + the Pause/Break key on your keyboard at the same 
time). Then select the Device Manager tab (Windows 98) or the Hardware tab and then Device Manager 
(Windows 2000/XP). Note: The Windows logo key is located on the lower-left of your keyboard and Pause/Break 
on the upper-right. Consult your Windows Help system if additional assistance is required. 
Discount Pricing: (Pro) Price Manager feature that allows you to define percentage off or quantity discounts for an 
item or group of items, optionally scheduling the discount dates. When listing a sufficient quantity of included items 
on a sales receipt or customer order, Point of Sale automatically applies the correct discount price to each item. 
Examples: Buy 3 T-shirts for $30. Buy 3 T-shirts and get 15% off.  Get 15% off all T-shirts. 
Document item list: The list of items being processed on a document. 
Documents: General term including all transactional documents and order documents; including sales receipts, 
receiving vouchers, adjustment memos, purchase orders, layaways/sales orders/work orders, and transfer slips. 
Dynamic date: A date or date range relative to the current date. Examples include Year-to-Date, Month-to-Date, 
etc. As the current date changes, so does the dynamic date or range. Dynamic dates are used to define date 
ranges for filtering lists and for reporting purposes. 
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Element: (Pro) In Print Designer, an element is any object (data field, data field group, static text, logo, etc.) that 
you can add or manipulate on a print design. 
  

F 
Facebook: The leading social networking site. There are marketing opportunities for merchants that use Facebook. 
Fee: (PO/Voucher) A field on purchase orders and vouchers used to record amounts that are charged in addition to 
the cost of goods, shipping, and tax, such as an order fee. 
Field: A component of a page design where data can be entered or viewed. In lists and Style View, a field is the 
cell where a column and row intersect. Field names are included in the header for each column and row. 
Fill status: A summary of the quantity still due on an order document. Different than the order status, which tracks 
the current standing of the document as open, closed, or any custom status you have defined. 

% Unfilled = Qty due divided by Qty ordered multiplied by 100 
Filters: Used to include/exclude records for display or reports. You define your filter criteria and Point of Sale 
includes/excludes records based on your criteria. 
Filter element: A component of a filter screen. Element names identify the criteria to be entered in each field. 
Financial Exchange: Integration and sharing of data between Point of Sale and your QuickBooks financial 
software. 
Form: A detailed view that displays all fields of data contained in a single record. 
Foursquare: One of many location-based social networking sites for mobile devices, that helps locate venues and 
events close to a customer's current location. Used as a marketing tool by many small and large companies alike . 
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G 
Gift receipt: Optional second copy of a receipt printed for the customer. Gift receipts do not include prices or 
payment information. Enabled in workstation print option preferences. 
Global discount: A discount applied to the subtotal on a document. See also item discount. 
GoPayment: An Intuit service allowing credit card payments to be accepted via a mobile phone. 
GoPayment card reader: A small device that is temporarily attached to a mobile phone in order for a credit card to 
be swiped.  
Also referred to as a swiper. 
Grid: (Pro) A concise format used to display style items in Style View in inventory. Includes both a horizontal and 
vertical axis, with different descriptive fields located on each. See also cell. 
Group (security): A set of users that are granted specific security rights and access to program functions. 
Group (item): (Pro) An item group provides a way to list all of the included items on a document by entering the 
single group item identifier. 
Groupon: An online marketing site featuring discounted gift certificates and coupons usable at local or national 
retail outlets.  
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H 
Headquarters: Store 1 in a multi-store installation; has centralized control over inventory and purchasing, 
exchanges information with QuickBooks, and runs company reports. 
History documents: Saved transactional documents stored in document history lists. Includes receipts, 
vouchers,adjustment memos, and transfer slips. Used for reporting purposes and for building customer, vendor and 
item histories. 
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Integrated applications: A QuickBooks feature that allows external applications such as Point of Sale to access 
the company file and exchange data. Refer to your QuickBooks financial software documentation for more 
information. 
Intuit Service: Method of exchanging data between stores using the Internet application "QuickBase". 
Inventory: A store’s or company’s set of merchandise, quantities, and other related information. Also, the Point of 
Sale module for tracking that merchandise. 
Inventory reminders: A Point of Sale feature that alerts users when inventory tasks need their attention, such as 
reordering items. 
Item #: The number assigned by the program to each item added to inventory. Corresponds to the row number in 
the item list and used as an item identifier (for listing items on documents), for filtering the list, and for printing bar 
codes on tags. 
Item discount: A discount applied to an individual item price on a sales document. See also global discount. 
Item group: (Pro) See group item. 
Item identifiers: The Item #, Universal Product Code (UPC), and Alternate Lookup values for items in inventory. 
Item identifiers are used for looking up and listing items on documents, and for other program functions. 
Item lookup: A method that is used to list an item on a document. Item lookups can be performed with the Item #, 
UPC #, Alternate Lookup, or by entering a search keyword. 
Item type: Field used to designate the type of inventory item. 
I Want To menu: List of available actions or tasks related to the currently displayed window. Select a task to carry 
out the specified action. Displayed on the window toolbar. 
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J 
K 

L 
Layaway: (Pro) A temporary order document that allows customers to pay for merchandise using a series of 
deposits. 
List: Displays all or a filtered subset of the records of a particular type, or a listing of the items to be processed on a 
document. 
Lookup: Ability to quickly locate a related record from another area or document and enter that information in the 
other area or document. For an example, see item lookup. 
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M 
Main tool bar: The horizontal tool bar located across the top of the Point of Sale screen, providing direct access to 
program areas and tasks. You can customize or turn off its display from the View menu. 
Manual discount: An item discount that is manually applied as needed at the time of sale. Uses include discounts 
for damaged or demo merchandise or a discount to meet or beat  a competitor's price. 
Mapping: In Point of Sale, refers to the "linking" of accounts, payment types, and information fields with your 
QuickBooks financial software. This linking affects how Point of Sale data is transferred to your financial software. 
Point of Sale uses a default set of accounts and payment types unless you customize them in company 
preferences. 
Margin %:  The percentage of the selling price that represents profit. One way to express the relationship between 
item cost and price. Margin can be used in Point of Sale’s pricing formula to calculate prices when adding new 
items to inventory. 

Margin % = [(Price minus Cost) divided by Price] multiplied by 100 
Markup: Alternate way to express profit; markup by n% over cost. 
Memo: See adjustment memo. 
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Merchant number: For retailers who use the QuickBooks POS Merchant Service to perform credit and/or 
debit/ATM card transactions, the merchant number is assigned to the retailer in order to identify that retailer when 
performing authorizations and settlements. 
Merchant Service Center: Intuit’s own site to help merchants manage their payment solutions. 
Mobile Sales:  Sales that are performed when a customer makes the purchase from their mobile device.  
Mobile Device:  A ‘smart’ phone or other device that is generally small and connected to the Internet. iPhones and 
Android-based phones are two types of mobile devices.  
MSRP: Manufacturer’s suggested retail price. IF the MSRP is defined on an item’s record, price tags (space 
allowing) include the reference price to demonstrate savings to customers. 
Multi-Store: (Pro) Referring to a Point of Sale Pro configuration with multiple stores. 
Multi-vendor: (Pro) Feature that allows purchasing of an item from up to five different vendors, each with a unique 
order cost and UPC. 
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N 
Navigator: Graphical representation of a retail workflow and corresponding Point of Sale tasks. Clicking an icon 
from the Navigator takes you directly to the program area to complete the task. 
Network: Two or more computers linked together and sharing data files. Information recorded by any computer on 
the network is instantly available to all users on the network. 
Non-inventory item: A non-merchandise inventory item or service for which you do not track on-hand quantities. 
Typically, the non-inventory item type is used for miscellaneous fees or charges (e.g. delivery, recycling fee, 
shipping, etc.). See also service item. 
Non-tolerant activity: An activity that requires all other users to be out of Point of Sale before it can be performed, 
such as restoring the POS company data from a backup or installing a program update. 
  

Return to top 

O 
Order document: (Basic, Pro) A temporary document used to plan the purchase (purchase order) or sale 
(customer order) of merchandise or services. 
Order cost: The cost at which an item is ordered and received. This is different than average unit cost, which is the 
average cost paid for the units currently on hand. 
Open Windows: List of all open Point of Sale windows for current tasks; displayed on the Window menu at the top 
of the screen. While only one window can be viewed at a time, Point of Sale allows you to open and have many 
available. You can think of the windows being on top of another. You can immediately switch to another open 
window by selecting it from the Window menu. 

  

P 
Payout: The removal of cash amounts from the cash drawer for a store-related purpose, such as to make a mid-
day deposit, buy office supplies, or fund an office party. Select New Payout from the Point of Sale menu to access 
this feature. 
Payment History: (Pro) A record of payments/deposits made for a particular layaway, sales order, or work order. 
Payment type/method: On a receipt, how the customer pays for merchandise. Examples: cash, check, credit card, 
gift certificate, etc. 
PCI DSS: Payment Card Industry Data Security Standard; outlines requirements for the protection of customers' 
credit and debit card information. 
Physical inventory (PI): The process of counting the actual merchandise on hand and then correcting the 
quantities recorded in inventory as needed. 
Physical inventory scanner: Optional, portable hardware that allows you to scan inventory bar codes and 
download the scanned data into a physical inventory count. 
PO: See purchase order. 
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Point of Sale (POS): This software product name and the location(s) in your store where customer-facing sales 
activities are carried out. On menus in Point of Sale, this term refers to the area containing the sales, customer 
order, customer tracking, and End of Day tasks. 
Pole display: A screen oriented towards the customer to display transaction detail and store messages. 
Preferences: Settings that configure your Point of Sale program to work with your hardware and accessories, 
establish feature options, and customize program behavior. There are two types of preferences in Point of Sale: 
company preferences and workstation preferences. 
Price levels: Up to four optional markdown prices, in addition to your regular price, for each item in inventory. 
Different price levels can be used to record employee prices, promotional sale prices, wholesale prices, etc. When 
making a sale, you can select the price level that applies or assign a price level on a customer’s record and it will 
be automatically suggested when making a sale to that customer. 
Price Manager: Price utility that allows you to change item prices or set up discounts, for all or selected items, in a 
variety of ways. 
Price rounding: Price Manager feature that allows rounding of calculated prices to end in user-specified amounts, 
e.g. always to .99, or to even dollars, etc. 
Pricing formula: Used by Point of Sale to automatically calculate a new item’s price by applying a defined 
department margin or markup to the average unit cost. 
Primary vendor: (Pro) For a multi-vendor item, that vendor that is displayed in item lists, on merchandise reports, 
etc. for the item. See also alternate vendor. 
Print Designer: (Pro) Tool used to customize printed documents and tags. Available from the Tools menu. 
Purchase order (PO): A temporary planning document recording the merchandise ordered from a vendor. 
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Q 
QB POS: Abbreviation for the QuickBooks Point of Sale software. 
Quick Add Item: Procedure to add an item to your inventory while creating a document, such as a sales receipt, 
entering only the basic item information needed to complete the document. Ideal for when a customer is waiting to 
purchase an item not yet added to inventory. Learn more. 
QuickFill: Customer feature on sales documents where the program recognizes the name you are typing and 
suggests the matching name from your customer file, saving you the time of typing the full name. 
Quick Find: Feature available from the Navigator allowing you to quickly find customers, items, sales receipts, and 
more. 
Quick Pick: A feature of Intuit Point of Sale where selected items are grouped and instantly accessible on the 
system during the check-out process. 
Quick Zoom: Ability to click a line or value in a report and see the source documents or records contributing to that 
value. 

Return to top 

R 
Receipt: A transactional document that records a sale, deposit on, or return of merchandise at point of sale. Also, 
the printed record of the transaction, typically given to the customer. See sales receipt and return receipt. 
Receiving voucher: A transactional document that provides a permanent record of merchandise received from a 
vendor. Vouchers update inventory cost and quantity for items received. 
Record: (noun) Point of Sale data is typically stored as a sequence of records in your POS company data file. A 
record could be either document (receipt, voucher, etc.) or non-document (item, customer, vendor, etc.) data. 
Reminders: A feature that helps you track and manage your inventory by alerting you to situations that may need 
your attention, such as when item quantities fall below their reorder points. 
Remote store: In a multi-store installation, all stores except the Headquarters is referred to as a remote store. 
Remote Data Sharing (RDS): Optional configuration allowing the exchange of information between Point of Sale 
and QuickBooks financial software wherein the two applications communicate over a network via server and client 
applications. With this configuration it is not necessary to install QuickBooks on the Point of Sale Server 
Workstation. Refer to the Point of Sale Getting Guide for more information on this advanced option. 
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Reorder point: User-specified minimum on-hand quantity at which an item should be reordered (or rebuilt in the 
case of assembly items). When the combined on-order and on-hand quantity is at or below this level, the item is 
added to the inventory reorder reminder list and reorder reports. Facilitates timely replenishment of merchandise. 
Restore: (relating to the Restore feature) Using backup data to replace data files. 
Return receipt: A transactional document that provides a permanent record of a merchandise return at point of 
sale. Printed, it serves as the customer’s receipt. 
Return voucher: A transactional document that provides a permanent record of merchandise returned to a vendor. 
Reverse: To create a new, opposite document that cancels the effects of a former document. Receipts, vouchers, 
transfer slips, and adjustment memos can be reversed. 
Rights: See security rights. 
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S 
Sales order (SO): (Pro) A temporary order document recording the planned sale of merchandise or services to a 
customer in the future, such as for custom items or an item currently out of stock. The items listed on a sales order 
can be quickly transferred to a sales receipt when the final sale is made. 
Sales receipt: A transactional document that provides a permanent record of a merchandise sale or deposit. The 
printed receipt serves as the customer’s receipt. 
Sales tax location: A set of sales tax codes assigned to a specific geographic area or for customers that qualify for 
special tax handling. 
Sales tax code: A code used to identify if and how sales tax is applied to item sales. Sales tax codes in Point of 
Sale can be mapped to sales tax items/groups and codes in your QuickBooks financial software. 
Sales tax item: In QuickBooks financial software, sales tax items identify the rate and the tax agency from which 
you collect sales tax for a transaction. Retailers who use QuickBooks in conjunction with Point of Sale can map a 
sales tax code in Point of Sale to a tax item in QuickBooks. Refer to your QuickBooks financial software 
documentation for more information. 
Sales tax group: In QuickBooks financial software, a sales tax group is used to calculate two or more sales tax 
items grouped together and applied to the same sale. Retailers who use QuickBooks financial software in 
conjunction with Point of Sale can map a sales tax code in Point of Sale to a sales tax group in QuickBooks. Point 
of Sale sales taxes will then be reported in your financial software according to the structure of the QuickBooks tax 
group. Refer to your QuickBooks financial software documentation for more information. 
Sales tax rate: The actual percentage tax collected. Each taxable tax code must have a tax rate assigned. 
Section (Print Designer): (Pro) Logical regions of document templates, each with a unique printing behavior. For 
example, data fields placed in the repeating header section of a template appear at the top of each page of the 
printed document. Some templates, such as tags and mailing labels do not have sections. Template sections 
cannot be re-positioned, though they typically can be vertically resized to add or remove white space in a design. 
Security group: Predefined or custom set of security rights to which employees can be assigned. 
Security rights: The set of program features and data access defined for a security group. 
Serial number: (Pro) Unique alphanumeric string assigned to an item for tracking purposes. Typically used for 
warranty purposes or for meeting legal requirements. Serial numbers can be recorded on most Point of Sale 
documents. 
Server Workstation: In a multiple workstation installation, the first workstation on which QuickBooks Point of Sale 
is installed and which stores the POS company data. If you have only one workstation, it must be installed as a 
Server Workstation. Certain activities, such as Financial Exchange with QuickBooks, creation of company data, 
and importing data can only be done on this workstation. The Server Workstation must be running (but not 
necessarily with Point of Sale open) for client workstations to access the company data file. You can view your 
current workstation type by selecting About Point of Sale from the Help menu. 
Service item: Used to charge for non-merchandise and labor-based services, such as repairs, warranties, delivery, 
installation, etc. on sales and customer orders. The on-hand quantity of service items is always zero (0). 
Shopper display: See pole display. 
Shortcut key: Keyboard command that executes a Point of Sale function. For example, entering <Alt + the 
underlined letter> instantly invokes the menu or icon option displaying the underlined letter. Select Keyboard 
Shortcuts from the Help menu to see a list of shortcuts for your current area in Point of Sale. 
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Simple View: A simplified version of the regular sales receipt form, with support for touchscreen and a virtual 
keyboard. Learn more. 
Slip: (Pro) See transfer slip. 
Smart phone: See Mobile Device. 
SO: (Pro) See sales order. 
Social Networking: The use of the internet to connect with others using sites specifically designed to bring groups 
of people together.  
Facebook and other social networking sites can be leveraged for marketing purposes.  
Sort field: A field/column in a list by which the records can be sorted and displayed. Indicated by the  symbol in 
the column header. Click the header to sort by the column values; click again to change sort order. Sort by multiple 
columns by selecting Sort List  Sort on multiple columns from the View menu. 
Special order item: (Pro) Item-type created while making a document (such as a customer order) to sell an item 
not currently carried in inventory. 
Split-payment sale: A sale paid for using two or more payment methods. 
Status: On order documents, the current standing of the document. A status of Open is assigned to all new orders 
and Closed to those that have been filled (received or sold). You can define your own statuses and Point of Sale 
will track the changes in status as an order progresses toward completion. The Status field can be used to filter for 
list display or reports. 
Status bar: An information line located on the bottom of most Point of Sale screens, displaying data such as the 
active price level, the currently logged in employee, record status, etc. 
Store: A physical location at which you receive and sell merchandise. 
Store Exchange: The procedure of sending and receiving data between remote stores and Headquarters in a 
multi-store installation. QuickBooks POS supports four methods of Store Exchange: desktop e-mail, Web-based e-
mail, removable media, and network file transfer. 
Store type: In a multi-store configuration, each store is either a Headquarters or a remote store, each with defined 
roles and allowed activities. 
Style: (Pro) A group of related inventory items, with the same department and Item Name, but differing in color, 
size, or other attribute. In Point of Sale, the items in a style are linked so they can be viewed and worked with 
together in a style grid or in a linear display. 
Style View/grid: (Pro) See grid. 
Style template: (Pro)  A predefined array of item attributes (sizes, colors, etc.) that can be used when creating or 
modifying a style grid. 
Suggest PO: (Pro) Automated suggestion and generation of purchase orders for items that have fallen below their 
designated reorder quantities, after taking currently on-order quantities into consideration. 
Swipe: To slide a credit or debit card through the GoPayment card reader (or swiper) for processing. 
Swiper: A small device that is temporarily attached to a mobile phone in order for a credit card to be swiped. Also 
referred to as the GoPayment card reader. 
Sync / Syncing / Synchronize: Updating or merging information on two or more computers or devices. For 
example, syncing sales on your mobile device with your main computer is needed in order for your main computer 
to have all the most current sales information from your mobile device(s). 
System Administrator (Sysadmin): Pre-defined user with all security rights to add or delete employees, turn 
on/off the requirement to log in to use the program, and change passwords for other employees. Only the 
Sysadmin user can make these changes. 
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T 
Tax code: A code assigned to each item in inventory that defines the tax handling (such as taxable or non-taxable) 
and taxing instructions of the item. 
Tax location: See sales tax location. 
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Template: The print layout of fields for a particular document type. Point of Sale includes several design choices 
for each document type for use with various printers and for various needs. (Pro) You can customize these 
templates in the Print Designer. See also style template. 
Terms: (PO/Voucher) How and when the retailer plans to pay the vendor for merchandise ordered. Examples: 
COD and 2% 10, Net 30. 
Tools: Program utilities that provide ancillary or support capabilities. 
Transactional documents: Receipts, vouchers, adjustment memos, and transfer slips. Transactional documents 
record changes in inventory on-hand quantities or costs, and are then stored in your document history lists. 
Transfer slip: (Pro) A transactional document that records the movement of merchandise from one store to 
another. 
Tweet: A message sent via Twitter. 
Twitter: With over 100 million users, this is the most popular micro-blogging site. “Tweets”, or messages, are 
condensed to 140 characters or less aimed at a specific target audience of “followers”. Individuals, celebrities, and 
merchants make good use of Twitter to help stay in touch with customers and fans, to communicate news, 
specials, gossip, or deals. 
  
  

Return to top 

U 
Unit of measure: Display field on item records that can be used to filter and sort the item list and reports. ((Pro) If 
using multiple units of measure (company preference), allows purchasing and selling an item in different units, such 
as cases, multi-packs, bottles, pounds, etc., each with a different UPC code, alternate lookup, and price. 
Unlock: Term referring to an upgrade in program licensing that makes additional features available to the user, i.e. 
from Free to Basic to Pro. 
UPC (universal product code): A family of widely used bar code symbologies that encode both manufacturer and 
product identification. In Point of Sale, UPC numbers can be used to look up or scan items when listing them on 
documents. 
User license: A single license or entitlement for a computer to run Point of Sale. Having multiple user licenses 
allows multiple computers to run Point of Sale at the same time. 
Update: In QB POS, update has two possible meanings: 

• When using QuickBooks financial software, update refers to a manually-initiated Financial 
Exchange to share data between Point of Sale and QuickBooks. 

• The process of obtaining and installing updated Point of Sale program files within the same 
version. These updates are used to fix bugs, enhance features, or provide additional information. 

  
Return to top 

V 
Values: Numerical data; such as a field entry or calculation of quantities, costs, or prices. 
Vendor code: The user-defined code assigned to each vendor and used to track that vendor’s merchandise as it is 
received and sold. 
Voucher: A transactional document that records merchandise received from or returned to a vendor. See also 
receiving voucher and return voucher. 
  

Return to top 

W 
Window tool bar: The horizontal toolbar across the top of the open window; contains icons for tasks related to the 
displayed window and a task-specific help button. 
Work Order: (Pro) A customer order used for services and non-inventory merchandise transactions, such as 
repairs, alterations, and warranty work. 
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Workstation (W/S): An individual PC. In Point of Sale, installed workstations (up to ten per store) are either a 
Server Workstation, storing both program and data files, or a client workstation, which stores program files but 
accesses the data files across a network. 
Workstation preferences: Workstation preferences define workstation-specific settings and options, including 
hardware setup and printing preferences. 
  

Return to top 

X 
X/Z-Out report: Report of point-of-sale activities. The X-Out Shift Report can be run throughout the day to monitor 
sales activity. The Z-Out Drawer Count report is typically run at the end of a shift or day to reconcile the cash 
drawer. The Z-Out Store Close report is run at the end of the day to summarize the day’s sales activities and cash 
flow for the entire store, as well as help in preparing a bank deposit. 

Y 

Z 
Z-Out report: See X/Z-Out report. 
  

Return to top 
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Help & Support Resources 
Help & Support Overview | Navigate this Help System | Manuals 
  
This help system, together with your Point of Sale User Guide, will serve to answer most of your questions about 
Point of Sale. However, should you require further assistance, use the resources listed below. 
You may also find the answers to your issue in these troubleshooting topics. We recommend you start here. 

Then try these additional resources... 
Free, Self-Service Support  

• Support Web Site: For the latest information about your product and immediate answers to most 
questions, visit us at our Support Web Site. 

• Point of Sale User Community: Visit the User Community to connect with other Point of Sale users and 
experts to ask questions and share advice. 

  
Assisted Support Resources  

  

       Support Plans (Fees apply) 
Intuit offers a variety of support plans providing personalized expert assistance and other valuable 
services. Learn more. 
Already have a support plan?  Call your plan hotline and we'll route your issue to the appropriate support 
team. 
For a fee, per incident support is also available by calling 800-348-0254. 

  
QuickBooks POS Merchant and Gift Card Services Support  

Call 800-558-9558, 24 hours a day, 7 days a week. Free support for account holders 
  
  
Related Topics 
Order POS Supplies 
Find a local, certified Point of Sale expert 
Free resources for starting and growing your business 

Licensing, Registration, Updates 

Point of Sale Licensing 
How Do I?   
  
When you purchased Point of Sale, you purchased one or more user licenses. One user license allows one 
computer to access the Point of Sale company file at a time. Multiple user licenses allow multiple networked 
computers to access the company file at the same time. 
  

http://www.quickbooks.com/support
http://www.qbinproduct.com/community/help/pos
http://www.quickbokspos.com/plans
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One License, Multiple Workstations 
You can install Point of Sale on more than one networked computer with a single user license. However, only one 
of those computers will be able to use Point of Sale at any one time. Likewise, if you purchase two user licenses, 
you can install Point of Sale on more than two computers, but only two computers can work in the company file at 
one time, and so on. 
  
Example: How many licenses do I need to use Point of Sale on three workstations?  

Answer: It depends on how you want to use the workstations. 

• To use all three workstations at the same time requires three user licenses, one for each workstation. 

• To use only one or two workstations at the same time, requires either one or two user licenses, 
respectively. You need as many user licenses as you have workstations simultaneously running Point of 
Sale. 

• The Server Workstation acts as the license manager, checking in and out available user licenses to all 
networked workstations. The Server Workstation must always be turned on, but not necessarily running 
Point of Sale, for other workstations to access a license and your Point of Sale data. 

  
  

Note: All installations on a network must be the same version and level (Free, Basic, or Pro) of Point of Sale. 

  

Network Licensing Flexibility 
This licensing structure provides a great deal of flexibility. You may have different computers in your store that you 
use for different tasks, but not necessarily at the same time. 
For example, you want to use a point-of-sale workstation in the front of the store during business hours, but want to 
use a networked back-office workstation in the evenings to create purchase orders and exchange data with your 
QuickBooks financial software. In this example, only a single copy (with one user license) of Point of Sale is 
required. It would be installed on the back-office computer as the Server Workstation and the front computer as a 
Client Workstation, using the same license number. Either workstation can access Point of Sale, but only one at 
any given time. 
This licensing structure allows you to: 

• Use multiple workstations for sale lanes or specialized roles (purchasing, receiving, etc.) 

• Use a single user license that is accessible via multiple workstations, but only one at a time, or 

• Use multiple workstations at the same time provided multiple user licenses have been purchased 

Server Workstation Manages User Licenses 
When you install your Server Workstation, you are required to register that software license with Intuit. This license 
becomes the "master" license for the store and reflects the number of user licenses you have purchased. 
If you install Client Workstations using the same license number, any of the workstations can run Point of Sale, but 
simultaneous access is limited to the number of user licenses you have purchased. 
The Server Workstation functions as the licensing "manager" and must be running (though Point of Sale does not 
have to be open) for Client Workstations to access the company data. When any starts Point of Sale, it connects to 
the company file on the Server Workstation, an available user license is allocated to it until it exits Point of Sale, at 
which time that user license becomes available to another workstation. 
As your business grows and you need more workstations using Point of Sale at the same time, you can purchase 
additional user licenses, up to a total of ten per store: one Server Workstation and nine Client Workstations. No 
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matter how many user licenses you purchase, they all share one "master license" (the license registered from the 
Server Workstation). 
  

Merge License Numbers 
If you purchase and install additional copies of Point of Sale with different license numbers, you must merge them 
with the Server Workstation’s license. After merging, the new workstation shares the same license as the Server 
Workstation and its original license number is deactivated. 
The Server Workstation, in turn, is prompted to synchronize its license info with Intuit’s licensing servers to reflect 
the fact that an additional user license has been added. The new user license is not available for use until 
synchronization is completed. 

Register Your Software 
Point of Sale Licensing 
  
You can use Point of Sale for 5 days without registering. On the 6th day, you must register to continue using Point 
of Sale. You will be reminded to register each time you start the program until registration has been completed. You 
can register online or by phone. 

To register Point of Sale: 
1. From the Product Registration reminder screen on the Server Workstation, select Register Now. 

If you are connected to the Internet, an online registration form is displayed. 
If you are not connected to the Internet, the phone registration window is displayed. Dial the number listed to 
register. 

2. Follow the online prompts or the instructions provided by the phone agent to complete your 
registration. 

Notes: 

• You are encouraged to register promptly. Besides keeping your software functional, registration provides 
other valuable benefits including access to technical support, product updates, and certain other online 
features. 

• Multiple copies of Point of Sale on a network in one location share a license number. If you install another 
workstation with a different license number, you are prompted to merge the license number with that of your 
Server Workstation. Learn more. 

• Each workstation installed on a network must have the same Point of Sale level (i.e., Free, Basic, Pro) and 
version (e.g., 10.0) to access the same company file. 

• Your license and product number can be viewed by selecting About Point of Sale from the Help menu. 
You will be asked for these numbers if you contact Intuit for technical support or to unlock to a higher level of 
features. 

Merge License Numbers 
License Overview | Manage My License 
  
Multiple copies of Point of Sale on a network in one location share a license number. If you purchased multiple 
copies of Point of Sale directly from Intuit, you are provided a single license number that includes multiple user 
licenses. 
However, if you purchased additional copies of Point of Sale from a retail store or other source, the additional 
copies will come with unique license numbers, which must be merged with the existing license number on your 
Server Workstation within 5 days of installation. 
When the new (Client) workstation connects to the company file on the Server Workstation, you are prompted to 
merge the licenses. On the 6th day, Point of Sale will cease to function on the Client if the licenses have not been 
merged. Licenses can be merged online or by phone. 

To merge license numbers: 
1. From the prompt displayed, select Merge Now. 



Help and Learning 

617 

• If you are connected to the Internet, the merge happens automatically online. Select finish when 
the process is completed to close the merge window. 

• If you are not connected to the Internet, the phone merge window is displayed. Call the number 
shown. 
2. Follow the on-screen or phone agent instructions to complete the merge on the Client 
Workstation. 
3. To complete the merge and make the additional user license available, the Server Workstation 
must synchronize its license with Intuit’s licensing servers. 

• If the Server Workstation is connected to the Internet and has previously registered, this is 
immediate and automatic. 

• If the Server Workstation is not connected to the Internet or has not yet registered, a prompt to 
synchronize and/or register will be displayed periodically on the Server Workstation until completed. The 
synchronization can be done online or by phone. 

Notes: 
• You are encouraged to synchronize your license immediately from the Server Workstation. Once the 
licenses have been merged, the number of user licenses available for the company file is not updated until 
synchronization is completed. If you had only one previous license, only one workstation can access the 
company file at a time until synchronization is completed. 

• If installing several workstations at one time and they are not connected to the Internet, you might want to 
get all of them to the point of merging before calling Intuit to complete the merge. Typically, several merges 
and synchronization of the Server Workstation can be handled with a single call. The phone agent will guide 
you through this process. 

• The original license number of the Client Workstation is deactivated after merging. It now shares a license 
number with the Server Workstation. 

Related Topics 
Help and support overview 

Manage My License 
How Do I?   | About Point of Sale Licensing | Merge Licenses 
  
The Manage My License area allows you to view and print the Point of Sale license agreement, purchase additional 
user licenses, and to synchronize your in-product license information with the license data Intuit has stored for you. 
The latter could become necessary if you have re-installed Point of Sale on new computers. 
Up to ten licenses can be used within a single store, running any one level of Point of Sale (Free, Basic, Pro). Use 
this procedure to buy additional licenses at your current level. If you want to unlock to a higher level of Point of Sale 
instead, read the unlock topic. 
Example: How many licenses do I need to use Point of Sale on three workstations?  

Answer: It depends on how you want to use the workstations. 

• To use all three workstations at the same time requires three user licenses, one for each workstation. 

• To use only one or two workstations at the same time, requires either one or two user licenses, 
respectively. You need as many user licenses as you have workstations simultaneously running Point of 
Sale. 

• The Server Workstation acts as the license manager, checking in and out available user licenses to all 
networked workstations. The Server Workstation must always be turned on, but not necessarily running 
Point of Sale, for other workstations to access a license and your Point of Sale data. 

  

To buy additional user licenses: 
1. Select Manage My License  Buy Additional User License from the Help menu at the Server 
Workstation. 
2. Select Next on the window displayed to complete your purchase online. 
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OR 
Select Skip online and purchase additional license by phone. 

3. Follow the on-screen prompts to purchase the additional license. 
4. If purchasing by phone, enter the validation code given you by the operator and select Next. 

To synchronize your license data with Intuit records: 
You must have an active Internet connection for this option. If you don’t have an Internet connection, select the 
Buy Additional User License option as described above, access the phone option, and tell the operator you are 
calling to synchronize your license. 

1. Select Manage My License  Synchronize License Data Online from the Help menu at the 
Server Workstation. 
2. Follow the on-screen prompts to synchronize license data. 

  
Related Topics 
Feature comparison by level 
Help and support overview 
Point of Sale software updates 

Install Additional Workstations 
Network Issues | Company Data Connection Issues 

Basic  

QuickBooks Point of Sale can be networked to allow up to ten workstations simultaneous access to the program 
across a network within a store; one Server Workstation and up to nine client workstations. About Server and Client 
Workstations. 
  

Note: Virtual Private Networks (VPN) and wireless networks tend to be low bandwidth (slow) and therefore are not recommended 
for use with Point of Sale. These network configurations may be unreliable. 

  
Use this procedure to install additional Client workstations to an existing Point of Sale server installation. If multiple 
workstations are to concurrently access the Point of Sale company data, each must have a separately purchased 
user license and all computers on the network must have the same version (e.g. 10.0) and level (e.g. Pro) of Point 
of Sale installed. About Point of Sale licensing. 
For additional information or if you need to install the Server Workstation, read the Point of Sale User Guide 
(launches electronic version in a separate window) 

To install an additional client workstation: 
1. If necessary, network your computers, following the instructions for your networking hardware and 
software. 
2. Close all running programs, except Windows, on the computer that you are installing as a Client. 
3. Put the QuickBooks Point of Sale CD into your CD-ROM drive (if installing from a downloaded 
file, follow the instructions provided). 

The install Wizard will launch automatically. If it doesn’t, browse to the Setup.exe file on the CD and double-
click it to start the installation. 

4. Follow the on-screen prompts to install the program files to the client workstation: 

• Enter License and Product numbers from the CD holder purchased for the workstation or enter 
the same numbers used on the Server Workstation (with the latter choice, the Client will be able to run 
Point of Sale only if the Server Workstation closes the program) 

• Read and accept the license agreement. 

• Select Client Workstation as the installation type. 
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• Accept the default installation folder (recommended) or browse and enter an alternate folder 
name on this workstation. Do not browse to the server’s installation folder over the network! Each 
workstation must have the program files installed locally. 
5. Follow the on-screen prompts to complete the installation. 
6. With the Server Workstation running (Point of Sale does not have to be open), launch Point of 
Sale on the Client workstation.. 
7. Connect to the company data on the Server workstation. 

If only one company data file exists on the network, you are automatically connected. If multiple files exist, a 
list is displayed and you can select a file. 

8. When prompted, select a workstation number for this computer. If using passwords, log in using 
the user name and password assigned to you when prompted. 
9. When the Hardware Setup Wizard appears, follow the on-screed directions to connect and 
configure any Point of Sale hardware you have purchased. 
10. Merge the Client license with the Server license if prompted. 

  

Notes: 
• The Server Workstation has all program, company data, and the database application files installed. Client 
workstations install the program files, but access the company data file across the network to carry out 
program activities. 

• The following activities cannot be done on a client workstation: 

• Creation of a Point of Sale company data file 

• Exchanging data with QuickBooks financial software 

• Accessing Intuit servers online to manage program license information 

• Importing data with the Data Import Tool 

• (Pro) Store Exchange with other stores 

• It is recommended that you check for and install available program updates immediately after adding a 
workstation. If installing updates, make sure you update all workstation on your network. 

Related Topics 
Help and support overview 
Work with your POS company data 
Install supported hardware 

Comparison of Features by Level: Free, Basic, Pro 
Unlock to a Higher Level | Point of Sale Licensing 
  
The Point of Sale software that you purchased contains three separate levels of the program, each with a specific 
set of features. This allows you to license and use only those features that you need, without having to pay for 
advanced features you don't need. 
Your current program level is shown in the title bar at the top of the Point of Sale window. 
Point of Sale Free provides fundamental retail functionality to: 

• Ring up sales 

• Track sales by product or department 

• Run insightful reports to see what's selling and what's not 

• Accept credit, debit, and gift cards1 

• Transfer summary sales and expenses to QuickBooks Financial Software 
Point of Sale Basic includes all the Free features, plus: 

• Manage up to 20 checkout lanes in one store2 
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• Receiving of merchandise into inventory 

• Track inventory item quantities and cost of goods sold 

• Track customer purchases and contact information 

• Integration options with QuickBooks financial software to help you manage your business better 

• Control access to features by password 
Point of Sale Pro includes all of the Free and Basic features, plus these additional features: 

• Customer orders (layaways, sales orders, and work orders) 

• Customer Rewards program 

• Create Customer ID cards 

• Inventory styles (size and color grid), assemblies, and grouped items 

• Inventory item pictures 

• Track multiple vendors per item, each with separate UPC, ALU, and order cost 

• Purchase and sell items by multiple units of measure (case-to-unit) 

• Create and track purchase orders with your vendors 

• Record item serial numbers on documents 

• Track available and committed quantities 

• Capture customer shipping addresses 

• Enter shipping and tracking information on receipts and customer orders; integrated Shipping Manager 

• Track employee hours worked and send time records to QuickBooks for payroll purposes 

• Track employee commissions on sales 

• Define and apply manual, automatic, and coupon discount pricing for special or temporary sales 

• New item, price change, and customer order reminders 

• Suggest PO and generating POs from customer orders simplifies purchasing 

• Create special order items to sell or order customized or one-off merchandise 

• Customize printed documents and tags 

• Define and use custom fields for vendor, item, employee, and customer records 

• Manage up to 20 stores efficiently from a Headquarters location 

• Track merchandise transfers between stores 

• Collect different sales tax rates and set default payment methods at each store 

• Centralized inventory control and purchasing 

• Exchange information between stores 

• Company reports 

• Run store-specific profit/loss and other reports by class in QuickBooks financial software 
Notes: 
1 Requires an account with QuickBooks POS Merchant and/or QuickBooks POS Gift Card Services. Fees apply. 
2 Requires a separately purchased license for each lane. 
  
Related Topics 
Unlock to a higher program level 
Manage my license 
Point of Sale software updates 
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Help and support overview 

Unlock to a Higher Point of Sale Level 
About Point of Sale Licensing | Feature Comparison by Level 
  
If you need additional functionality, you can unlock to a higher level of Point of Sale at any time over the phone, for 
an additional fee. 

To unlock to a higher license level: 
1. On your Server Workstation, select Home from the main toolbar to display the Point of Sale Navigator. 
2. From the Help menu, select Manage My License and then Buy Additional User License. 
3. Call the 800 number listed and tell the service agent that you want to unlock to a higher level. 
4. Follow the instruction provided to enter the new product and validation numbers. 
5. Close Point of Sale and restart on all workstations to begin using the higher-level features. 

Notes: 

• If you have multiple user licenses for a networked installation, you must unlock all licenses to the same 
level of Point of Sale. User licenses that are not unlocked will not be able to access the company file after the 
Server Workstation has unlocked. 

• There is no need to reinstall the Point of Sale software or transfer your company file, the change to the 
new level is handled automatically as each workstation is restarted. 

• Write down or print your new license number and product code. If you ever have to reinstall Point of Sale, 
you should use these new numbers. If you have to reinstall and have lost these numbers, call Intuit Technical 
Support for assistance. 

• Every unlock comes with a 60-Day, Money-Back Satisfaction Guarantee (ask for details when calling). 
Related Topics 
Help and support overview 
Point of Sale software updates 

Program Updates: Download and Install 
Help & Support 
  
Updates to your Point of Sale software—such as maintenance releases, enhancements, and updated help files—
can be quickly and easily downloaded and installed, ensuring that you have the most up-to-date features and 
capabilities available. 
You can have Point of Sale automatically download update files (recommended), be notified when an update is 
available but download it yourself, or not be notified at all and manually check for updates yourself. 
If you have multiple networked Point of Sale workstations, you can configure updates so that all workstations can 
update from a shared download file. 

What's important about software updates? 

• An update should be installed on your Server Workstation first. All other workstations on your network 
must exit Point of Sale during the update to the Server Workstation. 

• Point of Sale will automatically back up your company data before updating the Server Workstation. 

• We recommend installing updates while your store is closed, when you have time to complete the 
installation and familiarize yourself with program enhancements. Updating multiple workstations or a large 
data file may take some time. 

• (Pro) Each workstation at each store must install an update to ensure compatibility within a store as well as 
between stores. All stores should follow the same update procedures and schedule. 

Updating Point of Sale includes these steps: 
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1. Set your updater preferences.  

1.  

From the Help menu, select Software Updates > Updater Preferences and select how you want to 
be notified of available updates: 

• Download only. Let me choose when to install. (Recommended). Point of Sale will 
download updates in the background anytime you are connected to the Internet and let you 
know when an update is ready to install. 

• Notify me. Do not download. Point of Sale will check for updates and notify you when one is 
available to download. But you choose when to download and install. 

• Do not notify me. I will check for updates myself. Point of Sale will not check for updates 
at all. You can manually check for and download updates at your discretion. 

If you have multiple networked workstations: 
Consider updating all workstations from a shared download. With this option, only one workstation 
needs to be connected to the Internet to download updates. Once downloaded, the shared file is 
available to all workstations. To learn more or to enable this option, select the Shared Download tab 
on the Updater Preferences window. 
Important: Each workstation must select the shared download preference to use this feature. 

1.   
2. If updates are not downloaded automatically, select Software Updates > Check for Updates 
from the Help menu at the Server Workstation. 

Point of Sale connects to the update site and checks for available updates. If an update is available, 
information about what is included and an estimate of how long it will take to download it is displayed. 

3. Select Update Now (on automatic downloads, select OK when notified). 
Or, select Remind Me Later to delay a download/installation until a later time. 

4. Follow the on-screen prompts to install the update. 
5. Restart Point of Sale after the update is installed. 
6. If applicable, install the update to additional workstations. 

  
To review the update history on a workstation, select Software Updates > View Installed Updates from the Help 
menu. 
  

Notes: 
• A program update does not upgrade Point of Sale to a new version or unlock the features of a program 
level other than what you have licensed (e.g., Basic to Pro). Read How do I unlock to a higher level? . 

• FAQ and troubleshooting information can be found in the help topics available from the Updater 
Preferences window. Select any blue help link or button, choose Home and then choose the Frequently 
Asked Questions or Troubleshooting links. 

• If you have modified your Point of Sale lists, reports, or customized printed documents and tags, installing 
an update will not overwrite your modified layouts to add any new fields or options included in the update. 
You may need to further modify your layouts to add them or, in the case of reports, use the Revert option to 
reset to the default layouts and then re-memorize. 

• For information about what data may be read from your computer during software updates (such as your 
current version and licensing information), please read our Privacy Policy by selecting Privacy Statement 
from the Help menu. 

Return to top 

Troubleshooting & FAQs 

Troubleshooting Overview 



Help and Learning 

623 

Help & Support Overview | Help & Support Resources 
  
Select a topic below for assistance in troubleshooting problems. If you received an error message, click on the Help 
button on the message for specific help related to the activity you were performing. 

What do you need help with? 
  
Feature availability 
Cash drawer 
Receipt printer 
Pole display 
Bar code scanner 
Hardware (general) 
Printing (general) 
Sales taxes 
Merchant & Gift Card Services 
Financial Exchange with QuickBooks 
Windows user rights 
Connecting to POS company data 
Performance and networking 
E-mailing from Point of Sale 
Print Designer 
Store Exchange 
  
Related Topics 
Find a local. certified Point of Sale expert 
Compatible POS hardware list 
Program capacities 

Company Data Connection Issues 
Help & Support Overview | Networking Issues 
  
Point of Sale must be able to access the POS company data that is stored on the Server Workstation. In a 
networked installation, the connection issues outlined below most commonly apply when a Client workstation is 
unable to locate or connect to the data on the Server Workstation.  About Server and Client Workstations 
  

Note: Virtual Private Networks (VPN) and wireless networks tend to be low bandwidth (slow) and therefore are not recommended 
for use with Point of Sale. These network configurations may be unreliable. 

  

Data Connection Requirements 
There are certain prerequisites to being able to access the Point of Sale data, whether it is being accessed from the 
Server or Client Workstation. 

1. The Server Workstation must be turned on (but Point of Sale need not be running). 
2. Firewall software must be configured to allow Point of Sale components to access needed ports. 

  

POS Data Connection Error Messages 
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If a workstation cannot locate or connect to the POS company data, you may see an error message similar to that 
shown below. 

Application could not find, could not connect to, or could not open company data. 
Review the list of possible causes and solutions below to correct the problem. When encountering connection 
difficulties on a Server Workstation, the first step is for the user to sign onto the computer as a user with Windows 
Administrator rights. 
When encountering connection difficulties on a Client Workstation, the first step is for the user to sign-on to the 
Client Workstation as an administrator AND that an administrator also sign-on to the Server Workstation. 

  

Possible Cause: Solution: 
Company data was renamed, 
moved, or deleted. 

A list of the data files and Server 
Workstations found on the network is 
listed. Select the correct data/server 
and then select OK. On subsequent 
startups, the client workstation will 
reconnect to this same data. 

The data file does not have a 
unique name. 

Ensure that the POS data file has a 
unique name. 

The Server Workstation is not 
running. In order for a client 
workstation to access the data 
stored on the Server 
Workstation, the Server 
Workstation must be running. 

Once you are sure the Server 
Workstation and network are 
working, enter the Server 
Workstation computer name (can be 
found at Windows Control Panel  
System  Computer Name on the 
Server) and POS company data file 
name (can be found in the Point of 
Sale title bar on the server) and then 
select OK. 

Return to top 

  

The Server Workstation has a 
different data file open than the 
one to which a client workstation 
is trying to connect. 

Open the correct company data on 
the Server Workstation or select to 
connect the currently open data. 

The network connection or 
configuration is not working. 

Check your network connections and 
cables on both Client and Server 
Workstations. Can you access other 
information on the Server 
Workstation from the client? Check 
the Performance and Networking 
FAQs or consult with a qualified 
computer network specialist for help. 

Firewall settings, on either the 
client or server workstation, are 
blocking the connection. In most 
cases, you will see a message 
from the firewall if this is the 
case. (Note: Some firewalls don’t 
display a message at all in this 
case and others display 
messages only if the user has 
Windows Administrator rights.) 

Check your firewall settings. Be sure 
you are signed on to Windows as a 
user with Administrator rights and 
then try to connect again. If you 
receive a firewall message saying 
that Point of Sale (or the applications: 
QBUpdate, QBDBMgrN, Adaptive 
Server Anywhere Network Server) 
are trying to access the Internet, 
answer Yes, always to allow the 
connection. This should prevent this 
problem in the future. Note: Firewalls 
may vary in their message and the 
solution to this problem. Click the link 
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above or refer to your firewall 
documentation for additional 
assistance. 

Return to top 

  

Selected data is not a Point of 
Sale database. 

Select a valid Point of Sale data file. 

There are more workstations 
running than are allowed by 
license. 

Shut down excess workstations or 
purchase additional Point of Sale 
licenses. 

The workstation is not running 
the same level or version of 
Point of Sale as another 
workstation that is currently 
accessing the database. 

Update or upgrade all workstations to 
the same level and/or version of 
Point of Sale. 

Insufficient user rights to create 
a database or to change the 
currently accessed database. 

Ensure that you are logging in to 
Point of Sale with sufficient rights to 
create or change the currently 
accessed database. Also, be sure 
that your Windows user rights are not 
blocking access. 

Client Workstation is still logged 
into a database, preventing 
Restore, Open Database or 
Rename Database. 

Close the Client Workstation 
database connection or exit Point of 
Sale on the client. 

Return to top 
  
Related Topics 
Advanced settings that might affect connection 
Configure port filters 
Performance and networking issues 

Connection, Performance, and Networking Issues 
Help & Support Overview | Help & Support Resources | Troubleshoot 
  
Connection Issues 
I get error messages saying Point of Sale cannot connect to my company data 
My firewall is blocking me from the POS company data 
How do I set my port filters to allow access to needed ports? 
When trying to update my Point of Sale program, I get an Error 12029 
I cannot launch Web pages using links in Point of Sale 
  
General Performance 
Does your PC meet the minimum system requirements? 
Do you have the latest updates or Service Packs for your Windows® operating system? 
Is the configuration and scheduling correct for anti-virus software? 
When Windows comes out of hibernation, Point of Sale crashes 
I had a power failure and now am getting error messages about data corruption 
  
Networking Issues 
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Many network configuration parameters can influence the connection or performance of Point of Sale. An 
improperly configured network can cause all system resources to work harder, deterring from their ability to serve 
Point of Sale and other application requests. Following is a list of questions and answers related to the most 
common parameters that can adversely affect Point of Sale performance. Every computer and network 
configuration is unique; consult a qualified computer consultant for help, if necessary, to address networking 
issues. 

Note: Virtual Private Networks (VPN) and wireless networks tend to be low bandwidth (slow) and therefore are not recommended 
for use with Point of Sale. These network configurations may be unreliable. 

  
Is the configuration and scheduling correct for anti-virus software? 
Is any network backup software on the Server Workstation scheduled to run while QuickBooks Point of Sale 
operations are being performed? 
Does the Server Workstation have appropriate hardware? 
Does each client workstation have the appropriate hardware? 
Is each device connected to a 100 Mbps Hub/Switch that is transmitting at 100Mbps? 
  

Warning: The following advanced network issues should be addressed only by a qualified computer network consultant. 
These issues assume you have addressed the basic network settings posed in the questions above 

  
Are the switches and network cards capable of auto-negotiating 100Mbps/Full Duplex? 
Does each computer-switch port link auto-negotiate to 100Mbps/Full Duplex properly? 
Are all devices connected to a 100Mbps hub operating at Half Duplex? 
Is the Server Workstation hard drive defragmented on a regular basis? 
Are system performance options properly set according to Point of Sale usage on the Server Workstation? 
Are Port Filters set to allow access to needed ports? 
  
  

Didn’t find an answer to your question? Try these other resources: 

Visit the Point of Sale Community Message Board to ask questions and share ideas, solutions, and advice with 
other Point of Sale users and experts. 

Check out our support website to search our online database of answers to frequently asked questions at 
www.quickbooks.com/support/pos. 
  
  
Related Topics 
Help and support overview 
Troubleshooting overview 
Configuring firewalls 
  
  
  
  
  

When trying to get the latest Point of Sale update, I get an Error 12029. What is wrong and how can I fix 
this? 
This error indicates that Point of Sale cannot connect to the update servers using your current Internet connection. 
Follow these steps to fix this problem: 

http://www.qbinproduct.com/community/help/pos
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1. Make sure your Internet connection is active and working outside of Point of Sale. 

• Can you successfully connect to other Web sites? If not, use the Windows Network Connections 
manager (available from Control Panel) to configure and test your Internet connection. Contact your 
Internet Service Provider for assistance, if necessary. 

2. Select Preferences  Workstation from the Point of Sale File menu. 
3. Select Automatic Update from the preferences list on the left side of the window. 
4. Click the Internet Connection Setup button. 
5. Select the choice labeled Use my computer’s Internet Connection settings to establish a connection 

when this application accesses the Internet. 
6. Select Next and then Done to finish. 
7. Select Save to exit Workstation preferences. 
8. Try updating Point of Sale again (select Update QBPOS from the File menu and then select Get 

Updates. 
If this does not correct the problem, then there is probably a firewall installed on your computer that is blocking the 
Internet connection. Read Configuring firewalls and refer to your firewall’s documentation or a qualified computer 
consultant for information about configuring the firewall for the following settings: 

• Ports 80 (for HTTP) and 443 (for HTTPS) are enabled 

• The following files are configured to allow them to connect to the Internet and download updates: 

• The QuickBooks Point of Sale executable file (qbpos.exe, located in the QuickBooks Point of Sale root 
directory)) 

• The QuickBooks Delivery Agent module file (qbupdate.exe; located in the C:\Program Files\Common 
Files\Intuit\QuickBooks\QBUpdate folder) 

Return to question list 
  
  
  
Does the PC meet the minimum system requirements? 
Review the system requirements in your Point of Sale User Guide. Generally, increasing system RAM is the most 
cost-effective way to increase the performance on a single PC, assuming all other minimum requirements are met. 
Return to question list 
  
  
  
Do you have the latest updates or Service Packs for your operating system (Windows®)? 
Maintaining your Windows operating system with the latest updates and/or Service Packs is critical to ensuring 
optimum performance and data protection. Visit the Windows Update Internet site regularly to review and update 
your operating system files as necessary. For most versions of Windows, the update site can be accessed by 
selecting Start and then Windows Update. 
Return to question list 
  
  
  

When Windows comes out of hibernation, Point of Sale crashes. How can I fix this? 
Some Windows systems come with a hibernation feature that puts the computer to "sleep" after a set period of 
inactivity. This feature can be problematic with some programs. If you experience any difficulty returning from 
hibernation it is recommended that you disable this feature on your system. 
Return to question list 
  
  
  
Is the configuration and scheduling correct for anti-virus software? 
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If a workstation or network running Point of Sale seems to be abnormally slow, try reconfiguring your virus scanning 
software. By default, most virus scanning software scans all files in all folders. This can cause significant load on 
the system resources resulting in decreased performance for Point of Sale. 
Be aware that changing the options of your virus scanning software can reduce its effectiveness. Consult a 
qualified computer technical consultant prior to making any changes to ensure that you understand the 
consequences of those changes. 
Some anti-virus configuration options that may improve performance are: 

• Disable continuous scanning and schedule virus scanning during off-peak hours. 

• Limit scanning to specific file types (such as .exe, .vbs, etc.). 

• If you are operating in a network environment, make sure each workstation is configured to scan only its 
own hard drive and not entire network. 

• If scanning in continuous mode, exclude the …\Program Files\Intuit\QuickBooks Point of Sale n.n 
folder from INBOUND and OUTBOUND scan operations. (n.n = Point of Sale version, i.e. 10.0) 

Return to question list 
  
  
  

I had a power failure and now am getting error messages about data corruption. What do I do? 
A power failure that occurs while Point of Sale is writing to your company date file may result in data loss or 
corruption, and any transaction or activity in process will most likely be lost. If you can access your company data, 
print out all transactional documents made after your last backup. Then restore your data from the backup and re-
enter those transactions. 
If you are integrated with QuickBooks financial software, and the re-entered documents have already been sent to 
QuickBooks you can mark them so that they are not sent again. With the document selected in your Point of Sale 
history list, select View Financial History from the I Want To menu and then select the checkbox labeled Mark 
this document as successfully sent. 
  

Note: Data Recovery Service. If your attempt to restore your data is unsuccessful or if you need additional help, you can contact 
Intuit Technical Support for assistance. There may be a fee for this service. 

  
We strongly recommend installing a UPS (uninterruptible power supply) on at least the Server Workstation, which 
stores your company data, and on the workstation you use to communicate for electronic funds transactions. 
Ideally, every workstation running Point of Sale should have a UPS installed. A UPS will give you the time to finish 
and save transactions in progress and shut down your system safely in the event the power loss lasts more than a 
few minutes. 
Return to question list 
  
  
  
Is any network backup software on the Server Workstation scheduled to run while Point of Sale operations 
are being performed? 
Network backups are demanding on system resources and may cause performance degradation. There may be 
resource contention among the different services, applications, and Point of Sale on the server. It is recommended 
that you not use your Point of Sale Server Workstation for other network services, such as a domain controller, web 
server, file server, etc. If backups or other scheduled tasks must be run from the Server Workstation, schedule 
them for a time that does not conflict with Point of Sale operations. 
Return to question list 
  
  
  
Does the Server Workstation have appropriate hardware? 
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To perform optimally as data host for several workstations, the Server Workstation will require more than the Point 
of Sale minimum hardware requirements. Consult your network professional for more information and 
recommendations. 
Return to question list 
  
  
  
Does each client workstations have the appropriate hardware? 
Each client workstation must meet the minimum system requirements, e.g. Pentium III or equivalent, 500 MHz 
CPU, 256 MB of RAM and a minimum of 250MB of free drive space. 
Return to question list 
  
  
  
Is each device connected to a 100 Mbps Hub/Switch that is transmitting at 100Mbps? 
Since hubs operate at Half Duplex and transmit all frames to all ports, if one device is connected to a hub at 
10Mbps, all devices will be downgraded to 10Mbps. There are intelligent hubs that do support independent speed 
settings per port, but you must confirm whether or not your hub supports this and that it is working correctly. 
Full Duplex switches with auto-negotiation capabilities are the preferred connectivity devices for networks. 
Return to question list 
  
  
  

Warning: The following advanced network issues should be addressed only by a qualified computer network consultant. 
These issues assume you have addressed the basic network settings posed in the questions above 

  
 
Are the switches and network cards capable of auto-negotiating 100Mbps/Full Duplex? 
A workstation or server connected to a switch port by a CAT5 cable is identified as a 'link'. The computer network 
card and the switch must support operating in 100Mb/Full Duplex. If either does not support this, the potential 
exists for a speed/duplex mismatch. 
Return to question list 
  
  
  
Does each computer-switch port link auto-negotiate to 100Mbps/Full Duplex properly? 
Whenever possible, configure the network card and the switch port to auto-negotiate the speed and duplex setting. 
If the auto-negotiation protocols are working to industry standards, they will negotiate to the highest available speed 
and duplex setting (100Mbps/Full Duplex). This will result in the least amount of administration. 
When using auto-negotiation, you must verify that the negotiation is occurring properly. If either device fails in the 
negotiation, the result can be a speed/duplex mismatch or a reduction in the speed/duplex settings the devices 
have negotiated. Either of these conditions will cause performance degradation. (See below for verifying 
speed/duplex settings). 
If auto-negotiation is not an option on both devices, or it fails, manually set the speed/duplex settings for both 
devices identically ; 100Mbps/Full Duplex is the target configuration when connecting to a switch that supports this. 
Link speeds and duplex settings are configurable per switch port. All Point of Sale devices should be set to operate 
on 100Mbps/Full Duplex links for best performance. 
With fiber optics, auto-negotiation is less likely to be supported. If you connect two switches, or a server and a 
switch, with fiber, you should manually configure both ends of this link for the same speed (100Mbps or 1000Mbps) 
and Full Duplex. 
Auto-negotiation protocols will not detect an inferior cable, such as a CAT3 cable. The auto-negotiation will resolve 
to 100Mbps/Full Duplex, then errors will begin occurring during normal data transmission if you elect to use CAT3 
cabling. 
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Return to question list 
  
  
  
Are all devices connected to a 100 Mbps hub operating at Half Duplex? 
Hubs are not compatible with Full Duplex communications. Full Duplex devices do not detect other devices that are 
transmitting on the wire; they will transmit at will. A Full Duplex network card connected to a hub will transmit data 
whenever it is received, without regard for any other devices transmitting on the wire, causing excessive collisions. 
Full Duplex switches with auto-negotiation capabilities are the preferred connectivity devices for networks because 
of better performance. 
Return to question list 
  
  
  
Is the Server Workstation hard drive defragmented on a regular basis? 
Periodic defragmentation of the hard drive is essential to optimal server performance. Files become fragmented 
over time as they grow in size and as the OS tries to conserve space by writing new data to open, non-contiguous 
blocks on the hard drive. Under severely fragmented conditions, a disk read-write head may have to perform 10-15 
seek operations to read a fragmented file vs. one seek operation if this file were written contiguously to the disk. 
Windows 2000 and XP both include a defragmentation utility. Refer to your Windows help for instructions to run this 
utility. There are also many good third-party utilities that allow for scheduling and automated defragmentation as 
well as other features to help maintain your disk subsystems. 
Even if the defragmentation utility reports that defragmentation is not required, you should select View Report and 
look at the "Most Fragmented Files" area for critical files and their level of fragmentation. If you find critical system 
files or Point of Sale files heavily fragmented, you should run a defragmentation operation. 
Note that files that are in use, or held open will not be defragmented, so this operation should be performed with 
everyone out of the system or at a time of low utilization. 
Return to question list 
  
  
  
Are system performance options properly set according to Point of Sale usage on the Server Workstation? 
Application Performance 
On the Server Workstation, access Control Panel  System  Advanced tab Performance Options: 

• Set to Applications if using the server as a workstation (normal). 

• Set to Background Services if most Point of Sale work is done over the network by client 
workstations. 

This setting affects how the system allocates CPU cycles to each thread. If you use Point of Sale regularly on the 
Server Workstation and you want to allocate more CPU cycles to this instance of the program, select Applications. 
If you rarely run Point of Sale on the server, you should select Background Services. This will distribute CPU 
cycles equally among all services. 
For client workstations, this setting should always be set to Applications. 
  
The Pagefile 
By default, the pagefile is created on the boot partition, where the system files are located and has an initial size 
equal to 1.5 times the amount of physical RAM, with the ability to grow beyond that initial size. 
If a STOP error occurs and you want to create a memory dump file for debugging purposes, it is necessary to have 
the pagefile on the boot partition. For optimal performance though, the pagefile should be located on a separate 
physical drive from the boot partition to eliminate the disk access contention created between pagefile I/O and 
system file I/O. To balance out the need for creating a memory dump and the need to optimize performance, you 
can leave the pagefile on the boot partition and create an additional pagefile on a physically separate drive. 
Windows 2000 uses an algorithm for paging to the pagefile on the least busy drive. 
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Also, consider setting the initial and maximum size of the pagefile the same. This prevents the pagefile from 
growing. Resizing the pagefile takes CPU cycles and causes pagefile fragmentation, which, in turn, causes slower 
paging. Make sure the page file's initial size is at least 1.5 times physical RAM. 
To view or revise pagefile settings, open Control Panel  System  Advanced tab  Performance Options, 
and under Virtual Memory select Change. 
Return to question list 
  
  

Are Port Filters set to allow access to needed ports? 
Windows 2000 and XP allow TCP/IP and UDP ports to be filtered, which could affect Point of Sale operations. To 
determine if this is the source of the problem, do the following: 

1. From the Windows Start menu or Control Panel, right-click My Network Places and select Properties. 
(Called Network and Dial-up Connections in Windows 2000.) 

2. Right-click Local Area Connection and select Properties. 
3. Select Internet Protocol (TCP/IP). (Make sure the box is checked.) 
4. Select Properties. 
5. Select Advanced. 
6. Select the Options tab. 
7. Select TCP/IP Filtering and then Properties. 

If Permit All is checked in each category, your ports are not being filtered and are not blocking Point of Sale 
actions at the operating system level. If Permit Only is checked in any category that is needed for Point of Sale, or 
required ports are not in the list, the same problems will occur as with a firewall. See the table below for a list of 
ports and which program files access them. Add the appropriate port to the permit list where necessary. 
  

Default 
Port 

Program File When Accessed 

443 EFTSvr.exe Throughout operation 

8443 EFTSvr.exe Throughout operation 
Merchant Service 
transactions 

2638 DataImporter.exe 
EFTSvr.exe 
QBDBMgr.exe 
QBDBMgrN.exe 
QBPOSDBServiceEx.exe 

Throughout operation 
Conversion from 
previous version 
Changing currently 
running database. 
Startup 
Detecting change to 
QBDatabases.ini 
Help > Manage my 
license 

46203 EFTSvr.exe 
QBDBMgrN.exe 
qbpos.exe 

Throughout operation 
Changing currently 
running database. 

46204 EFTSvr.exe 
QBDBMgrN.exe 
QBPOS.exe 

Throughout operation 
Changing currently 
running database. 

8024 
  

QBPOS.exe Web installation 
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Setup.exe License verification 
Throughout operation 

8025 QBPOS.exe 
Setup.exe 

Web installation 
License verification 
Throughout operation 

Return to question list 

Configure Your Firewall 
Help and Support | Troubleshoot 
  
A firewall, on either the Client or Server workstation, can block communication between workstations and the Point 
of Sale company data or to the Internet. You may see a message from the firewall if this is the case. 
Note: Some firewalls don’t display a message and others display messages only if the current user has Windows 
Administrator rights. Make sure you are logged into Windows with Administrator rights to ensure you are seeing 
any messages your firewall might be generating. Read configure Windows user rights for more information. 
  

Get Latest Firewall Updates 
Several major firewall applications are updated regularly with the latest Point of Sale file and port information and 
will automatically allow access to the ports and files needed. Use your firewall application’s instructions to be sure 
you have the most recent updates available before installing Point of Sale and each time you install a Point of Sale 
update. 
  

Windows Integrated Firewall 
If you use the Windows integrated firewall, and it is blocking access, Point of Sale will alert you on startup and offer 
to automatically configure the firewall for you. It is strongly recommended that you allow the automatic 
configuration. 
  

Manually Configuring Firewalls 
Each firewall program presents its interface in a slightly different manner; each provides its own phrase for asking 
what you would like to do regarding the action it views as a possible threat. You will see some form of the question, 
"What do you want to do about this?" That question will be followed by a list of options, such as allow, grant, deny, 
block, permit, or something similar, from which you must choose an action. 
You should select the option to allow, grant or permit the action. There should not be a prompt the next time 
the same action is performed. However, permitting one action for one file will not automatically enable all actions 
from anywhere in the Point of Sale program. Several different Point of Sale files perform actions that might be seen 
by your firewall as an attempt to connect to the Internet. Permission must be granted separately for each action. 
If firewall messages continue to appear, it may be necessary to manually configure the firewall to allow access for 
the required program files. 
If you need to manually configure your firewall application, you should review the appropriate sections of the 
manual or help file that was supplied with the firewall program. 
  
Note: Windows 64 bit version is shown below.  
          For 32 bit versions, (x86) is not shown in the path. For example: C:\Program Files\Intuit\QuickBooks Point of 
Sale 11.0 
The program files to grant access to are: 

• QBPOSShell.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0 

• QBPOS.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0 

• QBDBMgrN9.exe 
C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0\DatabaseServer 
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• QBDBMgrN10.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0\DatabaseServer 

• QBPOSDBService.exe 
 C:\Program Files (x86)\Intuit\QuickBooks Point of Sale 11.0\DatabaseServer 

The services to grant access to are: 

• Intuit Update Service 

• Intuit Entitlement Service 

• QBPOS Database Manager 
Note: Folder locations shown assume the default installation location on Windows 7/Vista.  
         Adjust accordingly if you installed to a different location. If necessary, use Windows Search from My 
Computer to locate these files. 
  
Related Topics 
POS company data connection issues 
Performance and networking issues 
Troubleshoot QuickBooks Financial Exchange 
Configure port filters 
Help and support overview 
Contact Technical Support 

Printing FAQs 
Printing Overview | Compatible Printers | Hardware Setup 
  
The following lists include common questions about printing. Under the appropriate category below, click on a 
question to view the answer. 
If you have problems printing, we recommend you use the Hardware Troubleshooter (access from the Help 
menu) for assistance. The troubleshooter will help you identify and correct your specific issue. 
  

Printer Configuration & Preferences 
My printer is not printing. What could cause this? 
The Print or Print Tags buttons are grayed out. Why can't I access this option? 
After upgrading, I can't find the same print template I used for a document/area before. Why is this? 
  

Document & Report Printing 
What is wrong when the right side of the text is truncated when printing the Z-Out Store Close report on the Star 
TSP600 receipt printer? 
How can I change font size on a report? 
What happens if I select print while viewing a document before the document has been updated? 
What should I do if a printed document does not contain a field I want? 
Can I customize my printed documents? 
Can I change printing options at the time of printing? 
How do I cancel a printing job after it has started? 
When printing a X/Z-Out report to my 40-column printer, I get the error message "There was an error found when 
printing the document to LPT1: Do you want to retry or cancel the job?" If I cancel the print job Point of Sale freezes 
up. What can I do to correct this? 
I am using the Epson TMU200 and am experiencing poor print quality. What is wrong? 
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Tag and Label Printing 
How do I cancel a tag printing job after it has started? 
When printing tags using the Zebra tag printer, tags are printed erratically, skipped, printed upside down, or not 
properly centered on tag stock. How can I fix this? 
Tags are skipped when printing on a Zebra tag printer, even after a calibration. What could be the problem? 
I accidentally sent a print job to the Zebra tag printer that was meant for another printer. What should I do? 
The Zebra tag printer prints one tag, advances past several blank tags, and then the printer light becomes red, or 
the printer light becomes red when sending a job to the printer. How can I correct this? 
When printing tags with cost there are unusual characters, but no cost. What has happened? 
What is wrong when nothing prints on hangtags? 
Can I customize my printed tags? 
I changed fonts and font sizes in Print Designer, but my printouts are now messed up. Why? 
See also Common issues with Zebra tag printers 
Back to top 
  

Didn’t find an answer to your question? Try these other free resources: 

Visit the Point of Sale Community Message Board to ask questions and share ideas, solutions, and advice with 
other Point of Sale users and experts. 

Check out our support website to search our online Knowledgebase of answers to frequently asked questions at 
www.quickbooks.com/support. 
  
Related Topics 
Print records or documents 
Print tags 
Print the cost and last-received date on tags 
Print customer labels 
Workstation preferences: Printing 
Compatible hardware list 
  
  
  
  

Printer Configuration & Preferences Answers 
My printer is not printing. What could cause this? 
A number of things could cause this problem. Check for the following: 

• No power/printer is offline 

• No paper in printer 

• Printer is not properly installed 

• Printer is not properly connected to computer 

• Workstation preferences are not properly configured for the printer (use the Hardware Setup 
Wizard, accessible from the File menu, to connect and configure new hardware) 

• No template is selected in workstation preferences for the document type you are trying to print 

• More than one printer is connected to the port assigned (use the Hardware Troubleshooter, 
accessible from the Help menu, to identify and correct the problem) 

• You plugged a USB printer into a port other than the one on which it was originally installed. 
Replug the printer into the same USB port used before. 

http://www.qbinproduct.com/community/help/pos
http://www.quickbooks.com/support
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Receipt printer troubleshooter 
Return to question list 
  
  
The print or print tags button is grayed out. Why can’t I access this option? 
Typically, this happens when no printer has been set up in Windows or assigned in Point of Sale. Selecting 
Preferences  Workstation from the File menu and then select Available Printers from the preferences menu on 
the left. If your printer is not listed, select Hardware Setup Wizard to install it now. Then select Documents & 
Printers and specify the printer for documents as necessary. 
Return to question list 
  
  
After upgrading to this version, I can’t find the same print template I used for a document/area in earlier 
versions. Why is this? 
Improved print templates (called "designs" in some previous versions) have replaced previous templates. Review 
your template choices in workstation preferences and make new selections as appropriate. If you do not have a 
print template selected when selecting to print, a dialog will be presented from which you can make your selection. 
Return to question list 
  
  

Can I customize how my printed documents and tags look? 
Yes, if you are a Pro-level user, you can customize printed documents and tags using the Print Designer. Learn 
more. 
Return to question list 
  
  

Document & Report Printing 
What is wrong when the right side of the text is truncated when printing the Z-Out Store Close report on 
the Star TSP600 receipt printer? 
Go to File  Preferences  Workstation  Print Options  X/Z-out and change the template assigned to X/Z-
Out reports to 40-column X/Z-Out. 
Return to question list 
  
  
How can I change font size on a report? 
You can change a number of report options, including font, header/footer information, and the columns of 
information displayed in the report. In the Report Center, choose the report you wish to run. Depending on how you 
run the report, the Modify Report wizard may be displayed before running or you can select Modify from the toolbar 
after it is displayed. Choose Change Report Appearance and then select an area of the report in the Fonts 
section to review or change font characteristics. 
Return to question list 
  
  
What happens if I select print while viewing a document before the document has been saved? 
In this case, selecting Print has the same effect as selecting Save & Print. The document is saved, then printed. 
Return to question list 
  
  
What should I do if a printed document does not contain a field I want? 
Try a different document template at File  Preferences  Workstation  Documents & Printers and see if the 
new template contains the field/information you want. A number of templates are provided for each document type, 
each containing different information and fields. 
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(Pro) f the provided templates don’t meet your needs, you can customize them or create new ones to meet your 
needs using Print Designer. 
Return to question list 
  
  
Is there a way I can change printing options at the time of printing? 
At File  Preferences Workstation  Print Options, make sure the checkbox for Display Print Dialog... is 
selected for each type of document for which you would like to change options at the time of printing. You will be 
able to change the printer, number of copies, template, and various other options depending on the document type. 
Return to question list 
  
  
When printing a X/Z-Out report to my 40-column printer, I get the error message "There was an error found 
when printing the document to LPT1: Do you want to retry or cancel the job?" If I cancel the print job Point 
of Sale freezes up. What can I do to correct this? 
There are really two separate issues here. First, ignore the error message and let the printer continue printing. This 
error is caused by an overrun in the Windows print buffer, and if you just ignore it the message will disappear as 
soon as the buffer catches up. If it is a large report, this may take a few minutes but the message will disappear on 
its own and the print job will finish correctly. 
The second issue, Point of Sale freezing when you do cancel the print job, is most likely because your printer 
properties are set to "Print directly to printer." If this is the case, system control is never returned from Windows to 
Point of Sale after canceling the print job. Open your Windows Printers folder, right-click your 40-column printer 
and select Properties. Locate the setting for spooling print jobs (typically on the Advanced page) and be sure the 
"Spool print jobs…" and "Start printing immediately" settings are selected. 
Return to question list 
  
  

I am using the Epson TMU200 and am experiencing poor print quality. What is wrong? 
Try the following suggestions to improve the print quality with this printer. 

• Uninstall the printer from the Windows Printers dialog. Then run the ADT206E.exe file from the 
Extras\Drivers\Epson Printer & USB drivers folder on your Point of Sale installation CD, choosing the 
Status API and TMU 210 ReceiptA(R) options. This will reinstall the printer with the correct driver. 

• Select print templates that use the Arial font at File  Preferences  Workstation  
Documents & Printers. Look for the {Arial} suffix on the template names. 

• If you have a cash drawer attached and get extra characters printing, try changing the Cash 
Drawer settings in workstation preferences to "Connected through Epson Generic". 

• If extra paper is fed after a receipt is cut, try switching report/partial cut settings to assigned paper 
size on the Windows Printer Properties  Device Settings tab. 

• This is a dot matrix printer and does not support printing of scannable bar codes. 
Return to question list 
  
  

Tag Printing 
When printing tags using the Zebra tag printer, tags are printed erratically, skipped, printed upside down, 
or not properly centered on tag stock. How can I fix this? 
There are two possible reasons for this. 1) A dirty printhead, or 2) the printer needs to be calibrated. Calibration is 
offered required right after switching between label types, changing the roll, or just because tag printers can be 
finicky. 
See Common issues with Zebra tag printers for advice on these issues and more. 
  
Return to question list 
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Tags are skipped when printing on a Zebra tag printer, even after a calibration. What could be the problem? 
Earlier models of the Zebra LP2824 printer work erratically with the current driver. Ensure that the manufacture 
date of the Zebra LP2824 is after October 2002. 
See Common issues with Zebra tag printers for advice on these issues and more. 
  
Return to question list 
  
  
I accidentally sent a print job to the Zebra LP2824 that was meant for another printer. What should I do? 
Jobs meant for other printers are likely to have embedded commands that will create printing problems on the 
Zebra LP2824 printer. When this happens: 

1. Delete all pending print jobs for all printers (this may require rebooting Windows). 
2. Power the printer off, and then back on. 
3. Recalibrate the printer by selecting the Calibrate button on the Print dialog. 

Return to question list 
  
  
The Zebra tag printer prints one tag, advances past several blank tags, and then the printer light becomes 
red, or the printer light becomes red when sending a job to the printer. How can I correct this? 
This problem may be caused by accidentally sending a printer job meant for another printer to the Zebra LP2824. 

1. Delete all pending print jobs for all printers (this may require deleting jobs and rebooting Windows). 
2. Power the printer off, and then back on. 
3. Recalibrate the printer by selecting the Calibrate button on the Print dialog. 

Return to question list 
  
  
When printing tags with cost there are unusual characters, but no cost. What has happened? 
Tags can be printed in code to prevent inadvertent disclosure of Cost and Last Received Date information. The 
default at Edit  Preferences  Company  Pricing  Price Tag Codes maps the first 10 letters of the alphabet 
to the numbers 0-9 (a=1, b=2, c=3, etc.). Cost will print on tags in this code when you use a tag template with a 
suffix of "+ cost" (for example, "Zebra Label +cost"). Change the cost codes to suit your taste. 
Return to question list 
  
  
What is wrong when nothing prints on hang tags? 
Only one side of tag stock is designed for thermal printing. Reverse the direction that the tag stock feeds and try 
printing again. 
Return to question list 
  
  

(Pro) I changed fonts and font sizes in Print Designer, but my printouts are now messed up. Why? 
Print Designer allows you to change almost everything about a print template, including fonts, special characters, 
font sizes, colors, etc. But Print Designer doesn't know what printer you will use to actually print your tags or 
documents. Take care to not make changes that your printer won't support. For example, receipt and tag printers 
may not support all font characters, sizes, or color. Always test template changes to be sure the output is what you 
expected before putting the template into use in your store. 

How do I cancel a printing job after it has started? 
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Point of Sale "spools" a printing job to Windows and Windows then sends the job to your printer. This allows you to 
begin another task sooner in Point of Sale, while Windows handles the printing chores. You can cancel the print job 
using the Cancel button on the print progress dialog in Point of Sale. Unfortunately, on many print jobs the spooling 
and this dialog are visible for only a few seconds in Point of Sale. 
You may still be able to cancel the print job in Windows. Look for the printer icon in your system tray and double-
click it. This opens the Windows print queue window for the printer. Your print job and its status is displayed. To 
cancel the print job, select the document and then from the Document menu, select Cancel. 
Another, and possibly quicker, method of canceling a print job is too power off the printer itself. Cycling the printer 
power off and on typically clears any printer buffer (memory) that the printer itself may be using to hold the print job. 
You may still have to cancel or delete the job in the Windows print queue or it will remain there and possibly 
attempt to restart later. 
Refer to Windows help for more information on working with printers or changing your print settings. 
  
Return to question list 

Print Designer FAQs 
Print Designer Overview 

Pro 

Adding and Removing Elements from the Template 
I see something on the screen that I want to remove, how can I do that? 
How do I add a new section? 
Besides my logo, what other images can I add to the template? 
How do I know what information fields are available in the template? 
  

Formatting Text and Element Properties 
What options are available for formatting text and lines? 
How do I change the text in a message or comment line? 
  

Positioning and Sizing Elements and Sections 
How do I know where or how something will appear when I print? 
How do I get things to line up the way I want? 
Can I resize column and field widths? 
How do I resize or move a section? 
How do I align elements and groups? 
How do I turn on/off the rulers? 
How do the X/Y coordinates work? 
  

Printing and Viewing 
I see an element in the template, why is it not there when I print? 
Why is my new template not being used when I print? 
How do I know where or how something will appear when I print? 
  

Saving a Template 
How do I save and use my template design? 
How can I export my template so it can be used at another store or in another company data file? 
  
  

Didn’t find an answer to your question? Try these other resources: 
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Visit the Point of Sale User Community to ask questions and share ideas, solutions, and advice with other Point 
of Sale users and experts. 

Check out our support website to search our online database of answers to frequently asked questions at 
www.quickbooks.com/support/pos. 
  
  
  
  
I see something on the screen that I want to remove, how can I do that? 
The easiest way to remove an element from a template in Print Designer is to select it and press the enter key on 
your keyboard. You can also use the remove button on the toolbar. 
When a selected element displays a grey background, it is required and cannot be removed. However, a required 
group field may have components you can turn off so that they will not display. 
Sections cannot be removed from a template. If you do not wish section to be printed, just remove the elements in 
that section. 
Learn more about removing elements from a template. 
Print Designer overview 
Return to question list 
  
  
How do I add a new a section? 
Each template has a predefined and unchangeable number of sections. The number of sections in a template will 
vary depending on the template and on whether you are using a 40-column printer. 
Learn more about template sections. 
Print Designer overview 
Return to question list 
  
  
Besides my logo, what other images can I add to the template? 
More than one image can be specified in company preferences. but one must be designated the default logo. 
When you select an image in Print Designer, you can select the image set as the default logo, specify a different 
image than the default, or use more than one image in a document template. 
Learn more about adding a logo. 
Print Designer overview 
Return to question list 
  
  
How do I know what information fields are available in the template? 
Though most information is available to be printed, specific data fields will vary from template to template, and from 
section to section within each template. To determine what fields are available to be added in a section of a 
template, select that section and then select Add and Data field or Group of Fields. A dialog is displayed showing 
unused data fields that are available to be added to that section of the template. Data fields that are already in that 
section of the template will not be included in this list. 
Return to question list 
  
  
How do I change the text in a message or comment line? 
There are several different types of text messages. Some are defined in company preferences. Many documents in 
Point of Sale have comments fields that you can edit directly from the document. 
Some text fields, such as the signature memo on credit card receipts, cannot be edited. This text message can be 
turned off however by accessing the properties of the group element containing the credit card transaction and 
signature line. 

http://www.qbinproduct.com/community/help/pos
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You can also add text to any section of a document template. 
Return to question list 
  
  

Formatting Text and Elements 
In Print Designer, text can be formatted in the same manner as it is formatted in most word processing programs, 
including font, size, bold, italic, underline and color. To change the formatting of text, access the properties of the 
element containing the text. 
Specialized formatting of borders and graphic lines is not supported. 
Learn more about changing font, line and border properties. 
Print Designer overview 
Return to question list 
  
  
How do I know where or how something will appear when I print? 
The exact vertical placement of an element is dynamic based upon the other content in the printed document. More 
content or less content will cause elements to shift up or down the printed document. The template design window 
shows you what elements are assigned in each section, their general horizontal position, the sequence in which 
they will appear, and the space between them. 
The Print Preview screen will provide a much closer approximation to the printed document. However, the preview 
screen does not have an actual transaction to use a basis for the display and therefore is still not a perfect example 
of the printed document. 
The only way to see exactly how a document will print is to actually print a document from your history. However, 
you should bear in mind that not all fields are used in every document. For example, a receipt for a cash sale will 
not print the credit card signature lines. 
Learn more about positioning elements. 
Learn more about template sections and spacing. 
Return to question list 
  
  
How do I get things to line up the way I want? 
Elements can be aligned through various methods: 

• Drag and drop positioning 

• Using the alignment tools 

• Using the status bar coordinates 
It might also be necessary to resize an element in order to get it aligned in the way you prefer. 
Return to question list 
  
  
Can I re-size Column and field widths? 
Column widths, such as in the item list, can be re-sized. However, if you size the column and it becomes too 
narrow for the information that will appear in the column, the information will be cut off. 
Field and element widths can also be re-sized. Again, it is important to ensure that you do not re-size the field to a 
size too small for the data that will be printed in the field. 
Return to question list 
  
  
How do I resize or move a section? 
Sections in the template and particularly at the end of the document will vary in vertical length depending upon the 
particular type of document and the printer being used. It is recommended that you build each section from the top 
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down and then set the placement for the end of each section and the end of the document according to the lowest 
field placed in that section. The sequence of sections is predefined in each template. 
The image below shows the divider at the end of the document moved to just below the end of the last field. This 
ensures that no wasted space is added to the printed documents. If more space is needed, the divider can be 
moved down. 

 
  
Return to question list 
  
  
How do I turn on/off the rulers? 
You can turn the rulers and set other interactive features in Print Designer preferences. These features give you 
choices for how you want to view and work with templates: 

• Snap overlapping objects to their edges – helps quickly align the vertical edges of adjacent elements. 
With this option selected, you can overlap the top or bottom edges of two elements and they will automatically 
"snap" the edges to align with each other. 

• Show example text for data fields – With this option selected, data fields display sample text instead of 
the field description. 

• Show Top Ruler – Helps position elements horizontally on the page. 

• Show Side Ruler – Helps position elements vertically on the page. Note that vertical positioning is relative, 
rather than absolute. When the document is printed, fields not populated with data are removed and lower 
fields on the template moved up to fill the blank space. 

To set Print Designer preferences: 
1. With a template displayed, select Preferences from the lower-left of the screen. 
2. Select or clear the checkboxes for the preference options. 
3. Select Save. 

  
Return to question list 
  
  
How do the X/Y coordinates work? 
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The X and Y coordinates are, respectively, the current horizontal and vertical position of the top left corner of the 
selected element. While moving an element, the displayed coordinates show the position changes, allowing you to 
place the element exactly, whether you are using drag and drop, or the arrow keys on the keyboard. 
Learn more about status bar coordinates. 
  
Return to question list 
  
  
I see an element in the template, why is it not there when I print? 
Some elements are conditional and are only printed when applicable. For example, a credit card signature line 
would not appear on a receipt for a transaction being paid with cash. In such cases, the unused element and the 
space it takes are removed from the printed document. Elements that appear below the unused element are moved 
up the document accordingly. 
  
Return to question list 
  
  
Why is my new template not being used when I print? 
Point of Sale uses whichever template is assigned in workstation preferences. When printing tags, you have the 
ability to change the template and/or printer directly from the print dialog. 
  
Return to question list 
  
  
How do I save and use my template design? 
Templates can be modified and saved with the same name, or they can be modified and using Save As can be 
saved with a different name. Once complete, the modified template will be available for use. 
Point of Sale uses whichever template is assigned in workstation preferences. When printing tags, you have the 
ability to change the template and/or printer directly from the print dialog. 
Learn more about modifying and saving changes to a template. 
Learn more about recommended sequence for editing and saving templates. 
Return to question list 
  
  
How can I export my template so it can be used at another store or in another company data file? 
If you have created templates that you wish to use at another location or in another Point of Sale company file , use 
the import/export feature to export specific or all modified templates to an external file. Once you have copied the 
external file to the destination location, use the import/export feature at that location to bring the templates into that 
system. 
Learn more about importing and exporting templates. 
Return to question list 

Sales Tax FAQs 
Sales Tax Overview | Configuring Sales Tax | Sales Tax Reports 
  
The following lists include common questions about collecting sales taxes in Point of Sale. Click on a question or 
scroll down to view the answers. 
  
How do I collect sales tax based on unit price thresholds? 
Due to a recent tax law change, when selling an item above a specified unit price I need to collect one combined 
tax rate for two agencies, but if the unit price is below the threshold I only collect tax for one of the agencies. How 
do I handle this in Point of Sale? 
How do I collect a different tax rate on certain "luxury" items 



Help and Learning 

643 

I often take coupons or provide discounts which are reimbursed to me later by a third-party. I am required to collect 
tax on the full item price, prior to the coupon or discount being applied. How can I do this? 
My city requires me to collect ½ of 1% tax on top of the state sales tax charged. How do I set this up and get proper 
tax reporting? 
I didn't need a particular tax code in my second tax location, because all sales using that location are non-taxable. 
However, when I deleted the code from the second location, it was also deleted from my default location ( where I 
do need it to collect sales tax). Why? 
How do I collect tax on shipping amounts? 

Didn’t find an answer to your question? Try these other free resources: 

Visit the Point of Sale Community User Forums to ask questions and share ideas, solutions, and advice with 
other Point of Sale users and experts. 

Check out our support website to search our online database of answers to frequently asked questions at 
www.quickbooks.com/support. 
  
  
  
  

I am required to collect 8.0 % sales tax on certain items, but only if the unit price of the item exceeds a set 
amount, and then the tax applies only to the amount above that price. How do I handle this? 
Set up a separate tax code in company preferences for this purpose. Select the Price-dependent single-rate tax 
option when defining the tax code . Enter the unit price threshold (the amount above which tax is collected), and 
then also select the checkbox to Apply sales tax only to the amount over the unit price threshold. 

 
   
After setting up the tax code, assign it to the items in inventory that are taxed this way. 
Point of Sale will automatically apply sales tax to the items associated with this code when they are listed on a 
sales receipt. 
Learn more 
Sales tax overview 
Return to sales tax FAQs 
  
  
  

Due to a recent tax law change, when selling an item above a set unit price I need to collect one combined 
tax rate for two agencies, but if the unit price is below the threshold I only collect tax for one of the 
agencies. How do I handle this in Point of Sale? 
This is best handled by setting up a multi-rate tax code. Set up one component of the tax code for each different 
rate/price range/agency combination needed, up to three components per tax code. 
Click here to learn more about multi-rate tax codes and to view some examples of their use. 
After setting up the tax code, assign it to the items in inventory that are taxed this way. 
  
Return to sales tax FAQs 
  
  
  

http://www.qbinproduct.com/community/help/pos
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I am required to collect a tax rate higher than my normal sales tax on certain "luxury" items. How do I 
handle this? 
Set up a separate tax code and assign it to the luxury items in inventory. When defining the taxing instructions, 
enter the higher tax rate. Point of Sale will automatically apply the higher sales tax rate to the items associated with 
this code when they are listed on a sales receipt. 
Example: Most of your taxable items are assigned the tax code "Tax" with a 7.0% tax rate. However, the luxury 
items you sell must be taxed at 8.5%. Add a tax code named "Luxury" or similar, enter the 8.5% tax rate, and 
optionally define a different tax code "mark" for this code to print on the customer’s receipt, such as an "L". Then 
assign the new tax code to the appropriate items in inventory. 
If the tax only applies to the portion of the item price exceeding a defined threshold, you can use the price-
dependent option when defining the tax code. 
Return to sales tax FAQs 
Using sales tax codes 
Sales tax overview 
  
  
  

I often take coupons or provide discounts which are reimbursed to me later by a third-party. I am required 
to collect tax on the full item price, prior to the coupon or discount being applied. How can I do this? 
Set up a non-taxable, non-inventory item for the coupon/discount that can be listed on the sales receipt. Include 
identifying information in the item description so that reports can be filtered or sorted by this value and set the price 
as a negative amount equal to the coupon amount or discount. (Option: Enter a generic description, e.g. "Coupon" 
and no price and edit the item when listing on a receipt to enter the amount and identifying information). 
When selling the item, list both the item being sold at its regular price and the non-inventory coupon/discount item. 
Tax will be applied to the full price of the sold item, but the total due from the customer will be reduced by the 
discount item amount. 
Since you are using an inventory item to apply the discount, consider the affect on your merchandise sales reports. 
You may want to filter and memorize your merchandise sales reports to exclude the coupon/discount item. 
Sales tax overview 
Return to sales tax FAQs 
  
  
  

My city requires me to collect ½ of 1% tax on top of the state sales tax charged. I need to report and pay 
this tax separately to the city. How do I set this up and get proper tax reporting? 
When defining your tax codes, select the Multi-rate option. Enter the city and state tax rates as separate 
components of the code, each with their respective tax rate. (Note: Enter 0.5 % by typing 0.005 in the tax rate field). 
Since the tax is collected on the full price of the taxable items, do not enter any price thresholds. Assign this tax 
code to all taxable items in inventory and Point of Sale will collect the full combined tax rate on sales, but you'll 
have the ability to sort and sub-total your tax reports by agency. 
Click here to learn more about using multi-rate tax codes. 
  
Alternative: If you have integrated Point of Sale with QuickBooks financial software, you can accomplish the same 
reporting by setting up a tax group in QuickBooks and then mapping a single-rate Point of Sale tax code to the tax 
group. With this setup, the Point of Sale tax code will collect the single combined tax rate on sales, but your tax 
reports in QuickBooks financial software can break out the taxes due to each agency. Read Collecting sales tax for 
multiple agencies for more information. 
Sales tax overview 
Sales tax reports 
Return to sales tax FAQs 



Help and Learning 

645 

  
  
  

I didn’t need a particular tax code in my second tax location, because all sales using that location are non-
taxable. However, when I deleted the code from the second location, it was also deleted from my default 
location ( where I do need it to collect sales tax). Why? 
Tax codes are universal across all your tax locations. Adding or deleting a tax code adds or deletes it to/from all tax 
locations. However, the taxing instructions for the code can be different for each location. In this case, you should 
add the tax code back but edit it in your second location to specify a 0% tax rate. 
Also, in the second location (0% tax), you can map the tax code to a different QuickBooks tax item so it is reported 
properly in QuickBooks. 
Using tax codes 
Using tax locations 
Sales tax integration with QuickBooks 
Configuring sales tax 
Return to sales tax FAQs 

Office Integration FAQs (E-mail, Import/Export, Write Letters) 
E-mail Documents | E-mail Preferences | Store Exchange Methods 

Basic  

E-mailing from Point of Sale 
I have Outlook Express set up as my default Windows e-mail client, but when I select to e-mail a document or run 
Store Exchange, Point of Sale launches Microsoft Outlook instead. How do I fix this?  

There are known issues with using Outlook Express to handle file attachments, which is necessary when e-
mailing documents or Store Exchange files. For this reason, if you also have Outlook installed, Point of Sale will 
use Outlook to send these files. Outlook Express will continue to be used when sending e-mails from a vendor 
or customer record. 
Your choices in this case are: 

• Continue in the same manner in which it is working. 

• Set Outlook as your Windows e-mail client. How do I? 

• Use the Add or Remove Programs option in Windows Control Panel to remove Microsoft Outlook 
from your computer. Point of Sale will correctly launch Outlook Express once Outlook is removed, 
however your e-mail documents will be subject to Outlook Express’s limitations. 

  
How do I change the format of my e-mailed documents?  

The format of your e-mailed documents is controlled by: 

• The document template specified in workstation preferences: Specifies the information fields 
included and their arrangement on the page. This setting affects both printed and e-mailed documents. 
How do I change the document template? 

• (Pro) The e-mail format specified in company preferences: Use this setting to be sure the e-mailed 
document is compatible with the recipients installed programs for viewing it. File format options are PDF, 
Text, HTML, or Excel. How do I change the document file format? 

  
How do I view e-mail attachments that are in PDF format?  

Viewing PDF documents requires that you have the free Adobe Acrobat Reader installed. You can install this 
program from your Point of Sale CD. View instructions  

  
Can I e-mail all of my customers or vendors at once?  
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You cannot complete mass e-mailing from within Point of Sale. However, you can build targeted marketing 
customer lists to use with third-party e-mail marketing providers or export your customer (and vendor) lists to 
Excel. 
The customer lists you create can be sent directly to an e-mail marketing partner integrated with Point of Sale 
or can be manually uploaded to another provider of your choice.   
Learn more about: 
E-mailing a customer 
E-mailing a vendor 
E-Mail Marketing with Point of Sale 

  
  

Writing Letters 
I get an "invalid field" message when trying to write a letter. How do I fix it?   
  
Related Topics 
Troubleshooting overview 
Help and support overview 

Why is a Point of Sale feature not available to me? 
Help and Support Overview | Unlock to Higher Level 
  
If a Point of Sale feature is not available to you, it may be due to one of the following reasons. Features not 
available may be grayed out or not displayed on your screen at all, depending on the specific reason. Select a link 
for more information on a particular setting or feature. 

• The level of Point of Sale (Free, Basic, or Pro) you have licensed doesn't include that feature 

• You don't have security rights to access that feature 

• You are on a Client Workstation, but the feature is available only on the Server Workstation 

• The feature has been turned off in company preferences 

• A related feature, required for the feature you are trying to use, is not available, has been turned off or not 
set up (e.g. to track charge accounts requires that you track customers, to require employees to log in and 
restrict their access requires a company preference setting to that effect, and to use customer orders requires 
you also have tracking customers turned on, etc.) 

• You are trying to use a Financial Exchange feature but your connection with QuickBooks has not been set 
up 

• You are at a remote store in a multi-store configuration and the feature is not available to remote stores 
Important Note: New information fields, list columns, and report options may be added in support of new and 
enhanced features in Point of Sale upgrades and updates. In most cases, these new fields and options are 
automatically available to you. However, if you have customized your Point of Sale lists,  reports, or printed 
documents and tags, the new installation does not overwrite your customized layouts to add the new fields. If you 
plan to use a new feature, and the fields or options are not visible to you, you may need to further customize your 
layouts to add them or, in the case of reports, use the Revert option to reset to the default options and then re-
memorize. 
  
Related Topics 
Help & Support Resources 

Troubleshoot Your Cash Drawer 
Compatible Cash Drawers | Help & Support Overview 

My cash drawer will not open. What could cause this? 
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Use the procedure below to troubleshoot your cash drawer, or use the Hardware Troubleshooter wizard , available 
from the Help menu. 
To function in Point of sale, a cash drawer must be connected through a working 40-column receipt printer. 

1. Are both your cash drawer and receipt printer on the Point of Sale compatible hardware list? 

Note:The M-S Cash Drawer formerly sold by Intuit works only with compatible Star receipt printers. Learn more  

• If YES, continue with the following steps. 

• If NO, has your cash drawer/printer worked with Point of Sale in the past? If it has, try the 
following steps to restore operation. If not, obtain and install compatible hardware. 
2. Are the cash drawer and printer cables connected  tightly? 

Note: Use only the manufacturer's cable included with the cash drawer for this connection. Using any other cable, including 
phone cords, may result in irreparable damage to your receipt printer. 

• If YES, continue with the following steps. 

• If NO, correct the connections and then test the cash drawer again. 
3. Is the receipt printer printing normally? Try re-printing a saved receipt from your sales history to 
test. 

• If YES, continue with the next step. 

• If NO, troubleshoot the printer first. Fixing the printer operation will most likely correct the cash 
drawer issue as well. 
4. Does the receipt printer specified in your cash drawer setup exactly match the receipt printer 
specified for printing receipts in workstation preferences? 

  
Edit  Preferences  Workstation  Cash Drawer: Make sure the receipt printer specified here matches 
the one specified on your Documents & Printers page for printing sales receipts. 

 
Edit  Preferences  Workstation  Documents & Printers 

 
• If YES, continue with the next step. 

• If NO, change your selections to match your receipt printer, and then select the Open Cash 
Drawer button to test the operation. Continue with the following steps if necessary. 
5. Are your company sales preferences set to open the cash drawer for the payment type you are 
taking? 
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6. Is the cash drawer locked? Use your key to open it, if necessary. 
7. Is something inside the cash drawer preventing it from opening? Try gently shaking the cash 
drawer to dislodge the obstruction. 

  
Related Topics 
Install the VAL-u Line cash drawer 
Install the M-S cash drawer 

Troubleshoot Your Receipt Printer 
Print FAQs | Help & Support Overview 
  
Use the procedure below to troubleshoot your receipt printer or use the Hardware Troubleshooter, available from 
the Help menu. 

My 40-column receipt printer is not working. What could cause this? 
1. Is your receipt printer on the Point of Sale compatible hardware list? 

• If YES, continue with the following steps. 

• If NO, has your printer worked with Point of Sale in the past? If it has, try the following steps to 
restore operation. If not, obtain and install a compatible printer. 
2. Check the following printer conditions: 

• Is the printer plugged in and powered on? 

• Is the printer out of paper? 

• Is the printer cover open? 

• Are there error lights illuminated on the printer? Information and solutions for error light conditions 
are available for these printers: Star TSP 100, Star TSP 600, Epson TM-T88III, Epson TM-T88IV, Citizen 
CT-S300. 

If your printer isn't listed, consult the printer's user guide or contact the vendor for more information. 
3. Is the receipt printer correctly installed and specified in workstation preferences? 

• Is your printer model on the Available Printers list? If not, choose Add Printer and install it now. 

 
• Is your printer model selected on the Documents & Printers page for printing receipts? 
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If not, change your selections to match your printer, and then select Print Test Page. Continue with the 
following steps if this doesn't fix the problem. 
  

4. If using a USB printer, did you recently change the USB port into which you have it attached to 
your computer? 

Changing the USB port for your printer causes Windows to install the printer a second time. Each installation of 
the printer is unique to the USB port into which it is attached. If this has happened, your Available Printers list 
will have a second instance of your printer named Copy of <model>. 
You can either plug the printer back into the original port or, if leaving it in the new port, return to the 
Documents & Printers page of workstation preferences and select Copy of <model> as your receipt printer. 
If using a cash drawer with the receipt printer, also change your cash drawer setup to reflect the Copy of 
<model> receipt printer selection. 
In general, it is recommended you always plug the receipt printer into the same USB port and delete the other 
instance of the printer from your Windows printer list. 

If the steps above do not correct the problem, uninstall and reinstall the printer. 
1. Open your Windows Printers and Faxes folder from the Windows Start menu or Control Panel. 
2. Ensure there are no documents waiting to be printed by double-clicking your receipt printer name. 
If documents are pending, select Cancel All Documents from the Printer menu and then close the 
documents window. 

If there are multiple copies of your receipt printer listed, do this for each. 
3. Delete each occurrence of your printer by highlighting it and then selecting Delete from the File 
menu. 
4. Reinstall your printer, following the instructions provided with it. Click here for instructions to 
install supported hardware you have purchased from Intuit. 
5. Return to workstation preferences and select the new installation of your printer for sales receipts 
and, if applicable, for your cash drawer connection. 

  
Related Topics 
Print FAQs 
Troubleshoot a cash drawer 
Troubleshooting Overview 

Pole (Shopper) Display FAQs 
Compatible Pole Displays | Configure your Pole Display 

Nothing displays on my pole display. What could be wrong? 
Check the following, seeking the help of a qualified computer consultant if necessary: 

• Be sure the display has power. Some older units have a power switch located under the display unit; be 
sure this is turned on. When the unit is first powered on, the display will show the power up information for 
several seconds. If you do not see this then it is either not getting power or the unit is defective. 

• Ensure that the port selected in workstation preferences matches the physical port on the computer. 

• Serial pole displays may conflict with other serial devices, such as modems or printers, even if the other 
device is not connected or powered on. It may be necessary to reassign other serial devices to different ports. 

• If using a Logic Controls pole display, unplug the unit for a few minutes an then plug back in; this will 
reset the display 

Related Topics 
Install the Partner Tech CD7220 pole display 
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Troubleshooting overview 
Help and support overview 

Bar Code Scanner FAQs 
Help & Support Overview | Support Resources 

How do I configure my bar code scanner to automatically insert a carriage return after each scan? 
Bar code scanners can be configured to insert a carriage return after each scan by scanning a bar code included in 
the documentation that you received with your scanner. Check the documentation for specific instructions. 
Bar code scanners purchased from Intuit should be preconfigured to insert the carriage return automatically, but if 
this setting is somehow lost, it can be reprogrammed by following the directions that came with the scanner. 
  

How do I reset the HHP® IT3800LR model bar code scanner? 
1. Locate the Resetting the Factory Settings section in your HHP IT3800 User manual. 
2. Scan the bar code labeled Factory Default Settings with the scanner. This will reset the 
scanner. 

  
Related Topics 
List of compatible bar code scanners 
Using bar codes and scanners in Point of Sale 

Implement a Comprehensive Data Protection Strategy 
Data Overview | Backup and Restore Data | Troubleshoot 
  
The data you accumulate in your business is extremely valuable. Keeping it safe should be a top priority. Point of 
Sale provides several methods to help you protect your data: 

• By requiring employee logins and assigning security rights you can limit access to your data and program 
features. Learn more 

• Changes that affect your inventory value (cost and quantity) are automatically tracked on transactional 
documents and adjustment memos, creating an audit "trail." Learn more 

• Backup copies of your company data can be made each time you run the End of Day procedure, 
automatically once each day when the Server Workstation exits the software, or at any scheduled time you 
specify. Additional protection can be gained by following a regular manual backup routine. 

• Your data files are automatically checked for integrity and repaired if necessary as backups are made. This 
procedure is automatic and no user action is necessary. 

• If you use the QuickBooks POS Merchant Service to process credit and debit card transactions, you must 
take measures beyond the general recommendations listed below to protect your customer's card information. 
Refer to the electronic Implementation Guide for assistance in using Point of Sale within an overall system 
that meets the Payment Card Industry (PCI) Data Security Standard (DSS) requirements. 

General System and Network Protection 
While the steps above are intended to protect your Point of Sale data, you should also be concerned about general 
system protection. Here are several more suggestions for protecting your data and the systems on your company 
network. 

• Require password logins – Assign a unique username and password to each person in your company 
using Point of Sale. Each employee should have a unique user name and password for Windows and for 
Point of Sale. Point of Sale, like any Windows application, relies on security features within Windows. These 
features are most effective when each user on the system can be accounted for. With password protection 
set, access to your company file can only be granted with the assigned passwords. If you share your data file 
with an accountant or other business advisor, assign user names and passwords to them as well. 

• Restrict Security Rights – Configure Point of Sale security rights appropriate for your business and the 
needs of your employees to access specific features and data. Point of Sale comes with four default security 
groups (sets of rights) and you can create custom groups as needed. 
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• Install and use anti-virus software – and keep it up to date! 

• Install a network-based or PC-based firewall – If you install a firewall on your Internet connection, you 
can reduce the likelihood that uninvited persons will use the Internet to access systems on your network. 
Firewall products will help you to ensure that your computers only conduct the traffic you allow. Most major 
brands of anti-virus software also offer firewalls. Firewalls may have to be configured to allow Point of Sale to 
communicate between workstations on a network. 

• Use Windows security and Windows Update – To obtain and install the latest security updates for your 
computer. Find out more about Windows security and Windows Update services from Microsoft at 
http://www.microsoft.com/security/. 

• Backup your data frequently – Keep backups of your data file in a safe location, preferably off-site. Keep 
your backups in a fireproof safe, or at a business records management facility. 

• Install a UPS – A UPS (uninterruptible power supply) helps ensure data integrity in the event of a sudden 
power loss by providing a few critical minutes of backup power in which you can complete and save in-
progress transactions. Without a UPS, these transactions are usually lost and, as with any software, the data 
file can become corrupt if disk-write operations were in progress when the power was lost. We recommend a 
UPS on each Point of Sale workstation, but most importantly on the Server Workstation which stores your 
data. 

• Restart your computer at least a couple times a week. – Restarting or "rebooting" is how your 
computer cleans up the bits and pieces (i.e., files) of applications and data that inevitably get stranded in its 
memory and temporary file locations over time. Left to accumulate, these files eventually can cause conflicts 
as applications compete for your computer’s resources. Restarting occasionally wipes the slate clean and 
helps resolve these conflicts. We also recommend completely shutting down your computer at least once per 
week or anytime you are having hardware-related issues (leave it off for at least 15 seconds before powering 
on again). 

User Information Window and Non-Tolerant Activities 
Help and Support Overview 
  
Some tasks in Point of Sale are non-tolerant activities, meaning that all other workstations must exit Point of Sale 
before the task can be performed. 
In most cases, the User Information window is displayed automatically if you launch a non-tolerant activity and 
gives you a list of other workstations currently using the program or applications that must be ended. You can also 
access this information manually following the procedure below. 

To view the User Information screen: 
1. From the File menu, select Utilities >  User Information. 

The workstations currently in Point of Sale are displayed. If these workstations exit, you can select Refresh to 
update the information. 

2. Select OK to exit. 
  

Notes: 
• If you use third-party applications that are integrated with Point of Sale and they are currently connected to 
the Point of Sale company data they must be shut down for a non-tolerant task to be completed. 

Non-tolerant activities in Point of Sale include: 

• Restoring from data backup files 

• Changing certain company preferences 

• Cleaning up company data 

• Manually downloading and/or installing Point of Sale program updates 

• Renaming the company data file 

• Importing item data 

http://www.microsoft.com/security/
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Configure Windows User Rights 
Help & Support Overview | Help & Support Resources | Troubleshoot 
  
If you use Windows 2000, XP, Vista, or 2003 Server, and have configured user rights at the operating system level, 
those Windows rights may affect access to Point of Sale. 
Point of Sale checks the Window’s rights (of the user that is logged in to Windows) on startup and displays a 
message if Windows rights are blocking access to the program. In this case, you should configure your Windows 
rights to give users Administrator or " full control" rights to the QuickBooks Point of Sale folders and their sub-
folders as described below. These rights allow reading and writing of data to the QuickBooks Point of Sale folders. 
Windows user rights are computer and user-specific. If you have multiple workstations, you have to set up 
Windows rights on each computer for each user that will log on to Windows. 
Windows user rights need only be set up for the employees that log on to Windows, not for each Point of 
Sale user. 
On the Server Workstation, for each user that will log on to Windows, give full control rights to: 

• The folder where Point of Sale is installed; typically …C:\Program Files\Intuit\QuickBooks Point of Sale 
n.n (n.n = version number) 

On each client workstation, for each user that will log on to Windows, give full control rights to: 

• The folder where Point of Sale is installed 

Note: Giving full control to users for these folders DOES NOT give them rights to any other programs or folders on your system. 
The Point of Sale rights you assign to your employees within Point of Sale still restricts access to program features. 

  
Following are summarized instructions for managing Windows users and setting Windows rights for these folders. 
These instructions are for Windows XP and may vary depending on the version of Windows that you have. Consult 
your Windows documentation for specific instructions. 

To add or manage Windows users or groups: 
1. Right click on My computer and then select Manage. 
2. Select Local Users and Groups and then either the users or groups folder. 
3. Use the menu options to add, delete, set passwords, or view the properties of users or groups, as 
necessary. 

To set up Windows rights for specific folders: 
1. In Windows Explorer, browse to a folder. 
2. Right-click on the folder and select Sharing and Security. 
3. Select the Security tab. 
4. In the upper pane, click the user or group name to which you want to assign rights. 
5. In the lower pane, click the checkbox for Full Access (so that the box is checked). 
6. Repeat for other users or groups. 
7. Select OK. 
8. Restart Point of Sale. 

  

Note: Security steps have been taken in Point of Sale to prevent unauthorized access to your company data. Part of this 
protection includes creating a user profile in Windows called QBPOSDBSrvUser. This ensures that your company information 
can only be accessed through Point of Sale. If your system has been set up with only one user and no login password, Windows 
has been bypassing the user selection screen during startup; this will no longer occur. 

  
Related Topics 
Employees and security 

Set Your Internet Explorer Security Level 
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Some Point of Sale features are displayed using the Microsoft Internet Explorer browser. If the security levels set 
for Internet Explorer on your computer are too restrictive, you may not be able to access some features or view 
some content in Point of Sale, or you may have to click through several security messages to view the content. 
Point of Sale features that use Internet Explorer will typically display correctly if the security levels for Internet 
Explorer are set to Medium. Only you can decide which level of security is right for you, and 
  
What are the default security levels in Internet Explorer?  

For the Internet zone, the default security level is Medium. At this level, Internet Explorer prompts you before 
downloading potentially unsafe content from an Internet site. 
For the Local intranet zone, the default security level is Medium-low. Since this zone is used for browsing sites 
on your company's network (intranet), the lower security setting is usually appropriate. If you are concerned 
about this security setting, contact the system administrator at your company. 
Note: For some versions of Microsoft Windows, such as Microsoft Windows Server, the default security level 
may be different. In these cases, you must set the security levels to Medium. 

  
Will changing my settings affect Internet Explorer outside of Point of Sale?  

When you change your security settings for Internet Explorer, the changes affect your Web browsing both 
inside and outside of Point of Sale. 
You can increase the security levels for Internet Explorer after you leave Point of Sale. However, the next time 
that you attempt to the use the same feature in Point of Sale, you will be asked to reduce the security levels 
again. 
To use all Point of Sale features, the security levels for Internet Explorer should not be set higher than Medium. 
The Medium security level is designed for safe browsing without loss of functionality. 

  

To change the security levels: 
1. In Microsoft Internet Explorer, go to the Tools menu and select Internet Options. 
2. Choose the Security tab. 

At the top of the page, you'll see a list of the Web content zones. You need only verify and change the settings 
for the Internet and Local intranet zones. 

3. Select the Internet icon at the top of the window. Then, select the Default Level button. 
Medium security should be selected, and a description of the security level appears in the window. 

Note: If Medium security is not selected as the default, use the slider to set the security level to Medium. 

4. Select the Local intranet icon at the top of the window. Then, select the Default Level button. 
Medium-low security should be selected, and a description of the security level appears in the window. 

Note: If Medium-low security is not selected as the default, use the slider to set the security level to Medium-low. 

4. Select OK. 
  

Notes: 
• For more detailed information about Internet Explorer's security levels, refer to the information and help 
provided in the Internet Options window. 

Hardware Troubleshooter 
Hardware Drivers  | Compatible Hardware List | Hardware Setup Wizard 
  
The Hardware Troubleshooter can help you identify and correct problems with your Point of Sale hardware. 

To use the Hardware Troubleshooter: 
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1. From the Point of Sale Help menu, select Hardware Troubleshooter. 
2. Select the type of hardware with which you are having trouble. 
3. Follow the on-screen prompts to narrow down the possible causes, try the suggested solutions, 
and then use the test option to verify the issue has been resolved. 

  

Notes: 
• If you have non-Intuit hardware, you may be prompted to use the manufacturer’s CD or instructions to 
troubleshoot the device. When done return to the troubleshooter and continue. 

Related Topics 
Troubleshoot a receipt printer 
Troubleshoot a cash drawer 
Troubleshooting overview 
Help and support overview 
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